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Chapter 1.  .NET Component Hosting

About CIMPLICITY .NET Component Hosting

Component Hosting enables you to take advantage of .NET technology by seamlessly supporting 

hosting .NET components in CIMPLICITY screens.

• .NET Control: Configuration guidelines.

• .NET Control: Technical reference.

Install and System Requirements

Installed features and requirements for .NET components include:

• The .NET Component Hosting package is automatically installed with the CIMPLICITY v8.2 SIM 10 

or higher.

• Component Hosting requires that Microsoft .NET Framework be installed with the target system.

The following will be installed when CIMPLICITY is installed:

• Two additional modules, specifically tailored for interfacing with CIMPLICITY screen editing and 

runtime views, are also installed without user interactions.

The modules, which are demo and sample components, are installed into the following folder.

..\<CIMPLICITY Installation>\exe\DotNet Components.
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.NET Control: Configuration

.NET Control: Configuration Guidelines

 .NET Component Hosting, .NET control makes configuration available to different degrees in both the 

control's Properties - Object dialog box>Control Properties list and using CimEdit's properties, such as 

events, procedures/methods and scripts.

Similar to other ActiveX controls, because there are so many varieties of .NET controls, the available and 

appropriate configuration depends on the selected control.

.NET Configuration Guidelines

• .NET Control: Insert into a CimEdit screen.

• .NET Control: Color and font properties.

• .NET Control: Additional CimEdit configuration.

.NET Control: Insert into a CimEdit Screen

.NET controls can be easily found and placed onto a CimEdit screen using the Ribbon bar .NET button.

1  (on 

page 

14)

Open the .NET Component Brows

er.

2  (on 

page 

15)

Select a .NET control to insert.

3  (on 

page 

16)

Adjust the control on the screen.

1. Open  the .NET Component Browser

1. Click the .NET button in the Drawing>Objects group on the CimEdit Ribbon bar.
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The ActiveX placement cursor  displays on the screen.

1. Place the cursor where the component will be placed initially.

2. Click the left-mouse button.

A .NET Component Browser opens; the browser (initially) includes the following categories of .NET 

components.

Note:

You can modify the list by adding and/or removing  (on page 61)  components.

A System.Windows.Forms (Forms-based controls)

B Windows Presentation Framework (WPF controls)

C Sample Components Note:  CIMPLICITY provides two sample con

trols

• TrendChart

• LinearGauge  (on page 31)

1. Select  a .NET Control to Insert

Do the following.
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A Select a component in the .NET Component browser's expanded 

tree.

B Click OK.

Result: The component displays on the CimEdit screen.

1. Adjust  the Component on the Screen

Screen editing actions and configuration actions with the Properties dialog box on a screen that contains 

hosted .NET components all work essentially the same as on a screen that contains only OLE and 

CIMPLICITY native objects.

Actions include, but are not limited to:

• Copy • Paste • Undo

• Delete • Re

size

• Save

• Move • Select • Load

Note:  For most actions, the control will have to be in configuration mode.

• .NET Control: Display modes.

• .NET Control: Resize.

• .NET Control: Move.
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.NET Control: Display  Modes

When .NET controls are placed initially on the CimEdit screen they are in configuration mode, which 

displays as follows.

A The initial object size is the same regardless of what control is select

ed.

B Text identifies the selected component.

The control display when you double-click it depends on the default control configuration and properties.

A The initial object size is the same regardless of what component is selected.

B Possible displays include:

• A representation of the runtime image. (e.g. Calendar).

• A blank box.
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C Area surrounding control display, if there is one, standardizes the initial insert 

size.

Important:

Because these components come from different sources, the display may require additional 

scripting or configuration for anything to display. If the image is blank or not what you expect, 

consult the documentation from the component's source to learn what is required.

.NET Control: Resize

You can resize the .NET component using the same methods as you use for any CimEdit object.

Note:

The:

• Resize process may require some toggling between the configuration mode image and the runtime 

(or blank) representation.

• Actual runtime display may or may not resize, depending on the control. However the area around it 

can be increased or decreased.

Examples

• The initial size of a checkbox control is the same as any other control. The checkbox itself cannot 

be resized; the area around the checkbox can be reduced so only the checkbox displays.

• The actual text box in a Rich Text box control can be larger or smaller, as required.

1. Select the handle that will resize the object in the appropriate direction

2. Drag the handle in the direction that will correctly resize the object.

3. (If necessary) Click the left mouse button outside of the component.

The display will toggle to the view that does not currently display.

4. Toggle back and forth until the image is the appropriate size.
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Display 

Mode
Guidelines

A Configu

ration

Resize the .NET component object the same say you resize any CimEdit object.

◦ Select a handle and move it.

◦ Enter new Geometry  specifications in the object's Properties dialog box.

Note:

If the component size is reduced, the identification label may no longer dis

play when the control is in configuration mode.

B Runtime ◦ If the component has enough information to display a runtime representa

tion, this display will guide the resizing.

◦ If the runtime image is blank, you can estimate the size and modify it when 

your configuration produces an image.

guide:

Guideline: Component Identification

Naming the component will enable you to identify it easily. Instances when entering a unique name 

will help include:
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◦ The size is reduced so the configuration mode no longer displays the name.

◦ The runtime mode is blank.

◦ More than one of the same component is required.

◦ A CIMPLICITY procedure that requires the control name is being configured.

a. Right-click the component; select Properties on the Popup menu.

The component's Properties dialog box opens.

a. Select General.

b. Enter a unique name in the Object Name  field.

.NET Control: Move

Move the .NET component object the same way you move other CimEdit objects.

Note:

The object must be in the configuration mode to move it.

◦ Select the object and move it.

◦ Enter new Geometry  specifications in the object's Properties dialog box.

.NET Control: Color and Font Properties

Many .NET control properties are unique to the selected control. However, in most cases colors/

brush types and fonts that are included in the control can be changed in the Properties - Object dialog 

box>Control Properties.
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• .NET Control: Select colors and brush types.

• .NET Control: Select fonts.

.NET Control: Select Colors  and Brush Types

When using Component Hosting, the Windows Forms color (System.Drawing.Color) and WPF color 

(System.Windows.Media.Color) types are converted to the COM color type (OLE_COLOR) so the two .NET 

color types can be configured with the standard Windows palette.

• Color: Color

• Color: Brush types.

Color: Color

1. Right-click a .NET control>select Properties  on the Popup menu.

The Properties - Object dialog box opens.

2. Select Control Properties.

3. Click the Palette button to the right of the control color you want to change.

\

A standard Windows color palette opens.

4. Select a color.
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Selection options include the following.

A Palette 

tab

Click a preconfigured color on any of the Palette tab color groups. Note:  Use the For

ward/Back scroll buttons to display available preconfigured color groups. Result: The 

preconfigured color is selected for the control.

B Ad

vanced 

palette

Right-click a reserved color box on the Palette tab. Configure a custom color in the 

Advanced Color dialog box. Click Add Color. Result: The configured color is:

◦ Added to the selected box on the Palette tab.

◦ Selected for the control.



Addons and Options  | 1 - .NET Component Hosting  | 23

Color: Brush  Type

Brush types are available for most WPF control parts that can be colored.

Brush Type Options are as follows.

◦ BrushType_Solid

◦ BrushType_Linear

◦ BrushType_Radial

BrushType_Solid

Select one color.

Select BrushType_Solid for the selected color area, e.g. Background_Type.

Result: The selected color area will display one solid color.
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BrushType_Linear

A linear brush provides a "straight line" gradation in which one color gradually changes to another. 

You can select where in the gradation, each color will begin and end.

Select BrushType_Linear in the ...Type  field for the selected area.

Required configuration entries include the following.

Field Description

A ...Color1/...Color2 Two colors are required for a Linear brush type.

B ...Point1X/Point1Y X and Y coordinates of the gradient starting posi

tion

C ...Point2X/Point2Y X and Y coordinates of the gradient ending position

BrushType_Radial

A radial brush provides a circular gradation in which one color starts at a center point and gradually 

changes to another. You can select where in the gradation, each color will begin and end.

Select BrushType_Radial in the ...Type  field for the selected area.
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Required configuration entries include the following.

Fields Description

A ...Color1/...Color2 Two colors are required for a Linear brush type.

B ...Point1X/Point1Y Color1 color position. Coordinates of the gradient center.

C ...Point2X/Point2Y Color2 color position X and Y radii of the gradient ending el

lipse

.NET Control: Select Fonts

Font configuration options are based on the control type.

◦ Fonts: Windows forms-based controls.

◦ Fonts: .NET WPF controls

Fonts: Windows Forms-based Controls

Windows Forms-based controls use the standard Font dialog box to configure font.

5. Open a Properties dialog box for a Windows Forms-based control.

6. Select Control Properties.

7. Click the Font button to the right of the field.
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A Font dialog box opens.

8. Select the font properties: font,  Font style, Size  and Effects.

Note:  Script  does not work for standard WinForm controls.

9. Click OK.
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Result: The selected font displays in the Font field; the text in the control displays the new font 

selections.

Note:

◦ In most instances, you can change the font color in the FontColor  field. Select a solid color 

the same way you select a color for any control feature that enables color selection.

◦ A Windows Forms-based control plain text box does not word wrap. The text that goes 

beyond the width of the box will not display.

Fonts: .NET WPF  Controls

.NET WPF control font configuration is primarily located in the Control Properties list rather than in 

a separate Font dialog box. However, the Font dialog box is still available in order to select a font. 

The new configuration enables you to apply more granulated configuration to the font, both in style 

and color.

10. Open a Properties dialog box for a .NET WPF control.

11. Select Control Properties.

12. Click the Font button to the right a Font Family  field.

A Font dialog box opens.
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13. Select the font that should display.

Note:  Only Font is applied to the control; all other font related properties in the Font dialog box are 

not applied

14. Click OK.

The Font dialog box closes.

15. Select values for other Font properties, including the following.
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Field Description

A Font Size The text display size in the Rich text box. Note:  The size entered in this Font Size 

field is the size that is used, not the size that appears to be selected in the Font 

dialog box.

B FontStretch Expands or contracts the text width, based on the selection. Selections can in

clude, but are not limited to: FontStretch_Condensed FontStretch_Expanded 

FontStretch_ExtraCondensed FontStretch_ExtraExpanded FontStretch_Medium 

FontStretch_Normal FontStretch_SemiCondensed FontStretch_SemiExpanded 

FontStretch_UltraCondensed FontStretch_UltraExpanded

C FontStyle Common styles (if the selected font includes them). Selections can include: 

FontStyle_Italic FontStyle_Normal FontStyle_Oblique

D FontWeight The weight applied to each character. Note:  Results can also depend on the se

lected font configuration capabilities. Selections can include, but are not limit

ed to: FontWeight_Black FontWeight_Bold FontWeight_DemiBold FontWeight_

ExtraBlack FontWeight_ExtraBold FontWeight_ExtraLight FontWeight_Heavy 

FontWeight_Light FontWeight_Medium FontWeight_Normal FontWeight_Regular 

FontWeight_SemiBold FontWeight_Thin FontWeight_UltraBlack FontWeight_Ul

traBold FontWeight_UltraLight

E Foreground Both color and brush types can be applied to .NET WPF control fonts.

.Net Control: Configuration for new .Net components

The following properties enable you to view or hide thebase members or newly added 

members/controls. You can modify the following propertiesas per your requirementin the 

GEIP.Orion.ComponentBuilder.configlocated at <installation_location>\Proficy\Proficy CIMPLICITY\exe:

Property Default Values Values

IncludeBaseMem

bers

<IncludeBaseMembers>false</IncludeBaseMem

bers>

The base members are not in

cluded to object properties in 

CimEdit.

Set to True if you want to include 

base members to object proper

ties in CimEdit.
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Property Default Values Values

IncludeNewMem

bers

<IncludeNewMembers>false</IncludeNewMem

bers>

When you upgrade .Net compo

nents version the, the new mem

bers introduced in the version, will 

not appear in object properties in 

CimEdit.

Set to True if you want to include 

newly introduced members to ob

ject properties in CimEdit.

IncludeNewControls <IncludeNewControls>true</IncludeNewCon

trols>

When you upgrade .Net compo

nents version the, the new con

trols introduced in the version, 

will appear in the .Net Component 

Browser in CimEdit.

Set to False if you do not want 

to include the newly introduced 

controls to the .Net Component 

Browser in CimEdit.

.NET Control: Additional CimEdit Configuration

.NET Control:  Additional CimEdit Configuration

Properties that are available to the .NET controls in their Control Properties lists vary widely. Some .NET 

controls can be completely customized for your system by simply entering and/or selecting values in the 

Control Properties list. More often some additional configuration will be required.

CimEdit provides extensive additional configuration options for the .NET control when more than the data 

types in the control's Properties - Object dialog box>Control Properties  list is required.

CimEdit enables you to:

• Get or set properties of the primitive and complex data types;

• Call methods.

• Handle events.
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Because .NET Component Hosting exposes all of the properties, methods and events of the 

underlying .NET component with appropriate data conversions, the underlying component can be fully 

manipulated with CimEdit scripting.

Examples that Demonstrate Simple to more Complex .NET Control Configuration

• .NET Example: Control Properties/Simple Event and Script  (on page 31)

• .NET Example: Complex Properties and Methods  (on page 37)

• .NET Example: Parameters Not Fully Converted  (on page 46)

.NET Example: Control Properties/Simple Event and Script

Some .NET controls can be almost completely configured, if not completely, using the properties in the 

control's Properties - Object dialog box>Control Properties.

A linear gauge, which is available in the .NET Component Browser, is one of these controls. With Control 

Properties configuration, a Periodic event and simple script, the gauge can display a selected point's 

values.

Note:

The gauge will be configured to report the value of a point PROCESS_VISCOSITY.

Point attributes include the following.

Point At

tributes
Description

Point Type REAL

Decimal places 2

Maximum value 1.10

Minimum value 0.60

Linear Gauge: Place  on the CimEdit Screen.

1. Open the .NET Component browser.

2. Place the LinearGauge on the CimEdit screen, as follows.
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3. Select .NET Components>Sample Components>GaugeControls>LinearGauge.

4. Click OK.

The linear gauge control is placed on the CimEdit screen.

 Resize/move the linear gauge to accommodate 

the display.

Linear Gauge: Apply Basic  Control Properties
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The linear gauge's basic display properties can be selected in the control's Properties - Object dialog 

box>Control Properties list.

1. (Optional) Change the color and/or fonts.

Note:

The linear control also has a BlinkSeconds property that causes a region to blink if the 

value is in its range. BlinkSecond indicates the number of times the region should blink per 

second. Blink = 1 per second or higher. No Blink = 0.

2. Revise some basic values in the control's Properties dialog box>Control Properties list to 

customize the control for the selected point.

Field Description
Exam

ple Value

1 MinReading Lowest reading on the gauge. 0.6

2 MaxReading Highest reading on the gauge. 1.1

3 DecimalPlaces Number of decimal places in the value display. 2

4 MajorTicks Prominent ticks on the gauge.

Note: The value excludes the starting point.

5

5 Range1Color Color for the lowest range on the gauge Yellow

Range1High Highest value for Range1.

Note: The Range1 color ends at this value.

.75

6 MinorTicks Small ticks going from one major tick to the next. 4
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Field Description
Exam

ple Value

7 Range 2Color Color for the middle range Green

Range2High Highest value for Range2.

Note: The Range2 color ends at this value.

1

8 Range3Color Color for the highest range. Red.

9 Title Identifies the linear gauge Viscosity

Result: The linear gauge display is ready to report point values (e.g. PROCESS_VISCOSITY). A simple 

script will pull the data into the gauge; the script will be triggered by an event.

Linear Gauge: Configure an Event  and Simple Script

Although the linear gauge has many properties that can be easily configured in the control properties list, 

an event and script are required to connect a selected point's data to the gauge.

For this control a simple event and script are all that is required:

1. Select Events in the Linear Gauge control's Properties - Object dialog box.

2. Open a new Edit Script window for a Periodic event.
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A Event Select Periodic.

B Time peri

od

500 Ms

Note: Specifies the period between the time the event's procedure ends and the time it is 

re-triggered.

C Action 1. Click the Popup button to the right of the Action field.

2. Select New Script on the Popup menu.

An Edit Script window opens for the control's periodic event:

1. Right-click the mouse under Sub OnTimer().

2. Select ActiveX Properties>Value of>Reading on the extended Popup menu.

CimOleObj.Reading is inserted into the script:

1. Enter an Equals sign ( =) after CimOleObj.Reading.

2. Right-click the Edit Script window after the Equals sign.

3. Select Points>Get on the Popup menu.
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A Get Point dialog box opens:

A Enter a point ID (e.g.PROCESS_VISCOSITY) in the Point Id field.

B Click OK.

The script is now ready to be compiled.

Private cimOleObj As Occ_System_Windows_Forms_DataVisualization.IOccChart

Sub OnTimer()

 cimOleObj.Reading = PointGet("PROCESS_VISCOSITY")

End Sub

Compile the script; close the Edit Script window.

Close the linear gauge's Properties - Object dialog box.

Result: The linear gauge is ready to be tested.
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Linear Gauge: Runtime Test

If the configuration is correct, the Gauge needle position will report the point value, and the Region the 

value is in will blink if blinking is enabled.

.NET Example: Complex Properties and Methods

1. Click the Popup button to the right of the Action field.

2. Select New Script  on the Popup menu.

3. Right-click the Edit Script window in the location where the method should be inserted.

Note:  In this script, the method is entered under the rs.Open line.

4. Select ActiveX Methods>Call  on the extended Popup menu.

An Edit Method dialog box opens.

5. Select and enter the following.
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Field Select/Enter

A Method name DataBindTable.  Note: Select the method from a dropdown list of methods.

B DataSource rs  (Recordset variable name in the script)

C xField String column in the selected table. Example "CustomerID"

D Click OK.

Result. The Edit Method dialog box closes; the line created from your selections and entries is en

tered into the script where you opened the Popup menu.

a. Chart: Test  the Script - Part 1

a. Compile the script; close the Edit Script window.

b. Close the control's Properties - Object dialog box.

c. Click the Test Button on the CimEdit Ribbon bar.

If the configuration is correct .NET Chart displays as a bar chart with data pulled from SQL Server.

Chart: Script - Part 2

Since the Generic ActiveX Wrapper exposes component events defined by an underlying .NET control as 

ActiveX events, they can be handled with CimEdit scripting.

1  (on 

page 

39)

Chart: Add three mouse events.
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2  (on 

page 

42)

Chart: Complete (sample) script: Parts 1 and 2.

3  (on 

page 

43)

Chart: Test the Script - Parts 1 and 2.

1. Chart: Add Three Mouse  Events

Note:

• This configuration that demonstrates rotating the chart using MouseMove  handler logic is simplified 

to emphasize the main points of event handling.

• The mouse event handlers that will be used are converted by the Data Conversion module from the 

corresponding .NET mouse event handlers.

Key event handlers are also converted to the forms similar to their respective Win32 key messages.

1. Re-open the control chart's Properties - Object dialog box.

2. Select Events.

3. Add events and create new scripts as follows.
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1 Add a MouseDown  event. Create a new 

script.

2 Add a MouseMove  event. Create a new script

3 Add a MouseDown  event. Create a new 

script.

The chart's script will now include three additional event handlers.

Sub OnMouseDown(state As Long, x As Long, y As Long)

 

End Sub

 

Sub OnMouseMove(state As Long, x As Long, y As Long)

 

End Sub

 

Sub OnMouseUp(state As Long, x As Long, y As Long)

 

End Sub
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Note:

• The .NET control events have the conventional two-parameter signature,

• Sender (Object)

• e (EventArg)

However, the Data Conversion module has converted these mouse events into those with Win32-style 

parameters.

• The x and y values are the x and y coordinates of the mouse pointer

• The state value is the mouse button state (not used here).

1. Add a mouse down state variable and some simple handling code.

Sub OnMouseDown(state As Long, x As Long, y As Long)

    mouseDown = True

End Sub

Sub OnMouseMove(state As Long, x As Long, y As Long)

    If mouseDown = True Then

        area.Area3DStyle.Inclination = (x Mod 90) / 2

        area.Area3DStyle.Rotation = (y Mod 180) / 2

    End If

End Sub

Sub OnMouseUp(state As Long, x As Long, y As Long)

    mouseDown = False

End Sub

 

Private Sub Chart1_MouseUp(ByVal state As Long, ByVal x As Long, ByVal y As Long)

    mouseDown = False

End Sub

1. Add Private mouseDown As Boolean  to the beginning of the script.

Private cimOleObj As Occ_System_Windows_Forms_DataVisualization.IOccChart

Private area As Object

Private mouseDown As Boolean
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1. Compile the script; close the Edit Script window and Properties - Object dialog box.

1. Chart: Complete (Sample) Script:  Parts 1 and 2

This is the complete (sample) script (Parts 1 and 2) that includes pulling data from SQL server and using 

mouse events to rotate the chart.

Private cimOleObj As Occ_System_Windows_Forms_DataVisualization.IOccChart

Private area As Object

Private mouseDown As Boolean

 

Sub OnScreenOpen()

    Dim conn As Object

    Dim rs As Object

    Dim series As Object

 

    Set area = cimOleObj.ChartAreas.Add("area1")

    area.BackColor = &H8000FF00

    area.Area3DStyle.Enable3D = True

    

    Set conn = CreateObject("ADODB.Connection")

    Set rs = CreateObject("ADODB.Recordset")     

    conn.ConnectionString = "Provider=SQLNCLI10;Data Source=.\sqlexpress;" _

        & "AttachDbFilename=C:\SQLSampleDatabases\NORTHWND.MDF;Integrated Security=SSPI;"

    

    conn.Open

    rs.Open "Select Top 12 CustomerID, Freight from Orders", conn

    cimOleObj.DataBindTable rs, "CustomerID"

    rs.Close    

    conn.Close

    Set series = cimOleObj.Series.Item(0)

    series.ChartType = SeriesChartType_Column

    series.SetCustomProperty "DrawingStyle", "Cylinder"

End Sub

Sub OnMouseDown(state As Long, x As Long, y As Long)

    mouseDown = True

End Sub

Sub OnMouseMove(state As Long, x As Long, y As Long)
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    If mouseDown = True Then

        area.Area3DStyle.Inclination = (x Mod 90) / 2

        area.Area3DStyle.Rotation = (y Mod 180) / 2

    End If

End Sub

Sub OnMouseUp(state As Long, x As Long, y As Long)

    mouseDown = False

End Sub

 

Private Sub Chart1_MouseUp(ByVal state As Long, ByVal x As Long, ByVal y As Long)

    mouseDown = False

End Sub

 

1. Chart: Test  the Script - Parts 1 and 2

The chart should rotate as you hold the mouse button down and move it.

Chart: Script: Part - 3

More sophisticated code than the mouse handling logic used in Sample Script 1 is needed to make the 

graph move more smoothly in rotation and inclination.

1  (on 

page 

44)

Chart: Complete (sample) script: Parts 1 and 3.
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2  (on 

page 

45)

Chart: Test the script - Parts 1 and 3

1. Chart: Complete (Sample) Script: Parts 1 and 3

The following chart graph uses the same event handling script used in Sample Script 1, but selects two 

numeric columns from another table.

Replace the code in Sample Script - Parts 1 and 2 from the conn.Open  line in the OnScreenOpen( ) 

subroutine to the End Sub  with the code that is now in that location.

Private cimOleObj As Occ_System_Windows_Forms_DataVisualization.IOccChart

Private area As Object

Private mouseDown As Boolean

Sub OnScreenOpen()

    Dim conn As Object

    Dim rs As Object

    Dim series As Object

 

    Set area = cimOleObj.ChartAreas.Add("area1")

    area.BackColor = &H8000FF00

    area.Area3DStyle.Enable3D = True

    

    Set conn = CreateObject("ADODB.Connection")

    Set rs = CreateObject("ADODB.Recordset")     

    conn.ConnectionString = "Provider=SQLNCLI10;Data Source=.\sqlexpress;" _

        & "AttachDbFilename=C:\SQLSampleDatabases\NORTHWND.MDF;Integrated Security=SSPI;"

    

    conn.Open

    rs.Open "select Top 50 OrderID, UnitPrice, Quantity from [Order Details]", conn

    cimOleObj.DataBindTable rs, "OrderID"

    rs.Close    

    conn.Close

    Set series = cimOleObj.Series.Item(0)

    series.ChartType = SeriesChartType_Column

    series.SetCustomProperty "DrawingStyle", "Cylinder"

    Set series = cimOleObj.Series.Item(1)
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    series.ChartType = SeriesChartType_Column

    series.SetCustomProperty "DrawingStyle", "Cylinder"

End Sub

Sub OnMouseDown(state As Long, x As Long, y As Long)

    mouseDown = True

End Sub

Sub OnMouseMove(state As Long, x As Long, y As Long)

    If mouseDown = True Then

        area.Area3DStyle.Inclination = (x Mod 90) / 2

        area.Area3DStyle.Rotation = (y Mod 180) / 2

    End If

End Sub

Sub OnMouseUp(state As Long, x As Long, y As Long)

    mouseDown = False

End Sub

 

Private Sub Chart1_MouseUp(ByVal state As Long, ByVal x As Long, ByVal y As Long)

    mouseDown = False

End Sub

1. Chart: Test the Script  - Parts 1 and 3

If the script details have been entered correctly two columns will display. The chart should also rotate 

more smoothly.
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.NET Example: Parameters Not Fully Converted

Because there are endless .NET event argument types, the common and most useful types will be 

converted first for the .NET Component Host; additional .NET argument types will be converted in future 

CIMPLICITY releases.

However, when parameters are not fully converted, the controls can be configured using CimEdit features, 

such as events, scripts and procedures.

A DataGrid  and ComboBox, which are available in the .NET Component Browser, have properties of not 

fully converted data types that have these requirements.

Note:

The DataGrid  and ComboBox  example:

• Will be configured to display logged data in the DataGrid whose category can be selected in the 

ComboBox.

• Uses the Microsoft SQL Server sample database Northwind.mdf/Mothwind.ldf files, which can be 

downloaded from the Microsoft Website.

Important:

Before you work with or apply this example make sure that a Virtual integer point  is available for 

the script.

The sample uses a point named SEL_INDEX.

• Controls: Script - Part 1

• Controls: Script - Part 2

Controls: Script - Part 1

Once a chart is placed on the screen, scripting can be started that will pull data into the control from SQL 

Server.

1  (on 

page 

47)

Controls: Place and resize on the CimEdit 

screen.
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2  (on 

page 

48)

Controls: Create a new script.

3  (on 

page 

50)

Controls: Test the script - Part 1.

1. Controls: Place  and Resize on the CimEdit Screen

DataGrid: Place on the CimEdit screen.

1. Open the .NET Components Browser.

2. Select .NET Components>.NET Framework>Windows Presentation Framework>Presentation 

Framework>DataGrid.

3. Close the .NET Components Browser.

4. Resize the DataGrid.

Note:  Since the DataGrid runtime representation is blank, approximate its size. You can modify the 

size later.

5. Open the DataGrid's Properties - Object dialog box.

6. Select General.

7. Name the DataGrid in the Object name  field (e.g. Data Grid1).

8. Close the Properties - Object dialog box.

ComboBox: Place and Resize on the CimEdit screen.

9. Open the .NET Components Browser.

10. Select .NET Components>.NET Framework>Windows Presentation Framework>Presentation 

Framework>ComboBox.

11. Close the .NET Components Browser.

12. Resize the ComboBox.

Since the ComboBox runtime representation displays a drop list arrow aiding you to approximate 

its size. You can modify the size later.

13. Open the ComboBox's Properties - Object dialog box.

14. Select General.

15. Name the ComboBox in the Object name  field (e.g. Combo Box1).

16. Close the Properties - Object dialog box.
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The controls

Note:

Colors  (on page 21)  and fonts  (on page 25)  that are different from the default colors 

and fonts can be selected at anytime in the control's Properties - Object dialog box>Control 

Properties  list.

Solid colors can be selected for the DataGrid rows.

Example

The following colors are selected for the DataGrid rows.

Row RGB Color

AlternatingRowBackground_Col

or1

218,227,188

RowBackground_Color1 250,192,143

The DataGrid rows will alternate these colors during runtime.

a. Controls: Create  a New Script

Scripts that will populate the DataGrid and ComboBox are based on a Screen Open  event.

◦ DataGrid: Create a Script  - Part 1

◦ ComboBox: Create a Script - Part 1

DataGrid:  Create a Script - Part 1
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a. Add a Screen Open  event to the DataGrid control.

b. Create a new script.

c. Add the following code to the script.

Important:  Change the information, if necessary, to match your database specifications.

Private cimOleObj As Occ_PresentationFramework.IOccDataGrid

Sub OnScreenOpen()

    Dim conn As Object

    Dim rs As Object

    

    Set conn = CreateObject("ADODB.Connection")

    Set rs = CreateObject("ADODB.Recordset")   

    conn.ConnectionString = "Provider=SQLNCLI10;Data Source=.\sqlexpress;" _

        & "AttachDbFilename=C:\SQLSampleDatabases\NORTHWND.MDF;Integrated Security=SSPI;"

    

    conn.Open    

    rs.Open "Select Top 20 * from Orders", conn

    Set cimOleObj.ItemsSource = rs

    

    rs.Close

    conn.Close

End Sub

a. Compile the script; close the Edit Script window.

b. Close the DataGrid's Properties - Object dialog box.

ComboBox: Create a Script - Part 1

a. Add a Screen Open  event to the ComboBox control

b. Create a new script.

c. Add the following code to the script.

Important:  Change the information, if necessary, to match your database specifications.

Private cimOleObj As Occ_PresentationFramework.IOccComboBox

Sub OnScreenOpen()

    Dim conn As Object

    Dim rs As Object
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    Set conn = CreateObject("ADODB.Connection")

    Set rs = CreateObject("ADODB.Recordset")   

    conn.ConnectionString = "Provider=SQLNCLI10;Data Source=.\sqlexpress;" _

        & "AttachDbFilename=C:\SQLSampleDatabases\NORTHWND.MDF;Integrated Security=SSPI;"

    

    conn.Open    

    rs.Open "Select Top 20 * from Orders", conn

    

    Do While Not rs.EOF

        cimOleObj.Items.Add CStr(rs("CustomerID"))

        rs.MoveNext

    Loop

    cimOleObj.SelectedIndex = 0

    

    rs.Close

    conn.Close

End Sub

a. Compile the script; close the Edit Script window.

b. Close the ComboBox's Properties - Object dialog box.

a. Controls: Test  the Script - Part 1

The controls should now display data from the selected database (e.g. Northwind).
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A user can:

A Scroll up and down the DataGrid to review data.

B Select different items on the ComboBox drop down 

list.

There is currently no connection between the DataGrid and the ComboBox.

Controls: Script - Part 2

When two additional scripts are applied to a procedure, they will connect the two .NET controls and 

cause the ComboBox selection to drive the DataGrid display.

1  (on 

page 

52)

Controls: Add subroutines- Part 2

2  (on 

page 

52)

Controls: Create a procedure to invoke the 

scripts.

3  (on 

page 

54)

Controls: Test scripts and procedures.
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a. Controls: Add Subroutines  - Part 2

The .NET controls subroutines get and set the Virtual point that you created or selected for use 

before placing the controls on the CimEdit screen.

ComboBox: Add a Subroutine

A ComboBox subroutine sets the point (e.g. SEL_INDEX).

This is the companion to the DataGrid subroutine that will get the point.

Sub GetSelection()

PointSet "SEL_INDEX", cimOleObj.SelectedIndex

End Sub

DataGrid: Add a Subroutine

A DataGrid subroutine gets the point (e.g. SEL_INDEX).

This is the companion to the ComboBox subroutine that will set the point.

Sub SetSelection()

cimOleObj.SelectedIndex = PointGet("SEL_INDEX")

End Sub

a. Controls: Create a Procedure  to Invoke the Scripts

Note:

Because the two parameters are of the COM Variant type, it's not as straightforward to use a 

handler routine as, for example, Mouse  events.

However, because both the DataGrid and ComboBox each have the SelectionIndex  property, the 

selection in the ComboBox drop down list can be determined and the corresponding row selection 

of the DataGrid component can be set by accessing their SelectionIndex  properties.

A straightforward way to configure the parameters is through an ActiveX Event>SelectionChanged 

event and a procedure that uses InvokeScript  actions.

◦ ComboBox: Configure SetChangedProc

◦ DataGrid: Configure SetChangedProc
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ComboBox: Configure SetChangedProc

a. Open the ComboBox Properties - Object dialog box.

b. Select Events.

c. Create an ActiveX Event>SelectionChanged  event.

d. Create a new procedure for the event.

The procedure Includes two Invoke script  actions.

1 Proce

dure 

name

Name to clearly identify the procedure. Example SetChangedProc

2 Action 

type 1

Invoke script

3 Object 

name1

Select the name that was entered in the ComboBox's Properties - Object dialog 

box>General>Object name  field. Example Combo Box1

4 Method1 GetSelection

2 Action 

type 2

Invoke script
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3 Object 

name2

Select the name that was entered in the DataGrid's Properties - Object dialog 

box>General>Object name  field Example DataGrid1

4 Method SetSelection

a. Click Apply; close the ComboBox control's Properties - Object dialog box.

DataGrid: Configure SetChangedProc

Configure the same ActiveX Event>Selection Changed event with the same SetChangedProc in the 

DataGrid control's Properties - Object dialog box.

a. Controls: Test Scripts and Procedures  -

If the scripts and configuration are completed correctly the DataGrid control now automatically 

highlights the data row based on the selection made in the ComboBox control.

.NET Control: Technical Reference

.NET Control: Technical Reference

• .NET Components: General information.

• .NET Control: Create new components.

• .NET Component Browser: Modifications.

• .NET Components: On other CIMPLICITY systems.
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• .NET Files: Location.

• .NET Data: Conversion rules.

• .NET Error: Logging.

• .NET: Glossary.

.NET Components: General Information

• Component supporting files.

• Unique NET Control Assembly names.

• Supported .NET Control types.

• Remote use: Webspace.

Component  Supporting Files

Component supporting files are automatically created  (on page 65)  from the original .NET source 

assembly (e.g. ChartControls.dll).

Assemblies referenced by the source assembly and not installed in the assembly cache must be put in the 

same folder.

The component creation process creates the following essential files for a .NET source assembly to 

support hosting and communicating with all the components created from the selected controls in the 

source assembly:

File Description

<Occ><ordinal number>_<source assembly name>.dll: Component assembly

<Occ><the same ordinal number>_<source assembly 

name>.tlb

Component type li

brary

Note:

• Occ  is short for Orion COM Component (Orion is the original name of Component Client.).

• Do not manually delete the essential supporting files.

• Some temporary or debugging files may be created; they are not essential for the components to 

function.

• If the same source assembly is selected to the Add Components process the second time, the 

ordinal number will increase.
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Unique NET Control Assembly  Names

A control assembly  (on page 63)  name (e.g. ChartControls) must be unique among all .NET control 

assemblies that are used to build CIMPLICITY containable components.

If a name is not unique unexpected results may happen as the .NET runtime will use the first loaded 

control assembly for all same named assemblies.

Note:

• .NET has provisions to support loading assemblies with the same name but different versions.

However, that requires the versioned assemblies be signed and installed into the system assembly cache; 

this scenario is not appropriate to the current case and thus is not supported.

• The full name (namespace and class name) of any .NET control must be unique.

Supported .NET Control  Types

Component Hosting Release 1.0 supports following two .NET control types.

These types basically cover all .NET controls used for non-web-based applications.

Specifically, custom or third-party controls that are derived from the following .NET Framework 4.0 

classes can be hosted:

WPF • System.Windows.UIElement

• System.Windows.FrameworkElement

• Any of the over 100 control classes in the System.Windows.Controls name

space

Win

Forms

• System.Windows.Forms.Control

• Any of the over 60 control classes in the System.Windows.Forms namespace.

Note:

All custom controls must define a parameter-less constructor or no constructors at all (so the 

compiler will add a parameter-less one) in order for them to be created in an environment that no 

parameters may be passed to. This is the same requirement for all ActiveX controls working with 

a COM client and all .NET controls used by a user-interface configurable .NET environment.
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Remote Use: Webspace

If  you are working remotely with CimView screens that include .NET components, use Webspace to 

insure that the components, which are ActiveX controls display and perform correctly.

.NET Control: Create new Components

The Generic ActiveX Wrapper and other modules in the CimEdit .NET feature support hosting and 

interfacing with any WPF and WinForms controls, As a result, you can use third-party controls or create 

your own controls based on any .NET Framework WPF or WinForms control types.

Note:

If you are using a third party control this procedure can be omitted.

1. Create a folder in the..\<CIMPLICITY Installation>\exe\DotNet Components directory.

Example

..\Proficy\Proficy CIMPLICITY\exe\DotNet Components\My Samples

2. Do the following.

a. Use a text editor (e.g. Notepad) to write following code as a C#  source file.

b. Name the file TrendChart.cs.

c. Save the file in your My Samples folder.

using System;

using System.Drawing;

using System.Windows.Forms.DataVisualization.Charting;

namespace ChartControls

{

    public class TrendChart : Chart

    {

        private double _value;

        private ChartArea _area;

        private Series _series;

        private Title _title;

        public TrendChart()

        {

            BackColor = Color.Silver;
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            BorderSkin.SkinStyle = BorderSkinStyle.FrameThin5;

            _title = Titles.Add("Trend Chart");

            _title.Font = new Font("Arial", 10, FontStyle.Bold);

            _area = ChartAreas.Add("area0");

            _area.AxisX.LabelStyle.Format = "hh:mm:ss";

            _area.AxisX.LabelStyle.Interval = 5;

            _area.AxisX.LabelStyle.IntervalType = DateTimeIntervalType.Seconds;

            _area.AxisX.MajorGrid.Interval = 5;

            _area.AxisX.MajorGrid.IntervalType = DateTimeIntervalType.Seconds;

            _area.BackColor = Color.Orange;

            _area.BackGradientStyle = GradientStyle.TopBottom;

            _series = Series.Add("series0");

            _series.ChartType = SeriesChartType.Line;

            _series.ShadowOffset = 1;

        }

        public string Title

        {

            get { return _title.Text; }

            set { _title.Text = value; }

        }

        public double Value

        {

            get { return _value; }

            set

            {

                _value = value;

                DateTime current = DateTime.Now;

                _series.Points.AddXY(current.ToOADate(), _value);

                double removeBefore = current.AddSeconds(-25).ToOADate();

                while (_series.Points[0].XValue < removeBefore)

                    _series.Points.RemoveAt(0);

                _area.AxisX.Minimum = _series.Points[0].XValue;

                _area.AxisX.Maximum

                    = DateTime.FromOADate(_series.Points[0].XValue).AddSeconds(30).ToOADate();

            }

        }
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    }

}

Note:

The TrendChart class is derived from the Framework 4.0 Chart class.

3. In the constructor, a ChartArea  and a Series  are added to the chart control,

4. The control is then configured by setting some ChartArea  and Series  properties.

5. Two properties are defined:

Title Sets a chart title

Val

ue

Binds to a data source

6. When the data value changes, the set action of the Value  property adds a new data point to the 

chart.

7. When the number of data points excesses a preset limit, the oldest points are removed.

8. Open a Command Prompt window.

9. Change the directory to the path to your new DotNet component folder.

Example

C:\Program Files (x86)\Proficy\Proficy CIMPLICITY\exe\DotNet Components\My Samples

10. Enter the following command.

C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319\csc /t:library /out:ChartControls.dll /r:Sys

tem.dll;System.Windows.Forms.dll;System.Windows.Forms.DataVisualization.dll TrendChart.cs

A ChartControls.dll is now included in your DotNet components folder.
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Note:  This TrendChart control can also be built with Visual Studio 11.0. A project for this is included in the 

folder

..\<CIMPLICITY Install>\exe\DotNet Components\Sample Components\VS2010SampleProjects.

Important:

Make sure that the .dll files you use to add  new components are unblocked.

1. Right-click the file in Windows Explorer.

The Properties dialog box opens.

1. Select the General tab.

2. Click Unblock.



Addons and Options  | 1 - .NET Component Hosting  | 61

.NET Component Browser: Modifications

The .NET Component Browser can be modified to accommodate your system's .NET requirements.

• Add a group.

• Add components to a group.

• Delete nodes.

• Delete .NET Components.

Add a Group

1. Open the .NET Component Browser.

2. Do the following.



Addons and Options  | 1 - .NET Component Hosting  | 62

A Select the folder that will include the new group.

B Click Add Group.

3. Enter the following.

Group 

Name

Name that will clearly identify the group of .NET controls that will be added.

De

scrip

tion

(Optional) Additional information to help users know what controls are in the group. 

Note:  The description will display as the tooltip of the group name.

4. Click OK.

Result: A group folder is added to the .NET Component Browser at the level in which it was 

inserted.
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Add Components  to a Group

5. Open the .NET Component Browser.

6. Do the following.

A Select the folder that will include the added component.

B Click Add Components.

An Add .NET Components dialog box opens.

7. Do the following.



Addons and Options  | 1 - .NET Component Hosting  | 64

A Select a Compo

nent Source

a. Click the Browse button to the right of the field to open the folder 

that contains the appropriate Control file.

b. Select the ChartControls.dll file in the selected folder.

Example C:\Program Files (x86)\Proficy\Proficy CIMPLICITY\exe\DotNet 

Components\My Samples\ChartControls.dll

B Component As

sembly Name

The assembly name, which is the name of the selected .dll, will be entered 

automatically.

C Select Compo

nents to Add

Check the components, located in the selected assembly, which will be 

added to the .NET Components Browser.

D Click OK.

The .NET Components Browser now lists the selected components in the selected folder.
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Result: Two additional files  (on page 55)  are added to the new directory.

A Occ.ChartControls.dll Component assembly

B Occ.ChartControls.tlb Component type li

brary

.NET Controls with Non-System References

This example (depends on) only system assemblies (as listed for the /r  command option.

They are:

◦ System.dll

◦ System.Windows.Forms.dll

◦ System.Windows.Forms.DataVisualization.dll.
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Third-party controls, however, usually reference their own supporting assemblies. When a control 

assembly is compiled, the compiler copies all non-system reference assemblies to the output 

folder.

The control assembly and its supporting reference assemblies should be copied to a specific 

folder under the ..\<CIMPLICITY Installation>\exe\DotNet Components folder. However, some third-

party common assemblies may need to be installed into the system assembly cache or be copied 

to the ..\<CIMPLICITY Installation>\exe folder.

Delete  Nodes

You can delete a group or an assembly node from the .NET Component Browser.

Do the following.

A Select the node to delete.

B Click Delete Node.

guide:

Delete Node Guidelines

The Delete feature can help to keep the browser clean and well organized. However, be very 

cautious when deleting components such as the ChartControls  node. A CIMPLICITY screen will fail 

to load if it contains any control objects created from the components of the deleted assembly.

The deletion action includes the following safeguards.
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◦ Custom nodes that are deleted can be recovered by adding their assemblies (Add 

Components  (on page 63)).

◦ If any node under .NET Framework is deleted, the .NET Component feature will have to be 

reinstalled to recover the deleted node.

◦ The root Group node (.NET Components) cannot be deleted;

◦ A Group node cannot be deleted if it contains child nodes.

◦ An Assembly node cannot be deleted if any opened CIMPLICITY screens contain control 

objects created from its components.

◦ An assembly node added in the current session cannot be deleted.

Note:  The generated supporting assembly is loaded when performing an Add Components action; 

it cannot be deleted unless it is unloaded at the session's end. If you are certain that the assembly 

entry  should no longer be available it can be deleted by closing and reopening CimEdit.

Problems with deletion arise if a closed picture that contains components from the deleted 

assembly is then opened, because CimEdit cannot check references in closed screens. This is the 

same behavior as that of CIMPLICITY ActiveX controls in case that they are unregistered.

Delete .NET Components

Deleting a component entry is a serious action and is a rarely used feature.

However, if it is necessary to delete a .NET component,

8. Click the Browse button to the right of the field to open the folder that contains the appropriate 

Control file.

9. Select the ChartControls.dll file in the selected folder.

ExampleC:\Program Files (x86)\Proficy\Proficy CIMPLICITY\exe\DotNet Components\My Samples

\ChartControls.dll

10. All of the .NET component's children (e.g. groups, assembly nodes, etc.) must be deleted first.

11. CimEdit must be closed and re-opened.

.NET Components: On other CIMPLICITY Systems

• Component files copied to other systems.

• Components added to the component browser of another CIMPLICITY system.

Component Files Copied  to Other Systems
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If new components are created and inserted into CIMPLICITY screens on one CIMPLICITY system, and 

the saved screens are opened on another CIMPLICITY system, the screens will not load with the new 

components if they do not exist on the new system. This is the same situation as ActiveX controls if they 

are not installed (copied and registered) on a new target system.

There is no need to register the new components: neither the component assembly nor the component 

type library files.

Copy the same directory hierarchy relative to the ..\<CIMPLICITY Installation>/exe folder to other systems 

in the same hierarchy.

Example

If the ChartControls.dll, Occ.ChartControls.dll and Occ.ChartControls.tlb files are copied to the ..

\ <CIMPLICITY Installation>\exe\DotNet Components\My Sample Components folder of another 

CIMPLICITY system, the TrendChart objects configured on the original system will then load and function 

on the new system.

Any custom or third-party supporting assemblies in the <CIMPLICITY Install>\exe folder must also be 

copied to the <CIMPLICITY Install>\exe folder of other systems.

Components Added  to the Component Browser of another CIMPLICITY System

A suitable entry needs to be on the Component Browser's tree view to insert objects of a new component 

into a CIMPLICITY screen on another system,

Options include the following.

Keep all the created components synchronized across all systems.

1. Keep the folder hierarchy and file contents synchronized from < CIMPLICITY Installation>\exe

\DotNet Components (inclusive) on all systems using a main copy.

2. Overwrite the Component Browser content files: <CIMPLICITY Installation>\exe

\GEIP.Orion.Components.dat on all systems using a main copy.

Add Entries to the .NET Component Browser

Browsing entries for a group of new components may be easily added to the .NET Component 

Browser, especially if different complexity and usefulness levels are desired across the involved 

systems.

Example
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A Trend .NET control will be made available to other browser.

3. Open the .NET Component Browser.

4. Add a new group (e.g. My Sample Components).

5. Do the following.

A Select the new folder (.e.g. My Sample Components).

B Click Add Components.

An Add .NET Components dialog box opens.

6. Do the following.
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A Select a 

Component 

Source

a. Click the Browse button to the right of the field to open the folder that 

contains the appropriate Control file.

b. Select the Occ.ChartControls.dll  file in the selected folder.

Important:

Do not select chartControls.dll.

Example C:\Program Files (x86)\Proficy\Proficy CIMPLICITY\exe\DotNet Com

ponents\My Samples\Occ.ChartControls.dll.

B Component 

Assembly 

Name

The assembly name, which is the name of the selected .dll, will be entered auto

matically.

C Select Com

ponents to 

Add

Check the components, located in the selected assembly that will be added to 

the .NET Components Browser. Note; The class name is ChartControls.Occ

.TrendChart.

D Click OK.

7. Click the Browse button to the right of the field to open the folder that contains the appropriate 

Control file.

8. Select the Occ.ChartControls.dll  file in the selected folder.

Important:

Do not select chartControls.dll.

ExampleC:\Program Files (x86)\Proficy\Proficy CIMPLICITY\exe\DotNet Components\My Samples

\Occ.ChartControls.dll.

.NET Files: Location

All .NET components must be located in the following directory (or subfolders in the following directory).

..\<CIMPLICITY Installation>\exe\DotNet Components
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Important:

• All original .NET control assemblies must be stored under the root component directory.

• Network shared folders for component storage are not supported due to .NET security 

implementations

Default subfolders and files include the following.

Folder/File Description

A Sample Components CimEdit sample controls.

B WinForms Windows-Forms-based con

trols

C WPF .NET WPF controls

D  (on 

page 

77)

ComponentsLogger.log Error logging file.

E DefaultGEIP.Orion.Components

.dat

F GEIP.Orion.Components.dat
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.NET Data: Conversion Rules

• Properties and methods.

• Events.

• Complex data types.

• Strategies for parameter types that cannot be converted.

Properties  and Methods

If a custom or third-party .NET control is one of the supported .NET control types, any public property or 

method defined in the control class will be exposed if the data type of the property or the type of each 

parameter of the method is one of the following types:

Type Description

Primitive Including integral and floating numeric

COM recognizable Including:

• String

• DateTime

• System.Drawing.Color (WinForms Color)

COM visible Such as:

• System.Collections.ArrayList

• System.Collections.IList

• System.Object

NET generic list • List<short>

• List<int>

• List<float>

• List<double>

• List<string>

• (All of the System.Collections.Generic namespace).

DataTable and DataView class

es

• (All of the System.Data namespace)

• System.Windows.Media.Brush class

• System.Collections.IEnamerable interface

• System.Windows.Control.ItemCollection class.
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Type Description

Windows Forms Font • System.Drawing.Font

• WPF FontFamily (System.Windows.Media.FontFamily) class

es

• FontStretch

• FontStyle

• FontWeight structures

• (All of the System.Windows namespace).

Note:

• The property or method in the exposed COM interface will have the corresponding COM types 

converted from the original .NET types.

• If a property or method does not meet the above condition, it will be ignored in the component 

building process and will not be available in the component COM interface.

Events

All the public events defined in the control class are exposed as COM connection point handlers, 

according to the following rules:

1. If all the parameter types of a .NET event delegate are convertible according to the conditions 

listed in the Properties and Methods section, the .NET event delegate will be converted to a COM 

event handler with the same number of parameters of the corresponding COM types.

2. Some common .NET delegate types are converted to specifically defined COM event handlers.

These include the:

◦ Mouse events.

◦ WPF MouseEventHandler

◦ MouseButtonEventHandler

◦ MouseWheelEventHandler

◦ WinForms MouseEventHandler delegates

◦ Key events

◦ WPF KeyEventHandler

◦ KeyboardEventHandler

◦ WinForms KeyEventHandler

◦ KeyPressEventHandler delegates
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◦ Selection events

◦ SelectionChangedEventHandler

◦ EventHandler<SelectionChangedEventArgs> delegates.

3. The converted COM mouse event handlers are defined to have three parameters:

◦ Mouse button state.

◦ X and Y positions

Refer to the Win32 documents for the definitions of the mouse button state.

4. The COM key event handlers are defined to have two parameters

◦ Key state

◦ Key code

Refer to the Win32 documents for the definitions of the key state.

5. The converted COM selection event handler has two parameters of the COM Variant type with an 

array subtype:

◦ AddedItems, for items newly added to the selected items collection.

◦ RemovedItems, for items newly removed from the selected items collection.

Note:  To avoid array indexing problems (the items arrays might be empty), check with the VBA 

function UBound.

6. All other delegates that follow the .NET convention (two parameters: sender of the Object type and 

e of an EventArgs derived type) are converted to a COM handler of two parameters of the String 

type.

Complex  Data Types

The data conversion module supports passing complex data types such as arrays (lists) and 

data tables. The supported .NET types are exposed as common COM types or specific interfaces 

and types implemented by the conversion module. The supported COM types may be passed 

to or returned from the methods and properties of .NET controls, to which, as a result of data 

conversion, these data types appear as the corresponding .NET types.

◦ DataTable, DataView  (both of System.Data) and IEnumerable  (of System.Collection).

◦ These types appear as ADODB Recordset  and are used to pass data tables with columns and 

rows.

IEnumerable  is converted to Recordset because many .NET controls use the IEnumerable interface 

to pass DataTable objects.
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◦ Add the Microsoft ActiveX Data Objects Library (2.7 or higher) reference when scripting with 

these date types.

Refer to ADODB documents for the usage of the Recordset interface.

◦ List<short>, List<int>, List<float>, List<double>, and List<string>  (all of 

System.Collections.Generic).

These types, implemented in the data conversion module, appear as:

◦ ShortList

◦ IntList

◦ FloatList

◦ DoubleList

◦ StringList

Add the GEIP_Orion_Dataconversion  reference when scripting with these date types.

The ShortList list implements the following interface:

interface IShortList : IDispatch

{

    [id(0x60020000), propget]

    HRESULT Count([out, retval] long* pRetVal);

    [id(0x60020001)]

    HRESULT Add([in] short item);

    [id(0x60020002)]

    HRESULT Clear();

    [id(00000000), propget]

    HRESULT item(

                    [in] long index,

                    [out, retval] short* pRetVal);

    [id(00000000), propput]

    HRESULT item(

                    [in] long index,

                    [in] short pRetVal);

    [id(0x60020005)]

    HRESULT Insert(

                    [in] long index,

                    [in] short item);
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    [id(0x60020006)]

    HRESULT RemoveAt([in] long index);

};

All the rest implement basically the same interface, but with different data types (long  for IntList, 

etc.) for the item parameter.

◦ ArrayList  (of System.Collections).

This displays as ObjectList, which implements the following interface:

interface IObjectList : IDispatch

{

    [id(0x60020000), propget]

    HRESULT Count([out, retval] long* pRetVal);

    [id(0x60020001)]

    HRESULT Add(

                    [in] VARIANT item,

                    [out, retval] long* pRetVal);

    [id(0x60020002)]

    HRESULT Clear();

    [id(00000000), propget]

    HRESULT item(

                    [in] long index,

                    [out, retval] VARIANT* pRetVal);

    [id(00000000), propputref]

    HRESULT item(

                    [in] long index,

                    [in] VARIANT pRetVal);

    [id(0x60020005)]

    HRESULT Insert(

                    [in] long index,

                    [in] VARIANT item);

    [id(0x60020006)]

    HRESULT RemoveAt([in] long index);

};

As the item type here is VARIANT, this list can pass any convertible types supported by the data 

conversion module.
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For example, list objects can be added to an ObjectList  as list items, resulting a multi- dimensional 

array.

Add the GEIP_Orion_Dataconversion  reference when scripting with this date type.

Strategies for Parameter  Types that Cannot Be Converted

Most commonly used parameter types are converted, so CIMPLICITY screens host and also 

communicate with the .NET controls through primitive data types and converted parameter types.

 However, there will be parameter types that cannot be converted and thus ignored by the current 

release because the authors of custom .NET controls may use any Framework types and create 

and use their own types.

In order to avoid the essential properties, methods and events of a .NET control not being exposed, 

the control author may do the following.

◦ Rewrite a desired property using the convertible types listed above.

◦ Separate a desired property into multiple properties of the convertible type.

◦ Rewrite a method with the convertible types or with more parameters so that each 

parameter can be converted.

◦ Define a new event type (delegate) with all parameters convertible and reroute the original 

event with the new delegate.

.NET Error: Logging

The error logging module is designed to log information and error messages to a file, so that error causes 

may be analyzed for rather complicated processes, such as the process to build a component that can be 

hosted with the CIMPLICITY environment.

The logging process is controlled by a logging configuration file named 

GEIP.Orion.ComponentsLogger.config in the ..\<CIMPLICITY Installation>\exe folder.

GEIP.Orion.ComponentsLogger.config has the following typical content:

<?xml version="1.0" encoding="utf-8" ?>

<log4net debug="true">

  <appender name="RollingLogFileAppender" type="log4net.Appender.RollingFileAppender">

    <file value=".\\DotNet Components\\ComponentsLogger.log" />

    <appendToFile value="true" />

    <rollingStyle value="Size" />
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    <maxSizeRollBackups value="10" />

    <maximumFileSize value="10MB" />

    <staticLogFileName value="true" />

    <layout type="log4net.Layout.PatternLayout">

      <conversionPattern value="%d [%t] %-5p %logger %method%n%m%n" />

    </layout>

  </appender>

  <root>

    <level value="WARN" />

    <appender-ref ref="RollingLogFileAppender" />

  </root>

</log4net>

• Items may be easily changed are the:

• Logging file path.

• Logging level.

• The content above sets the path to ..\<CIMPLICITY Installation>\exe\DotNet Components

\ComponentsLogger.log.

• Levels include:

• DEBUG Logs everything

• INFO

• WARN

• ERROR

• FATAL

Log successively fewer mes

sages

Refer to the log4net document for more details.

• The logging actions are mostly performed at the configuration mode and have no significant 

performance panelties even if the logging level is set to DEBUG.

.NET: Glossary

.NET terms include the following.

Term Definition

Ac

tiveX

ActiveX is a framework for defining reusable software components in a programming language 

independent way. This technology is often used to develop user interface controls, and the con
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Term Definition

trols so developed are therefore called ActiveX controls, or OLE controls after the older terminol

ogy.

CCW COM Callable Wrapper is a proxy that enables you to use .NET code from a COM client.

CLR Common Language Runtime "brings to the table" cross-language integration, security and ver

sioning support, and garbage collection  (MSDN)

COM The Microsoft Component Object Model is a binary interface standard to allow for reuse of ob

jects with no knowledge of their internal implementation in environments different from the one 

they were created in.

Man

aged 

Code

Code that operates within the .NET CLR.

.NET The Microsoft .NET Framework is a software framework that includes a large library of coded 

solutions to common programming problems and a virtual machine that manages the execution 

of programs written specifically for the framework.

.NET 

com

po

nent

A component is a special type of executable built from a .NET project. typically referenced by 

applications needing the services provided by the component. (MSDN)

Un

man

aged 

Code

Code that operates outside the .NET CLR. All COM code is unmanaged code.

Win32 The 32-bit Windows of Application Programming Interfaces. This is Microsoft's core set of APIs 

available in the Microsoft Windows operating systems.

Win

dows 

Forms

Windows Forms, or shortly WinForms, is the graphical API included as a part of the Mi

crosoft .NET Framework, providing access to native Windows interface elements and controls. 

The .NET Framework 4 now includes sophisticated charting features that are based on Win

dows Forms.

WPF The Windows Presentation Foundation is a graphical subsystem for rendering user interfaces 

in Windows-based applications. WPF, initially released as part of .NET Framework 3.0, provides 

a consistent programming model for building applications with a clear separation between the 

user interface and the business logic.



Chapter 2. Change Management

About Change Management

• About Change Management overview.

• Change Management topics.

• CIMPLICITY options not supported in Change Management.

About Change Management Overview

Beginning with CIMPLICITY 7.0, several versions of configuration and files that apply to a single 

CIMPLICITY projector computer level configuration can be stored and retrieved on a Change Management 

 (PCM) server.

• More than one local server can hold copies of the same CIMPLICITY project and maintain the 

project's integrity through the PCM.

• Each local server can store versions of the computer-based files.

1 Local Server 1 holds the following projects: C1, M2, P1.

2 Local Server 2 holds the following projects: P1, M2, C2.

3 Change Management Server holds several versions of the following: C1, M2, P1, C2.
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Change Management Topics

• Entities Overview in Change Management.

• Enable computer management.

• Enable project management.

• Change Management procedures.

• Change Management client.

• Change Management best practices.

• Change Management technical reference.

CIMPLICITY Options not Supported  in Change Management

The following are not supported in Change Management.

• Microsoft Cluster.

• Tracker.

• Order Execution Management.

Entities Overview in Change Management

Entities Overview in Change Management

There are two types of Change Management projects.

• CIMPLICITY project.

• Computer project.

There are two classes of entities that can be added to Change Management for each project type.

Entity Class Description

Base Configuration A collection of interrelated files that must remain interrelated and, thus, must be 

managed as a single unit.

Individually man

aged files

Files that can be managed as individual units.
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Field Description

CIMPLICITY Project

Project All user configurable configuration files in the CIMPLICITY project can be added to Change 

Management. Project configuration includes:

• Base configuration.

• Individually managed files.

Base 

Con

figura

tion

Files that make up the project's basic configuration, e.g. points, alarms, configuration files, are 

required for the project processes to run. Note:  The processes start when the project starts. 

Base configuration files:

• Are automatically added to Change Management the next time the base configuration 

(or project) is checked in.

• Are checked in whenever any base configuration entity is selected to be checked in.

Important:

Base configuration must be added once to be managed.
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Field Description

Indi

vid

ually 

man

aged 

files

Single files that are listed in the CIMPLICITY  project’s Managed files folder can be added sep

arately to Change Management. These files, e.g. CimView screens and scripts,  are individually 

controlled. Individually managed  files:

• Are added to Change Management when the project is added.

Note:  The project can be added more than once: each time it is added any individually man

aged files that have not already been added will be added to Change Management.

• Can be added individually.

• Must be added in order to be managed; they are not automatically added when the 

project is checked in.

Example

Computer Project

Com

puter

All files in the computer project can be added to Changed Management. Computer files include:

• Computer base configuration.

• Managed files.

Base 

Con

figura

tion

Files included in the system's basic configuration, e.g. globals.ini, cimhosts.txt. These files are 

required for the Computer project system's processes to run.

Man

aged 

files

Single files that are listed in the Computer project’s Managed files folder can be added sepa

rately to Change Management. These files are individually controlled and are not required for 

the Computer project's processes to run. These files, e.g.  CimView screens and scripts, are in

dividually controlled. Individually managed  files:

• Are added to Change Management when the project is added.
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Field Description

Note:  The project can be added more than once; each time it is added any individually managed 

files that have not already been added will be added to Change Management.

• Can be added individually.

• Must be added in order to be managed; they are not automatically added when the 

project is checked in.

Example 

CIMPLICITY Project in the Workbench: Managed Files Overview

When a CIMPLICITY project is managed, the Workbench entities can be added, checked in or checked out 

as part of the base configuration or as individually managed files.

The following table identifies the category  (on page 86)  when an icon is right-clicked in the Workbench 

left pane.

Icon Base Individual NM

Screens Screens X

Objects Objects X

Classes Classes X

Points Points X

Attribute Sets X

Point Enumerations X

Cross Reference X

Alarms Alarms X

Alarm Classes X

Alarm Strings X
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Icon Base Individual NM

Alarm Printer X

Alarm OPC Client X

Alarm Blocking X

Alarm Translator X

Alarm Paging X

Basic Control En

gine

Event Editor X

Scripts X

BCE User Interface X

Equipment Devices

Ports

Diagnostics X

Marquee X

Security Users X

Roles X

Resources X

Advanced X

Status Log X

Advanced Project Parameters X

Measurement Units X

Process Health Parameters X

Managed Files Managed Files X

Recipes Recipe Files X

Database Logger Database Logger configura

tion

X

Archive X
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Icon Base Individual NM

SPC SPC files X

Document Delivery Base X

Object X

Action Calendar X

Table headings  are:

Base Base configuration.

Individual Files in the selected node's right pane are individually managed

NM Not managed.

• Other files, e.g. Class export files, *.soc, are not listed in the Workbench so they are not included in 

this table.

• View a complete list of individually project managed files.

• Files that are individually managed in your system configuration are listed (and available)  in the 

project's Managed Files folder  (on page 83).

Computer Project in the Workbench: Managed Files Overview

When a Computer project is managed, the Workbench entities can be added, checked in or checked out 

as part of the base configuration or as individually managed files, as follows.

The following table identifies the category  (on page 87)  when an icon is right-clicked in the Workbench 

left pane.

Entity Base Individual NM

System Log X

Computer Parameters Computer Parameters X

Managed Files Managed Files X

System Sentry System Sentry X

Options Options X



Addons and Options  | 2 - Change Management  | 87

Entity Base Individual NM

DGR X

(ME) Change Management X

FirstPAGE Administrator FirstPAGE Administra

tor

X

Table headings  are:

Base Base configuration.

Individual Files in the selected node's right pane are individually managed

NM Not managed.

• Other files, e.g. Class export files, *.soc, are not listed in the Workbench so they are not included in 

this table.

• Files that are individually managed in your system configuration are listed (and available) inthe 

project's Managed Files folder .

Enable Computer Management

1. Do one of the following.

◦ Click Computer>Properties on the Workbench menu bar.

◦ Click the Computer Properties button  on the Workbench toolbar.

The Computer Properties dialog box opens.

2. Enter  specifications as follows.
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1. #unique_23_Connect_42_AEnable  (on page 89)

2. #unique_23_Connect_42_BServer  (on page 89)

3. #unique_23_Connect_42_CTest  (on page 89)

4. #unique_23_Connect_42_DLogon  (on page 90)

5. #unique_23_Connect_42_EChngeMgtProject  (on page 91)

6. #unique_23_Connect_42_FCheckoutChanges  (on page 91)

7. #unique_23_Connect_42_GChangesNoServer  (on page 92)

A  (on 

page 

89)

Enable Change Management.

B  (on 

page 

89)

Server.

C  (on 

page 

89)

Test Connection
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D  (on 

page 

90)

Logon at Workbench startup/Prompt for username and password at startup.

E  (on 

page 

91)

Name (Change Management project).

F  (on 

page 

91)

Require checkout before changes

G  (on 

page 

92)

Allow changes when the server is not available.

A Enable Change Management

Do one of the following.

Check Enables Change Management for the computer. This will apply to every open Workbench 

on the computer.

Clear Change Management is not enabled for the computer. Note:  This does not affect en

abling Change Management for a CIMPLICITY project.

B Server

Name of the Change Management server.

C Test connection

Click to confirm that the Change Management server is available and can connect to the project.

3. Click Test connection to confirm that the Change Management server is available and can connect 

to the project.

A Change Management Logon  (on page 102)  dialog box opens.

4. Enter an authorized user name and password.

Results:
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One of the following will occur depending on the project/Change Management Server status.

◦ The connection is successful

A message opens and reports:

The change management server connection test succeeded.

◦ The connection fails.

A message opens and reports:

Unable to connect to change management server <Change Management server> with user <User 

Name>. Server unreachable or not found.

If the connection failed, check with the Change Management system administrator to correct the 

problem.

D Logon at Workbench startup/Prompt for username and password at startup

Checking either or both Logon at Workbench startup/Prompt for username and password at 

startup determines the following.

Lo

gon 

at 

Work

bench 

Prompt 

 for 

user

name 

and 

Result
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start

up

pass

word

X If the CIMPLICITY log on credentials are the same as the Change Management cre

dentials, the computer project is automatically logged onto the Change Manage

ment server when the Workbench opens. Note:  If Allow Configuration Auto Logonis 

checked in the Windows Authentication window, a user who is allowed to log on us

ing Windows Authentication is also automatically logged onto Change Management 

for the computer project when the Workbench opens.

X X ◦ A Change Management Logon dialog box for the computer project opens 

when the Workbench opens.

◦ If an authorized username and password are entered, the project is logged in

to the Change Management server.

X ◦ The computer project is not logged onto the Change Management server 

when the Workbench opens.

◦ When a logon is attempted a Change Manage Logon dialog box for the com

puter project opens.

◦ If an authorized username and password are entered, the project is logged in

to the Change Management server.

◦ The computer project is not logged onto the Change Management server 

when the Workbench opens.

◦ Change Management will attempt to log you into the PCM server using CIM

PLICITY login credentials. If the CIMPLICITY credentials do not match the 

PCM credentials, a Change Management Logon dialog box will open.

E Name (Change Management Project)

The project name used on the Change Management server.

The default name is the name of the local server.

Important:

It is strongly recommended that this name be the same as the local server name.

F Require checkout before 

changes
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Check to require that an item be checked out of Change Management before it can be edited.

Note:

◦ If an item is not checked out a Check out dialog box will open when a user attempts to edit 

an entity.

If Require checkout before changes is:

Checked 

(on page 

107)

An authorized user must enter a valid Change Management ID/password in order to 

edit (or save) the selected item.

Clear An authorized Change Management user can cancel the checkout and edit the select

ed item.

◦ Enabling this feature provides the highest level of integration with Change Management.

◦ If the checkout is cancelled a message opens reporting that:

You are required to check out the configuration before you can modify it.

G Allow changes when the server is not avail

able

Check to allow changes when the Change Management server is not available.

Important:

If this feature is checked make sure a Project Compare is performed when the Change 

Management server is available. The report will aid you to check modified entities into the 

Change Management server so they will not be lost.

5. Click OK.

Result
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◦ If the Computer project has already been added to the Change Management server:

A message opens and reports:

Change Management project <project name> already exists on the Server <Change Management 

server>. Do you want to replace the project?

Click one of the following.

But

ton
Description

Yes ◦ Change Management maps your CIMPLICITY project to the existing Change Man

agement project.

◦ The local project is now managed.

Note:  The project (version) that was replaced is still on the Change Management server 

and can be retrieved, if necessary.

No The local project is

◦ Not added to the Change Management server.

◦ Not managed.

◦ If the project is new on the Change Management server:

◦ The Change Management server maps a place for the Change Management project.

◦ The project is now managed.

Note:  The project or entities in the project that should be managed still need to be added  (on page 

137)  to the Change Management server.

Enable Project Management

Access Change Management Dialog Box

1. Click Project>Properties on the Workbench menu bar, or click the Project Properties button  on 

the Workbench toolbar. The Project Properties dialog box opens.

2. Select the Change Management tab. Change Management options are as follows.
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Enable Change Management

Do one of the following:

Check Enables Change Management for the active CIMPLICITY project.

Clear Change Management is not enabled for the active CIMPLICITY project. This does not affect en

abling Change Management for the computer project.

• When Change Management is enabled for a CIMPLICITY project, the project’s Configuration 

Security on the Options tab is automatically checked and made read-only.

• Change Management can be enabled for both a running and a stopped project.
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Configure Server

Name of Change Management server that the user will be using to authenticate/log in to Change 

management.

Test Connection

1. Click Test connection to confirm that the selected Change Management server is available and can 

connect to the project. A Change Management Logon  (on page 102)  dialog box opens.

2. Enter an authorized user name and password.

Results: One of the following will occur depending on the project/Change Management Server status.

• The connection is successful. A message opens and reports. The change management server 

connection test succeeded.

• The connection fails.

A message opens and reports: Unable to connect to change management server <Change Management 

server> with user <User Name>. Server unreachable or not found.

If the connection failed, check with the Change Management system administrator to correct the problem.

Requirement for logging into the Change Management server depends on the following.

Log on at Workbench startup/Prompt for user name and password at logon

If Change Management is enabled for the CIMPLICITY project, configuration security is enabled.
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Other factors that determine if and when a user needs to log onto PCM include whether or not: the 

following are checked Yes or No:

• Allow Configuration Auto Logon in the Windows Authentication dialog box. If Allow Configuration 

Auto Logon is not checked, logging in options/requirements are the same as if the Windows 

Authentication login is invalid.

• Prompt Username/password.

• PCM Workbench Start.

If Allow Configuration Auto Logon is checked in the Windows Authentication window options and 

requirements for Change Management logon are as follows.

1 Windows Logon for CIMPLICITY Windows Logon for PCM

 Valid  Valid

Windows Logon for CIMPLICITY Windows Logon for PCM

VALID VALID

THEN IF TYPE WHEN

CIMPLICITY Logon

Configuration Security Yes Auto Workbench Start

PCM Logon

Prompt Username/Pass

word

Yes / No Manual / Au

to

PCM Workbench Start Yes / No Workbench Start / PCM 

Open

Windows Logon for CIMPLICITY Windows Logon for PCM

VALID INVALID

IF TYPE WHEN

CIMPLICITY Logon

Configuration Security Yes Auto Workbench Start

PCM Logon
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Windows Logon for CIMPLICITY Windows Logon for PCM

VALID INVALID

IF TYPE WHEN

Prompt Username/Pass

word

Yes / No Manual / Manual

PCM Workbench Start Yes / No Workbench Start / PCM 

Open

Windows Logon for CIMPLICITY Windows Logon for PCM

Invalid Valid

IF TYPE WHEN

CIMPLICITY Logon

Configuration Security Yes Manual Workbench Start

PCM Logon

CIMPLICITY Login is Valid  PCM Login

Prompt Username/Password Yes / No Manual / Auto

PCM Workbench Start Yes / No Workbench Start / PCM 

Open

CIMPLICITY Login is Invalid  PCM Login

Prompt Username/Password Yes / No Manual / Manual

PCM Workbench Start Yes / No Workbench Start / PCM 

Open

Windows Logon for CIMPLICITY Windows Logon for PCM

Invalid Invalid

IF TYPE WHEN

CIMPLICITY Logon

Configuration Security Yes Manual Workbench Start

PCM Logon
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Windows Logon for CIMPLICITY Windows Logon for PCM

Invalid Invalid

IF TYPE WHEN

CIMPLICITY Login is Valid  PCM Login

Prompt Username/Password Yes /  No Manual / Auto

PCM Workbench Start Yes / No Workbench Start / PCM 

Open

CIMPLICITY Login is Invalid  PCM Login

Prompt Username/Password Yes / No Manual / Manual

PCM Workbench Start Yes / No Workbench Start / PCM 

Open

Enter a Change Management Project Name

It is strongly recommended that this name be the same as the CIMPLICITY project name. The default 

name is the name of the local project. When the user first logs in, if the project does not exist in Change 

Management, the project is created. No files are added to the project except when specifically requested 

by the user.

Require Checkout Before Changes

Do one of the following.

Check Require that an entity be checked out of Change Management before it can be edited. A mes

sage reminds a user that: You are required to check out the project before you can modify it.

• If a project is being managed a user must add the entity and check out the entity before 

making any changes.

• Enabling this feature provides the highest level of integration with Change Management.
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• If the project is not checked out, a user cannot do a configuration update when trying to 

start the project.

• Certain managed files, e.g. CimEdit screens (*.cim) and scripts (*.bcl), may be edited 

even when Require checkout before changes is checked and the files are not checked 

out. However, the edited file can only be saved using the File>Save as  option either:

◦ To an unmanaged folder.

◦ With a different name than the managed entity in the managed folder. (File> Save 

as the managed entity name to a managed folder is not allowed.)

The new saved as version will not be managed. The managed version will be the original version 

before it was edited. When a new file is created, it is not managed until it is added. The unman

aged file can be edited no matter where it it located until it is added.

Clear An entity does not have to be checked out of Change Management to be edited and saved.

Allow changes when the server is not available

Do one of the following.

Check Allow changes when the Change Management server is not available.

Clear Do not allow changes when the Change Management server is not available. Important:  If Re

quire Checkout before changes is checked, configuration changes will not be possible if the 

Change Management Server is not available.

Important:

If this feature is checked make sure a Project Compare is performed when the Change 

Management server is available. The report will aid you to check modified entities into the 

Change Management server so they will not be lost.

Example:

1. Allow changes when the server is not available is checked.

2. A CimEdit screen, TANK750, is not checked out.

3. TANK750 is enhanced with new graphic and text objects reporting additional point values.

4. The following is done so these changes will be preserved.

a. TANK750 is checked out. IMPORTANT: Don't overwrite local files with managed copy is 

checked.

b. TANK750 is checked in.
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Preserve runtime configuration data on fetch (passwords and alarm setups)

Prompt

The Preserve runtime configuration data on Fetch options dictate how the runtime data will be handled.

A Save Configuration Data dialog box opens with check box entries for each of the configuration data that 

has changed. The dialog box opens before any of the following processes are completed:

• Fetch.

• Check out.

• Get latest version.

Note:

Currently the configuration data includes passwords and alarm setups.

Check the configuration data that you want to preserve:

• Passwords that were specified as valid after the checkout continue to be valid. A user who is 

logged in with a new password can continue configuration with no interruptions.

• New or modified alarm setups are preserved.

Click one more than one of the following:

• OK - Preserves or overwrites the configuration data based on your selection.

• Cancel - Cancels the retrieval.

• Select All - Checks all listed data check boxes. All listed data will be preserved.

• Clear All - Clears all the check boxes. All listed data will be overwritten.

Yes
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• Passwords that were specified as valid after the checkout continue to be valid. A user who is 

logged in with a new password can continue configuration with no interruptions.

• New or modified alarm setups are preserved.

• When the base configuration is checked into Change Management, the file will be checked in with 

the current valid passwords.

No

• The file with the old passwords is fetched from Change Management and overwrites the file with 

the new passwords.

• The new passwords are no longer valid.

• A user will have to re-enter the old password and, in instances where a new password is required, 

the new password in order to continue configuration.

• When the base configuration is checked into Change Management, the file will be checked in with 

the passwords that were specified as valid after the checkout.

If the project has already been added to the Change Management server: a message opens and reports: 

Change Management project <project name> already exists on the Server <Change Management server>. 

Do you want to replace the project?

Click one of the following:

• Yes - Change Management maps your CIMPLICITY project to the existing Change Management 

project. The local project is now managed. The project (version) that was replaced is still on the 

Change Management server and can be retrieved, if necessary.

• No - The local project is Not added to the Change Management server. Not managed.

If the project is new on the Change Management server, the Change Management server maps a place for 

the Change Management project. The project is now managed.

Note:

The project or entities in the project that should be managed still need to be added to the Change 

Management server.

Enable enhanced auditing

When the enhanced auditing check box is checked CIMPLICITY will put entries in the Change 

Management audit log when a point is added, modified or deleted.
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The audit entries include the:

• Point.

• Action.

• User who performed the action.

Important:

This feature will have a performance impact when bulk operations are performed on large 

numbers of points so it is best to enable it after the main provisioning stage of the project and 

more in the maintenance stage. A global parameter, PCM_ENH_AUDIT, is added when you check 

Enable Enhanced Auditing. Perform a Workbench configuration update after you check/clear the 

check box.

Change Management Procedures

Change Management Procedures

1. Right-click Project or Computer in the Workbench left pane.

2. Select Manage on the Popup menu.

3. Select one of the following in the Workbench left1 pane.

◦ Project>Managed files

◦ Computer>Managed files

4. Right-click a file in the Workbench  right pane.

1. Log On

The Logon options are enabled for a CIMPLICITY project and a computer project, if the user was not 

logged in when the Workbench started up.

Logon opens a Change Management Logon dialog box to log a CIMPLICITY project or computer project 

onto the Change Management server.

Tip:

If a logged in CIMPLICITY project user name and password are the same as an authorized 

Change Management user name and password, you can avoid logging in twice  (on page ) , if 

you select to.

unique_27_Connect_42_DLogon
unique_27_Connect_42_DLogon
unique_27_Connect_42_DLogon
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Specifications in a Change Management Logon dialog box are as follows.

1. #unique_24_Connect_42_i1User  (on page 104)

2. #unique_24_Connect_42_i2Password  (on page 104)

3. #unique_24_Connect_42_i3ChgPassword  (on page 104)

4. #unique_24_Connect_42_i4Domain  (on page 105)

5. #unique_24_Connect_42_i5Server  (on page 105)

1  (on 

page 

104)

User name

2  (on 

page 

104)

Password

3  (on 

page 

104)

Change Pass

word

4  (on 

page 

105)

Domain

5  (on 

page 

105)

Server
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1 User name

Authorized Change Management user.

Note:  The privileges that a user has are set by the Change Management server administrator.

Therefore, it is possible for a PCM server user to be able to log into the PCM server, but not be able to 

modify or check in files even if the user has administrative permissions on the CIMPLICITY server.

Note:

CIMPLICITY User names can be 32 characters, however, Change Management limits user names 

to 20 characters. If the same user names will be used for CIMPLICITY and Change Management, 

limit the length to 20 characters.

2 Pass

word.

Valid password for specified Change Management user.

3 Change Pass

word

1. Click Change Password to open the Change Management - Change Password dialog box.

Fields are as follows.
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Field Description

User (Read only) User logged into the Change Management serv

er.

Authority (Read only) Selected Domain authentication.

Existing password User's current valid password.

New password Password the user will use for the next and future log ins.

Confirm new pass

word

New password repeated.

Server (Read only) Change Management server.

1. Click OK.

The Change Management - Change Password dialog box closes.

The password is changed.

1. Confirm that the new password is entered in the Password  field.

4 Domain

Change Management provides the capability to log in to the Change Management server using either of 

the following.

• Change Management authentication.

• Windows authentication.

Note:

The feature used to authenticate the Domain log on  is based on how the Change Manager 

access control was set up.

Consult Change Management documentation for details about setting up access control.

5 Server

(Read-only)

The Change Management server is identified for the project or computer as follows.
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Project Server entered on the Change Management tab in the Project Properties dialog box.

Computer Server entered in the Computer Properties dialog box.

Note:

If the computer project requires a log on in order to make changes and a user tries to open a 

CIMPLICITY application e.g. the Options dialog box, a Change Management Logon dialog box 

will open for the user to log onto the PCM server. Even though the user is then logged onto the 

PCM Server, the Workbench status bar  (on page 113)  will continue to report that the user is not 

logged on. The Workbench status bar only reports a log on when the user logs on by right-clicking 

an icon in the Workbench and selecting Log On in the Popup menu.

2. Log Off

Log off  logs the CIMPLICITY project or computer project user off of the Change Management server.

Your ability to work with managed entities will depend on whether you checked Allow changes when the 

server is not available when configuring the Change Management properties for the project  (on page 

)  or computer  (on page 92) .

Important:

Close the Show History  (on page 116)  window after logging out of the Change management 

server

3. Get Latest Version

Get Latest Version copies the latest version of the selected entity (computer, project or managed file(s)) 

that are on the Change Management server into the CIMPLICITY project or computer project.

When Get Latest Version of the base configuration is selected, Change Management first compares the 

local files with the files on the Change Management server. If there are differences a Changed Files dialog 

box opens.

Note:  The Changed Files dialog box also lists files that are different before performing a checkout  (on 

page 107)  of the project or base configuration, where the selection is to get the latest copy from the 

Change Management server.

unique_27_Connect_42_GAllow
unique_27_Connect_42_GAllow
unique_27_Connect_42_GAllow
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Click one of the following.

Ok All files that are on the Change Management server are copied to the local server. Files that were 

on the local server are overwritten.

Can

cel

Cancels the check out.

Important:

• If the project is running, you cannot get the project base configuration. You must work with the 

local copy until you stop the project.

• It is strongly recommended that you compare the local project version with the project version on 

the Change Management server before performing a Get Latest Version, in order to check in any 

file versions that you do not want to have overwritten.

• Get Latest Version does not check out the files.

4. Check Out

Check out prohibits another user from adding or checking in another version of the entity on the PCM 

server if Require check out before changes is checked for the project in which the checkout was made, 

the CIMPLICITY  (on page )  or computer  (on page 91)  project.

unique_27_Connect_42_FCheckout
unique_27_Connect_42_FCheckout
unique_27_Connect_42_FCheckout
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Note:

Workbench Check Out toolbar buttons are available as follows:

Project Check Out

Computer Check Out

A Check Out dialog box opens when you check out a selected entity.

• Check Out dialog box options.

• Check Out guidelines.

Check Out Dialog Box Options

Important:

If the project is running, you cannot get a copy of a base configuration entity from Change 

Management. You must work with the local copy until you stop the project.

Options are as follows.

Field Description

Logon User (Read only) Name of the logged on user who is checking out the entity. Note:  If a 

user is not logged in a Change Management Logon dialog box opens, requiring an 

authorized user/password.

Name (Read only) Name of the entity being checked out.

Don't overwrite 

local files with 

managed copy

Do one of the following: Check, Clear, Default
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Field Description

Important:

It is highly recommended that when you:

• Begin working on a file or set up files,  always overwrite the local files with the 

managed copies (Leave the checkbox clear.)

• Take a break or are done  for the day, always check in any work that is either 

an in-progress or  finished project.

This enables you  to back-track if that is required and is  particularly useful  if more 

than one person is working with the project.

Check out Guidelines

• If you select the project or base configuration to check out and/or get the latest copy from Change 

Management, this may affect more than one file in your project. Change Management determines 

if there are differences between the Change Management latest copy and the local copy for all 

effected files. If there are differences a message box reports what files are different.

Note:  The Changed Files dialog box also lists files that are different before performing a get latest version 

(on page 106) .

Click one of the following.
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Ok Continues the check out.

Cancel Cancels the check out.

• If Require checkout before changes is checked in the Project Properties or Computer Properties 

tabs in dialog boxes are disabled to prevent configuration.

Note: Some managed files, e.g. scripts and CimEdit screens, can be opened. However, any changes made 

to the screen cannot be saved until it is checked out or saved as  (on page 91)  an unmanaged file.

Example

1. A CimEdit screen is created and added to the PCM server.

2. The CimEdit screen is not checked out.

3. A user attempts to open it to edit.

4. A Check Out dialog box opens.

5. The user clicks Cancel.

A CimEdit Message box opens reporting:

You are required to check out the file before you can modify it.

6. The user

a. Clicks OK to close the message box.

b. Edits the CimEdit screen.

c. Clicks the Save button.

A Check Out dialog box opens again.

7. The user clicks Cancel.

The CimEdit message box opens again reporting that check out is required.

The user will not be able to save the screen as a managed file until it is checked out.

5. Check In

Check In copies the local version of the selected entity onto the Change Management server.

Note:

Workbench Check In toolbar buttons are available as follows:
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Project Check In

Computer Check In

A Check In dialog box opens when you check in a selected entity.

Important:

 If the project is running, you cannot get a copy of a base configuration entity from Change 

Management. You must work with the local copy until you stop the project.

Options are as follows.

Field Description

Logon 

User

(Read only) Name of the logged on user who is checking out the entity. Note: If a user is not 

logged in a Change Management Logon dialog box opens, requiring an authorized user/pass

word.

Name (Read only) Name of the entity being checked out.

Keep 

local 

copy

(Read only) Retains copy of the checked in entity on the local computer.
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Field Description

Keep 

check 

out

Do one of the following: Check or Clear

Com

ment

Description for a user to distinguish the entity version being checked in from other versions. 

Max Length

Note:

An Apply Label  (on page 114)  dialog box will open before the entity is checked in if it is a project 

or core configuration.

6. Undo Check Out

Undo checkout removes the check out status of an entity that was checked out of Change Management 

and identifies it as checked in on the Change Management Server.

If the file has been edited while it was checked out, the edited version that is on the local computer can be 

remain on the local computer and not be overwritten by the managed coopy.

Options in an Undo Check Out dialog box that opens when Undo checkout is selected are as follows.

Field Description

Logon User User who is logged into Change Management.

Name Name of the entity that will have it

Don't overwrite local files with managed 

copy

Do one of the following: Check, Clear, or Default.
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7. Refresh

Refresh the Workbench updates icons and Workbench right pane details columns (that are available for 

selected nodes) that report the status of a managed entity.

Note:

The Workbench status bar reports if the project is connected to the Change Management server 

and the Change Management server name. When you select Refresh the Workbench determines 

and then displays the status for the selected entity.

Example

If you select Computer>Managed Files>Manage>Refresh, the Workbench refreshes the status for the 

Managed files only. The status for other entities in the Computer project may still be unknown.

Status  icons include the following.

1. #unique_29_Connect_42_StatusEntity  (on page 114)

2. #unique_29_Connect_42_Computer  (on page 114)

3. #unique_29_Connect_42_User  (on page 114)

4. #unique_29_Connect_42_statusBar  (on page 114)

5. #unique_29_Connect_42_NotManaged  (on page 114)

6. #unique_29_Connect_42_CheckedOutOther  (on page 114)

7. #unique_29_Connect_42_CheckedOut  (on page 114)

8. #unique_29_Connect_42_Question  (on page 114)
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Icon/

De

tail

Description

Not yet on the Change Management server; the entity is not currently being managed. Example 

A computer project is enabled for Change Management. However, only selected files have been 

added. Icons for other computer files that could be managed display a down arrow.

The entity is checked out to another user or computer. It cannot be checked out on the local com

puter. The entity can be available only if the user name/password that checked it out logs in, 

checks the entity in or an authorized user undoes the checkout. Tip:  Use the Check out Status op

tion to see what user has the entity checked out.

Unknown.

Checked out.

No 

icon

No icon indicates one of the following. The entity:

• Is in Change Management and not currently checked out.

• Cannot be managed.

Sta

tus

Entity status

User User who has the entity checked out, if it is checked out.

Com

put

er

Computer on which the entity is checked out, if it is checked out.

Note:

The status bar  reports if the selected project, CIMPLICITY or Computer, is connected (logged 

onto  (on page 102) ) the PCM Server and the user who logged in. The status changes only when 

a user right-clicks an icon in the Workbench and selects Log on in the Popup menu.

8. Label

Labels enable you to create a set of easily identifiable managed entities that can be retrieved from 

Change Management.
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Checking out or getting a labelled set retrieves the file versions that were included when the entity was 

labelled.

Managed en

tities that:
Include:

Can be la

belled.

• CIMPLICITY project.

• Computer project

• Primary folders and icons in the Workbench left pane.

Examples

• Screens

• Ports

• Resources

Cannot be la

belled.

• Individual files.

• Managed Files  folders in the Workbench left pane.

Note:  The Managed Files  folders are not actual directories. They only exist in the Work

bench to contain all of the individually managed files.

Label options include the following.
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Field Description

Lo

gon 

User

(Read only) Name of the logged on user who is checking out the entity. Note:  If a user is not 

logged in a Change Management Logon dialog box opens, requiring an authorized user/pass

word.

Name (Read only) Name of the entity being labeled.

Ver

sion

(Read only) N/A

Date (Read only) N/A

Label Label that clearly identifies the entity version being added.

Note:

Make sure that a label is entered if you want to view the version in the PCM History win

dow  (on page 116)  and retrieve it.

Note:

The Apply Label dialog box opens after a project or the base configuration is added or checked 

into the PCM server.

9. Show History

9. Show History

Show History opens the PCM History window that lists the versions and data history of the selected 

entity that are on the Change Management server, e.g. if the project is selected, the PCM history window 

displays the history of the project; if a screen is selected, the PCM History window displays the history of 

the selected screen.

Important:

Make sure the PCM History window is closed after logging out of Change Management through 

the Workbench.

Automatically generatedshort point IDs replace their corresponding long point IDs to display in History 

report lists.
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Tip:

You can list (and sort) the short point IDs in the Workbench right-pane next to their associated 

long point IDs.

Use the Field Chooserto select and position the field.

1. #unique_31_Connect_42_BComponents  (on page 118)

2. #unique_31_Connect_42_APCMHistoryWindowColumns  (on page 117)

A  (on 

page 

117)

PCM History window overview.

B  (on 

page 

118)

PCM History window compo

nents.

1. PCM  History Window Columns
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In

for

ma

tion

Description

Ver

sion

Number that defines when the selected entity was checked in static to other check-ins. Note: 

Folders, e.g. projects, do not have version numbers; a file, e.g. a screen is assigned a version 

number each time a new version is added, then checked into the Change Management server.

Path PCM server path (starts with the project root).

User User who performed an action (e.g. check in, add) on the entity.

Label Label, if there is one, that is applied to the added or checked in entity  (on page 114).

Date/

Time

The date and time the action occurred on the Change Management server.

Ac

tion

The type of action performed on the file or folder in the Change Management product. Some ac

tions include (but are not limited to):

• Add

• Label

• Get Latest

• Get

• Check Out

• Check In

• Undo Check Out.

Com

ment

Comment that was entered in the Check In  (on page 110)  or Add  (on page 137)  dialog box.

1. PCM History Window Components

9.1  (on 

page 

119)

Details

9.2  (on 

page 

120)

Differ

ence
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9.3  (on 

page 

124)

Get

9.4  (on 

page 

125)

Report

9.1 Details

The Details button opens a Details screen that provides the following read-only information about the 

selected version.

Note:

You can double-click a version to open its Details screen.

Topic Description

Time Time the action was performed on the entity on the Change Management server.

File / 

Folder

Folder on the Change Management server where the entity is located. Note:  The Change Man

agement server adds a GEF_ prefix to the local checked in CIMPLICITY project folder and COM_ 

to a computer project folder.
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Topic Description

Server

Path

ServerPath Path to the entity on the Change Management server.

La

bel/Ver

sion

• A version is assigned to files.

• A label is assigned to folders.

User User who performed an action on the entity.

Ac

tion

Action that was taken on the entity. Example A screen is created and added to the Change Man

agement server. The action is Created.

Com

ment

Comment entered in the Check In or Add dialog box Comment  field.

9.2. Difference

The Difference button provides the ability to compare a selected entity version on the PCM server vs. the 

local server entity by running either of the following.

Important:

Automatically generatedshort point IDs replace their corresponding long point IDs to display in 

History difference report lists.

Tip:  Use the pt_name_map.idtfile to look up what long point ID is associated with any automatically 

generated short point ID.

• Binary compare

• Text compare (available for selected entities)

Binary  Compare
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Binary compare that identifies the files that are different in the selected entity version vs. the entity's files 

on the local server.

1. Click the Difference button to begin the comparison process.

When Change Management has completed comparing the local entity version vs. the select PCM 

version, a Web Browser opens displaying the report.

Direc

tory
Description

A Left List of files on the PCM server

B Right Status of the file on the PCM server compared vs. the local directo

ry.

2. Scroll through the report to check the status of each file.
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Selection Description

A Red with underline Link to a report that the files are different.

B Matched The files are the same

C Red with description Description of difference between the 

files.

3. Click the underlined Differences exist in the Directory Comparison Report..

Result: A report opens that lists the lines in the selected file on the PCM server vs. the local server.

A Difference X of N. Where

X 

=

Identifies the sequential order of the selected line from the first lines that are different.

N 

=

The total number of lines that are different when the files are compared.

B Navigation buttons are:

Prev Click to go to the previous line that is different. Note:  If you click Prev when  the select

ed line is the first different line in the files, the Directory Comparison Report list will dis

play.

Next Click to go to the next line that is different.

C Left 

column

Rows in the Change Management server file.
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Right 

colum

Rows in the local file.

D A row highlighted in red is the selected line.

E Rows highlighted in yellow lines are different.

F Rows with a white background are the same.

Text  Compare (available for selected entities)

A Text Compare check box is available for selected managed files, including:

◦ CimEdit screens

◦ Scripts

◦ Recipes

Text Compare displays the details of the changes in the selected file when Difference is clicked.

4. Check Text Compare.

5. Click Difference.

A Comparison report opens identifying the details of the changes.
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9.3. Get

The Get button fetches the selected entity version and overwrites the corresponding files on the local 

server.

Important:

It is strongly recommended that you compare the difference between the selected entity version 

and the entity on the local server before getting the file.

1. Click Get.

A message box opens asking you to confirm that you want to get the selected PCM entity version.

2. Click one of the following.

OK The selected entity on the PCM server overwrites the local 

copy.

Cancel Cancels the Get.
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9.4. Report

The Report button opens a Save As dialog box to save the data in the PCM History window.

1. Click Report.

A Save As dialog box opens.

2. Select the file format in the Save as type  drop down box.

Options are:

◦ HTML

◦ XML

◦ CSV

◦ TXT

3. Enter a  File name  for the report file.

Note:  When you select HTML, the file is automatically saved as an HTM file unless you enter .html 

when you enter the file name.

If you let the file be saved as an .htm file, it will not automatically display when you select the HTML 

type the next time you save a report.

Enter *.htm in the File name  field to display the existing .htm files.

4. Click Save.

The report is saved in the selected format.
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10. Show Master Label History

A Change Management Master Label project version enables:

• Users to select any version of a project and/or computer (system) as its Master label.

• The Change Management Scheduler to compare the current local version against the Master 

version.

Note:

• Only one version at a time can be selected as the Master for the project and one version for the 

computer.

• Before this enhancement the Change Management Scheduler could only compare (and optionally 

backup) the current version of a local project/computer against the last checked in project/

computer version.

• Local computer: New Master Label features.

• Change Management Server: Required Master Label configuration.

Local  Computer: New Master Label Features

The following  new and enhanced Change Management features enable you to select and work with the 

Master Label.

• Project/Computer New and Enhanced Manage Menu Items

• Show History: Enhanced PCM History Window

• Show Master Label History: New PCM (Master Label) History Window
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Project/Computer New and Enhanced Manage Menu  Items

Do the following to display either the Project or the Computer Manage menus.

1. Select the Project  or Computer  folder in the Workbench left-pane.

2. Do one of the following.

◦ Right-click the selection; select Manage on the Popup menu.

◦ Click Project or Computer (corresponding to your selection) on the Workbench Menu bar; 

select Manage.

Result: Items on the extended menus provide access to the following.

1. 9. Show History  (on page 116)

Show History: Enhanced  PCM History Window

The Show History window for the project or computer provides the following new and enhanced 

features.

1 Label Master but

ton

A Label Master button has been added; when it is clicked the selected 

row is:
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◦ Identified as the Master version.

◦ Used by the Change Management Scheduler  when it does com

parisons.

2 Selected Row/De

tailed Label  Col

umn

◦ One row only must be selected in order to enable the Label Master 

button.

Note:  If more than one row is highlighted, click the rows that should not 

be highlighted to deselect them

◦ A new Detailed Label  column displays the following.

3 Master Version The Master Version row is identified as Master in the Version  column.

Show Master Label History: New  PCM (Master Label) History Window

Master Label versions are tracked as follows.

◦ _config.ini file.

◦ PCM (Master Label) History window columns.

◦ Master version details and differences.

_Config.ini File

Change Management internally updates a _config.ini file as it keeps track of which project/

computer version is currently selected as the Master version. Each time a different version is 

selected, the _config.ini file is updated.
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The Master Label identification for the Master version in the _config.ini is the same as the value 

that displays in the project/computer PCM History window's  Detailed Label  column.

A Master Label string

B Version label entered manually or by de

fault.

CAUTION:

This file is updated internally. Do not change it manually.

PCM (Master Label) History Window Columns

The PCM (Master Label) History window displays the history of the Master Label config.ini file 

updates.

Columns in the PCM (Master Label) History window provide details about the _config.ini file, as 

follows.
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Column Identifies

1 Version Each time the _config.ini file was updated.

2 Path _config.ini.

3 User Person who selected the project/computer version to be the Master for that in

stance.

4 Date/

Time

When the _config.ini file was updated.

5 Action The action performed on the _config.ini file.

Master Version Details  and Differences

Master version details and differences can be reviewed through the PCM (Master Label) History 

window.

Select two _config.ini file versions; click Difference.

Result: An HTML page opens that displays the details and differences between the two versions.

The Master Label identification for the Master version is the same as the value that displays in the 

project/computer PCM History window's  Detailed Label  column.
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A Master Label string.

B Version label entered manually or by de

fault.

Change Management Server: Required Master Label Configuration

Change Management Server script updates are included in CIMPLICITY v8.1-000004. These 

updates need to be copied and pasted on the Change Management Server; once copied some 

minor configuration is required.

The procedures to copy/paste the updates and required configuration are as follows.

◦ Change Management Server Script File Updates

◦ Change Management Scheduled Event

◦ Permissions to select the Master Label

Change Management Server Script File Updates

Scripts on the Change Management server must be updated in order for the server to recognize the 

new Master Label feature.

The updated scripts are included in the SIM and will be placed in the ..Proficy\CIMPLICITY\Extras 

folder.

Do the following to update the scripts on the Change Management server.

3. Log on to the desired Change Management server.

4. Open Machine Edition.

5. Right-click the Custom Project Settings>Scheduler Scripts  folder.

6. Select Check Out on the Popup menu.
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7. Right-click Scheduler Scripts  again.

8. Select Explore on the Popup menu.

A Windows Explorer window opens with the Scheduler Scripts folder selected.

9. Paste the updated script files in this location.

The files are:

◦ In the ..\Proficy CIMPLICITY\Extras folder on the computer where you just installed 

CIMPLICITY v8.1-000004.

◦ Named:

◦ APICompare_functions.vb

◦ Cimplicity_Compare_Master.vb

◦ Cimplicity_Compare_MasterLabel.vb

◦ scriptdef.ini

A message will ask if you want to overwrite the existing files.
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10. Click Yes.

11. Right-click Scheduler Scripts  again.

12. Select Check In on the Popup menu.

Change Management Scheduled Event

Master Label configuration includes creating one or more scheduled event that

13. Right-click Select Scheduler Event List  in the Machine Edition window.

14. Select Check Out Scheduler Settings on the Popup menu.

15. Right-click Select Scheduler Event List  again.

16. Select Add Event on the Popup menu.
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A new event is added to the Scheduler Event List tree.

17. Name the event, e.g. CIMPChnge.

18. Select the event.

19. Configure the following in the Inspector.

A Event 

Type

Select CIMPLICITY Compare with MasterLabel.

B Project 

List

Click the button on the Project List line; Result: A Project List for <event name> dialog 

box opens. Associate a project with the event, as follows.
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20. Right-click Select Scheduler Event List  again.

21. Select Check In Scheduler Settings on the Popup menu.

22. Select ..>Machine Edition>Scheduler Engine on the Windows Start menu.

A Scheduler icon displays on the Windows Task bar, indicating that the Scheduler has been started.

23. Right-click the Scheduler  icon.

24. Select Maximize Scheduler on the Popup menu.
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The Change Management Scheduler dialog box opens.

25. Do the following.

A Right-click the event that should be started.

B Select Run on the Popup menu.

The Scheduler will now run the script to compare the Master Label project with the current project 

version.

Note:

If the Master Label is not set through the Project List for <event name> dialog box, the script will 

fall back to comparing the latest version on the Change Management server with the current 

version.

Permissions  to select the Master Label

CIMPLICITY Change Management users can select project versions as the Master version only if the 

feature is set to True on the Change Management Server.

Do the following.
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A Select Access Control>Groups>CIMOPRGRP>Permissions>Change Management  in the Machine Edi

tion Navigator.

B Select True for Set Master Version  in the Inspector.

11. Add

• Add procedure.

• Important.

Add  Procedure

Adds the selected entity to Change Management.

1. Select a project folder, base configuration icon or managed file that is or belongs to the entity that 

will be added.

2. Do one of the following.

Entity Do one of the following. Adds

◦ Computer project folder ◦ Right-click; select Add on the Popup 

menu.

◦ Click Computer>Manage>Add on the 

Workbench menu bar.

Computer 

project
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Entity Do one of the following. Adds

◦ Proficy CIMPLICITY Project 

folder

◦ Managed project file

Right-click; select Add on the Popup menu. Selected entity.

◦ Proficy CIMPLICITY Project 

folder

◦ CIMPLICITY project base 

configuration entity

◦ Managed project file

Click Project>Manage>Add on the Work

bench menu bar.

The CIMPLICI

TY project.

An Add or Add Files dialog box opens, based on the selected entity.

3. Enter  specifications as follows.

◦ Project or base configuration

◦ Managed files

Project  or Base Configuration

Field Description

Logon User (Read-only) Displays the Change Management user name.

Name (Read0only) Selected entity name.

Keep Local 

copy

(Read-only) A copy of the entity being added is maintained on the local comput

er.

Keep check out Checked

Managed  Files
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Field Description

Logon User (Read-only) Displays the Change Management user name.

Name (Read0only) Selected entity name.

Keep Local 

copy

(Read-only) A copy of the entity being adds is maintained on the local computer.

Keep check 

out

Checked

Comment Description for a user to distinguish the entity version being checked in from other 

versions. Max Length.

4. Click OK.

The selected entity is added to Change Management.

Results

a. If an entity that can be labelled  (on page 114)  is added:

An Apply Label dialog box opens.
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5. (Optional) Enter a Label to conform to your system standards.

6. Click either:

OK ◦ Saves the label.

◦ Closes the Apply Label dialog box.

Cancel ◦ Cancels applying a label.

◦ Closes the Apply Label dialog box.

a. The entity is added to the Change Management server.

b. If Keep checked out was checked, Checkout  icons display to the left of the added entities in 

the Workbench.

Important:

◦ An entity is not managed until it is added to Change Management; this includes the base 

configuration. If you create a managed file, e.g. a new CimEdit screen or a new alarm setup, 

remember to add it separately or in a full project add so it will be included in the managed 

set.

◦ If two projects (which would be on different computers) have the same name, the first 

project's .gef file that is added to Change Management has precedence over the second.

Example

Two computers add the .gef file for projects with the same name to Change Management.

Computer Project Name When the .gef  file was Added

Comp1 Project A July 9, 2008
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Comp2 Project A August 2, 2008

Since Comp1 added Project A's .gef file first, Change Management gives Comp1's Project A .gef file 

precedence over Comp2's Project A .gef file..

Use Case

7.  A production version of a project is running on a production server.

8. The project is checked out to a test project running on a test server.

9. Once tested, the tested project is returned to Change Management where the production project 

can get the latest version at a break in production, e.g. the weekend.

10. The .gef file is the file from the production version.

12. Destroy

Destroy destroys the selected managed entity on the Change Management server.

The project can be either checked in or out.

Warning:

This is not a delete function. Destroy literally destroys all traces of the selected entity on the 

Change Management server.

A Destroy message box will open to warn you.

13. Check out Status
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Check out Status opens a Check Out Status dialog box that provides details about the status of the 

selected entity.

Information in the dialog box includes the following.

Field Description

Logon user (Read-only) User who logged onto the Change Management serv

er.

File (Read-only) File (or entity) that is being reported on.

Check out computer (Read-only) Either: Entity is checked out or Entity is checked in.

Check out user (Read-only) Either: Entity is checked out or Entity is checked in.

Check out status (Read-only) Either: Entity is checked out or Entity is checked in.

14. Fetch Project

Fetch Project enables you to fetch any project that is available on the Change Management server and 

copy it to a selected destination directory.

• Fetch project procedure.

• Fetch project notes.

Fetch Project Procedure

1. Open a Workbench on the target computer.

Note: The Workbench can either be blank or can contain an existing project.
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2. Click File>Fetch Project on the Workbench menu bar.

A Fetch Project Dialog box opens.

3. Enter  or select the following.

1. #unique_43_Connect_42_AServer  (on page 144)

2. #unique_43_Connect_42_BProject  (on page 144)

3. #unique_43_Connect_42_CDestination  (on page 145)

4. #unique_43_Connect_42_DManage  (on page 145)

A  (on 

page 

144)

Server name.

B  (on 

page 

144)

Project name.



Addons and Options  | 2 - Change Management  | 144

C  (on 

page 

145)

Destination directo

ry.

D  (on 

page 

145)

Manage project.

A Server name

Name of the Change Management server that has the project to be fetched.

B Project name

Name of the project to be fetched.

Find and add the project as follows, if you do not know the exact name.

4. Click the Browse button to the right of the Project name field.

A Change Management Logon dialog box opens.

5. Enter an authorized user name and password.

6. Click OK.

A Select Project Browser opens with a listing of projects on the Change Management Server; the 

listed project may include either the entire project or selected managed files. However, only entire 

projects can be fetched.

7. Select the project to be fetched.

8. Click OK.
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Result: The Select Project browser closes and the selected project displays in the Project name 

field.

Note:  If you selected a partial project a message box will open to report:

Item not be found.

C Destination directo

ry

Directory the project directory will be fetched to.

De

fault

...\Program Files\Proficy\Proficy CIMPLICITY\Projects  Where ...\Program Files\\Profi

cy\Proficy CIMPLICITY  is the root directory.

Note:

◦ If the project already exists on the target computer, the destination directory must be in a 

different location from the local project.

◦ UNC paths are not supported.

e.g. \\computer\share

D Manage project

Do one of the following.

Check The project will be managed by Change Management.

Clear The project will be copied to the destination directory; however,Enable Change Manage

ment  (on page )  will not be checked in the Project Properties dialog box.

9. Click OK.

unique_27_Connect_42_AEnable
unique_27_Connect_42_AEnable
unique_27_Connect_42_AEnable
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Result:

10. If you are not already logged onto the Change Management server, a Change Management Logon 

dialog box opens.

a. Enter an authorized user name and password.

b. Click OK.

11. The selected project is fetched to the selected destination directory.

Fetch Project Notes

◦ If the PCM project name is not the same as the CIMPLICITY project name:

◦ The folder for the fetched project has the Change Management project name.

◦ The project name is the local project name.

Example

◦ A local project is named PCMLOCAL.

◦ The project is named PCMSERVER on the Change Management server.

◦ The project PCMSERVER is fetched to another computer.

◦ The names are as follows.

A The fetched project folder name is PCMSERV

ER.

B The fetched project name is PCMLOCAL.
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◦ If you immediately open a Directory Comparison reportit will report that there are 

differences.

However, if you run the report to discover what the differences are, the report may declare there are 

no differences.

The initial notification that there are differences is based on time stamps of actual file creation vs. 

Fetch creation.

Note:  If there actually were differences when the project was added or checked into the PCM 

server, those differences will be reported.

Change Management Client

Change Management Client

The Change Management client:

• Can be installed when Machine Edition is installed.

• Includes a Scheduler that enables you to schedule events to perform either a - CIMPLICITY 

compare or CIMPLICITY compare and back up.

Important:  Change Management client requires Machine Edition Change Management Client v. 5.6 SIM2 

or higher.

Step 1 

(on page 

148)

Install the Change Management Client on the Local Serv

er.

Step 2 

(on page 

149)

Open the Machine Edition InfoViewer window.

Step 3 

(on page 

152)

Configure and Use the Scheduler

Step 4 

(on page 

152)

Enable Auto Login
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Note:

You can also look at the status of your projects; computer projects, site root project; you can see 

who has items checked out.

Step 1. Install the Change Management Client on the Local Server

1. Start the Machine Edition installation.

The Machine Edition Splash screen opens..

2. Click Change Management.

3. Continue with the installation until the Machine Edition Setup screen opens.

Consult Machine Edition documentation for details.

4. (If a list of support product modules displays that includes CIMPLICITY HMI) Make sure that 

CIMPLICITY HMI is not selected.
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5. Continue with the Change Management client installation.

Consult Machine Edition documentation for details.

When the installation is complete:

• A Change Management client  icon will display in the Workbench left pane.

• Machine Edition and Scheduler will be listed on the Windows Start menu.

Step 2. Open the Machine Edition InfoViewer Window

1. Make sure your project is checked into the Change Management server.

2. Do one of the following.

◦ Workbench Log On
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A Click Edit>Properties on the Workbench menu bar.

B Click the Properties button on the Workbench toolbar.

C In the Workbench left pane:

a. Right-click Change Management.

b. Select Properties on the Popup menu.

D In the Workbench right pane, double click Change Manage

ment.

E Press Alt+Enter on the keyboard.

◦ Windows Start Menu

a. Click Start on the Workbench task bar.

b. Machine Edition on the Start menu.

Example

(Windows 7) The selection is Proficy>Machine Edition.
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Result: A Change Management Log On dialog box opens when you use either method.

3. Right-click Change Management.

4. Select Properties on the Popup menu.

5. Enter the following.

Field Description

User

name

Authorized Change Management server user name.

Pass

word

Valid password for authorized user.



Addons and Options  | 2 - Change Management  | 152

Field Description

Server Change Management server. Note:  The server name can be typed in or selected from 

the drop-down list.

6. Click OK.

A Machine Edition InfoViewer window opens.

Step 3. Configure and Use the Scheduler

1. Compare a local project to a project in Change Management

2. Indicate if they are different.

3. Compare a local project to a project in Change Management

4. (If the projects are different) the local project will be automatically checked out and checked back 

in.

Notes

◦ During the checkout, the local project will not be overwritten.

◦ The items do not remain checked out when they are checked back in.

◦ No entities can be checked out for the compare and backup to work.

Step 4. Enable Auto Login
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If you had selected to allow users to log in automatically to Change Management in the Windows 

Authenticationwindow and Project Properties  (on page )  dialog box, the Change Management Client 

also must be configured to recognize the auto login feature.

1  (on 

page 

153)

Check out the Access Control Data

base

2  (on 

page 

154)

Select Auto Login

3  (on 

page 

154)

Check in the Access Control Database

Check  out the Access Control Database

1. Right-click Access Control in the Machine Edition Navigator.

2. Select Check Out Access Control on the Popup menu.

unique_27_Connect_42_DLogon
unique_27_Connect_42_DLogon
unique_27_Connect_42_DLogon
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Select  Auto Login

1. Select the Auto Login field in the Inspector.

2. Select True in the drop down menu.

Check  in the Access Control Database

1. Right-click Access Control in the Machine Edition Navigator.

2. Select Check In Access Control on the Popup menu.
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Result: The Change Management Client will now recognize the auto login feature.

Change Management Best Practices

Change Management Best Practices

Several best practices are provided as guidelines to help insure that Change Management keeps your 

system accurate and up-to-date.

1  (on 

page 

155)

Best practices: Initial development.

2  (on 

page 

161)

Best practices: Change Management Project Manage

ment.

3  (on 

page 

161)

Best practices: Test bed to production.

4  (on 

page 

164)

Best practices: CIMPLICITY version changes.

1. Best Practices: Initial Development

1. Best Practices Initial Development

The following cases describe best project management practices to use when setting up or making 

configuration changes for a managed project.

Case 1.1 

(on page 

156)

Multiple users, non-shared dri

ves.

Case 1.2 

(on page 

158)

Multiple users, shared drive.
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Case 1.1. Multiple Users, Non-shared Drives

1  (on 

page 

156)

Case description.

2  (on 

page 

156)

CIMPLICITY project configuration.

3  (on 

page 

157)

Managed characteristics configura

tion.

4  (on 

page 

157)

User setup.

5  (on 

page 

158)

Configuration changes guidelines.

6  (on 

page 

158)

Exceptions

Case  Description

• Multiple users use Change Management.

• Users do not use shared drives.

• Users use separate local copies of the project.

CIMPLICITY  Project Configuration

1. Create a project in CIMPLICITY.

2. Add all of the userswho will need access to CIMPLICITY and/or Change Management to the new 

project.

3. Configure the CIMPLICITY project to perform according to your system specifications.
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Managed  Characteristics Configuration

1. Select the Change Management tab in the Project Properties dialog box.

2. Do the following.

1 PCM user names and passwords vs. CIMPLICITY user names and passwords. CIMPLICITY/PCM 

user names and passwords are not the same.

2 Check Require check out before changes.

1. Add the CIMPLICITY project to the Change Management server.

User  Setup

• For Computer level projects

• On the same computer:

The computer level project is the same.

• On different computers:

1. Click Computer>Properties>Manage>Logon on the Workbench menu bar.

2. Configure the characteristics to match those specified on the original project log in as a unique 

PCM user.
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3. Right-click the entity.

4. Select Manage>Get Latest Version on the Popup menu.

Note:  This will impact other computer project on the computer to which these files were fetched.

• For CIMPLICITY projects

1. Click File>Fetch Project on the Workbench menu bar.

The Fetch Project dialog box opens.

1. Enter the PCM Server name and name of the project to be fetched.

2. Select a unique directory location for the project.

3. Configure the characteristics to match those specified on the original project.

Configuration Changes Guidelines

Always follow these guidelines when performing configuration changes:

• Always close all configuration applications before performing a check in operation, when 

performing configuration transactions.

• Perform a check out of the item(s) before beginning application changes.

• Never check Don't overwrite local files with managed copy  (on page 107)  when performing a 

check out operation.

• Never check Don't overwrite local files with managed copy  (on page 112)  when performing an 

undo check out.

• Never share PCM user names with different users.

Exceptions

Failure to follow these instructions can result in one user overwriting another user’s changes or an 

incoherent project as a result of concurrent changes.

Case 1.2. Multiple users, Shared Drive

1  (on 

page 

159)

Case description.
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2  (on 

page 

159)

CIMPLICITY project configuration.

3  (on 

page 

159)

Managed characteristics configura

tion.

4  (on 

page 

160)

Configuration changes guidelines.

5  (on 

page 

160)

Exceptions.

Case  Description

• Multiple users use Change Management.

• Users are using the same copy of the project on a shared drive.

CIMPLICITY  Project Configuration

1. Create a project in CIMPLICITY.

2. Add all of the userswho will need access to CIMPLICITY and/or Change Management to the new 

project.

3. Configure the CIMPLICITY project to perform according to your system specifications.

Managed  Characteristics Configuration

1. Select the Change Management tab in the Project Properties dialog box.

2. Do the following.
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1 PCM user names and passwords vs. CIMPLICITY user names and pass

words.

2 Check Require check out before changes.

1. Add the CIMPLICITY project to the Change Management server.

Configuration Changes Guidelines

Always follow these guidelines when performing configuration changes:

• Always close all configuration applications before performing a check in operation, when 

performing configuration transactions.

• Perform a check out of the item(s) before beginning application changes

• Never check Don't overwrite local files with managed copy  (on page 107)  when performing a 

check out operation,

• Never check Don't overwrite local files with managed copy  (on page 112)  when performing an 

undo check out.

• Never share PCM user names with different users.

Exceptions

Failure to follow these instructions can result in one user overwriting another user’s changes or an 

incoherent project as a result of concurrent changes.
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2. Best Practices: Change Management Project Management

1  (on 

page 

161)

Case description.

2  (on 

page 

161)

Recommended proce

dure.

Case  Description

• The existing project is running correctly.

• Insure that it can be recovered from PCM.

Recommended Procedure

The following procedure helps to insure that local and managed projects are properly managed and can 

be correctly recovered from the PCM Server.

Use this procedure consistently whenever making configuration changes to a managed CIMPLICITY 

project:

1. Verify that all configuration applications are closed and remain closed throughout this process.

2. Check in all checked out files

3. Add project that will add in any missing files

4. Check out project without get (to get all files that were modified without checking out)

5. Check in project to update the managed project.

6. Label Project

3. Best Practices: Test Bed to Production

3. Best Practices: Test Bed to Production

The following cases provide best practices to help insure a smooth transition from a test bed managed 

project to production.

Case 3.1 

(on page 

162)

CIMPLICITY test bed project deployed to production sys

tem.
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Case 3.2 

(on page 

163)

Project not acceptable after configuration changes.

Case 3.1. CIMPLICITY Test Bed Project Deployed to Production System

1  (on 

page 

162)

Case description.

2  (on 

page 

162)

Recommended proce

dure

3  (on 

page 

163)

Notes and issues.

Case  Description

A Project is developed in the test bed and deployed in production.

Recommended Procedure

Important:

• Use a managed project for the test bed and the deployed project.

• Make sure that no configuration applications are open through the process except where 

specifically noted.

• Make sure that change management operations are not performed on either system except as 

specified in this use case

• For the test bed and production system, use project management  (on page 161)  recommended 

procedure to ensure that managed data is up-to-date.

Procedure

1. Modify the managed characteristics of the test bed local project to point to the production project 

in Change Management.

2. Compare latest test bed project with the current production project in Change Management.
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1. Identify independently managed files that are in the current production project, but not in the test 

bed version.

2. Confirm that all differences are acceptable.

3. Re-configure the managed characteristics of the test bed project to point to the test bed project.

4. Shutdown the production system.

5. Make a backup copy of the local production project directory.

6. Modify the managed characteristics of the production local project to point to the test bed project 

in Change Management.

7. Right-click Project  in the Workbench.

8. Select Manage>Get Latest on the Popup menu.

Note:  This method is used so that runtime data that is not managed remains in the production project. If 

this is not desired do a Fetch Project  (on page 142)  instead of following this procedure.

1. Delete any files that were not in the test bed project.

2. Modify any non-CIMPLICITY configuration changes that were made to support the requirements 

change.

3. Modify the managed characteristics of the local production project to point to the production 

project in Change Management.

4. Check out the production project from Change Management.

Important:  Do not overwrite the local copy.

1. Check in the production project.

2. Start the production project.

3. Perform a configuration update.

4. Start the production project to resume production

Notes  and Issues

• Must manually perform any configuration changes not related to CIMPLICITY

• Must be careful about runtime data that is stored with configuration

Case 3.2. Project not Acceptable after Configuration Changes

1  (on 

page 

164)

Case description.
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2  (on 

page 

164)

Recommended proce

dure

Case  Description

• The project is developed on a test bed and deployed in production.

• Requirements are revised.

• Change Management project management  (on page 161)  recommended procedure are followed 

to ensure all data is always on the Change Management server.

• Production starts.

• Problems are noted

Recommended Procedure

Important:

Make sure that all configuration applications are closed and remain closed through this process.

Procedure

1. Stop the production project.

2. Right-click Project  in the Workbench.

3. Select Manage>Show History on the Popup menu.

4. Select the labeled version of the project that was running successfully

5. Click Get to get that version

6. Delete any files that were added from the local project.

7. Modify any non-CIMPLICITY configuration changes that were made to support the requirements 

change.

Note:  You may need to delete saved runtime information (e.g. SAVED_POINT files).

1. Use project management best practices  (on page 161)  to ensure that the current version of the 

managed project matches the production system project.

2. Start the production project.

4. Best Practices: CIMPLICITY Version Changes
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1  (on 

page 

165)

CIMPLICITY version upgrade.

2  (on 

page 

165)

CIMPLICITY version down

grade.

CIMPLICITY Version Upgrade

1. Follow the Change Management project management  (on page 161)  recommended procedure to 

ensure the managed project is up to date.

2. Apply the CIMPLICITY upgrade.

3. Follow the Change Management project management  (on page 161)  recommended procedure to 

ensure the managed project is up to date.

CIMPLICITY Version Downgrade

Important:

Make sure that all configuration applications are closed and remain closed through this process.

Procedure

1. Follow the Change Management project management  (on page 161)  recommended procedure to 

ensure the managed project is up to date on the Change Management server.

2. Right-click Project in the Workbench.

3. Select Manage>Show History on the Popup menu.

4. Select the current project and the labeled project that corresponds to the previous version of 

CIMPLICITY.

5. Identify the configuration changes.

6. Stop the project.

7. Right-click Project in the Workbench.

8. Click Manage>Show History on the Popup menu.

9. Select the labeled version of the project that was running successfully.

10. Click Get to get that version.

11. Delete any files that were added from the local project.

12. Modify any non-CIMPLICITY configuration changes that were made to support the requirements 

change
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Note:  You may need to delete saved runtime information (e.g. SAVED_POINT files).

1. Apply any desired/application configuration changes from the new project

2. Use project management best practices  (on page 155)  to ensure that the current version of the 

managed project matches the production system project.

Change Management Technical Reference

Change Management Technical Reference

• File and folder names.

• Server Redundancy guidelines.

• Computer level files: Management categories.

• Project level files: Management categories.

• Managed Enterprise Server project guidelines.

• Pager data files management.

• Change Management licensing.

File and Folder Names

File and folder names that include following characters cannot be added to Change Management Server.

Note: In the rare cases, if an invalid character is in a file or folder name, the character will be replaced with 

a correspondent string. The modified file or folder name will be saved to Change Management Server.

Users will see different file or folder names on the Server side if they choose to use the Change 

Management client.

Example

Invalid Char

acter  Name
Name with Replacement String

$Filename &#36Filename



Addons and Options  | 2 - Change Management  | 167

Invalid characters and, in rare cases, replacement strings are as follows.

Invalid 

Characters
Replacement Strings

& &#38

$ &#36

@ &#64

[ &#91

] &#93

( &#40

) &#41

= &#61

^ &#94

! &#33

% &#37

, &#44

; &#59

Important:

Do not use replacement strings a file or folder name.

Server Redundancy Guidelines

• A Host redundant system is managed from the Primary node only.

• Only the files on the primary are protected.

• The secondary server does not know the project is managed.

• To use project restoration on a redundant system

1. Recover the primary while the project is not running.

2. Do a configuration update.

3. Start the project start
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Important:

The secondary and the primary server must have the same configuration.

Change management has no way to ensure this because of dynamic configuration and the 

possibility that the last changes where not checked in. So the only support we have requires that 

the project not be running on the redundant pair.

◦ Screens that are copied to the secondary server cannot be change managed.

◦ The following files are not managed.

◦ Alarm comments file.

◦ Files used to sync up data base logging.

Note:  These files have the prefix ptnr_.

◦ The secondary server can be managed as a computer project.

◦ When fetching a redundant primary project to a different physical node than the one it came 

from, do the following:

4. Copy the gefconfig.ini file from the windows directory of the secondary node to the local one.

5. Create a Redundancy share drive with the same drive letter as the original primary node.

6. Change the local node's node name to be the same as the original primary node.

Computer Level Files: Management Categories

The following table lists the categories of files that are:

• Excluded from the Base Configuration.

• Individually Managed. Individually managed  files are included in both the Excluded from Base 

Configuration list and Individually Managed lists.

• Base Configuration. Essentially the base configuration files are all files not included in the Excluded 

from Base Configuration list.

Excluded from 

Base Configuration
Individually Managed Included Base Configuration

\.PCMFILE

\_CONFIG.INI

\CNC_README.CHM
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Excluded from 

Base Configuration
Individually Managed Included Base Configuration

\COMPUTER.GEF

\README.CHM

*.AMV *.AMV

*.ASC *.ASC

*.BACKUP

*.BCD *.BCD

*.BCL *.BCL (Except, see below  (on page 

174))

*.BCLRT *.BCLRT

*.CIM *.CIM (Except, see below  (on page 

174))

*.CIMRT *.CIMRT

*.CLG

*.CLM *.CLM

*.CMS *.CMS

*.CMSRT *.CMSRT

*.CTX *.CTX

*.ERR

*.INI (That are not in Base 

Config)

*.INI (Except, see below  (on page 

174)  and not in Base Config.)

DATA\GLOBALS.INI

DATA\master_pos_0.ini

DATA\MASTER_POS_63.ini

DATA\S90TRIO.ini

*.HTM

*.HTML (Except, see below  (on 

page 174))
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Excluded from 

Base Configuration
Individually Managed Included Base Configuration

*.LOCK

*.OCX

*.PP *.PP

*.PPL  *.PPL

*.PRO *.PRO

*.QTR *.QTR

*.REG

*.RGP *.RGP

*.RTF

*.SOC *.SOC

*.SPC *.SPC

*.STG

*.TXT (That are not in Base 

Config)

PERFSERV\DEFAULTCOUN

TERS.TXT

ETC\CIMHOSTS.TXT

*.XLS

*.XML (That are not in Base 

Config)

DATA\PCIM.XML DATA\CIMOPCSERVER.XML

AEOPC\*.*

API\*.*

ARC\*.MDB

BSM_DATA\*.*

CIMPOLE\*.*

CLASSES\*.*

CNC\*.* CNC\*.*

CNC_SETUP\*.*
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Excluded from 

Base Configuration
Individually Managed Included Base Configuration

DATA\*.CACHE

DATA\*.DAT DATA\RGB.DAT

DATA\*.FAV

DATA\*.IDX

DATA\*.IDT DATA\CIMVIEWSESSIONS.IDT

DATA\AMLP.CFG

DATA\CIMCMSAFE.CFG DATA\CIMCMSAFE.CFG, DA

TA\CIMVIEW.CFG

DATA\CIM_CONFIG_

SERVICE.JSON

DATA\CIM_CONFIG_

SERVICE.JSON

DATA\DATALOG.DAT

DATA\GEFDEPL.DPLCFG DATA\GEFDEPL.DPLCFG

DATA\GEFKEYPAD.CFG DATA\GEFKEYPAD.CFG

DATA\HISTMGR_CONNEC

TION_CONFIG.XML

DATA\HISTMGR_CONNECTION_

CONFIG.XML

DATA\LOGPROC.DAT

DATA\NODE.DAT

DATA\OPCINISETTINGS.CFG DATA\OPCINISETTINGS.CFG

DATA\OPCUA-BROWSE-CON

FIG.JSON

DATA\OPCUA-BROWSE-CON

FIG.JSON

DATA\PROJECTS.JSON DATA\PROJECTS.JSON

DATA\PROJSHARES.DAT

DATA\PTMGMT.DAT

DATA\SERVICE.DAT

DC\*.*

DOCS\*.*
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Excluded from 

Base Configuration
Individually Managed Included Base Configuration

DRIVERS\GENIUS\SETUP.EXE

ETC\*.TXT

EXE\*.*

EXTRAS\*.*

FIREWALL\SP2MANAG

ER.DLL

FIREWALL\SP2MANAGEREX

E.EXE

FONTS\*.*

GEFVCR\*.*

HELP\*.*

LOG\*.*

MDAC\*.*

MSSQL*\*.*

OPCSERVER\*.*

OPENSSL\*.*

OPT\*.*

PAGER\INSTALL.LOG

PAGER\UNWISE.ENG

PAGER\UNWISE32.EXE

PAGER\BACKUP\

PAGER\DATA\FPADMIN.MDB PAGER\DATA\FPADMIN.MDB

PAGER\DATA\FPSERV

ER.MDB

PAGER\DATA\FPSERVER.MDB

PAGER\DBSCRIPTS\*.*

PAGER\EXAMPLES\*.*
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Excluded from 

Base Configuration
Individually Managed Included Base Configuration

PAGER\EXE\*.*

PAGER\LIBS\*.*

PAGER\LOGS\*.*

PAGER\MANUALS\*.*

PAGER\REPORTS\*.*

PERFSERV\*.*

POMS\*.*

PROJECTS\*.*

DATA\PTOPC_CONFIG.XML DATA\PTOPC_CONFIG.XML

PUBLISHSUBSCRIBE

DELIVERY\*.*

RCO\*.*

REPORT\*.*

SCRIPTS\*.*

SERIES90\*.*

SETUP\*.*

SYMBOLS\*.* SYMBOLS\*.*

SYSTEMSENTRY\*.* SYSTEMSENTRY\*.*

TADB\*.*

TQE\*.*

TRACKER\*.*

UNINSTALL\*.*

WEB\*.* WEB\EXE\CONF\NGINX.CONF

WEBPAGES\*.*
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Excluded from 

Base Configuration
Individually Managed Included Base Configuration

All other files not listed in this table 

or as exceptions.

Files that are Exceptions  to the Rule

The following files may be types that are individually managed. However, these specific files are excluded 

from computer project management.

\_CONFIG.INI

API\REDUNDANT_API\[_A-Z0-9].*\.BCL

BSM_DATA\[_A-Z0-9].*\.BCL

BSM_DATA\[_A-Z0-9].*\.INI

DATA\GLOBALS.INI

EXE\[_A-Z0-9].*\.INI

\FIREWALL.*

PAGER\EXAMPLES\[_A-Z0-9].*\.BCL

PERFSERV\[_A-Z0-9].*\.H

PERFSERV\MACROS.IDT

PERFSERV\[_A-Z0-9].*\.INI

SERIES90\[_A-Z0-9].*\.CIM

WEB\EXE\DOCS\*.*

WEB\EXE\LOGS\*.*

WEB\EXE\TEMP\*.*

WEB\HTML\*.*

Project Level Files: Management Categories
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The following table lists the categories of files that are:

• Excluded from the Base Configuration.

• Individually Managed

Individually managed  files are included in both the Excluded from Base Configuration list and Individually 

Managed lists.

• Base Configuration

Essentially the base configuration files are all files not included in the Excluded from Base Configuration 

list.

Excluded from 

Base Configuration
  Individually Managed Included  Base Configuration

\.PCMFILE

\_CONFIG.INI

*.AMV *.AMV

*.ASC *.ASC

*.BCD *.BCD

*.BCL *.BCL

*.BCLRT *.BCLRT

*.CIM *.CIM

*.CIMRT *.CIMRT

*.CLG

*.CLM *.CLM

*.CMS *.CMS

*.CMSRT *.CMSRT

*.CTX *.CTX

*.EXE *.EXE

*.INI (That are not in Base Con

fig)

*.INI (That are not in Base Con

fig)

\ABRFID.INI
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Excluded from 

Base Configuration
  Individually Managed Included  Base Configuration

 

DATA\CIMPAGER.DAT

DATA\GEF_CFG.INI

DATA\HWABC.INI

DATA\MASTER_COM[0-9]*.INI

DATA\MASTER_OPC_*.INI

DATA\MASTER_POS_*.INI

DATA\MBPLUS.INI

DATA\NSC.INI

DATA\OPCAESERVER.INI

DATA\PAGERDIS.DAT

DATA\PAGERDL.DAT

DATA\[_A-Z0-9].*_FS\.INI

DATA\SPCACTIVELIST

DATA\TRIPLEX_PASSWORD.INI

DATA\*.XML

MASTER\TRIPLEX_PASS

WORD.INI

*.PP *.PP

*.PPL *.PPL

*.PRO *.PRO

*.QTR *.QTR

*.RGP *.RGP

*.SOC *.SOC

Alarm_Help\*.* Alarm Help\*.* (Except *.cmt)
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Excluded from 

Base Configuration
  Individually Managed Included  Base Configuration

ARC\*.CSV

CNC\*.* CNC\*.*

DATA\*.IDT

DATA\*.IDX

DATA\ALARMSETUPMERGE

DATA\DYN_CFG.CFG

DATA\FPAGECIM.CSV

DATA\PTX_POINTS.CFG

DATA\USER.TXT

DATA\WARMDATA.SAV

GATHERFILES\*.*

LOCK\*.*

LOG\*.ERR

LOG\*.LOG

LOG\*.OUT

LOG\AMRP_TRANSLATED.TXT

LOG\SAVED_POINT.STG

MASTER\*.IDT

MASTER\*.IDX

MASTER\USER.TXT

PXR\*.*

SCREENS\*.* SCREENS\*.*

SCRIPTS\*.* SCRIPTS\*.*

RECIPES\*.* RECIPES\*.*

XREF\*.*
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Excluded from 

Base Configuration
  Individually Managed Included  Base Configuration

All other files not listed in this ta

ble.

Managed Enterprise Server Project Guidelines

When a managed project is an Enterprise Server, the Enterprise Server files, ES_*, are included in the 

managed base configuration.

However, the files will change when the Enterprise project synchronizes with source projects at startup, 

regardless of its checkout status.

Because of the synchronization, it can take a long time to startup an Enterprise project. Therefore, it is 

recommended that the changes made by the startup synchronization between the projects get checked 

into the PCM server.

A recommended approach is as follows.

After points that are marked as Enterprise points have been changed in a source project.

1. Checkout the Enterprise project’s base configuration.

2. Start the Enterprise project

3. Wait for synchronization to complete.

4. Check in the Enterprise project’s base configuration so that the ES_* file changes are captured.

Note:

This procedures is not critical to success. However, it will help insure that the next time the 

project is fetched from the PCM server that there are no conflicts to be resolved between 

the checked in ES_* files and the points configured in the source projects.

These conflicts are resolved by sending out dynamic configuration messages for every point that is 

new or that has been modified.

Pager Data Files Management

Beginning in CIMPLICITY 7.0, Pager configuration data is stored in two .mdb files that are located in the 

directory:
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...\Program Files\Proficy\Proficy CIMPLICITY\PAGER\DATA.

The files are:

• FPADMIN.MDB

• FPSERVER.MDB

In the Workbench the files are in the Computer>Managed Files  folder.

A user may manually check these files in and out and trigger manual PCM checks. However, the PCM 

server will not do any automatic check in and check out validation

Change Management Licensing

Change Management licensing is as follows.

• Each physical PC that is connected to the PCM server consumes a single PCM client license, 

regardless of how many actual connections are made from that machine.

• Each Terminal Services client that connects to the PCM server will consume one license.

Note:

Projects that do not include configuration privileges can be Change Managed. In this situation 

Change Management:

• Can act as a place for safe keeping and deployment.

• Adds the ability for password changes, alarm setups, and other runtime configuration information 

to be managed.



Chapter 3. HMI for CNC

Overview

HMI for CNC is a product option release of HMI/SCADA CIMPLICITY. If you purchased a licensed system, 

the following is included:

• CIMPLICITY software license agreement.

• Licenses for the CIMPLICITY Base System, HMI for CNC option, HMI for CNC additional 

connections, and other options you purchased.

• Install media containing the software you need to install and use HMI for CNC.

• Associated documentation.

Note the following important information regarding HMI for CNC:

Item Description

HMI for CNC is not 

cluster-aware.

Due to protocol limitations, HMI for CNC is not currently supported in a cluster 

environment.

Retry method for 

down devices.

When communicating with multiple FOCAS Ethernet CNCs, it’s recommend

ed that the global parameter DC_RETRY_ONE_DEVICE be set to TRUE for the 

project. For information on global parameters, see Global Parameters in CIM

PLICITY Help.

Count licenses by 

CNCs rather than 

paths.

HMI for CNC licensing now counts the Host, IP, or HSSB address of the CNC; it 

does not count each path. This is of particular value to users who use a CNC 

such as the Series 30i/31i/32i, which supports up to ten (10) paths per CNC.

Handling multiple de

vices.

If multiple devices are configured to use the same physical CNC, only one of the 

available HMI for CNC licenses will be used.

Licensing. If you don't have a license for CIMPLICITY for CNC v10.0, the product will run in 

2-hour demo mode. In addition to that time limit, actual device communications 

and the CNC alarm process are disabled.

Converting CimEdit 

screens with embed

ded FANUC ActiveX 

controls.

If you created CimEdit screens under HMI for CNC version 4.0 or earlier, with 

embedded FANUC ActiveX controls, and have not performed the following steps, 

complete the steps now  so the screens can be upgraded to work with HMI for 

CNC 10.0.
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Item Description

1. Ensure all CIMPLICITY projects are shut down.

2. For each project with a screen or multiple screens that have embedded 

FANUC ActiveX controls, do the following.

1. Open Workbench.

2. Click Tools>Command Prompt  on the Workbench menu bar.

The Command window opens. The command prompt displays as: c:\<project 

name> Where c:\<project name> represents the drive that the project is on and 

the project name.

1. Type the following:

cd screens  The prompt changes to c:\<project name>\screens>

1. Type the following:

convert_screen "screen name"  or convert_screen *

Obsolete interface 

boards.

Because only the PCI HSSB Interface Board is supported in Windows XP and 

subsequent versions of Windows, ISA HSSB Interface Boards

Required and Supported Hardware and Software

CIMPLCIITY v10.0 must be instaelled before installing HMI for CNC v10.0.

FANUC Open CNC API Specification (FOCAS) 1/2 libraries (available from the CNC Application 

Development Kt 1.5 Edition) are required, but are no longer included with the HMI for CNC distribution. 

 You must acquire them directly from FANUC (Part  number A08B-9010-J555#ZZ12).

Note:  Consult your FANUC representative for more information about the FOCAS libraries and hardware.

Supported Hardware

HMI for CNC v10.0 supports the following models of FANUC CNC’s using:

FOCAS HSSB

Series 0iMA, 0iMB, 0iMC, 0iTA, 0iTB, 0iTC
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Series 150MB, 150TB, 150MBMA (up to 15 axis), 150MBMA2 (up to 24 axis)

Series 150iMA (up to 24 axis), Series 150iMB (up to 24 axis)

Series 160MB, 160TB, 160MC, 160TC

Series 180MB, 180TB, 180MC, 180TC

Series 210MB, 210TB

Series 160iMA, 160iTA, 160iMB, 160iTB, 160iMP, 160iTP

Series 160iLA, 160iWA, 160iLB, 160iWB, 160iLP, 160iWP

Series 180iMA, 180iTA, 180iMB, 180iTB, 180iMP, 180iTP

Series 180iWA, 180iWB, 180iWP

Series 210iMA, 210iTA, 210iMB, 210iTB

Series 300iA, 310iA, 320iA

Power Mate H, i-H, i-D

FOCAS Ethernet

Series 150iMA (up to 24 axis), Series 150iMB (up to 24 axis)

Series 160iMA, 160iTA, 160iMB, 160iTB, 160iMP, 160iTP

Series 160iLA, 160iWA, 160iLB, 160iWB, 160iLP, 160iWP

Series 180iMA, 180iTA, 180iMB, 180iTB, 180iMP, 180iTP

Series 180iWA, 180iWB, 180iWP

Series 210iMA, 210iTA, 210iMB, 210iTB

Series 300iA, 310iA, 320iA

Power Mate i-H, i-D

Upgrading from Previous Releases

Before upgrading from a previous release of HMI for CNC:
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If you want to retain and upgrade your projects, save them in a directory outside of the CIMPLICITY path. 

 Once upgraded, the projects will not work with earlier CIMPLICITY software versions.

a. Shut down all CIMPLICITY and FOCAS software.

b. Start the CIMPLICITY v10.0 installation and follow the prompts.

c. After the installation finishes, reboot your computer.

d. Start the HMI for CNC v10.0 installation and follow the prompts.

Licensing Requirements

The following scenarios describe the behavior of HMI for CNC device communications and the CNC 

Alarm process with and without licensing:

• If the base product, HMI/SCADA CIMPLICITY, is not licensed, HMI for CNC is also not licensed. 

CIMPLICITY will run in a two hour demonstration mode; however, the Router will shut down any 

HMI for CNC device communications and the HIM for CNC Alarm process.

• If the base product, HMI/SCADA CIMPLICITY, is licensed, but HMI for CNC is not licensed, HMI for 

CNC device communications and the HMI for CNC Alarm process will shut down immediately.

• If the base product, HMI/SCADA CIMPLICITY, is licensed and HMI for CNC is also licensed, HMI for 

CNC will run for the number of purchased licenses.

Consult your GE representative for detailed information about HMI for CNC software licensing.

Consult your FANUC representative for detailed information about hardware.

Interface Requirements

Interface Requirements

Depending on the protocol you choose to use, you may need to purchase some required hardware and 

software to optimize your system.

• HSSB interface requirements.

• Ethernet interface requirements.

• Hardware supplied by FANUC.

HSSB Interface Requirements
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• HSSB card configuration

• HSSB card set

HSSB  card configuration

HMI for CNC supports communication through the following High Speed Serial Bus (HSSB) interfaces:

• Type 2

• Type 3 (30i/31i/32i) (Formerly Series 300i/310i/320i)

You can configure your system to support a:

• Single HSSB-card per PC or

• Multiple HSSB-cards per PC, up to 8 total CNC connections. This can be any of the following:

• 8 single channel boards.

• 4 dual channel boards.

• A combination of single channel boards and dual channel boards

The following diagram illustrates a multiple HSSB card configuration:

HSSB  card set

The HSSB card set can have a PC PCI or PCI Express card, plus a fiber optic cable, and a CNC card. Each 

connection requires a card set.



Addons and Options  | 3 - HMI for CNC  | 185

Note:

DISA HSSB Interface Boards are obsolete.

Ethernet Interface Requirements

CNC  to port configuration

HMI for CNC supports communication through an Ethernet connection on your network.

You can configure your system to support 10 CNC's per CIMPLICITY port, with a maximum of 10 ports, to 

a total of 100 CNC's.

The following diagram illustrates multiple CNC's to port configuration:

Ethernet  card set

The Ethernet card set consists of a standard network adapter, network cable, and a CNC card. A CNC card 

is required for every CNC.



Addons and Options  | 3 - HMI for CNC  | 186

Hardware and Optional Software Supplied by FANUC

Contact your FANUC sales representative for details about CNC hardware.

Software Installation

Software Installation

Steps for installing HMI for CNC are as follows.

Step 1 

(on page 

187)

(HSSB only) Install HSSB interface hardware.

Step 2 

(on page 

187)

Install CIMPLICITY software.

Step 3 

(on page 

187)

Install FOCAS HSSB driver if HSSB card is 

used.

Step 4 

(on page 

192)

Configure the HSSB Card.

Step 5 

(on page 

193)

Copy FOCAS Libraries to your system.

Step 6 

(on page 

194)

Install HMI for CNC software.
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Step 7 

(on page 

196)

Verify successful communications.

Note:

HMI for CNC licensingis included in the licensing hardware key. Consult your GE sales 

representative for details.

Step 1. Install HSSB Interface Hardware

Contact FANUC for HSSB interface parts (hardware and the driver) and installation instructions if you are 

going to use the HSSB.

Important:

HSSB hardware and the driver must be installed before you install HMI for CNC.

Step 2. Install CIMPLICITY Software

Install the latest CIMPLICITY SIM.  

 For more information, refer to the CIMPLICITY installation documentation.

Step 3. Install the HSSB Driver

Note:

: Make sure your CNC supports HSSB cards if you plan to use one.  

The PCI HSSB interface board and the HSSB interface board for PCI Express are supported.  When two 

or more PCI HSSB interface boards are installed, the nodes are first allotted from the PCI HSSB interface 

board inserted in the  lower PCI slot number.

Either of two procedures can be used to install the driver.

Note:  This procedure describes installation on Windows 7.  

• Automatic HSSB Driver Detection by Windows Installation

• Manual HSSB Driver Installation
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Automatic  HSSB Driver Detection by Windows Installation

When Windows is started, the PCI HSSB interface board is detected as PCI Simple Communications 

Controller in the Found New Hardware wizard.

1. Make sure your FANUC CNC Application Development Kit 1.5 Edition distribution is inserted into 

the DVD drive.

2. Check Select Locate and Install driver software (recommended).

3. Click Next.

A Please choose your search and installation options screen opens.

Note:  If User Account Control  is configured and you are not an Administrative user, a User Account 

Control Window opens.  

Click Continue to proceed with the driver installation.

A Found New Hardware – PCI Simple Communications Controller opens.

4. Check Don’t search online.

An Insert the disk that came with your PCI Simple Communications Controller message displays.

5. Check I don’t have the disc. Show me other options.

A Windows couldn’t find driver software for your device message displays.

6. Check Browse my computer for driver software (advanced).

Win

dows 

7

Enter or Browse to:

32-

bit 

edi

tion

<DVD drive>:\FOCAS2 Library\Hssb\Vista Note:  A message will display: Windows can’t 

verify the publisher of this driver software. Check Install this driver software anyway.  The 

installation will continue.

64-

bit 

edi

tion

<DVD drive>:\FOCAS2 Library\hssb\win7_64

The driver software will automatically be installed.
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When the hardware has been successfully installed, a message reports:

Found New Hardware – FANUC HSSB xxxxx.

Where

xxxxx indicates the board type.

7. Click Close to finish the installation.

Note:

This procedure installs the driver for all HSSB cards in the PC.

Manual  HSSB Driver Installation

8. Open the Windows Device Manager.

Note:  Methods for Windows 7 include the following.

◦ Click Start on the Windows Task Bar; select Control Panel>Device Manager.

◦ Display the Command prompt; enter devmgmt.msc.

9. Expand Other devices if it is not expanded.

10. Right-click PCI Simple Communications Controller.

11. Select Update Driver Software on the Popup menu.

A How do you want to search for driver software screen opens.
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12. Click Browse my computer for driver software.

A Browse for driver software on your computer screen opens.

13. Do the following in the Search for driver software in this location section.

A Enter or browse for the software. The selected folder depends on whether the system is 32-bit 

or 64-bit.

Win

dows 

7

Enter or Browse to:
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32-

bit 

edi

tion

<DVD drive>:\FOCAS2 Library\Hssb\Vista Note:  A message will display: Windows can’t 

verify the publisher of this driver software. Check Install this driver software anyway. 

 The installation will continue.

64-

bit 

edi

tion

<DVD drive>:\FOCAS2 Library\hssb\win7_64

B Check Include subfolders.

14. Click Next.

The driver software will  be installed.  

A screen reports when the driver has been successfully installed.

15. Select Close to finish the installation.

The installed HSSB driver is now listed in the Device Manager.
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Step 4. Configure the HSSB Card

1. Click Start on the Windows task bar.

2. Select Settings>Control Panel.

3. Do one of the following.

◦ Double-click the HSSB  icon  in the Control Panel.

◦ Click the HSSB  icon  on the Control Panel menu.

The HSSB dialog box opens.

4. Select a node and click Setting. The HSSB: Node n dialog box opens.

5. Fill in the fields as follows.
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Field Description

Node Name Name for the machine connected to the HSSB card.

CNC Type Select the appropriate CNC type from the drop-down list.

I/O Port Ad

dress

a. When the HSSB dialog box is first opened,  select Use PCI from a drop-

down list.

b. The field changes to read-only with an assigned port address after you re

boot the computer.

6. When the HSSB dialog box is first opened,  select Use PCI from a drop-down list.

7. The field changes to read-only with an assigned port address after you reboot the computer.

8. Click OK.

The HSSB dialog box re-displays.

9. (Optional) Select a new node number and repeat the procedure to configure additional hardware.

10. Click Cancel  in the HSSB dialog box when all of the hardware has been configured.

(For CIMPLICITY supported operating systems) The settings are immediately changed. No further action 

is needed.

Step 5. Copy FOCAS Libraries to your System

The FOCAS libraries used by HMI for CNC are no longer included with the HMI for CNC distribution. 

Therefore, you will need to manually copy these files from the FANUC CNC Application Development Kit 

1.5 Edition DVD to your hard drive.

For example:
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copy "F:\FOCAS2 Library\Fwlib\*.dll" "C:\Windows\SysWOW64"

• Software installation.

Step 6. Install HMI for CNC Software

Step 6. Install HMI for CNC Software

Important:

Before you begin to install HMI for CNC make sure you have:

• InstalledCIMPLICITY software on your PC. If you do not have the correct version, the installation 

process will stop and inform you that you must install the correct version.

• Removed  (on page 436)  any previous version of HMI for CNC.

HMI for CNC installation steps are as follows.

Step 6.1 

(on page 

194)

Begin the HMI for CNC installation.

Step 6.2 

(on page 

195)

Complete HMI for CNC installation.

Step 6.1. Begin the HMI for CNC Installation

1. Start the installer.

a. Click Start>Run on the Windows desktop.

b. Type  D:\InstallFrontEnd.exe   (where  D   is the drive where your install media is located)

c. Click OK.

The HMI/SCADA - CIMPLICITY® Setup screen opens.

2. Click  Install HMI for CNC  10.

The Welcome screen displays.
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HMI for CNC setup will analyze your system. If an older or unknown version of this software exists, 

you will be instructed to remove it from your system to avoid conflicts with the newer version of the 

software.

3. Click Next.

The License Agreement screen displays.

4. Check I accept the terms of the license agreement.

5. Click Next  to accept all the terms of the license agreement.

The Important Product Information screen displays.

Recommendation:  Read all the information on this screen as it contains important information 

about the HMI for CNC software.

Note:  You can access a complete list of release notes through the HMI/SCADA - CIMPLICITY® 

Setup screen>View README option.

6. Click Yes.

The Ready to Install the Program screen displays.

7. Click Install.

The InstallShield Wizard begins to install HMI for CNC. Follow the installation prompts.

Step 6.2. Complete the HMI for CNC Installation
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When HMI for CNC and all of the selected components are installed the InstallShield Wizard Complete 

screen displays.

Click Finish.

Important:

Reboot your machine after you click Finish.

Result: After reboot, HMI for CNC and all selected components are installed and ready for configuration.

Step 7. Verify Successful Communications

• Command prompt commands.

• Communication verification.

Command  Prompt Commands

Ethernet

Type test_cnc  Address Portnum timeout

where:

Ad

dress=

CNC's IP Address or host name to connect. (e.g. 192.168.0.1 or CNCBRASSTAG)
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Port

num=

Port number of the DNC1/Ethernet (TCP) function. Important:  The port number cannot be less 

than 5001.

Time

out=

Time out in seconds. The best time out value is different depending on the system. For exam

ple, in the case of a hi-speed network, 10 seconds is sufficient for time out. But, in the case of a 

low-speed telephone line, more than 60 seconds is better for time out. So you must specify the 

timeout value after the measurement of the system.

HSSB

Type TEST_CNC  without parameters to display all the currently configured FOCAS/HSSB node(s).

Communication  Verification

1. Click Start on the Windows task bar.

2. Select (All) Programs> HMI SCADA - CIMPLICITY 10 >CNC QuikStart project.

3. Click Tools>Command prompt on the CNC QuikStart Workbench toolbar.

4. Test the CNC connections.

◦ Verify FOCAS/Ethernet.

◦ Verify FOCAS/HSSB.

Verify FOCAS/Ethernet

a. Type the following command at the command prompt.

test_cnc  Address Portnum timeout

a. Press Enter.

The status of the CNC connection is reported.

Ethernet Successful
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1 When a connection is successful, a line dis

plays:

Established communications.

2 Device details.

3 CNC Ethernet details.

Ethernet Failed

4 If the Ethernet connection fails, a message line  (on page 423)  displays ex

plaining the problem.

Example: (-16) Investigate address power/cable/board.

Verify FOCAS/HSSB
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1. Type the following command at the command prompt:

test_cnc

1. Press Enter.

The status of CNC connections is reported.

HSSB Successful

1 When a connection is successful, a line dis

plays:

Established communications with Node n.

2 CNC node details.

3 CNC HSSB details.
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HSSB failed

4 If the HSSB connection fails, a message line  (on page 423)  displays ex

plaining the problem.

Example: (-3) No FOCAS HSSB drivers, device all configured HSSB nodes.

Up  (on page 197)

Important:

You must be able to run the test_cnc program successfully before continuing.

Project Creation

Project Creation

CIMPLICITY software features are available for your HMI for CNC project.

These features can be created when you create a new project, modified or added to an existing project.

Steps to create or configure a HMI for CNC project are:

Step 1 

(on page 

201)

Create a new HMI for CNC project.

Step 2 

(on page 

204)

Set HMI for CNC Project Properties.
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Step 3 

(on page 

207)

Configure ports.

Step 4 

(on page 

211)

Configure devices.

Step 5 

(on page 

219)

Configure points.

o  (on page 

222)

Supported data types.

Step 6 

(on page 

299)

Configure screens.

Step 7 

(on page 

313)

Configure and view alarms.

Step 1. Create a new HMI for CNC Project

Step 1. Create a new HMI for CNC Project

Option 1.1 

(on page 

201)

Create a totally new HMI for CNC Project.

Option 1.2 

(on page 

202)

Copy the CNC QuikStart Project to a New Project.

Option 1.1. Create a totally new HMI for CNC Project

1. Open a CIMPLICITY Workbench.

a. Click Start  on the Windows task bar.

b. Select (All) Programs>HMI SCADA - CIMPLICITY 10>Workbench.
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A blank CIMPLICITY Workbench opens.

2. Click the New Project button  on the Workbench toolbar.

A New Project dialog box opens.

3. Select the features that apply to your HMI for CNC project.

Feature Description

Create (field) Directory in which the project directory should be created.

Project (Required) A unique name for the HMI for CNC project.

Options CIMPLICITY options that should be enabled for the HMI for CNC project.

Protocols Available CNC protocols can include:

◦ FOCAS/Ethernet

◦ FOCAS/HSSB

Create (but

ton)

Click to begin project creation.

Option 1.2. Copy the CNC QuikStart Project to a New Project
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Note:

The CNC QuikStart project is an HMI for CNC installation option.

1. Click Start on the Windows taskbar.

2. Select (All) Programs>HMI SCADA - CIMPLICITY 10>CNC QuikStart Project.

The CNC QuikStart project opens in the CIMPLICITY Workbench.

3. Click File>Copy to Project on the Workbench menu bar.

The Copy Project to New Project dialog box opens.

4. Do the following.
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A Select a directory for the project to be copied 

to.

B Enter a project name in the Project  field.

C Click Create.

The new project is created with the CNC QuikStart project configuration.

5. Click Project>Properties on the Workbench menu bar.

The Project Properties dialog box opens.

Step 2. Set HMI for CNC Project Properties

A  (on 

page 

204)

General tab in the Project Properties dialog box.

B  (on 

page 

205)

Options tab in the Project Properties dialog box.

1. General  tab in the Project Properties dialog box
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1. Select the General tab on the Project Properties dialog box.

2. Check options you want enabled in the project that are not already checked.

3. Check either or both of the FOCAS protocols.

Clear either protocol that you do not want enabled. One must be checked.

A FOCAS/Ethernet

B FOCAS/HSSB

a. Options  tab in the Project Properties dialog box

4. Select the Options tab on the Project Properties dialog box.

5. Enter the following.
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Feature Description

A De

scrip

tion

Description that identifies the project.

B Enable 

project 

broad

cast

Allow the project data to be "seen" over the network.

C Use 

this 

IP ad

dress

(Enabled if either Enable project broadcast or multicast is checked) The IP address 

that will be used in project broadcast/multicast can be entered in this field; this is 

used if you want to restrict the project announcements to only one IP address.

Note:  The drop-down list contains IP addresses that are selected for use on the Net

work tab in the CIMPLICITY® Options dialog box. The field is writable; an IP address 

that is not in the list can be entered manually.

D Com

puter 

name

Server on which the project is set up.
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Feature Description

Note:  The computer name defaults to the computer you are setting the project up 

on.

E Startup 

timeout

Number of minutes that CIMPLICITY should wait for the project to start before it 

times out. The default is 10 minutes. The project will continue to try and start up un

til the timer expires.

Note:  Other configuration features on the Options tab are optional for the HMI for CNC project.

6. Select the Settings tab.

7. Configure settings, as needed.

8. Click OK  in the Project Properties dialog box.

For a project created:

1. The properties are set.

2. The Workbench re-displays.

Step 3. Configure Ports

Create CNC ports for:

• Completely new projects.

• Projects created by copying the CNC QuikStart project.

CNC Ports for Completely  new projects
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1. Right-click Ports  in the Workbench left pane and select New on the Popup menu.

A New Port dialog box opens.

2. Create  either of the following.

Ethernet

HSSB

Ethernet

Field Select

Proto

col

FOCAS_ETHERNET

Port One of the available FETHn 

ports.

Ethernet  Port Guidelines

Each port that uses the Ethernet protocol can provide communication for up to 10  devices or a 

total of 100  devices.
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Each PC generally has a network adapter on which you can configure 10 Ethernet ports numbered 

0 – 9.

HSSB

Field Select

Proto

col

FOCAS_HSSB

Port One of the available HSSBn 

ports.

HSSB  Port Guidelines

Each port that uses the HSSB protocol can provide communication to only 1  physical device.

Each PC can have a maximum of 8  HSSB cards, or 4 dual-port HSSB cards, on which you can 

configure 8  HSSB ports numbered 0 – 7.
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3. Click OK.

A Port Properties dialog box opens.

Options for the port's general properties are the same as for other ports.

4. Click OK.

The port is added to the list in the Workbench right pane.

CNC Ports for Projects  created by copying the CNC QuikStart project

If you created the project by copying the CNC QuikStart project, this step may not be necessary.

The following ports are already added to the project.
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Protocol ID Port

A FOCAS_ETHERNET 

(on page 208)

MASTER_FETH<n>

B FOCAS_HSSB  (on 

page 209)

MASTER_HSSB<n>

Step 4. Configure Devices

Step 4. Configure Devices

Step 4.1 

(on page 

211)

Open a Device Properties dialog box.

Step 4.2 

(on page 

213)

Enter CNC Device General Properties.

Step 4.3 

(on page 

217)

Enter CNC Device Specific Proper

ties.

Step 4.1. Open a Device Properties Dialog Box

Open the Device Properties dialog box for:
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• A new device.

• An existing CNC device.

New  device

1. Right-click Devices  in the Workbench left pane and select New.

A New Device dialog box opens.

2. Enter the following information.

Field Description

De

vice

Enter a unique name.

Port Select one of the available ports 

for:

FOCAS/Ethernet MASTER_FETHn

FOCAS/HSSB MASTER_HSSBn

3. Click OK.
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Result: A Device Properties dialog box of for the selected port/protocol opens.

Existing  CNC device

4. Click Devices  in the Workbench left pane.

The existing devices are displayed in the Workbench right pane.

5. Double-click a device in the Workbench right pane.

Device Opens a Devices Properties dialog box for:

A Ethernet FOCAS/Ethernet

B HSSB FOCAS/HSSB

The Device Properties dialog box opens for the selected device.

Step 4.2. Enter CNC Device General Properties

Enter or modify general CNC device specifications as follows.

• HSSB devices.

• Ethernet devices.
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HSSB  devices

            

Field Description

Port The selected  port can be changed.

CNC HSSB port guidelines

Proto

col

FOCAS_HSSB

De

scrip

tion

Unique description that will display when the device description is available, e.g. in the Work

bench right-pane.

Re

source 

ID

The resource you want to associate with the device.

Important:

Because the device ID is not displayed in the Alarm Viewer, we strongly recommend 

that you create a meaningful and unique resource ID for each device. This ensures that 

you can identify alarm, operator, and macro messages for your devices in the Resource 

ID column in the Alarm Viewer. For detailed information about creating resources, refer 

to About Resources.

Model 

type

Available HSSB model types include:
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Field Description

• POWER_MATE_H

• POWER_MATEi_D

• POWER_MATEi_H

• SERIES_0i_M

• SERIES_0i_T

• SERIES_150_M

• SERIES_150_T

• SERIES_150_TT

• SERIES_150i_M

• SERIES_160/180/210_M

• SERIES_160/180/210_T

• SERIES_160/180_TT

• SERIES_160_MM

• SERIES_160i/180i/210i_M

• SERIES_160i/180i/210i_T

• SERIES_160/180i_P

• SERIES_160i/180i_TT

• SERIES_160i/180i_W

• SERIES_160i_L

• SERIES_160i_MM

• SERIES_160i_TTT

• SERIES_30i/31i/32i

Click Apply.

Result: The specifications are applied to the selected or new device.
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Ethernet  devices

Field Description

Port The selected port can be changed.

CNC Ethernet port guidelines

Proto

col

FOCAS_ETHERNET

De

scrip

tion

Unique description that will display when the device description is available, e.g. in the Work

bench right-pane.

Re

source 

ID

The resource you want to associate with the device.

Important:

Because the device ID is not displayed in the Alarm Viewer, we strongly recommend 

that you create a meaningful and unique resource ID for each device. This ensures that 

you can identify alarm, operator, and macro messages for your devices in the Resource 

ID column in the Alarm Viewer. For detailed information about creating resources, refer 

to About Resources.

Model 

type

Available Ethernet model types include:
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• POWER_MATEi_D

• POWER_MATEi_H

• SERIES_0i_M

• SERIES_0i_T

• SERIES_150i_M

• SERIES_160i/180i/210i_M

• SERIES_160i/180i/210i_T

• SERIES_160i/180i_P

• SERIES_160i/180i_TT

• SERIES_160i/180i_W

• SERIES_160i_L

• SERIES_160i_MM

• SERIES_160i_TTT

• SERIES_30i/31i/32i

Click Apply.

Result: The specifications are applied to the selected or new device.

Step 4.3. Enter CNC Device Specific Properties

The tab in the dialog box depends on the device's protocol.

• FOCAS/HSSB tab.

• FOCAS/Ethernet tab.

FOCAS/HSSB tab

1. Select the FOCAS/HSSB tab.

Selections on the tab depend on the Model type selected.

2. Enter the following.

Field Description

CNC Path *    For all models except:

◦ POWER_MATE_H

◦ POWER_MATEi_D

◦ POWER_MATEi_H
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Field Description

PMC Path **  For SERIES_30i/31i/32i only.

Enable De

vice

Controls communications capabili

ty.

Checked Enables communication.

Clear Disables communication.

3. Click OK.

Result: The device is configured and, if new, added to the list in the Workbench right-pane.

FOCAS/ETHERNET tab

Important:

The IP address or Host name and Port Number must match the CNC from which data is to 

be collected. Communications will fail if either field is entered incorrectly.

4. Select the FOCAS/Ethernet tab.

Selections on the tab depend on the Model type selected.

5. Enter the following.
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Field Description

IP Address IP address or Host name for the CNC from which data and alarms are to be col

lected.

Port Number Port number for the CNC.

Timeout CIMPLICITY attempts to connect with the device until the timer expires.

Unit Seconds

CNC Path *     For all models except:

◦ POWER_MATEi_D

◦ POWER_MATEi_H

PMC Path **  For SERIES_ 30i/31i/32i only

Enable De

vice

Controls communications capability.

Checked Enables communication.

Clear Disables communication.

6. Click OK.

Step 5. Configure Points

Step 5. Configure Points

1. Do one of the following to open a Point Properties dialog box for a CNC device point.

◦ A new point.

◦ An existing CNC point.

New  point for a CNC device

Note:

: Review supported  (on page 222)  data types before you configure points for a CNC 

device.

Using the correct data types is essential for making your project communicate with the device.

a. Right-click Points  in the Workbench left pane; select New on the Popup menu.
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A New Point dialog box opens.

a. Create  a new CNC device point.

The Point Properties dialog box opens for the new point.

Existing  CNC point

a. Click Points  in the Workbench left pane.

b. Double-click a point connected to a CNC device in the Workbench right pane.
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The Point Properties dialog box for the selected point opens.

Note:

The CNC QuikStart project contains more than 1500 pre-configured points.

If you use this project or copied it to a new HMI for CNC project, the points will be available for use.

2. Enter or make any required modifications to the CNC device point.

3. Click OK when you have completed configuration.

The Point Properties dialog box closes.

4. Click the Configuration Update button on the Workbench menu bar.
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The point is available for the project.

Supported Data Types

Supported Data Types

Descriptions of pre-configured and configured points for each of the CNC data types are as follows.

• Floating data.

• CNC data types.

Floating  data

All floating point data is actually stored on the CNC in two separate memory locations.

The two memory locations are:

1. A long integer that specifies the value.

2. A short integer that specifies the number of decimal places (for example, the precision).

Within CIMPLICITY software, these two integers are:

◦ Converted into a single 8-byte, double precision, floating point number and

◦ Stored in a REAL point.

Important:

The nature of floating point data is such that imprecision is likely in the least significant 

digits.

Therefore, when dealing with REAL points, it is not appropriate to use these points in conditions 

that involve EQUALS or NOT EQUALS.

Example

◦ It is not appropriate to test if REAL point A = 5 since the exact representation stored in A 

might be 5.000000000000001.

◦ It is appropriate to use the Less than or equal to  or Greater than or equal to  operators.

CNC  data types

Use any combination of pre-configured and configured points for each of the following CNC data 

types in your CIMPLICITY project.
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◦ Active program numbers.

◦ Actual axis feedrate / actual spindle speed.

◦ Axis position data (static, absolute, machine, and distance-to-go).

◦ Custom macro variable data.

◦ Diagnosis data.

◦ P Code macro variable data.

◦ Parameter data.

◦ Pitch error compensation data.

◦ PMC BMI bits.

◦ Skip data.

◦ Tool offset data.

◦ Work zero offset data.

◦ Tool Life Management data.

◦ Tool Management data.

Active Program Numbers

• Active main program number.

• Active program number.

• Active program sequence number.

Active  Main Program Number

Point Class ANA

LOG

Type DINT

Access READ

Valid Address

es

PM

Address Offset None

Active  Program Number

Point Class ANA

LOG

Type DINT
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Access READ

Valid Address

es

PN

Address Offset None

Active  Program Sequence Number

Point Class ANA

LOG

Type DINT

Access READ

Valid Address

es

SN

Address Offset None

Actual Axis Feedrate / Actual Spindle Speed

• Actual axis feed rate.

• Actual spindle speed.

Actual  axis feed rate

Point Class ANA

LOG

Type REAL

Access READ

Valid Address

es

AF

Address Offset None
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Actual  spindle speed

Note:

The Power Mate H and i-H CNC's do not support the actual spindle speed. The Power Mate i-D 

control does support the actual spindle speed.

Point Class ANALOG

Type DINT

Access READ

CNC Valid Address

es

Series 150, 160/180/210, 0i-A SS

Series 150i, 160i/180i/210i, 0i-B, 0i-C SS, SS1-SS4

Series 30i/31i/32i, 0i-D SS, SS1-SS8

Power Mate i-D SS

Address Offset None

Note:

The retrieval of actual spindle speed data is related to the following.

CNC Option Spindle Speed Data Related to:

M series of Series 160/180/210, 160i/180i/210i, 

30i/31i/32i, 0i, Power Mate i

Thread cutting, synchronous cutting

CNC Parameter Spindle Speed Data Related to:

Series 150 7613#0=1, 7613#2=1 (must be set)

Series 160/180/210, 160i/180i/210i, 0i A/B/C, Power 

Mate i

3118#0,#1,#2,#3 (influenced by setting) 4001#2 

(influenced by setting)

Series 30i/31i/32i, 0i-D 3799#2 (influenced by setting) 4001#2 (influ

enced by setting)
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Axis Position Data

Axis Position Data

Axis Position data 

points

Are read-on

ly.

• Points for axis positions attributes.

• Address specifications.

• Support for obtaining data.

Points  for axis positions attributes

When configuring these points, you must specify the following attributes.

• Static axis positions.

• Absolute axis positions.

• Distance-to-go axis positions.

• Machine axis positions.

Address  specifications

Address specifications for axis positions include the following.

Address specification Indicates

Two-letter prefix Position type

Number following the pre

fix

Particular axis.

Example

DA6 specifies Distance-to-Go axis number 6.

Support  for obtaining data

Support is provided for obtaining data from up to:
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Axes CNC

24 ax

es

Series 150/150i

8 axes Series 160/180/210, 160i/180i/210i, 0i-A/B/C

32 ax

es

Series 30i/31i/32i.

4 axes Series 0i-D

2 axes PowerMatei-D

6 axes PowermateH, iH

You will only be able to obtain data for the number of controlled axes that are configured in your CNC.

Example

If your CNC is currently configured for 3 controlled axes, you can define points for Machine Axis Positions 

MA1 - MA8. However, only points MA1, MA2, and MA3 will have values.

Relative Axis Positions

Point Class ANALOG

Type REAL

Access READ

CNC Valid Address

es

Series 150/150i  RA1-RA24

Series 160/180/210, 160i/180i/210i, 0i-A/B/C RA1-RA8

Series 30i/31i,32i RA1-RA32

Series 0i-D RA1-RA4

Power Mate i-D  RA1, RA2

Power Mate H, i-H RA1-RA6

Address Offset None
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Absolute Axis Positions

Point Class ANALOG

Type REAL

Access READ

CNC Valid Address

es

Series 150/150i AA1-AA24

Series 160/180/210, 160i/180i/210i, 0i-A/B/C AA1-AA8

Series 30i/31i,32i AA1-AA32

Series 0i-D AA1-AA4

Power Mate i-D AA1, AA2

Power Mate H, i-H AA1-AA6

Address Offset None

Distance-to-Go Axis Positions

Point Class ANALOG

Type REAL

Access READ

CNC Valid Address

es

Series 150/150i DA1-DA24

Series 160/180/210, 160i/180i/210i, 0i-A/B/C DA1-DA8

Series 30i/31i,32i DA1-DA32

Series 0i-D DA1-DA4

Power Mate i-D DA1, DA2

Power Mate H, i-H DA1-DA6

Address Offset None
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Machine Axis Positions

Point Class ANALOG

Type REAL

Access READ

CNC Valid Address

es

Series 150150i MA1-MA24

Series 160/180/210, 160i/180i/210i, 0i-A/B/C MA1-MA8

Series 30i/31i,32i MA1-MA32

Series 0i-D MA1-MA4

Power Mate i-D MA1, MA2

Power Mate H, i-H MA1-MA6

Address Offset None

Custom Macro Variable Data

Note:

Bits for Custom Macro variables are purchase options.

• Custom Macro Variable guidelines.

• Custom Macro Variable attributes.

• Custom Macro Variable restrictions.

Custom  Macro Variable guidelines

Vari

able 

Type

Guidelines

Local You cannot write Local  common variables (CMV1-CMV33).
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Vari

able 

Type

Guidelines

Va

cant

Individual custom macro variables may be vacant  on the CNC. Vacant macro variables are not 

currently assigned a value. A point that is reading a vacant custom macro variable will have a 

value of 0.

Custom  Macro Variable attributes

When configuring points for Custom Macro Variable Data, specify the following attributes:

Point Class ANALOG

Type REAL

Access READ or READ/WRITE

CNC Valid Addresses Variable Types

Series 150 M/T CMV1-CMV33 Local Macro Variables

CMV100-CMV149, CMV500-CMV531 Macro Variable

CMV100 - CMV149, CMV500 - CMV549 

or

CMV100 - CMV199, CMV500 - CMV599 

or

CMV100 - CMV199, CMV500 - CMV699 

or

CMV100 - CMV199, CMV500 - CMV999 

or

CMV1000-CMV9999 System Macro Variables

Series 150i CMV1 - CMV33 Local Macro Variables

CMV100 - CMV199, CMV500 - CMV999 

or

Macro Variables

CMV100 - CMV199, CMV200 - CMV999 

or

CMV1000-CMV9999 System Macro Variables
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Series 15TT CMV1 - CMV33 Local Macro Variables

CMV100 - CMV149, CMV500 - CMV524 

or

Macro Variables

CMV100 - CMV149, CMV500 - CMV549 

or

CMV100 - CMV149, CMV500 - CMV599 

or

CMV100 - CMV149, CMV500 - CMV749 

or

CMV1000-CMV9999 System Macro Variables

Series 160/180, 

160i/180i, 0i

CMV1 - CMV33 Local Macro Variables

CMV100 - CMV149, CMV500 - CMV531 

or

Macro Variables

CMV100 - CMV199, CMV500 - CMV999 

or

CMV100 - CMV199, CMV500 - CMV599 

or

CMV1000-CMV9999 System Macro Variables

Series 160i/180i W CMV1 - CMV33 Local Macro Variables

CMV100 - CMV149, CMV500 - CMV531 

or

Macro Variables

CMV100 - CMV314, CMV500 - CMV699 

or

CMV100 - CMV149, CMV500 - CMV699 

or

CMV100 - CMV314, CMV500 - CMV531 

or

CMV100 - CMV149, CMV500 - CMV999 

or
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CMV100 - CMV314, CMV500 - CMV999 

or

CMV1000-CMV9999 System Macro Variables

Series 30i/31i/32i CMV1 - CMV33 Local Macro Variables

CMV100 - CMV149, CMV500 - CMV549 

or

Macro Variables

CMV100 - CMV199, CMV500 - CMV999 

or

CMV100 - CMV149, CMV200 - CMV499, 

CMV500 - CMV549 or

CMV100 - CMV199, CMV200 - CMV499, 

CMV500 - CMV999 or

CMV1000-CMV9999 System Macro Variables

Power Mate, Power 

Mate i-D/H

CMV1 - CMV33 Local Macro Variables

CMV100 - CMV149, CMV500 - CMV549 

or

Macro Variables

CMV100 - CMV199, CMV500 - CMV999 

or

CMV100 - CMV149, CMV200 - CMV499, 

CMV500 - CMV549 or

CMV100 - CMV199, CMV200 - CMV499, 

CMV500 - CMV999 or

CMV1000-CMV9999 System Macro Variables

Address Offset None

Note:

CIMPLICITY supports the system macro variable range of 1000-9999. However each CNC 

configuration may not support this range of address; that support depends on your physical 

devices and configuration.
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Custom  Macro Variable restrictions

guide:

 Guidelines

When writing P Code Macro Variables that support the real (floating-point) data type, please be aware that 

the available range is 999999999,...,-999999999.

Diagnosis Data

Diagnosis Data

• Diagnosis information for point configuration.

• Control manual required information for point configuration.

• Restrictions for configuring points as diagnosis.

Diagnosis  information for point configuration

After you have determined this information, you may configure points using the following information:

• Bit Diagnosis (no axis).

• Bit Diagnosis (with axis).

• Byte Diagnosis (no axis).

• Byte Diagnosis (with axis).

• Word Diagnosis (no axis).

• Word Diagnosis (with axis).

• Longword (2-word) Diagnosis (no axis).

• Longword (2-word) Diagnosis (with axis).

• Real (4-word) Diagnosis (no axis).

• Real (4-word) Diagnosis (with axis).

Control  manual required information for point configuration

Before configuring a point, refer to the Maintenance Manual for your control type (Series 15, Series 16 or 

Power Mate) to determine the following information.

• Is the CNC diagnosis a bit, byte, word, longword (2-word) or real (4-word) data?

• Does the CNC diagnosis contain signed or unsigned data?

• Does the CNC diagnosis have data for every axis or is there just a single value?
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Restrictions  for configuring points as diagnosis

When configuring points as diagnosis, be aware of the following restrictions:

• You cannot configure points as array points for diagnosis data.

• You cannot write to diagnosis data.

• In general, most CNC diagnosis data contain "SIGNED" data, so you should use the equivalent 

signed point type (SINT, INT, or DINT).

• Valid diagnosis addresses are 0 &endash; 6,200.

Important:

CIMPLICITY HSSB and Ethernet device points for diagnosis data should be configured according 

to the instructions in the appropriate CNC Controller Maintenance Manual.

Bit Diagnosis (no axis)

Point Class DIGITAL

Type BOOL

Access READ

Valid Address

es

DNx, where x is a valid diagnosis number for a bit diagnosis

Address Offset 0-7, depending upon which bit you want to access

Bit Diagnosis (with axis)

Point Class DIGITAL

Type BOOL

Access READ

Valid Address

es

DNxAy, where x is a valid diagnosis number for a bit diagnosis, and y is the particular 

axis number

Address Off

set

0-7, depending upon which bit you want to access
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Byte Diagnosis (no axis)

Point Class ANALOG

Type SINT for signed data; USINT for unsigned data

Access READ

Valid Address

es

DNx, where x is a valid diagnosis number for a byte diagnosis

Address Offset N/A

Byte Diagnosis (with axis)

Point Class ANALOG

Type SINT for signed data; USINT for unsigned data

Access READ

Valid Ad

dresses

DNxAy, where x is a valid diagnosis number for a byte diagnosis, and y is the particular 

axis number

Address Off

set

N/A

Word Diagnosis (no axis)

Point Class ANALOG

Type INT for signed data; UINT for unsigned data

Access READ

Valid Address

es

DNx, where x is a valid diagnosis number for a word diagnosis

Address Offset N/A

Word Diagnosis (with axis)

Point Class ANALOG
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Type INT for signed data; UINT for unsigned data

Access READ

Valid Ad

dresses

DNxAy, where x is a valid diagnosis number for a word diagnosis, and y is the particular 

axis number

Address Off

set

N/A

Longword (2-word) Diagnosis (no axis)

Point Class ANALOG

Type DINT for signed data; UDINT for unsigned data

Access READ

Valid Address

es

DNx, where x is a valid diagnosis number for a longword diagno

sis

Address Offset N/A

Longword (2-word) Diagnosis (with axis)

Point Class ANALOG

Type DINT for signed data; UDINT for unsigned data

Access READ

Valid Ad

dresses

DNxAy, where x is a valid diagnosis number for a longword diagnosis, and y is the partic

ular axis number

Address Off

set

N/A

Real (4-word) Diagnosis (no axis)

Point Class ANALOG

Type REAL

Access READ
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Valid Address

es

DNx, where x is a valid diagnosis number for a real word diagno

sis

Address Offset N/A

Real (4-word) Diagnosis (with axis)

Point Class ANALOG

Type REAL

Access READ

Valid Ad

dresses

DNxAy, where x is a valid diagnosis number for a real diagnosis, and y is the particular 

axis number

Address Off

set

N/A

P Code Macro Variable Data

P Code Macro Variable Data

Important:

• Before you configure P Code Macro variable data, please review the Macro Compiler/Macro 

Executor Programming Manual for details on how to configure your CNC.

• Series 150i and Power Mate are not supported for P Code macro variable data.

Points for P code macro variable da

ta

Are read and write in the P Code Macro variable ta

ble.

On the CNC, individual P code macro variables may be vacant (i.e. they are not currently assigned a 

value).

A point that is reading a vacant P code macro variable has a value of 0.

When configuring these points, you must specify the following attributes:

• P Code Macro Variable 10000-Type A

• P Code Macro Variable 10000-Type B
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• P Code Macro Variable 20000-Type A

• P Code Macro Variable 20000-Type B

• P Code Macro Variable 20000-Type C

• P Code Macro Variable 20000-Type D.

• P Code Macro Variable 30000-Type A

• P Code Macro Variable 30000-Type B.

• P Code Macro Variable 40000-Type A

• P Code Macro Variable 40000-Type B.

guide:

 Guidelines

When writing P Code Macro Variables that support the real (floating-point) data type, please be aware that 

the available range is 999999999,...,-999999999.

P Code Macro Variable 10000-Type A

Point Class ANALOG

Type REAL (8 bytes)

Access READ or READ/WRITE

CNC Valid Addresses

Series 160/180/210, 160i/180i/210i, 0i-A/B/C PMV10000-PMV75535

Series 30i/31i/32i, 0i-D PMV10000-PMV19999

Power Mate i PMV10000-PMV75535

Address Offset None

P Code Macro Variable 10000-Type B

Point Class ANALOG

Type INT (2 bytes)

Access READ or READ/WRITE

CNC Valid Addresses
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Series 30i/31i/32i, 0i-D PMV20000-PMV89999

Address Offset None

P Code Macro Variable 20000-Type A

Point Class ANALOG

Type REAL (8 bytes)

Access READ or READ/WRITE

CNC Valid Addresses

Series 160/180/210, 160i/180i/210i, 0i PMV20000-PMV85535

Power Mate i PMV20000-PMV85535

Address Offset None

P Code Macro Variable 20000-Type B

Point Class ANALOG

Type INT (2 bytes)

Access READ or READ/WRITE

CNC Valid Addresses

Series 160/180/210, 160i/180i/210i, 0i PMV20000-PMV85535

PMV20000-PMV85535 PMV20000-PMV85535

Power Mate i PMV20000-PMV85535

Address Offset None

P Code Macro Variable 20000-Type C

Point Class ANALOG

Type INT (2 bytes)

Access: READ or READ/WRITE

CNC Valid Addresses
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Series 160/180, 160i/180i PMV20000-PMV85535

Address Offset None

P Code Macro Variable 20000-Type D

Point Class ANALOG

Type INT (2 bytes)

Access READ or READ/WRITE

CNC Valid Addresses

Series 160/180, 160i/180i PMV20000-PMV85535

Address Offset None

P Code Macro Variable 30000-Type A

Point Class ANALOG

Type INT (2 bytes)

Access READ or READ/WRITE

CNC Valid Addresses

Series 150 PMV30000-PMV95535

Address Off

set

None

P Code Macro Variable 30000-Type B

Point Class ANALOG

Type INT (2 bytes)

Access READ or READ/WRITE

CNC Valid Addresses

Series 150 PMV30000-PMV95535
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Address Off

set

None

P Code Macro Variable 40000-Type A

Point Class ANALOG

Type REAL (8 bytes)

Access READ or READ/WRITE

CNC Valid Addresses

Series 150 PMV40000-PMV105535

Address Off

set

None

P Code Macro Variable 40000-Type B

Point Class ANALOG

Type INT (2 bytes)

Access READ or READ/WRITE

CNC Valid Addresses

Series 150 PMV40000-PMV105535

Address Off

set

None

Parameter Data

Parameter Data

You can configure points to read and write parameters in the parameter table.

• Parameter information for point configuration.

• Control manual required information for point configuration.

• Restrictions for configuring points as parameters.

• Write Enable Bit Parameter.
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Parameter  information for point configuration

Use the control manual and following parameter information to configure points.

• Bit Parameters (no axis).

• Bit Parameters (with axis).

• Byte Parameters (no axis).

• Byte Parameters (with axis).

• Word Parameters (no axis).

• Word Parameters (with axis).

• Longword (2-word) Parameters (no axis).

• Longword (2-word) Parameters (with axis).

• Real (4-word) Parameters (no axis).

• Real (4-word) Parameters (with axis).

Control  manual required information for point configuration

Before configuring a point, refer to the Parameter Manual for your CNC to determine the following 

information:

• Is the CNC parameter a bit, byte, word, longword (2-word) or real (4-word) parameter?

• Does the CNC parameter contain signed or unsigned data?

• Does the CNC parameter have data for every axis (an axis  parameter), or is there just a single 

value?

Restrictions  for configuring points as parameters

When configuring points as parameters, be aware of the following restrictions:

• Points cannot be configured as array points for parameters.

• The default behavior of the HMI for CNC product is to check the Parameter Write Enable bit (the 

"PWE" bit) before writing any parameter data. Thus, if the Parameter Write Enable bit is not set, 

any setpoints for parameters will fail. You can override the default behavior by forcing CIMPLICITY 

software to ignore the Parameter Write Enabler bit  (on page 243) .

• In general, most CNC parameters contain SIGNED  data, so you should use the equivalent signed 

point type (SINT, INT, or DINT).

• Valid parameter addresses are 0 &endash; 16,000.
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Note:

CIMPLICITY HSSB and Ethernet device points for parameter data should be configured according 

to the instructions in the appropriate CNC Controller Parameter Manual.

Write Enable Bit Parameter

The default behavior of the HMI for CNC product is to check the Parameter Write Enable (PWE) bit before 

allowing CIMPLICITY to write any points that are configured to access the CNC parameter table.

You can override the default behavior and allow CIMPLICITY software to always write to the parameter 

table through the global parameter DC_CHECK_PWE.

1. Stop the CIMPLICITY project if it is running.

2. Do the following.

A Expand the Advanced folder in the Workbench left pane.

B Expand the Global Parameters folder.

C Select Project

D Change the valueof the appropriate global parameter to N as fol

lows
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Single controllers DC_CHECK_PWE

Dual path controllers One of the following:

◦ DC_CHECK_PWE

◦ DC_CHECK_PWE2

Multi-path controllers One of the following:

◦ DC_CHECK_PWE

◦ DC_CHECK_PWE2

◦ DC_CHECK_PWE<n>

Where n = 3, 4, 5, 6, 7, 8, 9, or 10

3. Click the Run button  on the Workbench toolbar to restart the project.

4. Update the project configuration files when prompted.

Bit Parameters (no axis)

Point Class DIGITAL

Type BOOL

Access READ or READ/WRITE

Valid Address

es

PAx, where x is a valid parameter number for a bit parame

ter.

Address Offset 0-7, depending upon which bit you want to access

Bit Parameters (with axis)

Point Class DIGITAL

Type BOOL

Access READ or READ/WRITE

Valid Ad

dresses

PAxAy, where x is a valid parameter number for a bit parameter, and y is the particular 

axis number

Address Off

set

0-7, depending upon which bit you want to access
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Byte Parameters (no axis)

Point Class ANALOG

Type SINT for signed data; USINT for unsigned data

Access READ or READ/WRITE

Valid Address

es

PAx, where x is a valid parameter number for a byte parame

ter

Address Offset N/A

Byte Parameters (with axis)

Point Class ANALOG

Type SINT for signed data; USINT for unsigned data

Access READ or READ/WRITE

Valid Ad

dresses

PAxAy, where x is a valid parameter number for a byte parameter, and y is the particular 

axis number

Address Off

set

N/A

Word Parameters (no axis)

Point Class ANALOG

Type INT for signed data; UINT for unsigned data

Access READ or READ/WRITE

Valid Address

es

PAx, where x is a valid parameter number for a word parame

ter

Address Offset N/A

Word Parameters (with axis)

Point Class ANALOG
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Type INT for signed data; UINT for unsigned data

Access READ or READ/WRITE

Valid Ad

dresses

PAxAy, where x is a valid parameter number for a word parameter, and y is the particular 

axis number

Address Off

set

N/A

Longword (2-word) Parameters (no axis)

Point Class ANALOG

Type DINT for signed data; UDINT for unsigned data

Access READ or READ/WRITE

Valid Address

es

PAx, where x is a valid parameter number for a longword parame

ter

Address Offset N/A

Longword (2-word) Parameters (with axis)

Point Class ANALOG

Type DINT for signed data; UDINT for unsigned data

Access READ or READ/WRITE

Valid Ad

dresses

PAxAy, where x is a valid parameter number for a longword parameter, and y is the par

ticular axis number

Address Off

set

N/A

Real (4-word) Parameters (no axis)

Point Class ANALOG

Type REAL

Access READ or READ/WRITE
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Valid Address

es

PAx, where x is a valid parameter number for a real parame

ter

Address Offset N/A

Real (4-word) Parameters (with axis)

Point Class ANALOG

Type REAL

Access READ or READ/WRITE

Valid Ad

dresses

PAxAy, where x is a valid parameter number for a real parameter, and y is the particular 

axis number

Address Off

set

N/A

Pitch Error Compensation Data

Note:

The pitch error compensation is a purchase option.

• Pitch Error Compensation entry numbers and values.

• Pitch Error Compensation attributes.

Pitch  Error Compensation entry numbers and values

Each entry in the Pitch Error Compensation table has the following.

  Entry for CNC Has a unique  number be

tween

Has an allowed assigned  value be

tween

Series 150 0 and 1279 -7 and 7

Series 150i 0 and 1279 -128 and 127

Series 160/180/210, 160i/180i/210i, 0i-

A/B/C

0 and 1023 -7 and 7

Series 30i/31i/32i 0 and 1535 -128 and 127
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Series 0i-D 0 and 1023 -7 and 7

Power Mate i-D 0 and 1023 -7 and 7

Pitch  Error Compensation attributes

When configuring points for Pitch Error Compensation, specify the following attributes.

Note:

The Power Mate H and Power Mate i-H CNC's do not support pitch error compensation attributes.

Point Class: ANALOG

Type: SINT

Access: READ or READ/WRITE

CNC Valid Addresses

Series 150 PEC0000 - PEC1279

Series 150i PEC0000 - PEC1279

Series 160/180/210, 160i/180i/210i, 0i PEC0000 - PEC1023

Series 30i/31i/32i PEC0000 - PEC1535

Power Mate i-D PEC0000 - PEC1023

PMC BMI Bits

PMC BMI Bits

PMC data is frequently referred to as BMI Bits.

• Details about PMC BMI Bits.

• Guidelines for PMC BMI Bits points.

• Series 150 CNC's and Motorola vs. Intel standards.
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Details  about PMC BMI Bits

G  (on 

page 

251)

G Data

F  (on 

page 

253)

F Data

X  (on 

page 

257)

X Data

Y  (on 

page 

255)

Y Data

R  (on 

page 

261)

R Data

A  (on 

page 

259)

A Data

T  (on 

page 

263)

T Data

K  (on 

page 

265)

K Data

C  (on 

page 

267)

C Data

D  (on 

page 

270)

D Data
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E  (on 

page 

271)

E Data

Guidelines  for PMC BMI Bits points

You can configure:

• Points that read and write individual bits of data using digital points.

• Analog points that access PMC data locations as individual bytes, words (2 bytes), or longwords (4 

bytes) of data at a time.

• Digital points to access bits of data.

CIMPLICITY accesses the memory location as a byte.

In order to specify the particular bit, set the Address Offset  field to a value between 0 and 7,

Where

0 specifies the least significant bit and

7 specifies the most significant bit.

• Analog points to access 1, 2, or 4 bytes of data at a time.

Do not set the Address Offset  field.

Series  150 CNC's and Motorola vs. Intel Standards

Important:

Due to the different standards between Motorola and Intel, Series 150 CNC's that use PMC type 

NA will swap the high and low order bytes of each word. This issue was resolved in a previous 

HMI for CNC software release. All analog points configured to reference PMC BMI Bits data 

locations as words (2 bytes) or longwords (4 bytes) are converted as follows:
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G Data

• G Data definition.

• Digital points to reference individual bits configuration.

• Analog points to reference individual bytes, words, or longwords configuration.

• Supported addresses

G Data  definition

G Data Is information sent:

From PMC

To CNC

G data points Are read and write

Digital  points to reference individual bits

Point Class DIGITAL

Type BOOL

Access READ or READ/WRITE

Valid Address

es

Gxxxx, where xxxx is a valid address for your PMC 

type

Address Offset 0-7, for the particular bit you want to reference

Analog  points to reference individual bytes, words, or longwords

Point Class ANALOG

Type SINT, INT, or DINT (1, 2, or 4 bytes)

Access READ or READ/WRITE

Valid Address

es

Gxxxx, where xxxx is a valid address for your PMC 

type

Address Offset none
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Supported  addresses

CNC PMC Type Valid Address Range

Series 150 NA/NB/NB2 G0000-G0511

Series 

150i

NB6 G0000-G0511 G1000-G1511

Series 

160/180-

B/C

SA1/SB3/SB5/SC3 G0000-G0255 G1000-G1255

SB4/SB6/SC4 G0000-G0511 G1000-G1511 G2000-G2511

Series 

210-B, 0i-A

SA1/SA3 G0000-G0255 G1000-G1255

Series 

160i/180i, 

0i-B(SB7)

SB5 G0000-G0255 G1000-G1255

SB6 G0000-G0511 G1000-G1511 G2000-G2511

SB7 G0000-G0767 G1000-G1767 G2000-G2767

Series 

210i, 0i-

B(SA1)

SA1/SA5 G0000-G0255 G1000-G1255

Series 0i-D PMC G0000-G0767 G1000-G1767 G2000-G2767 

G3000-G3767 G4000-G4767 G5000-G5767 

G6000-G6767 G7000-G7767 G8000-G8767 

G9000-G9767

PMC/L G0000-G0767 G1000-G1767

Series 

Mate 0i-D

PMC/L G0000-G0767 G1000-G1767

Power 

Mate

All G0000-G0255 G1000-G1255

Power 

Mate i

SB5 G0000-G0255 G1000-G1255
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CNC PMC Type Valid Address Range

SB6 G0000-G0511 G1000-G1511 G2000-G2511

CNC 1st PMC *2nd PMC *3rd PMC

Series 

30i/31i/32i

G0000-G0767 G1000-G1767 

G2000-G2767 G3000-G3767 

G4000-G4767 G5000-G5767 

G6000-G6767 G7000-G7767 

G8000-G8767 G9000-G9767

G0000-G0767 G1000-G1767 

G2000-G2767 G3000-G3767 

G4000-G4767 G5000-G5767 

G6000-G6767 G7000-G7767 

G8000-G8767 G9000-G9767

G0000-G0767 G1000-G1767 

G2000-G2767 G3000-G3767 

G4000-G4767 G5000-G5767 

G6000-G6767 G7000-G7767 

G8000-G8767 G9000-G9767

* Optional.

F Data

• F Data definition.

• Digital points to reference individual bits configuration.

• Analog points to reference individual bytes, words, or longwords configuration.

• Supported addresses.

F Data  definition

F Data Is information sent:

From CNC

To PMC

F data points Are read-only

Digital  points to reference individual bits

Point Class DIGITAL

Type BOOL

Access Read-only

Valid Address

es

Fxxxx, where xxxx is a valid address for your PMC 

type

Address Offset 0-7, for the particular bit you want to reference
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Analog  points to reference individual bytes, words, or longwords configuration

Point Class ANALOG

Type SINT, INT, or DINT (1, 2, or 4 bytes)

Access Read-only

Valid Address

es

Fxxxx, where xxxx is a valid address for your PMC 

type

Address Offset none

Supported  addresses

CNC PMC Type Valid Address Range

Series 150 NA F0000-F0319

NB/NB2 F0000-F0511

Series 

150i

NB6 F0000-F0511 F1000-F1511

Series 

160/180-

B/C

SA1/SB3/SB5/SC3 F0000-F0255 F1000-F1255

SSB4/SB6/SC4 F0000-F0511 F1000-F1511 F2000-F2511

Series 

210-B, 0i-A

SA1/SA3 F0000-F0255 F1000-F1255

Series 

160i/180i, 

0i-B(SB7)

SB5 F0000-F0255 F1000-F1255

SB6 F0000-F0511 F1000-F1511 F2000-F2511

SB7 F0000-F0767 F1000-F1767 F2000-F2767

Series 

210i, 0i-

B(SA1)

SA1/SA5 F0000-F0255 F1000-F1255
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CNC PMC Type Valid Address Range

Series 0i-D PMC F0000-F0767 F1000-F1767 F2000-F2767 F3000-

F3767 F4000-F4767 F5000-F5767 F6000-F6767 

F7000-F7767 F8000-F8767 F9000-F9767

PMC/L F0000-F0767 F1000-F1767

Series 

Mate 0i-D

PMC/L F0000-F0767 F1000-F1767

Power 

Mate

All F0000-F0255 F1000-F1255

Power 

Mate i

SB5 F0000-F0255 F1000-F1255

SB6 F0000-F0511 F1000-F1511 F2000-F2511

CNC 1st PMC *2nd PMC *3rd PMC

Series 

30i/31i/32i

F0000-F0767 F1000-F1767 

F2000-F2767 F3000-F3767 

F4000-F4767 F5000-F5767 

F6000-F6767 F7000-F7767 

F8000-F8767 F9000-F9767

F0000-F0767 F1000-F1767 

F2000-F2767 F3000-F3767 

F4000-F4767 F5000-F5767 

F6000-F6767 F7000-F7767 

F8000-F8767 F9000-F9767

F0000-F0767 F1000-F1767 

F2000-F2767 F3000-F3767 

F4000-F4767 F5000-F5767 

F6000-F6767 F7000-F7767 

F8000-F8767 F9000-F9767

* Optional

Y Data

• Y Data definition.

• Digital points to reference individual bits configuration.

• Analog points to reference individual bytes, words, or longwords configuration.

• Supported addresses.

Y Data  definition

Y Data Is output data:

From PMC

To Machine tool



Addons and Options  | 3 - HMI for CNC  | 256

Y data points Are read and write.

Digital  points to reference individual bits

Point Class DIGITAL

Type BOOL

Access READ or READ/WRITE

Valid Address

es

Yxxxx, where xxxx is a valid address for your PMC 

type

Address Offset 0-7, for the particular bit you want to reference

Analog  points to reference individual bytes, words, or longwords

Point Class ANALOG

Type SINT, INT, or DINT (1, 2, or 4 bytes)

Access: READ or READ/WRITE

Valid Address

es

Yxxxx, where xxxx is a valid address for your PMC 

type

Address Offset none

Supported  addresses

CNC PMC Type Valid Address Range

Series 150 NA/NB/NB2 Y0000-Y0127

Series 

150i

NB6 Y0000-Y0127 Y0200-Y0327

Series 

160/180-

B/C

SA1/SB3/SB4/SB5/SB6/SC3/SC4 Y0000-Y0127 Y1000-Y1014 Y1020-Y1034

Series 

210-B, 0i-A

SA1/SA3 Y0000-Y0127 Y1000-Y1008
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CNC PMC Type Valid Address Range

Series 

160i/180i, 

0i-B(SB7)

SB5/SB6/SB7 Y0000-Y0127

SB6/SB7 Y0200-Y0327

Series 

210i, 0i-

B(SA1)

SA1/SA5 Y0000-Y0127

Series 0i-D PMC Y0000-Y0127 Y0200-Y0327

PMC/L Y0000-Y0127

Series 

Mate 0i-D

PMC/L Y0000-Y0127

Power 

Mate

All Y0000-Y0127 Y1000-Y1063

Power 

Mate i

SB5/SB6 Y0000-Y0127 Y1000-Y1002 Y1020-Y1051

CNC 1st PMC *2nd PMC *3rd PMC

Series 

30i/31i/32i

Y0000-Y0127 Y0200-Y0327 

Y0400-Y0527 Y0600-Y0727 

Y1000-Y1127**

Y0000-Y0127 Y0200-Y0327 

Y0400-Y0527 Y0600-Y0727 

Y1000-Y1127**

Y0000-Y0127 Y0200-Y0327 

Y0400-Y0527 Y0600-Y0727 

Y1000-Y1127**

*     Optional

**    Y1000-Y1127 is reserved for PMC management software. No I/O can be allocated in this area. Do not 

use it in user programs.

X Data

• X Data definition.

• Digital points to reference individual bits configuration.

• Analog points to reference individual bytes, words, or longwords configuration.

• Supported addresses.
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X Data  definition

X Data Is input data:

From Machine tool

To PMC

X data points Are read only

Digital  points to reference individual bits

Point Class DIGITAL

Type BOOL

Access Read only

Valid Address

es

Xxxxx, where xxxx is a valid address for your PMC 

type

Address Offset 0-7, for the particular bit you want to reference

Analog  points to reference individual bytes, words, or longwords

Point Class ANALOG

Type SINT, INT, or DINT (1, 2, or 4 bytes)

Access Read only

Valid Address

es

Xxxxx, where xxxx is a valid address for your PMC 

type

Address Offset none

Supported  addresses

CNC PMC Type Valid Address Range

Series 150 NA/NB/NB2 X0000-X0127

Series 

150i

NB6 X0000-X0127 X0200-X0327
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CNC PMC Type Valid Address Range

Series 

160/180-

B/C

SA1/SB3/SB4/SB5/SB6/SC3/SC4 X0000-X0127 X1000-X1019 X1020-X1039

Series 

210-B, 0i-A

SA1/SA3 X0000-X0127 X1000-X1011

Series 

160i/180i, 

0i-B(SB7)

SB5/SB6/SB7 X0000-X0127

SB6/SB7 X0200-X0327

Series 

210i, 0i-

B(SA1)

SA1/SA5 X0000-X0127

Series 0i-D PMC X0000-X0127 X0200-X0327

PMC/L X0000-X0127

Series 

Mate 0i-D

PMC/L X0000-X0127

Power 

Mate

All X0000-X0127 X1000-X1063

Power 

Mate i

SB5/SB6 X0000-X0127 X1000-X1003 X1020-X1051

CNC 1st PMC *2nd PMC *3rd PMC

Series 

30i/31i/32i

X0000-X0127 X0200-X0327 

X0400-X0527 X0600-X0727 

X1000-X1127**

X0000-X0127 X0200-X0327 

X0400-X0527 X0600-X0727 

X1000-X1127**

X0000-X0127 X0200-X0327 

X0400-X0527 X0600-X0727 

X1000-X1127**

*     Optional

**    X1000-X1127 is reserved for PMC management software. No I/O can be allocated in this area. Do not 

use it in user programs.

A Data
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• A Data definition.

• Digital points to reference individual bits configuration.

• Analog points to reference individual bytes, words, or longwords configuration.

• Supported addresses.

A Data  definition

A Data Is for message demand.

A data points Are read and write.

Digital  points to reference individual bits

Point Class DIGITAL

Type BOOL

Access Read or Read/Write

Valid Address

es

Axxxx, where xxxx is a valid address for your PMC 

type

Address Offset 0-7, for the particular bit you want to reference

Analog  points to reference individual bytes, words, or longwords

Point Class ANALOG

Type SINT, INT, or DINT (1, 2, or 4 bytes)

Access Read or Read/Write

Valid Address

es

Axxxx, where xxxx is a valid address for your PMC 

type

Address Offset none

Supported  addresses

CNC PMC Type Valid Address Range

Series 150 NA/NB A0000-A0024

NB2 A0000-A0124

Series 150i NB6 A0000-A0124



Addons and Options  | 3 - HMI for CNC  | 261

CNC PMC Type Valid Address Range

Series 160/180-B/C SA1/SB3/SB5/SC3 A0000-A0024

SB4/SB6/SC4 A0000-A0124

Series 210-B, 0i-A SA1/SA3 A0000-A0024

SB5 A0000-A0024Series 160i/180i, 0i-B(SB7)

SB6 A0000-A0124

SB7 A0000-A0249, A9000-A9249

Series 210i, 0i-B(SA1) SA1/SA5 A0000-A0024

Series 0i-D All A0000-A0249 A9000-A9249

Series Mate 0i-D PMC/L A0000-A0249 A9000-A9249

Power Mate All A0000-A0024

Power Mate i SB5 A0000-A0024

SB6 A0000-A0124

CNC 1st PMC *2nd PMC *3rd PMC

Series 30i/31i/32i

Message Display A0000-A0249 A0000-A0249 A0000-A0249

Status Display A9000-A9249 A9000-A9249 A9000-A9249

*  Optional

**

R Data

• R Data definition.

• Digital points to reference individual bits configuration.

• Analog points to reference individual bytes, words, or longwords configuration.

• Supported addresses.
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R Data  definition

R Data Is for internal re

lays.

R data points Are read and write.

Digital  points to reference individual bits

Point Class DIGITAL

Type BOOL

Access Read or Read/Write

Valid Address

es

Rxxxx, where xxxx is a valid address for your PMC 

type

Address Offset 0-7, for the particular bit you want to reference

Analog  points to reference individual bytes, words, or longwords

Point Class ANALOG

Type SINT, INT, or DINT (1, 2, or 4 bytes)

Access Read or Read/Write

Valid Address

es

Rxxxx, where xxxx is a valid address for your PMC 

type

Address Offset none

Supported  addresses

CNC PMC Type Valid Address Range

Series 150 NA R0000-R0999 R2000-R2999

NB R0000-R1499 R9000-R9117

NB2 R0000-R2999 R9000-R9199

Series 150i NB6 R0000-R2999 R9000-R9199

Series 160/180-B/C SA1 R0000-R0999 R9000-R9099
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CNC PMC Type Valid Address Range

SB3/SB5/SC3 R0000-R1499 R9000-R9117

SB4/SB6/SC4 R0000-R2999 R9000-R9199

Series 210-B, 0i-A SA1 R0000-R0999 R9000-R9099

SA3 R0000-R0999 R9000-R9117

SB5 R0000-R1499 R9000-R9117Series 160i/180i, 0i-B(SB7)

SB6 R0000-R2999 R9000-R9199

SB7 R0000-R7999 R9000-R9499

Series 210i, 0i-B(SA1) SA1 R0000-R0999 R9000-R9099

SA5 R0000-R0999 R9000-R9117

Series 0i-D PMC R0000-R7999 R9000-R9499

PMC/L R0000-R1499 R9000-R9499

Series Mate 0i-D PMC/L R0000-R1499 R9000-R9499

Power Mate All R0000-R0999 R9000-R9117

Power Mate i SB5 R0000-R1499 R9000-R9117

SB6 R0000-R2999 R9000-R9199

CNC 1st PMC *2nd PMC *3rd PMC

Series 30i/31i/32i

User Range R0000-R7999 R0000-R1499 R0000-R1499

System Range R9000-R9499 R9000-R9499 R9000-R9499

*      Optional.

T Data

• T Data definition.

• Digital points to reference individual bits configuration.

• Analog points to reference individual bytes, words, or longwords configuration.

• Supported addresses.
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T Data  definition

T Data Is for changeable timers.

T data points Are read and write.

Digital  points to reference individual bits

Point Class DIGITAL

Type BOOL

Access Read or Read/Write

Valid Address

es

Txxxx, where xxxx is a valid address for your PMC 

type

Address Offset 0-7, for the particular bit you want to reference

Analog  points to reference individual bytes, words, or longwords

Point Class ANALOG

Type SINT, INT, or DINT (1, 2, or 4 bytes)

Access Read or Read/Write

Valid Address

es

Txxxx, where xxxx is a valid address for your PMC 

type

Address Offset none

Supported  addresses

CNC PMC Type Valid Address Range

Series 150 NA/NB T0000-T0079

NB2 T0000-T0299

Series 150i NB6 T0000-T0299

Series 160/180-B/C SA1/SB3/SB5/SC3 T0000-T0079

SB4/SB6/SC4 T0000-T0299

Series 210-B, 0i-A SA1/SA3 T0000-T0079
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CNC PMC Type Valid Address Range

SB5 T0000-T0079Series 160i/180i, 0i-B(SB7)

SB6 T0000-T0299

SB7 T0000-T0499, T9000-T9499

Series 210i, 0i-B(SA1) SA1/SA5 T0000-T0079

Series 0i-D PMC T0000-T0499 T9000-T9499

PMC/L T0000-T0079 T9000-T9079

Series Mate 0i-D PMC/L T0000-T0079 T9000-T9079

Power Mate All T0000-T0079

Power Mate i SB5 T0000-T0079

SB6 T0000-T0299

CNC 1st PMC *2nd PMC *3rd PMC

Series 30i/31i/32i

Changeable time T0000-T0499 T0000-T0079 T0000-T0079

Variable-timer precision T9000-T9499 T9000-T9079 T9000-T9079

*  Optional

**

Note:

The CRT/MDI panel and the CNC Screens provide the ability to display Timer data as both 

individual bits, and as word data using the Timer screen. When displayed as word data, the Timer 

screen manipulates the data and displays the actual data as multiples of 48 or 8. software does 

not manipulate the data when you configure points as word data.

K Data

• K Data definition.

• Digital points to reference individual bits configuration.

• Analog points to reference individual bytes, words, or longwords configuration.

• Supported addresses.
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K Data  definition

K Data Is for keep relays.

K data points Are read and write.

Digital  points to reference individual bits

Point Class DIGITAL

Type BOOL

Access Read or Read/Write

Valid Address

es

Kxxxx, where xxxx is a valid address for your PMC 

type

Address Offset 0-7, for the particular bit you want to reference

Analog  points to reference individual bytes, words, or longwords

Point Class ANALOG

Type SINT, INT, or DINT (1, 2, or 4 bytes)

Access Read or Read/Write

Valid Address

es

Kxxxx, where xxxx is a valid address for your PMC 

type

Address Offset none

Supported  addresses

CNC PMC Type Valid Address Range

Series 150 NA K0000-K0018

NB K0000-K0019

NB2 K0000-K0039 K0900-K0909

Series 150i NB6 K0000-K0039 K0900-K0909

Series 160/180-B/C SA1/SB3/SB5/SC3 K0000-K0019

SB4/SB6/SC4 K0000-K0039 K0900-K0909
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CNC PMC Type Valid Address Range

Series 210-B, 0i-A SA1/SA3 K0000-K0019

SB5 K0000-K0019Series 160i/180i, 0i-B(SB7)

SB6 K0000-K0039 K0900-K0909

SB7 K0000-K0099 K0900-K0919

Series 210i, 0i-B(SA1) SA1/SA5 K0000-K0019

Series 0i-D  PMC K0000-K0099 K0900-K0999

PMC/L K0000-K0019

Series Mate 0i-D PMC/L K0000-K0019

Power Mate All K0000-K0019

Power Mate i SB5 K0000-K0019

SB6 K0000-K0039 K0900-K0909

CNC 1st PMC *2nd PMC *3rd PMC

Series 30i/31i/32i

User Range K0000-K0099 K0000-K0019 K0000-K0019

System Range K0900-K0999 K0900-K0999 K0900-K0999

*     Optional.

Note:

The CRT/MDI panel and the CNC Screens provide the ability to display K data as individual bits. 

To configure points to display data in the same format, configure DIGITAL points of type BOOL.

CAUTION:

If you have an NA, NB, RA1, RA3, RB3, or and RC3 PMC, you must not write to Keep Relay 

locations K0017-K0019. If you have an RB4 or an RC4 PMC, you must not write Keep Relay 

locations K0900-K0909. CIMPLICITY software will not prevent you from writing to these memory 

locations.

C Data
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• C Data definition.

• Digital points to reference individual bits configuration.

• Analog points to reference individual bytes, words, or longwords configuration.

• Supported addresses.

C Data  definition

C Data Is for counters.

C data points Are read and write.

Digital  points to reference individual bits

Point Class DIGITAL

Type BOOL

Access Read or Read/Write

Valid Address

es

Cxxxx, where xxxx is a valid address for your PMC 

type

Address Offset 0-7, for the particular bit you want to reference

Analog  points to reference individual bytes, words, or longwords

Point Class ANALOG

Type SINT, INT, or DINT (1, 2, or 4 bytes)

Access Read or Read/Write

Valid Address

es

Cxxxx, where xxxx is a valid address for your PMC 

type

Address Offset none

Supported  addresses

CNC PMC Type Valid Address Range

Series 150 NA/NB C0000-C0079

NB2 C0000-C0199

Series 150i NB6 C0000-C0199
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CNC PMC Type Valid Address Range

Series 160/180-B/C SA1/SB3/SB5/SC3 C0000-C0079

SB4/SB6/SC4 C0000-C0199

Series 210-B, 0i-A SA1/SA3 C0000-C0079

SB5 C0000-C0079Series 160i/180i, 0i-B(SB7)

SB5 C0000-C0199

SB7 C0000-C0399 C5000-C5199

Series 210i, 0i-B(SA1) SA1/SA5 C0000-C0079

Series 0i-D PMC C0000-C0399 C5000-C5199

PMC/L C0000-C0079 C5000-C5039

Series Mate 0i-D PMC/L C0000-C0079 C5000-C5039

Power Mate All C0000-C0079

Power Mate i SB5 C0000-C0079

SB6 C0000-C0199

CNC 1st PMC *2nd PMC *3rd PMC

Series 30i/31i/32i

Changeable counter C0000-C0399 C0000-C0079 C0000-C0079

Fixed counter C5000-C5199 C5000-C5039 C5000-C5039

*Optional

**

Note:

The CRT/MDI panel and the CNC Screens provide the ability to display C data as individual bits, or 

as word data from the Counter screen. On the Counter screen, the first 2 bytes will be displayed in 

a column labeled Presetvalue. The next 2 bytes are displayed in a column labeled Current data. 

You should configure points as type INT to obtain data in a similar format to the Counter screen. 

For example, a point of type INT with address C0000 would contain the Preset value. A point of 

type INT with address C0002 would contain the Current value.
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D Data

• D Data definition.

• Digital points to reference individual bits configuration.

• Analog points to reference individual bytes, words, or long words configuration.

• Supported addresses.

D Data  definition

D Data Is to access the data table.

D data points Are read and write.

Digital  points to reference individual bits

Point Class DIGITAL

Type BOOL

Access Read or Read/Write

Valid Address

es

Dxxxx, where xxxx is a valid address for your PMC 

type

Address Offset 0-7, for the particular bit you want to reference

Analog  points to reference individual bytes, words, or longwords

Point Class ANALOG

Type SINT, INT, or DINT (1, 2, or 4 bytes)

Access: Read or Read/Write

Valid Address

es

Dxxxx, where xxxx is a valid address for your PMC 

type

Address Offset none

Supported  addresses

CNC PMC Type Valid Address Range

Series 150 NA/NB D0000-D0299
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CNC PMC Type Valid Address Range

NB2 D0000-D7999

Series 150i NB6 D0000-D7999

Series 160/180-B/C SA1 D0000-D1859

SB3/SB5/SC3 D0000-D2999

SB4/SB6/SC4 D0000-D7999

Series 210-B, 0i-A SA3 D0000-D1859

SB5 D0000-D2999Series 160i/180i, 0i-B(SB7)

SB6 D0000-D7999

SB7 D0000-D9999

Series 210i, 0i-B(SA1) SA1/SA5 D0000-D1859

Series 0i-D PMC D0000-D9999

PMC/L D0000-D2999

Series Mate 0i-D PMC/L D0000-D2999

Power Mate All D0000-D1859

SB5 D0000-D2999Power Mate i

SB6 D0000-D7999

CNC 1st PMC *2nd PMC *3rd PMC

Series 30i/31i/32i D0000-D9999 D0000-D2999 D0000-D2999

*     Optional

Note:

The CRT/MDI panel and the CNC Screens provide the ability to display D data individual bits, 

and as longwords from the Data screen. To have software display the data in the same format, 

configure points as type DINT.

E Data
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Note:

E Data is supported only on Series 160i, 180i, and 0i with a PMC SB7, and Series 30i/31i/32i.

• E Data definition.

• Digital points to reference individual bits configuration.

• Analog points to reference individual bytes, words, or longwords configuration.

• Supported addresses.

E Data  definition

E Data Is for extended re

lay.

E data points Are read and write.

Digital  points to reference individual bits

Point Class DIGITAL

Type BOOL

Access Read or Read/Write

Valid Address

es

Exxxx, where xxxx is a valid address for your PMC 

type

Address Offset 0-7, for the particular bit you want to reference

Analog  points to reference individual bytes, words, or longwords

Point Class ANALOG

Type SINT, INT, or DINT (1, 2, or 4 bytes)

Access: Read or Read/Write

Valid Address

es

Exxxx, where xxxx is a valid address for your PMC 

type

Address Offset none
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Supported  addresses

CNC PMC Type Valid Address Range

Series 160i/180i, 0i-B(SB7) SB7 E0000-E7999

Series 0i-D All E0000-E9999

CNC 1st PMC *2nd PMC *3rd PMC

Series 30i/31i/32i E0000-E9999 E0000-E9999** E0000-E9999**

*       Optional

**     This area is common memory for the multi-PMC function. It is possible for each program to read the 

same value from, and write to, the area.

Note:  The 30i/31i/32i CNC's can have up to 3 PMC ladders. This is different than older controls. The E 

range listed is for sharing data between the 3 ladders.

Skip Data

Skip Data points Are read-on

ly.

When configuring Skip Data points, specify the following attributes.

Point Class ANALOG

Type REAL

Access READ

CNC Valid Address

es

Series 150/150i SD1-SD24

Series 160/180/210, 160i/180i/210i, 0i SD1-SD8

Series 30i/31i/32i SD1-SD32

Power Mate i-D SD1, SD2

Power Mate H SD1-SD6

Address Offset None
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Note:

If the current number of controlled axes on your CNC is less than 8, then you will be able to obtain 

data only for the number of axes you have configured. For example, if your CNC is currently 

configured for 3 controlled axes, then you may define Skip Data points SD1 - SD8. However, only 

points SD1, SD2, and SD3 will have values.

Tool Offset Data

Tool Offset Data

Note:

• The types of data that you can access in the tool offset table depends on the type of:

• CNC (M, T or Power Mate) and

• Tool offset memory (A, B, or C)

that you purchased for your CNC.

• The Series 160i/180i W CNC, when using FOCA/HSSB, does not support tool offset data.

• Data type details.

• Number of allowed tool offsets for series.

• Significant digits before and after a decimal point.

Data  type details

• Machining Series &endash; Memory Type A (including Power Mate and Series 30i/31i/32i ).

• Machining Series &endash; Memory Type B

• Machining Series &endash; Memory Type C

• Lathe Series / Tool Offset &endash; Memory Type A

• Lathe Series &endash; Memory Type B

Number  of allowed tool offsets for series

The total number of tool offsets that you can access for each memory type depends upon the number of 

tool offsets that you have purchased for your CNC.

The number of allowed tool offsets for series are:
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CNC Total number of allowed Tool offsets

Series 150/150i M 32, 99, 200, 499, or 999

Series 150 T 32, 64, or 160

Series 150TT 16, 32 or 80 (each path)

Series 160/180-210, 160i/180i/210i, 0i M 32, 64, 99, 200, 400, 499 or 999

Series 160/180/210, 160i/180i/210i, 0i T 16, 32, 64, or 99

Series 30i/31i,32i 16, 32, 64, 99, 200, 400, 499, 999 or 2000

Power Mate H 99

Power Mate i 32, 64, 99, 200, 400, 499 or 999

Significant  digits before and after a decimal point

For example, the number of significant digits you can enter before and after the decimal point can include 

the following. Be aware that the actual number of digits will vary based on the CNC model you are using.

For Number of Digits

Inches Before the decimal point Up to 3 digits

After the decimal point 4 digits

Example 999.9999 is valid. 9999.9999 is not valid.

Millimeters Before the decimal point Up to 4 digits

After the decimal point 3 digits

Note:

The Power Mate control only supports Machining Series memory type A.

Machining Series - Memory Type A (Including Power Mate and Series 
Series 30i/31i,32i)

Point types that can be configured for Machining series - Memory Type A or Power Mate include:

• Single Tool offsets.

• Direction of imaginary tool nose (Series 30i/31i/32i).
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Single  Tool Offsets

Point Class ANALOG

Type REAL

Access Read-only or Read/Write

Valid Address

es

TOSx, where x is a valid tool offset number for your CNC.

Address Offset N/A

Direction  of imaginary tool nose (Series 30i/31i,32i only)

Point Class ANALOG

Type REAL

Access Read-only or Read/Write

Valid Address

es

DITNx, where x is a valid tool offset number for your CNC.

Address Offset N/A

Machining Series - Memory Type B

Point types that can be configured for Machining series - Memory Type B include:

• Tool geometry offsets.

• Tool wear offsets.

• Direction of imaginary tool nose (Series 30i/31i/32i only).

Tool Geometry  Offsets

Point Class ANALOG

Type REAL

Access Read-only or Read/Write

Valid Address

es

TGOx, where x is a valid tool offset number for your CNC

Address Offset N/A
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Tool Wear  Offsets

Point Class ANALOG

Type REAL

Access Read-only or Read/Write

Valid Address

es

TWOx, where x is a valid tool offset number for your CNC

Address Offset N/A

Direction  of Imaginary Tool Nose (Series 30i/31i/32i  only)

Point Class ANALOG

Type REAL

Access Read-only or Read/Write

Valid Address

es

DITNx, where x is a valid tool offset number for your CNC

Address Offset N/A

Machining Series - Memory Type C

Point types that can be configured for Machining series - Memory Type C include:

• Tool length / Geometry offsets.

• Tool length / Wear offsets.

• Cutter radius / Geometry offsets.

• Cutter radius / Wear offsets.

• Direction of imaginary tool nose (Series 30i/31i/32i only).

Tool  Length / Geometry Offsets

Point Class ANALOG

Type REAL

Access Read-only or Read/Write
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Valid Address

es

TLGx, where x is a valid tool offset number for your 

CNC

Address Offset N/A

Tool  Length / Wear Offsets

Point Class ANALOG

Type REAL

Access: Read-only or Read/Write

Valid Address

es

TLWx, where x is a valid tool offset number for your 

CNC

Address Offset N/A

Cutter  Radius / Geometry Offsets

Point Class ANALOG

Type REAL

Access Read-only or Read/Write

Valid Address

es

CRGx, where x is a valid tool offset number for your CNC

Address Offset N/A

Cutter  Radius / Wear Offsets

Point Class ANALOG

Type REAL

Access Read-only or Read/Write

Valid Address

es

CRWx, where x is a valid tool offset number for your CNC

Address Offset N/A
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Direction  of Imaginary Tool Nose (Series 30i/31i/32i only)

Point Class ANALOG

Type REAL

Access Read-only or Read/Write

Valid Address

es

DITNx, where x is a valid tool offset number for your CNC

Address Offset N/A

Lathe Series/Tool Offset - Memory Type A

Point types that can be configured for Lathe series - Memory Type A include:

• X-axis geometry offsets.

• Y-axis geometry offsets.

• Z-axis geometry offsets.

• Nose radius offsets

• Direction of imaginary tool nose.

X-axis  Geometry Offsets

Point Class ANALOG

Type REAL

Access: Read-only or Read/Write

Valid Address

es

XAOx, where x is a valid tool offset number for your CNC.

Address Offset N/A

Y-axis  Geometry Offsets

Point Class ANALOG

Type REAL

Access Read-only or Read/Write
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Valid Address

es

YAOx, where x is a valid tool offset number for your CNC.

Address Offset N/A

Z-axis  Geometry Offsets

Point Class ANALOG

Type REAL

Access Read-only or Read/Write

Valid Address

es

ZAOx, where x is a valid tool offset number for your CNC.

Address Offset N/A

Nose  Radius Offsets

Point Class ANALOG

Type REAL

Access Read-only or Read/Write

Valid Address

es

NROx, where x is a valid tool offset number for your CNC.

Address Offset N/A

Direction  of Imaginary Tool Nose

Point Class ANALOG

Type INT

Access Read-only or Read/Write

Valid Address

es

DITNx, where x is a valid tool offset number for your CNC.

Address Offset N/A

Lathe Series - Memory Type B
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Point types that can be configured for Lather series - Memory Type B include:

• X-axis geometry offsets.

• Y-axis geometry offsets.

• Z-axis geometry offsets.

• Nose radius geometry offsets.

• X-axis wear offsets.

• Y-axis wear offsets.

• Z-axis wear offsets.

• Nose radius wear offsets.

• Direction of imaginary tool nose.

X-axis  Geometry Offsets

Point Class ANALOG

Type REAL

Access Read-only or Read/Write

Valid Address

es

XGOx, where x is a valid tool offset number for your CNC.

Address Offset N/A

Y-axis  Geometry Offsets

Point Class ANALOG

Type REAL

Access Read-only or Read/Write

Valid Address

es

YGOx, where x is a valid tool offset number for your CNC.

Address Offset N/A

Z-axis  Geometry Offsets

Point Class ANALOG

Type REAL
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Access Read-only or Read/Write

Valid Address

es

ZGOx, where x is a valid tool offset number for your CNC.

Address Offset N/A

Nose  Radius Geometry Offsets

Point Class ANALOG

Type REAL

Access Read-only or Read/Write

Valid Address

es

NRGx, where x is a valid tool offset number for your CNC.

Address Offset N/A

X-axis  Wear Offsets

Point Class ANALOG

Type REAL

Access Read-only or Read/Write

Valid Address

es

XWOx, where x is a valid tool offset number for your CNC.

Address Offset N/A

Y-axis  Wear Offsets

Point Class ANALOG

Type REAL

Access Read-only or Read/Write

Valid Address

es

YWOx, where x is a valid tool offset number for your CNC.

Address Offset N/A
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Z-axis  Wear Offsets

Point Class ANALOG

Type REAL

Access Read-only or Read/Write

Valid Address

es

ZWOx, where x is a valid tool offset number for your CNC.

Address Offset N/A

Nose  Radius Wear Offsets

Point Class ANALOG

Type REAL

Access Read-only or Read/Write

Valid Address

es

NRWx, where x is a valid tool offset number for your CNC.

Address Offset N/A

Direction  of Imaginary Tool Nose

Point Class ANALOG

Type REAL

Access Read-only or Read/Write

Valid Address

es

DITNx, where x is a valid tool offset number for your CNC.

Address Offset N/A

Work Zero Offset Data

Significant digits before and after a decimal 

point.

Number of allowed work zero offsets for series.
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Work Zero Offset notes.

Work Zero Offset attributes.

Number  of allowed work zero offsets for series

The total number of work zero offsets you may access depends upon the number you have purchased for 

your CNC.

The number of zero offsets for series are:

CNC
Total number of al

lowed Work Zero offsets

Series 150/150i, 0i-D 0-6, 7-54

Series 160/180/210, 160i/180i-210i, 0i-A/B/C M 0 -6, 7-54, 55-306

Series 160/180/210, 160i/180i-210i, 0i-A/B/C T 0-6

Series 30i/31i/32i 0-6, 7-54, 55-306

Value Definition

0 External work zero offset value of Common.

1,..,6 Work zero offset value of G54 through G59.

7,..,54 Work zero offset value of G54.1P1 through G54.1P48.

55,..,306 Work zero offset value of G54.1P49 through 

G54.1P300.

Significant  digits before and after a decimal point

For example, the number of significant digits you can enter before and after the decimal point can include 

the following. Be aware that the actual number of digits will vary based on the CNC model you are using.

For Number of Digits

Inches Before the decimal point Up to 4 digits

After the decimal point 4 digits

Example 9999.9999 is valid 99999.9999 is not.

Millimeters Before the decimal point Up to 5 digits
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For Number of Digits

After the decimal point 3 digits

Work Zero Offset Notes

When configuring an array point to access work zero offset data, keep in mind that data is addressed one 

axis at a time.

Example

Configuraton Description

Array point 10 elements

Address for the 

point

WZO1A1

Array Description

First element Offset 1, Axis 1

Second element Offset 2, Axis 1 (not Offset 1, Axis 2).

Important:

The Power Mate, Power Mate i and Series 210 T CNC's do not support the Work Zero Offset table.

Work Zero Offset  attributes

To configure a point to access work zero offset data, you must specify the following information.

Point Class ANALOG

Type REAL

Access Read or Read/Write

Valid Address

es

WZOxAy, where x is a valid tool offset number for your CNC, and y is a valid axis num

ber.

Address Offset N/A
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Tool Life Management Data

Tool Life Management Data

Be aware that:

• Bits for Tool Life Management and Tool Life Management B are options you can purchase .

• Tool Life Management B is supported only on Series 160i, 180i, and 30i/31i/32i .

• Tools and tool groups cannot be created or deleted using points; they can only be read, modified or 

cleared.

Point Configuration Criteria

• Clear tool life groups.

• Current number of registered tool groups.

• Current tool group number.

• Current tool number.

• Individual tool data.

• Maximum number of registered tool groups.

• Maximum number of registered tools.

• Optional group number for tool groups. (Tool Life management B only.)

• Tool group data.

• Tool group rest counter. (Tool Life Management B only.)

• Tool life counter.

Clear Tool Life Groups

Points can be configured to clear the following for each tool group or any number of tool groups.

• Tool life counter and

• Tool information.

Specify the following for clear the tool life group points.

Point Class ANALOG

Type INT

Access Read/Write
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Valid Addresses CLTG<x>, where x is the tool group number and the data value is the end tool group 

number.

Number of Ele

ments

1

Example 1

IF Address = CLTG1

Data Value = 0 or 1

Then Tool Group 1 is cleared from the CNC system data.

Example 2

IF Address = CLTG1

Data Value = 20

Then Tool Groups 1 through 20 are cleared from the CNC system data.

Current Number of Registered Tool Groups

Specify the following for current number of registered tool groups points.

Point Class ANALOG

Type DINT

Access Read-only

Valid Addresses CNTG

Number of Elements 1

Current Tool Group Number

Specify the following for current tool group number points.

Point Class ANALOG

Type DINT

Access Read-only
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Valid Addresses CTG

Number of Elements 1

Current Tool Number

Specify the following for current tool number data points in a currently selected group.

Point Class ANALOG

Type DINT

Access Read-only

Valid Addresses CTN

Number of Elements 1

Individual Tool Data

• Point data access.

• Point configuration.

• Point array elements.

Point  data access

You can configure a point to access individual tool data, including the:

Tool number T-code

Tool length compensation number H-code

Cutter radius compensation num

ber

D-code

Status of the individual tool • Regis

tered

• Expired

• Skipped
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Note:

Access for:

Ma

chining 

CNC

Type 

M

Are read/write.

Lathe 

CNC

Type 

T

Are read-only. The tool length compensation number and the cutter radius compensation 

number will always have a value of 0, since this data does not apply to a Lathe CNC.

Point  configuration

Specify the following for individual tool data access points.

Point Class ANALOG

Type DINT

Elements 4-element array

Access Read/Write

Valid Addresses INTD<X>, where X  is the tool number

Number of Elements 4

Point  array elements

The elements of the Individual Tool Data point array are as follows:

Element 0 The tool number (T-code)

Element 1 The tool length compensation number (H-code)

Element 2 The cutter radius compensation number (D-

code)

Element 3 The status of the individual tool are as follows:

Value The tool is:

1 Registered

2 Expired
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3 Skipped

Note:

If the first element of the array point, element 0, has a value of 0, this indicates that this tool does 

not exist. If this is the case, then you should not try to set the other elements of this array point.

Also, note that there is a special numbering mechanism that is used when configuring the address of 

individual tool points. The number of tool groups and the number of tools in each group is enabled in 

the controller. Therefore, the address of the first tool in tool group 1 is INTD1  and the address of the first 

tool in tool group 2 could be INTD 3, 5, 9, 17  or 33. The first tool number in tool group 2 depends on the 

configuration of the controller.

Examples

• If each group has 2 tools.

Addresses are:

Tool Group Addresses

Group 1 INTD1, INTD2

Group 2 INTD3, INTD4

• If each group has 4 tools.

Addresses are:

Tool Group Addresses

Group 1 INTD1, INTD2, INTD3, INTD4

Group 2 INTD5, INTD6, INTD7, INTD8

Maximum Number of Registered Tool Groups

Specify the following for the maximum number of registered tool groups points.

Point Class ANALOG

Type DINT
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Access Read-only

Valid Addresses MNTG

Number of Elements 1

Maximum Number of Registered Tools

You can configure a point to read the maximum number of tools that can be registered in any given tool 

group. This point may not be written.

Specify the following for the maximum number of registered tools points.

Point Class ANALOG

Type DINT

Access Read-only

Valid Addresses MNRT

Number of Elements 1

Optional Group Number for Tool Groups

You can configure a point to read and write the optional 8-digit group number for each tool group.

Note:

Optional Tool Group Number points can only be configured if you have purchased the Tool Life 

Management B  option bit.

Specify the following for optional tool group number points.

Point Class ANALOG

Type DINT

Access Read/Write

Valid Addresses OTGN<X>, where X  is the tool group num

ber

Number of Elements 1



Addons and Options  | 3 - HMI for CNC  | 292

Note:

If a given tool group does not have any registered tools, the value of the optional tool group 

number will be 0. Attempts to set the optional tool group number will fail.

Tool Group Data

• Point data access.

• Point configuration.

• Point array elements.

Point  data access

You can configure a point to access tool group data, including the:

• Number of tools in the tool group.

• Tool life value.

• Tool group count (number of cuts).

• Units to be used to increment the count (either Cycles or Minutes).

Note:

Access for:

Machining CNC Type M Are read/write except for the number of tools in the tool 

group.

Lathe CNC Type T Are read-only.

Point  Configuration

Specify the following for tool group data points.

Point Class ANALOG

Type DINT

Access Read/Write

Valid Addresses TDGN<X>, where X  is the tool group number

Number of Elements 4
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Point  array elements

The elements of the Individual Tool Data point array are as follows.

Element 0 The number of tools in the tool group

Element 1 The tool life value

Element 2 The tool group count (number of cuts)

Element 3 The units to be used to increment the counter. The value identifies the unit as fol

lows.

Value Unit

0 Cycles

1 Minutes

Note:

If the first element of the array point, element 0, has a value of 0, this indicates that no tools 

have been registered in this tool group. If this is the case, then you should not try to set the other 

elements of this array point.

Tool Group Rest Counter

You can configure a point to read and write the rest counter for each tool group.

Note:

Rest Counter points can only be configured if you have purchased the Tool Life Management B 

option bit.

Specify the following for tool group rest counter points.

Point Class ANALOG

Type DINT

Access Read/Write

Valid Addresses REST<X>, where X  is the tool group number

Number of Elements 1
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Note:

If a given tool group does not have any registered tools, the value of the rest counter will be 0. 

Attempts to set the rest counter will fail.

Tool Life Counter

You can configure a point to read and write the tool life counter for each tool group.

Specify the following for tool life counter points for each tool group.

Point Class ANALOG

Type DINT

Access Read/Write

Valid Addresses TLC<x>, where x is the tool group num

ber

Number of Elements 1

Note:

If a given tool group does not have any registered tools, the value of the tool life counter will be 0. 

Attempts to set the tool life counter will fail.

Tool Management Data

Note:

Bits for Tool Management are options you can purchase .

Important:

Tool Management Data is supported only on Series 160i, 180i, 210i, and 30i/31i/32i .

• Point data access.

• Point configuration.

• Point array elements.
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Point  data access

You can configure a point to access the Tool Management Data table,  including the:

• Tool number T code

• Tool life counter

• Maximum of tool life

• Predictive tool life

• State of tool life • Tool is not managed

• Unused tool

• Enable to use

• Life is over

• Tool is broken

• Customizing Bits

• Tool info bit 0      : RGS bit 1      : TIM bit 2      : BDT bit 3      : LOC bit 

4,...,15 : Reserved

• Tool length compensation 

number

H code

• Cutter compensation number D code

• Spindle speed S code

• Feed rate F code

• Magazine number Read-only

• Pot number Read-only

• Tool geometric compensation 

umber

G code Turning system only

• Tool wear compensation num

ber

W code Turning system only

Point  configuration

Specify the following for the Tool Management Data table access points.

Point Class ANALOG
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Type DINT

Elements 15-element array

Access Read/Write

Valid Addresses TOOL<X>, where X  is the tool number

Number of Elements 15

Point  array elements

The elements of the Tool Management Data table point array are as follows.

Ele

ment 0

Tool number (T)

Setting 

range

0 to 99999999

Ele

ment 1

Tool life counter

Setting 

range

0 to 99999999 Unit count

Setting 

range

0 to 3599999 Unit sec

Ele

ment 2

Maximum of tool life

Setting 

range

0 to 99999999 Unit count

Setting 

range

0 to 3599999 Unit sec

Ele

ment 3

Predictive tool life

Setting 

range

0 to 99999999 Unit count

Setting 

range

0 to 3599999 Unit sec
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Ele

ment 4

State of tool life

0 Tool is not managed

1 Unused tool

2 Enable to use

3 Life is over

4 Tool is broken

Ele

ment 5

Customizing Bits

Ele

ment 6

Tool info

bit 0   : RGS

0 Tool management data is void.

1 Tool management data is valid.

bit 1   : TIM

0 Tool life is specified by count.

1 Tool life is specified by time.

bit 2   : BDT

0 Normal tool.

1 Big tool.

bit 3   : LOC

0 Data accessible.

1 Data locked.

bit 4,...,15 Reserved

Ele

ment 7

Tool length compensation number (H)

Setting 

range

0 to 999
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Ele

ment 8

Cutter compensation number (D)

Setting 

range

0 to 999

Ele

ment 9

Spindle speed (S)

Setting 

range

0 to 99999 Unit /min

Ele

ment 

10

Feed rate (F)

Setting 

range

0 to 99999999 Unit mm/min inch/min deg/min 

mm/rev inch/rev

Ele

ment 

11

Magazine number This data is read-only; it cannot be used for writing data.

Ele

ment 

12

Pot number This data is read-only; it cannot be used for writing data.

Ele

ment 

13

Tool geometric compensation number (G) This data is Turning system on

ly.

Ele

ment 

14

Tool wear compensation number (W) This data is Turning system on

ly.

Note:

If the first element of the array point, element 0, has a value of 0, this indicates that this tool does 

not exist. If this is the case, then you should not try to set the other elements of this array point.
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Step 6. Configure Screens

Step 6. Configure Screens

Step 6.1 

(on page 

299)

Use CNC QuikStart Demo project screens.

Tip:

All of the CIMPLICITY CimEdit capability is available, in addition to the FANUC Controls, for 

creating HMI for CNC screens.

Step 6.1. Use the CNC QuikStart Demo Project screens

Step 6.1. Use the CNC QuikStart Demo Project screens

HMI for CNC includes a demo project named CNC Quikstart, which provides you with a configuration that 

can "quickstart" a customized project.

The demo project has several screens that enable you to monitor and modify the CNC.

Step 6.1.1 

(on page 

299)

Start the CNC QuikStart Demo project.

Step 6.1.2 

(on page 

302)

Review the CNC QuikStart Demo project screens.

Step 6.1.3 

(on page 

312)

Stop the CNC QuikStart Demo project.

• Step 6. Configure screens.

Step 6.1.1. Start the CNC QuikStart Demo Project

1. Click Start on the Windows task bar.

2. Select (All) Programs> HMI SCADA - CIMPLICITY 10 >Start CNC QuikStart Demo project.
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If the CNC_QUIKSTART project is not running

A Select CIMPLICITY® Project dialog box opens.

a. Select CNC_QUIKSTART.gef.

b. Click Start.

A message box asks if you want to start the project.

a. Click Yes.

A Starting CNC_QUIKSTART window opens displaying the CIMPLICITY process startups.

Result: A CIMPLICITY® Login dialog box opens.

When the CNC_QUIKSTART project is running

Result: A CIMPLICITY® Login dialog box opens.

3. Enter a User ID  and Password  for a user who has access to CNC runtime screens.
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4. Click OK.

An HMI for CNC QuikStart Main Menu screen opens.
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Note:

Your computer must be connected to a CNC and the CNC must be powered up for the CNC Demo 

project to function properly.

Step 6.1.2. Review the CNC QuikStart Demo Project Screens

Step 6.1.2. Review the CNC QuikStart Demo Project Screens

Several screens for the HMI for CNC QuikStart Project main menu are described in this section, along with 

a brief description of each screen's functionality.

Note:

Features on the screens are defaults. If necessary, you can modify any of the screens to 

customize them for your project.

1. Option 6.1.2.1. Axis Positions Screens  (on page 303)

2. Option 6.1.2.3. Part Program  (on page 307)

3. Option 6.1.2.2. Settings Screens  (on page 305)

4. Option 6.1.2.4. PMC Data Menu  (on page 308)
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5. Option 6.1.2.5. Status Screen  (on page 310)

6. Option 6.1.2.6. Exit the QuikStart Project Main Menu  (on page 311)

For Option 6.1.2.

1  (on 

page 

303)

Axis Posi

tions

2  (on 

page 

305)

Settings

3  (on 

page 

307)

Part Program

4  (on 

page 

308)

PMC Data

5  (on 

page 

310)

Status

6  (on 

page 

311)

Exit

Option 6.1.2.1. Axis Positions Screens

The Axis Positions  button on the HMI for CNC QuikStart Project screen opens the Axis Positions Menu 

screen.

Axis Positions Menu

Buttons  include:
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1. #unique_180_Connect_42_static  (on page 304)

2. Step 6.1.2. Review the CNC QuikStart Demo Project Screens  (on page 302)

A  (on 

page 

304)

Buttons on the Axis Positions Menu screen display the:

• Relative Axis.

• Absolute Axis.

• Distance-to-Go.

• Machine Axis.

B  (on 

page 

302)

Main Menu Returns to the CNC QuikStart Project screen.

Relative  Axis Screen

Note:

The default screens that display for each of the selections are formatted the same, but are 

configured to report about the associated axis.

Default features include:
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1 Axis positions 1 -3.

2 Devices 0 - 4.

3 Close Returns to the Relative Axis Main Menu 

screen.

Option 6.1.2.2. Settings Screens

The Settings  button on the HMI for CNC QuikStart Project screen opens the Settings Menu screen.

Buttons  include:
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A  (on 

page 

306)

Custom Macro Variables

B  (on 

page 

307)

Pitch Error Compensation

C  (on 

page 

302)

Main Menu Returns to the CNC QuikStart Project screen.

1. Custom  Macro Variables screen

Default features include:

1 CMV macro variables 100 - 109 Read and write values.

2 Devices 0 - 4

3 Close Returns to the Settings Main Menu screen.

Note:

Set the value of a Custom Macro Variable by clicking selected value on screen.

Up  (on page 305)
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1. Pitch  Error Compensation screen

Default features include:

1 Pitch Error Compensation 0 - 9 Read and write values.

2 Slider - Value Move slider to the:

Left Decreases the value.

Right Increases the value.

3 Devices 0 - 4

4 Close Returns to the Settings Main Menu screen.

Up  (on page 305)

Option 6.1.2.3. Part Program

The Part Programs  button on the HMI for CNC QuikStart Project screen opens the Part Program window.

1. Part  Program window
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The CNC Part Program Application enables you to upload and download part programs between your PC 

and CNC.

1 Download  (on page 375)  part programs to the 

CNC.

2 Delete  (on page 377)  part program files from 

the PC>

3 Part program files on the PC.

4 Upload  (on page 378)  part programs to the PC.

5 Delete  (on page 380)  part programs from the 

CNC.

6 Part programs on the CNC.

7  (on 

page 

299)

Exit Returns to the CNC QuikStart Project screen.

Option 6.1.2.4. PMC Data Menu

The PMC Data  button on the HMI for CNC QuikStart Project screen opens the PMC Data Menu screen.
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PMC Data Menu

Buttons include:

1. Step 6.1.2. Review the CNC QuikStart Demo Project Screens  (on page 302)

2. #unique_183_Connect_42_A  (on page 309)

A  Buttons on the PMC Data Menu screen display the:

G Data (PMC to CNC)

F Data CNC to PMC

Y Data Outputs

X Data Inputs

A Data Message Demand

R Data Internal Relay

B  (on 

page 

302)

Main Menu Returns to the CNC QuikStart Project screen.
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G Data (PMC to CNC)

Note:

The default screens that display for each of the selections are formatted the same, but are 

configured to report about the associated PMC data.

Default features include:

1 Offset Read and write.

2 De

vices

0 - 4

3 Close Returns to the static Axis Main Menu screen.

Note:

Set the Offset value by clicking the selected value on screen.

Option 6.1.2.5. Status Screen

The Status  button on the HMI for CNC QuikStart Project screen opens the Program Status screen.
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1. Step 6.1.2. Review the CNC QuikStart Demo Project Screens  (on page 302)

1 Displays the status for the CNC of the:

1. Active program number.

2. Active sequence number.

3. Actual axis feed rate.

4. Actual spindle speed.

2 Devices 0-4

3 Set Max RPM. Set the maximum RPM scale on the Actual Spindle Speed 

gauge.

4  (on page 302) Main Menu. Returns to the CNC QuikStart Project screen.

Option 6.1.2.6. Exit the QuikStart Project Main Menu

Click Exit  to close the HMI for CNC QuikStart Project screen.
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Step 6.1.3. Stop the CNC QuikStart Project

1. Click Start on the Windows task bar.

2. Select (All) Programs> HMI SCADA - CIMPLICITY version>CNC QuikStart Project.

The CIMPLICITY Workbench opens, displaying the CNC QuikStart project.

3. Click the Stop button.

The CNC QuikStart Project stops.
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Step 7. Configure and View Alarms

Step 7. Configure and View Alarms

Step 7.1 

(on page 

313)

Configure CNC alarms.

Step 7.2 

(on page 

315)

View CNC alarms in the Alarm View

er.

Step 7.1. Configure CNC Alarms

Alarms can be configured to display with messages and other information about the state of CNC's in 

your production facility.

• CNC pre-configured alarm types.

• CNC pre-configured alarm class.

• Alarm settings.

CNC pre-configured  alarm types

When you initially install the HMI for CNC software on your PC, three alarm types are automatically 

configured and added to the Alarms list.

The three pre-configured CNC alarm types are:
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Item Description

1 CNC 

Alarms

Displays if the CNC is in an alarm state.

2 CNC 

Macro 

Mes

sages

A CNC Macro Message alerts an operator to a situation that is worth noting. The message 

can simply be to let the operator know that something is happening, or to remind the op

erator that an action must be taken. Macro Messages are developed by the Machine Tool 

Builder and are programmed in Macro B or Macro Executor.

3 CNC 

Oper

ator 

Mes

sages

Alerts an operator to a situation that is worth noting. The message can simply be to let 

the operator know that something is happening, or to remind the operator that an action 

must be taken. Operator Messages are developed by the Machine Tool Builder and are pro

grammed in CNC Ladder and are generated by setting PMC A Bits. The Alarm Class ID is al

ways MSG, but will still show a state of ALARM in the Alarm Viewer. Once the operator ac

knowledges the message, the state will display as NORMAL.

CNC  pre-configured alarm class

By default CNC alarms use the following alarm classes.
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1 Commonly used default classes.

Class Indicates a:

HIGH Serious condition that requires immediate attention.

MED Moderate condition that requires attention.

LOW Lesser condition that may require attention.

2 MSG Pre-configured CNC alarm class for a CNC operator mes

sage.

Alarm  settings

CNC alarms can be created and configured the same as other CIMPLICITY alarms.

The following topics provide detailed descriptions of CIMPLICITY alarms.

• Create new alarms.

• Modify alarm routing.

• Modify alarm options.

• Configure alarm classes.

Step 7.2. View CNC Alarms in the Alarm Viewer

When an alarm condition has occurred on your CNC for a local or remote project, alarm details, including 

the message display in the Alarm Vieweror Alarm Viewer Control.
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In addition to alarms that are created specifically for the project, pre-configured generated alarms display.

A $CNC_ALARM

B $CNC_OPER_MSG

C $CNC_MACRO_

MSG

When a value from 0 to 200 is assigned to variable #3000, the CNC stops with a macro message alarm.

After an expression, a macro message can be described by adding #3000 to the alarm message.

Example

#3000=1 (TOOL NOT FOUND)

The alarm screen displays 3001 Tool not found.

Note:

You can view alarms and messages from a remote project in either the:

Stand-alone Alarm View

er.

Alarm Viewer Control.
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CNC Dynamic Link Library

CNC Dynamic Link Library

The CNC Dynamic Link Library enables you to transfer part programs and file data between your PC and 

CNC.

You have complete and total access to all the external entry points of the CNC DLL.

• CNC DLL entry point interfaces for FOCAS/HSSB.

• CNC DLL entry point interfaces for FOCAS/Ethernet.

• CNC DLL sample application script and screens.

The CNC Part Program Application (C++ program), the CNC Command Line Utilities (C Programs) and 

CIMPLICITY CimView screens (CimEdit scripts) use the CNC Dynamic Link Library's external entry points 

to access part programs and file data on a CNC.

Following is a graphic Dynamic Link Library overview.

1. CNC Part Program  (on page 361)

2. CNC Command Line Utilities  (on page 394)

3. Step 6.1. Use the CNC QuikStart Demo Project screens  (on page 299)

Important:

In order to use the CNC DLL, make sure you:
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• Understand the entry point interfaces provided by the CNC DLL.

• Understand the necessary configuration requirements of the CNC.

• Code appropriate application programs.

CNC DLL Entry Point Interfaces for FOCAS/HSSB

CNC DLL Entry Point Interfaces for FOCAS/HSSB

CNC DLL entry point interfaces for FOCAS/HSSB are used to communicate with an Open Factory CNC 

that uses the FOCAS/HSSB protocol.

The routines used for communicating through the CNC DLL are divided into two main categories as 

follows.

• Part Program routines for FOCAS/HSSB.

• File Data routines for FOCAS/HSSB.

Part Program Routines for FOCAS/HSSB

Part Program Routines for FOCAS/HSSB

The following CNC DLL entry point interfaces are used to communicate with an Open Factory CNC that 

uses the FOCAS/HSSB protocol.

• delete_pp

• dir_pp

• directory_pp

• download_pp

• select_pp

• upload_pp

delete_pp

Purpose

Delete a part program on your CNC.

Syntax

int delete_pp (long int node_no, short path_no, long int prognum)
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Arguments

Input

node_no Node number 0-7

path_no Value

0

1-2

1-10

prognum Part program number

Output

None

Return Value

ERR_BADPROGNUM 82 Bad program number/invalid range 

  

CNC data window error  (on page 423)  handling return statuses.

dir_pp

Purpose

Retrieve a short directory (just the part program numbers) of registered part programs on your CNC.

Syntax

int dir_pp (long int node_no, short path_no, long int *prog, int max_files)

Arguments

Input

node_no Node number 0-7

path_no Value: 0, 1-2, 1-10

max_files Number of elements in prog array (Max 1024)
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Output

prog Pointer to array of program numbers currently registered in the CNC.

Return Value

ERR_BADDIR  120 Bad directory info from 

CNC

CNC data window error  (on page 423)  handling return statuses.

directory_pp

Purpose

Retrieve long directory (including sizes and comments) of registered part programs on your CNC.

Syntax

int directory_pp (long int node_no, short path_no, long int *prog, char *comment, int *size, int comment_size, int 

 max_files)

Arguments

Input

node_no Node number 0-7

path_no Value: 0, 1-2, 1-10.

commen

t_size

Number of characters for each element of a comment array (Max 24)

max_

files

Number of elements in a prog array (Max 1024)

Output

prog Pointer to integer array of program numbers currently registered in the CNC (Max 1024 ele

ments).

comment Pointer to string array of program comments currently registered in the CNC (Max 1024 ele

ments of Max 24 characters).
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size Pointer to integer array of program sizes currently registered in the CNC (Max 1024 ele

ments).

Return Value

ERR_BADDIR  120 Bad directory info from 

CNC

CNC data window error  (on page 423)  handling return statuses.

download_pp

Purpose

Download a text file containing a single part program or multiple part programs to your CNC.

Syntax

int download_pp (long int node_no, short path_no, char *progfile, long int *badprog)

Arguments

Input

node_no Node number 0-7

path_no Value: 0, 1-2, 1-10.

progfile Pointer to file specification containing part program(s)

Output

badprog Pointer to bad program number, if a program error occurred, otherwise zero.

Return Value

ERR_BADPROGFILE 80 File open failed

ERR_BADPROG 81 Bad program

ERR_BADPROGNUM 82 Bad program number/invalid 

range

ERR_PROGSEL 84 Program already selected
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CNC data window error  (on page 423)  handling return statuses.

select_pp

Purpose

Select a part program on your CNC.

Syntax

int select_pp (long int node_no, short path_no, long int prognum)

Arguments

Input

node_no Node number 0-7

path_no Value: 0, 1-2, 1-10.

prognum Part program number

Output

None

Return Value

ERR_BADPROGNUM 82 Bad program number/invalid 

range

ERR_PROGNOTSEL 95 Program was not selected

CNC data window error  (on page 423)  handling return statuses.

upload_pp

Purpose

Upload a single part program or multiple part programs to a file from your CNC.

Syntax

int upload_pp (long int node_no, short path_no, char *progfile, unsigned long int startprg, unsigned long int endprg)
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Arguments

Input

node_no Node number 0-7

path_no Value: 0, 1-2, 1-10.

progfile Pointer to file specification to contain part program(s)

startprg Starting part program number

endprg Ending part program number

Output

None

Return Value

ERR_BADPROGFILE 80 File open failed

ERR_BADPROGNUM 82 Bad program number/invalid 

range

ERR_DISKERROR  87 Disk error

ERR_NOPROGS 110 No programs found

ERR_BADDIR 120 Bad directory info from CNC

CNC data window error  (on page 423)  handling return statuses.

File Data Routines for FOCAS/HSSB

File Data Routines for FOCAS/HSSB

The following CNC DLL entry point interfaces are used to communicate with an Open Factory CNC using 

the FOCAS/HSSB protocol:

• download_cmv

• download_kbit

• download_parm

• download_pec

• download_tofs
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• download_zofs

• upload_cmv

• upload_diag

• upload_kbit

• upload_parm

• upload_pec

• upload_tofs

• upload_zofs

download_cmv

Purpose

Download a file containing custom macro variable data, in comma-separated variable (.csv) format, to 

your CNC.

Syntax

int download_cmv (long int node_no, short path_no, char *filespec)

Arguments

Input

node_no Node number 0-7

path_no Value: 0, 1-2, 1-10.

filespec Pointer to file specification containing custom macro variable data val

ues

Output

download_tool_log.csv

Return Value

ERR_BADCSVFILE 130 Unable to open CSV file

ERR_BADCSVFOR

MAT

131 Bad CSV format

ERR_BADLOGFILE 132 Unable to open LOG file
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ERR_BADRANGE 133 Bad input number or invalid 

range

ERR_BADCNC 134 CNC type different than CNC

ERR_BADMODEL 135 Model type different than CNC

CNC data window error  (on page 423)  handling return statuses.

download_kbit

Purpose

Download a file containing pmc k-bit data, in comma separated variable format, to your CNC.

Syntax

int download_kbit (long int node_no, short path_no, char *filespec)

Arguments

Input

node_no Node number 0-7

path_no Value: 0, 1-2, 1-10.

filespec Pointer to file specification containing pmc k-bit data values

Output

download_tool_log.csv

Return Value

ERR_BADCSVFILE 130 Unable to open CSV file

ERR_BADCSVFOR

MAT

131 Bad CSV format

ERR_BADLOGFILE 132 Unable to open LOG file

ERR_BADRANGE 133 Bad input number or invalid 

range

CNC data window error  (on page 423)  handling return statuses.
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download_parm

Purpose

Download a file containing parameter data, in comma separated variable format, to your CNC.

Syntax

int download_parm (long int node_no, short path_no, char *filespec)

Arguments

Input

node_no Node number 0-7

path_no Value: 0, 1-2, 1-10.

filespec Pointer to file specification containing parameter data values

Output

download_tool_log.csv

Return Value

ERR_BADCSVFILE 130 Unable to open CSV file

ERR_BADCSVFOR

MAT

131 Bad CSV format

Bad CSV format 132 Unable to open LOG file

CNC data window error  (on page 423)  handling return statuses.

download_pec

Purpose

Download a file containing pitch error compensation data, in comma separated variable format, to your 

CNC.

Syntax

int download_pec (long int node_no, short path_no, char *filespec)
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Arguments

Input

node_no Node number 0-7

path_no Value: 0, 1-2, 1-10.

filespec Pointer to file specification containing pitch error compensation data val

ues

Output

download_tool_log.csv

Return Value

ERR_BADCSVFILE 130 Unable to open CSV file

ERR_BADCSVFOR

MAT

131 Bad CSV format

ERR_BADLOGFILE 132 Unable to open LOG file

ERR_BADRANGE 133 Bad input number or invalid 

range

CNC data window error  (on page 423)  handling return statuses.

download_tofs

Purpose

Download a file containing tool offset data, in comma separated variable format, to your CNC.

Syntax

int download_tofs (long int node_no, short path_no, char *filespec)

Arguments

Input

node_no Node number 0-7

path_no Value: 0, 1-2, 1-10.
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filespec Pointer to file specification containing tool offset data values

Output

download_tool_log.csv

Return Value

ERR_BADCSVFILE 130 Unable to open CSV file

ERR_BADCSVFOR

MAT

131 Bad CSV format

ERR_BADLOGFILE 132 Unable to open LOG file

ERR_BADMODEL 135 Model type different than CNC

ERR_BADMEMORY 136 Memory type different than 

CNC

ERR_UNKNOWNMEM 137 Unknown Memory type (A B C)

CNC data window error  (on page 423)  handling return statuses.

download_zofs

Purpose

Download a file containing work zero offset data, in comma separated variable format, to your CNC.

Syntax

int download_zofs (long int node_no, short path_no, char *filespec)

Arguments

Input

node_no Node number 0-7

path_no Value: 0, 1-2, 1-10.

filespec Pointer to file specification containing work zero offset data values

Output

download_tool_log.csv
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Return Value

ERR_BADCSVFILE 130 Unable to open CSV file

ERR_BADCSVFOR

MAT

131 Bad CSV format

ERR_BADLOGFILE 132 Unable to open LOG file

CNC data window error  (on page 423)  handling return statuses.

upload_cmv

Purpose

Upload a range of custom macro variable data to a file, in comma separated variable format, from your 

CNC.

Syntax

int upload_cmv (long int node_no, short path_no, char *filespec, unsigned short startrange, unsigned short endrange)

Arguments

Input

node_no Node number 0-7

path_no Value: 0, 1-2, 1-10.

filespec Pointer to file specification to contain custom macro variable data val

ues

startrange Low end of range to upload

endrange High end of range to upload

Output

upload_tool_log.csv

Return Value

ERR_BADCSVFILE 130 Unable to open CSV file
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ERR_BAD

LOGFILE

132 Unable to open LOG file

ERR_BADRANGE 133 Bad input number or invalid 

range

CNC data window error  (on page 423)  handling return statuses.

upload_diag

Purpose

Upload a range of diagnostic data to a file, in comma separated variable format, from your CNC.

Syntax

int upload_diag (long int node_no, short path_no, char *filespec, unsigned short startrange, unsigned short endrange)

Arguments

Input

node_no Node number 0-7

path_no Value: 0, 1-2, 1-10.

filespec Pointer to file specification to contain diagnostic data values

startrange Low end of range to upload

endrange High end of range to upload

Output

upload_tool_log.csv

Return Value

ERR_BADCSVFILE 130 Unable to open CSV file

ERR_BAD

LOGFILE

132 Unable to open LOG file

ERR_BADRANGE 133 Bad input number or invalid 

range
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CNC data window error  (on page 423)  handling return statuses.

upload_kbit

Purpose

Upload a range of pmv k-bit data to a file, in comma separated variable format, from your CNC.

Syntax

int upload_kbit (long int node_no, short path_no, char *filespec, unsigned short startrange, unsigned short endrange)

Arguments

Input

node_no Node number 0-7

path_no Value: 0, 1-2, 1-10.

filespec Pointer to file specification to contain pmc k-bit data values

startrange Low end of range to upload

endrange High end of range to upload

Output

upload_tool_log.csv

Return Value

ERR_BADCSVFILE 130 Unable to open CSV file

ERR_BAD

LOGFILE

132 Unable to open LOG file

ERR_BADRANGE 133 Bad input number or invalid 

range

CNC data window error  (on page 423)  handling return statuses.

upload_parm

Purpose
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Upload a range of parameter data to a file, in comma separated variable format, from your CNC.

Syntax

int upload_parm (long int node_no, short path_no, char *filespec, unsigned short startrange, unsigned short endrange)

Arguments

Input

node_no Node number 0-7

path_no Value: 0, 1-2, 1-10.

filespec Pointer to file specification to contain parameter data values

startrange Low end of range to upload

endrange High end of range to upload

Output

upload_tool_log.csv

Return Value

ERR_BADCSVFILE 130 Unable to open CSV file

ERR_BAD

LOGFILE

132 Unable to open LOG file

ERR_BADRANGE 133 Bad input number or invalid 

range

CNC data window error  (on page 423)  handling return statuses.

upload_pec

Purpose

Upload a range of pitch error compensation data to a file, in comma separated variable format, from your 

CNC.

Syntax

int upload_pec (long int node_no, short path_no, char *filespec, unsigned short startrange, unsigned short endrange)
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Arguments

Input

node_no Node number 0-7

path_no Value: 0, 1-2, 1-10.

filespec Pointer to file specification to contain pitch error compensation data val

ues

startrange Low end of range to upload

endrange High end of range to upload

Output

upload_tool_log.csv

Return Value

ERR_BADCSVFILE 130 Unable to open CSV file

ERR_BAD

LOGFILE

132 Unable to open LOG file

ERR_BADRANGE 133 Bad input number or invalid 

range

CNC data window error  (on page 423)  handling return statuses.

upload_tofs

Purpose

Upload a range of tool offset data to a file, in comma separated variable format, from your CNC.

Syntax

int upload_tofs (long int node_no, short path_no, char *filespec, unsigned short startrange, unsigned short endrange)

Arguments

Input

node_no Node number 0-7
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path_no Value: 0, 1-2, 1-10.

filespec Pointer to file specification to contain tool offset data values

startrange Low end of range to upload

endrange High end of range to upload

Output

upload_tool_log.csv

Return Value

ERR_BADCSVFILE 130 Unable to open CSV file

ERR_BAD

LOGFILE

132 Unable to open LOG file

ERR_BADRANGE 133 Bad input number or invalid 

range

CNC data window error  (on page 423)  handling return statuses.

upload_zofs

Purpose

Upload a range of work zero offset data to a file, in comma separated variable format, from your CNC.

Syntax

int upload_zofs (long int node_no, short path_no, char *filespec, unsigned short startrange, unsigned short endrange)

Arguments

Input

node_no Node number (0-7)

path_no Value: 0, 1-2, 1-10.

filespec Pointer to file specification to contain work zero offset data values

startrange Low end of range to upload

endrange High end of range to upload
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Output

upload_tool_log.csv

Return Value

ERR_BADCSVFILE 130 Unable to open CSV file

ERR_BAD

LOGFILE

132 Unable to open LOG file

ERR_BADRANGE 133 Bad input number or invalid 

range

CNC data window error  (on page 423)  handling return statuses.

CNC DLL Entry Point Interfaces for FOCAS/Ethernet

CNC DLL Entry Point Interfaces for FOCAS/Ethernet

NC DLL entry point interfaces for FOCAS/Ethernet are used to communicate with an Open Factory CNC 

using FOCAS/Ethernet protocol.

The routines used for communicating through the CNC DLL are divided into two main categories as 

follows:

• Part Program Routines for FOCAS/Ethernet.

• File Data Routines for FOCAS/Ethernet.

Part Program Routines for FOCAS/Ethernet

Part Program Routines for FOCAS/Ethernet

The following CNC DLL entry point interfaces are used to communicate with an Open Factory CNC using 

FOCAS/Ethernet protocol:

• edelete_pp

• edir_pp

• edirectory_pp

• edownload_pp
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• eselect_pp

• eupload_pp

edelete_pp

Purpose

Delete a part program on your CNC.

Syntax

int edelete_pp (char *ipaddr, unsigned short port, long int timeout, short path_no, long int prognum)

Arguments

Input

ipaddr IP address of the CNC

port Port number of the CNC

timeout Seconds for timeout (0 to ignore and wait infinitely)

path_no Value: 0, 1-2, 1-10.

prognum Part program number

Output

None

Return Value

ERR_BADPROGNUM 82 Bad program number/invalid 

range

CNC data window error  (on page 423)  handling return statuses.

edir_pp

Purpose

Retrieve a short directory (just the part program numbers) of registered part programs on your CNC.
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Syntax

int edir_pp (char *ipaddr, unsigned short port, long int timeout, short path_no, long int *prog, int max_files)

Arguments

Input

ipaddr IP address of the CNC

port Port number of the CNC

timeout Seconds for timeout (0 to ignore and wait infinitely)

path_no Value: 0, 1-2, 1-10.

max_

files

Number of elements in prog array (Max 1024)

Output

prog Pointer to array of program numbers currently registered in the CNC

Return Value

ERR_BADDIR 120 Bad directory info from 

CNC

CNC data window error  (on page 423)  handling return statuses.

edirectory_pp

Purpose

Retrieve long directory (including sizes and comments) of registered part programs on your CNC.

Syntax

int edirectory_pp (char *ipaddr, unsigned short port, long int timeout, short path_no, long int *prog, char *comment, 

 int *size, int comment_size, int max_files)

Arguments

Input

ipaddr IP address of the CNC



Addons and Options  | 3 - HMI for CNC  | 338

port Port number of the CNC

timeout Seconds for timeout (0 to ignore and wait infinitely)

path_no Value

comment_

size

Number of characters for each element of comment array (Max 24)

max_files Number of elements in prog array (Max 1024)

Output

prog Pointer to integer array of program numbers currently registered in the CNC (Max 1024 ele

ments)

comment Pointer to string array of program comments currently registered in the CNC (Max 1024 ele

ments of Max 24 characters)

size Pointer to integer array of program sizes currently registered in the CNC (Max 1024 ele

ments)

Return Value

ERR_BADDIR 120 Bad directory info from 

CNC

CNC data window error  (on page 423)  handling return statuses.

edownload_pp

Purpose

Download a text file containing a single part program or multiple part programs to your CNC.

Syntax

int edownload_pp (char *ipaddr, unsigned short port, long int timeout, short path_no, char *progfile, long int 

 *badprog)

Arguments

Input

ipaddr IP address of the CNC
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port Port number of the CNC

time

out

Seconds for timeout (0 to ignore and wait infinitely)

path_

no

Value: 0, 1-2, 1-10.

prog

file

Pointer to file specification containing part program(s)

Output

bad

prog

Pointer to bad program number, if a program error occurred, otherwise zero

Return Value

ERR_BADPROGFILE 80 File open failed

ERR_BADPROG 81 Bad program

ERR_BADPROGNUM 82 Bad program number/invalid 

range

ERR_PROGSEL 84 Program already selected

CNC data window error  (on page 423)  handling return statuses.

eselect_pp

Purpose

Select a part program on your CNC.

Syntax

int eselect_pp (char *ipaddr, unsigned short port, long int timeout, short path_no, long int prognum)

Arguments

Input

ipaddr IP address of the CNC

port Port number of the CNC
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timeout Seconds for timeout (0 to ignore and wait infinitely)

path_no Value: 0, 1-2, 1-10.

prognum Part program number

Output

None

Return Value

ERR_BADPROGNUM 82 Bad program number/invalid 

range

ERR_PROGNOTSEL 95 Program was not selected

CNC data window error  (on page 423)  handling return statuses.

eupload_pp

Purpose

Upload a single part program or multiple part programs to a file from your CNC.

Syntax

int eupload_pp (char *ipaddr, unsigned short port, long int timeout, short path_no, char *progfile, unsigned long int 

 startprg, unsigned long int endprg)

Arguments

Input

ipaddr IP address of the CNC

port Port number of the CNC

time

out

Seconds for timeout (0 to ignore and wait infinitely)

path_

no

Value: 0, 1-2, 1-10.

prog

file

Pointer to file specification to contain part program(s)
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start

prg

Starting part program number

endprg Ending part program number

Output

None

Return Value

ERR_BADPROGFILE 80 File open failed

ERR_BADPROGNUM 82 Bad program number/invalid 

range

ERR_DISKERROR  87 Disk error

ERR_NOPROGS 110 No programs found

ERR_BADDIR 120 Bad directory info from CNC

CNC data window error  (on page 423)  handling return statuses.

File Data Routines for FOCAS/Ethernet

File Data Routines for FOCAS/Ethernet

The following CNC DLL entry point interfaces are used to communicate with an Open Factory CNC using 

FOCAS/Ethernet protocol.

• edownload_cmv

• edownload_kbit

• edownload_parm

• edownload_pec

• edownload_tofs

• edownload_zofs

• eupload_cmv

• eupload_diag

• eupload_kbit

• eupload_parm

• eupload_pec
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• eupload_tofs

• eupload_zofs

edownload_cmv

Purpose

Download a file containing custom macro variable data, in comma-separated variable (csv) format, to 

your CNC.

Syntax

int edownload_cmv (char *ipaddr, unsigned short port, long int timeout, short path_no, char *filespec)

Arguments

Input

ipaddr IP address of the CNC

port Port number of the CNC

timeout Seconds for timeout (0 to ignore and wait infinitely)

path_no Value: 0, 1-2, 1-10

filespec Pointer to file specification containing custom macro variable data values

Output

upload_tool_

log.csv

Return Value

ERR_BADCSVFILE 130 Unable to open CSV file

ERR_BADCSVFOR

MAT

131 Bad CSV format

ERR_BADLOGFILE 132 Unable to open LOG file

ERR_BADRANGE 133 Bad input number or invalid 

range

ERR_BADCNC 134 CNC type different than CNC
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ERR_BADMODEL 135 Model type different than CNC

CNC data window error  (on page 423)  handling return statuses.

edownload_kbit

Purpose

Download a file containing pmc k-bit data, in comma separated variable format, to your CNC.

Syntax

int edownload_kbit (char *ipaddr, unsigned short port, long int timeout, short path_no, char *filespec)

Arguments

Input

ipaddr IP address of the CNC

port Port number of the CNC

timeout Seconds for timeout (0 to ignore and wait infinitely)

path_no Value: 0, 1-2, 1-10

filespec

Output

upload_tool_

log.csv

Return Value

ERR_BADCSVFILE 130 Unable to open CSV file

ERR_BADCSVFOR

MAT

131 Bad CSV format

ERR_BADLOGFILE 132 Unable to open LOG file

ERR_BADRANGE 133 Bad input number or invalid 

range

CNC data window error  (on page 423)  handling return statuses.
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edownload_parm

Purpose

Download a file containing parameter data, in comma separated variable format, to your CNC.

Syntax

int edownload_parm (char *ipaddr, unsigned short port, long int timeout, short path_no, char *filespec)

Arguments

Input

ipaddr IP address of the CNC

port Port number of the CNC

timeout Seconds for timeout (0 to ignore and wait infinitely)

path_no Value: 0, 1-2, 1-10

filespec Pointer to file specification containing parameter data values

Output

upload_tool_

log.csv

Return Value

ERR_BADCSVFILE 130 Unable to open CSV file

ERR_BADCSVFOR

MAT

131 Bad CSV format

Bad CSV format 132 Unable to open LOG file

CNC data window error  (on page 423)  handling return statuses.

edownload_pec

Purpose

Download a file containing pitch error compensation data, in comma separated variable format, to your 

CNC.
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Syntax

int edownload_pec (char *ipaddr, unsigned short port, long int timeout, short path_no, char *filespec)

Arguments

Input

ipaddr IP address of the CNC

port Port number of the CNC

timeout Seconds for timeout (0 to ignore and wait infinitely)

path_no Value: 0, 1-2, 1-10.

filespec Pointer to file specification containing pitch error compensation data values

Output

download_tool_

log.csv

Return Value

ERR_BADCSVFILE 130 Unable to open CSV file

ERR_BADCSVFOR

MAT

131 Bad CSV format

ERR_BADLOGFILE 132 Unable to open LOG file

ERR_BADRANGE 133 Bad input number or invalid 

range

CNC data window error  (on page 423)  handling return statuses.

edownload_tofs

Purpose

Download a file containing tool offset data, in comma separated variable format, to your CNC.

Syntax

int edownload_tofs (char *ipaddr, unsigned short port, long int timeout, short path_no, char *filespec)
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Arguments

Input

ipaddr IP address of the CNC

port Port number of the CNC

timeout Seconds for timeout (0 to ignore and wait infinitely)

path_no Value: 0, 1-2, 1-10

filespec Pointer to file specification containing tool offset data values

Output

upload_tool_

log.csv

Return Value

ERR_BADCSVFILE 130 Unable to open CSV file

ERR_BADCSVFOR

MAT

131 Bad CSV format

ERR_BADLOGFILE 132 Unable to open LOG file

ERR_BADMODEL 135 Model type different than CNC

ERR_BADMEMORY 136 Memory type different than 

CNC

ERR_UNKNOWNMEM 137 Unknown Memory type (A B C)

CNC data window error  (on page 423)  handling return statuses.

edownload_zofs

Purpose

Download a file containing work zero offset data, in comma separated variable format, to your CNC.

Syntax

int edownload_zofs (char *ipaddr, unsigned short port, long int timeout, short path_no, char *filespec)
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Arguments

Input

ipaddr IP address of the CNC

port Port number of the CNC

timeout Seconds for timeout (0 to ignore and wait infinitely)

path_no Value: 0, 1-2, 1-10

filespec Pointer to file specification containing work zero offset data values

startrange Low end of range to upload

endrange High end of range to upload

Output

upload_tool_

log.csv

Return Value

ERR_BADCSVFILE 130 Unable to open CSV file

ERR_BADCSVFOR

MAT

131 Bad CSV format

ERR_BADLOGFILE 132 Unable to open LOG file

CNC data window error  (on page 423)  handling return statuses.

eupload_diag

Purpose

Upload a range of diagnostic data to a file, in comma separated variable format, from your CNC.

Syntax

int eupload_diag (char *ipaddr, unsigned short port, long int timeout, short path_no, char *filespec, unsigned short 

 startrange, unsigned short endrange)
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Arguments

Input

ipaddr IP address of the CNC

port Port number of the CNC

timeout Seconds for timeout (0 to ignore and wait infinitely)

path_no Value: 0, 1-2, 1-10

filespec Pointer to file specification to contain diagnostic data values

startrange Low end of range to upload

endrange High end of range to upload

Output

upload_tool_

log.csv

Return Value

ERR_BADCSVFILE 130 Unable to open CSV file

ERR_BAD

LOGFILE

132 Unable to open LOG file

ERR_BADRANGE 133 Bad input number or invalid 

range

CNC data window error  (on page 423)  handling return statuses.

eupload_cmv

Purpose

Upload a range of custom macro variable data to a file, in comma separated variable format, from your 

CNC.

Syntax

int eupload_cmv (char *ipaddr, unsigned short port, long int timeout, short path_no, char *filespec, unsigned short 

 startrange, unsigned short endrange)
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Arguments

Input

ipaddr IP address of the CNC

port Port number of the CNC

timeout Seconds for timeout (0 to ignore and wait infinitely)

path_no Value: 0, 1-2, 1-10

filespec Pointer to file specification to contain custom macro variable data values

startrange Low end of range to upload

endrange High end of range to upload

Output

upload_tool_

log.csv

Return Value

ERR_BADCSVFILE 130 Unable to open CSV file

ERR_BAD

LOGFILE

132 Unable to open LOG file

ERR_BADRANGE 133 Bad input number or invalid 

range

CNC data window error  (on page 423)  handling return statuses.

eupload_kbit

Purpose

Upload a range of pmv k-bit data to a file, in comma separated variable format, from your CNC.

Syntax

int eupload_kbit (char *ipaddr, unsigned short port, long int timeout, short path_no, char *filespec, unsigned short 

 startrange, unsigned short endrange)
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Arguments

Input

ipaddr IP address of the CNC

port Port number of the CNC

timeout Seconds for timeout (0 to ignore and wait infinitely)

path_no Value: 0, 1-2, 1-10

filespec Pointer to file specification to contain pmc k-bit data values

startrange Low end of range to upload

endrange High end of range to upload

Output

upload_tool_

log.csv

Return Value

ERR_BADCSVFILE 130 Unable to open CSV file

ERR_BAD

LOGFILE

132 Unable to open LOG file

ERR_BADRANGE 133 Bad input number or invalid 

range

CNC data window error  (on page 423)  handling return statuses.

eupload_parm

Purpose

Upload a range of parameter data to a file, in comma separated variable format, from your CNC.

Syntax

int eupload_parm (char *ipaddr, unsigned short port, long int timeout, short path_no, char *filespec, unsigned short 

 startrange, unsigned short endrange)
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Arguments

Input

ipaddr IP address of the CNC

port Port number of the CNC

timeout Seconds for timeout (0 to ignore and wait infinitely)

path_no Value: 0, 1-2, 1-10

filespec Pointer to file specification to contain parameter data values

startrange Low end of range to upload

endrange High end of range to upload

Output

upload_tool_

log.csv

Return Value

ERR_BADCSVFILE 130 Unable to open CSV file

ERR_BAD

LOGFILE

132 Unable to open LOG file

ERR_BADRANGE 133 Bad input number or invalid 

range

CNC data window error  (on page 423)  handling return statuses.

eupload_pec

Purpose

Upload a range of pitch error compensation data to a file, in comma separated variable format, from your 

CNC.

Syntax

int eupload_pec (char *ipaddr, unsigned short port, long int timeout, short path_no, char *filespec, unsigned short 

 startrange, unsigned short endrange)
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Arguments

Input

ipaddr IP address of the CNC

port Port number of the CNC

timeout Seconds for timeout (0 to ignore and wait infinitely)

path_no Value: 0, 1-2, 1-10.

filespec Pointer to file specification to contain pitch error compensation data values

startrange Low end of range to upload

endrange High end of range to upload

Output

upload_tool_

log.csv

Return Value

ERR_BADCSVFILE 130 Unable to open CSV file

ERR_BAD

LOGFILE

132 Unable to open LOG file

ERR_BADRANGE 133 Bad input number or invalid 

range

CNC data window error  (on page 423)  handling return statuses.

eupload_tofs

Purpose

Upload a range of tool offset data to a file, in comma separated variable format, from your CNC.

Syntax

int eupload_tofs (char *ipaddr, unsigned short port, long int timeout, short path_no, char *filespec, unsigned short 

 startrange, unsigned short endrange)
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Arguments

Input

ipaddr IP address of the CNC

port Port number of the CNC

timeout Seconds for timeout (0 to ignore and wait infinitely)

path_no Value: 0, 1-2, 1-10.

filespec Pointer to file specification to contain tool offset data values

startrange Low end of range to upload

endrange High end of range to upload

Output

upload_tool_

log.csv

Return Value

ERR_BADCSVFILE 130 Unable to open CSV file

ERR_BAD

LOGFILE

132 Unable to open LOG file

ERR_BADRANGE 133 Bad input number or invalid 

range

CNC data window error  (on page 423)  handling return statuses.

eupload_zofs

Purpose

Upload a range of work zero offset data to a file, in comma separated variable format, from your CNC.

Syntax

int eupload_zofs (char *ipaddr, unsigned short port, long int timeout, short path_no, char *filespec, unsigned short 

 startrange, unsigned short endrange)
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Arguments

Input

ipaddr IP address of the CNC

port Port number of the CNC

timeout Seconds for timeout (0 to ignore and wait infinitely)

path_no Value: 0, 1-2, 1-10

filespec Pointer to file specification to contain work zero offset data values

startrange Low end of range to upload

endrange High end of range to upload

Output

upload_tool_

log.csv

Return Value

ERR_BADCSVFILE 130 Unable to open CSV file

ERR_BAD

LOGFILE

132 Unable to open LOG file

ERR_BADRANGE 133 Bad input number or invalid 

range

CNC data window error  (on page 423)  handling return statuses.

CNC DLL Sample Application Script and Screens

CNC DLL Sample Application Script and Screens

The example in this section demonstrates how the CNC DLL  works.

• A sample application script

• Declares an external entry point into the DLL.
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• Shows how an application might be written to access CNC File Data using the FOCAS/HSSB 

protocol.

• Graphic examples in CimEdit and CimView illustrate how the CNC DLL accesses CNC data and 

returns runtime values that can be used to monitor the production facility.

CNC DLL Application Script

‘CNC_DLL.DLL function declarations

Declare Function dir_pp CDecl Lib "cnc_dll" Alias "dir_pp" (ByVal node_no As Long, ByVal path_no As Integer, ByRef 

 prog() As Long, ByVal max_files As Integer) As Integer

 

Sub OnScreenOpen()

 

Dim i As Integer

Dim node As Long

Dim path As Integer

Dim progs(1023) As Long

Dim maxfiles As Integer

Dim idx As Integer

Dim pp(1023) As CimObjectVariable

Dim cnc_error As CimObjectVariable

Dim cnc_node As CimObjectVariable

Dim cnc_path As CimObjectVariable

 

Set pp(0)  = CimGetRootObject().GetVariable("pp0")

Set pp(1)  = CimGetRootObject().GetVariable("pp1")

Set pp(2)  = CimGetRootObject().GetVariable("pp2")

Set pp(3)  = CimGetRootObject().GetVariable("pp3")

Set pp(4)  = CimGetRootObject().GetVariable("pp4")

Set pp(5)  = CimGetRootObject().GetVariable("pp5")

Set pp(6)  = CimGetRootObject().GetVariable("pp6")

Set pp(7)  = CimGetRootObject().GetVariable("pp7")

Set pp(8)  = CimGetRootObject().GetVariable("pp8")

Set pp(9)  = CimGetRootObject().GetVariable("pp9")

Set pp(10) = CimGetRootObject().GetVariable("pp10")

Set pp(11) = CimGetRootObject().GetVariable("pp11")

Set pp(12) = CimGetRootObject().GetVariable("pp12")

Set pp(13) = CimGetRootObject().GetVariable("pp13")
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Set pp(14) = CimGetRootObject().GetVariable("pp14")

Set pp(15) = CimGetRootObject().GetVariable("pp15")

 

Set cnc_error = CimGetRootObject().GetVariable("cnc_error")

Set cnc_node = CimGetRootObject().GetVariable("cnc_node")

Set cnc_path = CimGetRootObject().GetVariable("cnc_path")

 

' Initial arguments

 

node = 0

cnc_node = node

path = 1

cnc_path = path

maxfiles = 1024

 

' Get short directory (no comments or sizes)

 

i = dir_pp ( node, path, progs, maxfiles )

 

If i <> 0 Then

     ' Log error to Status Log

     LogStatus CIM_FAILURE,"dir_pp","Unable to get directory information from CNC.",i,0

     ' Initialize all part program screen variable to make them invisible

     For idx = 0 To 15

         pp(idx) = 0

     Next idx

     ' Set screen variable to display error

     cnc_error = """Unable to get directory info from CNC"""

     Exit Sub

End If

' Loop thru all part programs returned and set screen variables

Do While (progs(idx) <> 0)

     pp(idx) = progs(idx)

     dx = idx + 1

Loop

End Sub

Sub OnTimer()
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Dim i As Integer

Dim node As Long

Dim path As Integer

Dim progs(1023) As Long

Dim maxfiles As Integer

Dim idx As Integer

Dim pp(1023) As CimObjectVariable

Dim cnc_error As CimObjectVariable

Dim cnc_node As CimObjectVariable

Dim cnc_path As CimObjectVariable

Set pp(0)  = CimGetRootObject().GetVariable("pp0")

Set pp(1)  = CimGetRootObject().GetVariable("pp1")

Set pp(2)  = CimGetRootObject().GetVariable("pp2")

Set pp(3)  = CimGetRootObject().GetVariable("pp3")

Set pp(4)  = CimGetRootObject().GetVariable("pp4")

Set pp(5)  = CimGetRootObject().GetVariable("pp5")

Set pp(6)  = CimGetRootObject().GetVariable("pp6")

Set pp(7)  = CimGetRootObject().GetVariable("pp7")

Set pp(8)  = CimGetRootObject().GetVariable("pp8")

Set pp(9)  = CimGetRootObject().GetVariable("pp9")

Set pp(10) = CimGetRootObject().GetVariable("pp10")

Set pp(11) = CimGetRootObject().GetVariable("pp11")

Set pp(12) = CimGetRootObject().GetVariable("pp12")

Set pp(13) = CimGetRootObject().GetVariable("pp13")

Set pp(14) = CimGetRootObject().GetVariable("pp14")

Set pp(15) = CimGetRootObject().GetVariable("pp15")

Set cnc_error = CimGetRootObject().GetVariable("cnc_error")

Set cnc_node = CimGetRootObject().GetVariable("cnc_node")

Set cnc_path = CimGetRootObject().GetVariable("cnc_path")

' Initial arguments

node = cnc_node

path = cnc_path

maxfiles = 1024

' Get short directory (no comments or sizes)

i = dir_pp ( node, path, progs, maxfiles )

If i <> 0 Then

     ' Initialize all part program screen variable to make them invisible
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     For idx = 0 To 15

         pp(idx) = 0

     Next idx

     ' Set screen variable to display error

     cnc_error = """Unable to get directory info from CNC"""

     Exit Sub

End If

' Loop thru all part programs returned and set screen variables

Do While (progs(idx) <> 0)

     pp(idx) = progs(idx)

     idx = idx + 1

Loop

End Sub

Sub OnF2KeyDown(key As Integer)

Dim cnc_node As CimObjectVariable

Set cnc_node = CimGetRootObject().GetVariable("cnc_node")

If ((cnc_node + 1) < 8) Then

     nc_node = cnc_node + 1

Else

     cnc_node = 0

End If

End Sub

Sub OnF3KeyDown(key As Integer)

Dim cnc_path As CimObjectVariable

Set cnc_path = CimGetRootObject().GetVariable("cnc_path")

If ((cnc_path + 1) < 3) Then

     cnc_path = cnc_path + 1

Else

     cnc_path = 1

End If

End Sub

CNC DLL CimEdit/CimView Example

Following is a sample of a script being applied to CimEdit/CimView to access CNC file data.

Note:  You need to create a screen with
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1  (on 

page 

359)

A sample application script is written to access CNC File Data.

2  (on 

page 

359)

The script is applied to CimEdit screen.

3  (on 

page 

360)

CimView displays available data.

4  (on 

page 

361)

CimView generates an error message.

A  sample application script is written to access CNC File Data.

Note:  The script used is the CNC DLL application script  (on page 355)  provided in the previous topic.

The  script is applied to CimEdit screen.

Text objects on the screen are populated with CNC data during runtime or an error is generated when 

there is a configuration problem or unavailable data.
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CimView  displays available data.

Using the CNC DLL, a sample application screen in CimView displays a directory of part programs on a 

CNC.

The following graphic shows that the configuration data is correct and CNC information is available.
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CimView  generates an error message.

The CNC DLL sample application screen shows that Node 1 is either not configured or unavailable as 

demonstrated by the error message generated in CimView.

CNC Part Program

CNC Part Program
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• Overview.

• Environment variables on the PC.

• Part Program file type associations.

• Part Program parameters.

• Use the CNC Part Program application.

Overview

• The CNC Part Program Application enables you to upload and download part programs between 

your PC and CNC.

• The CNC dynamic link library (DLL) provides a common interface for enabling communication 

between an application and a CNC device.

1 Application requests part program da

ta.

2 DLL links request to CNC.

3 CNC sends part program data.

4 DLL links to the application.
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Note:

All existing directories and part program files on your network can be used in this application.

Environment  variables on the PC

Define a temporary directory name TEMP or TMP in your environment.

Part  program file type associations

The recommended file extension for part program files is .pro.

Note:

Associate the file with your selected text editor through the Windows Explorer.

That way you can open quickly open the text editor whenever you select a part program file.

See Windows documentation for information about associating files.

Part Program Parameters

The CNC Part Program Application provides you with an easy to use interface for managing your part 

programs. Before you begin to use the application, there are some configuration guidelines to consider to 

ensure that your PC and CNCs are optimized for using the application.

• Part Program parameters on the CNC.

• Download program parameters.

• Upload Program parameters.

Part  Program parameters on the CNC

Series Parameter

HSSB

• 160/180/210, 160i/180i/210i, 30i/31i/32i 3202#0,#4,#6 influenced by setting  3210,3211 in

fluenced by setting

• Power Mate i 3202#0,#4,#6 influenced by setting

Ethernet

• 160i/180i/210i, 30i/31i/32i 3202#0,#4,#6 3204#3,#4 3210,3211
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Series Parameter

• Power Mate i 3202#0,#4,#6 3204#3,#4

CNC Mode Mode Search

HSSB

• 150 • EDIT

• Other

Foreground Background

• 150i, 160/180/210, 160i/180i/210i, 

30i/31i/32i, Power Mate i

• EDIT, MEM

• Other

Foreground Background

Ethernet

The behavior of this function depends on the CNC 

mode.

EDIT, MEM Other Foreground Background

Download  program parameters

• Downstart

• Downstart3 (Ethernet only)

Downstart

Series Parameter

Series 150,150i 0020=16(EDIT mode) must be set 0022=16(except EDIT mode) must 

be set 0000#0 influenced by setting 2200#1,#3,#4 influenced by setting 

0011#0,2201#0 influenced by setting 2210,2211,2212,2213 influenced by set

ting

Series 

160i/180i/210i, 

30i/31i/32i

0000#0 influenced by setting 3201#2,#5,#6 influenced by setting 3202#0,#4 in

fluenced by setting 3210,3211 influenced by setting 3290#7 influenced by set

ting

Series 160i/180i-W, 

Power Mate i

0000#0 influenced by setting 3201#2,#5,#6 influenced by setting 3202#0,#4 in

fluenced by setting 3290#7 influenced by setting

CNC Mode Mode

• 150/150i It is possible to use in any CNC mode.(It is necessary to set the parameter ac

cording to the mode)
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• 160/180/210, 

160i/180i/210i, 

30i/31i/32i, 

Power Mate I

(It is possible to use in other than MDI mode.)

• Power Mate i This function can be used in any CNC mode. (It is necessary to set mode ac

cording to the target data.)

Up  (on page 364)

Downstart3  (Ethernet only)

Series Parameter

Series 150i 0020=7(*) must be set 0022=7(*) must be set 0000#0 2200#1,#3,#4 

0011#0,2201#0 2210,2211,2212,2213 8000#0

Program Use

• NC Program

EDIT Node 0020

Not EDIT Mode 0022

• All except NC

Background Editing 0020

Not Background Editing Cannot be used.

Series 

160i/180i/210i, 

30i/31i/32i

0000#0 3201#2,#5,#6 3202#0,#4 3204#3,#4 3210,3211,8900#0

Power Mate i 0000#0 3201#2,#5,#6 3202#0,#4 3204#3,#4 8900#0

CNC Mode

This function can be used in any CNC mode. (It is necessary to set mode according to the target data.)

Up  (on page 364)

Upload  program parameters

• Upstart

• Upstart3
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Upstart

Series Parameter

• 150i 0021=16 (EDIT mode) must be set 0023=16 (except EDIT mode) must be 

set

Up  (on page 365)

Upstart3

Series Parameter

Series 150i 0021=7(*) must be set 0023=7(*) must be set 0000#0 2200#1,#3,#4 

0011#0,2201#0 2210,2211,2212,2213

Program Use

• NC Program

EDIT Node 0021

Not EDIT Mode 0023

• All except NC

Background Editing 0023

Not Background Editing 0021

Series 160i/180i/210i, 

30i/31i/32i

0000#0 3201#2,#5,#6 3202#0,#4 3204#3,#4 3210,3211

Power Mate i 0000#0 3201#2,#5,#6 3202#0,#4 3204#3,#4

Up  (on page 365)

Use the CNC Part Program Application

Use the CNC Part Program Application

The CNC Part Program application provides the functionality you need to manage your part programs.

Step 1 

(on page 

367)

Create or Edit CNC programs.
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Step 2 

(on page 

370)

Connect to an open factory CNC.

Step 3 

(on page 

373)

Work in the CNC Part Program win

dow.

Step 1. Create or Edit CNC Programs

1. Open the text editor of your choice.

2. Create  a file with:

◦ One program.

◦ Two or more programs.

One  program

The file with one part program must use the following format.

Line Format

1 %
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Line Format

2 Onnnnnnnn    (XXXXXXX)

Where O  is a capital o. nnnnnnnn  is the program number up to 8  digits. (XXXXXXX)  (optional) 

is descriptive.

Next Part program commands

End %

Where %  is the end of file

Two  or more programs

When downloading a file that contains multiple programs, the programs are downloaded one at a 

time.

The file with two or more part programs must use the following format.



Addons and Options  | 3 - HMI for CNC  | 369

Line Format

1 %

2 0xxxxxxxx (XXXXXXX)

Where O  is a capital o. nnnnnnnn  is the program number up to 8  digits. (XXXXXXX)  (optional) 

is descriptive.

Next Part program commands for the first program.

Di

vide

%  (Optional)

Where %  is the file separator

n2 0xxxxxxxx (XXXXXXX)

Where Onnnnnnnn  is the second line for the next program up to 8  digits. O  is a capital o. 

nnnnnnnn  is the program number up to 8  digits. (XXXXXXX)  (optional) is descriptive.

Next Part program commands for the next program.

End %

Where %  is the end of file

3. Save the file in a selected directory.

Recommended:  Use the extension .pro for part programs or when making the file type association.

.pro is the default extension used in the CNC Part Program Application.

Example
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C:\CNCFile is the selected directory for the CNC .pro files.

Step 2. Connect to an Open Factory CNC

Do any of the following.

Method 1

a. Expand Project  in the Workbench left pane.

b. Double-click CNC Part Program.
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Method 2

a. Click Start on the Windows task bar.

b. Select (All) Programs> HMI SCADA - CIMPLICITY version>CNC Part Program 

.

Method 6

a. Click Start on the Windows task bar.

b. Select Run.

The Run dialog box opens.

a. Enter cnc_program  in the Open  field.

b. Press Enter.

Method 4

Click a button that has been configured for a CimView screen.

Note:

A CimEdit screen designer can configure a button with an Execute Command action.
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The entry in the Command  field will be cnc_program

The CNC Part Program– Protocol Selection dialog box opens.

A CNC Part Program - Protocol Selection dialog box opens when you use any method.

Method 5

a. Click Programs on the CNC Quikstart Main Menu.

b. Select the protocol you are using.

c. Click OK.

d. Continue  based on your selection.

• FOCAS/HSSB

• FOCAS/Ethernet

FOCAS/HSSB

A CNC Part Program – Node Selection dialog box opens.

a. Select a node from the Available node list.

b. Click OK.

FOCAS/Ethernet
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A CNC Part Program –  Network Selection dialog box opens.

A.   Enter the following.

Field Description

Host Valid IP address for the host or select one from the available 

list.

Port Port number the address is hooked to.

Timeout

B.   Click OK.

Step 3. Work in the CNC Part Program Window

Step 3. Work in the CNC Part Program Window

The Part Program Application window provides several features to work with part program files as 

follows.
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1. Option 3.1. Download a Part Program to the CNC  (on page 375)

2. Option 3.1. Download a Part Program to the CNC  (on page 375)

3. Option 3.2. Delete Part Programs on your PC  (on page 377)

4. Option 3.3. Upload a Part Program to a PC  (on page 378)

5. Option 3.4. Delete Part Programs on your CNC  (on page 380)

6. Option 3.5. Rename PC Files through the Part Program Window  (on page 381)

7. Option 3.7. Open a PC File through the CNC Part Program Window  (on page 386)

8. Option 3.6. Rename CNC Files through the Part Program Window  (on page 383)

9. Option 3.8. Open a CNC File through the CNC Part Program Window  (on page 388)

10. Option 3.9. Select and Rewind Part Programs  (on page 390)

11. Option 3.3. Upload a Part Program to a PC  (on page 378)

12. Option 3.2. Delete Part Programs on your PC  (on page 377)

13. Option 3.4. Delete Part Programs on your CNC  (on page 380)

14. Option 3.10. Exit the Part Program Window  (on page 392)

Option 3.1 

(on page 

375)

Download a part program to the CNC.



Addons and Options  | 3 - HMI for CNC  | 375

Option 3.2 

(on page 

377)

Delete part programs on your PC.

Option 3.3 

(on page 

378)

Upload a part program to a PC.

Option 3.4 

(on page 

380)

Delete part programs on your CNC.

Option 3.5 

(on page 

381)

Rename PC files through the part program window.

Option 3.6 

(on page 

383)

rename CNC files through the part program window.

Option 3.7 

(on page 

386)

Open a PC file through the CNC Part Program window.

Option 3.8 

(on page 

388)

Open a CNC file through the CNC Part program win

dow.

Option 3.9 

(on page 

390)

Select and rewind part programs

Option 3.10 

(on page 

392)

Exit the Part Program window.

Option 3.1. Download a Part Program to the CNC

Download part programs to a CNC as follows.
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Step Description

1 (Optional) Select the path. The path number is enabled if the device model supports multiple 

paths. The selected path from the drop down list is the path on the CNC to which files will be 

downloaded.

2 Check Download in the Select Mode  box.

3 Select the directory in which the part program files are stored in the Programs on PC  field.

Browse opens the the Open browser to help find the directory. The files in the selected directory 

display in the Programs on PC  box.

4 Select the files in the Programs on PC  box that will be downloaded to the CNC. The selected file

names have a .pro extension, or another that may have been assigned to the file.

5 Click Add. The files are moved to the Selected Programs  box.

6 Click Download.

Results
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• Part programs are downloaded to the CNC, one at a time.

• The file name extensions (.pro) are removed.

• The download process is reported in the Messages box.

• Part programs that are not downloaded due to errors are shown in the Messages area.

Option 3.2. Delete Part Programs on your PC

Delete part programs from your PC as follows.

1 Check Delete from PC in the Select Mode  box.

2 Select the directory in which the part program files are stored in the Programs on PC 

field.
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Browse Opens the Open browser to help find the directory.

The files in the selected directory display in the Programs on PC  box.

3 Select the files that will be deleted from the PC.

4 Click Add.

The files are moved to the Selected Programs  box.

5 Click Delete.

Result: Part programs are deleted from your PC one by one. The delete process is reported in the 

Messages box.

Option 3.3. Upload a Part Program to a PC

Upload part programs to a PC as follows.
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1 (Optional) Select the path.

Note:  The path number is enabled if the device model supports multiple paths. The selected path 

from the drop down list is the path on the CNC from which files will be uploaded.

2 Check Upload in the Select Mode box.

3 (Optional) Click Refresh.

The file display in the Programs on CNC box  is brought up-to-date.

4 Select the files in the Programs on CNC  box that will be uploaded to the PC.

Note:  The filenames have no extensions.

5 Click Add.

The files are moved to the Selected Programs  box.

6 Click Upload.

Results
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• Part programs are uploaded to the PC, one at a time.

• The file is created in the directory displayed in the Programs on PC  box.

• The filename extension (e.g. .pro) is added to each of the files.

• The upload process is reported in the Messages box.

Option 3.4. Delete Part Programs on your CNC

Delete part programs from your CNC as follows.

1 (Optional) Select the path.

The path number is enabled if the device model supports multiple paths. The selected path from the 

drop down list is the path on the CNC from which files will be deleted.

2 Check Delete from CNC in the Select Mode box.
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3 (Optional) Click Refresh.

The file display in the Programs on CNC box  is brought up-to-date.

4 Select the files in the Programs on CNC  box that will be deleted from the CNC.

Note:  The filenames have no extensions.

5 Click Add.

The files are moved to the Selected Programs  box.

6 Click Delete.

Results

• The selected part programs are deleted from your CNC, one by one.

• The process is reported in the Messages area.

Option 3.5. Rename PC Files through the Part Program Window

Rename a part program file on the PC as follows.
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1 Check either Download or Delete from PC in the Select Mode  box.

2 Select the directory in which the part program files are stored in the Programs on PC  field.

Browse Opens the Open browser to help find the directory.

The files in the selected directory display in the Programs on PC  box.

3 Select a file to rename in the Programs on PC  box.

Note:  The selected filenames have a three letter extension, e.g. .pro.

4 Do one of the following.

• Click the Rename button on the CNC Part Program window toolbar.

• Click File>Rename on the CNC Part Program window file menu.

• Press Ctrl+N on the keyboard.

A Rename File dialog box opens.

5 Enter a new file name with the correct three letter extension, e.g. .pro, in the New Name  field.
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6 Click OK.

Result: The new filename displays in the Programs on PC box.

1. A message informs you that the name change is successful.

2. The renamed file displays in the:

Programs on PC  box.

Note:

Files in the Selected Programs  box can be renamed, regardless of what is checked in the 

Select Mode  box.

Option 3.6. Rename CNC Files through the Part Program Window

Rename a part program file on the CNC as follows.
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1 (Optional) Select the path.

Note:  The path number is enabled if the device model supports multiple paths. The selected path 

from the drop down list is the path on the CNC in which files can be selected to be renamed.

2 Check either Upload or Delete from CNC in the Select Mode  box.

3 (Optional) Click Refresh.

The file display in the Programs on CNC box  is brought up-to-date.

4 Select a file to rename in the Programs on CNC  box.

Note:  The selected filenames have no extension.

5 Do one of the following.

• Click the Rename button on the CNC Part Program window toolbar.

• Click File>Rename on the CNC Part Program window file menu.

• Press Ctrl+N on the keyboard.

A Rename File dialog box opens.
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6 Enter a new file name with no extension New Name  field.

Messages inform you that the current file is uploaded to an ...\Temp\CNCO00004 file. The temporary 

file will be deleted when the application exits.

7 Click OK.

Results

1. Messages inform you that:

A The file has been successfully renamed to Onnnnnnnn, e.g. 

O00000333

B The original file name, e.g. O0004, has been deleted.

2. The renamed file displays in the:

Programs on CNC  box.



Addons and Options  | 3 - HMI for CNC  | 386

Note:

Files in the Selected Programs  box can be renamed, regardless of what is checked in the 

Select Mode  box.

Option 3.7. Open a PC File through the CNC Part Program Window

Note:

The program file extension, e.g. .pro, needs to be associated with a text editor for the file to open 

automatically. If it is not, a message will display asking you to find an application to open the file.

Consult Windows documentation for information about associating files with applications.

Open a part program file that is on the PC, as follows.
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1 Check either Download or Delete from PC in the Select Mode  box.

2 Select the directory in which the part program files are stored in the Programs on PC  field.

Browse Opens the Open browser to help find the directory.

The files in the selected directory display in the Programs on PC  box.

3 Select a file to open in the Programs on PC  box.

Note:  The selected filenames have a three letter extension, e.g. .pro.

4 Do one of the following.

• Click the Open button on the CNC Part Program window toolbar.

• Click File>Open on the CNC Part Program window file menu.

• Press Ctrl+O on the keyboard.

Result: The associated text editor, e.g. Notepad, opens the file.
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Option 3.8. Open a CNC File through the CNC Part Program Window

Note:

The program file extension, e.g. .pro, needs to be associated with a text editor for the file to open 

automatically. If it is not, a message will display asking you to find an application to open the file.

Consult Windows documentation for information about associating files with applications.

Open a part program file that is on the PC, as follows.
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1 (Optional) Select the path.

Note:  The path number is enabled if the device model supports multiple paths. The selected path 

from the drop down list is the path on the CNC in which files can be selected to be opened.

2 Check either Upload or Delete from CNC in the Select Mode  box.

3 (Optional) Click Refresh.

The file display in the Programs on CNC box  is brought up-to-date.

4 Select a file to open in the Programs on CNC  box.

Note:  The selected filenames do not have an extension.

5 Do one of the following.

• Click the Open button on the CNC Part Program window toolbar.

• Click File>Open on the CNC Part Program window file menu.

• Press Ctrl+O on the keyboard.

Results
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1. Messages inform you that:

A The file is uploading.

B A ...\Temp\CNCOnnnnnnnn temporary file will be deleted when the application ex

its.

2. The associated text editor, e.g. Notepad, opens the file.

The filename has a CNC prefix.

Example

Selected file O0004 displays as CNCO0004 on the text editor title bar.

Option 3.9. Select and Rewind Part Programs

A program that you select and rewind is loaded into memory on the CNC and then rewound to the 

beginning.
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1 (Optional) Select the path.

Note:  The path number is enabled if the device model supports multiple paths. The selected path 

from the drop down list is the path on the CNC in which files can be selected for rewind.

2 Check either Upload or Delete from CNC in the Select Mode  box.

3 (Optional) Click Refresh.

The file display in the Programs on CNC box  is brought up-to-date.

4 Select a file to rewind in the Programs on CNC  box.

5 Click Select and Rewind.

Result: The program is loaded into memory on the CNC and then rewound to the beginning.

Select and Rewind Error

If either of the following messages is displayed:
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• CNC is not in EDIT mode.

• CNC is not in EDIT or MEMORY mode.

• Ensure that the CNC is in the correct mode.

Option 3.10. Exit the Part Program Window

Exit the Part Program application, as follows.

Do any of the following.

• Click Exit.

• Click File>Exit on the Part Program window menu bar.

• Press Ctrl+X on the keyboard.

Part Program Troubleshooting

• Unexpected files on PC.

• Select and rewind error.
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Unexpected  Files on PC

Problem

Unexpected files have names with the format of CNCOxxxx

Guideline

The files are temporary files created during the opening or renaming of part programs on your CNC.

Define the TMP or TEMP environment variable on your computer.

Select  and Rewind Error

Problem

One of the following messages displays.

CNC is not in EDIT mode.

CNC is not in EDIT or MEMORY mode.

Guideline

Ensure that the CNC is in the correct mode.

Use the Programs on PC edit box

You can use the Programs on PC edit box to locate a part program on your PC.

To use Programs on PC edit box:

1. In the Programs on PC edit box, type the fully qualified path for the part program using the 

following format:

drive:\[directory1\directory2\&ldots;]\[filename]

2. Click outside of the edit box.

The CNC Part Program application searches for the program and returns the result in the Programs on PC 

list box.
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Tip:

You can use a ? (question mark) or an * (asterisk) as wild cards in the file name to expand search 

criteria.

CNC Command Line Utilities

CNC Command Line Utilities

The CNC Command Line Utilities enable you to:

• Manage and display CNC part program and file data by entering commands at the MS DOS prompt.

• Batch programming to create automated procedures.

This functionality extends to any existing directories and files on your PC network.

Associated utilities include:

CNC Part Program Command Line Utilities

• FOCAS/HSSB

• FOCAS/Ethernet

CNC File Data Command Line Utilities

• FOCAS/HSSB

• FOCAS/Ethernet

CNC Dynamic Link Library Graphic Overview

Using the CNC dynamic link library a request is made and responded to.
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1. #unique_255_Connect_42_i1  (on page 395)

2. #unique_255_Connect_42_i2  (on page 395)

3. #unique_255_Connect_42_i3  (on page 395)

4. #unique_255_Connect_42_i3  (on page 395)

1 CNC data request.

2 Application request.

3 CNC data for application..

4 CNC data response.

CNC Part Program Command Line Utilities for FOCAS/HSSB

CNC Part Program Command Line Utilities for FOCAS/HSSB

The CNC Part Program Command Line Utilities for FOCAS/HSSB enable you to:

• Manage and display part programs using an MS DOS window.

• Perform most of the same functions as the CNC Part Program application by entering the 

appropriate commands.

• Use any existing directories and part programs on your PC network.
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CNC Part Program command line utilities for FOCAS/HSSB are:

• cnc_upload.exe

• cnc_download.exe

• cnc_delete.exe

• cnc_dir.exe

• cnc_select.exe

cnc_upload.exe

Purpose

Upload a single part program or a sequence of part programs from CNC memory to a single file on the PC.

Correct usage

C:\> cnc_upload <nodenum> <pathnum> <filespec> <startprogram> <endprogram>

Usage Defined

<noden

um>

Node number (configured HSSB card).

<pathn

um>

CNC path. Enter one of the following.

Value Path

0 None

1 First

2 Second

3 Third

4 Fourth Series 30i/31i/32i only

5 Fifth Series 30i/31i/32i only

6 Sixth Series 30i/31i/32i only

7 Seventh Series 30i/31i/32i only

8 Eighth Series 30i/31i/32i only
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9 Ninth Series 30i/31i/32i only

10 Tenth Series 30i/31i/32i only

If the CNC does not support multiple paths, enter 0.

<filesp

ec>

File specification of file to receive the uploaded part program(s). This may be a fully qualified 

filename or a filename in the current directory.

<startpr

ogram>

Starting range of part programs to upload.

<endprog

ram>

Ending range of part programs to upload.

Example

The contents of CNC part programs between <startprogram>  and <endprogram>  are uploaded to the 

<filespec>  for <nodenum>  and <pathnum>:

C:\> cnc_upload 0 0 test.pp 1 10

Uploading part programs O0001 – O0010 to test.pp: Success

C:\>

The file test.pp is either created or overwritten with all the part programs in the range of 1  to 10  currently 

registered in CNC memory.

Following is a list of possible errors:

• Could not determine CNC type for node x.

• Failure to get directory info.

• Bad directory info returned.

cnc_download.exe

Purpose

Download one or more files from the PC to CNC memory. Each file may contain a single part program or a 

sequence of part programs.

Correct usage

C:\> cnc_download <nodenum> <pathnum> <filespec1> [<filespec2>] [<filespec3>]&ldots;



Addons and Options  | 3 - HMI for CNC  | 398

Usage defined

<no

den

um>

Node number (configured HSSB card).

<pa

thn

um>

CNC path. Enter one of the following.

Value Path

0 None

1 First

2 Second

3 Third

4 Fourth Series 30i/31i/32i only

5 Fifth Series 30i/31i/32i only

6 Sixth Series 30i/31i/32i only

7 Seventh Series 30i/31i/32i only

8 Eighth Series 30i/31i/32i only

9 Ninth Series 30i/31i/32i only

10 Tenth Series 30i/31i/32i only

If the CNC does not support multiple paths, enter 0.

<fi

les

p

ec>

File specification. Each file specification indicates a single file containing part program(s) to 

download. This may be a fully qualified filename or a filename in the current directory.

Example

The contents of each file is downloaded to CNC memory and displays success or failure status when it is 

complete:
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C:\> cnc_download 0 0 c:\O0001.pp c:\O0002.pp c:\O0003.pp

Beginning download:

C:\O0001.pp: Success

C:\O0002.pp: File open failed

C:\O0003.pp: Success

C:\>

The O0001.pp and O0003.pp part program files have been downloaded and registered in CNC memory. 

The part program O0002.pp could not be opened and was not processed.

The following is a list of possible errors:

• File not found.

• Failed to open file for reading.

• File contains bad program.

• CNC write protect.

• CNC out of memory.

cnc_delete.exe

Purpose

Delete one or more part programs from CNC memory.

Correct usage

C:\> cnc_delete <nodenum> <pathnum> <prognum1> [<prognum2>] [<prognum3>] &ldots;

Usage defined

<nodenum> Node number (configured HSSB card).

<pathnum> CNC path. Enter one of the following.

Value Path

0 None

1 First

2 Second

3 Third
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4 Fourth Series 30i/31i/32i only

5 Fifth Series 30i/31i/32i only

6 Sixth Series 30i/31i/32i only

7 Seventh Series 30i/31i/32i only

8 Eighth Series 30i/31i/32i only

9 Ninth Series 30i/31i/32i only

10 Tenth Series 30i/31i/32i only

If the CNC does not support multiple paths, enter 0.

<prognum> Represents one or more part program numbers to 

delete.

Example

The contents of each part program are deleted from CNC memory. A success or failure status displays 

when each deletion completes:

C:\>cnc_delete 0 0 1 4 660 5000

Deleting part program O0001: Success

Deleting part program O0004: Success

Deleting part program O0660: Data error

Deleting part program O5000: Success

C:\>

The part programs O0001, O0004 and O5000 have been deleted from CNC memory. The part program 

O0660 did not exist on the CNC and was not processed.

The following is a list of possible errors:

• Program does not exist on CNC.

• CNC memory protected.

cnc_dir.exe

Purpose

Display a directory of registered part programs in CNC memory.
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Correct usage

C:\> cnc_dir <nodenum> <pathnum> [/w]

Usage defined

<nodenum> Node number (configured HSSB card).

<pathnum> CNC path. Enter one of the following.

Value Path

0 None

1 First

2 Second

3 Third

4 Fourth Series 30i/31i/32i only

5 Fifth Series 30i/31i/32i only

6 Sixth Series 30i/31i/32i only

7 Seventh Series 30i/31i/32i only

8 Eighth Series 30i/31i/32i only

9 Ninth Series 30i/31i/32i only

10 Tenth Series 30i/31i/32i only

If the CNC does not support multiple paths, enter 0.

 

                  /w

                

Optional request for a wide directory listing.

Example

A directory of part programs registered in CNC memory is displayed, along with comments and sizes:

C:\> cnc_dir 0 0

Program Comment        Size

O0020 TEST PROGRAM 20    216

O0038 TEST PROGRAM 38    432
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O0039 TEST PROGRAM 39    288

O0040 TEST PROGRAM 40    288

O0041 TEST PROGRAM 41    216

O0042 TEST PROGRAM 42    720

6 Total file(s).

C:\> cnc_dir 0 0 /w

O0020   O0038   O0039   O0040   O0041   O0042

6 Total file(s).

C:\>

Following is a list of possible errors:

• Bad directory info.

• CNC memory protected.

cnc_select.exe

Purpose

The command line utility cnc_select.exe  selects one part program in CNC memory.

Correct usage

C:\> cnc_select <nodenum> <pathnum> <prognum>

Usage Defined

<nodenum> Node number (configured HSSB card).

<pathnum> CNC path. Enter one of the following.

Value Path

0 None

1 First

2 Second

3 Third

4 Fourth Series 30i/31i/32i only

5 Fifth Series 30i/31i/32i only
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6 Sixth Series 30i/31i/32i only

7 Seventh Series 30i/31i/32i only

8 Eighth Series 30i/31i/32i only

9 Ninth Series 30i/31i/32i only

10 Tenth Series 30i/31i/32i only

If the CNC does not support multiple paths, enter 0.

<program> Represents the part program to select.

Example

The part program was found and selected in CNC memory. A success or failure status displays when the 

selection completes:

C:\>cnc_select 0 0 5000

Selecting part program 05000: Successful

C:\>

The part program 05000 was found and selected in CNC memory.

Following is a list of possible errors:

• Program does not exist on CNC.

• CNC in wrong mode.

CNC Part Program Command Line Utilities for FOCAS/Ethernet

CNC Part Program Command Line Utilities for FOCAS/Ethernet

The CNC Part Program Command Line Utilities for FOCAS/Ethernet enable you to:

• Manage and display part programs using an MS DOS window.

• Perform most of the same functions as the CNC Part Program application by entering the 

appropriate commands.

• Use any existing directories and part programs on your PC network.

CNC Part Program command line utilities for FOCAS/Ethernet are:
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• cnc_eupload.exe

• cnc_edownload.exe

• cnc_edelete.exe

• cnc_edir.exe

• cnc_eselect.exe

cnc_eupload.exe

Purpose

Upload a single part program or a sequence of part programs from CNC memory to a single file on the PC.

Correct Usage

C:\> cnc_eupload <ipaddr> <portnum> <pathnum> <filespec> <startprogram> <endprogram>

Usage Defined

<ipaddr> IP address of the CNC.

<portn

um>

Port number of the CNC.

<pathn

um>

CNC path. Enter one of the following.

Value Path

0 None

1 First

2 Second

3 Third

4 Fourth Series 30i/31i/32i only

5 Fifth Series 30i/31i/32i only

6 Sixth Series 30i/31i/32ionly

7 Seventh Series 30i/31i/32i only

8 Eighth Series 30i/31i/32i only
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9 Ninth Series 30i/31i/32i only

10 Tenth Series 30i/31i/32i only

If the CNC does not support multiple paths, enter 0.

<filesp

ec>

File specification of file to receive the uploaded part program(s). This may be a fully qualified 

filename or a filename in the current directory.

<startpr

ogram>

Starting range of part programs to upload.

<endprog

ram>

Ending range of part programs to upload.

Example

The contents of CNC part programs between <startprogram>  and <endprogram>  are uploaded to the 

<filespec>  for <ipaddr>, <portnum> and <pathnum>:

C:\> cnc_eupload 3.26.7.150 8172 0 test.pp 1 10

Uploading part programs O0001 – O0010 to test.pp: Success

C:\>

The file test.pp is either created or overwritten with all the part programs in the range of 1  to 10  currently 

registered in CNC memory.

Following is a list of possible errors.

• Could not determine CNC type for node x.

• Failure to get directory info.

• Bad directory info returned.

cnc_edownload.exe

Purpose

Download one or more files from the PC to CNC memory. Each file may contain a single part program or a 

sequence of part programs.

Correct usage

C:\> cnc_edownload <ipaddr> <portnum> <pathnum> <filespec1> [<filespec2>] [<filespec3>]&ldots;
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Usage defined

<ip

ad

dr>

IP address of the CNC.

<po

rtn

um>

Port number of the CNC.

<pa

thn

um>

CNC path. Enter one of the following.

Value Path

0 None

1 First

2 Second

3 Third

4 Fourth Series 30i/31i/32i only

5 Fifth Series 30i/31i/32i only

6 Sixth Series 30i/31i/32i only

7 Seventh Series 30i/31i/32ionly

8 Eighth Series 30i/31i/32ionly

9 Ninth Series 30i/31i/32ionly

10 Tenth Series 30i/31i/32i only

If the CNC does not support multiple paths, enter 0.

<fi

les

p

ec>

File specification. Each file specification indicates a single file containing part program(s) to 

download. This may be a fully qualified filename or a filename in the current directory.
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Example

The contents of each file is downloaded to the CNC and displays success or failure status when it is 

complete:

C:\> cnc_edownload 3.26.7.150 8172 0 c:\O0001.pp c:\O0002.pp c:\O0003.pp

Beginning download:

C:\O0001.pp: Success

C:\O0002.pp: File open failed

C:\O0003.pp: Success

C:\>

The O0001.pp and O0003.pp part program files have been downloaded and registered in CNC memory. 

The part program O0002.pp could not be opened and was not processed.

Following is a list of possible errors.

• File not found.

• Failed to open file for reading.

• File contains bad program.

• CNC write protect.

• CNC out of memory.

cnc_edelete.exe

Purpose

Delete one or more part programs from CNC memory.

Correct usage.

C:\> cnc_edelete <ipaddr> <portnum> <pathnum> <prognum1> [<prognum2>] [<prognum3>] &ldots;

Usage defined

<ipaddr> IP address of the CNC.

<portnum> Port number of the CNC.

<pathnum> CNC path. Enter one of the following.

Value Path
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0 None

1 First

2 Second

3 Third

4 Fourth Series 30i/31i/32i only

5 Fifth Series 30i/31i/32i only

6 Sixth Series 30i/31i/32ionly

7 Seventh Series 30i/31i/32i only

8 Eighth Series 30i/31i/32i only

9 Ninth Series 30i/31i/32ionly

10 Tenth Series 30i/31i/32i only

If the CNC does not support multiple paths, enter 0.

<prognum> One or more part program numbers to delete.

Example

In the following example, the contents of each part program are deleted from CNC memory. A success or 

failure status displays when each deletion completes:

C:\>cnc_edelete 3.26.7.150 8172 0 1 4 660 5000

Deleting part program O0001: Success

Deleting part program O0004: Success

Deleting part program O0660: Data error

Deleting part program O5000: Success

C:\>

The part programs O0001, O0004 and O5000 have been deleted from CNC memory. The part program 

O0660 did not exist on the CNC and was not processed.

Following is a list of possible errors.

• Program does not exist on CNC.

• CNC memory protected.
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cnc_edir.exe

Purpose

Display a directory of registered part programs in CNC memory.

Correct usage

C:\> cnc_edir <ipaddr> <portnum> <pathnum> [/w]

Usage defined

<ipaddr> IP address of the CNC.

<portnum> Port number of the CNC.

<pathnum> CNC path. Enter one of the following.

Value Path

0 None

1 First

2 Second

3 Third

4 Fourth Series 30i/31i/32i only

5 Fifth Series 30i/31i/32i only

6 Sixth Series 30i/31i/32i only

7 Seventh Series 30i/31i/32i only

8 Eighth Series 30i/31i/32i only

9 Ninth Series 30i/31i/32i only

10 Tenth Series 30i/31i/32i only

If the CNC does not support multiple paths, enter 0.

 

                  /w

                

Optional request for a wide directory listing.
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Example

A directory of part programs registered in CNC memory is displayed, along with comments and sizes:

C:\> cnc_edir 3.26.7.150 8172 0

Program Comment         Size

O0020 TEST PROGRAM 20     216

O0038 TEST PROGRAM 38     432

O0039 TEST PROGRAM 39     288

O0040 TEST PROGRAM 40     288

O0041 TEST PROGRAM 41     216

O0042 TEST PROGRAM 42     720

6 Total file(s).

C:\> cnc_edir 3.26.7.150 8172 0 /w

O0020   O0038   O0039   O0040   O0041    O0042

6 Total file(s).

C:\>

Following is a list of possible errors:

• Bad directory info.

• CNC memory protected.

cnc_eselect.exe

Purpose

Select one part program in CNC memory.

Correct usage

C:\> cnc_eselect <ipaddr> <portnum> <pathnum> <prognum>

Usage Defined

<ipaddr> IP address of the CNC.

<portnum> Port number of the CNC.

<pathnum> CNC path. Enter one of the following.

Value Path
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0 None

1 First

2 Second

3 Third

4 Fourth Series 30i/31i/32i only

5 Fifth Series 30i/31i/32i only

6 Sixth Series 30i/31i/32i only

7 Seventh Series 30i/31i/32i only

8 Eighth Series 30i/31i/32i only

9 Ninth Series 30i/31i/32i only

10 Tenth Series 30i/31i/32i only

If the CNC does not support multiple paths, enter 0.

<program> Part program to select.

Example

The part program was found and selected in CNC memory. A success or failure status displays when the 

selection completes:

C:\> cnc_eselect 3.26.7.150 8172 5000

Selecting part program 05000: Successful

C:\>

The part program 05000 was found and selected in CNC memory.

Following is a list of possible errors.

• Program does not exist on CNC.

• CNC in wrong mode.

CNC File Data Command Line Utilities for FOCAS/HSSB

CNC File Data Command Line Utilities for FOCAS/HSSB
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The CNC File Data Command Line Utilities for FOCAS/HSSB enable you to manage and display CNC 

file data in an MS DOS window. You can upload or download CNC file data by entering the appropriate 

commands.

• The following CNC file data can be uploaded to your PC from the CNC.

• Parameter

• Tool offset

• Work zero offset

• Custom macro variable

• Pitch error compensation

• Keep relay

• Diagnostic data

• All of the CNC file data and most of the keep relay data can be downloaded from your PC to the 

CNC.

The CNC Part Program command line utilities for FOCAS/HSSB to upload and download are:

• cnc_upload_tool.exe

• cnc_download_tool.exe

cnc_upload_tool.exe

Purpose

The command line utility cnc_upload_tool.exe  uploads CNC file data from CNC memory to files on the PC.

Correct usage

C:\> cnc_upload_tool <data> <nodenum> <pathnum> <filespec.csv> <start> <end>

Usage defined

<da

ta>

CNC file data. Enter one of the following.

parm Parameter Data

tofs Tool Offset Data

zofs Work Zero Offset Data

cmv Custom Macro Variable Data
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pec Pitch Error Compensation

kbit Keep Relay Data

diag Diagnostic Data

<no

den

um>

Node number (configured HSSB card).

<pa

thn

um>

Path to the CNC. Enter one of the following.

Value Path

0 None

1 First

2 Second

3 Third

4 Fourth Series 30i/31i/32i only

5 Fifth Series 30i/31i/32i only

6 Sixth Series 30i/31i/32i only

7 Seventh Series 30i/31i/32i only

8 Eighth Series 30i/31i/32i only

9 Ninth Series 30i/31i/32i only

10 Tenth Series 30i/31i/32i only

If the CNC does not support multiple paths, enter 0.

<fi

les

p

ec>

File specification of file to receive the uploaded data. This may be a fully qualified filename or a 

filename in the current directory in comma separated variable (.csv) format.

<st

a

rt>

Starting range of file data to upload.
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<e

nd>

Ending range of file data to upload.

If both the start and end are left blank, all of the specified data for the CNC is uploaded.

Example

The contents of the CNC parameter data table between <start>  and <end>  are uploaded to the <filespec> 

for <nodenum>and <pathnum>:

C:\> cnc_upload_tool parm 0 0 parm1000.csv 1 1000

Uploading parm 0001 - 1000 to parm1000.csv: Success

C:\>

The file parm1000.csv  is either created or overwritten with all the parameters in the range of 1  to 1000 

currently registered in CNC memory. The file upload_tool_log.csv  is either created or overwritten with any 

errors during the upload.

In the following example, the entire contents of the CNC parameter data table is uploaded to the 

<filespec>  for <nodenum>and <pathnum>:

C:\> cnc_upload_tool parm 0 0 parmall.csv

Uploading all parm to parmall.csv: Success

C:\>

The file parmall.csv  is either created or overwritten with all the parameters currently registered in CNC 

memory. The file upload_tool_log.csv  is either created or overwritten with any errors during the upload.

The following is a list of possible errors:

• Could not determine CNC type for node x.

• Could not link to DLL.

• Failure to get directory info.

• Bad directory info returned.

cnc_download_tool.exe

Purpose

Download CNC file data from files on the PC to CNC memory.
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Correct usage

C:\> cnc_download_tool <data> <nodenum> <pathnum> <filespec.csv>

Usage defined

<da

ta>

CNC file data. Enter one of the following.

parm Parameter Data

tofs Tool Offset Data

zofs Work Zero Offset Data

cmv Custom Macro Variable Data

pec Pitch Error Compensation

kbit Keep Relay Data

<no

den

um>

Node number (configured HSSB card).

<pa

thn

um>

Path to the CNC. Enter one of the following.

Value Path

0 None

1 First

2 Second

3 Third

4 Fourth Series 30i/31i/32i only

5 Fifth Series 30i/31i/32i only

6 Sixth Series 30i/31i/32ionly

7 Seventh Series 30i/31i/32i only

8 Eighth Series 30i/31i/32i only
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9 Ninth Series 30i/31i/32i only

10 Tenth Series 30i/31i/32i only

If the CNC does not support multiple paths, enter 0.

<fi

les

p

ec>

File specification of file to receive the uploaded data. This may be a fully qualified filename or a 

filename in the current directory in comma separate variable (.csv) format.

Example

The contents of the file parm1000.csv  is downloaded to the CNC parameter data table <nodenum>  and 

<pathnum>:

C:\> cnc_download_tool parm 0 0 parm1000.csv

Downloading parm for parmall.csv: Success

C:\>

The file download_tool_log.csv  is either created or overwritten with any errors during the download.

Following is a list of possible errors.

• Could not determine CNC type.

• Could not link to DLL.

• Failure to get directory info.

• Bad directory info returned.

CNC File Data Command Line Utilities for FOCAS/Ethernet

CNC File Data Command Line Utilities for FOCAS/Ethernet

The CNC File Data Command Line Utilities for FOCAS/Ethernet enable you to manage and display CNC 

file data in an MS DOS window.  You can upload or download CNC file date by entering the appropriate 

commands.

• The following CNC file data can be uploaded to your PC from the CNC.

• Parameter

• Tool offset

• Work zero offset
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• Custom macro variable

• Pitch error compensation

• Keep relay

• Diagnostic data

• All of the CNC file data and most of the keep relay data can be downloaded from your PC to the 

CNC.

The CNC Part Program command line utilities for FOCAS/Ethernet to upload and download are:

• cnc_eupload_tool.exe

• cnc_edownload_tool.exe

cnc_eupload_tool.exe

Purpose

Upload CNC file data from CNC memory to files on the PC.

Correct usage

C:\> cnc_eupload_tool <data> <ipaddr> <portnum> <pathnum> <filespec.csv> <start> <end>

Usage defined

<da

ta>

CNC file data. Enter one of the following.

parm Parameter Data

tofs Tool Offset Data

zofs Work Zero Offset Data

cmv Custom Macro Variable Data

pec Pitch Error Compensation

kbit Keep Relay Data

diag Diagnostic Data

<ip

ad

dr>

IP address of the CNC.
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<po

rtn

um>

Port number of the CNC.

<pa

thn

um>

Path to the CNC. Enter one of the following.

Value Path

0 None

1 First

2 Second

3 Third

4 Fourth Series 30i/31i/32i only

5 Fifth Series 30i/31i/32i only

6 Sixth Series 30i/31i/32i only

7 Seventh Series 30i/31i/32i only

8 Eighth Series 30i/31i/32i only

9 Ninth Series 30i/31i/32i only

10 Tenth Series 30i/31i/32i only

If the CNC does not support multiple paths, enter 0.

<fi

les

p

ec>

File specification of file to receive the uploaded data. This may be a fully qualified filename or a 

filename in the current directory in comma separated variable (.csv) format.

<st

a

rt>

Starting range of file data to upload.

<e

nd>

Ending range of file data to upload.

If both the start and end are left blank, all of the specified data for the CNC is uploaded.
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Example

The contents of the CNC parameter data table between <start>  and <end>  are uploaded to the <filespec> 

for <ipaddr>, <portnum> and <pathnum>:

C:\> cnc_eupload_tool parm 3.26.7.150 8172 0 parm1000.csv 1 1000

Uploading parm 0001 - 1000 to parm1000.csv: Success

C:\>

The file parm1000.csv  is either created or overwritten with all the parameters in the range of 1  to 1000 

currently registered in CNC memory. The file upload_tool_log.csv  is either created or overwritten with any 

errors during the upload.

In the following example, the entire contents of the CNC parameter data table is uploaded to the 

<filespec>  for <ipaddr>, <portnum> and <pathnum>:

C:\> cnc_eupload_tool parm 3.26.7.150 8172 0 parmall.csv

Uploading all parm to parmall.csv: Success

C:\>

The file parmall.csv  is either created or overwritten with all the parameters currently registered in CNC 

memory. The file upload_tool_log.csv  is either created or overwritten with any errors during the upload.

Following is a list of possible errors:

• Could not determine CNC type for node x.

• Could not link to DLL.

• Failure to get directory info.

• Bad directory info returned.

cnc_edownload_tool.exe

Purpose

Download CNC File data.

The command line utility cnc_edownload_tool.exe  downloads CNC file data from files on the PC to CNC 

memory.

Correct usage

The following is the correct usage.
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C:\> cnc_edownload_tool <data> <ipaddr> <portnum> <pathnum> <filespec.csv>

User defined

<da

ta>

CNC file data. Enter one of the following.

parm Parameter Data

tofs Tool Offset Data

zofs Work Zero Offset Data

cmv Custom Macro Variable Data

pec Pitch Error Compensation

kbit Keep Relay Data

<ip

ad

dr>

IP address of the CNC.

<po

rtn

um>

Port number of the CNC.

<pa

thn

um>

CNC path. Enter one of the following.

Value Path

0 None

1 First

2 Second

3 Third

4 Fourth Series 30i/31i/32i only

5 Fifth Series 30i/31i/32i only

6 Sixth Series 30i/31i/32i only

7 Seventh Series 30i/31i/32i only
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8 Eighth Series 30i/31i/32i only

9 Ninth Series 30i/31i/32i only

10 Tenth Series 30i/31i/32i only

If the CNC does not support multiple paths, enter 0.

<fi

les

p

ec>

File specification of file to receive the uploaded data. This may be a fully qualified filename or a 

filename in the current directory in comma separate variable (.csv) format.

Example

The contents of the file parm1000.csv  is downloaded to the CNC parameter data table <ipaddr>, 

<portnum>  and <pathnum>:

C:\> cnc_edownload_tool parm 3.26.7.150 8172 0 parm1000.csv

Downloading parm for parmall.csv: Success

C:\>

The file download_tool_log.csv  is either created or overwritten with any errors during the download.

Following is a list of possible errors.

• Could not determine CNC type.

• Could not link to DLL.

• Failure to get directory info.

• Bad directory info returned.

Error Handling

Error Handling

Descriptions about error codes and handling errors are as follows.

• Connection error handling.

• CNC Data window error handling.

• Ethernet version only error handling.

• PMC Data window error handling.
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Note:

Consult FANUC CNC documentation for more details about handling error codes.

Connection Error Handling

The PC must be able to communicate successfully with the CNC.

If communication fails, run the  test_cnc  (on page 196)   utility in order to verify communication to the 

CNC.

Suggestions to resolve communication problems.

• HSSB.

• Ethernet.

HSSB

If you do not receive a response when you try to connect to the CNC.

1. Check to see if any other PC-vendor printed circuit board is using the HSSB assigned I/O address.

2. Check the rotary switch settings on the CNC-based HSSB printed circuit board.

The switch should be set to 1 to start up in normal mode. (If you change the setting, remember to 

cycle CNC power.)

3. Reboot the PC and look at Windows Boot Log or the CIMPLICITY supportedoperating system 

System Log for errors that HSSB Driver is installed.

4. Verify that the target CNC has the correct software and the option is enabled.

5. Verify that the green LED located on the HSSB PC printed circuit board is ON after the CNC/ PC 

boot. This LED is visible from the rear of the PC next to the fiber optic connection.

6. Reboot the PC and CNC after changing any setup configuration data.

Ethernet

If you do not receive a response when you ping the IP address:

7. Check with your Network Administrator to ensure that the

◦ IP address is not in use by another device,

◦ Subnet mask is correct for the device.

8. Reboot the PC and CNC after changing any setup configuration data.
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CNC Data Window Error Handling

Re

turn
Meaning Explanation Error Handling

EW_

PRO

TO

COL 

 (-

17)

Protocol error 

Ethernet version 

only

Data from Ethernet Board is incorrect Contact with the service section or the 

section in charge.

EW_

SOC

KET 

 (-

16)

Socket error  Eth

ernet version on

ly

Investigate CNC power supply, Ether

net cable and I/F board.

EW_

NO

DLL 

 (-

15)

DLL file error There is no DLL file for each CNC se

ries corresponding to specified node.

EW_

BUS 

 (-

11)

Bus error  HSSB 

version only

A bus error of CNC system occurred. Contact with the service section or the 

section in charge.

EW_

SYS

T

EM2 

 (-

10)

System error (2) 

HSSB version 

only

A system error of CNC system oc

curred.

Contact with the service section or the 

section in charge.

EW_

H

SSB 

Communication 

error of HSSB 

HSSB version 

only

Investigate the serial line or I/F board 

of HSSB.
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Re

turn
Meaning Explanation Error Handling

 (

-9)

EW_

HAN

DLE 

 (

-8)

Handle number 

error

Get the library handle number.

EW_

VER

S

ION 

 (

-7)

Version mis

match between 

the CNC/PMC 

and library

The CNC/PMC version does not 

match that of the library.

Replace the library or the CNC/PMC 

control software.

EW_

UN

EXP 

 (

-6)

Abnormal library 

state

An unanticipated error occurred. Contact with the section in charge.

EW_

SYS

TEM 

 (

-5)

System error 

HSSB version 

only

A system error of CNC occurred. Contact with the service section or the 

section in charge.

EW_

PAR

ITY 

 (

-4)

Shared RAM par

ity error  HSSB 

version only

A hardware error occurred. Contact with the service section.

EW_

MMC

SYS 

FANUC drivers 

installation er

ror  HSSB version 

only

The drivers required for execution are 

not installed.
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Re

turn
Meaning Explanation Error Handling

 (

-3)

EW_

RE

SET 

 (

-2)

Reset or stop re

quest

The RESET or STOP button was 

pressed.

Call the termination function.

EW_

B

USY 

 (

-1)

Busy Wait until the completion of CNC pro

cessing, or retry.

EW

_OK 

 (0)

Normal termina

tion

EW_

F

UNC 

 (1)

Error (function is 

not executed, or 

not available)

Specific function which must be exe

cuted beforehand has not been exe

cuted.  Otherwise that function is not 

available.

EW_

LEN

GTH 

 (2)

Error (data block 

length error, er

ror of number of 

data)

Check and correct the data block 

length or number of data.

EW_

NUM

BER 

 (3)

Error (data num

ber error)

Check and correct the data number.

EW_

ATT

RIB

(4)

Error (data at

tribute error)

Check and correct the data attribute.
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Re

turn
Meaning Explanation Error Handling

EW_

D

ATA 

 (5)

Error (data error) Check and correct the data.  For the fol

lowing operations, this code indicates 

that the specified program cannot be 

found.

• Delete specified program

• Search specified program

• Start uploading NC program

EW_

NO

OPT 

 (6)

Error (no option) There is no corresponding CNC op

tion.

EW_

P

ROT 

 (7)

Error (write pro

tection)

Write operation is prohibited.

EW_

OVR

F

LOW 

 (8)

Error (memory 

overflow)

CNC tape memory is overflowed.

EW_

PA

RAM 

 (9)

Error (CNC para

meter error)

CNC parameter is set incorrectly.

EW_

BUF

FER 

 (

10)

Error (buffer 

empty/full)

The buffer is empty or full. Wait until completion of CNC process

ing, or retry.

EW_

P

Error (path num

ber error)

A path number is incorrect.
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Re

turn
Meaning Explanation Error Handling

ATH 

 (

11)

EW_

M

ODE 

 (

12)

Error (CNC 

mode error)

The CNC mode is incorrect. Correct the CNC mode.

EW_

REJ

ECT 

 (

13)

Error (CNC exe

cution rejection)

The execution at the CNC is rejected. Check the condition of execution.

EW_

DTS

RVR 

 (

14)

Error (Data serv

er error)

Some errors occur at the data server.

EW_

AL

ARM 

 (

15)

Error (alarm) The function cannot be executed due 

to an alarm in CNC.

Remove the cause of alarm.

EW_

S

TOP 

 (

16)

Error (stop) CNC status is stop or emergency.

EW_

PAS

SWD 

Error (State of 

data protection)

Data is protected by the CNC data 

protection function.
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Re

turn
Meaning Explanation Error Handling

 (

17)

Ethernet Version Only Error Handling

Return Meaning

EW_SOCKET (=-16) Socket API related error.

err_

no

Meaning err_dtno

1 Error of socket API func

tion

2 Error of connect API 

function

Return value of Windows API WSAGetLastError function.

3 Error of send API func

tion

4 Error of recv API function

5 Error of select API func

tion

6 Error of setsockopt API 

function

7 Error of gethostbyname 

API function

8 Timeout error of send 

API function

Where the error is occurred.

1 At sending request

2 At sending data of download

9 Timeout error of recv API 

function

Where the error is occurred.

1 At receiving request header
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Return Meaning

2 At receiving request data

3 At canceling upload data

4 At receiving data of upload

5 At starting or finishing the communication

10 Error of Winsock API 

is occurred in other 

process

Always 0.

11 EOF (end of file) detect

ed

Where the error is occurred.

1 At send API function

2 At recv API function

Return Meaning

EW_PROTOCOL (=-17) Violation of the protocol.

err_

no

Meaning err_dtno

1 The send data is larger 

than the maximum trans

fer unit.

Always 0.

2 The sending data size is 

illegal.

3 The number of the re

cieved packet is 0.

4 The mark of the proto

col is incorrect in the re

ceived packet header.

5 The packet type flag is 

incorrect in the received 

packet header.
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Return Meaning

6 The flag of the direc

tion is incorrect in the re

ceived packet header.

7 Illegal received data size. The detail information is shown.

1 The received data size is larger than the maximum transfer unit.

2 The received data size is incorrect at start of communication.

3 The data size of the received packet is less than 2 bytes.

4 The sum of data blocks of the received packet is larger than all 

packet size.

5 The sum of data blocks of the received packet is smaller than all 

packet size.

8 Communication error in 

the Ethernet Board

Error code of the Ethernet Board  When the error occurs, its detail mes

sage is displayed in the log screen of the Ethernet Board on CNC side. 

And refer it.  The main error is as follows.

2 The personal computer would establish over limited connection. 

See FANUC documentation for details.

PMC Data Window Error Handling

Re

turn
Meaning Explanation  Error Handling

EW_P

ROTO

COL 

 (-

17)

Protocol error Ether

net version only

Data from Ethernet Board is 

incorrect.

Contact with the service section or the 

section in charge.

EW_S

OC

KET 

 (-

16)

Socket error Ether

net version only

Investigate CNC power supply, Ethernet 

cable and I/F board.
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Re

turn
Meaning Explanation  Error Handling

EW_N

ODLL 

 (-

15)

DLL file error There is no DLL file for each 

CNC series corresponding to 

specified node.

EW_

BUS 

 (-

11)

Bus error  HSSB ver

sion only

A bus error of CNC system 

occurred.

Contact with the service section or the 

section in charge.

EW_S

YST

EM2 

 (-

10)

System error (2 

HSSB version only

A system error of CNC sys

tem occurred.

Contact with the service section or the 

section in charge.

EW_H

SSB 

 (

-9)

Communication er

ror of HSSB  HSSB 

version only

Investigate the serial line or I/F board of 

HSSB.

EW_H

AN

DLE 

 (

-8)

Handle number error Get the library handle number.

EW_V

ERS

ION 

 (

-7)

Version mismatch 

between the CNC/

PMC and library

The CNC/PMC version does 

not match that of the library.

Replace the library or the CNC/PMC con

trol software.

EW_U

NEXP 

 (

-6)

Abnormal library 

state

An unanticipated error oc

curred.

Contact with the section in charge.
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Re

turn
Meaning Explanation  Error Handling

EW_S

YS

TEM 

 (

-5)

System error  HSSB 

version only

A system error of CNC oc

curred.

Contact with the service section or the 

section in charge.

EW_P

AR

ITY 

 (

-4)

Shared RAM parity 

error  HSSB version 

only

A hardware error occurred. Contact with the service section.

EW_M

MC

SYS 

 (

-3)

FANUC drivers in

stallation error  HSSB 

version only

The drivers required for exe

cution are not installed.

EW

_OK 

 (0)

Normal termination

EW_N

OPMC 

 (1)

Error (No PMC) The PMC does not exist.

EW_L

EN

GTH 

 (2)

Error (data block 

length error)

Check and correct the data block length.

EW_R

ANGE 

 (3)

Error (address range 

error)

Check and correct the address range.



Addons and Options  | 3 - HMI for CNC  | 433

Re

turn
Meaning Explanation  Error Handling

EW_T

YPE 

 (4)

Error (address type/

data type error)

Check and correct the address type/data 

type.

EW_D

ATA 

 (5)

Error (data error) Check and correct the data.

EW_N

OOPT 

 (6)

Error (no option) There is no corresponding 

CNC option.

EW_B

UF

FER 

 (

10)

Error (buffer emp

ty/full)

The buffer is empty or full. Wait until completion of PMC processing, 

or retry.  Alternatively, add the required pro

cessing for the PMC.

EW_P

AS

SWD 

 (

17)

Error (State of data 

protection)

Data is protected by the CNC 

data protection function.

CNC Dynamic Link Library Error Codes and Messages

Error codes:

Error 

Number
Description

[-17] Protocol error, bad data from CNC.

[-16] Socket error, investigate CNC.

[-15] No FOCAS DLL.

[-11] Bus error.
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Error 

Number
Description

[-10] System 2 error.

[-9] HSSB communications error.

[-8] FOCAS DLL allocation error.

[-7] FOCAS DLL and CNC/PMC version error.

[-6] Unexpected FOCAS DLL error.

[-5] System error.

[-4] Shared RAM parity error.

[-3] No FOCAS HSSB drivers.

[-2] Reset or stop button pressed.

[-1] CNC is busy.

(1) Function not executed or not available.

(1) PMC does not exist.

(2) Function data length or data amount er

ror.

(3) Function data number error.

(3) Function address range error.

(4) Function data attribute error.

(4) Function address type or data type error.

(5) Data error or specified program not 

found.

(6) CNC option not enabled or found.

(7) Write operation prohibited.

(8) CNC tape memory overflow.

(9) CNc parameter not set correctly.

(10) Buffer is empty or full.
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Error 

Number
Description

(11) Incorrect path number.

(12) Incorrect CNC mode.

(13) CNC execution rejected.

(14) Data server error.

(15) Function not executed due to CNC alarm.

(16) CNC status is stop or emergency.

(17) CNc data password is enabled.

Error messages:

Description

File open failed.

Bad program.

Bad program number/invalid range.

Timeout.

CNC edit in progress.

Program already selected.

Disk error.

CNC is not in EDIT mode.

CNC is not in EDIT or MEMORY mode.

Error getting directory.

No Programs found.

Bad directory info from CNC.

Failure.

Unable to open CSV file.

Bad CSV file format.
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Description

Unable to open LOG file.

Bad input number or invalid range.

CNC type in file does not match control.

Model type different than CNC.

Memory type different than CNC.

Unknown memory type (A B C).

Number of values greater than number of ax

es.

Initiation of Windows Sockets DLL failed.

Software Removal and Driver Deletion

Software Removal and Driver Deletion

• Software removal.

• HSSB driver deletion.

Software Removal

Important:

Before you remove HMI for CNC software from your computer, you should save any projects 

that you do not want to lose. You can save them on storage media, or in a directory other than 

CIMPLICITY.

1. Open the Add or Remove Program window in the Windows Control Panel.

One method is as follows.

a. Click Start on the Windows task bar.

b. Select Settings>Control Panel>Add or Remove Programs .

2. Select CIMPLICITY HMI for CNC in the Currently installed programs  list.
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3. Click Remove.

4. Click OK in the message box.

5. Restart your computer.

HSSB Driver Deletion

Consult FANUC to uninstall the HSSB driver.



Chapter 4. Machine Edition Integration with 
CIMPLICITY

About Machine Edition Integration with CIMPLICITY

You can view the live point data for a running Machine Edition project through any of the following 

CIMPLICITY  tools.

• Point Control Panel.

• CimView/CimEdit

• Basic scripting (to set points)

• Enterprise server (for points only)

• Point data logging.

For example, the CIMPLICITY Point Control Panel may display the following data.

A CIMPLICITY points that access Machine Edition vari

ables.

B CIMPLICITY points for the CIMPLICITY project.

C Machine Edition variables.

Machine Integration Architecture

CIMPLICITY integration of Machine Edition point data supports two types of architecture:
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• Enterprise Server connectivity.

• Viewer connectivity.

Enterprise  Server connectivity

CIMPLICITY can use Enterprise Server architecture to interact with Machine Edition View nodes as data 

providers.

The CIMPLICITY Enterprise Server serves data from one or more Machine Edition projects.

Condition Enterprise Server:

Enterprise Server starts. • Obtains a list of exported Machine Edition 

points

• Adds the Machine Edition points to the 

points it is serving.

Machine Edition node is restarted. Re-synchronizes the list of points

Enterprise Server point goes into demand (e.g. a 

Viewer starts using the point).

Starts collecting the point data from the Machine 

Edition or CIMPLICITY node.

Important:

CIMPLICITY Enterprise server architecture provides scalability. Therefore, the server can handle 

data distribution to hundreds of viewers while limiting the impact on the CIMPLICITY View to one 

request per point.
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Viewer  connectivity

A CIMPLICITY Viewer application can connect directly to View systems on the network without the need 

for an intermediate Enterprise Server.

Machine Edition Variables in CIMPLICITY

Machine Edition Variables in CIMPLICITY

Note:

Guidelines

• The data that Machine Edition refers to as variables or tags are referred to as points in CIMPLICITY.

• Machine Edition provides detailed documentation with sample projects to explain how to create a 

Machine Edition project and variables.

Step 1 

(on page 

441)

Configure the Machine Edition project for CIMPLICITY.

Step 2 

(on page 

445)

(Optional) Configure CIMPLICITY points to access machine Edition Vari

ables.

Step 3 

(on page 

461)

View/set/log Machine Edition variable data through CIMPLICITY.
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Step 1. Configure the Machine Edition Project for CIMPLICITY

Step 1. Configure the Machine Edition Project for CIMPLICITY

Step 1.1 

(on page 

441)

Set up Machine Edition project broadcast.

Step 1.2 

(on page 

443)

Download the Machine Edition project to 

View.

Step 1.1. Set up Machine Edition Project Broadcast

Setting up the Machine Edition Project broadcast includes the following.

1  (on 

page 

441)

Enable the Machine Edition project broadcast'

2  (on 

page 

442)

Mark variables that will be viewed in CIMPLICITY as used.

1. Enable the Machine Edition project broadcast.
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A Select the Project tab in the Machine Edition Naviga

tor.

B Right-click the Target project.

C Select Properties. The Inspector opens.

D Select True in the Enable Project Broadcast  field.

1. Mark variables  that will be viewed in CIMPLICITY as used.
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A Select the Variables tab in the Machine Edition Navigator.

B Right-click a variable that should be available to CIMPLICI

TY.

C Select Properties on the Popup menu. The Inspector opens.

D Select True in the Mark As Used  field.

Save the Machine Edition project.

Step 1.2. Download the Machine Edition Project to View

Do the following download and start the Machine Edition project.
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A Select the Project tab in the Navigator.

B Select the Target that will be downloaded.

C Do one of the following.

• Right-click the Target>Select Download and Start on the Popup 

menu.

• Press F9 on the keyboard.

The View Runtime window opens if the download succeeded.

Important:

View must be open to display Machine Edition points in CIMPLICITY..
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Step 2. (Optional) Configure CIMPLICITY Points to Access Machine Edition 
Points

Step 2. (Optional) Configure CIMPLICITY Points to Access Machine Edition 
Variables

A runtime user can view Machine Edition variable values directly from the Machine Edition project.

However, you can also set up the CIMPLICITY project and configure CIMPLICITY points to access 

Machine Edition variables. During runtime, the CIMPLICITY points will display the Machine Edition variable 

data.

Important:

The following steps are very straightforward. However, they include several details that are 

required for successful communication.

Steps to configure the CIMPLICITY project and points are as follows.

Step 2.1 

(on page 

446)

Add a remote project to the CIMPLICITY project.
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Step 2.2 

(on page 

449)

Add a Machine Edition user to the CIMPLICITY project.

Step 2.3 

(on page 

451)

Create a resource for the Machine Edition project.

Step 2.4 

(on page 

452)

Enable the Machine Edition resource for the Machine Edition user.

Step 2.5 

(on page 

453)

Create a port to communicate with the Machine Edition project.

Step 2.6 

(on page 

454)

Create a device to communicate with the Machine Edition project.

Step 2.7 

(on page 

456)

Create CIMPLICITY device points to access Machine Edition vari

ables.

Step 2.1. Add a Remote Project to the CIMPLICITY Project

1. Select Project>Security>Advanced>Remote Projects in the Workbench left pane.

2. Do any of the following.
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A Click File>New>Object  on the Workbench menu bar.

B Click the New Object button on the Workbench toolbar.

C In the Workbench left pane:

Either Or

Double click Remote Projects. a. Right-click Remote Projects.

b. Select New on the Popup 

menu.

D In the Workbench right pane.

a. Right-click anywhere.

b. Select New on the Popup menu.

E Press Ctrl+N on the keyboard.

A New Project dialog box opens when you use any method.

3. Right-click Remote Projects.

4. Select New on the Popup menu.

5. Enter the Machine Edition project name in the Project name  field.
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6. Click OK.

The Remote Project - <Machine Edition project name> dialog box opens.

7. Select the General tab.

8. Enter the following.

Feature Description

User ID The ID of a user who has rights to access and right to the Machine Edition 

project.

Password Valid Machine Edition password for the User ID

Confirm pass

word

Password repeated.

Enable Check to enable login.

9. Select the Enterprise tab.

10. Check Collect points.
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11. Click OK.

The remote project is now available to when configuring a resource and device to collect data from the 

selected project.

Step 2.2. Add a Machine Edition User to the CIMPLICITY Project

1. Expand Security in the Workbench left pane.

2. Double-click Users.

Note:  You can use any of the available methodsto create a new user.
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A New User dialog box opens.

3. Enter a valid Machine Edition administrator user ID in the User ID  field.

4. Click OK.

A User Properties - <user name> dialog box opens.

5. Select the General tab.

6. Enter the following.

Feature Description

Role Role that has administrative privileges in the CIMPLICITY project.

Password needed Check to require a password when user log in is required.

Password Password user must enter when logging in.

Confirm pass

word

Password repeated.

User name User's name or descriptive text about the user, e.g. ME Administra

tor.

7. Select the Resources tab.
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8. Make sure that the Machine Edition resource is in the Configured  box.

9. Click OK.

An authorized Machine Edition user is now also authorized FOR CIMPLICITY.

Step 2.3. Create a Resource for the Machine Edition Project

1. Expand Security in the Workbench left pane.

2. Double-click Resources.
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A New Resource dialog box opens.

3. Enter the remote project name in the Resource ID  field.

4. Click OK.

The Resource Definition - <Resource name> dialog box opens.

5. Make sure an authorized user in the Machine Edition project is in the Users for this resource  box.

6. Click OK.

A CIMPLICITY resource with an assigned authorized user are now available for the Machine Edition 

variable data.

Step 2.4. Enable the Machine Edition Resource for the Machine Edition User

1. Re-open the Machine Edition user's User Properties dialog box.

2. Select the Resources tab.

3. Move the Machine Edition resource to the Configured  box.
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4. Click OK.

An authorized Machine Edition user now also authorized for the CIMPLICITY Machine Edition resource.

Step 2.5. Create a Port to Communicate with the Machine Edition Project

1. Expand the Equipment folder in the Workbench left pane.

2. Double-click Ports.

A New Port dialog box opens.
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3. Select the following.

Field Description

Proto

col

POINT_BRIDGE

Port Available POINT_BRIDGE 

port

4. Click OK.

The Port Properties - <Port> dialog box opens.

5. Check Enable.

6. Click OK.

A port is now set up to access Machine Edition variable data.

Step 2.6. Create a Device to Communicate with the Machine Edition Project

1. Expand the Equipment folder in the Workbench left pane.

2. Double-click Devices.
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A New Device dialog box opens.

3. Enter the following.

Field Description

De

vice

Machine Edition (remote) project 

name.

Port POINT_BRIDGE port.

4. Click OK.

The Device - <device name> dialog box opens.

5. Make sure the following is selected.
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Field Select

Port POINT_BRIDGE port.

Description (Recommended) Enter a brief statement to help identify the de

vice.

Resource 

ID

Machine Edition resource  (on page 451)

Model type CIMPLICITY System

6. Click OK.

A device is now set up to communicate with the Machine Edition project.

Step 2.7. Create CIMPLICITY Device Points to Access Machine Edition 
Variables

Note:

The CIMPLICITY point definition must match the Machine Edition variable definition for the point 

to access variable data.

1  (on 

page 

457)

Create a point.
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2  (on 

page 

458)

Configure the General tab.

3  (on 

page 

459)

Configure the Device tab.

4  (on 

page 

461)

Complete point configura

tion.

Create  a point.

1. Double-click Points  in the Workbench left pane.

Note:  You can use any of the available methodsto create a new device point.

A New Point dialog box opens.

1. Enter and select the following.
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Field Description

Point 

ID

Name of the CIMPLICITY point that will access a selected Machine Edition variable's values. The 

name does not have be the same as the Machine Edition variable name, but it can be.

Type Device Device created to communicated with the Machine Edition project.

Class 

(on 

page 

477)

Must correspond to  the selected Machine Edition variable.

1. Click OK.

Result: The Point Properties - <Point name> dialog box opens.

Configure the General  tab

1. Select the General tab.

2. Make sure the following is entered/selected.
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Field Description

Description (Optional) Point identification.

Data type 

(on page 

477)

Machine Edition variable data type defined as a CIMPLICITY data types.

Elements Same number of elements as the Machine Edition variable. If the point is an ar

ray

Read only Check If the Machine Edition variable cannot be set.

Clear If the Machine Edition variable can be set.

Enable point Check Enable the point.

Resource ID Resource configured for Machine Edition variables.

Configure the Device  tab

1. Select the Device tab.

2. Make sure the following is entered/selected.

Field Description

De

vice 

ID

Device created to communicate with the Machine Edition project.

Ad

dress

Machine Edition variable name. Any Machine Edition variable that corresponds to the point defin

ition can be entered, including an array element. Important



Addons and Options  | 4 - Machine Edition Integration with CIMPLICITY  | 460

Field Description

• Two CIMPLICITY points cannot be configured to access the same Machine Edition vari

able.

POINT_BRIDGE checks for duplicate address names. If two points use the exact same names in 

the Address  field, only the first point will be validated. A duplicate name log will be entered in the 

status log for the second point. Example

• A CIMPLICITY point, CSin1, is configured to access a Machine Edition variable, Sine1.

• A second CIMPLICITY point, e.g. CSin1_2 cannot access data from the same variable, 

Sine1.

• Two or more CIMPLICITY points can be configured to access different elements in an ar

ray variable, including the array variable itself.

POINT_BRIDGE views points that access different elements in an array as non-duplicate points. 

Each of the array element points will be validated. Creating different CIMPLICITY points for ele

ments is more efficient than creating a single point for the array variable Example

• A CIMPLICITY point, MARRAYDINT[2], is configured to access element 2 in a Machine Edi

tion variable, ARRAYDINT.

• Another CIMPLICITY point MARRAYDINT[3] can also access element 3 in the same Ma

chine Edition variable, ARRAYDINT.

Note:

When a CIMPLICITY point that accesses a Machine Edition array element is updated, val

ues for every element in the array are transmitted back to Machine Edition. As a result, in 

some rare instances old array element values from CIMPLICITY may overwrite new array 

element values in Machine Edition.

Example

• A CIMPLICITY point, CARRAY2, is configured to access  a Machine Edition array element, 

MARRAY[2].

• The Machine Edition array element, MARRAY[5] has changed from 9 to 11. However, this 

change has not been transmitted to CIMPLICITY; CIMPLICITY still has the old Machine 

Edition array element values.

• A CIMPLICITY user sets the CIMPLICITY point CARRAY2 value from 6 to 10.
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Field Description

• Values for every element in MARRAY are transmitted from CIMPLICITY back to Machine 

Edition when the CIMPLICITY point is set; this includes the old MARRAY[5] value, 9.

• The old MARRAY[5], 9, from CIMPLICITY overwrites Machine Edition's new value, 11.

Complete  point configuration

1. Click OK.

2. Repeat this step to create all required points.

Result: The configured points will now report Machine Edition variable data. Read/write points can be 

used to set values in the Machine Edition project.

Step 3. View/Set/Log Machine Edition Variable Data through CIMPLICITY

Step 3. View/Set/Log Machine Edition Variable Data through CIMPLICITY

Machine Edition variable configuration and runtime use is essentially the same as for any CIMPLICITY 

remote project.

Machine Edition variables can be viewed, set and logged using the following CIMPLICITY applications.

• Point Control Panel.

• CimView/CimEdit

• Point data logging.

CIMPLICITY points that access Machine Edition variables and Machine Edition variables can be selected 

in any CIMPLICITY Select a Point browser by a user who is authorized to use both projects.

• Machine Edition variables selected in a Select a Point browser.

• Machine Edition in CIMPLICITY example

Machine Edition Variables selected in a Select a Point Browser

Note:

A log in user name and password may or may not be required to access CIMPLICITY and/or 

Machine Edition variables based on security configuration.
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1. Make sure the Machine Edition project is running.

2. Make sure the CIMPLICITY project is running.

3. Openthe Select a Point browser through the Point Control Panel, CimEdit or the DATA_LOG.

The local CIMPLICITY project name displays in the disabled Project  field.

(If a user ID and password are required for CIMPLICITY) a CIMPLICITY Login dialog box - 

<CIMPLICITY project name> opens.

4. Enter a valid CIMPLICITY User ID  and Password.

5. Click OK.

Points in the running CIMPLICITY project are now available to be selected.

6. Do one of the following.

Select one or more CIMPLICITY device points that have access to a Machine Edition variable.

Select the CIMPLICITY device point(s) the same way you select any point.

Select one or more Machine Edition variables.

The Project  field is enabled when the CIMPLICITY user log in is validated.

a. Select the Machine Edition project in the Project  drop-down list.

b. Click Browse.

(If a user ID and password are required for Machine Edition) a CIMPLICITY Login dialog box - 

<Machine Edition project name> opens.

a. Enter a valid Machine Edition User ID  and Password.



Addons and Options  | 4 - Machine Edition Integration with CIMPLICITY  | 463

a. Click Ok.

The points that fill the Select a Point browser criteria and that were made available  (on page 441) 

for the Machine Edition project are listed.

a. Do the following.

A Select the Machine Edition variable(s) that you want to display, use or 

log.

B Click OK.
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Result: The selected points display in the application for which they were selected.

Machine Edition in CIMPLICITY  Example

Authorized CIMPLICITY users need to monitor a Machine Edition Car Wash project through 

CIMPLICITY.

In order to do this, an authorized user.

7. Starts a Machine Edition project named MECar.

8. Starts a CIMPLICITY project named ECIMP.

9. Configures the CIMPLICITY project to support POINT_BRIDGE device points that can access 

Machine Edition variables.

10. Creates the following device points to access Machine Edition variables.

CIMPLICITY Point
Machine Edi

tion variable

MCode Code

MSIN1 SINE1

11. Configures and uses Machine Edition variables with the following.

Example 3.1 

(on page 

464)

Point Control Panel.

Example 3.2 

(on page 

468)

CimEdit/CimView.

Example 3.3 

(on page 

472)

CIMPLICITY point logs.

Example 3.1. Machine Edition Variables in the Point Control Panel
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Note:

Both CIMPLICITY points that access Machine Edition variables and Machine Edition variables 

display and are updated in the CIMPLICITY Point Control Panel as long as Machine Edition View 

is running.

If a user has authorization, CIMPLICITY points and Machine Edition variables can be set.

An authorized CIMPLICITY and Machine Edition opensthe Point Control Panel.

The user uses the Point Control Panel as follows.

1  (on 

page 

465)

Changes the Machine Edition Code variable to 77777. This variable selects the highest price 

car wash.

2  (on 

page 

467)

Reviews the values in the Machine Edition array variable named ARRAY_DINT.

Change  the Machine Edition code variable to 77777

The authorized Point Control Panel user:

1. Adds  (on page 461)  either of the following.

CIMPLICITY device point MCode.

Machine Edition variable \\MECAR\Code.
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1. Opensthe PCP Point Properties dialog box for the selected point or variable.

2. Setsthe value to 77777.

1. Closes the PCP Point Properties dialog box.

Result: The value displays as 77777 for the:

• CIMPLICITY point MCode and Machine Edition variable Code in the Point Control Panel.
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• Machine Edition variable Code in the Machine Edition Variable Inspector.

Consult Machine Edition documentation to review details about the Variable Inspector.

Review  the values in a Machine Edition Array

The authorized Point Control Panel user:

1. Opens the Select a Point browser.

2. Selects the following.

1 Machine Edition Project in the Project  field.

2 Machine Edition integer array, ARRAY_DINT and all of its ele

ments.

1. Reviews the array variable and array element values in the Point Control Panel.
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1 Array variable Values in the array variable can be set the same way a CIMPLICITY array 

pointis set.

2 Array variable ele

ments

A value for each array element can be set the same way a value for a CIMPLICI

TY pointis set.

Example 3.2. Machine Edition Variables in CimEdit/CimView

Note:

Machine Edition variables can be selected in CimEdit directly or through CIMPLICITY device 

points to be viewed and set in CimView.

A CIMPLICITY CimView screen is required for users to view and set the car wash Code and stages of the 

wash, e.g. Rinse, Wash, Dry and Wax.

An authorized screen designer creates a CimEdit screen to include Machine Edition data.

The screen designer configures and tests objects on the screen as follows.

1  (on 

page 

469)

Text object to display the CIMPLICITY MCode device point da

ta.

2  (on 

page 

470)

Text objects to display Machine Edition variable data.
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3  (on 

page 

470)

Other objects to complete the screen.

4  (on 

page 

471)

CimView/View  runtime test.

Text object to display the CIMPLICITY MCode device point  data.

The screen designer:

1. Places a text objecton the screen.

2. Opens the text object's Properties dialog box.

3. Configures the Text tab as follows.

1 Enters MCODE as the default string.

2 Selects the point MCODE as the expres

sion.

3 Enables Setpoint action.
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Text objects to display Machine Edition variable  data.

The screen designer:

1. Places several text objectson the screen that will display Machine Edition variable values.

2. Opens the Properties dialog box for one text object.

3. Configures the Text tab as follows.

1 Enters R7 as the default string.

2 Selects the fully qualifiedMachine Edition variable \\MECAR\Rinse_7X as the expression. Note:  The 

designer selects the variable as follows.

1. Selects Browse Point ID on the Expression field's Popup menu

2. Uses the Select a Point browser to select  (on page 461)  the variable.

3 Enables Setpoint action.

Other  objects that complete the screen.

The screen designer adds graphics and text to enhance the screen.

Note:  The designer could use the Machine Edition variables:
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• In Basic scripts.

• CimEdit actions, e.g. Toggle Setpoint

• Other CIMPLICITY features in which a CIMPLICITY point can be used.

Result: The CimEdit screen is now ready use the CIMPLICITY points and Machine Edition variables during 

runtime.

CimView/View Runtime  test

During runtime an authorized operator can:

• Set the wash code or any of the car wash phases.

The value is changed in the Machine Edition project.
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Note:  Consult Machine Edition documentation to review details about viewing variable values in Machine 

Edition.

• Monitor a car's progress through the car wash based on values that were generated in the Machine 

Edition project.

Example 3.3. Machine Edition Variables Logged through CIMPLICITY

• Log to Historian

• Log to SQL

Log to Historian

Note:

CIMPLICITY device points that access Machine Edition variable values can be logged to 

Historian.

The data for two Machine Edition variables, Code and SINE1, must be logged to Historian.

The authorized user:

1. Makes sure that the Historian Interface options are checked in the CIMPLICITY Project Properties 

dialog box.

2. Creates CIMPLICITY points, MCode and MSIN1, to access the corresponding Machine Edition 

variables.

3. Checks Log Data on the General tab in each point's Point Properties dialog box.
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4. Makes sure the project configuration is updated (e.g. configuration update or configured in 

dynamic configuration).

Result: When the project is running the point data will be logged to Historian.

Log to SQL

Note:

Both CIMPLICITY device points and Machine Edition variables can be logged to 

CIMPLICITY DATA_LOG and GROUP_LOG tables in SQL.

Car wash data for the high price car wash needs to be logged to SQL.

◦ Both CIMPLICITY device points and Machine Edition variables are logged.

◦ CIMPLICITY log tables are both the DATA_LOG and GROUP_LOG.

An authorized user:

5. Opens the DATA_LOG in the Database Logger.

6. Opensthe Select a Point browser.

7. Selects Machine Edition variables  (on page 461).

8. Adds the selected Machine Edition variables to the DATA_LOG.
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Note:  Points that have Log Data checked in their Point Properties dialog box will be logged to the 

DATA_LOG.

9. Opens the GROUP_LOG.

10. Adds the following to the GROUP_LOG.

A Machine Edition variables.

B CIMPLICITY device points that access Machine Edition vari

ables.

Data for both CIMPLICITY device points and Machine Edition variables is logged to the SQL DATA_LOG 

and GROUP_LOG.

• SQL DATA_LOG  displays:
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A Machine Edition variables.

B CIMPLICITY device points that access Machine Edition vari

ables.

• SQL GROUP_LOG displays:

A CIMPLICITY device points that access Machine Edition vari

ables.

B Machine Edition variables.

Machine Edition to CIMPLICITY Technical Reference

Machine Edition to CIMPLICITY Technical Reference

• Point data integration technical reference.

• Machine Edition variable data types defined as CIMPLICITY point data types.

Point Data Integration Technical Notes

Following is a list of how CIMPLICITY handles feature variations in the two products.
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Fea

ture
Description of how Handled through Integration

Point 

ID's

Machine Edition long point ID's are supported.

Point 

Read

ings

Any valid user can read point data. There are no restrictions on users accessing point data.

Set

point 

Privi

lege

Machine Edition has a privilege that allows the user to perform setpoints. This privilege is 

mapped to the CIMPLICITY Setpoint Privilege.

Secu

rity

CIMPLICITY allows logging into View using the View User ID. Note:  Connections will only be al

lowed using View User Ids of 32 characters or less with passwords of less than 16 characters.

EU 

Con

ver

sion

In CIMPLICITY the client performs Engineering Unit conversions. In the Machine Edition, View 

will indicate that the data type of the point is REAL and send the converted value to the applica

tion instead of the raw value. Likewise, on a setpoint PTMAP will send the EU value and View 

will convert it back to a raw value before sending it to the device.

Dupli

cate 

Project 

Broad

cast

By default, Machine Edition will broadcast more than one project with the same name. For prop

er operating, the user must ensure that no two broadcasting projects have the same name. If 

two project broadcasts use the same name, it will not be predictable as to which project CIM

PLICITY will get data from.

Project 

Ac

knowl

edge

ment 

Time

Machine Edition broadcasts projects every 75 seconds. Therefore, it can take up to 75 seconds 

for a project to appear on a list of projects available for point data monitoring.

Point 

Up

dates

Machine Edition uses a scan based reporting mechanism for reporting point values. As a re

sult, CIMPLICITY will miss intermediate values of a point that changes faster than the scan rate. 

Note:  If a point exists in CIMPLICITY and the description of the corresponding variable changes 

in Machine Edition, the point description does not get updated when the variable is exported 

from Machine Edition into CIMPLICITY.
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 More information

• Machine Edition to CIMPLICITY technical reference.

Machine Edition Variable Data Types Defined as CIMPLICITY Point Data 
Types

Machine Edition variable data types and default display format definitions are defined as CIMPLICITY 

point classes and data types as follows.

Use the CIMPLICITY class and data type that corresponds to the Machine Edition data type when you 

create a CIMPLICITY device point that accesses a Machine Edition variable.

Machine Edition CIMPLICITY

Data Type Default Display For

mat

Class Data Type

BOOL Boolean BOOL

COUNTER.CV Analog DINT

DATE (YR, MO, DAY) Analog DINT

DATE_AND_TIME (YR, MO, DAY, HR, MIN, 

SEC)

Analog DINT

DINT Binary Analog DINT

Decimal Analog DINT

Hexadecimal Analog DINT

Octal Analog DINT

Text Analog DINT

LREAL Floating point Analog REAL

Scientific notation Analog REAL

STEP.X Boolean BOOL

STEP.T.DAY, STEP.T.HR Analog DINT

STRING <Max Length> Text STRING

TIME(DAY, HR, MIN, MS, SEC) Analog DINT
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Machine Edition CIMPLICITY

TIMER.PT,TIMER.ET Analog DINT

TIME_OF_DAY(HR, MIN, MS, SEC) Analog DINT



Chapter 5. Recipes Configuration

About Recipes

The CIMPLICITY Recipes software option enables you to create and manage recipe data for your 

production processes. The Recipes interface consists of a spreadsheet format in which you enter the 

configuration data for each of your recipes. This format allows you to group similar products together.

• Recipes overview.

• Recipe configuration.

Recipes Overview

Using the Recipes Configuration you can:

• Create and manage recipe parameters, recipes, and maps in a spreadsheet format.

• Import and export recipe groups to and from CSV file formats.

• Archive recipe groups.

• Reconcile recipe groups automatically to accommodate changes in the group's structure and 

layout.

• Compare recipes.

• Upload recipes manually.

• Review and modify parameters and values.

• Download recipes manually.

Recipe objects can also be embedded in CimView screens (using OCX Controls). These objects enable 

you to:

• Upload and download recipes manually.

• Review and modify parameters manually.

Recipe Configuration

Recipe overview and configuration topics include the following.

• Open a RecipeConfig window.

• RecipeConfig window overview.

• Recipe group configuration.

• Recipe control configuration.
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Open a RecipeConfig Window

Open a RecipeConfig Window

Note:

Make sure the Recipes is checked in the Optionsbox in the Project Properties dialog box.

Option 1 

(on page 

480)

Open a new RecipConfig window.

Option 2 

(on page 

482)

Open an existing recipe group win

dow.

Option 1. Open a new RecipeConfig Window

Note:

Make sure the Recipes is checked in the Optionsbox in the Project Properties dialog box.

CIMPLICITY provides several methods to open a new RecipeConfig window.

1. Start the CIMPLICITY project.

2. Select Project>Recipes  in the Workbench left pane.

3. Do one of the following.
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A Click File>New  on the Workbench menu bar.

B Click the New Object button on the Workbench toolbar.

C In the Workbench left pane:

Either Or

Double click Recipes. a. Right-click Recipes.

b. Select New on the Popup 

menu.

D a. In the Workbench right pane.

a. Right-click any recipe file.

b. Select New on the Popup menu.

E Press Ctrl+N on the keyboard.

4. Right-click Recipes.

5. Select New on the Popup menu.

6. Right-click any recipe file.

7. Select New on the Popup menu.
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Option 2. Open an existing Recipe Group Window

1. Select Project>Recipes  in the Workbench left pane.

2. Select a recipe in the Workbench right pane.

3. Do one of the following.

A Click Edit>Properties on the Workbench menu bar.

B Click the Properties button on the Workbench toolbar.

C In the Workbench left pane:

a. Right-click Recipes.

b. Select Open on the Popup menu.

D In the Workbench right pane:

Either Or

Double click a recipe. a. Right-click a recipe.

b. Select OPen on the Popup 

menu.

E Press Alt+Enter on the keyboard.
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4. Right-click Recipes.

5. Select Open on the Popup menu.

6. Right-click a recipe.

7. Select OPen on the Popup menu.

RecipeConfig Window Overview

RecipeConfig Window Overview

The RecipeConfig window is divided into two panes.

The left pane lists the recipe group's basic components.

The right pane provides a grid that displays the values applied to the recipe group's components.

1. 1. RecipeConfig Window: Left Pane  (on page 484)

2. 6. RecipeConfig Window: Keyboard Operations  (on page 493)

3. 5. RecipeConfig Window: Mouse Operations  (on page 491)

4. 4. RecipeConfig Window: Menu Items  (on page 488)

5. 3. RecipeConfig Window: Toolbar Buttons  (on page 487)

6. 2. RecipeConfig Window: Right Pane  (on page 486)

1  (on 

page 

484)

Window left pane.
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2  (on 

page 

486)

Window right pane.

3  (on 

page 

487)

Toolbar buttons

4  (on 

page 

488)

Menu items

5  (on 

page 

491)

Mouse operations

6  (on 

page 

493)

Keyboard opera

tions.

1. RecipeConfig Window: Left Pane

The RecipeConfig window left pane is a tree that lists the recipe group components.

• Left pane components.

• Left pane icons.

Left Pane Components

Recipe group components are as follows.
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1. #unique_307_Connect_42_DMaps  (on page 485)

2. #unique_307_Connect_42_CRecipes  (on page 485)

3. #unique_307_Connect_42_BParameters  (on page 485)

4. #unique_307_Connect_42_ARecipeGroup  (on page 485)

Com

ponent
Description

A Recipe 

group

Recipes and maps that share a common structure. The common structure is made up of 

the list of ingredients needed to produce a recipe, process variables, and point IDs that map 

the recipes to process equipment in the factory.

B Para

meter 

Attrib

utes

(Pre-defined) Seven attributes that contain user specified values for user created parame

ters. The parameters are the list of ingredients and process variables (e.g. temperature) 

that can be included in any of the group's recipes. The pre-defined parameter attributes are:

• ID.

• Data Type.

• Units.

• Low Limit.

• High Limit.

• Default Value.

• Default Source Point.

C Recipes (User created) A recipe provides the values needed for each parameter to manufacture a 

specific batch of product. Recipes that use the same parameters can be placed in a recipe 

group.

D Maps (User created) List of point IDs that recipe parameter values are either:

Written to on Download.

Read from on Upload.

A map's points may represent noncontiguous device addresses and can span several de

vices. Each group can contain one or more maps.

Left Pane Icons

The RecipeConfig window uses standard icons to view and change the left pane display.

Icons are as follows.
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Icon Description

Folder is not selected.

Folder is selected and its items are displayed.

Represents a recipe item that has not yet been loaded into memo

ry.

Represents a recipe item that has been loaded into memory.

Item is displayed in the right pane (spreadsheet grid).

Expand a folder.

Collapse a folder.

2. RecipeConfig Window: Right Pane

The RecipeConfig Window provides a grid in which you can enter values for all of the components in the 

left pane.

Columns that can be displayed or hidden, re-sized and moved include values for the following.

Note:

Columns are added at the:

• Right side of the grid

• Default size of 5 characters.

A Parameter attribut

es.
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B Recipes.

C Maps.

3. RecipeConfig Window: Toolbar Buttons

The toolbar buttons offer one-click access to the most commonly used functions.

Button Description

1 New Creates a new group, recipe or map, based on which type of component is selected in 

the tree.

2 Open Opens an existing group.

3 Save Saves the selected group, attribute, recipe, map or folder.

4 Cut Cuts the current grid cell contents to the clipboard.

5 Copy Copies the current grid cell contents to the clipboard.

6 Paste Inserts the contents of the clipboard into the current grid cell.

7 Delete Deletes the current selection in the tree or grid.

8 About Displays program information, version number and copyright.

9 Browse Browses for points.

10 New 

Point

Creates a new point.

11 Dynamic Enables/disables dynamic configuration updates.

12 Down

load

Initiates a download of the selected recipe or map.

13 Upload Initiates an upload of the selected recipe or map.

14 Import Imports a new group.

15 Export Exports the group to a .csv file.

16 Archive Converts the group to a read-only archive.
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Button Description

17 Validate Validates the selected column(s) in the grid.

4. RecipeConfig Window: Menu Items

The menu bar offers several options for creating and maintaining data items in your Recipes directory, 

along with maintaining the spreadsheet structure in the right pane.

• File

• Edit

• View

• Tools

• Tree

• Grid

• Help

File  menu

The File menu has the following options:

Option Description

New Based on the item selected in the directory, creates a new folder or data 

item.

Open Opens the Open dialog box to open an existing Group.

Save Saves the item selected in the directory.

Save As Opens the Save As dialog box to name and save the Group.

Save All Saves all folders and data items in the directory.

Rename Enables a selected tree item to be edited.

Archive Converts the Group

Export Exports data in the Group to a CSV file.

Import Imports a new Group.

Recent Files Shows the files most recently opened and allows you to select them directly.

Exit Quits the Recipe Configuration interface.
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Edit  menu

The Edit menu has the following options:

Option Description

Cut Removes the contents of the selected cell and place them on the Clipboard.

Copy Copies the contents of the selected cell and places them on the Clipboard.

Paste Place the contents on the Clipboard into the selected cell.

Delete Deletes the selected data item in the directory, or the selected cell con

tents.

Properties Launches the Properties dialog box for the selected item.

View  menu

The View menu has the following options:

Option Description

Toolbar Displays the toolbar. A check mark indicates active option.

Status Bar Displays the status bar. A check mark indicates active op

tion.

Split Resizes the left and right panes of the interface.

Tools  menu

The Tools menu has the following options:

Option Description

Upload Uploads the selected Recipe or Map.

Download Downloads the selected Recipe or Map.

Create Auto 

Action

Generates a Recipe Parameter file, which supplies the information required to automati

cally upload or download a Recipe.

Validate Validates the entries in the selected column and report errors.

Compare Compares the selected Recipe to other recipes and displays the results in the grid.
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Option Description

Dynamic 

Config

Toggles dynamic configuration update function.

New Point Launches the New Point dialog box to create a new point.

Point Browse Launches the Select a Point dialog box to enable browsing for points.

Tree  menu

The Tree menu has the following options:

Option Description

Expand One Level Opens the selected folder.

Expand One Branch Opens the selected folder and any subfolders.

Expand All Opens all the folder and subfolders in the directory.

Collapse Branch Closes the selected folder.

Indicate Expandable 

Branches

Displays the symbols for expanding folders. A check mark indicates active 

option.

View Displays the selected data item in the grid.

View All Displays all data items from the selected folder in the grid.

Copy Copies the selected Recipe or Map.

Create Subfolder Creates a Recipe or Map subfolder.

Grid  menu

The Grid menu has the following options:

Option Description

Select Column Highlights the selected column.

Select Row Highlights the selected row.

Freeze Selection Disables scrolling for the selected column(s) or row(s).

Unfreeze Rows Re-enables scrolling of the frozen row(s).

Unfreeze Columns Re-enables scrolling of the frozen column(s).
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Option Description

Hide Column Removes the selected column from the grid. Column is only hidden, not delet

ed.

Hide All Columns Removes all columns from the grid. Columns are only hidden, not deleted.

Hide All Attribute 

Columns

Removes all Attribute columns only from the grid. Columns are only hidden, 

not deleted.

Hide All Recipe 

Columns

Removes all Recipe columns only from the grid. Columns are only hidden, not 

deleted.

Hide All Map Columns Removes all Map columns only from the grid. Columns are only hidden, not 

deleted.

Insert Parameters Adds a row(s) to the grid.

Delete Parameters Removes a row(s) from the grid.

Help  menu

The Help menu has the following options:

Option Description

Contents Launches the Help contents file.

About Recipe Con

fig.

Displays the current version number for 

Recipes.

5. RecipeConfig Window: Mouse Operations

• Directory operations

• Grid operations

Directory  Operations

Use your mouse to quickly navigate within the directory:

Action Mouse Operation

Select an item Left click.

Edit item text Left click; left click.
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Action Mouse Operation

Display popup menu Right-click.

Download Left click on Recipe and drag onto a Map.

Upload Left click on Map and drag onto a Recipe.

Move Recipe into folder Left click on Recipe and drag into a Recipe folder.

Copy Receipt into fold

er

Left click + Ctrl Key on Recipe and drag into a Recipe fold

er.

Move Map into folder Left click on Map and drag into a Map folder.

Copy Map into folder Left click + Ctrl Key on Map and drag into a Map folder.

Display popup menu Right-click on folder or data item in the directory.

Grid  Operations

Use your mouse to quickly navigate within the grid:

Action Mouse Operation

Select col

umn

Left click on unfrozen column header.

Select two 

or more 

columns

Left click on first column; hold down Ctrl key and left click on

out of se

quence

subsequent columns. Columns cannot be frozen.

Select two 

or more 

columns

Left click on first column; hold down Shift key and left click

in se

quence

on the last column in the sequence. Columns cannot be frozen. For example if you want to 

select four columns, select column 1 and then hold down the Shift key and select column 4 

to select all four columns.

Select row Left click on a cell in a frozen column.
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Action Mouse Operation

Select two 

or more 

rows

Left click on a cell in a frozen column; hold down the Ctrl key

out of se

quence

and left click on subsequence rows in the frozen column

Select two 

or more 

rows

Left click on first row in frozen column; hold down Shift key

in se

quence

and left click on the last row in the sequence. For example if you want to select four rows, 

select row 1 and then hold down the Shift key and select row 4 to select all four rows.

Edit cell Double-click cell. Column cannot be frozen.

Move a col

umn

Left click on a column header and drag into position (either to the left or the right). Column 

cannot be frozen.

Move a 

row

Left click on a row and drag into position (either up or down).

Display 

popup 

menu

Right-click on a column header or any cell.

6. RecipeConfig Window: Keyboard Operations

• Quick keys

• Keystrokes in Recipes

• Grid navigation

Quick  keys

Here are some commonly used shortcuts using keystrokes:

Key

strokes
Function

Alt+En

ter

Displays the Properties dialog box for the selected recipe or map data item in the directory or 

grid.
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Key

strokes
Function

+ Expands all branches in the directory.

- Collapses all branches in the directory.

Ctrl+A Converts the Groups to a read-only archive.

Ctrl+C Copies cell contents to the Clipboard.

Ctrl+D Initiates download of the selected Recipe or Map.

Ctrl+E Exports Group data to a .csv file when the top level folder is selected.

Alt+F

+M

Enables renaming a selected recipe.

Ctrl+I Imports a new Group when the top level folder is selected.

Ctrl+L Validates the selected column(s).

Ctrl+N Based on the item selected in the directory, creates a new Group, Recipe or Map.

Ctrl+O Opens the Open dialog box for opening an existing Group.

Ctrl+S Based on the item selected in the directory, saves a Group, Parameter Attribute, Recipe, Map or 

Folder; if the group structure changes the entire group has to be saved, when save is selected.

Ctrl+U Initiates an upload of the selected Recipe or Map.

Ctrl+V Pastes the contents from the Clipboard into the selected cell.

Ctrl+X Removes the cell contents and places them on the Clipboard.

Delete Deletes the selected data item in the directory, or the highlighted contents in the cell.

Keystrokes  in Recipes

The following symbols on the keyboard can be used to perform functions as follows:

Symbol Function

+ Opens the selected folder in the directory.

* Opens the selected folder and its subfolders.

- Collapses the selected folder in the directo

ry.
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Grid  navigation

Keystrokes Function

Left arrow Moves to the left in the grid.

Right arrow Moves to the right in the grid.

Up arrow Moves up in the grid.

Down ar

row

Moves down in the grid.

F2 Edit cell contents.

F6 Moves between directory and grid panes.

End Moves to the end of the selected row.

Ctrl+End Moves to the last cell in the last row of the grid.

Home Moves to the beginning of the selected row.

PageUp Scrolls up in the pane.

PageDown Scrolls down in the pane.

Enter Moves down one cell.

Esc Aborts edit and reverts to original text.

Tab Moves between directory and grid panes.

Recipe Group Configuration

Recipe Group Configuration

A recipe group includes recipes, maps and parameters that share a common structure.

Steps to configure a recipe group are as follows.

Step 1 

(on page 

496)

Select a recipe group.
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Step 2 

(on page 

501)

Define parameter attributes for the recipe 

group.

Step 3 

(on page 

509)

Configure recipes.

Step 4 

(on page 

524)

Configure recipe maps.

Step 5 

(on page 

531)

Upload/download recipes and maps.

Step 6 

(on page 

545)

Administer recipe groups.

Step 1. Select a Recipe Group

Step 1. Select a Recipe Group

Option 1.1 

(on page 

496)

Create a new recipe group.

Option 1.2 

(on page 

500)

Use an existing recipe group.

Option 1.1. Create a New Recipe Group

A recipe group includes your entire configuration in a single RecipeConfig window.

The configuration includes:

• Parameter attributes.

• Recipes.

• Maps.
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You may define one or more Recipe Groups, depending on your application. Each Recipe Group that you 

create and save is stored in a file with an .   rgp   extension.

Do the following to create your new recipe group.

1  (on 

page 

497)

Open a new recipe group.

2  (on 

page 

498)

Define the recipe group.

3  (on 

page 

499)

Name the recipe group.

Open  a new recipe group.

Open a new RecipeConfig window to open a new recipe group.

You can open a new window from the Workbench.  (on page 480)

If a RecipeConfig window is already open:

1. Select the Group folder.

2. Do one of the following.

1 Click the New button on the RecipeConfig toolbar.

2 Click File>New on the RecipeConfig menu bar.
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3 Right-click the group; select New on the Popup 

menu

4 Press Ctrl+N on the keyboard.

A message may open if you have unsaved data in the current, asking if you want to save the data.

1. Select whether or not to save the data.

Result: The current window closes; a new untitled RecipeConfig window opens.

Define  the Recipe group

1. Select the Untitled group.

2. Do one of the following.

1 Click Edit>Properties on the Recipes menu bar.

2 Click the right mouse button; select Properties on the Popup menu.

3 Press Alt+Enter.

The Recipe Group Data dialog opens.

1. Enter the following.
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Group 

Name

(Read-only) Untitled displays before the RecipeConfig window is saved.

Descrip

tion

Description of the Group.

Group 

Point

Name of a CIMPLICITY Point ID to write the Group Name to when a Recipe is Downloaded 

or Uploaded.

• The Point ID may be unqualified or fully qualified.

• The Point ID must be a Text point of sufficient length to hold the group name.

1. Click OK.

Result: The Recipe Group Data dialog box closes.

Name  the Recipe group

The name you use when you save the RecipeConfig window is the name that is assigned to the group.

1. Do one of the following.

• Click the Save button on the RecipeConfig toolbar.

Note:  The Save button is enabled after you open the Recipe Group Data dialog box.

• Click File>Save on the RecipeConfig menu bar.

• Press Ctrl+S on the keyboard.

A Save As dialog box opens.

1. Enter a name for the group.

2. Click Save.
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Results

• The Group is saved as an .rgp file.

• The name given to the group replaces Untitled at the top of the tree.

• The new group name displays in the Group Name field in the Recipe Group Data dialog box.

Option 1.2. Use an Existing Recipe Group

• Open an existing recipe group window.

• Import a recipe group.

Open  an Existing Recipe Group window

You open an existing Recipe group when you open an existing Recipe Group window  (on page 482) .

Import  a Recipe Group

1. Select the top folder in a RecipeConfig window.

2. Do one of the following.
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A Click File>Import on the RecipeConfig window menu bar.

B Click the Import Recipes button on the RecipeConfig window tool

bar.

C Press Ctrl+I on the keyboard.

An Open dialog box opens when you use any method.

3. Select the file (.csv) that you want to import.

4. Click Open.

The selected recipe group opens in the RecipeConfig window.

 

Step 2. Define Parameter Attributes for a Recipe Group

Step 2. Define Parameter Attributes for a Recipe Group
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• Parameters overview

• Parameter configuration

Parameters Overview

A recipe group may have one or more Parameters associated with it.

Parameters attributes identify the components (e.g. ingredients, temperature, ramp time) used to produce 

a product.

Each Parameter that you define for the Group has seven attributes.

You can use these attributes to

• Define the data type for the Parameter.

• Describe the Parameter.

• Set limits for the Parameter in Recipes.

• Define default values for Recipes.

The parameters and parameter attributes display in the RecipeConfig window as follows.

1 Parameters are listed in rows in the grid.

2 Values for parameter attributes (available in the RecipeConfig window's left pane) display in columns 

in the grid. Notes  The column can display or be hidden for one or more attributes.

Important:

Any time you add, delete or rearrange Parameters in the group, all recipes and maps will 

automatically be reconciled to reflect your changes.
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Parameter Configuration

Step 2.1 

(on page 

503)

Insert rows for parameter attribut

es.

Step 2.2 

(on page 

506)

Define parameter attributes.

Step 2.1. Insert Rows for Parameter Attributes

Each parameter for your group is placed on its own row in the table.

You can insert parameters in a new group or existing group.

• New group.

• Existing group.

New  Group

A new Group has, by default, one cell in the RecipeConfig window right pane.

1. Select the one cell in the in the RecipeConfig window right pane.

2. Do any of the following.

A Click Grid>Insert parameters on the RecipeConfig window menu 

bar.
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B Right click the cell; select Insert Parameters on the Popup menu.

C Click Alt+G+I on the keyboard.

An Insert Parameters dialog box opens.

3. Enter a number that represents the additional number of parameters you want to define.

Note:

You can add up to 250 parameters each time you open the Insert Parameters dialog box 

and enter a value.

4. Click OK.

Result: The number of rows entered in the Insert Parameters dialog box are added before the 

existing cell. Columns to enter the attribute values are hidden.

Existing  Group

You can add additional parameter to your recipe group at anytime.

5. Click a row number in the RecipeConfig window grid.
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The a row is selected.

6. Do any of the following.

A Click Grid>Insert parameters on the RecipeConfig window menu 

bar.

B Right click the cell; select Insert Parameters on the Popup menu.

C Click Alt+G+I on the keyboard.

An Insert Parameters dialog box opens.

7. Enter a number that represents the additional number of parameters you want to define.

Note:

You can add up to 250 parameters each time you open the Insert Parameters dialog box 

and enter a value.

8. Click OK.

The specified number of blank rows are inserted above the selected row; the new Parameter rows will 

automatically be inserted in all existing Recipes and Maps.
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Step 2.2. Define Parameter Attributes

1  (on 

page 

506)

Display parameter attribute columns.

2  (on 

page 

507)

Enter attribute values.

3  (on 

page 

508)

(Optional) Remove parameter attribut

es.

Display  parameter attribute columns.

1. (Optional) Expand the Parameters tree.

The list of seven available attribute categories displays in the Recipeconfig window left pane.

1. Do one of the following.

• Right-click one of the attributes in the list; select View on the Popup menu.

• Right-click the Parameters Attributes folder; select View All on the Popup menu.

• Double-click a selected attribute.

Result: The selected attribute columns display in the table.
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Note:

• Attribute cells are blank the first time you display the columns, except the Data Type column, which 

displays Text as the default value.

• The icon that displays to the left of an attribute in the Recipeconfig window left pane identifies 

whether the attribute's column is hidden or visible, as follows.

Icon
Attribute's 

Column is:

Hidden.

Visible

Enter  attribute values.

A ID (Optional) Identifies the Parameter.

B Data 

Type

(Required) Parameter's data type of the Parameter. The following options are in the field's 

drop down list.

• SINT

• INT

• DINT

• Digital
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• REAL

• Text

• USINT

• UINT

• UDINT

Important:  When a Recipe is downloaded, the parameter's data type must match the point's 

data type in the map  (on page 524)  to which the Recipe parameter is being downloaded. 

The default data type is Text. You may choose one of the following types:

C Units (Optional) Engineering units that this Parameter's value refers to.

D Low 

Limit

(Optional) The lowest  value allowed for the selected parameter.

E High 

Limit

(Optional) The highest value allowed for the selected parameter.

F De

fault 

Value

(Optional) Default value for the selected parameter. Once you specify a default value, new 

Recipes will automatically use this value as a starting point. If you change the default value, 

existing Recipes are not updated with the new default value.

G De

fault 

Source 

Point

(Optional) Default source point for the selected parameter.

• Once you specify a default source point, new Recipes will automatically use this value 

as a starting point. If you change the default source point, existing Recipes are not up

dated with the new default value.

• If both the Default Value and Default Source Point are specified for a Parameter, the 

Default Source Point takes precedence when you create a new Recipe.

(Optional) Remove  Parameter Attributes

You can remove parameters from your recipe group.

1. Click the number of the row you want to remove.
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Note:

Hold down the following keys for multiple rows.

Shift key Adjacent rows.

Ctrl key Non-adjacent rows

1. Do one of the following:

• Click the right mouse button; select Delete Parameters on the Popup menu.

• Click Grid>Delete Parameters on the RecipeConfig window menu bar.

1. Confirm your selection.

Result: The selected parameter row or rows are deleted. The parameters are also deleted from all recipes 

and maps in the group.

Step 3. Configure Recipes

Step 3. Configure Recipes

A Recipe specifies the amount (value) of each Parameter that will be used to manufacture a specific 

batch of product. All the Recipes for a Recipe Group are found in the Recipes folder.

• Recipe organization.

• Recipe configuration.

Recipe Organization

You can create subfolders at anytime in the Recipes folder to further classify your Recipes.
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1. Select Recipes in the RecipeConfig window left pane.

2. Do one of the following.

◦ Select Tree>Create SubFolder on the RecipeConfig window menu bar.

◦ Right-click Recipes; select New>SubFolder on the Popup menu.

A new subfolder is created in the Recipe tree.

3. Enter the name of the new subfolder.

4. (Optional) Drag existing recipes into any subfolder to re-organize your group.

There is no restriction on the number of levels of subfolders you can create. You can create a 

Recipe in the Recipes folder or in any Recipes subfolder.

Recipe Configuration

Initially, the Recipes folder contains no Recipes or Recipe subfolders.

Steps to create, configure and administer recipes are as follows.

Step 3.1 

(on page 

511)

Create a recipe

Step 3.2 

(on page 

512)

Rename a recipe.
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Step 3.3 

(on page 

513)

Display/hide recipe parameter val

ues.

Step 3.4 

(on page 

514)

Enter recipe parameter values.

Step 3.5 

(on page 

519)

Enter recipe properties.

Step 3.6 

(on page 

520)

Compare recipes

Step 3.7 

(on page 

522)

Copy/move/delete recipes.

Step 3.8 

(on page 

523)

Print recipe data.

Step 3.1. Create a Recipe

1. Select one of the following.

◦ Recipes folder

◦ Recipes subfolder.

◦ Existing recipe.

2. Do one of the following.
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A Click the New button on the RecipeConfig toolbar.

B Right-click your selection: select New>Recipe on the Popup 

menu.

C Press Ctrl+N on the keyboard.

The new Recipe is added to the end of the Recipe list in the selected folder and is given the default name 

New Recipe.

Note:

The next time the recipe group is saved, the recipe  (on page 547)  list will be resorted so the new 

recipe will be listed in the correct alphanumeric order.

Step 3.2. Rename a Recipe

When a recipe is first created, the default name is available for editing.
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You can edit any recipe names as follows.

1. Select a recipe.

2. Do one of the following.

◦ Click File>Rename on the RecipeConfig window menu bar.

◦ Right-click the name; select Rename on the Popup menu.

◦ Press Alt+F+M on the keyboard.

The name becomes available for editing.

3. Enter the new recipe name.

Note:  The maximum length for a recipe name is 255 characters.

Note:

The name must be unique across the entire Group. The maximum length is 255 characters.

Step 3.3. Display/Hide Recipe Parameter Values

You can display or hide values for a single or all recipes in order  to review them and modify them.

• Display a single recipe's values.

• Display values for recipes in a selected subfolder

• Display all recipes' values.

• Hide recipes' values

Display a single  recipe's values
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1. Select a recipe.

2. Do one of the following.

◦ Double-click the recipe in the RecipeConfig window left pane.

◦ Click Tree>View on the RecipeConfig window menu bar.

◦ Right-click the recipe; select View on the Popup menu.

Result: Parameter values for the selected recipe display in a column in the RecipeConfig right pane 

(grid).

Display values for recipes in a selected subfolder

3. Select a recipe subfolder.

4. Do one of the following:

◦ Click Tree>View All on the RecipeConfig window menu bar.

◦ Right-click the subfolder; select View All on the Popup menu.

Result: Parameter values for all recipes in the selected subfolder and its subfolders display in the 

RecipeConfig right pane.

Display all  recipes' values

5. Select the Recipes folder.

6. Do one of the following to display

◦ Click Tree>View All on the RecipeConfig window menu bar.

◦ Right-click the Recipes folder; select View All on the Popup menu.

Result: Parameter values for all recipes in the Recipes folder and all subfolders display in the 

RecipeConfig right pane.

Hide  Recipes' Values

7. Select one or more columns in the RecipeConfig window right pane.

8. Do one of the following to hide your selection.

◦ Click Grid>Hide column

◦ Click Grid>Hide all columns

◦ Click Grid>Hide all Recipe columns.

◦ Right-click your selection>select Hide Column on the Popup menu.

The columns are hidden based on your selection.

Step 3.4. Enter Recipe Parameter Values
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1  (on 

page 

515)

(New recipe) Review default recipe val

ues.

2  (on 

page 

516)

Modify recipe parameter values.

3  (on 

page 

517)

Confirm recipe properties.

4  (on 

page 

518)

Validate parameters.

(New recipe) Review  default recipe values

Display  (on page 513)  the values for a new recipe.

The column that displays in the grid default  values for the new recipe in the following priority.

1 Default source points that are defined for the Parameter have top priority.

2 A default value, when there is no default source point, is used as the recipe parameter's default val

ue.

3 When a parameter has no default value or source point, the recipe parameter default value is blank.,
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Modify  recipe parameter values

1. Display  (on page 513)  parameter values for any Recipe in the RecipeConfig window's grid.

2. Select the Parameter value you want to modify.

3. Change the value for the Parameter.

Possible values are:

1 Absolute value.

2 Blank (no value). Important:  The cell can only be blank if a default source point is specified for the 

parameter.

3 Point ID

Tip: There are several tools to help you select and enter point ID's. Select the field in the Recipe col

umn that is on the same row as the ID. Do any of the following.

• Create a point

• Click the New Point button  on the RecipeConfig toolbar.

• Click Tools>New Point on the RecipeConfig menu bar.

Note:

• If the project is running, make sure Dynamic Configuration is turned on in the RecipConfig win

dow.

• If you create a new point, you may have to browse for the point or type its ID in the field to en

ter it.

• Browse for a point
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• Click the Browse point button  on the RecipeConfig toolbar.

• Click Tools>Point Browse on the RecipeConfig menu bar.

• Right-click the field; select Point Browse on the Popup menu.

• Type the point ID in the field.

Confirm  recipe properties

A Recipe Cell Properties dialog box is available to do a quick check for each Recipe entry.

Do one of the following.

• Click Edit>Properties on the RecipeConfig menu bar.

• Right-click the field; select Properties on the Popup menu.

A Recipe Cell Properties dialog box opens.

Options are as follows.

A Options for Value can be modified before Download are:

Checked (Default) Allows the value to be  read/write before download.

Clear Makes the value read-only before download.

B Options are:

Value

Checked The value in the cell is downloaded to the corresponding Map point.

Checked by default if one of the following happens.
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• An absolute value is entered

• The field is blank

• A point ID that is entered is not available in the project.

CIM

PLICITY 

Point

(Checked) Contents of the CIMPLICITY Point ID are downloaded to the corresponding Map 

point. Checked by default if a point ID is entered that is available in the project.

Validate  parameters

The following validations are performed in Parameter columns:

• High/Low Limits

• Default Value

• Default Source Point

• High/Low Limits

The following validations are performed for the High Limit and Low Limit columns:

• If the cell is blank, no validation is performed.

• If the cell is not blank, the Data Type of the row must be numeric.

• When validating the Low Limit column, each Low Limit must be less than its corresponding High 

Limit.

• When validating the High Limit column, each High Limit must be greater than its corresponding 

Low Limit.

• Default Value

The following validations are performed for the Default Value column:

• Cell can only be blank if a Default Source Point is filled in for the row.

• If the Data Type for the row is numeric, the cell can contain only a numeric value.

• If the Data Type for the row is digital, the cell can contain only 0 or 1.

• If the Data Type for the row is text, the cell can contain anything.

• If the Data Type for the row is numeric, and Default High/Low limits are defined, the Default Value 

is verified to be within those limits.

• Default Source  Point

The following validations are performed for the Default Source Point column:
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• If the cell is blank, no validation is performed.

• The Point Type for the Default Source Point must match the Data Type of the row.

• If the Default Source Point is an array element, it must be within the array bounds.

• The point must be Enabled.

Step 3.5. Enter Recipe Properties

1. Select a recipe using either of the following methods.

◦ Click a recipe in the RecipeConfig window left pane.

◦ Click the recipe's name that identifies its column in the RecipeConfig window right pane.

2. Do one of the following.

◦ Click Edit>Properties on the RecipeConfig window menu bar.

◦ Click the right-mouse button; select Properties on the Popup menu.

◦ Press Alt+Enter.

The Recipe Data dialog opens.

3. Enter and review the following.
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Field Description

Recipe 

Name

(Read-only) Name of the Recipe.

Create 

Time

(Read-only) Date and time the Recipe was initially created.

Last Mod

ified

(Read-only) Date and time the Recipe was last modified.

Version Recipe version.

Product 

Code

Product code associated with the Recipe.

Author Author of the Recipe.

Recipe 

Point

CIMPLICITY Point ID to write the Recipe Name to when the Recipe is downloaded or 

uploaded. The point ID:

◦ May be unqualified or fully qualified.

◦ Must be a Text point of sufficient length to hold the Recipe name.

Batch 

Point

CIMPLICITY Point ID to write the user defined Batch ID to when the Recipe is Down

loaded. The point ID:

◦ May be unqualified or fully qualified.

◦ Must be a Text point of sufficient length to hold the Batch ID.

Com

ments

Text box for any comments about the recipe that should be recorded.

Step 3.6. Compare Recipes

1. Select a recipe.

2. Do one of the following:

◦ Click Tools>Compare on the RecipeConfig menu bar.

◦ Right-click the recipe; select Compare from the Popup menu.

A Recipe Compare Select browser opens displaying the additional recipes in the Recipes folder.

3. Select the recipes you want to compare.
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4. Click OK (or Cancel).

A message opens asking if you want to clear the grid before displaying the tecipe comparisons.

5. Click one of the buttons.

Yes Clears the grid.

No Leaves current data displaying in the 

grid.

The message closes; the grid displays your selections..
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A Values for the selected recipe display.

B Values for the recipes selected for comparison display. Note:  Values that are different from the first 

recipe display in bold.

Step 3.7. Copy/Move/Delete Recipes

As you manage your recipes, you can copy or move recipes between recipe folders, add more or delete 

ones that are no longer needed. You can also cut, copy and paste values from one recipe to another.

• Copy recipes.

• Move recipes.

• Delete recipes.

• Cut/copy a recipe value.

• Paste a recipe value.

Copy  recipes

1. Select a recipe name.

2. Do one of the following.

◦ Right-click the recipe; select Copy on the Popup menu.

◦ Click Tree>Copy on the RecipeConfig menu bar.

◦ Hold down the Ctrl key and the left mouse button; drag the recipe to the Recipes folder or a 

subfolder ; release the left mouse button.

Result: A Copy of the selected recipe is created in the selected folder; the default name is ready to 

be edited.

Move  recipes

3. Select a recipe name.

4. Hold down the left mouse button; drag the recipe to a selected Recipes folder or subfolder; release 

the left mouse button.

Result: The recipe is moved to the selected location.

Delete  recipes

5. Select the recipe you want to delete.

6. Do one of the following.
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◦ Click Edit>Delete on the RecipeConfig menu bar.

◦ Click the Delete button on the RecipConfig toolbar.

◦ Right-click the recipe; select Delete on the Popup menu.

◦ Press the Delete key.

Cut/Copy/ a recipe value

7. Select a recipe value in the RecipeConfig window right pane.

8. Do one of the following.

◦ Click the Cut or Copy buttons on the RecipeConfig toolbar.

◦ Click Edit>Cut or Edit>Copy on the RecipeConfig menu bar.

◦ Right-click the value; select Cut or Copy on the Popup menu.

◦ Press Ctrl+X (Cut) or Ctrl+C (Copy) on the keyboard.

Result: The selected value is cut or copied.

Paste  a recipe value

9. Select a recipe cell in the RecipeConfig window right pane where the value should be pasted.

10. Do one of the following.

◦ Click the Paste button on the RecipeConfig toolbar.

◦ Click Edit>Paste on the RecipeConfig menu bar.

◦ Right-click the value; select Paste on the Popup menu.

◦ Press Ctrl+V (Paste) on the keyboard.

The value is pasted into the selected cell.

Step 3.8. Print Recipe Data

1. Right-click a recipe.

2. Select Print on the Popup menu.

A Printer dialog box for the system's default printer appears.

3. Select the printer you want to use.

4. Select Landscape printing.

5. Print the document.

Recipes prints the following.

• The Recipe name is in the report heading.
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Note:  If the recipe name contains spaces, the text will wrap within the space boundaries.

• Columns include:

• ID

• Data Type

• Units

• Low Limit

• High Limit

• Default Value

• Default Source Point

• StoreValue

Step 4. Configure Recipe Maps

Step 4. Configure Recipe Maps

A Map is a list of CIMPLICITY Point IDs to which Recipe parameter values will be written during a 

Download request, or from which Recipe parameter values will be read during an Upload request. Map 

points may represent non-contiguous device addresses, and can span several devices.

You can create subfolders in the Maps folder to further classify your Maps. There is no restriction on the 

number of levels of subfolders you can create. You can create a Map in the Maps folder or in any Map 

subfolder.

Initially, the Maps folder contains no Maps or Map subfolders.

Component names must be unique.

Steps to create, configure and administer recipe maps are as follows.

Step 4.1 

(on page 

525)

Create a recipe map.

Step 4.2 

(on page 

526)

Rename a recipe map.

Step 4.3 

(on page 

527)

Display recipe map values.
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Step 4.4 

(on page 

528)

Enter recipe map parameter values.

Step 4.5 

(on page 

529)

Enter recipe map properties.

Step 4.6 

(on page 

530)

Create, rename, copy and delete a recipe 

map.

Step 4.1. Create a Recipe Map

1. Select one of the following.

◦ Maps folder

◦ Maps subfolder.

◦ Existing map.

2. Do one of the following.

A Click the New button on the RecipeConfig toolbar.
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B Right-click your selection: select New>Map on the Popup 

menu.

C Press Ctrl+N on the keyboard.

The new map is added to the end of the map list in the selected folder and is given the default name New 

Map.

Note:

The next time the recipe group is saved, the map  (on page 547)  list will be resorted so the new 

recipe will be listed in the correct alphanumeric order.

Step 4.2. Rename a Recipe Map

When a map is first created, the default name is available for editing.

You can edit any map names as follows.

1. Select a map.

2. Do one of the following.

◦ Click File>Rename on the Recipes menu bar.

◦ Right-click the name; select Rename on the Popup menu.

◦ Press Alt+F+M on the keyboard.

The name becomes available for editing.

3. Enter the new map name.
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Note:

The name must be unique across the entire Group. The maximum length is 255 characters.

Step 4.3. Display Recipe Map Values

You can display the contents of a single Map, all Maps, or all Maps in a subfolder.

Note:

The icon in the Tree changes from  or  to for Maps that you are displaying in the Grid.

• Display a single map.

• Display all maps

Display a single  recipe's map values

1. Select a map.

2. Do one of the following.

◦ Double-click the map in the RecipeConfig window left pane.

◦ Click Tree>View on the RecipeConfig window menu bar.

◦ Right-click the recipe; select View on the Popup menu.

Result: Parameter values for the selected map display in a column in the RecipeConfig right pane 

(grid).

 Display recipe map values in a selected subfolder

3. Select a map subfolder.

4. Do one of the following:

◦ Click Tree>View All on the RecipeConfig window menu bar.

◦ Right-click the subfolder; select View All on the Popup menu

Result: Parameter values for all maps in the selected subfolder and its subfolders display in the 

RecipeConfig right pane.
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Display all  recipe map values

5. Select the Maps folder.

6. Do one of the following.

◦ Click Tree>View All on the RecipeConfig window menu bar.

◦ Right-click the Maps folder; select View All on the Popup menu.

All Maps in the Maps folder and all Map subfolders will be displayed in the Grid.

Parameter values for all maps in the Maps folder and all subfolders display in the RecipeConfig right 

pane.

Step 4.4. Enter Recipe Map Parameter Values

Map parameter values are device points where CIMPLICITY software can Download or Upload Recipe 

parameters. You can enter Point IDs manually or use the Point Browser to select them. Point IDs may be 

unqualified or fully qualified.

• Define map parameter values

• Modify map parameter values

Define  map parameter values

The device points you define for the Map do not need to be contiguous or on the same device. However, 

the more non-contiguous points you have in the Map, the more time will be needed to perform Uploads 

and Downloads.

For best performance on Uploads or Downloads, use contiguous array points in a Map. For example, 

consider the following Maps:

When MAP1 is used for a Download or Upload, a single write/read request is issued.
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When MAP2 is used for a Download or Upload, three write/read requests are issued.

Modify  map parameter values

1. Display the Map in the Grid.

2. In the Map, select the Parameter value you want to modify.

3. Change the CIMPLICITY Point ID for the Parameter. You may enter the new Point ID manually, or 

use the Point Browser to select a Point ID. The Point ID may be unqualified or fully qualified.

Step 4.5. Enter Recipe Map Properties

1. Select a recipe map using either of the following methods.

◦ Click a map in the RecipeConfig window left pane.

◦ Click the map's name that identifies its column in the RecipeConfig window right pane.

2. Do one of the following:

◦ Click Edit>Properties on the RecipeConfig window menu bar.

◦ Click the right-mouse button; select Properties on the Popup menu.

◦ Press Alt+Enter.

The Map Data dialog box opens.

3. Enter and review the following.

Map 

Name

(Read-only) Name of the selected map.

De

scrip

tion

Descriptive phrase to help identify the map.
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Map 

Point

CIMPLICITY point ID that the map name will be written to when a Recipe is downloaded 

or uploaded. Note:  The point ID may be:

◦ May be unqualified or fully qualified.

◦ Must be a text point of sufficient length to hold the map name.

Status 

Point

CIMPLICITY Point ID that the status will be written to while a Recipe is downloaded or up

loaded. Notes

◦ The point ID can be unqualified or fully qualified.

◦ The way the status is reported depends on the point type, as follows.

◦ An analog or float type point provides a numeric percentage (0-100%) that will be 

written to the point while the recipe is downloaded or uploaded.

This point can then be used to animate an object on a CimView screen.

◦ A text point provides a status message that will be written to the point.

Be sure to use a TEXT_80  type point so that the status message can be displayed in full.

Step 4.6. Create, Rename, Copy and Delete a Recipe Map

• Copy recipe maps.

• Move recipe maps.

• Delete recipe maps.

• Cut/copy a map value.

• Paste a map value.

Copy  recipe maps

1. Select a map name.

2. Do one of the following.

◦ Right-click the map; select Copy on the Popup menu.

◦ Hold down the Ctrl key and the left mouse button; drag the map to the Recipes folder or a 

subfolder ; release the left mouse button.

Result: A Copy of the selected map is created in the selected folder; the default name is ready to be 

edited.

Move  recipe maps

3. Select a map name.

4. Hold down the left mouse button; drag the map to a selected Maps folder or subfolder; release the 

left mouse button.
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Result: The map is moved to the selected location.

Delete  a recipe map

5. Select the map you want to delete.

6. Do one of the following.

◦ Click Edit>Delete on the RecipeConfig menu bar.

◦ Click the Delete button on the RecipConfig toolbar.

◦ Right-click the map; select Delete on the Popup menu.

◦ Press the Delete key.

Cut/Copy/ a recipe map value

7. Select a map value in the RecipeConfig window right pane.

8. Do one of the following.

◦ Click the Cut or Copy buttons on the RecipeConfig toolbar.

◦ Click Edit>Cut or Edit>Copy on the RecipeConfig menu bar.

◦ Right-click the value; select Cut or Copy on the Popup menu.

◦ Press Ctrl+X (Cut) or Ctrl+C (Copy) on the keyboard.

Result: The selected value is cut or copied.

Paste  a recipe value

9. Select a map cell in the RecipeConfig window right pane where the value should be pasted.

10. Do one of the following.

◦ Click the Paste button on the RecipeConfig toolbar.

◦ Click Edit>Paste on the RecipeConfig menu bar.

◦ Right-click the value; select Paste on the Popup menu.

◦ Press Ctrl+V (Paste) on the keyboard.

The value is pasted into the selected cell.

Step 5. Upload/Download Recipes and Maps

Step 5. Upload/Download Recipes and Maps

Map values can be uploaded or downloaded to or from any selected recipe.

The process can be triggered manually or automatically.
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Option 5.1 

(on page 

532)

Upload/download recipes and maps manually.

Option 5.2 

(on page 

541)

Configure recipe automatic upload/download ac

tions.

Option 5.1. Upload/Download Recipes and Maps Manually

Option 5.1. Upload/Download Recipes and Maps Manually

Recipes can be manually uploaded or downloaded through the RecipeConfig window.

Option 5.1.2 

(on page 

532)

Upload recipes and maps manually.

Option 5.1.2 

(on page 

535)

Download recipes and maps manual

ly.

Option 5.1.1. Upload Recipes and Maps Manually

Option 5.1.1. Upload Recipes and Maps Manually

Step 5.1.1.1 

(on page 

532)

Open an Upload a Recipe dialog box.

Step 5.1.1.2 

(on page 

534)

Enter recipe upload properties.

Step 5.1.1.1. Open an Upload a Recipe Dialog Box

1. Select a recipe or map in the RecipeConfig window left pane.

2. Do one of the following:
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A Click Tools>Upload on the RecipeConfig window menu bar.

B Click the Upload Recipes button on the RecipeConfig window toolbar.

C Right-click the selected recipe or map; select Upload on the Popup 

menu.

D Press Ctrl+U on the keyboard.

E Drag a map onto the recipe that you want to use for the upload.

An Upload a Recipe dialog box opens when you use any method.
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Step 5.1.1.2. Enter Recipe Upload Properties

1. Enter the following.

Recipe Recipe to be uploaded. Recipes that are included in the recipe group are available in the 

drop down list.

If the: Recipe was selected Recipe was not selected

Default is: Selected recipe. First recipe in the list.

Map Map to be uploaded. Maps that are included in the recipe group are available in the drop 

down list.

If the: Map was selected Map was not selected

Default is: Selected map First map in the list

Up

load 

To

Recipe to which map values will be uploaded. Recipes that are included in the recipe 

group are available in the drop down list.

If the: Recipe was selected Recipe was not selected

Default is: Selected recipe. First recipe in the list.

2. Click one of the following.

◦ OK

One of the following occurs.

• If the target already exists a message will open.

Click on of the following.



Addons and Options  | 5 - Recipes Configuration  | 535

Yes Uploads the recipe and overwrites the existing recipe's con

tents.

No Closes the message so another target can be selected.

Cancel Closes the message and the Upload a Recipe dialog box.

• If the target recipe does not already exist.

The selected recipe and map values are uploaded.

• Cancel

The Upload a Recipe dialog box closes: the upload is cancelled.

Option 5.1.2. Download Recipes and Maps Manually

Option 5.1.2. Download Recipes and Maps Manually

Step 5.1.2.1 

(on page 

536)

Open a Download a Recipe dialog box.

Step 5.1.2.2 

(on page 

537)

Enter recipe download general proper

ties.

Step 5.1.2.3 

(on page 

538)

Modify recipe parameters for download.

Step 5.1.2.4 

(on page 

539)

Manually start the recipe download.
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Step 5.1.2.1. Open a Download a Recipe Dialog Box

1. Select a recipe or map in the RecipeConfig window left pane.

2. Do one of the following:

A Click Tools>Download on the RecipeConfig window menu bar.

B Click the Download Recipes button on the RecipeConfig window toolbar.

C Right-click the selected recipe or map; select Upload on the Popup 

menu.

D Press Ctrl+D on the keyboard.

E Drag a recipe onto the map that you want to use for the upload.

A Download a Recipe dialog opens when you use any method.



Addons and Options  | 5 - Recipes Configuration  | 537

Step 5.1.2.2. Enter Recipe Download General Properties

The default values that display on the General tab depend on whether a recipe, map or both were selected 

to open the Download a Recipe dialog box.

Review and enter the following.

Recipe Recipe to be downloaded. Recipes that are included in the recipe group are available in the 

drop down list.

If the: Recipe was selected Recipe was not selected

Default Selected recipe. First recipe in the list.

Map Map to be downloaded. Maps that are included in the recipe group are available in the drop 

down list.
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If the: Map was selected Map was not selected

Default Selected map First map in the list

Batch 

ID

(Option) Batch Identifier for the product to be manufactured. When the Download is executed, 

this text will be placed in the Batch Point defined for the Recipe. Note:  When a value is entered 

in the Batch ID  field, the Batch ID Source Point  field is disabled.

Batch 

ID 

Source 

Point

(Option) CIMPLICITY Point ID. When the Download is executed, the text contained in this Point 

ID will be placed in the Batch Point defined for the Recipe. The point ID:

• May be unqualified or fully qualified.

• Must be a Text point of sufficient length to hold the batch ID.

Note:  When a value is entered in the Batch ID Source Point  field, the Batch ID  field is disabled.

Step 5.1.2.3. Modify Recipe Parameters for Download

1. Select the Modify Parameters tab.

The parameters and values that display represent the selected recipe and map.

2. (Optional) Modify any parameter that has the Value can be modified before Download  (on page 

517)  checkbox checked, as follows.

a. Double-click the parameter in the Recipe list.
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A Modify Recipe Value dialog box opens.

a. Review and enter the following.

Parameter (Read-only) Parameter selected to be modified.

Units (Read-only) Units assigned to the parameter.

Recipe Value New value that should be downloaded.

CIMPLICITY Point Check if the new value is a CIMPLICITY point ID.

3. Click OK.

Step 5.1.2.4. Manually Start the Recipe Download
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1. Click OK when the recipe download specifications are accurate.

A message opens asking if you want to validate the recipe and map before you download.

2. Click one of the following.

◦ Yes

During the download, Recipes validates the parameters.

If a parameter is invalid a message displays reporting the issue.

You can choose to continue or stop the validation when the recipe resumes and continues downloading.

• No

The recipe is downloaded with no validation.
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Option 5.2. Configure Recipe Automatic Upload/Download Actions

Option 5.2. Configure Recipe Automatic Upload/Download Actions

For Recipes, Automatic Actions are Downloads and Uploads that are done automatically through the 

Event Manager. Once you configure an Automatic Action, you can use the Event Editor to create Events 

that will cause the Action to be executed.

Step 5.2.1 

(on page 

541)

Open a Create auto Action Parameter File dialog box.

Step 5.2.2 

(on page 

542)

Create an automatic upload or download parameter 

file.

Step 5.2.1. Open a Create Auto Action Parameter File Dialog Box

1. Select a recipe or map in the RecipeConfig window left pane.

2. Do one of the following:
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A Click Tools>Create Auto Action on the RecipeConfig window menu bar.

B Right-click the selected recipe or map; select Create Auto Action on the Popup 

menu.

D Press Alt+T+A on the keyboard.

A Create Auto Action Parameter File dialog box opens when you use any method.

Step 5.2.2. Create an Automatic Upload or Download Parameter File

A  (on 

page 

542)

Select the recipe and map that will be automatically uploaded or down

loaded.

B  (on 

page 

543)

Enter upload or download specifications.

C  (on 

page 

544)

Save the parameter file.

1. Select  the Recipe and Map that will be automatically uploaded or downloaded.

Enter the following.
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Recipe Recipe to be uploaded. Recipes that are included in the recipe group are available in the drop 

down list.

If the: Recipe was selected Recipe was not selected

Default is: Selected recipe. First recipe in the list.

Map Map to be uploaded. Maps that are included in the recipe group are available in the drop down 

list.

If the: Map was selected Map was not selected

Default is: Selected map First map in the list

1. Enter  upload or download specifications.

Upload Specifications

Do the following.

1 Check Upload.
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2 Enter the name of the recipe to which map values will be up

loaded.

Download Specifications

Do the following.

1 Check Download.

2 Enter one of the following.

Batch 

ID

(Option) Batch Identifier for the product to be manufactured. When the Download is execut

ed, this text will be placed in the Batch Point defined for the Recipe. Note:  When a value is 

entered in the Batch ID field, the Batch ID Source Point field is disabled.

Batch 

ID 

Source 

Point

(Option) CIMPLICITY Point ID. When the Download is executed, the text contained in this 

Point ID will be placed in the Batch Point defined for the Recipe. The point ID:

• May be unqualified or fully qualified.

• Must be a Text point of sufficient length to hold the batch ID.

Note:  When a value is entered in the Batch ID field, the Batch ID Source Point field is dis

abled.

1. Save  the parameter file.
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1. Click OK in the Create Auto Action Parameter File dialog box.

A Save as dialog box opens.

2. Enter the name of the upload or download file in the File name  field.

Note:  If the file already exists a message will display asking you if you want to overwrite it.

3. Click Save.

The file will now be available to be used with a CIMPLICITY event.

Step 6. Administer Recipe Groups

Step 6. Administer Recipe Groups

Option 6.1 

(on page 

545)

Validate recipe group columns.

Option 6.2 

(on page 

547)

Save and refresh a modified recipe 

group.

Option 6.3 

(on page 

549)

Export a recipe group.

Option 6.4 

(on page 

550)

Archive a recipe group.

Option 6.1. Validate Recipe Group Columns

You can validate the following information in your Recipe Group:

• Parameters

• Recipes

• Maps

The type of validation done, and the messages displayed, depends on the type of column you are 

validating.
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Important:

To validate Default Source Points, Recipe Points, or Maps, your CIMPLICITY project must be 

running.

1. Make sure the information you want to validate displays in a column in the RecipeConfig window 

right pane.

2. Select the column you want to validate.

Note:  You can validate one column at a time.

3. Do one of the following:

A Click Tools>Validate on the RecipeConfig window menu bar.

B Click the Validate button on the RecipeConfig window tool

bar.

C Press Ctrl+L on the keyboard.

Result: When the Validation procedure finds a problem, it does the following.

◦ Displays a dialog box with detailed information about the location and type of problem

Example
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◦ Is recorded in the project's Status Log.

4. Click one of the following buttons.

But

ton
Result

Yes The validation continues and displays additional warnings and errors.

No The validation continues without displaying messages. Messages will still be logged to 

the project's Status Log.

Can

celt

Cancels the validation.

Option 6.2. Save and Refresh a Modified Recipe Group

Note:

First time save, make sure you are saving in the correct project folder.

Do one of the following.
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A Click File>Save on the RecipeConfig window menu bar.

B Click File>Save All on the RecipeConfig window menu bar.

C Click the Save button on the RecipeConfig window toolbar. Note:  The Save button is enabled if the 

Recipe group has been modified since the last time it was saved.

D Press one of the following on the keyboard.

For Press

Save Ctrl+S

Save All Alt+F+V

Result: One of the following happens depending on whether Save or Save All was used.

• Save

A message box opens reporting the entire group must be saved.

Click Yes to save the recipe group.

• Save All

The recipe group is saved.

The recipe group is saved; the view in the RecipeConfig window is refreshed, e.g. the recipe and maps 

lists are resorted so all items including additions are listed in alphanumeric order.
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Note:

When you attempt to close the Recipe Group, if there are unsaved modifications, you will be 

notified and asked if you want to save them.

Option 6.3. Export a Recipe Group

A recipe group can be exported as a .csv file.

1. Select the Group folder in RecipeConfig window left pane.

A Click File>Export on the RecipeConfig window menu bar.

B Click the Export Recipes button on the RecipeConfig window tool

bar.
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C Press Ctrl+E on the keyboard.

A Save As dialog box opens.

2. In the Save As dialog, enter a file name and select a directory for the export file.

Note:  The file type for an exported Recipe Group is .csv.

3. Click OK  to export the recipe group, or Cancel  to cancel the Export request.

The recipe group is exported.

Note:

You can use Notepad or Microsoft Excel to display and make changes in the .csv  file.

Option 6.4. Archive a Recipe Group

1. Select the Group folder in the RecipeConfig window left pane.

2. Do one of the following:
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A Click File>Archive on the RecipeConfig window menu bar.

B Click the Archive button on the RecipeConfig window tool

bar.

C Press Ctrl+A on the keyboard.

A Save As dialog box opens.

3. Enter a file name (the default name is the Group name) and select a directory for the archive file.

Notes

◦ The default name is the recipe group name.

◦ The file type for an archived Recipe Group is .rar.

4. Click OK  to archive the file, or Cancel  to cancel the Archive request.

The recipe group is archived.
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Note:

If there are differences between the displayed Recipe Group and the saved Recipe Group, you will 

be asked if you want to save the Group before archiving it.

Recipe Control Configuration

Recipe Control Configuration

You can configure a Recipes ActiveX control in CimEdit  that enables operators to Upload and Download 

Recipes during runtime.

Steps to configure and use a recipe control are as follows.

Step 1 

(on page 

552)

Place a recipe control on a CimEdit screen.

Step 2 

(on page 

554)

Open a CIMPLICITY Recipe Control Properties dialog box.

Step 3 

(on page 

555)

Define general recipe control properties.

Step 4 

(on page 

557)

Specify recipe control batch ID properties.

Step 5 

(on page 

558)

Upload or download recipes during runtime.

Step 1. Place a Recipe Control on a CimEdit Screen
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1. Do the following.

A Select the Drawing tab on the CimEdit Ribbon bar.

B Click the OLE OLE button in the Objects group.

C Place the cursor in the location where the control should be 

placed.

D Click the left-mouse button.

An Insert Object browser opens.

2. Do the following.
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A Select CIMPLICITY Recipe Con

trol.

B Click OK.

A Recipe control button is placed on the CimEdit screen.

Note:

You can resize or move the Recipe control object the using the same methods used for other 

objects on a CimEdit screen.

Step 2. Open a CIMPLICITY Recipe Control Properties Dialog Box

Do one of the following.



Addons and Options  | 5 - Recipes Configuration  | 555

A Double-click the Recipe control object.

B Right-click the Recipe control object; select CIMPLICITY Recipe Control Object>Properties on the 

Popup menu.

Result: The Recipe Control Properties dialog box opens when you use either method.

Step 3. Define General Recipe Control Properties
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1. Enter general Recipe control specifications, as follows.

Text Text that will display on the button.

Group Recipe group that contains the selected recipe and map. Note:  The Popup Menu button 

to the right of the input field enables you  to search for and select a Group. Important: 

The recipe group cannot be open in the RecipeConfig window when you select it in the 

CIMPLICITY Recipe Control Properties dialog box.

Recipe Name of the Recipe that will be uploaded or downloaded. Note:  The  drop-down list in

cludes a list of the Recipes that are in the recipe group.

Map Map whose values will be downloaded or uploaded. Note:  The drop-down list includes a 

list of the maps that are in the recipe group.

Action Select one of the following actions for the control:

Action Description

Download/Modify a. Modify Recipe parameters.

b. Download the modified Recipe.

Download Download a Recipe without modifying it.

Upload to New a. Upload a Recipe.

b. Save the values in a new Recipe.

Upload/Save Upload a Recipe and overwrite its existing values with the new ones.
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2. Modify Recipe parameters.

3. Download the modified Recipe.

4. Upload a Recipe.

5. Save the values in a new Recipe.

6. Do one of the following when you have entered the general specifications.

But

ton
Result

OK Applies the changes; closes the CIMPLICITY Control Properties dialog box.

Can

cel

Cancels the changes.

Ap

ply

Applies the changes; does not close the dialog box. Note:  If you have selected to download 

the recipe/map, you can enter Batch specifications on the Batch ID tab.

Step 4. Specify Recipe Control Batch ID Properties

When you create a Recipe, you can define a Batch Point.

Recipes will place a Batch ID in the Batch Point when the Recipe is downloaded.

1. Select the Batch ID tab in the CIMPLICITY Recipe Control Properties dialog box.

2. Enter one of the following.

a. Batch ID
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Enter text in the Batch ID  field.

When the Recipe is downloaded the text will be written to the Batch point when the Recipe is 

downloaded.

Note:  When a value is entered in the Batch ID field, the Batch ID Source Point field is disabled.

a. Batch ID Source Point

Enter a Point ID in the Batch ID Source Point  field.

When the Recipe is downloaded, the contents of this Point ID are written to the Batch Point.

Note:

◦ The Point ID:

◦ May be unqualified or fully qualified.

◦ Must be a Text point.

◦ Use the Browser and Popup Menu buttons to the right of the input field to browse for an 

existing point ID or create a new one.

◦ When a value is entered in the Batch ID Source Point  field, the Batch ID  field is disabled.

3. Click one of the following.

Button Result

OK Applies the changes; closes the CIMPLICITY Control Properties dialog box.

Cancel Cancels the changes.

Apply Applies the changes; does not close the dialog box.

Step 5. Upload or Download Recipes during Runtime

When a Recipe Control dialog box opens during runtime, entries made during configuration display as 

default values in the dialog box fields.

• Download a recipe.

• Upload a recipe.

Download  a recipe



Addons and Options  | 5 - Recipes Configuration  | 559

1. Click a Recipe control on a CimView screen that was configured to download a recipe/map.

A Download a Recipe dialog box opens.

The specifications entered in the CIMPLICITY Recipe Control Properties dialog box display in the 

Download a Recipe dialog box.

2. (Optional) Change any of the recipe/map and batch  (on page 537)  specifications to 

accommodate runtime download requirements.

3. Click one of the following.

Button Result

OK Starts the download.

Cancel Cancels the download.

Mod 

Params

Opens a Modify Download Values dialog box. You can modify parameter values, as 

follows.
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Button Result

a. Click each value that should be modified.

The fields in the Value  column are read/write.

a. Enter the modified value.

b. Click Download when the values comply with the download specifications.

Result: The download proceeds using the modified values.

Note:

You can lengthen or shorten the width of the Download a Recipe dialog box.

Upload  a Recipe

4. Click each value that should be modified.

The fields in the Value  column are read/write.

5. Enter the modified value.

6. Click Download when the values comply with the download specifications.



Addons and Options  | 5 - Recipes Configuration  | 561

7. Click a Recipe control on a CimView screen that was configured to upload a recipe/map.

An Upload a Recipe dialog box opens; the dialog box width is the same width as the width of the 

last dialog box that was open during the runtime session.

The specifications entered in the CIMPLICITY Recipe Control Properties dialog box display in the 

Upload a Recipe dialog box.
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8. (Optional) Change any of the specifications to accommodate runtime upload requirements.

9. Click one of the following.

Button Result

OK Starts the upload.

Cancel Cancels the upload.

Note:

You can lengthen or shorten the width of the Upload a Recipe dialog box.

Technical Reference

Technical Reference

1  (on 

page 

562)

CSV file format for import/export.

2  (on 

page 

565)

Basic Control Engine extensions for 

recipes.

1. CSV File Format for Import/Export

1. CSV File Format for Import/Export

The data included in the .csv file for Recipes is divided into four areas:
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A  (on 

page 

563)

Group information

B  (on 

page 

563)

Recipes information

C  (on 

page 

563)

Maps information

D  (on 

page 

564)

Parameters informa

tion

Each area consists of one line that lists the fields included in the area, followed by as many lines needed 

to contain the data for the area.

1. Group  information

The first and second lines consist of the following.

Line Consists of

1 Text for Group Name, Description, GroupPoint

2 Data for the Line 1 fields.

1. Recipe  information

The first line and several following lines consist of the text:

Line Consists of

1 Text for Recipe Name, Version, ProductCode, Author, RecipePoint, BatchPoint, Comments

2 - N (One line for each recipe in the recipe group) Data for the Line 1 fields.

1. Map  information

The first line and several following lines consist of the text:
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Line Consists of

1 Text for Map Name, Description, MapPoint, StatusPoint

2 - N (One line for each map in the recipe group) Data for the Line 1 fields.

1. Parameters  information

The first line and several following lines consist of the text:

Line Consists of

1 Text for ID,Data Type,Units,Low Limit,High Limit,Default Value,Default Source Point,r1,Can 

Mod,IsPoint,r2,Can Mod,IsPoint,...,rn,Can Mod,IsPoint

2 - 

N

(One line for each parameter in the recipe group) Data for the Line 1 fields. This parameter infor

mation also includes information about whether the corresponding Recipes parameters can be 

modified or are CIMPLICITY points.

Sample .csv File

The following is an example of the CSV file that is exported by Recipes:

Group Name, Description, GroupPoint

Breads,,

Recipe Name, Version, ProductCode, Author, RecipePoint, BatchPoint, Comments

\\Breads\Recipes\White,,,,,,

\\Breads\Recipes\Raisin,,,,,,

\\Breads\Recipes\Rye,,,,,,

Map Name, Description, MapPoint, StatusPoint

\\Breads\Maps\Old Line,,,

\\Breads\Maps\New Line,,,

ID,Data Type,Units,Low Limit,High Limit,Default Value,Default Source Point,White,Can Mod,IsPoint,Raisin,Can 

 Mod,IsPoint,Rye,Can Mod,IsPoint,Old Line,New Line

Yeast,USINT,oz.,,,,,2,Y,N,2,Y,N,2,Y,N,PT_700_PLC1,PT_1

Water,INT,gal.,,,,,20,Y,N,30,Y,N,23,Y,N,PT_701_PLC1,PT_2

Milk,INT,gal.,,,,,40,Y,N,35,Y,N,40,Y,N,PT_703_PLC1,PT_3

Sugar,INT,lbs.,,,,,15,Y,N,15,Y,N,13,Y,N,PT_704_PLC1,PT_4

Shortning,INT,cups,,,,,10,Y,N,10,Y,N,12,Y,N,PT_705_PLC1,PT_5

Salt,INT,tsp.,,,,,1,Y,N,1,Y,N,1,Y,N,PT_706_PLC1,PT_6

Flour,INT,lbs.,,,,,50,Y,N,50,Y,N,0,Y,N,PT_707_PLC1,PT_7
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Raisins,INT,cups,,,,,0,Y,N,10,Y,N,0,Y,N,PT_112_PLC1,PT_8

Molasses,INT,cups,,,,,0,Y,N,0,Y,N,10,Y,N,PT_113_PLC1,PT_9

Rye Flour,INT,lbs.,,,,,0,Y,N,0,Y,N,50,Y,N,PT_114_PLC1,PT_10

Caraway Seeds,INT,tbsp.,,,,,0,Y,N,0,Y,N,13,Y,N,PT_712_PLC1,PT_11

Temperature,INT,deg. F,,,,,425,Y,N,425,Y,N,420,Y,N,PT_1310_PLC2,PT_12

Mix Time,REAL,min.,,,,,15,Y,N,15,Y,N,17.5,Y,N,PT_1908_PLC2,PT_13

Bake Time,REAL,min.,,,,,25,Y,N,25,Y,N,29,Y,N,PT_2506_PLC2,PT_14

2. Basic Control Engine Extensions for Recipes

The Recipes option has a Scripting interface (using extensions to the Basic Control Engine) that enables 

you to:

• Upload and download recipes automatically based on system events, such as point changes from 

a shop floor device.

• Import and export recipe groups from/to CSV file formats.

• RCPDownload (statement)

• RCPUpload (statement)

• RCPGroupExport (statement)

• RCPGroupImport (statement)



Chapter 6. Statistical Process Control

About Statistical Process Control

SPC uses statistical methods to determine whether processes are within required limits. While 

CIMPLICITY's normal alarm functions detect when individual points actually exceed limits, SPC analysis 

can provide early warning by detecting undesirable systematic variations in your process. This can help 

you pinpoint process, machine, operator, or material problems so that actions can be taken to diagnose 

and resolve the problem.

CIMPLICITY performs a series of functions in order to provide you with information through the SPC 

option.

1. SPC Preparation  (on page 570)

2. SPC Products: Configuration  (on page 580)

3. SPC Control: Configuration  (on page 676)

4. 3. SPC Preparation: Points  (on page 572)

5. 4. SPC Preparation: Database Logger  (on page 575)
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6. SPC Runtime  (on page 695)

7. SPC Runtime  (on page 695)

8. 5.5. SPC Variable: Alarms/Control Tests  (on page 627)

9. 6.5. SPC Attribute: Alarms/Control Tests  (on page 655)

10. SPC Charts  (on page 718)

Item Descriptions

(on 

page 

570)

SPC Preparation  CIMPLICITY features, such as security, points and database logging require 

some configuration to work with and/or be available for SPC.

  (on 

page 

572)

Point Management includes points used in SPC document configuration.

  (on 

page 

575)

ODBC database

(on 

page 

580)

SPC Products Configuration includes creating and defining quality characteristics for:

  (on 

page 

605)

Variables

  (on page 627)  Variable alarms/control tests.

  (on 

page 

635)

Attributes

  (on page 655)Attribute alarms/control tests.
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Item Descriptions

  (on 

page 

663)

Defects

(on 

page 

676)

SPC Control Configuration provides options for chart properties and display.

(on 

page 

695)

SPC runtime During runtime users can interact with SPC charts. Options include:

  (on 

page 

697)

Manual data entry.

  (on 

page 

705)

Annotation.

  (on 

page 

701)

Exclusion.

(on 

page 

718)

SPC Runtime Charts SPC provides many charts for quality characteristics.

 

(on page 

719)

Variables
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Item Descriptions

 

(on page 

725)

Attributes

 

(on page 

730)

Defects

SPC Administration Alarms

During runtime the SPC application detects the following kinds of inconsistencies:

• Points are unavailable.

• Limits are out of sequence.

• Sampling parameters are invalid.

Therefore, SPC comes with a built-in $SPC_ADMIN_ALARM to alert operators to those conditions. This 

alarm is generated because of configuration inconsistencies, in contrast to SPC alarms that are generated 

because of process problems.

Each instance of this alarm, which will display in your Alarm Viewer, provides you with:

\\Group Name\Product Name\QC Name\Alarm number

Alarm Numbers are as follows:

1 Required Points(s) are unavailable.

2 XBar control limits are out of se

quence.

3 R/S control limits are out of sequence.

4 Sample size is invalid.

5 Gap size is invalid.
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SPC Preparation

SPC Preparation

Some CIMPLICITY setup is necessary before you begin to configure the SPC features.

1  (on 

page 

570)

SPC Preparation: Enable SPC.

2  (on 

page 

571)

SPC Preparation: Security..

3  (on 

page 

572)

SPC Preparation: Points..

4  (on 

page 

575)

SPC Preparation: Database Logger.

5  (on 

page 

576)

SPC Preparation: PKCS #7 Certifi

cate.

1. SPC Preparation: Enable SPC

1. Click Project>Properties on the Workbench menu bar.

The Project Properties dialog box opens.

2. Select the General tab.
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3. Check SPC Charts in the Options  box.

SPC is enabled for the CIMPLICITY project.

2. SPC Preparation: Security

• SPC: Roles

• SPC: Resources

SPC: Roles

SPC charts include an annotation feature, for which user access can be permitted or denied in the Roles 

Properties dialog box.

1. Select Project>Security>Roles  in the Workbench left-pane.

2. Select a role in the Workbench right-pane.

The Roles Properties dialog box opens.

3. Select the SPC Annotation tab.

4. Check or clear the Multi-Annotation  (on page 705)  checkbox to do the following.
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Check/Clear Role:

Check Can do multi-annotation

Clear Cannot do multi-annotation

During runtime the user will/will not be able to do annotations based on the assigned role.

SPC: Resources

SPC may have one or more unique resources. Make sure to assign the appropriate users to the 

resourcesbeing used for SPC.

3. SPC Preparation: Points

Although there are areas in SPC where values can be entered manually, CIMPLICITY points are at the core 

of data collection and evaluation.
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Points can be created at any time and used in the SPC configuration.

However, the following list of fields where runtime points might be used may help you create a logical 

naming convention as processes are evaluated and monitored.

• Points: For Variables

• Points: For Attributes

• Points: For Defects

Note:

These fields are based on runtime points being selected as the data source. The points can also 

be logged and logged values used as the data source. If you use logged values, make sure to 

check Logged Data on the Point Properties dialog box>General tab for the points that will be 

logged.

Points: For Variables

A Variable Quality Characteristics Properties dialog box  provides the tools to measure a product's 

selected variable quality characteristics.

Dialog Box Tab Field

General Data setpoint ID

Collection Point ID

Collection Match Point ID

Collection Batch Point ID

Limits XBar UCL

Limits XBar CL

Limits XBar LCL

Limits R/S UCL

Limits R/S CL

Limits R/S LCL

Limits Setpoint ID

Limits Force Auto Recalc
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Dialog Box Tab Field

Alarm Setpoint ID (XBar Alarms)

Points: For Attributes

A Attribute Quality Characteristics Properties dialog box  provides the tools to measure a product's 

selected attribute quality characteristics.

Dialog Box Tab Field

General Data setpoint ID

Collection Point ID

Collection Match Point ID

Collection Batch Point ID

Limits UCL

Limits CL

Limits LCL

Limits Setpoint ID

Limits Force Auto Re

calc

Alarm Setpoint ID

Points: For Defects

Defects are both grouped into categories and measured individually.

Defect Folders

The Defect Folder Properties dialog box  provides tools to help measure a defect group's characteristics.

Dialog Box Tab Field

General Match Point ID

General Batch Point ID
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Defect Properties

The Defect Properties dialog box  provides tools to measure a specific defect's occurance.

Dialog Box Tab Field

Collection Point ID

4. SPC Preparation: Database Logger

• ODBC data source

• Database Logger: Enabled

• Database Logger: SPC Tables

ODBC  Data Source

SPC automatically creates a default SQL Server data source, CIMPLICITY Logging - SPC.

New SPC documents will use this data source by default.

Important:

All the SPC documents in a CIMPLICITY project must log their data to the same SPC data source. 

You can share an SPC data source between projects or create a data source for each project.
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Database Logger: Enabled

Make sure the Database Logger is enabled; it will be listed in the Workbench left-panewhen it is.

Database Logger: SPC Tables

SPC includes the following tables to log and store data specifically for SPC. These are system tables and 

cannot be opened in the Database Logger window.

The tables are:

1. 5. SPC Runtime: Annotation  (on page 705)

2. 6. SPC Products: Attribute Quality Characteristics  (on page 635)

3. 7. SPC Products: Defect Properties  (on page 663)

4. 5. SPC Products: Variable Quality Characteristics  (on page 605)

5. 5. SPC Products: Variable Quality Characteristics  (on page 605)

Table Logs:

SPCANNO Annotations.

SPCATT Attribute data.

SPCDEF Defect data.

SPCVARX Variable.

SPC

VARXBAR

Variable data for XBar track

ing.

5. SPC Preparation:  PKCS #7 Certificate
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Supported Windows versions supersede the file extension .spc to reference the PKCS #7 certificates file 

format instead of CIMPLICITY .spc file format.

As a result, you may need to do some initial configuration to open .spc documents in the Workbench.

If Windows was installed before the first time you loaded the CIMPLICITY SPC option, you may also need 

to manually configure the CIMPLICITY SPC Configuration File Type.

Note:

This procedure was documented using Windows 7. It might differ slightly on your machine if you 

are using a different operating system.

1. Open the Associate a file type or protocol with a specific program window.

a. Open the Control Panel.

b. View by Small icons.

c. Select Default Programs.

The Associate a file type or protocol with a specific program window opens.

A Choose the programs that Windows uses by default window opens.

a. Click Associate a file type or protocol with a program.
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The Associate a file type or protocol with a specific program window opens.

2. Do the following.

A Select .spc - PKCS #7 Certifi

cate

B Click Change program.

An Open with window opens.

3. Click the Browse button.
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Windows Explorer displays in the Open with window.

4. Select ..<CIMPLICITY Installation>\exe\SpcCfg.exe

The Open with window now lists many options; SPCCFG is selected.

5. Click OK.

The Associate a file type or protocol with a specific program window reopens.
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6. Click Close.

The SPC documents can now be opened and configured.

SPC Products: Configuration

SPC Products: Configuration

An SPC document is the container for:

• All of the products that should be grouped together.

• A product group's quality control information

A selected product can include: variables, defects and attributes that are stored in a directory structure 

similar to Windows Explorer. When the product is selected, its

• Quality characteristics display in the SPC Configuration window right-pane.

• Defect folders in the SPC Configuration window left-pane.
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Items in the hierarchy can be added, configured and modified.

1. 7. SPC Products: Defect Properties  (on page 663)

2. 6. SPC Products: Attribute Quality Characteristics  (on page 635)

3. 5. SPC Products: Variable Quality Characteristics  (on page 605)

4. 4. SPC Products: Product Properties  (on page 603)

5. 3. SPC Products: File Menu/Toolbar/Quick Keys  (on page 594)

6. 2. SPC Products: Document Properties  (on page 592)

7. 1. SPC Products: Open the SPC Configuration Window  (on page 582)

Icon Section

1  (on 

page 

582)

SPC Document: Open.

2  (on 

page 

592)

SPC Products: Document properties.

3  (on 

page 

594)

SPC Products: File menu/Toolbar/Quick keys.

4  (on 

page 

603)

SPC Products: Product properties.
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Icon Section

5  (on 

page 

605)

SPC Products: Variable Quality characteristics.

6  (on 

page 

635)

SPC Products: Attribute Quality characteris

tics.

7  (on 

page 

663)

SPC Products: Defect properties.

Important:

The SPC Data Collector logs its raw and calculated data to an ODBC data source. Before you start 

configuring SPC for a project, make sure that the CIMPLICITY Database Logger is installed and 

configured for the project.

1. SPC Products: Open the SPC Configuration Window

1. SPC Products: Open the SPC Configuration Window

Software configuration for SPC begins with opening and configuring an SPC document. The SPC 

document is the container for one or more products that you will add and configure. When the document 

is active, every included product will be tracked, unless you deactivate tracking for one or more of the 

products at the product level .

1.1  (on 

page 

582)

SPC Document: Create.

1.2  (on 

page 

589)

SPC Document: Open existing.

1.1. SPC Products: Create a Document



Addons and Options  | 6 - Statistical Process Control  | 583

A  (on 

page 

583)

Open a new SPC Configuration win

dow.

B  (on 

page 

585)

Define document properties.

C  (on 

page 

587)

Save a new SPC document.

1. Open  a new SPC Configuration Window

You can open a new SPC Configuration window:

• Through the Workbench.

• Through an open SPC Configuration window.

Through the Workbench

1. Make sure the SPC Chartsoption is enabled.

2. Select Project>SPC  in the Workbench left pane.

3. Do one of the following.
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A Click File>New  on the Workbench menu bar.

B Click the New Object button on the Workbench toolbar.

C In the Workbench left pane:

Either Or

Double click SPC. a. Right-click SPC.

b. Select New on the Popup 

menu.

D a. In the Workbench right pane.

a. Right-click any SPC file.

b. Select New on the Popup menu.

E Press Ctrl+N on the keyboard.

Result: A blank SPC Configuration window opens when you use any method; the Save features are 

disabled.
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Through an open SPC Configuration Window

You can open an empty SPC Configuration window through an open SPC Configuration window.

Click File>New>SPC Configuration Document on the SPC Configuration window menu bar.

Result: A blank SPC Configuration window overlays the previous open window.

Note:

 The Save features may be enabled. However you cannot save the new document until the 

document properties are defined.

a.  Define  Document Properties

a. Click File>Properties on the SPC Configuration window menu bar.

The Document Properties dialog box opens.
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a. Select the following.

Option Description

Active Activate data collection for the document. Important:  The Database Logger 

must be configured for the project to enable the SPC Data Collector.

Default Checked.

Log update in

terval in sec

onds

Number (of seconds) that raw data will be retrieved from the database when 

using logged data as input.

ODBC data 

source

ODBC data source to use for the open CIMPLICITY project.

Database user Authorized database user.

Password Valid user password.

Result: The SPC Configuration window can now be saved.

Important:

◦ All the SPC documents in a CIMPLICITY project must log their data to the same SPC data 

source.

◦ System Data Sources may not be listed on the System DSN tab when you open The ODBC 

Data Source Administrator on a 64-bit system.

Do the following.
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CIMPLICITY Start menu

a. Expand All Programs>Proficy HMI SCADA - CIMPLICITY 8.2 on the Windows start menu.

b. Click ODBCAD32 - View 32bit DSNs.

The ODBC Data Source Administrator opens.

a. Select the DSN tab.

Result: The System Data Sources will be listed.

Command Line field.

a. Click the Start button on the Windows task bar.

b. Enter the following in the Command Line  field.

c:\windows\syswow64\odbcad32.exe

a. Press Enter.

The ODBC Data Source Administrator opens.

a. Select the DSN tab.

Result: The System Data Sources will be listed.

a. Save  a new SPC Document

4. Right-click SPC.

5. Select New on the Popup menu.

6. Right-click any SPC file.

7. Select New on the Popup menu.

8.  Do one or the following.
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A Click File>Save on the SPC Configuration window menu bar.

B Click the Save button on the SPC Configuration window tool 

bar.

C Press Ctrl+S on the keyboard.

A Save As dialog box opens.

9. Save the SPC document as an .spc file.

Important:

The maximum name length is 8 characters.

10. Click Save.

The Save As dialog box closes; The <Document Name>.SPC - SPC Configuration window is ready for the 

SPC products and specifications.
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Tip:

Refresh (F5) the Workbench if the new document is not listed in the right-pane when you close 

the SPC Configuration window.

1.2. SPC Products: Open an Existing Document

An existing SPC document can be opened:

• Through the Workbench.

• Through an open SPC Configuration window.

Open an Existing SPC Document: Through the Workbench

1. Make sure the SPC Chartsoption is enabled.

2. Select Project>SPC  in the Workbench left pane.

3. Select the SPC document to open.

4. Do one of the following.
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A Click Edit>Properties  on the Workbench menu bar.

B Click the Properties button on the Workbench toolbar.

C In the Workbench left pane:

a. Right-click SPC.

b. Select Open on the Popup menu.

D In the Workbench right pane

Either Or

Double click the selected file.. a. Right-click the selected file.

b. Select Open on the Popup 

menu.

E Press Alt+Enter on the keyboard.

Result: The selected file opens in the CIMPLICITY SPC Configuration window.

Open an Existing SPC Document: Through the SPC Configuration Window

You can open an existing SPC document through an open SPC Configuration window.
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5. Right-click SPC.

6. Select Open on the Popup menu.

7. Right-click the selected file.

8. Select Open on the Popup menu.

9. Do one of the following.

A Click File>Open on the SPC Configuration window menu 

bar.

B Click the Open button on the Workbench toolbar.

C Press Ctrl+O on the keyboard.

An Open dialog box opens.

10. Select the .SPC document that you want to open.

11. Click Open.
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The selected file opens in the CIMPLICITY SPC Configuration window.

2. SPC Products: Document Properties

The SPC document is the primary container for your quality control information. You can set its properties 

to:

• Activate or deactivate data collection for every included product.

• Specify basic parameters including the:

• Logged update interval in seconds.

• ODBC data source.

• Limit user access.

The properties that you specify at the document level will impact all of its included products  (on page 

603).

1. Click File>Properties on the document window menu bar.

The Document Properties dialog box opens.

2. Select the following.

Option Description

Active Activate data collection for the document. Important:  The Database Logger 

must be configured for the project to enable the SPC Data Collector.

Default Checked.
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Option Description

Log update in

terval in sec

onds

Number (of seconds) that raw data will be retrieved from the database when us

ing logged data as input.

ODBC data 

source

ODBC data source to use for the open CIMPLICITY document. Important:  You 

must use the same data source for all SPC documents created in a project.

Database user Authorized database user.

Password Valid user password.

The Save features in the SPC Configuration window are enabled.

Note:

• All the SPC documents in a CIMPLICITY project must log their data to the same SPC data source.

• System Data Sources may not be listed on the System DSN tab when you open  the ODBC Data 

Source Administrator on a 64-bit system.

Do the following.

CIMPLICITY Start menu

1. Expand All Programs>Proficy HMI SCADA - CIMPLICITY 8.2 on the Windows start menu.

2. Click ODBCAD32 - View 32bit DSNs.

The ODBC Data Source Administrator opens.

1. Select the DSN tab.

The System Data Sources will be listed.

Command Line field.

1. Click the Start button on the Windows task bar.

2. Enter the following in the Command Line  field.

c:\windows\syswow64\odbcad32.exe

1. Press Enter.
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The ODBC Data Source Administrator opens.

1. Select the DSN tab.

The System Data Sources will be listed.

3. SPC Products: File Menu/Toolbar/Quick Keys

The SPC Configuration window includes many menu items and toolbar buttons to facilitate creating and 

finding products and quality characteristics.

1. #unique_388_Connect_42_i02Toolbar  (on page 600)

2. #unique_388_Connect_42_i01MenuBar  (on page 595)

3. #unique_388_Connect_42_i03QuickKeys  (on page 601)

1  (on 

page 

595)

SPC Configuration: Menu bar.

2  (on 

page 

600)

SPC Configuration: Toolbar

3  (on 

page 

601)

SPC Configuration: Quick 

keys.
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SPC Configuration: Menu  Bar

The SPC Configuration window menu bar includes the following menus/items.

• File menu.

• Edit menu.

• View menu.

• Tools menu.

• Help menu.

File  Menu

New Create a new item. Note:  Items on the extended menu are enabled/disabled based on what cur

rent item is selected in the SPC Configuration window.

Open Open the Open browser to replace the open SPC document with another SPC document.

Save Save the selected SPC document.

Save 

As

Open the Save as browser to save the open SPC document in a different location and/or with a 

different name.

Prop

erties

Open the Document Properties dialog box.

Docu

ments

Open a listed recently opened document.

Exit Close the SPC Configuration window.
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Edit  Menu

Cut Cut the selected item.

Copy Copy the selected item.

Paste Paste the selected item in the same or a different SPC docu

ment.

Delete Delete the selected item.

Rename Rename the selected item.

Properties Open the Properties dialog box for the selected item.

View  Menu

Tool

bar

Display/hide the toolbar.

Check Displays the toolbar.

Clear Hides the toolbar.
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Sta

tus 

Bar

Display/hide the status bar.

Check Displays the status bar.

Clear Hides the status bar.

Split Displays a temporary slider that instantly changes the left/right pane widths when you click the 

mouse.

Icons Display your selection in the right-pane.

Note:

Click anywhere in the right-pane to enable the display options on the menu and toolbar.

Options are:

Large Icons

Small Icons

List

Details
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At

trib

utes

Open the Configure Display Attributes dialog box. The attributes, which can be added or re

moved, display in the Details view.

Note:  Attributes listed in the Display attributes box display in the right-pane Details view, left to 

right, in the order they are listed.

Tools  Menu

Find Opens a Find a Product/Quality Characteristics browser. Wild cards can replace the following.

* One or more characters in the string.

? One character in the string.

Filters are:
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Product Name All or part of the product name

QC Name (Quality Characteristic name) All or part of the name 

assigned to the variable, attribute or defect.

QC Type Variable, Attribute, defect

Dy

nam

ic

(When the project is running) Turns on/off Dynamic mode for SPC.

Important:

: The CIMPLICITY project needs to be running when you work with SPC charts in CimEd

it/CimView. Dynamic mode must be turned on in order for a chart to be alerted to  product 

and quality characteristic changes made in the SPC Configuration dialog box.

Help  Menu

Help Topics Open CIMPLICITY documentation beginning with SPC.

About Spc

Cfg

View build, copyright and other details about SPC and CIMPLICI

TY.
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SPC Configuration: Toolbar

Toolbar buttons correspond to basic menu items.

A  (on 

page 

595)

New item.

B  (on 

page 

595)

Open.

C  (on 

page 

595)

Save.

D  (on 

page 

596)

Cut.

E  (on 

page 

596)

Copy.

F  (on 

page 

596)

Paste.

G  (on 

page 

599)

Dynamic.

H  (on 

page 

597)

View: Large icons.

I  (on 

page 

597)

View: Small icons.
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J  (on 

page 

597)

View: List.

K  (on 

page 

597)

View: Details.

L  (on 

page 

599)

About SpcCfg.

SPC Configuration: Quick Keys

Some quick keys in the SPC Configuration window are as follows.

Important: The key strokes work when the correct item is selected.

Example

When a product is selected the quality characteristics and Defect folder can be created. Quick keys to 

create other items will not do anything.

o  (on 

page 

582)

Alt+f+n+s New SPC Configuration Document.

o  (on 

page 

603)

Alt+f+n+p New product.

o  (on 

page 

606)

Alt+f+n+v New Variable Quality characteristic.

o  (on 

page 

636)

Alt+f+n+a New Attribute Quality characteristic.

o  (on 

page 

663)

Alt+f+n+d New Defect folder.
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o  (on 

page 

669)

Alt+f+n+d New Defect category.

Ctrl+o Open

Ctrl+s Save

Alt+f+a Save as

Alt+f+p Open Document Properties dialog box.

Alt+f+x Exit the SPC Configuration window.

Ctrl+x Cut the selected item.

Ctrl+c Copy the selected item.

Ctrl+v Paste the selected item in the same or a different SPC document.

Del Delete selected item.

Alt+e+r Rename selected item.

Alt+e+o Open the Properties dialog box for the selected item.

Alt+v+t Display/hide the toolbar.

Alt+v+s Display/hide the status bar.

o  (on 

page 

597)

Alt+v+g View: Large icons.

o  (on 

page 

597)

Alt+v+m View: Small icons.

o  (on 

page 

597)

Alt+v+l View: List

o  (on 

page 

597)

Alt+v+d View: Details

Alt+v+a Open the Configure Display Attributes dialog box.
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Ctrl+f Open a Find a Product/Quality Characteristics browser.

Alt+t+d (When the project is running) Turns on/off Dynamic mode for SPC.

F1 Open CIMPLICITY documentation beginning with SPC.

4. SPC Products: Product Properties

1  (on 

page 

603)

Open a Product Properties dialog box.

2  (on 

page 

604)

Define product properties.

Open  a Product Properties Dialog Boxes

1. Select Products  in the SPC Configuration window left-pane.

2. Do one of the following.

1 Click File>New>Product on the SPC Configuration window menu 

bar.

2 Click the New button on the SPC Configuration window toolbar.

3 Right-click Products; select New Product on the Popup menu.
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4 Press Ctrl+N on the keyboard.

Result: The Product Properties dialog box opens.

Define  Product Properties

1. Enter the following to clearly identify the product.

Item Description

1 Active Check or clear the Active checkbox to do the following.

Checked Activate data collection for the product.

Clear Disable the product.

Default Checked

2 Product 

name

Name that identifies the product folder.

Note:

The maximum length is 16 characters.

3 Description (Optional) Provide details to more clearly identify the product.

4 Resource ID Resource to be used by alarms generated for the product.

Opens the Select a Resource browser.

Displays a Resource Popup menu
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1. Click OK.

Result: The Product Properties dialog box closes; the new product is listed in the SPC Configuration 

window.

5. SPC Products: Variable Quality Characteristics

5. SPC Products: Variable Quality Characteristics

Information that you enter in the Variable Quality Control Characteristics dialog box is used to configure 

the selected chart set in the CimEdit/CimView ActiveX control.

Options include the following.

5.1  (on 

page 

606)

SPC Variable: Add a variable.

5.2  (on 

page 

608)

SPC Variable: General characteristics.

5.3  (on 

page 

611)

SPC Variable: Collection characteris

tics.

5.4  (on 

page 

619)

SPC Variable: Limits.
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5.5  (on 

page 

627)

SPC Variable: Set alarms/Control tests.

CAUTION:

• If numeric values are entered (e.g. on the Limits  (on page 621)  tab) during configuration and an 

inconsistency is detected, SPC will display an error message. You cannot save the configured data 

until the error is corrected.

Example

You select Values  to enter a variable's control limits and enter 25 for an Upper Control Limit and 50 for a 

Lower Control Limit. SPC will display the following error message,

The upper control limit must be greater than the center line and the center line must be greater than the 

lower control limit.

• If Point IDs are entered (e.g. on the Limits  (on page 622)  tab), SPC will alert the user when the 

values become specific at runtime. If SPC detects configuration inconsistencies, it will display an 

$SPC_ADMIN _ALARM  in the Alarm Viewer.

5.1. SPC Variable: Add a Variable

1. Select a product in the SPC Configuration window left-pane.

2. Do one of the following.
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A Click File>New>Variable Quality Characteristic on the SPC Configuration window menu bar.

B Right-click the selected product; select New Variable Quality Characteristic on the Popup 

menu.

A Variable Quality Characteristic Properties - VAR dialog box opens.
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Note:

When you create a new characteristic, SPC refers to it as VAR by default in the document tree. 

If there is more than one variable that you have not named, SPC numbers them in the order they 

were created and lists the description you enter on the Variable Quality Characteristics Properties 

dialog box>General tab. You can rename the variable at any time.

5.2. SPC Variable: General Characteristics

Select the General tab in the Variable Quality Characteristics Properties dialog box.

General features are as follows.

1. #unique_397_Connect_42_i06SamplingParameters  (on page 611)

2. #unique_397_Connect_42_i05DataSetpointID  (on page 610)

3. #unique_397_Connect_42_i04CalculationType  (on page 610)

4. #unique_397_Connect_42_i03Description  (on page 609)

5. #unique_397_Connect_42_i02Name  (on page 609)

6. #unique_397_Connect_42_i01Active  (on page 609)

1  (on 

page 

609)

Active.
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2  (on 

page 

609)

Name.

3  (on 

page 

609)

Description.

4  (on 

page 

610)

Calculation type.

5  (on 

page 

610)

Data setpoint ID.

6  (on 

page 

611)

Sampling Parame

ters

1 Ac

tive

Does the following.

Checked Activates data collection for the product variable.

Clear De-activates data collection for the product vari

able.

Default Checked

2 Name

Identifies the product's variable characteristic that will be measured.

Default VAR

Maximum Length 16 charac

ters.

3 Description
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Provides details to clearly identify the characteristic.

Maximum Length 40 charac

ters

Note:

The description displays in the SPC Configuration window list.

4 Calculation type

Selects the variable characteristics calculation type that will be available for charting.

Types are:

Chart Values for:

X-Bar/R X-Bar and range.

X-Bar/S X-Bar and standard devia

tion.

Note:

The X-Bar chart type you select will be available on the CimEdit SPC Control Properties dialog box 

Chart menu; the other will not be. You can change your selection at any time; however, you will 

have to stop and restart a running project to have the SPC Control recognize the change.

5 Data setpoint ID

Enables usage of the current XBar-R or XBar- S values elsewhere in the selected project, or downloaded to 

a device.

Point type Floating-point array point of 2  ele

ments

The array contains values for the following.

Chart Values for:

XBar/R XBar and range

XBar/S XBar and standard deviation
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6 Sampling Parame

ters

Identifies the Subgroup size and gap size based on the Values or Points selection

Val

ues

Requires integers for values.

Subgroup 

size

(Integer) identifies sample size. Important: The subgroup size must be between 2 

and 100.

Gap size (Integer) identifies how many units will be skipped before the next sample is tak

en. 

Points Requires analog points for values.

Subgroup 

size

(Point)  identifies sample size.

Gap size (Point) identifies how many units will be skipped before the next sample is taken. 

5.3. SPC Variable: Collection Characteristics

The Collection tab in the Variable Quality Characteristics Properties dialog box:

• Enables/Disables collection.

• identifies the data collection source.

The three collection methods are:

• Point (Live data)

• Logged

• None

Point (Live Data)

Variable values can be retrieved from runtime point values.

Specifications for point value collection are as follows.
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1. #unique_398_Connect_42_P08ManualEntry  (on page 615)

2. #unique_398_Connect_42_P07BatchPointID  (on page 615)

3. #unique_398_Connect_42_P06MatchValue  (on page 614)

4. #unique_398_Connect_42_P05MatchPointID  (on page 614)

5. #unique_398_Connect_42_P04EUConversion  (on page 614)

6. #unique_398_Connect_42_P03EndElement  (on page 613)

7. #unique_398_Connect_42_P02StartElement  (on page 613)

8. #unique_398_Connect_42_P01PointID  (on page 613)

1  (on 

page 

613)

Point ID

2  (on 

page 

613)

Start element

3  (on 

page 

613)

End element
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4  (on 

page 

614)

EU conversion

5  (on 

page 

614)

Match Point ID

6  (on 

page 

614)

Match value

7  (on 

page 

615)

Batch Point ID

8  (on 

page 

615)

Manual entry allowed

1 Point ID

Identifies the point data source  from which the SPC Data Collector retrieves variable values.

Point type Analog

Note:

A batch point ID can be entered for a batch process.

2 Start element

(If the Point ID is an array point) Identifies the element number in the point array to start collection.

Default 0

3 End element

(If the Point ID is an array point) Identifies the element number in the point array to end collection.

Default 0
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4 EU conver

sion

Selects between EU and raw values for the point measurement unit..

Check or clear, as follows.

Check/Clear
The SPC Data Col

lector will use:

Check EU value(s) for the point.

Clear Raw value(s) for the point.

5 Match Point ID

Provides one data source to Identify for which of multiple variables data should be collected.

Point type Integer

Note:  The same or different match point can be used for attributes, variables and defects.

6 Match val

ue

Match point value that directs the selected SPC chart to collect data for the selected variable 

characteristic.

Important:

During runtime, the Match point value must be the value entered in the Match value  field for 

collection to occur. If the Match point value is different from the value entered for the selected 

variable, the selected SPC chart will report that there is not enough data available for it to be 

created.

Example

A match value to collect data for the finished decorated lead length variable is 1.

Data for the finished length is or is not collected if the selected Match point value is as follows.
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Collection Match Value equals:

Is collected 1

Is not collected Anything other than 1

7 Batch Point ID

(For a batch process) Distinguish between different batches for the same product quality characteristic.

Note:

The value of the Batch Point is associated with the calculated data and can be used as search 

criteria for charts and reports.

8 Manual entry allowed

Enables or disables manual data entry.

Do one of the following.

Check/Clear Manual data entry for SPC chart sets at runtime is:

Check Enabled

Clear Disabled

Logged

Retrieves data from an ODBC database table. Define the ODBC data source, table and column names.

Specifications for logged value collection are as follows.
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1. #unique_398_Connect_42_L05ManualEntry  (on page 618)

2. #unique_398_Connect_42_L04TableColumn  (on page 617)

3. #unique_398_Connect_42_L03Password  (on page 617)

4. #unique_398_Connect_42_L01ODBCdata  (on page 617)

5. #unique_398_Connect_42_L02DatabaseUser  (on page 617)

1  (on 

page 

617)

ODBC data source

2  (on 

page 

617)

Database user

3  (on 

page 

617)

Password

4  (on 

page 

617)

Table ID/Column ID
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5  (on 

page 

618)

Manual entry allowed

1 ODBC data source

Selects the database from which SPC will retrieve data.

2 Database user

Identifies the valid user name when logging into the ODBC data source.

3 Pass

word

Identifies the required user password for logging into the ODBC data source.

4 Table ID/Column 

ID

Selects the database table and column from which logged data will be retrieved.

Click the Browse button to the right of the Table ID  or Column ID  fields.

The table and column that are selected in the Select a Table/Column browser will be entered in the Table 

ID/Column ID  fields.
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5 Manual entry allowed

Enables or disables manual data entry.

Do one of the following.

Check/Clear Manual data entry for SPC chart sets at runtime is:

Check Enabled

Clear Disabled

None

If you choose to enter your own data, do not designate a data collection source.

Check None  to prevent automatic data collection.
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Manual data entry can be enabled or disabled.

Do one of the following.

Check/Clear Manual data entry for SPC chart sets at runtime is:

Check Enabled

Clear Disabled

Note:

SPC automatically includes manual entry when you select None.

5.4. SPC Variable: Limits

In order to set control limits for your chart sets, SPC provides you with several different options. If you 

know the limits that you want to set, you can use Points or Values. If the process is new and you would 

like to have limits calculated automatically for you, you can use the auto recalculation features. Whatever 

your preference, SPC provides you with an option.
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1. #unique_399_Connect_42_i04Specification  (on page 626)

2. #unique_399_Connect_42_i03ForceAutoRecalc  (on page 625)

3. #unique_399_Connect_42_i02Setpoint  (on page 625)

4. #unique_399_Connect_42_i01Control  (on page 621)

1  (on 

page 

621)

Control Limits

2  (on 

page 

625)

Setpoint ID

3  (on 

page 

625)

Force Auto Recalc

4  (on 

page 

626)

Specification limits
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5  (on 

page 

627)

Control Limits: Guide

lines

1 Control Lim

its

The control limits source types are as follows.

• Values

• Points

• Auto recalculation

Values

You can use your own absolute criteria to set control limits. Generally, when absolute values are used, the 

process is assessed to be in control.

Check Values.

Entries include the following.

1. #unique_399_Connect_42_VB_RS  (on page 622)

2. #unique_399_Connect_42_VA_XBar  (on page 622)

A  (on 

page 

622)

XBar UCL; XBar CL; XBar LCL
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B  (on 

page 

622)

R/S UCL; R/S CL; R/S LCL

A XBar UCL; XBar CL; XBar LCL

Provides absolute  values for the samples' limits.

XBar UCL XBar Upper Control Limit

XBar CL XBar Center Line

XBar LCL XBar Lower Control Lim

it

B R/S UCL; R/S CL; R/S LCL

Provides absolute  values for either the samples' range or sigma limits.

R/S UCL Range or Sigma Upper Control Limit

R/S CL Range or Sigma Center Line

R/S LCL Range or Sigma Lower Control Lim

it

The limits type depend on whether XBar-R or XBar-S  (on page 610)  was selected as the calculation type 

on the General tab in the Variable Quality Characteristics dialog box.

Note:

If you enter specific values during configuration and SPC detects an inconsistency, it will display 

an error message and will not allow you to save the configuration until you correct the error.

Points

Points can provide the control limit values that can be easily changed, when necessary simply by 

changing their value (e.g. in the Point Control Panel). The new value will display on the chart when the 

chart updates.



Addons and Options  | 6 - Statistical Process Control  | 623

1. #unique_399_Connect_42_PB_RS  (on page 623)

2. #unique_399_Connect_42_PA_XBar  (on page 623)

3. #unique_399_Connect_42_PB_RS  (on page 623)

A  (on 

page 

623)

XBar UCL; Bar CL; XBar LCL

B  (on 

page 

623)

R/S UCL; R/S CL; R/S LCL

A XBar UCL; XBar CL; XBar LCL

Provides point ID's whose value identifies the samples' limits.

XBar UCL XBar Upper Control Limit

XBar CL XBar Center Line

XBar LCL XBar Lower Control Lim

it

Point Type Analog

B R/S UCL; R/S CL; R/S LCL

Provides point ID whose values either the samples' range or sigma limits.

R/S UCL Range or Sigma Upper Control Limit

R/S CL Range or Sigma Center Line
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R/S LCL Range or Sigma Lower Control Lim

it

Point Type Analog

The limits type depend on whether XBar-R or XBar-S  (on page 610)  was selected as the calculation type 

on the General tab in the Variable Quality Characteristics dialog box.

Note:

• If you use Points  for general characteristics on limits rather than specific values, SPC will alert the 

user when the values become specific at runtime. If SPC detects configuration inconsistencies, it 

will display an $SPC_ADMIN_ALARM  (on page 569)  in the Alarm Viewer.

• Points need to be logged to be validated.

Auto recalculation

One of the many advantages SPC offers is its ability to automatically calculate the control limits for a 

process. This is particularly useful if your process is new and you want SPC to generate control limits.

Check Auto recalculation.

SPC recalculates the relevant control limits when the selected chart updates.

Note:

Once the control limits are automatically calculated, select either Values or Points for the life of 

the process.
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Important:

The Quality Control rules you have always followed for control limits still apply to both SPC 

automatic recalculation options, as follows:

• When your process is new or in optimum condition, calculate the limits using the Auto 

Recalculation or Force Auto Recalculation option.

• Once you determine that SPC has automatically collected enough data to calculate the correct 

control limits, disable the automatic calculation option.

• The calculated control limits are then used for the life of the process.

• Control limits produced by auto recalculation are valid only when your process is "in control." If you 

calculate them while your process is going "out of control," then the limits will be incorrect.

• A global variable SPC_RESIZE_OUT_OF_BOUNDScauses graph re-scaling and re-centering.

SPC_RESIZE_OUT_OF_BOUNDS is enabled by default.

When the SPC_RESIZE_OUT_OF_BOUNDS is disabled charts are not re-scaled and re-centered.

2 Setpoint ID

A setpoint entered in the Setpoint ID  field enables usage of the current XBar, Range or Sigma control 

limits values elsewhere in the selected project or downloaded to a device.

The array contains values for the following.

• XBar LCL

• XBar CL

• XBar UCL

• R/S LCL

• R/S CL

• R/S UCL

Point type Floating (Real) array point of 6  ele

ments

3 Force Auto Re

calc

A point can be used to Force Auto Recalc in addition to specifying control limit values or points. This 

option provides the flexibility to reset control limits during runtime.
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As a result, when you send an application to production, you can have SPC recalculate the control limits 

so that they are accurate for the process.

Point 

On/Off

Set 

to:
Auto-calculation is:

Point 

On

TRUE Activated and the XBar-R/S control limits are recalculated. Pre-set values are ignored.

Point 

Off

FALSE Deactivated and the last calculated values are used. Pre-set values are ignored until 

the data collector is restarted or dynamically refreshed.

Point 

type

BOOLEAN

Note:

• Whenever the Force Auto Recalc point is set to either TRUE or FALSE, the data collector will drop 

the current sample and start over .

• When the control limits have been automatically recalculated and the process is assessed to be 

under control,  disable the Force Auto Recalc option.

4 Specification lim

its

Entered values for specification limits are the maximum and minimum tolerances set to determine 

acceptable limits for the variable.

The values may or may not be the same as the upper and lower control limits.

Lower Lower specification lim

it.

Upper Upper specification limit.

Point Type Analog

Note:

The entered values display in the Histogram Information box as USL and LSL.
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5 Control Limits: Guide

lines

Important:

The Quality Control rules you have always followed for control limits still apply to both SPC 

automatic recalculation options (Auto recalculation and Force Auto Recalc) as follows:

• When your process is new or in optimum condition, calculate the limits using the Auto 

Recalculation or Force Auto Recalculation option.

• Once you determine that SPC has automatically collected enough data to calculate the correct 

control limits, disable the automatic calculation option.

• The calculated control limits are then used for the life of the process.

• Control limits produced by auto recalculation are valid only when your process is "in control." If you 

calculate them while your process is going "out of control," then the limits will be incorrect.

• A global variable SPC_RESIZE_OUT_OF_BOUNDScauses graph re-scaling and re-centering.

SPC_RESIZE_OUT_OF_BOUNDS is enabled by default.

When the SPC_RESIZE_OUT_OF_BOUNDS is disabled charts are not re-scaled and re-centered.

5.5. SPC Variable: Alarms/Control Tests

SPC can track several different types of occurrences to warn you if a process is slightly off, even if 

production has not exceeded its control limits on a regular basis. As a result, you can anticipate and 

handle potential problems before they occur.

Use the Alarm tab in the Variable Quality Characteristics Properties box to specify the:

• Type of alarm that will be triggered.

• Setpoint ID.

• Control test criteria that will initiate alarms or change setpoints.

Note:

The SPC variable charts display values between -4 sigma (-4)  and +4 sigma (+4 ). Data outside 

of this range is not displayed, but it is still used in the chart calculations unless they are excluded 

(on page 701) .
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When one of the control tests meets your criteria for issuing a warning, it will generate the type of warning 

you configure.

1. #unique_371_Connect_42_i04ControlTest  (on page 630)

2. #unique_371_Connect_42_i03AlarmEnabled  (on page 629)

3. #unique_371_Connect_42_i02SetpointID  (on page 629)

4. #unique_371_Connect_42_i01AlarmID  (on page 629)

1  (on 

page 

629)

Alarm ID

2  (on 

page 

629)

Setpoint ID (XBar Alarms)

3  (on 

page 

629)

Alarm enabled

4  (on 

page 

630)

Control Tests
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1 Alarm ID

Do one of the following:

• Select the $SPC_ALARM system Alarm ID.

• Create your own alarm in the Alarm ID  field.

Tip:  Use the SPC_ALARM  type when creating your own alarm.

The alarm message for SPC alarms consists of the following strings:

• Document Name.

• Product Name.

• Quality/Defect Characteristic Name.

• A description of the control check that triggered the alarm.

• The value of the sample that triggered the alarm.

• An alarm to alert operators.

If alarms are generated for more than one control test, they will stack up and be deleted according to 

specifications you enter in the CIMPLICITY Alarm Configuration (e.g. the assigned alarm severityfor the 

assigned alarm).

2 Setpoint ID (XBar Alarms)

Changes the setpoint value to the number of the XBar test that is in an alarm state (1 - 8).

Setpoints provide you with a way to automate corrective action. You can write scripts that trigger the 

appropriate action whenever the criteria have been met for one of the control tests.

The value of the Setpoint reflects the last test for which an alarm was triggered.

3 Alarm enabled

Enables/disables the alarm.

Check/Clear The alarm is:

Check Enabled

Clear Disabled
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4 Control 

Tests

• SPC performs all checked control tests during runtime.

• If any control test that is checked fails:

• An alarm will be generated (if enabled).

• The Nth subgroup and all following subgroups that fail the test criteria display in red.

• A tool tip displays the date, time, value and tests that failed when a failed value is right-clicked.

• The failure displays on the XBar, Range and/or Sigma chart.

• Some tests report when a specified number of values occur in one or more of the following zones.

Zone Is the area:

A Up to one standard deviation from the center line.

B Between one and two standard deviations from the center line.

C Between two and three standard deviations from the center 

line.

• When you create a control chart, you can select samples for exclusion  (on page 701) .

Control tests (with sample charts) are:

1  (on 

page 

631)

One Subgroup beyond upper or lower limits

2  (on 

page 

631)

N subgroups in a row on same side of center line

3  (on 

page 

632)

N Subgroups in a row all increasing or decreasing

4  (on 

page 

632)

N Subgroups in a row alternating up and down
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5  (on 

page 

633)

N Subgroups our of N Subgroups in a row in Zone A or beyond (same side of cen

ter)

6  (on 

page 

633)

N Subgroups our of N Subgroups in a row in Zone B or beyond (same side of cen

ter)

7  (on 

page 

634)

N Subgroups in a row in Zone C, above or below

8  (on 

page 

634)

 N Subgroups in a row beyond Zone C, above or below center

1 - One  Subgroup beyond upper or lower limits

Test 1 Fail

ure

Any time a subgroup goes beyond the UCL or 

LCL.

2 - N subgroups  in a row on same side of center line

Test 2 Fail

ure

When the specified number of subgroups fall on the same side of the center line, one after 

the other.

Default 7
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3 - N Subgroups  in a row all increasing or decreasing

Test 3 Fail

ure

When the specified number of subgroups increase of decrease in a row on either side of 

the center line.

Default 7

4 - N Subgroups  in a row alternating up and down

Test 4 Fail

ure

When the specified number of subgroups increase and then decrease on either side of the 

center line.

Default 14
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5 - N Subgroups  our of N Subgroups in a row in Zone A or beyond (same side of center)

Test 5 Fail

ure

When N  subgroups in N1 subgroups are in Zone A or beyond on the same side of the cen

ter line.

Default 2 out of 3

6 - N Subgroups  our of N Subgroups in a row in Zone B or beyond (same side of center)

Test 6 Fail

ure

When N  subgroups in N1 subgroups are in Zone B or beyond on the same side of the cen

ter line.

Default 4 out of 5
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7 - N Subgroups  in a row in Zone C, above or below

Test 7 

Failure

When the specified number of subgroups in a specified number of subgroups are in a row are 

in Zone C (either or both sides of he center line).

Default 15

8 - N Subgroups  in a row beyond Zone C, above or below center

Test 8 

Failure

When the specified number of subgroups in a specified number of subgroups are in a row are 

in Zones B, A or beyond (above or below the center line).

Default 8
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6. SPC Products: Attribute Quality Characteristics

6. SPC Products: Attribute Quality Characteristics

Information that you enter in the Attribute Quality Characteristics dialog box is used to configure the 

selected chart set in the CimEdit/CimView ActiveX control.

Options include the following.

6.1  (on 

page 

636)

SPC Attribute: Add an Attribute

6.2  (on 

page 

637)

SPC Attribute: General characteristics.

6.3  (on 

page 

640)

SPC Attribute: Collection characteris

tics.

6.4  (on 

page 

649)

SPC Attribute: Limits.

6.5  (on 

page 

655)

SPC Attribute: Alarms/Control tests.
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CAUTION:

If you enter specific values during configuration and an inconsistency is detected, SPC will display 

an error message. You cannot save the configured data until the error is corrected.

Note:

If you use Points for general characteristics on limits rather than specific values, SPC will alert the 

user when the values become specific at runtime. If SPC detects configuration inconsistencies, it 

will display an  $SPC_ADMIN_ALARM  (on page 569)   in the Alarm Viewer.

6.1. SPC Attribute: Add an Attribute

1. Select a product in the SPC Configuration window left-pane.

2. Do one of the following.

A Click File>New>Attribute Quality Characteristic on the SPC Configuration window menu bar.

B Right-click the selected product; select New Attribute Quality Characteristic on the Popup 

menu.

An Attribute Quality Characteristic Properties - ATT dialog box opens.
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6.2. SPC Attribute: General Characteristics

Select the General tab in the Attribute Quality Characteristics properties dialog box.

General features are as follows.
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1. #unique_400_Connect_42_i05DataSetpointID  (on page 639)

2. #unique_400_Connect_42_i04CalculationType  (on page 639)

3. #unique_400_Connect_42_i03Description  (on page 639)

4. #unique_400_Connect_42_i02Name  (on page 638)

5. #unique_400_Connect_42_i01Active  (on page 638)

1  (on 

page 

638)

Active

2  (on 

page 

638)

Name

3  (on 

page 

639)

Description

4  (on 

page 

639)

Calculation type

5  (on 

page 

639)

Data setpoint ID

1 Ac

tive

Does the following.

Checked Activates data collection for the product attribute.

Clear De-activates data collection for the product at

tribute.

Default Checked

2 Name

Identifies the product's attribute characteristic that will be measured
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Maximum Length 16 charac

ters.

Default ATT

3 Description

Provides details to clearly identify the characteristic.

Note:

The description displays in the SPC Configuration window list.

Maximum Length 40 charac

ters

4 Calculation type

Selects the attribute characteristics calculation type that will be available for charting.

Types are:

Chart Values for:

nP Chart Number of defective units in each sample.

P CHART Proportion of defective units in each sample.

C CHART Total number of defects in a unit.

U CHART Mean (average) defects per unit during the sampling peri

od.

Important:

• Only 1 of the 4 available attribute chart types can be configured for a single product at a time.

• A maximum of 4 attribute charts can be configured per product.

5 Data setpoint ID

Enables usage of the selected chart values elsewhere in the selected project, or downloaded to a device.
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Point type Floating-point array point of 2  ele

ments

6.3. SPC Attribute: Collection Characteristics

The Collection tab in the Variable Quality Characteristics Properties dialog box:

• Enables/Disables collection.

• identifies the data collection source.

The three collection methods are:

• Point (Live data)

• Logged

• None

Point (Live Data)

Attribute values can be retrieved from runtime point values.

Point data collection includes one or more CIMPLICITY points, are specified, along with start and end 

indices for array Points, and any engineering unit conversion (default).

Specifications for point value collection are as follows.
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1. #unique_401_Connect_42_P09EUConversion  (on page 644)

2. #unique_401_Connect_42_P08ManualEntry  (on page 644)

3. #unique_401_Connect_42_P07Sampling  (on page 644)

4. #unique_401_Connect_42_P06BatchPointID  (on page 643)

5. #unique_401_Connect_42_P05MatchValue  (on page 643)

6. #unique_401_Connect_42_P04MatchPointID  (on page 643)

7. #unique_401_Connect_42_P03EndElement  (on page 642)

8. #unique_401_Connect_42_P02StartElement  (on page 642)

9. #unique_401_Connect_42_P01PointID  (on page 642)

1  (on 

page 

642)

Point ID

2  (on 

page 

642)

Start element

3  (on 

page 

642)

End element
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4  (on 

page 

643)

Match Point ID

5  (on 

page 

643)

Match value

6  (on 

page 

643)

Batch Point ID

7  (on 

page 

644)

Sampling

8  (on 

page 

644)

Manual entry allowed

9  (on 

page 

644)

EU conversion

1 Point ID

Identifies the point data source  from which the SPC Data Collector retrieves attribute values.

Note:  The point must be a numeric point type.

2 Start element

(If the Point ID is an array point) Identifies the element number in the point array to start collection.

Default 0

3 End element

(If the Point ID is an array point) Identifies the element number in the point array to end collection.

Default 0
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4 Match Point ID

Provides one data source to Identify for which of multiple attribute data should be collected.

Point type Integer

Note:  The same or different match point can be used for attributes, variables and defects.

5 Match val

ue

Match point value that directs the selected SPC chart to collect data for the selected attribute 

characteristic.

Important:

During runtime, the Match point value must be the value entered in the Match value  field for 

collection to occur. If the Match point value is different from the value entered for the selected 

attribute, the selected SPC chart will report that there is not enough data available for it to be 

created.

Example

A match value to collect data for the finished decorated lead length attribute is 5.

Data for the finished length is or is not collected if the selected Match point value is as follows.

Collection Match Value equals:

Is collected 5

Is not collected Anything other than 5

6 Batch Point ID

(For a batch process) Distinguish between different batches for the same product quality characteristic.

Note:

The value of the Batch Point is associated with the calculated data and can be used as search 

criteria for charts and reports.
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7 Sampling

Identifies the Subgroup size and gap size based on the Values or Points selection

Val

ues

Requires integers for values.

Subgroup 

size

(Integer) identifies sample size. Important: The subgroup size must be between 2 

and 100.

Gap size (Integer) identifies how many units will be skipped before the next sample is tak

en. 

Points Requires analog points for values.

Subgroup 

size

(Point)  identifies sample size.

Gap size (Point) identifies how many units will be skipped before the next sample is taken. 

Default 400

8 Manual entry allowed

Enables or disables manual data entry.

Do one of the following.

Check/Clear Manual data entry for SPC chart sets at runtime is:

Check Enabled

Clear Disabled

9 EU conver

sion

Selects between EU and raw values for the point measurement unit..

Check or clear, as follows.

Check/Clear The SPC Data Collector will 

use:
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Check EU value(s) for the point.

Clear Raw value(s) for the point.

Logged

Retrieves data from an ODBC database table. Define the ODBC data source, table and column names.

Specifications for logged value collection are as follows.

1. #unique_401_Connect_42_L08ManualEntry  (on page 648)

2. #unique_401_Connect_42_L07Subgroup  (on page 648)

3. #unique_401_Connect_42_L06BatchColumn  (on page 647)

4. #unique_401_Connect_42_L05MatchColumnValue  (on page 647)

5. #unique_401_Connect_42_L04TableColumn  (on page 647)

6. #unique_401_Connect_42_L03Password  (on page 647)

7. #unique_401_Connect_42_L02DatabaseUser  (on page 646)

8. #unique_401_Connect_42_L01ODBCdata  (on page 646)
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1  (on 

page 

646)

ODBC data source

2  (on 

page 

646)

Database user

3  (on 

page 

647)

Password

4  (on 

page 

647)

Table ID\Column ID

5  (on 

page 

647)

Match Column ID\Match Val

ue

6  (on 

page 

647)

Batch Column ID

7  (on 

page 

648)

Sampling (subgroup size)

8  (on 

page 

648)

Manual entry allowed

1 ODBC data source

Selects the database from which SPC will retrieve data.

Default CIMPLICITY Logging - SPC

2 Database user

Identifies the valid user name when logging into the ODBC data source.
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3 Pass

word

Identifies the required user password for logging into the ODBC data source.

Note:  The password is hidden by stars (****).

4 Table ID/Column 

ID

Selects the database table and column from which logged data will be retrieved.

Click the Browse button to the right of the Table ID  or Column ID  fields.

The table and column that are selected in the Select a Table/Column browser will be entered in the Table 

ID/Column ID  fields.

5 Match Column ID/Match Val

ue

6 Batch Column ID

(For a batch process) Distinguish between different batches for the same product quality characteristic.
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7 Sampling (Subgroup 

Size)

(Integer) identifies sample size that will be used during runtime.

8 Manual entry allowed

Enables or disables manual data entry.

Do one of the following.

Check/Clear Manual data entry for SPC chart sets at runtime is:

Check Enabled

Clear Disabled

None

If you choose to enter your own data, do not designate a data collection source.

Check None  to prevent automatic data collection.

Manual data entry can be enabled or disabled.

Do one of the following.
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Check/Clear Manual data entry for SPC chart sets at runtime is:

Check Enabled

Clear Disabled

Note:

SPC automatically includes manual entry when you select None.

6.4. SPC Attribute: Limits

In order to set control limits for your chart sets, SPC provides you with several different options. If you 

know the limits that you want to set, you can use Points or Values. If the process is new and you would 

like to have limits calculated automatically for you, you can use the auto recalculation features. Whatever 

your preference, SPC provides you with an option.

1. #unique_402_Connect_42_i04Specification  (on page 654)

2. #unique_402_Connect_42_i03ForceAutoRecalc  (on page 653)

3. #unique_402_Connect_42_i02Setpoint  (on page 653)

4. #unique_402_Connect_42_i01Control  (on page 650)
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1  (on 

page 

650)

Control limits.

2  (on 

page 

653)

Setpoint ID.

3  (on 

page 

653)

Force Auto Recalc.

4  (on 

page 

654)

Specification limits.

5  (on 

page 

654)

Control limits: Guide

lines.

1 Control Lim

its

The control limits source types are as follows.

• Values

• Points

• Auto recalculation

Values

You can use your own absolute criteria to set control limits. Generally, when absolute values are used, the 

process is assessed to be in control.

Check Values.

Entries include the following.
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Provides absolute  values for the subgroup limits.

UCL Upper Control Limit

CL Center Line

LCL Lower Control Limit

Value type Numeric Note:  The data type depends on the selected attribute chart.

Points

Points can provide the control limit values that can be easily changed, when necessary simply by 

changing their value (e.g. in the Point Control Panel). The new value will display on the chart when the 

chart updates.

UCL Upper Control Limit

CL Center Line

LCL Lower Control Limit

Point type Analog Note:  The data type depends on the selected attribute chart.
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Note:

• If you use Points  for general characteristics on limits rather than specific values, SPC will alert the 

user when the values become specific at runtime. If SPC detects configuration inconsistencies, it 

will display an $SPC_ADMIN_ALARM  (on page 569)  in the Alarm Viewer.

• Points need to be logged to be validated.

Auto recalculation

One of the many advantages SPC offers is its ability to automatically calculate the control limits for a 

process. This is particularly useful if your process is new and you want SPC to generate control limits.

Check Auto recalculation.

SPC recalculates the relevant control limits when the selected chart updates.

Note:

Once the control limits are automatically calculated, select either Values or Points for the life of 

the process.

Important:

The Quality Control rules you have always followed for control limits still apply to both SPC 

automatic recalculation options, as follows:

• When your process is new or in optimum condition, calculate the limits using the Auto 

Recalculation or Force Auto Recalculation option.

• Once you determine that SPC has automatically collected enough data to calculate the correct 

control limits, disable the automatic calculation option.

• The calculated control limits are then used for the life of the process.
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• Control limits produced by auto recalculation are valid only when your process is "in control." If you 

calculate them while your process is going "out of control," then the limits will be incorrect.

• A global var iable SPC_RESIZE_OUT_OF_BOUNDScauses graph re-scaling and re-centering.

SPC_RESIZE_OUT_OF_BOUNDS is enabled by default.

When the SPC_RESIZE_OUT_OF_BOUNDS is disabled charts are not re-scaled and re-centered.

2 Setpoint ID

A setpoint entered in the Setpoint ID  field enables usage of the current P, nP, C or U control limits values 

elsewhere in the selected project or downloaded to a device.

The array contains values for the following.

• LCL

• CL

• UCL

Point type Floating (Real) array point of 3  ele

ments

3 Force Auto Re

calc

A point can be used to Force Auto Recalc in addition to specifying control limit values or points. This 

option provides the flexibility to reset control limits during runtime.

As a result, when you send an application to production, you can have SPC recalculate the control limits 

so that they are accurate for the process.

Point 

On/Off

Set 

to:
Auto-calculation is:

Point 

On

TRUE Activated and the XBar-R/S control limits are recalculated. Pre-set values are ignored.

Point 

Off

FALSE Deactivated and the last calculated values are used. Pre-set values are ignored until 

the data collector is restarted or dynamically refreshed.

Point 

type

BOOLEAN
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Note:

• Whenever the Force Auto Recalc point is set to either TRUE or FALSE, the data collector will drop 

the current sample and start over .

• When the control limits have been automatically recalculated and the process is assessed to be 

under control,  disable the Force Auto Recalc option.

4 Specification lim

its

Entered values for specification limits are the maximum tolerances set to determine acceptable limits for 

the attribute.

The values may or may not be the same as the upper control limits.

Upper Upper specification lim

it.

Point Type Analog

Note:

The entered values display in the Histogram Information box as USL and LSL.

5 Control Limits: Guide

lines

Important:

The Quality Control rules for control limits also apply to both SPC automatic recalculation options 

(Auto recalculation and Force Auto Recalc) as follows:

• When your process is new or in optimum condition, calculate the limits using the Auto 

Recalculation or Force Auto Recalculation option.

• Once you determine that SPC has automatically collected enough data to calculate the correct 

control limits, disable the automatic calculation option.

• The calculated control limits are then used for the life of the process.
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• Control limits produced by auto recalculation are valid only when your process is "in control." If you 

calculate them while your process is going "out of control," then the limits will be incorrect.

• A global variable SPC_RESIZE_OUT_OF_BOUNDScauses graph re-scaling and re-centering.

SPC_RESIZE_OUT_OF_BOUNDS is enabled by default.

When the SPC_RESIZE_OUT_OF_BOUNDS is disabled charts are not re-scaled and re-centered.

Example

An

• Upper Control Limit is set to 25.

• Lower Control Limit is set to 50.

SPC will display the following error message:

The upper control limit must be greater than the center line and the center line must be greater than the 

lower control limit.

Note:

If you use Points  for general characteristics on limits rather than specific values, SPC will 

alert the user when the values become specific at runtime. If SPC detects configuration 

inconsistencies, it will display an $SPC_ADMIN  (on page 569)  _ALARM in the Alarm Viewer. See 

"SPC Administration Alarms" in this chapter.

6.5. SPC Attribute: Alarms/Control Tests

SPC can track several different types of occurrences to warn you if a process is slightly off, even if 

production has not exceeded its control limits on a regular basis. As a result, you can anticipate and 

handle potential problems before they occur.

Use the Alarm tab in the Variable Quality Characteristics Properties box to specify the:

• Type of alarm that will be triggered.

• Setpoint ID.

• Control test criteria that will initiate alarms or change setpoints.

When one of the control tests meets your criteria for issuing a warning, it will generate the type of warning 

you configure.
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Overview

1. #unique_372_Connect_42_i04ControlTest  (on page 658)

2. #unique_372_Connect_42_i03AlarmEnabled  (on page 657)

3. #unique_372_Connect_42_i02SetpointID  (on page 657)

4. #unique_372_Connect_42_i01AlarmID  (on page 657)

1  (on 

page 

657)

Alarm ID

2  (on 

page 

657)

Setpoint ID (XBar Alarms)

3  (on 

page 

657)

Alarm enabled
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4  (on 

page 

658)

Control Tests

1 Alarm ID

Do one of the following:

• Select the $SPC_ALARM system Alarm ID.

• Create your own alarm in the Alarm ID  field.

Tip:  Use the SPC_ALARM  type when creating your own alarm.

The alarm message for SPC alarms consists of the following strings:

• Document Name.

• Product Name.

• Quality/Defect Characteristic Name.

• A description of the control check that triggered the alarm.

• The value of the sample that triggered the alarm.

• An alarm to alert operators.

If alarms are generated for more than one control test, they will stack up and be deleted according to 

specifications you enter in the CIMPLICITY Alarm Configuration (e.g. the assigned alarm severityfor the 

assigned alarm).

2 Setpoint ID

Changes the setpoint value to the number of the Attribute test that is in an alarm state.

Upper Specification Lim

it

0

Alarm state 1-8

Setpoints provide you with a way to automate corrective action. You can write scripts that trigger the 

appropriate action whenever the criteria have been met for one of the control tests.

The value of the Setpoint reflects that last test for which an alarm was triggered.

3 Alarm enabled
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Enables/disables the alarm.

Check/Clear The alarm is:

Check Enabled

Clear Disabled

4 Control 

Tests

• SPC performs all checked control tests during runtime.

• If any control test that is checked fails:

• An alarm will be generated (if enabled).

• The Nth subgroup and all following subgroups that fail the test criteria display in red.

• A tool tip displays the date, time, value and tests that failed when a failed value is right-clicked.

• The failure displays on the P, nP, C and/or U chart.

• Some tests report when a specified number of values occur in one or more of the following zones.

Zone Is the area:

A Up to one standard deviation from the center line.

B Between one and two standard deviations from the center line.

C Between two and three standard deviations from the center 

line.

• When you create a control chart, you can select samples for exclusion  (on page 701) .

Control tests (with sample charts) are:

0  (on 

page 

659)

Specification limit test

1  (on 

page 

659)

One Subgroup beyond upper or lower limits
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2  (on 

page 

660)

N subgroups in a row on same side of center line

3  (on 

page 

660)

N Subgroups in a row all increasing or decreasing

4  (on 

page 

661)

N Subgroups in a row alternating up and down

5  (on 

page 

661)

N Subgroups our of N Subgroups in a row in Zone A or beyond (same side of cen

ter)

6  (on 

page 

662)

N Subgroups our of N Subgroups in a row in Zone B or beyond (same side of cen

ter)

7  (on 

page 

662)

N Subgroups in a row in Zone C, above or below

8  (on 

page 

662)

 N Subgroups in a row beyond Zone C, above or below center

0 - Specification  limit test

Test 0 Fail

ure

Calculated acceptable percentage of nonconforming units or defects in the total sample 

size.

1 - One  Subgroup beyond upper or lower limits

Test 1 Fail

ure

Any time a subgroup goes beyond the UCL or 

LCL.
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2 - N subgroups  in a row on same side of center line

Test 2 Fail

ure

When the specified number of subgroups fall on the same side of the center line, one after 

the other.

Default 7

3 - N Subgroups  in a row all increasing or decreasing

Test 3 Fail

ure

When the specified number of subgroups increase of decrease in a row on either side of 

the center line.

Default 7
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4 - N Subgroups  in a row alternating up and down

Test 4 Fail

ure

When the specified number of subgroups increase and then decrease on either side of the 

center line.

Default 14

5 - N Subgroups  our of N Subgroups in a row in Zone A or beyond (same side of center)

Test 5 Fail

ure

When N  subgroups in N1 subgroups are in Zone A or beyond on the same side of the cen

ter line.

Default 2 out of 3
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6 - N Subgroups  our of N Subgroups in a row in Zone B or beyond (same side of center)

Test 6 Fail

ure

When N  subgroups in N1 subgroups are in Zone B or beyond on the same side of the cen

ter line.

Default 4 out of 5

7 - N Subgroups  in a row in Zone C, above or below

Test 7 

Failure

When the specified number of subgroups in a specified number of subgroups are in a row are 

in Zone C (either or both sides of the center line).

Default 15

8 - N Subgroups  in a row beyond Zone C, above or below center

Test 8 

Failure

When the specified number of subgroups in a specified number of subgroups are in a row are 

in Zones B, A or beyond (above or below the center line).

Default 8
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7. SPC Products: Defect Properties

7. SPC Products: Defect Properties

Information can be entered to track a product's defects. SPC displays each group of defects on a Pareto 

chart.

7.1  (on 

page 

663)

SPC Defect Group: Add a defect group.

7.2  (on 

page 

665)

SPC Defect Group: Properties.

7.3  (on 

page 

669)

SPC Defect Category: Add a category.

7.4  (on 

page 

670)

SPC Defect Category: General properties.

7.5  (on 

page 

671)

SPC Defect Category: Collection properties.

7.1. SPC Defect Group: Add a Defect Group

1. Select a product in the SPC Configuration window left-pane.

2. Do one of the following.
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A Click File>New>Defect Folder on the SPC Configuration window menu 

bar.

B Right-click the selected product; select Defect Folder on the Popup menu.

A Defect Folder Properties dialog box opens.
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7.2. SPC Defect Group: Properties

The Defect Folder Properties dialog box identifies the group of defect categories that will be included on 

one Pareto chart.

Information you enter here applies to every defect category in the group.

Defect folder properties are as follows.
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1. #unique_403_Connect_42_i08CollectionMethod  (on page 669)

2. #unique_403_Connect_42_i07BatchPoint  (on page 669)

3. #unique_403_Connect_42_i06MatchValue  (on page 668)

4. #unique_403_Connect_42_i05MatchPoint  (on page 668)

5. #unique_403_Connect_42_i04Description  (on page 668)

6. #unique_403_Connect_42_i03Name  (on page 668)

7. #unique_403_Connect_42_i02Manual  (on page 667)

8. #unique_403_Connect_42_i01Active  (on page 667)

1  (on 

page 

667)

Active

2  (on 

page 

667)

Manual entry allowed

3  (on 

page 

668)

Name
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4  (on 

page 

668)

Description

5  (on 

page 

668)

Match Point ID

6  (on 

page 

668)

Match value

7  (on 

page 

669)

Batch Point ID

8  (on 

page 

669)

Collection Method

1 Ac

tive

Does the following.

Checked Activates data collection for the defect group.

Clear De-activates data collection for the defect 

group.

Default Checked

2 Manual entry allowed

Enables or disables manual data entry.

Do one of the following.

Check/Clear Manual data entry for SPC chart sets at runtime is:

Check Enabled

Clear Disabled
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3 Name

Identifies the product's defect group that will be measured

Default DEF

Note:  The maximum length is 10 characters.

4 Description

Provides details to clearly identify the defect group.

Note:

• The description displays in the SPC Configuration window list.

• The maximum length is 40 characters.

5 Match Point ID

Provides one data source to Identify for which of product characteristics data should be collected.

Point type Integer

Note:  The same or different match point can be used for attributes, variables and defects.

6 Match val

ue

Match point value that directs the selected SPC chart to collect data for the selected defect group.

Important:

During runtime, the Match point value must be the value entered in the Match value  field for 

collection to occur. If the Match point value is different from the value entered for the selected 

variable, the selected SPC chart will report that there is not enough data available for it to be 

created.

Example

A match value to collect data for the finished decorated a black color defect group is 5.
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Data for the black color defect is or is not collected if the selected Match point value is as follows.

Collection Match Value equals:

Is collected 5

Is not collected Anything other than 5

7 Batch Point ID

(For a batch process) Distinguish between different batches for the same color defect.

Note:

The value of the Batch Point is associated with the calculated data and can be used as search 

criteria for charts and reports

8 Collection Method

Specifies the:

• Data source for the defect group.

• Corresponding input fields in the Collection tab of the Defect Properties dialog box for each 

category in the defect group.

All Defect Categories in this Defect folder will use the collection method selected for the folder.

Available collection methods are:

Point Retrieves data from CIMPLICITY point values.

Logged Retrieves data from one or more ODBC database tables.

None No data will be collected by the SPC Data Collector. Note:  The Manual entry allowed box is 

checked by default.

7.3. SPC Defect Category: Add a Category

Within a defect folder, you can create one or more defect categories that define the defect characteristics.

Note:  A bar on the Pareto chart represents each defect category.
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1. Select a defect folder in the SPC Configuration window left-pane.

2. Do one of the following.

A Click File>New>Defect Category on the SPC Configuration window menu bar.

B Right-click the selected product; select New Defect Category on the Popup 

menu.

C Press Ctrl+N on the keyboard.

A Defect Properties dialog box opens.

7.4. SPC Defect Category: General Properties
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The General tab in the Defect Properties dialog box identifies the defect.

1 Defect 

code

 Selected defect identification.

Maximum length 6 characters

2 Description Describes exactly what the defect is. Example A defect's:

• Category is the lead's BLACK color.

• Type is Scratched.

• Code 4BLACK will be applied to all leads that are scratched.

Maximum length 40 characters

7.5. SPC Defect Category: Collection Properties

The Collection tab in the Defect Properties dialog box provides details about the collection source that 

was selected  (on page 669)  in the Defect Folder Properties dialog box.

The three collection methods are:

• Point (Live data)

• Logged

• None

Point

Specifications for point value collection are as follows.
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1. #unique_405_Connect_42_P04EUConversion  (on page 673)

2. #unique_405_Connect_42_P03EndElement  (on page 673)

3. #unique_405_Connect_42_P02StartElement  (on page 673)

4. #unique_405_Connect_42_P01PointID  (on page 672)

1  (on 

page 

672)

Point ID

2  (on 

page 

673)

Start element

3  (on 

page 

673)

End element

4  (on 

page 

673)

EU conver

sion

1 Point ID

Identifies the point data source  from which the SPC Data Collector retrieves defect property values.

Point type Analog (with enough array elements to include the defect properties in the 

group).
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guide:

Guideline:  Defect groups generally include more than one property. Each property is an element in 

the array point.

2 Start element

(If the Point ID is an array point) Identifies the element number in point array to start collection.

Default 0

3 End element

(If the Point ID is an array point) Identifies the element number in point array to end collection.

Default 0

4 EU conver

sion

Selects between EU and raw values for the point measurement unit..

Check or clear, as follows.

Check/Clear
The SPC Data Col

lector will use:

Check EU value(s) for the point.

Clear Raw value(s) for the point

Logged

Retrieves data from an ODBC database table. Define the ODBC data source, table and column names.

Specifications for logged value collection are as follows.
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1. #unique_405_Connect_42_L04TableID  (on page 675)

2. #unique_405_Connect_42_L03Password  (on page 675)

3. #unique_405_Connect_42_L02DatabaseUser  (on page 674)

4. #unique_405_Connect_42_L01ODBCDataSource  (on page 674)

1  (on 

page 

674)

ODBC data source

2  (on 

page 

674)

Database user

3  (on 

page 

675)

Password

4  (on 

page 

675)

Table ID/Column 

ID

1 ODBC data source

Selects the database from which SPC will retrieve data.

2 Database user

Identifies the valid user name when logging into the ODBC data source.
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3 Pass

word

Identifies the required user password for logging into the ODBC data source.

4 Table ID/Column 

ID

Selects the database table and column from which logged data will be retrieved.

Click the Browse button to the right of the Table ID  or Column ID  fields.

The table and column that are selected in the Select a Table/Column browser will be entered in the Table 

ID/Column ID  fields.

None

If None is checked for the collection method in the Defect Folder Properties dialog box, the Collection tab 

in the Defect Properties dialog box is blank.
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SPC Control: Configuration

SPC Control: Configuration

Important:

The CIMPLICITY project must be running in order to connect the chart with SPC data.

1  (on 

page 

677)

SPC Control: Insert in CimEdit.

2  (on 

page 

679)

SPC Control: Open an SPC Control Properties dialog 

box.

3  (on 

page 

680)

SPC Control: General properties.

4  (on 

page 

684)

SPC Control: Chart properties.

5  (on 

page 

684)

SPC Control: Line display.
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6  (on 

page 

685)

SPC Control: Axis display.

7  (on 

page 

686)

SPC Control: Bar chart.

8  (on 

page 

690)

SPC Control: Report.

9  (on 

page 

694)

SPC Control: Annotation.

1. SPC Control: Insert in CimEdit

After you create your ODBC data source and configure your SPC data collection, you can configure SPC 

ActiveX controls in CimEdit/CimView screens or other ActiveX containers, such as Internet Explorer, to 

display your SPC data.

• SPC button.

• OLE button.

SPC  Button

Click SPC on the in the Drawing>Objects group on the CimEdit Ribbon bar.

Result: An SPC control is placed on the CimEdit screen. The top left corner is located at the top left corner 

of the screen.
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OLE  Button

1. Click OLE on the in the Drawing>Objects group on the CimEdit Ribbon bar.

An ActiveX Placement cursor displays on the CimEdit screen.

2. Place the ActiveX Placement cursor where you want the top left corner of the control to be located.

The Insert Object dialog box opens.

3. Select the CIMPLICITY SPC Control in the ActiveX list.
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4. Click OK.

A new SPC Control is placed at the position you selected in your CimEdit screen. The SPC control initially 

is empty and displays a message for editing the control.

2. SPC Control: Open an SPC Control Properties Dialog Box

1. Make sure the CIMPLICITY project is running.

2. Right-click the SPC Control object.
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3. Select SPC Control Object>Properties on the Popup menu.

An SPC Control Properties dialog box opens.

3. SPC Control: General Properties

The General tab in the SPC Control Properties dialog box identifies the quality characteristic that will be 

charted and the time the tests will be run.

Options are as follows.
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1. #unique_408_Connect_42_i05Duration  (on page 683)

2. #unique_408_Connect_42_i04BatchID  (on page 683)

3. #unique_408_Connect_42_i03QC  (on page 683)

4. #unique_408_Connect_42_i02Product  (on page 682)

5. #unique_408_Connect_42_i01Group  (on page 682)

1  (on 

page 

682)

Group

2  (on 

page 

682)

Product

3  (on 

page 

683)

QC

4  (on 

page 

683)

Batch ID

5  (on 

page 

683)

Duration
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6  (on 

page 

683)

Chart date/time format

1 Group

Identifies the project and SPC document that will be applied to the chart.

Group Qualified path to project\SPC Docu

ment  (on page 582)

Click the Browse button to the right of the Group  field.

A Select an SPC Group browser opens; search options include the following.

A Project Available SPC projects

B SPC Group Group name or search criteria for a group.

C SPC Group Groups found by browsing.

D Max. Record Limit Maximum number of found groups that will be listed.

2 Prod

uct
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Provides a drop down list of the products created for the selected SPC document (group).

3 QC

Provides a drop down list of all quality characteristics (variables, attributes and defects) that were 

configured for the selected product.

Note:  Your selection determines what charts will be available.

4 Batch ID

Text that identifies the batch process to be examined. The chart will display only those points where the 

content of the Batch Point ID matches this identifier.

5 Dura

tion

Options are:

Show most re

cent values

Displays the most recent values collected in the chart. Note:  The number of values 

that display is specified on the Chart tab

Time span Start time and date and the ending time and date to collect data to be displayed on 

the chart. The format is:

Start date/End date MM/DD/YYYY

Start time/End time HH:MM:SS AM/PM

6 Chart Date/Time For

mat

SPC uses the short date style.

To change the date/time format of that style on a chart, use the Regional Settings option on your 

Windows Control Panel.

Important:

If data has been logged to a SQL database in a selected time zone and that time zone is changed, 

SPC continues to display the timestamp from the original time zone.
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4. SPC Control: Chart Properties

1. Click the Font button.

A Font dialog box opens.

2. Select the font/style/size  to be used for the title.

5. SPC Control: Line Display

The SPC Control Properties dialog box>Lines tab enables you to select  whether to display/hide each of 

the control lines and zones.

Check  each line type or zone that should display on the chart.

1 UCL Upper Control Limit

2 CL Center Line

3 LCL Lower Control Lim

it

4 Zones A, B, C

Notes

Zones are as follows.
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Zone Area

C Up to one standard deviation from the center line.

B Between one and two standard deviations from the center line.

A Between two and three standard deviations from the center 

line.

In general, a control chart consists of the center line corresponding to the average value at which the 

quality characteristic should perform, and lines corresponding to the upper and lower control limits for the 

characteristic. The upper and lower control limits are also referred to as the upper and lower three-sigma 

control limits.

6. SPC Control: Axis Display

The Axis tab in the SPC Control Properties dialog box enables you to select  whether to display/hide each 

axis title and/or labels and configure the title and label fonts.

Options are:

1 Show X-

axis title

Displays the title under the X-axis labels. Note:  If the chart is an XBar-R or XBar-S chart, 

the title displays under the axis labels for the Range or Sigma Chart.
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2 Show X-

axis la

bels

Displays the X-axis labels under each chart.

3 Show Y-

axis title

Displays the title to the left of each chart

4 Show Y-

axis la

bels

Displays

5 Title Font 

button

Opens the Font dialog box to configure the font for the chart's title.

6 Label 

Font but

ton

Opens the Font dialog box to configure the font for the X-axis and Y-axis labels.

7. SPC Control: Bar Chart

Display options are available for Histograms  and Pareto  charts on the Bar Chart tab in the SPC Control 

Properties dialog box.

The chart that is selected on the Chart tab will be enabled.

• Histograms

• Pareto Charts

Histogram Charts

The Histogram  chart is available for Variable  properties. It is particularly valuable when setting 

up/adjusting your system and determining appropriate specification limits for the process.
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1. #unique_412_Connect_42_H04InfoBox  (on page 688)

2. #unique_412_Connect_42_H04InfoBox  (on page 688)

3. #unique_412_Connect_42_H03MaxSamples  (on page 688)

4. #unique_412_Connect_42_H02NormalCurve  (on page 688)

5. #unique_412_Connect_42_H02NormalCurve  (on page 688)

6. #unique_412_Connect_42_H01SpecLimits  (on page 688)

7. #unique_412_Connect_42_H01SpecLimits  (on page 688)

8. #unique_412_Connect_42_H01SpecLimits  (on page 688)

1  (on 

page 

688)

Show spec limits.

2  (on 

page 

688)

Show normal curve

3  (on 

page 

688)

Max samples

4  (on 

page 

688)

Show info box
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1 Show spec limits

Displays/hides the specification limits (USL/LSL).

Check Displays the specification lim

its.

Clear Hides the specification limits.

2 Show normal curve

Displays/hides a normal distribution curve.

Check Displays a normal distribution 

curve

Clear Hides the normal distribution curve.

3 Max samples

Maximum number of samples that will be used to create the curve.

Note:

• The samples that are selected are based on the:

o  (on 

page 

683)

Duration selection on the General tab in the SPC Control Properties

o  (on 

page 

611)

Sampling parameters selected in the General tab in the Variable Quality Characteristics Prop

erties dialog box.

• The actual number of samples may be slightly larger than the entered number. For example, if 40 is 

entered, the actual number of samples may be 40.2.

4 Show info box

Displays/hides a list of values calculated for the Histogram.
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Check Displays the info  list.

Clear Hides the info  list.

Note:

The information/values that display are:

• Cp metrics

• Cpk metrics

• USL (Upper Specification Limit)

• LSL (Lower Specification Limit)

• Mean

• Range

• Sigma

• Samples (Number included in calculations)

• Zusl score

• Zlsl score

• ZBench score

• Median

Pareto  Charts

The Pareto  chart provides a visual gage of the number of selected Defects  that occur in the process. 

Visual aids can be selected, as follows.
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1 Show fixed number 

of bars

Check or clear to do the following.

Check Displays the number of bars entered in the field.

Clear Displays the number of bars for all defects that have values greater 

than 0.

2 Show bar of re

maining defects

Displays a bar that:

• Reports the total of all defects that are not included in the defect cate

gories for the  bars that display in the chart.

• Is labelled O (for English systems).

3 Show info box Displays/hides a list of defect names/descriptions that are included in the Pare

to chart.

Check Displays the info  list.

Clear Hides the info  list.

8. SPC Control: Report

Checked fields on the SPC Control Properties dialog box>Report tab display as columns in the selected 

report.
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Fields in each of the three columns on the SPC Control Properties>Report tab are enabled/disabled based 

on whether the quality characteristic is a variable or attribute.

1. #unique_413_Connect_42_i05Report  (on page 693)

2. #unique_413_Connect_42_i04Buttons  (on page 693)

3. #unique_413_Connect_42_i03FieldsCol3  (on page 693)

4. #unique_413_Connect_42_i03FieldsCol3  (on page 693)

5. #unique_413_Connect_42_i02FieldsCol2  (on page 692)

6. #unique_413_Connect_42_i02FieldsCol2  (on page 692)

7. #unique_413_Connect_42_i01FieldsCol1  (on page 692)

8. #unique_413_Connect_42_i01FieldsCol1  (on page 692)

1  (on 

page 

692)

Fields: Column 1.

2  (on 

page 

692)

Fields: Column 2.

3  (on 

page 

693)

Fields: Column 3.
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4  (on 

page 

693)

Buttons.

5  (on 

page 

693)

Report: Quality Characteristic Description Columns

1 Fields: Column 1

The first column includes the following fields.

Field Description
Vari

able

At

tribute

Enabled for:

Date/Time Value date/time: MM/DD/YYYY HH:MM:SS 

AM/PM

Yes Yes

Subgroup Size entered on the SPC Document General tab Yes Yes

XBar val

ue

XBar/R or XBar/S variable value Yes No

R/S value Range (XBar/R) or Sigma (XBar/S) variable value Yes No

2 Fields: Column 2

The second column includes the following fields.

Field Description
Vari

able

At

tribute

Enabled for:

Lower CL Lower Control Limit val

ue

Yes Yes

CL Center line value Yes Yes

Upper CL Upper Control Limit value Yes Yes

Att_value Attribute value No Yes
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3 Fields: Column 3

The third column includes the following fields.

Field Description
Vari

able

At

tribute

Enabled for:

R/S LCL Range or Sigma Lower Control Limit Yes No

R/S CL Range or Sigma Center line Yes No

R/S UCL Range or Sigma Upper Control Limit Yes No

Annotation Annotations entered for selected val

ues

Yes Yes

4 But

tons

Buttons are available to do the following.

Select All Checks all of the check boxes available for the selected chart 

type.

Deselect All Clears all of the check boxes.

5 Report: Quality Characteristic Description Columns

The following columns are not optional. They display even if all the check boxes have been deselected.

Field Description

Group ID Group the QC is included in

Product 

ID

Product being tested

QC ID Quality Characteristic ID

Batch ID If a batch is used the batch ID; the column displays with no values if a batch is not being 

used.
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9. SPC Control: Annotation

SPC enables users whose role  (on page 571)  has been assigned access to enter comments 

(annotations) about one or more values that display on the charts.

The SPC Control Properties dialog box>Annotation tab enables you to specify colors that can help users 

quickly see what subgroups have annotations

1 

(on 

page 

706)

Annotation  High

light

The subgroup that represents the value on the SPC chart displays the Annota

tion highlight color when that subgroup is selected to display its existing anno

tations or to be assigned a new annotation.

2 

(on 

page 

706)

Annotation Sym

bol: One annota

tion

A light weight circle will display around subgroups that have one annotation; 

the circle will display in the selected color.

3 

(on 

page 

706)

Annotation Sym

bol: More than 

one annotation

A heavy weight circle will display around subgroups that have two or more an

notations; the circle will display in the selected color.

4 

(on 

page 

710)

Max Annotation 

Size

Each subgroup  value on a chart  (on page 710)  can have the maximum num

ber of annotations specified in the Max Annotation Size  field. The maximum 

number can be 2 through 20 annotations.
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Default 5

Note:  If a user attempts to enter more than the specified number of annota

tions, a message will open to explain that the limit was exceeded.

SPC Runtime

SPC Runtime

CIMPLICITY SPC provides many runtime features that enable users to evaluate chart results.

Features include the following.

1. 8. SPC Runtime: About SPC  (on page 717)

2. 7. SPC Runtime: Ambient Properties  (on page 716)

3. 6. SPC Runtime: Properties  (on page 715)

4. 5. SPC Runtime: Annotation  (on page 705)

5. 4. SPC Runtime: Exclusion Mode  (on page 701)

6. 3. SPC Runtime: Print  (on page 700)

7. 2. SPC Runtime: Manual Data Entry  (on page 697)

8. 1. SPC Runtime: Update  (on page 696)

1  (on 

page 

696)

SPC Runtime: Update



Addons and Options  | 6 - Statistical Process Control  | 696

2  (on 

page 

697)

SPC Runtime: Manual Data entry

3  (on 

page 

700)

SPC Runtime: Print

4  (on 

page 

701)

SPC Runtime: Exclusion Mode

5  (on 

page 

705)

SPC Runtime: Annotation Mode

6  (on 

page 

715)

SPC Runtime: Properties

7  (on 

page 

716)

Use Ambient Properties

8  (on 

page 

717)

SPC Runtime: About SPC

1. SPC Runtime: Update
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1. Right-click the chart to be updated.

2. Select Update on the Popup menu.

The chart is updated with the most recent data.

2. SPC Runtime: Manual Data Entry

If Manual entry allowed was checked in a selected feature's SPC Configuration window>Properties dialog 

box, it is available during runtime.

1  (on 

page 

697)

Open a Manual Data Entry dialog box.

2  (on 

page 

698)

Enter data manually.

Manual Data Entry: Open  a Manual Data Entry Dialog Box

1. Right-click an SPC chart.

2. Select Manual Data Entry on the Popup menu.
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A Manual Data Entry dialog box opens.

1. Enter  Data Manually

Do the following.
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A Raw Value 

field

Enter a value.

B Click the Entry button. The entered value is added to the manual entry 

list.

C Click the Submit button.

Result: SPC:

1. Groups the values into samples.

The sample (subgroup) size was entered on the

◦ Variable Quality Characteristics dialog box>General tab.

◦ Attribute Quality Characteristics dialog box>Collection tab.

2. Calculates the sample value.

Note:  If individual values remain in the list, after SPC creates the subgroups, those individual values 

will not be applied to the chart.

Example

Five manual entries are listed in the Manual Data Entry dialog box when the Submit button is 

clicked.

◦ The subgroup size is 2.

◦ SPC:
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◦ Creates two subgroups the first four values.

◦ Ignores the fifth value.

◦ Adds the two subgroup values to the chart.

3. SPC Runtime: Print

1. Right-click the chart to be printed.

2. Select Print on the Popup menu.
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A Print dialog box that lists the available printers opens.

3. Make any necessary adjustments to the selected printer.

4. Print the chart.

4. SPC Runtime: Exclusion Mode

A process must be in control when you determine its control limits. Some values (e.g. values collected 

when a machine is warming up or when a cutter is being recalibrated) contaminate the results. 

CIMPLICITY SPC includes the Exclusion mode so those values can be excluded from the calculations.

Important:

When calculating control limits, variation must be due to common causes only. Variation cannot 

be attributable to special causes or control limits are not valid.



Addons and Options  | 6 - Statistical Process Control  | 702

SPC Exclusion Mode is enabled on the following chart types:

Vari

able

At

tribute

XBar-R P

XBar-S nP

C

U

1  (on 

page 

702)

Detect explained erratic val

ues.

2  (on 

page 

703)

Enable exclusion mode.

3  (on 

page 

703)

Exclude values.

Detect  Explained Erratic Values

A chart with normally consistent values can show deviations for known reasons (e.g. a cutter was being 

re-calibrated while product was being cut and finished.

1 Charts report values that deviate from the targeted product length of 72 inches.

2 Auto-calculated means and upper/lower sample values.
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3 UCL/CL/LCL values are were entered in the variable's Variable Quality Characteristics Properties dia

log box>Limits tab.

Enable  Exclusion Mode

1. Right-click the mouse a chart

2. Select Exclusion Mode on the Popup menu.

Result: The chart goes into Exclusion mode; the ability to exclude values is enabled.

Exclude  Values

When values that are normally consistent deviate from the norm for known reasons, they can be excluded 

from SPC calculations.

Example

Values on a chart that are normally flat increase in value; the change is known to be a temporary machine 

adjustment.

The chart is put into Exclusion mode.

Note: An X  in the upper-left corner indicates that the chart is in Exclusion mode.
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An X  replaces the value. The X will be red if the value has failed one or more tests.

The X'd values are not included in the calculation; they may go beyond the new chart limits.

As the chart runs in Exclusion mode additional values may be X'd out.

Once you leave Exclusion mode and return the previously excluded values are again included in the 

sampling/calculations.

If the out of control values were a temporary, known reason, the process will again be in control.
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Note:

The GetControlLimits() ActiveX method provides access to the control limits displayed on the 

chart.

5. SPC Runtime: Annotation

5. SPC Runtime: Annotation

SPC enables users whose role  (on page 571)  has been assigned access to enter comments 

(annotations) about one or more values that display on the charts.

• Annotation Mode: Enabled.

• Annotation: Procedures.

Annotation Mode: Enabled

Right-click the SPC chart; select Annotation Mode on the Popup menu.

Result: SPC goes into annotation mode; one or more values can be selected to enter or review comments.

A slider follows the mouse cursor as it moves over subgroups. The subgroup value displays at the top of 

the slider.
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Annotation: Procedures

5.1  (on 

page 

706)

SPC Annotation: Values select

ed.

5.2  (on 

page 

710)

SPC Annotation: Entries.

5.1. SPC Annotation: Values Selected

Note: The chart pauses while it is in annotation mode. Values that can be selected include.

• Individual values.

• Group of values.

Individual  Values

Individual values can be selected for a list of annotation ready and annotation items.

1. Double-click one or more values on the SPC chart.

A box displays around selected values indicating that they will be listed in the Annotation Viewer.

Subgroups that display the following symbols are or have been included in an annotation session 

as follows.
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Symbol Description Subgroup

Annotation highlight. Is selected for immediate annotation in the Annotation 

Viewer. Note:  The subgroup displays a unique color.

Annotation symbol: One 

annotation.

Has one annotation.

Annotation symbol: 

More than one annota

tion.

Has more than one annotation

Box surrounding sub

group.

Is selected to be listed currently in the Annotation View

er.

Note:

Guidelines

◦ Single-click any box to remove the subgroup from being listed in the Annotation Viewer.

◦ Colors can be selected on the SPC Control Properties dialog box>Annotation tab, as follows.

◦ Annotation highlight.

◦ Annotation symbol: One annotation

◦ Annotation symbol: More than one annotation

2. Right click a selected value; select Add Annotation(s) on the Popup menu.

Note:  Click the checked Annotation mode at any time to return to standard runtime mode.

Result: The Annotation Viewer opens listing the selected values.
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A Values selected for annotation are listed in the left-pane. Source Information includes the fol

lowing.

Subgroup 

value

Sample value

Timestamp Time the sample value was calculated

Chart Type (e.g. Means)

B Annotation information includes the following.

Annotation All or part of the annotation. Note: An Annotation dialog box can be opened to 

display a longer annotation.

User User who entered the annotation.

Timestamp Time the annotation was entered.

Note:  Additional annotations for the same value are listed on separate lines.

Group  of Values

Many values can be selected at one time for annotation.

3. Hold down the left-mouse button as you drag the mouse over the chart area with the values that 

should be selected.

A box displays around the selections.
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4. Release the mouse button.

Each value in the group is surrounded by a box.

5. Right-click in the selected area; select Add Annotation(s) on the Popup menu.

The Annotation Viewer opens listing the selected values.
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5.2. SPC Annotation: Entries

The Annotation Viewer may list one to many values, depending on what was selected.

1  (on 

page 

710)

Enter annotations.

2  (on 

page 

713)

Read annotations.

1. Enter  Annotations

• Quick entry.

• Detailed entry.

Important:

The maximum number of annotations that can be entered for a single subgroup value is entered 

on the Control Properties dialog box>Annotation tab  (on page 694).  If a user attempts to enter 

more than the specified number of annotations, a message will open to explain that the limit was 

exceeded.

Quick  Entry

You can enter a quick annotation for a selected value directly in the Annotation Viewer.

Do the following.
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1 Select a value in the Annotation Viewer left pane.

2 Do the following.

A Double-click the next blank line in the Annotation Viewer right-pane.

The line becomes a read-write line.

B Enter the annotation.

Important:

• The maximum number or characters for a quick entry is 255

• Use the Annotation Detail dialog box to increase the annotation to a maximum of 1024 

characters.

3 Do the following.

A Press Enter on the keyboard.

The Save button displays.

B Click Save.

Result: The annotation is entered for the selected value.

Detailed  Entry

You can enter a detailed annotation for a selected value in an Annotation dialog box.
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1. Do the following.

1 Select a value in the Annotation Viewer left pane.

2 Do the following.

A Right-click the first blank row in the Annotation Viewer right-pane.

B Select Add Annotation on the Popup menu.

An Annotation Detail dialog box opens.

2. Enter the annotation.

The fields are as follows.

1 User (Read only) Logged in user who is entering the annotation.

2 Time (Read only) Time the Annotation Detail dialog box was opened.
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3 Com

ment

(Read-write) Text box to enter a detailed annotation, if necessary. Important: Important: 

The maximum number of characters you can enter in the Comment  box is 1024.

3. Click OK.

The Annotation Detail dialog box closes; the annotation wholly or partly (depending on the length) 

displays in the Annotation Viewer right-pane.

a. Read  Annotations

Annotations can be read in and through the Annotation Viewer and when a value on that chart that 

has one or more annotations is selected.

◦ Annotation Viewer.

◦ Chart Popup message.

Annotation Viewer

You can view annotations in the Annotation Viewer as follows.

wc

1  (on 

page 

713)

Detailed annotation

2  (on 

page 

714)

Quick entry annotation

1 Detailed  annotation
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If a detailed annotation is too long to be read on the Annotation Viewer line, do the following.

a. Right-click the line with the annotation you want to read.

b. Select View Detail on the Popup menu.

Result: A read-only Annotation Detail dialog box opens displaying the entire annotation.

2 Quick  entry annotation

Annotations that were entered on a line in the Annotation Viewer are generally short enough to 

read on that line. However, if necessary a read-only Annotation Detail dialog box can be opened for 

these annotations.

Chart Popup  Message

4. Hover the mouse over a value on the chart.

A Popup opens with details about the value. I there are one or more annotations, one, at least, will 

display on the Popup. If More annotations... is included in the Popup message,
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A Date/time the annotation was entered.

B User who entered the annotation.

C The annotation related to the date/time and user.

D More annota

tions...

(If on the Popup) indicates that there are additional annotations assigned to 

the selected value.

5. (More annotations... is on the Popup) Right-click the selected value.

6. Select View All Annotation(s)... on the Popup menu.

The Annotation Viewer opens. All of the annotations can be read in the Annotation Viewer and/or the 

Annotation Detail dialog box.

6. SPC Runtime: Properties
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1. Right-click the SPC chart.

2. Select Properties on the Popup menu.

The SPC chart's Properties dialog box opens. Options that apply to the selected chart are enabled.

7. SPC Runtime: Ambient Properties

An SPC runtime chart can use ambient properties as the display properties at any time.

Right click the chart; select Use Ambient Properties on the Popup menu.
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Resutl: The chart format now display in ambient properties.

8. SPC Runtime: About SPC
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1. Right-click an SPC runtime chart.

2. Select About SPC on the Popup menu.

An About SPC message box opens providing you with administrative details about the installed SPC 

version.

SPC Technical Reference

SPC Technical Reference

• SPC charts.

• ActiveX methods.

• ActiveX properties.

SPC Charts

SPC Charts

CIMPLICITY SPC provides a number of SPC charts to determine if a system process is in control or 

stable.

Note:  The SPC charts can also indicate a process that may be in control, but is producing unacceptable 

product. In this case, the entire process will require revamping.

• SPC Charts: Variables.

• SPC Charts: Attributes.

• SPC Charts: Defects.
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SPC Charts: Variables

Variable charts track and report the fluctuations of a particular process to help determine if the process is 

stable (in control).

• Chart: Individual

• Chart: Histogram

• Chart: XBar-S

• Chart: XBar-R

• Chart: (Simple) Moving Average

• Chart: Moving Range

• Chart: Exponentially Weighted Moving Average (EWMA)

• Chart: Report

Chart: Individual

X-Individual charts:

Track Individual values

Report Individual values over 

time.

Note:  The control limits are calculated by determine the standard deviation of the sample population.

The Individual chart is selected on the SPC Control Properties dialog box>Chart tab.
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Chart: Histogram

Histogram charts:

Track Individual values over a selected time period.

Report Distribution and other statistics based on the individual val

ues.

A Histogram chart displays the following.:

• Sample data.

• Distribution

• Central tendency

• Scatter or variability

• Data

• Calculated process capability.

• Depending on whether the source of the data is an XBar-R or XBar-S chart, the estimate of the 

process standard deviation differs.

• When arranged from lowest to highest; if the number of values is even, by convention the average 

of the middle two values is use.

• The histogram is selected on the SPC Control Properties dialog box>Chart tab.
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Chart: XBar-S

XBar-S charts:

Track Selected characteristic value of each unit in a subgroup.

Re

port

XBar Subgroup means over time. Control limits are calculated using the average standard de

viation.

Sig

ma

Subgroup standard deviation over time.

XBar-S subgroup is:

• Variable in size.

• Relatively large.

• Collected at regular intervals.

• Common with other subgroups in one or more features.

Notes

• The XBar-S chart is selected on the:

1. Variable Quality Characteristics Properties dialog box>General  (on page 610)  tab.

2. SPC Control Properties dialog box>Chart tab.

• Control tests  (on page 658)  are available for the XBar-S chart.

Chart: XBar-R

XBar-R charts
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Track Selected characteristic value of each unit in a subgroup.

Re

port

XBar Subgroup means over time. Control limits are calculated using the average standard de

viation.

Range Ranges within the subgroups.

XBar-R subgroup is:

• The same size.

• At regular collection intervals

• Common with other subgroups in one or more features.

Notes

• The XBar-R chart is selected on the:

1. Variable Quality Characteristics Properties dialog box>General  (on page 610)  tab.

2. SPC Control Properties dialog box>Chart tab.

• Control tests  (on page 658)  are available for the XBar-R chart.

Chart: (Simple) Moving Average

Moving Average charts:

Track Selected characteristic value of each unit in a fixed subset.
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Re

port

Average for the first fixed subset and then the average of the rolling subset. Note:  SPC drops the 

first value in the existing subset; picks up the next value after the existing subset.

Moving Average observation is a rolling, fixed size subset.

The Moving Average chart is selected on the SPC Control Properties dialog box>Chart tab.

Chart: Moving Range

Moving Range charts:

Track Selected characteristic value of each unit in a fixed sub

set.

Report Difference between one point and its predecessor.

Moving Range observation is:

• An individual unit

• Normally paired with the Individual chart to display the individual measured values.
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The Moving Range chart is selected on the SPC Control Properties dialog box>Chart tab.

Chart: Exponentially Weighted Moving Average (EWMA)

EWMA charts:

Track Selected characteristic value of each unit in a fixed subset.

Re

port

Weighted subgroup mean, the more recent the sample, the higher the weight. This detects much 

smaller process shifts than a normal control chart would.

EWMA observation is a rolling, fixed size weighted subset.

The EWMA chart is selected on the SPC Control Properties dialog box>Chart tab.
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Chart: Report

Report charts display variable values in table format.

Note:  Optional fields that display on the Report chart are selected on the SPC Control Properties dialog 

box>Report  (on page 690)  tab.

SPC Charts: Attributes

SPC attribute charts provide different perspectives for reviewing defective units. What constitutes a 

defective unit depends on your definition (e.g. a unit might have to have three defects or certain type of 

defects  to be classified as defective).

• Chart: nP

• Chart: P

• Chart: C

• Chart: U

• Chart: Exponentially Weighted Moving Average (EWMA)

• Chart: Report

Chart: nP

nP charts:

Track Number of defective units in each sam

ple.

Report Number of defective units in each sam

ple.
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Note:  Each unit is treated as pass or fail regardless of the number of defects it might have.

nP chart sample is:

• A constant:size.

• Normally collected in a frequency that emulates the process being evaluated.

• The nP chart is selected on the:

1. Attribute Quality Characteristics Properties dialog box>General tab.

2. SPC Control Properties dialog box>Chart tab.

• Control tests  (on page 658)  are available for the nP chart.

Chart: P

P charts:

Track Number of defective units in each sample.

Report Proportion (percent) of defective units in each sam

ple

Note:  Each unit is treated as pass or fail regardless of the number of defects it might have.

P chart subgroup is

• Possibly different from other subgroups in size.

• Normally collected in a frequency that emulates the process being evaluated.
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• The nP chart is selected on the:

1. Attribute Quality Characteristics Properties dialog box>General tab.

2. SPC Control Properties dialog box>Chart tab.

• Control tests are available for the P chart.

Chart: C

C charts:

Track Total number of defects in a 

unit.

Report Total number of defects in a 

unit.

C chart subgroup is:

• Either:

• One item.

• A fixed number of items that are treated as one item.

• Assigned one or more defects to track.
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• The C chart is selected on the:

1. Attribute Quality Characteristics Properties dialog box>General tab.

2. SPC Control Properties dialog box>Chart tab.

• Control tests  (on page 658)  are available for the C chart.

Chart: U

U charts:

Track  Total number of defects per unit that occur during the sampling period.

Re

port

Mean (average) defects per unit during the sampling period. Note:Currently in CIMPLICITY SPC, 

the UCL is 1 or lower.

U chart subgroup is:

• Able to have a different number of sampling units in each sampling period

• Assigned one or more defects to track.
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• The U chart is selected on the:

1. Attribute Quality Characteristics Properties dialog box>General tab.

2. SPC Control Properties dialog box>Chart tab.

• Control tests  (on page 658)  are available for the U chart.

Chart: Exponentially Weighted Moving Average (EWMA)

EWMA charts

Track Number of defective units in an observation.

Re

port

Weighted subgroup mean, the more recent the sample, the higher the weight. Note:  This detects 

much smaller process shifts than a normal control chart would

EWMA observation is a rolling, fixed size weighted subset.
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The EWMA chart is selected on the SPC Control Properties dialog box>Chart tab.

Chart: Report

Report charts display variable values in table format.

Optional fields that display on the Report chart are selected on the SPC Control Properties dialog 

box>Report  (on page 690)  tab.

SPC Charts: Defects

CIMPLICITY SPC provides the Pareto chart to review instances of defined defects.

Chart: Pareto

The Pareto bar chart displays the cumulative instances for each defined defect in a defect  (on page 

665)  group.
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The maximum bar height is based on the Max to display value in the SPC Control Properties dialog 

box>Chart tab.

ActiveX Methods

SPC charting provides you with a wide range of built-in functionality. However, if you are familiar with 

ActiveX and want to add to that functionality as you design your screens, the following methods are 

available.

void AboutBox( ); Calls the About dialog box.

Boolean GetControlLimits (ucl, cl, lcl, 

rucl, rcl, rlcl)

Gets the current control limits displayed on the chart

void Print( ); Calls the Print dialog box.

void UseAmbientProperties( ); Automatically changes an ActiveX control to use the ambient 

properties of the container

ActiveX Properties

The following Active-X properties are available.

BSTR ChartTitle;

BSTR UpdateInterval;

short ChartType;

boolean ByTime;

BSTR StartTime;

BSTR EndDate;
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BSTR EndTime;

short MaxDisplay;

boolean Exclusion mode;

OLE_COLOR BackgroundColor;

OLE_COLOR ChartColor;

OLE_COLOR ForegroundColor;

BSTR StartDate;

IFontDisp* TitleFont;

boolean UseAmbientBgColor;

boolean UseAmbientFgColor;

boolean UseAmbientChartTitleFont;

boolean UseAmbientChartColor;

BSTR BatchID;

BSTR ProjectGroup;

BSTR Product;

BSTR QC;

boolean ShowLegend;

boolean ShowChartTitle;

boolean ShowXAxisLabels;

boolean ShowXAxisTitle;

boolean ShowYAxisLabels;

boolean ShowYAxisTitle;

boolean UseAmbientAxisLabelFont;

boolean UseAmbientAxisTitleFont;

IFontDisp* AxisLabelFont;

IFontDisp* AxisTitleFont;

short ReportFields;

ISpcSPCLineProperties* UCLSPCLineProperties;

ISpcSPCLineProperties* CLSPCLineProperties;

ISpcSPCLineProperties* LCLSPCLineProperties;

ISpcSPCLineProperties* ZoneSPCLineProperties;

ISpcSPCLineProperties* SpecLimitSPCLineProperties;

ISpcSPCLineProperties* NormalCurveSPCLineProperties;

boolean ShowUpperControlLimit;

boolean ShowCenterLine;

boolean ShowLowerControlLimit;

boolean ShowZones;
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boolean ShowSpecLimits;

boolean ShowNormalCurve;

boolean ShowInfoBox;

boolean ShowFixedNumberOfBars;

boolean ShowRemainingDefects;

boolean ShowValues;

MaxHistogramSamples;

NumberOfZones;

float UpperSpecLimit;

float LowerSpecLimit;



Chapter 7. System Sentry

About System Sentry

Bottlenecks occur even in the best-designed systems. They occur when a resource, for example hard disk 

space, memory or cache, is asked to do more than it can handle. The result can slow down or even stop 

an entire system.

A system administrator may know that one or more of the many diverse resources in a system are 

potential trouble spots. The challenge he or she faces is to catch a bottleneck before it occurs. Other 

problems can be more difficult to track, simply because they occur "under the hood". Without suitable 

tools, finding them can turn into a guessing game that, at best, is frustrating, at worst wastes time and 

money.

Welcome to the System Sentry. You no longer have to cross your fingers and hope that your computer 

system will avoid the bottlenecks and overloads that occur even in the best of system designs.

The System Sentry can provide you with performance data for every resource in your system, ranging 

from available hard drive space, CPU usage and free memory at any given moment to the accumulated 

number of alarms that have been generated since you started a CIMPLICITY project.

The System Sentry can warn you before the bottlenecks occur. You can:

• Use your own customized System Sentry screens to display the performance of any process in 

your system (that comes with counters).

• Be warned audibly by an alarm if a bottleneck in a selected process is about to occur.

• Be paged if a bottleneck in a selected process is about to occur.

• Be warned of irregularities by visual or audio alarms while you work with a system.

• View the performance of all the processes on easy-to-read, pre-configured System Sentry screens.

You can use the System Sentry to diagnose:

• One or more CIMPLICITY projects.

• A local computer.

• Primary and secondary SQL server computers.

• Simple networks.

• Other systems, for example, Web systems.

System Sentry at a Glance
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The System Sentry provides a variety of tools to address your requirements and level of system expertise.

The tools that, when configured, enable you to knowledgeably maintain and diagnose your system 

include:

• System Sentry pre-configured screens that enable you to diagnose a CIMPLICITY project's 

performance, either for maintenance purposes or to find the source of a bottleneck.

• Customized CimView screens that display data for any process in your system. Integrated 

CIMPLICITY power tools including:

◦ Data logging

◦ Alarming

◦ Paging

When you activate the System Sentry, you give yourself this flexible access to data that is collected by 

several counters in your system.

Your Windowssystem will have at least two types of counters:

• CIMPLICITY counters that are installed when you install the System Sentry.

• Windows Performance counters

Other types of counters include counters that come with:

• Remote Access Server (RAS)

• SQL Server

• Internet Information Server (IIS)

The System Sentry enables you to take full advantage of any of these counters, as well as any other that 

might be on your system. In addition to simply opening the pre-configured screens, you can create any or 

all of the working tools listed above.

The CIMPLICITY tools that you use for configuration are the tools with which you are already familiar. 

They are:

• Device points

• Points by address

You configure one or the other to report data from a specific instance of a specific process, for example, 

the percent of free space on your logical disk's D drive. The System Sentry provides you with an easy 
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to use Address Builder dialog box that you open when you configure either a device point or point by 

address. It is through this dialog box that you choose the instance of the process you want to monitor.

Activate the System Sentry

1. Click Project>Properties on the Workbench menu bar.

2. Select the General tab.

3. Check System Sentry in the Options box.

System Sentry Screens

System Sentry Screens

The System Sentry screens enable you to view the actual statistics of your system's CPU memory and 

disk space usage in addition to the details of the current CIMPLICITY project's processes.

The System Sentry screens help take the guesswork out of keeping your CIMPLICITY projects running at 

peak performance, in addition diagnosing bottlenecks that might occur.

The System Sentry screens enable you to view the performance of CIMPLICITY objects by:
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• Glancing at visual indicators, including thermometers, gauges and trend lines

• Reviewing the data in numbers and percents

This capability makes it easy for you to:

• Monitor each component of CIMPLICITY to maintain highly efficient performance

• Spot bottlenecks before a problem occurs

• Provide data that helps you find the source of a bottleneck if one occurs

The System Sentry divides the data into the following screens:

Overview screen.

Processes screen.

CimView screen.

Point Manager screen.

Alarm Manager screen.

Logging screen.

Point Logging screen.

Data Logging screen.

Event Manager screen.

Derived Points screen.

User Registration 

screen.

Router screen.

Devices screen

Ports (Devcom) screen

Open System Sentry Screens

Open System Sentry Screens



Addons and Options  | 7 - System Sentry  | 738

Option 1 

(on page 

738)

Open the System Sentry Overview screen.

Option 2 

(on page 

740)

Open a selected System Sentry screen..

Option 1. Open the System Sentry Overview Screen

1. Select Computer>System Sentry in the Workbench left-pane.

2. Do either of the following.

◦ Select any screen in the Workbench right-pane.

◦ Select _Main.cim in the Workbench right-pane.

Select any screen  in the Workbench right-pane.

Do one of the following.

A Click File>New>Object on the Workbench menu bar.

B Click the New Object button on the Workbench toolbar.

C In the Workbench left pane:

Either Or
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Double click System Sentry. a. Right-click System Sentry.

b. Select New on the Popup 

menu.

D a. In the Workbench right pane.

a. Right-click any screen.

b. Select New on the Popup menu.

E Press Ctrl+N on the keyboard.

Select _Main.cim  in the Workbench right-pane.

Do one of the following.

A Click Edit>Properties on the Workbench menu bar.

B Click the Properties button on the Workbench toolbar.

C In the Workbench left pane:

Either Or

Double click System Sentry. a. Right-click System Sentry.

b. Select Open on the Popup 

menu.

D a. In the Workbench right pane.

a. Right-click any screen.

b. Select Open on the Popup menu.
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E Press Alt+Enter on the keyboard.

3. Right-click System Sentry.

4. Select New on the Popup menu.

5. Right-click any screen.

6. Select New on the Popup menu.

7. Right-click System Sentry.

8. Select Open on the Popup menu.

9. Right-click any screen.

10. Select Open on the Popup menu.

Option 2. Open a selected System Sentry Screen

1. Select Computer>System Sentry in the Workbench left pane.

2. Select any System Sentry screen in the Workbench right pane.

3. Do one of the following.

A Click Edit>Properties on the Workbench menu bar.

B Click the Properties button on the Workbench toolbar.

C In the Workbench left pane:

a. Right-click System Sentry.

b. Select Open on the Popup menu.

D In the Workbench right pane:
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Either Or

Double-click a System Sentry screen. a. Right-click a System Sentry screen.

b. Select Open on the Popup menu.

E Press Alt+Enter on the keyboard.

4. Right-click System Sentry.

5. Select Open on the Popup menu.

6. Right-click a System Sentry screen.

7. Select Open on the Popup menu.

System Sentry Overview Screen

The Overview  screen provides a general view of the computer and CIMPLICITY's performance.

1 System's current % CPU use.

2 System's current memory usage.
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3 System memory swapping*.

4 Time is days:hours:minutes:seconds since the system booted 

up.

5 Total points in the current CIMPLICITY project.

6 Total point updates/sec.

7 Messages in and out of CIMPLICITY.

guide:

 Guidelines for reading the Overview screen include:

• Review the CPU Overview  for:

• Current CPU Utilization

• Trend of CPU usage.

The steady state CPU Usage should be below 60% for a non-redundant project and below 45% for a 

redundant project.

Do not let your system become fully utilized. A lower utilization enables CIMPLICITY to respond in a timely 

manner to events in your process. This is particularly critical when using redundancy.

When your computer is over-utilized, you have two choices:

1. Replace it with faster hardware.

2. Reduce the software load on the system. To do this you need to identify what Process is using the 

majority of the CPU time. The System Sentry Process Screen can provide you with this information. 

Some typical ways to reduce CPU utilization are:

a. Reduce Device Communications Scan Rate (Port Configuration).

b. Reduce Database Logging frequency.

c. Reduce the number of points.

◦ Review the Memory Overview  for:

◦ Current memory utilization

◦ Trend of memory utilization

As with excessive CPU utilization, excessive memory utilization will degrade system performance.

As a rule-of-thumb, the

Steady-state memory utilization should not exceed 75%.
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To increase virtual memory

a. Open the Microsoft Windows Control Panel

b. Select System.

c. Select the Performance tab.

Use Microsoft Help for details on how to adjust the virtual memory size, which should be twice as 

high as physical memory.

Note:  increasing virtual memory size will not reduce swapping if it is occurring. It simply gives the 

computer more memory "headroom."

◦ Swapping indicator should indicate no swapping while running in a steady state (EX. not 

opening new applications).

Swapping occurs because there is not enough physical memory in the computer and memory 

is swapped to disk. This rule-of-thumb is most important because a system that is constantly 

swapping will exhibit poor performance.

Two ways to reduce swapping are:

a. Add more physical memory to the computer.

b. Decrease the memory being used by applications on computer.

◦ Check System Disk Usage  for the amount disk space being used. Running out of disk 

space will cause application problems. Therefore, you must maintain free disk space on the 

computer.

System Sentry Processes Screen

The Process  screen displays information about each CIMPLICITY process in the project being monitored.
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guide:

 Guidelines for reading the Processes screen include:

• Use the CPU utilization  views for each process, particularly when you suspect excessive CPU 

utilization and need to determine which process, or processes, is causing it.

Views include:

• A Max Capture  for CPU Utilization on the bar chart. The Max Capture indicator shows the highest 

reading since the screen has been open.

To track when a process is using excessive memory:

1. Leave the screen open for a period of days to capture the spikes.

2. Click the Max line  at regular intervals to display the date and time at which maximum utilization 

occurred.
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Example

• A one minute trend chart that provides a graphic comparison of the percent CPU utilization by each 

process.

• The actual percent CPU utilization  currently and at the trend chart slider, for each process.

• Check each process' Memory Utilization  as a percent of available system memory on the bar chart 

if the system is running low on memory. This can help you determine which process, or processes, 

is using the memory.

If any you require more information for any process, click its button at the bottom of the screen. A screen 

dedicated to that process will open.

System Sentry CimView Screen

CimView is the graphics process that displays your screens at runtime.

The CimView  screen displays CimView performance information.

Note:

Since the System Sentry uses CimView, the numbers you see include the System Sentry's use in 

monitoring the process.
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guide:

 Guidelines for reading the CimView screen include:

• Check CPU Usage  to make sure CimView's use is in an acceptable range.

• Look at Point Resp/Sec  if CimView's CPU usage is excessive. This counter indicates the number of 

point updates per second that are coming into CimView. If this number is large (over 100) and CPU 

Utilization is high, it may indicate that too much data is being sent to CimView.

Solutions to too much data being sent to CimView include:

• Reduce the number of screens in the cache.

• Reduce the number of points on the screens.

• Reduce the scan rate of the points in Device Communications.

• Verify that device points are configured as On Change, not On Scan.

System Sentry Point Manager Screen
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The Point Manager process manages point activity in a CIMPLICITY project.

The Point Manager  screen displays the Point Manager's performance and activity.

guide:

 Guidelines for reading the Point Manager screen include:

• Check Updates/Sec  to see how many point values are being updated per second. This indicates 

how much data is changing in the project.

• Check Clients  to see how many clients are connected to the Point Manager. Clients include 

CimView, Database Logging, Point Control Panel, Event Manager, etc.

• Check App Overflows  and Device Overflows. These numbers should be zero. A non-zero number 

indicates that data is being lost in the system.

App Overflows  indicate that data is being lost when being sent to a client. Typically indicating that too 

much data is being sent too fast to an application (typically Database Logging or CimView) – and that the 

application cannot keep up with the rate. A check of the system status log will indicate the process that is 

having the problem.
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Device Overflows  indicate that too much data is being sent too fast to the Point Manager by a Device 

Communications Process. Both of these problems will affect system stability and need to be remedied 

immediately.

To remedy these problems you must decrease the data rate to the application as follows:

• Reduce the number of points used by application.

• Reduce the scan rate of the device points.

• Improve the computer's performance by adding memory or buying a faster processor. (Check the 

System Sentry Overview screen to review the computer's performance.)

• Verify that device points are configured as On Change, NOT On Scan.

If overflows persist after you have implemented the above suggestions, contact GE Digital technical 

support immediately.

System Sentry Alarm Manager Screen

The Alarm Manager process manages alarm activity in a CIMPLICITY project.

The Alarm Manager  screen displays the Alarm Manager's performance and activity.
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guide:

 Guidelines for using the Alarm Manager screen include:

• The top row contains statistics on the number of active alarms in the system. Alarms/Sec 

represents the number of Alarms per Second that are being generated in the system.

System Sentry Logging Screen

CIMPLICITY maintains several Logging tables that document data, alarm and event statistics, in addition 

to other processes such as SPC.

The System Sentry Logging  screen enables you to see the total number of entries to the different log files.
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guide:

 Guidelines for using the Logging screen include:

• The Table Total  is the total for all the tables that exist within the computer that are being registered 

by any Data Log Manager on that computer including Point Data Log, Event Log and Alarm Log.

• The Table Totals, including number of Writes, Reads, Queue and Maintenance Actions  are the 

totals that have occurred since the project has been running on the computer that is being 

monitored.

• The gauge shows how many Writes/Sec  are actually occurring.

Example

For Data Log, Writes/Sec  keeps an average, how fast logging is occurring onto the Data Log table.

Note:

When a queue overflow is reported, it includes the number of overflows seen on this table 

since the logger was started. This value may be used to assess the correct setting for the 

DB_QUEUE_SIZE  parameter.
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System Sentry Point Logging Screen

The CIMPLICITY Point Logger logs point values to the Data Log table.

The System Sentry Point Logging  screen reports point logging performance and activity.

guide:

 Guidelines for using the Point Logging screen include:

Entries under Process Statistics  should remain constant. The actual number depends on what 

applications are running.

System Sentry Data Logger Screen
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The Data Logger  lets you log alarms, events, and point values to a database, then retrieve the information 

for reports via a variety of ODBC-compliant applications.

The System Sentry Data Logger  screen reports the Database Logger's performance and activity.

guide:

 Guidelines for using the Data Logger screen include:

Entries under Process Statistics  should remain constant. The actual number depends on what 

applications are running.

System Sentry Event Manager Screen

The Event Manager process, configured through the Event Editor, runs actions in response to system 

events. These actions can be simple set points or user written Basic Control Engine Scripts. The Basic 

Control Engine User Interface (BCE User Interface) can be used to obtain a detailed view of event 

processing within the Event Manager.

This Event Manger  Screen provides a measurement of how the Event Manager process is performing.
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guide:

 Guidelines for using the Event Manager screen include:

• Review Point Requests/Sec  for the number of requests being sent to the Point Manager per 

Second. The Event Manager point requests are one of the following:

• Set points that are issued by the Event Manager or your script

• Requests to read a point value (through the BCE PointGet command.)

This counter is directly dependent on your Event Manager application.

• Check the CPU Usage  to see how much processing time the Event Manager is using. Typically, this 

value will not be steady. Instead, it should reflect the processing performed by the Event Manager 

when it has work to do.
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In a typical application, the CPU Usage should drop to zero periodically. This indicates that there is 

enough CPU bandwidth for the Event Manager to complete its work in response to factory events. An 

Event Manager that never idles, is an Event Manager that is constantly busy and prone to fall behind in 

event processing.

• If you see a large spike in CPU Utilization  along with a large spike in Point Requests/Sec  check to 

see if a script is polling a point value in a loop with little or no delay.

To correct the spikes:

1. Identify the script though the BCE UI.

2. Correct the logic in the script to use the On Change  notification as opposed to busy polling.

Polling is a drain on system resources and will prevent you from getting the best performance from 

your project.

Note:

The performance data for the Basic Control Engine includes all scripts that are run under 

the control of the Basic Control Engine.

System Sentry Derived Points Screen

The Derived Point process maintains and updates all calculation points in the project. Calculation points 

typically take input from a device point and perform arithmetic, max capture, min capture, etc., and output 

this information to a point.

Data in the System Sentry Derived Points  screen reports the derived point system use and performance.
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guide:

 Guidelines for reading the Derived Points screen include:

• Check point requests per second (Point Req/Sec) and point responses per second (Point Resp/

Sec)

• Point Requests/Sec  represents the number of calculation points the derived point manager 

updates.

• Point Responses/Sec  represents the number of point value updates the derived point manager 

receives. The derived point manager uses these point values to produce the calculations.

• Check the derived point manager's CPU Usage. Excessive CPU usage and a large number of Point 

Req/Sec  may indicate that too many calculation points are being updated too rapidly.

To reduce the load on the Derived Point Process:
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1. Verify that device points are being reported OnChange  rather than OnScan.

2. Reduce the number of calculation being performed.

3. Reduce the scan rate of the device points.

System Sentry User Registration Screen

The User Registration process provides security management for the CIMPLICITY project. When users 

log into CIMPLICITY, they are validated by User Registration. In addition, User Registration manages the 

security policies configured for the CIMPLICITY Users.

The User Registration  screen provides a count of the number of users that are logged into the project.

guide:

 Guidelines for reading the User Registration screen include:

Check the number of Login Failures. A high number of login failures indicate that users are trying to guess 

passwords. If there is a high number, review your CIMPLICITY Event Log to determine what computers are 

being utilized to try to gain access.
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System Sentry Router Screen

The Router provides communications channels between the various CIMPLICITY processes and performs 

communication across the network to other routers.

The Router  screen provides vital information about the efficiency of these channels.

guide:

 Guidelines for reading the Router screen include:

• Make sure the Overflows  counter is zero. Overflows mean that inter-process messages are being 

dropped and indicate that data loss is occurring in your project. Typically this means that too much 

data is being sent too fast to an application. It cannot keep up with the data rate. Important data, 

such as alarm information may be lost.

To reduce the messaging load on the project, first identify the offending application by examining the 

overflow counters for the various ports. This is best accomplished through the Windows operating 

system Performance Monitor.
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• Make sure Retries/Sec  and Accumulated Totals–Retries  are zero, or very close. Non-zero values 

indicate bottlenecks in inter-process communication.

• Review Sent/Sec  and Receive/Sec for a general idea of the amount of inter-process 

communication that is occurring. Typically, the Sent and Received numbers should be close.

• Monitor the RR Out  counter in the Messages box. This number represents the number of Response 

Require Messages that are outstanding. The number will change as your system runs, but should 

not grow without bounds.

• Contact GE Digital technical support immediately if:

• You cannot resolve a reported Overflow

• Retries/Sec  or Retries Accumulated Totals  are not zero, or very close to zero

• RR Out  grows without bounds

System Sentry Devices Screen

The Devices  screen provides statistics concerning the communication to a factory device.

todo:

  To choose a device for evaluation:

1. Click the button to the right of the Device ID bar.

The Select a Device dialog box opens.

2. Select the device to be evaluated.
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guide:

 Guidelines for reading the Devices screen include:

◦ Review the number of transmissions  (on page 794)  per second (Transm/Sec) and 

responses per second (Resp/Sec) to and from the device are meeting your polling 

requirements.

◦ Make sure Failures  and Retries  are zero. Non-zero values indicate a problem. They could 

indicate that the device is being turned off or the communication link to the device is 

periodically failing.

◦ Check the Skipped Polls  to determine if too many points are being polled too fast. If 

they are, you will need to reduce the polling rate to a rate that can be sustained by the 

communication media and PLC.

System Sentry Ports (Devcom) Screen

The Ports (Devcoms)  screen provides statistics for a selected port.
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todo:

 To choose a port for evaluation:

1. Click the button to the right of the Port ID bar.

The Select a Port dialog box opens.

2. Select the port to be evaluated.

guide:

 Guidelines for reading the Ports screen include:

If the port's CPU usage is excessive, verify that device points are configured as On Change, NOT On 

Scan.

Frequently Used Features on System Sentry Screens

Frequently Used Features on System Sentry Screens
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Some indicators appear on several System Sentry screens. This is because the data they report is 

important to know for several individual applications.

Frequently used features include:

• Process statistics.

• Message statistics.

Process Statistics on a System Sentry Screen

Process 

Statis

tics

Description

CPU Us

age

Displays in three locations, the bar chart, text display and the trend chart. The CPU Usage is 

directly related to activity within the physical process. For example, when a conveyor system 

starts, we should expect an increase in CPU Usage as device points start changing and pass 

through the system

Mem

ory Us

age

Displays as a percent of system memory. Because it is a ratio, this number will change as oth

er applications open and close on the system. However, when the system is in a steady state 

this counter easily identifies where the memory is being used. A more accurate measure of 

memory usage is Private Bytes. This counter shows the amount of memory in Kilobytes being 

used by the process. In general, private bytes should remain constant for a process that is in a 

constant state.
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Process 

Statis

tics

Description

Threads Indicates the number of operating system threads active in the process. This number should 

be static for most processes except Event Manager and CimView.

Han

dles

Indicates the number of operating system handles in use by the process. This number may in

crease or decrease. However, the number should not constantly increase without bounds. If it 

does, it may indicate a software problem.

Message Statistics on a System Sentry Screen

The message statistics object provides information on the processes usage of CIMPLICITY Inter-process 

Communication (IPC.) IPC provides the mechanism by which CIMPLICITY processes send information 

(such as Point Updates) to each other. As such, these counters indicate the utilization and performance of 

this critical internal message delivery.

Mes

sage 

Statis

tics

Description

Mes

sages 

In

Displays as an accumulated total as well as per second counters in the bar chart and trend 

chart. Message In is a count of the number of messages received by this process from other 

CIMPLICITY processes. Typically messaging is directly related to the flow of point data from de
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Mes

sage 

Statis

tics

Description

vice communications to other processes. The Messages Out  counter displays the number of 

message sent out of the process.

Re

tries

Indicates the number of times message delivery had to be retried. Message retries occur when 

the applications mailbox is full and cannot accept more data. Retries should be close to zero in 

a properly configured application. Excessive retries degrade system performance and can be in

dicative of messaging bottlenecks. Additionally, retries may be the precursor to the more serious 

condition of message loss due to overflow.

Ports Indicates the number of mailboxes the process is using. This number will be different for differ

ent processes.

System Sentry Screen Viewing and Navigation Tools

System Sentry Screen Viewing and Navigation Tools

• Navigate from one screen to screen.

• System Sentry screen viewing tools.

• Print System Sentry screens.

Navigate from Screen to Screen

Method 1. Go from screen to screen

Click the appropriate button in the rows of buttons that appear at the bottom of every screen.

Method 2. Go to the previous screen

Do one of the following.

Option 1

Click View on the System Sentry menu bar.

Select Previous Screen.

Option 2
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Click Previous Screen  on a System Sentry screen toolbar.

Method 3. Go to the Overview screen

1.   Click View on the System Sentry menu bar.

2.   Select Home.

Using the System Sentry Screen Viewing Tools

System Sentry Screen Viewing Tools

• System Sentry screen size.

• System Sentry screen display tools.

System Sentry Screen Size

System Sentry Screen Size
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1. Choose any of the following to zoom the screen.

1  (on 

page 

765)

System Sentry Viewer toolbar buttons.

2  (on 

page 

765)

Zoom Percents on a System Sentry Screen's Edit 

Menu

3  (on 

page 

766)

Precise Zoom Percent

2. Fit the window to the new workspace display size.

1. System Sentry Screen's Toolbar Buttons

Click either the:

• Zoom 100-toolbar  button  to zoom the screen to the size it will display in CimView.

• Full Screen  toolbar button  to use the entire monitor screen for display.

Press ESC  on the keyboard to return to the System Sentry window environment.

2. Zoom Percents on a System Sentry Screen's Edit Menu

1. Click View on a System Sentry screen's menu bar.

2. Select the percent you want the display to zoom from one of the three- percent choices.
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Note:

You can also display a full screen by selecting Full Screen on the drop down menu.

3. Precise Zoom Percent

1. Click Edit on the System Sentry menu bar.

2. Select Zoom.

The Zoom dialog box opens.
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3. Either:

a. Select one of the zoom choices.

b. Enter a precise zoom percent in the Percent  field.

4. Click OK.

System Sentry Screen Display Tools

You can choose to display or hide the System Sentry toolbar, status bar and/or menu and title bar.

todo:

 To display or hide a System Sentry screen's display tools:

1. Click Edit on the System Sentry menu bar.

2. Select any one or all of the following.

Toolbars

a. Select Toolbars…

The Options dialog box opens.

a. Check one or all of the check boxes to display the options.

Status Bar

Check the check box to display the status bar.

Menu/Title Bar
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Check the check box to display the menu and title bars.

Print System Sentry Screens

A very powerful feature of System Sentry screens is that you can easily print any screen at any time

Whenever you see a System Sentry Screen that you want to print out to review on paper, you can.

Do one of the following.

Method 1

Click the Print  button .

Method 2

1. Click File on the System Sentry menu bar.

2. Select Print.

The Print dialog box for your printer will open.

Note:

The System Sentry file menu also provides you with Print Setup so you can configure your printer 

the same way you do in other Windows applications.
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Every system is unique. Therefore, you need to evaluate many of the numbers that display on your System 

Sentry screens in context with baseline and other system data.

System Sentry Power Tools

System Sentry Power Tools

The System Sentry takes monitoring capability to a new level by enabling you to create valuable 

customized tools that:

• Alert you if a selected instance in your system is exceeding its normal limits.

• Monitor objects other than CIMPLICITY objects that reside on your system, either on a local or 

remote computer.

By integrating the System Sentry with CIMPLICITY power tools, you can create:

• Logs to record performance data, including baseline performance.

• Alarms to audibly and/or visibly alert users that an instance has gone into alarm state.

• Pagers to page you if you are away from the system and an instance goes into alarm state.

• CimView screens–to display instances that are on your system in addition to the CIMPLICITY 

counters. You can dedicate entire or partial screens to your custom configuration.

You can create these power tools by doing configurations with which you are already familiar. You simply:

1. Use the familiar CIMPLICITY dialog boxes along with a new easy–to–use System Sentry Address 

builder to create a System Sentry:

◦ Device point.

◦ Point by address.

Whether you choose a device point or point by address depends on the use to which it will be put. 

The same advantages and limitations apply to System Sentry device points and points by address 

that apply to any others in a CIMPLICITY project.

Note:  In order to improve the performance, invalid points return a value of zero; they are not 

marked as invalid.

2. Continue configuring the CIMPLICITY power tools the same way you would for any other device 

point or point by address.
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Tip:

Use these tools to monitor:

◦ Local computers

◦ Remote computers

◦ SQL server primary and secondary computers

Power Tools Using System Sentry Device Points

Power Tools Using System Sentry Device Points

You can integrate System Sentry device points with several CIMPLICITY power tools to create System 

Sentry power tools. You can:

• Create log files to develop baseline data and review a performance history.

• Configure alarms to warn you before a bottleneck occurs.

• Configure pagers to warn you, even when you are not near the system, before a bottleneck occurs.

Note:

You can also configure objects on a CimEdit/CimView screen using a System Sentry device point. 

However, you can also use points by address. In order to improve the performance, invalid points 

return a value of zero; they are not marked as invalid.

System Sentry Device Points

System Sentry device points perform like any other configured device points. What makes them special is 

they report data, which is collected by internal performance counters, from your internal network systems 

and projects.

System Sentry obtains its data through an automatically installed System Sentry device that is connected 

to an automatically installed System Sentry software port. The System Sentry software port can access 

every counter in the system.

The counters include:

• CIMPLICITY counters.

• Windows Performance Monitor counters.
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• SQL Server counters.

• Any other counters that reside in the system.

You go through the same steps to create a System Sentry device as you would any other device point for 

which a port and a device are already installed.

Creating a System Sentry device point is straightforward. 

• When the System Sentry is installed, CIMPLICITY automatically installs a System Sentry protocol 

called PERFREAD.

• When you activate the System Sentry in the Project Properties dialog box, CIMPLICITY 

automatically installs a:

• Port called MASTER_PR0.

• Device called SYSTEM_SENTRY.

• When you create a new System Sentry device point, you simply choose the:

• System Sentry device.

• Address you want the device to reference.

System Sentry Port Configuration

When the System Sentry is activated, CIMPLICITY automatically installs a System Sentry:

• Protocol called PERFREAD.

• Port icon called MASTER_PR0 in the Workbench Ports area.

1. Open the CIMPLICITY Workbench.

2. Click the Ports  icon in the Workbench left pane.

3. Double-click MASTER_PR0 in the Workbench right pane.

The Port Properties dialog box opens.
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4. Select the General tab.

5. Enter the following:

Option Description

Descrip

tion

Descriptive identifier for the System Sentry device communication.

Scan rate Interval length between scans. The time type options are:

◦ Seconds

◦ Minutes

◦ Hours

Default 2 seconds

Retry 

count

Use the default.

Default 1

Enable Check to activate the port. Note:  The port is automatically created for System Sen

try.

Default Checked.

a. Note:

There is no configuration on the Default tab of the Port Properties dialog box.

System Sentry Device Configuration
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When the System Sentry is activated, CIMPLICITY automatically installs a System Sentry device called 

System_Sentry.

CIMPLICITY also automatically configures the System_Sentry device. The default configuration should 

not be changed.

todo:

 To view the System Sentry device configuration:

1. Open the Workbench.

2. Click the Devices  icon in the Workbench's left pane.

3. Double-click System_Sentry in the Device ID column in the right pane.

The General tab of the Device Properties dialog box opens. The configuration that displays is the correct 

configuration.
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System Sentry Device Point Configuration

System Sentry Device Point Configuration

You configure a System Sentry device point the same way that you do any device point.

You categorize the point as a System Sentry point by selecting the System Sentry device. :

The steps are

Step 1 

(on page 

774)

Create a new System Sentry device point.

Step 2 

(on page 

776)

Configure a System Sentry device point general proper

ties.

Step 3 

(on page 

776)

Configure a System Sentry device point device properties.

Step 4 

(on page 

776)

Specify the address for the System Sentry device.

Step 5 

(on page 

778)

Specify when the device point should be updated.

Note:

In order to improve the performance, invalid points return a value of zero; they are not marked as 

invalid.

Step 1. Create a New System Sentry Device Point

1. Open a New Point dialog box, using any of the following methods.

Method 1
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a. Select Points in the left pane of the Workbench.

b. Double-click the left mouse button.

Method 2

a. Select Points in the left pane of the Workbench.

b. Click File on the Workbench menu bar.

c. Select New.

d. Select Object.

Method 3

a. Select Points in the left pane of the Workbench.

b. Press Ctrl+N  on the keyboard.

Method 4

a. Select a point in the right pane.

b. Click the right mouse button.

c. Select New from the popup menu.

The New Point dialog box opens.

2. Define the point.

a. Name the System Sentry point.

b. Select Device as the Type.

c. Name System_Sentry as the device.

d. Choose Analog as the Class.

e. Click OK.
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The point's Properties dialog box opens.

Step 3. Configure a System Sentry Device Point Device Properties

1. Select the Device tab on the Point Properties dialog box.

2. Make sure the System_Sentry device displays in the Device ID  field.

3. Click Address Builder.

Step 2. Configure a System Sentry Device Point General Properties

1. Select the General tab of the Point Properties dialog box.

2. (Optional) Enter a description of the point in the Description  field.

3. Choose one of the two following data types.

UDINT Unsigned integers ranging from 0 to 4,294,967,295. The UDINT format is the format in 

which the counter results are stored. Note:  Decimals are truncated when UDINT is select

ed.

REAL Floating-point numbers. The REAL format is useful when the counter tracks current data, 

for example, per second counts.

4. Select one (1) in the Elements  field. The counter counts one (1) element.

5. Check the Read Only  check box. If the Read Only  check box is clear and someone tries to enter a 

setpoint value, CIMPLICITY will display an error message.

Step 4. Specify the Address for the System Sentry Device
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1. Select the object, in the Object  field, that you want to monitor.

You will see that every object in the system that has counters is available for you to choose.

2. Select the counter, from the Counter drop down list, that the device point will represent.

3. Select the instance, in the Instance  field, that the counter will count.

The available selections reflect the counter you selected and your system configuration.

Note:

The Total option appears whenever a total count can be made. This option enables you to 

include every system instance that can be counted by the selected counter.

4. Check the Include Computer Name  check box to specify which computer will provide the counter 

definitions. (The computer on which the System Sentry resides is used when you leave the check 

box blank.)

Note:  Checking this simple check box enables you to specify a SQL Server or remote computer 

reference.

The Computer Name  field displays.

Note:

To retrieve counters from remote computers make sure that the CIMPLICITY service can 

access the remote computer.

This means the service must run as a specific user and the user has to have access to the remote 

computer.

5. Enter one of the following:
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Entry References

@master Whatever server is currently the active server. The primary may have been switched, 

moved, or renamed, or the secondary may have taken over the active function. If it is 

the current active, it will be referenced.

@slave Whatever server is currently the standby. The secondary server may have been 

switched, moved, or renamed. If it is the current standby, it will be referenced.

@<project 

name>

A project in the system. If the project is not running, the point will be unavailable.

<comput

er name>

A computer that has the specified name. If the computer is renamed, it will no longer 

provide the counter definitions.

6. Click Connect  to connect to the specified computer.

7. Click OK.

The Device tab on the Point Properties dialog box appears displaying your selection in the Address 

field.

Step 5. Specify when the Device Point should be Updated

Select the update criteria in the Update Criteria  field. The choices are:

On Change (Default)

Data 

Col

lected

At a regular interval. The interval equals the base scan rate for the port on which the device is 

located multiplied by the scan rate for the point.

Value 

Updat

ed

Only when the value changes. This is an efficient criterion.

On Scan

Data 

Col

lected

At a regular interval. The interval equals the base scan rate for the port on which the device is 

located multiplied by the scan rate for the point.
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On Change (Default)

Value 

Updat

ed

The point's value is updated at the point's scan interval, whether or not the value changes. Be

cause this can increase system load, it is recommended that you use On Scan sparingly or not 

at all.

System Sentry Log File Creation

You can most accurately diagnose a system's performance when you have some baseline and historical 

data to use as a reference. You can easily collect this information for any System Sentry point data or 

alarm.

• Add points to a data log table.

• Add point alarms and alarms to the ALARM_LOG table.

System Sentry Alarms Creation

You unleash the power of a System Sentry device point when you configure alarms for the point.



Addons and Options  | 7 - System Sentry  | 780

You use the same process to configure alarmsfor a System Sentry point as you use for any other device 

point. You also receive the same benefits from the configuration.

When a point goes into your pre-defined alarm state, you can:

• Trigger a visual or audio alarm

• Transmit the alarm through a pager when you are not near the system

• Alert any roles (individuals doing specified tasks) who should be alerted

Tip:

When in doubt, log the point's data when the system is in a quiet state. The resulting baseline 

data can help you define when the point is in an alarm state.

System Sentry Pager Configuration

1.  Configure an alarm for the device point you want to attach to a pager.

2. Click the Pager folder in the CIMPLICITY Workbench.

3. Click the Alarms icon.

The CIMPLICITY Pager – Configuration window opens.

4. Click File on the Pager – Configuration window's menu bar.

5. Select New Entry.

The Add Alarm Pagers window opens.

6. Click Browse.

7.  Select the Alarm ID (Point ID) name from the Alarm ID list.

8. Continue configuration as you would for any pager selection.

CimView Screens Using System Sentry Points by Address

CimView Screens Using System Sentry Points by Address

A point by address provides an alternative to a device point when you want to periodically view one or 

more system instances on a CimView screen.

System Sentry Points by Address
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System Sentry points by address provide you with the same advantages and limitations as any 

CIMPLICITY point by address.

Points by address enable you to view raw device information without the overhead of configuring a 

CIMPLICITY point.

When a user opens a screen in CimView, the point is dynamically created in memory.

When the user closes the screen, the point is dynamically removed from memory.

The benefit of choosing a point by address is that point by address descriptions do not take up memory 

while they are not in use. This is because they are created and destroyed dynamically. However, there is a 

small delay during startup for these points to be created.

There are restrictions for point by address descriptions because they only exist while they are being 

viewed. A point by address:

• May only be used in applications like CimView, which directly display point data.

• Cannot be alarmed.

• Cannot be logged.

• Cannot be used in the configuration of another point.

• Cannot have engineering units conversion.

In general, a System Sentry point that is frequently used or is referenced by multiple CimView screens 

should be configured as a CIMPLICITY point. For diagnostic information, which is seldom used and is 

included in only one screen, a Point by Address is appropriate.

If you choose to use a point by address, you will discover that the System Sentry makes it easy to 

configure.

System Sentry Point by Address on a CimEdit Screen

System Sentry Point by Address on a CimEdit Screen

You can create an object that is governed by a system point by address on any CimEdit screen. These 

objects can provide you with system monitoring capabilities that augment the pre-configured System 

Sentry screens.
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Note:

If you want to use alarms with your object, you have to create an object that uses a System Sentry 

device point.

The steps to configure a System Sentry point by address are:

Step 

1  (on 

page 

783)

Insert or create an object (on an open CimEdit screen) that will be governed by the point by ad

dress at runtime

Step 

2  (on 

page 

783)

Open the Point by Address dialog box.

Step 

3  (on 

page 

785)

Fill in the Point by Address dialog box.

Step 

4  (on 

page 

786)

Select the object–counter–instance whose value will display.

Step 

5  (on 

page 

788)

(Optional) Change the scan rate.

Step 

6  (on 

page 

789)

Test the configuration.

Note:

These steps configure a simple shape and text object as an example. However, CimEdit offers 

you an extensive selection of objects that can be inserted or created in a screen.
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Step 1. Insert or Create an Object

Select or create an object from CimEdit's enormous selection.

• Text example

• Rectangle example

Text  Example

1. Click the Text  button in the Text group  on the CimEdit Ribbon bar.

2. Click the spot on the CimEdit screen where the text will display

3. Double-click the default Text object.

The Properties dialog box opens.

Rectangle  Example

4. Click the Rectangle  button in the Shapes group on the CimEdit toolbar.

5. Create the rectangle shape on the CimEdit screen.

6. Double-click the rectangle.

The Properties dialog box opens.

Step 2. Open the Point by Address Dialog Box

Click the Point menu button to the right of an expression field that applies to your configuration.

• Text example

• Rectangle example

Text  Example

1. Select a list item that enables you to enter a point or expression, e.g. Text.

2. Do the following.
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A Click the button to the right of the Expression 

field.

B Select Point by Address on the Popup menu.

Result: The Point by Address dialog box opens.

Rectangle  Example

3. Select a list item that enables you to enter a point or expression, e.g. Fill/Rotation.

4. Do the following.
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A Click the button to the right of the Expression 

field.

B Select Point by Address on the Popup menu.

The Point by Address dialog box opens.

Note:

Instead of selecting Point by Address you can select Browse Point ID or New Point from the Point 

ID popup menu. Choosing the former you will complete the System Sentry part of your object 

configuration; choosing the latter will open the New Point dialog box.

Step 3. Fill in the Point by Address Dialog Box
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1. Select the following in the Point By Address dialog box.

Field Select:

A Project The project that will be running when the System Sentry collects the point by address 

values.

B Device SYSTEM_SENTRY.

C Type A numeric format.

◦ UDINT is recommended.

◦ REAL can also be meaningful for per second values.

2. Click Address Builder.

The Address Builder dialog box opens.

Step 4. Select the Object-Counter Instance Whose Value will Display

Note:

The Address Builder dialog box is the same dialog box you use when configuring a System Sentry 

device point.
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1. Select the following in the System Sentry Address Builder dialog box.

Field Select:

A Object An objects that can be monitored from the available objects in the drop-down list. 

The exact list of objects is determined by your system configuration.

B Counter A counter for the object. The selected object determines the counters that are listed.

C Include Comput

er Name

(Optional) Check to monitor a remote computer.

a. Enter the remote computer name in the Computer  field.

b. Click Connect.

Result: The instances that are listed reside on the connected computer. 

Note:  The counter must be available to the network, not a local counter for 

the connection to succeed.

D In

stance

An instance for the counter. The selected object determines that instances that are 

listed.

2. Enter the remote computer name in the Computer  field.

3. Click Connect.

4. Click OK.

The Point By Address dialog box opens; an expression that applies to your selection displays in the 

Expression field.

Example



Addons and Options  | 7 - System Sentry  | 788

The following are selected for the rectangle and text object.

Object Logical Disk

Counter % Free Space

Remote computer SERVER1

Drive D

Step 5. (Optional) Change the Scan Rate

1. (Optional) Change the scan rate from the default of one second in the Scan  Rate field in the Point 

By Address dialog box.

2. Click OK
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The Point By Address box closes; the instance you selected displays in the Expression field in the 

Properties - Object dialog box.

3. Do any other configuration that the object requires.

4. Close the Properties - Object dialog box.

Step 6. Test the Configuration

Click the CimEdit Runtime button ..

Examples

The text and fill objects display that the D drive is 52% free.

.

CIMPLICITY Counters

CIMPLICITY Counters

The System Sentry comes with several CIMPLICITY counters. These counters provide the hard data that 

enables you to numerically diagnose the different components in your CIMPLICITY projects.

These numbers provide you with the tools to:

• Knowledgeably track a project's performance.

• Make a project run more efficiently.

• Avert potential bottlenecks.

The counters include accumulated totals, per second performance indicators and other statistics for the 

following CIMPLICITY objects:
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• HMI Alarm Manager.

• HMI CimView.

• HMI Device Communication (Devcom).

• HMI Device.

• HMI IPC.

• HMI Logging Table.

• HMI Point App.

• HMI Point Manager.

• HMI PRT DS Counters

• HMI Router.

• HMI Router Port.

• HMI User Registration.

• Levels in a system in which counters operate.

Levels in a System in which Counters Operate

Note:

Following are the levels in a system in which counters operate.

Lev

el
Description

Lev

el 

1–

Ob

ject

A system can be divided in several objects. Example There is a CIMPLICITY object called Alarm 

Class. There is a Windows object called LogicalDisk

Lev

el 

2–

Counter

There are one or more resources in an object that can be numerically counted. Example HMI Alarm 

Class includes Acknowledged alarms (Acked) and any Alarms (Alarms). Both can be counted Log

icalDisk includes several resources that can be numerically tracked. Resources include % Free 

Space, % Disk Read time, Avg. Disk Bytes per read

Lev

el 

3–

In

stance

Each counter includes one or more specific instance that can be singled out for diagnosis. Exam

ple: HMI Alarm Class Acknowledged alarms can focus on a specific CIMPLICITY project, or all the 

projects on a system (_Total) LogicalDisk % Free space can focus on a specific drive, such as the 

C: drive or all the drives in the system (_Total)
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CIMPLICITY Objects with Counters

CIMPLICITY Objects with Counters

The System Sentry provides several counters for CIMPLICITY objects.

CIMPLICITY counters can be grouped into three different categories that reflect the type of information 

they provide.

Code
Counter 

Level
Counter Provides:

N Novice Straightforward system indicators that alert a user if there is a potential problem. These 

counters, which are at the core of the System Sentry's usefulness, are the counters to 

use for most situations.

A Ad

vanced

Diagnostic data for a user, who is frequently responsible for increasing the project's effi

ciency or correcting a problem.

E Expert Diagnostic data for some of the most complex diagnostic requirements in CIMPLICITY 

project development.

A category code appears before each counter.

HMI Alarm Manager Counters

HMI Alarm Manager counters provide you with the capability to review a detailed performance of the 

alarms in one or all projects running on your system. Any one counter may raise a red flag that the system 

is generating more alarms than anticipated. When all of the counters are reviewed, the possibility that 

there is a problem in the system can be evaluated.

Accumulated totals since a CimView session started

For Counter Counts the Number of:

A Alarms 

Gener

ated

Alarms that have been generated and reset. In the case of reset, the message must be re-

sent to clients to change state Example  The same alarm may have been generated 100 

times since the project started. The last instance of the alarm being generated has not 

been deleted from the Alarm Manager. The Alarm Count is one (1). The Alarms Generat

ed count is 100.
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For Counter Counts the Number of:

A Alarms 

Ac

knowl

edged

Alarms that have been acknowledged.

A Alarms 

Reset

Alarms that have been reset.

A Alarms 

Deleted

Alarms that have been manually deleted.

Indicators of current performance

For Counter Displays the

N Alarm 

Count

Current alarms that display in the Alarm Manager. The generated alarms are either ac

knowledged or not acknowledged. They have not been deleted.

N Update 

Queue 

Length

Requests to generate alarms. The alarms are put in a queue. Then the queue is 

processed. This can cause the alarm manager to back up. The Update Queue Length 

should always be around 0.

N Appli

cation 

Queue 

Length

Applications can make requests to the Alarm Manager, for example, for the current list 

of alarms. The queue that forms before requests are processed should be a small num

ber.

N PTMRP 

Queue 

Length

Data comes from the point manager. The queue that forms before the data is 

processed should be a small number.

N Clients The number of clients that are currently requesting alarm data and have not yet re

ceived it. Clients include both allocated processes and alarm interested processes.

N Alarms 

Generat

ed/sec

The number of alarms that are being generated per second. This counter tells you if 

more alarms are being generated than you anticipated which, in context of other coun

ters, could indicate a problem with the system.

Expertise Code

N Novice
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A Ad

vanced

E Expert

HMI CimView Counters

HMI CimView counters provide you with the capability to review the performance of CimView during any 

single session. A CimView session begins when the first CimView screen is opened and ends when the 

last open CimView screen is closed. A session can include CimView, and Terminal Services access.

Accumulated totals since a CimView session started

For Counter Counts the Number of:

E BitBlts Cumulative number of BitBlockTransfers for a CimView session.

N Ob

ject Re

draws

Cumulative number of times objects are redrawn from the start of a CimView session. 

For example, each object on a screen is included in the total when the screen opens; ani

mated objects are counted each time they are redrawn.

A Events Cumulative number of events that have been fired from the start of a CimView session.

Indicators of current CimView performance

For Counter Displays the

E BitBlts/sec Current rate (per second) at which the BitBlockTransfers occur during a 

CimView session.

N Object Re

draws/sec

Current rate (per second) that objects are being redrawn in a CimView session.

N Open Screens The number of open CimView screens.

A Event Queue 

Length

Current number of events waiting to be fired.

A Events per sec Current rate (per second) that events are fired in a CimView session.

Other CimView session indicators
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For Counter Displays the

N Maxi

mum 

Cache 

Size

The maximum cache size available during a CimView session. CimView, Terminal Ser

vices and WebView have individual sizes. A system administrator can change any of the 

cache sizes for future CimView sessions using CIMPLICITY global parameters. The glob

al parameters are:

• GSM_CACHE_SIZE (CimView)

• GSM_TERMSERV_CAHE_SIZE(Terminal Services

• PROWLER_CACHE_SIZE(WebView)

N Process 

ID

The process number that Windows assigns CimView when a session starts. This num

ber remains constant during a single CimView session. When the session ends and a new 

session begins, a new number is assigned.

Expertise Code

N Novice

A Ad

vanced

E Expert

HMI Device Communication (Devcom) Counters

HMI Device Communication (Devcom) Counters provide you with the capability to review the performance 

of any one communication device in a project or all of the communication devices in the system.

Accumulated totals since the project started

For Counter Counts the Number of:

A Point Updates Point updates that have occurred on one or all communication de

vices.

Indicators of current performance

HMI Device Counters
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System Sentry provides performance data totals that indicate device performance since one or all 

projects in the system started. System Sentry also provides indicators that enable you to monitor current 

device performance.

Accumulated totals since the project started

For Counter

Col

lec

tion

Counts the Number of:

A Trans

mis

sions

Polled Transmissions to one or all devices, indicates how much activity is going into a 

communication device. A rapid increase may provide a warning for a communica

tion device overflow.

Unso

licited

Transmissions will not occur.

A Re

spons

es

Polled Responses from the device.

Unso

licited

Responses will increase every time a response for unsolicited communication is 

received even though  transmission will not increase.

Retries Polled Times a device has been retried.

A Unso

licited

Retries will not occur; unsolicited communication requires two transmission fail

ures before a retry can occur.

A Failures All Failures communicating to one or all devices.

E Skipped 

Polls

All Number of polls skipped when communicating to an Async device.

Note:

Transmissions, Responses, Retries Failures and Skipped Polls can also be found in diagnostic 

data for a device.

Indicators of current performance
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For Counter

Col

lec

tion

Displays the

N Transmis

sions/sec

Polled Transmissions to one or all devices per second.

Unso

licited

Transmissions will not occur.

Respons

es/sec

Polled Responses from the device per second.

N Unso

licited

Responses will increase every time a response for unsolicited communication 

is received even though  transmission will not increase.

For Other 

Counter

Indicates if the Device is Currently:

N Device Up 1 means the device is up.

N Device 

Down

1 means the device is down.

Note:

and Device Down  can also be found in diagnostic data for a device.

Expertise Code

N Novice

A Ad

vanced

E Expert

HMI IPC Counters

The System Sentry provides CIMPLICITY counters for the Inter-process Communications sub-system.

Accumulated totals since the project started
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For
Other 

Counter
Indicates if the Device is Currently:

A Mes

sages 

Sent

Messages sent by one or all processes. A number higher or lower than expectation may in

dicate a problem

A Mes

sages 

Re

ceived

Messages received by one or all processes. A number lower than messages sent indicates 

that one or more processes is not processing the messages as quickly as it is receiving 

them. The acceptable difference depends on the system and which process is being moni

tored.

A Log

ical 

Link 

Writes

Writes performed over the logical links. A logical link is a direct connection between 

processes, as opposed to sending the data through a router.

A Log

ical 

Link 

Reads

Reads performed over the logical links.

N Write 

Re

tries

Times a write operation was retried. If a process tries to write to a port and fails, it tries 

again. Write Retries can indicate that a process is backing up. Important:  Retries will not oc

cur on unsolicited communication; unsolicited communication requires two transmission 

failures before a retry occurs.

Indicators of current performance

For Counter Displays the

E Ports Software ports created by one or all projects' processes. A process might create 

entry ports at startup or continuously while it is running.

A Messages 

Sent/sec

Messages being sent by one or all processes per second.

Messages Re

ceived/sec

A Messages Re

ceived/sec

Messages being received by one or all processes per second.
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For Counter Displays the

A Write Re

tries/sec

Times a write operation is retried per second.

Expertise Code

N Novice

A Ad

vanced

E Expert

HMI Logging Table Counters

Listing of performance data for Database Logger Tables.

Accumulated totals since the project started

For Counter Counts the Number of:

A Writes Rows inserted into one or all logging tables. Accumulated Writes indicate that there is 

activity in the system.

A Reads Rows read from one or all logging tables. Reads will accumulate only if an application 

in the project performs reads, for example SPC. If not Reads will display as 0.

A Mainte

nance 

Events

Maintenance events submitted for one or all logging tables.

A Mainte

nance Ac

tions

Maintenance actions successfully completed for one or all logging tables. Each Export, 

Purge or other action configured for the table is counted separately.

Indicators of current performance

For Counter Displays the

N Writes/

sec

Rows inserted into the specified table per second indicate how quickly a process is trying 

to send messages through the system.
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For Counter Displays the

N Reads/

sec

Rows read from the specified table per second, are only read if an application in the 

project performs reads, for example SPC. If not, Reads/sec will display as 0.

N Queue 

Size

Database operations (including Reads, Writes and Maintenance Events) which have been 

submitted but not yet processed. If there is no application in the project that processes 

writes, the queue size will be 0.

Expertise Code

N Novice

A Ad

vanced

E Expert

HMI Point App Counters

The System Sentry provides CIMPLICITY counters for any one or all applications using the PTMAP API.

Accumulated totals since the project started

For Counter Counts the Number of:

A Point Re

quests

Requests to the Point Manager for point values.

A Service Re

quests

Requests to the Point Manager for anything other than a point value. For example, a 

setpoint would be a service request.

Indicators of current performance

For Counter Displays the

N Point Re

quests/sec

Requests per second to the Point Manager for point values, clearly showing how 

much demand is being placed on the Point Manager

N Service Re

quests/sec

Requests per second to the Point Manager for anything other than a point value, clear

ly showing how much demand is being placed on the Point Manager

Expertise Code
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N Novice

A Ad

vanced

E Expert

HMI Point Manager Counters

The System Sentry provides performance data for each instance of the Point Manager.

Accumulated totals since the project started

For Counter Counts the Number of:

A Mes

sages 

Sent

Total of all messages sent by the Point Manager.

N Dev

com 

Queue 

Over

flows

Messages dropped from the communication device queues. The Point Manager has di

rect connections to the communication devices. If a communication device  is not pro

cessing its messages quickly enough, the queue can back up and start dropping the Point 

Manager's messages. This counter shows the number of overflow messages since the 

project started.

N App 

Queue 

Over

flows

Messages dropped from point application queues. For example, if the Point Control panel 

is not processing its messages quickly enough, the queue can back up and start dropping 

the Point Manager's messages. This counter shows the number of overflow messages 

since the project started.

Indicators of current performance

For Counter Displays the

N Clients Clients requesting point data from the Point Manager.

N Points Points known to the Point Manager.

N Mes

sages 

Queued

Messages that the Point Manager has added to an application's queue. These messages 

are waiting to be sent.
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For Counter Displays the

A App 

Queue 

Size

Largest size of any Application message queue.

A Ad

hoc Re

quests

Requests for a Point by Address value.

A ES 

Points

All the Enterprise Points on an Enterprise server. The points may have requests or may be 

idle. One computer stores point values from several computers. This allows viewers to 

collect data from one computer, an Enterprise server, instead of having to be connected 

to several. The enterprise points are on one computer that is collecting data from all the 

other computers.

A ES 

Points 

Idle

Enterprise Points on an Enterprise server that are waiting to be released (currently not be

ing collected).

For Other 

Counter

Indicates if the Device is Currently:

N Con

figured 

Master

Server is the configured primary in a Server Redundant project. One (1) means yes.

N Current 

Master

Server is the current active in a Server Redundant project. This may be the configured pri

mary or a secondary server that has assumed the role. One (1) means yes.

Expertise Code

N Novice

A Ad

vanced

E Expert

HMI PRT DS Counters

The System Sentry provides counters to monitor the Production Tracker Data Server sub-system.
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Accumulated totals since the project started

For Counter Counts the Number of:

E DG Requests 

Added

Datagram requests that have been added (accumulated) since the project 

started.

E DL Requests 

Added

Data logger requests that have been added (accumulated) since the project 

started.

E LL Requests 

Added

Logical link requests that have been added (accumulated) since the project 

started.

Indicators of current performance

For Counter Displays the Number of:

E DG Request Queue Size Datagram requests that are currently in the queue.

E DG Requests Added/sec Datagram requests that were added in the last second.

E DG Requests Re

moved/sec

Datagram requests were removed in the last second.

E DL Request Queue Size Data logger requests that are currently in the queue.

E DL Requests Added/sec Data logger requests that were added in the last second.

E DL Requests Removed/sec Data logger requests that were removed in the last sec

ond.

E LL Request Queue Size Logical Link requests that are currently in the queue.

E LL Requests Added/sec Logical link requests that were added in the last second.

E LL Requests Removed/sec Logical link requests that were removed in the last second.

Expertise Code

N Novice

A Ad

vanced

E Expert
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HMI Router Counters

The System Sentry provides counters to monitor CIMPLICITY router performance.

Accumulated totals since the project started

For Counter Counts the Number of:

A Mes

sages 

Sent

Messages sent by the router.

A Mes

sages 

Rec

Messages received by the router.

A RCM 

Re

quests

Connection management requests. When a viewer needs to attach to a project, it makes 

an RCM request.

N Socket 

Errors

TCP/IP sockets are used to communicate. For example, if a cable is accidentally pulled 

off a socket, an error will be counted. Typically, there should not be many socket errors.

Indicators of current performance

For Counter Displays the

N Mes

sages 

Sent/

sec

Messages sent by the router per second.

N Mes

sages 

Rec/

sec

Messages received by the router per second.

N Sockets Sockets that are currently in use by the router. The router opens a socket for each con

nection to each computer. The router also uses sockets for other reasons. Example The 

router creates a separate connection between redundant nodes beyond the router mes

sage queue connection to show if the element has gone away. That can add extra sock

ets.
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For Counter Displays the

N Sock

et Er

rors/sec

Socket errors per second show if there currently is a problem. For example, a cable needs 

to be tightened.

N Con

nected 

Nodes

Nodes that are connected to the selected node.

E Ports Application ports in use by the router. This may be a well-known or anonymous port that 

is being sent out to a process. This indicates the current level of use.

E RR Out

stand

ing

Response required messages from a process that are on the router's queue waiting to be 

received by another process. If the router knows that the receiving process is unavailable, 

it informs the originating process.

Expertise Code

N Novice

A Ad

vanced

E Expert

HMI Router Port Counters

The CIMPLICITY counters for the IPC Ports inside the Router. The CIMPLICITY router is w32rtr.exe.

CIMPLICITY has three types of messages:

Message Description

Intermediate 

Response

Messages will follow this message

Final Response The last message in a chain sent by a process

Response Re

quired

Messages that require a response. This type of message eliminates waiting by quickly 

showing if a process is unavailable.

The difference between the number of these messages written and read can be a helpful diagnostic tool 

for solving a problem.
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Accumulated totals since the project started

For Counter Counts the Number of:

E RR 

Writes

Response Required messages that an application has sent via a software port to the 

router. The CIMPLICITY counter can count one or all ports.

E IR 

Writes

Intermediate Response messages that an application has sent via a software port to the 

router. The CIMPLICITY counter can count one or all ports.

E FR 

Writes

Final Response messages that an application has sent via a software port to the router. 

The CIMPLICITY counter can count one or all ports.

E RR 

Reads

Response Required messages sent from the router to an application via a software port. 

The CIMPLICITY counter can count one or all ports.

E IR 

Reads

Intermediate Response messages sent from the router to an application via a software 

port. The CIMPLICITY counter can count one or all ports.

E FR 

Reads

Final Response messages sent from the router to an application via a software port. The 

CIMPLICITY counter can count one or all ports.

E RR Can

cels

Response Required messages that have been canceled on one or all ports.

N IR 

Drops

Intermediate Response messages that have been dropped by the router. The router has a 

buffer in which it stores the queue. Messages are dropped when the router's buffer is full. 

The CIMPLICITY counter can count one or all ports. This, along with FR Drops, is a clear 

indicator that the system is not processing messages quickly enough.

N FR 

Drops

Final Response message has been dropped by the router on one or all software ports. 

The router has a buffer in which it stores the queue. Messages are dropped when the 

router's buffer is full. The CIMPLICITY counter can count one or all ports. This, along with 

IR Drops, is a clear indicator that the system is not processing messages quickly enough.

A Mes

sages 

Written

All of the messages sent from an application to the router via one or all software ports. 

The CIMPLICITY counter can count one or all ports.

A Mes

sages 

Read

All of the messages sent from the router to an application. The CIMPLICITY counter can 

count one or all ports.

Indicators of current performance



Addons and Options  | 7 - System Sentry  | 806

For Counter Displays the

A Messages 

Out

Messages that the router has queued waiting for a process.

For Other Counter Indicates that:

N Overflows Inter-process messages are being dropped and data loss is occurring in your 

project.

Expertise Code

N Novice

A Ad

vanced

E Expert

HMI User Registration Counters

The System Sentry provides counters to monitor the User Registration sub-system.

Accumulated totals since the project started

For Counter Counts the Number of:

N Login Fail

ures

Login failures for this 

project.

Indicators of current performance

For Counter Displays the

N Users Users currently connected to the project.

N Send Queue 

Length

Number of users attempting to log on to a project. This indicator should be ze

ro.

Expertise Code

N Novice
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A Ad

vanced

E Expert

CIMPLICITY Counters' Log Files

CIMPLICITY Counters' Log Files

The collection of the CIMPLICITY counters occurs whenever the router process (w32rtr.exe) is running.

Data is stored in log files. When the log file has reached a configured size it is closed and all the log files 

are rolled over.

The counter collection, including the number of files kept, is controlled by a configuration file.

The log files generated by the CIMPLICITY counter collection process are in the CIMPLICITY Log 

directory.

Example

\CIMPLICITY\hmi\log

There are two variations on the log file names

PERFDATA_#_DATA

PERFDATA_#_HEADER

Where:

PERFDATA_   indicates that the file is a CIMPLICITY counter log file

#   indicates when the file was created static to the other PERFDATA_  files. The newest file is 

PERFDATA_1.

_DATA   file contains the actual values recorded.

_HEADERS   file is used to match a column form the DATA file to a specific counter.

These files are in a comma-separated format (CSV) and can be loaded into Excel.
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Configuration File for the Counter Log Files

Configuration File for the Counter Log Files

The configuration file that controls the counter collection is called DefaultCounters.txt.

• DefaultCounters.txt location

• DefaultCounters.txt format and directives

DefaultCounters.txt Location

DefaultCounters.txt is in the CIMPLICITY perfserv directory.

Example

...\Proficy\Proficy CIMPLICITY\perfserv\DefaultCounters.txt

DefaultCounters.txt Format  and Directives

The following text displays when you open the DefaultCounters.txt file:

#VERSION 1

#UPDATERATE 300000

#MAXFILESIZE 1000000

#MAXFILES 7

Process|Private Bytes|_Total

Objects|Threads|

The format of the DefaultCounters.txt file is

• Directives preceded by a #

• Record indicating the counter to collect

The following directives are supported:

• VERSION   indicates the version of this file, should not be changed.

• UPDATERATE   how often data should be collected in milliseconds
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• MAXFILESIZE   how large can a log file be in bytes

• MAXFILES   how many versions of the log file to save

Each record in the file can have up to three fields separated by the '|' character:

• Object Name – name of the object to collect.

• Counter Name – name of counter to collect, can contain * as a wildcard character.

• Instance Name – name of the instance to collect, can be blank, can contain * as a wildcard 

character.

Specify the Number of Counter Log Files

DefaultCounters.txt specifies how many log files will accumulate before the oldest is deleted. The default 

number is seven. This number can be changed, for example, made smaller to free up disk space.

To change the number of accumulated CIMPLICITY counter log files:

1. Select the CIMPLICITY directory.

2. Select the perserv  folder.

3. Open the DefaultCounters.txt  file in a text editor application such as Notepad.

4. Change the number 7 for the entry #MAXFILES 7  to whatever number you want.

Specify What Objects, Counters and Instances will be Logged

A CIMPLICITY technical support person may request that you log system information to provide 

information that is pertinent to solving a problem.

You will have to add the instances to be logged the System Sentry DefaultCounters.txt file.

Each line of the list will include:

Object|Counter|Instance

Where

Name Description

Object Name Name of object to collect.

Counter Name Name of counter to collect, can contain * as a wildcard character.
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Name Description

Instance Name Name of the instance to collect, can be blank, can contain * as a wildcard charac

ter.

Tip:

Open a System Sentry Address Builder dialog box to see a list of all the objects available on your 

system. You can open the dialog box through a Point or Point by Address Properties dialog box.

System Sentry Privileges from Other Nodes

System Sentry Privileges from Other Nodes

System Sentry can monitor performance data from nodes other than the server on which it is installed. 

With some configuration, a system administrator can make use of this powerful feature for any or all of 

the nodes in your system.

Note:

You may not have to do any of the configuration changes described in this section. You can 

typically connect to a Windows Workstation without the extra configuration.
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Step 1 

(on page 

811)

Make CIMPLICITY a domain user.

Step 2 

(on page 

813)

Change local machine key privileges in the Windows Reg

istry.

Step 1. Make CIMPLICITY a Domain User

Step 1. Make CIMPLICITY a Domain User

In addition to changing permission for local machine keys  (on page 813)  in the Windows Registry, you 

need to make CIMPLICITY a domain user, when configuring node access privileges for the System Sentry.

Steps to make a CIMPLICITY  service a domain user are:

Step 1.1 

(on page 

811)

Create a domain user on a local machine.

Step 1.2 

(on page 

812)

Log CIMPLICITY on as the domain user with administrative privi

leges.

Step 1.1. Create a Domain User on a Local Machine

1. Create a User in the Windows User Manager dialog box.

2. Make sure the User is listed in the domain.

Example

Your company's domain is rloshkosh.

You create a user called sysnode5.

Make sure that sysnode5 is included in the domain so the name become s:

rloshkosh\sysnode5
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3. Grant the domain user administrative privileges for the local node.

Consult your Windows operating system documentation for more information about setting up 

user accounts.

Step 1.2. Log CIMPLICITY on as the Domain User with Administrative 
Privileges

1. Open the Windows Control Panel.

2. Double-click the Services  icon .

The Services dialog box opens.

3. Double-click CIMPLICITY service.

The Service dialog box opens.

4. Click the This Account  radio button.

5. Enter a domain name that has administrative privileges on the local node in the ThisAccount  field. 

(Click the Add User button to open the Add User browser.)

6. Enter a password in the Password  fields that will have to be entered when logging on to the 

domain.

7. Click OK.

If the User name you entered is on the domain or work group list, the CIMPLICITY service can log on as 

that user.
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Note:

In a work group, the user name and password must be the same on both nodes.

Step 2. Change Local Machine Key Privileges in the Windows Registry

Step 2. Change Local Machine Key Privileges in the Windows Registry

In addition to making CIMPLICITY a domain user  (on page 811) , you need to change permission for 

local machine keys in the Windows Registry, when configuring node access privileges for the System 

Sentry.

In order for the System Sentry to read performance data on remote computers there are two keys that 

need to give Everyone  Read access.

Step 2.1 

(on page 

814)

Set the \Winreg  key to Read access.

Step 2.2 

(on page 

814)

Set the \Perflib  key to Read access.
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CAUTION:

Before you edit the registry, make sure you understand how to restore it if a problem occurs. For 

information on how to do this, view Microsoft documentation.

Step 2.1. Set the \Winreg key to Read Access

1. Do one of the following.

Vista

Click the Start button on the Vista task bar.

Windows XP

a. Click Start on the Windows task bar.

b. Select Run.

The Run dialog box opens.

2. Type Regedt32.exe in the Start Search/Open  field.

3. Click OK.

The Registry Editor window opens.

4. Select HKEY_LOCAL_MACHINE.

5. Select SYSTEM>CurrentControlSet>Control>SecurePipeServers>Winreg.

6. Click Edit>Permissions on the Registry Editor menu bar.

The Permissions for winreg dialog box opens.

Note:  The permissions that are available in the dialog box depend on the Windows operating 

system.

7. Select the Domain user that you specified in the CIMPLICITY HMI Service.

8. Check Read in the Allow  column.

Step 2.2. Set the \Perflib Key to Read Access

1. Do one of the following.

Vista

Click the Start button on the Vista task bar.
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Windows XP

a. Click Start on the Windows task bar.

b. Select Run.

2. Type Regedt32.exe  in the Open  field.

3. Click OK.

The Registry Editor window opens.

4. Select HKEY_LOCAL_MACHINE.

5. Select SOFTWARE>Microsoft>Windows NT>CurrentVersion>Perflib.

6. Click Edit>Permissions on the Registry Editor menu bar.

The Permissions for Perflib dialog box opens.

Note:  The permissions that are available in the dialog box depend on the Windows operating 

system.

7. Select the Domain user that you specified in the CIMPLICITY HMI Service.

8. Check Read in the Allow  column.
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CIMPLICITY Marquee Manager Administrator

About CIMPLICITY Marquee Manager Administrator

The following topics provide an overview of the CIMPLICITY Marquee Manager Administrator product 

including detailed configuration descriptions:

• Marquee Manager Administrator:  Key Features  (on page 816)

• Marquee Manager Administrator:  How it Works  (on page 817)

• Marquee Manager Administrator: Available Object Types  (on page 819)

• Marquee Manager Administrator Pre-configuration  (on page 820)

• Marquee Manager Administrator Configuration  (on page 825)

• Marquee Manager Administrator Tools: Users  (on page 882)

• Marquee Manager Administrator Other Tools  (on page 885)

• Marquee Manager Administrator Technical Reference  (on page 891)

• Marquee Manager Administrator Glossary  (on page 900)

Marquee Manager Administrator:  Key Features

The Marquee Manager product family monitors manufacturing environments and sends real time, 

automated messages to visual or audible devices including LED display/Andon boards, stack lights and 

sounder alarms the moment a tolerance is breached. As an integral part of any lean initiative, Andon 

boards provide visibility into the activity on the plant floor but need to be driven by a robust, easy-to-use 

software solution.  Marquee Manager is the only multi-vendor marquee solution, supporting the majority 

of boards, including legacy displays.
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Key Features

• Delivers real-time information to most active matrix boards, including legacy displays.

• Industry standard NETCON Unit Protocol is a control language that speaks to numerous 

manufacturers’ boards.

• Easy-to-use message management system includes prioritization and queuing.

• Includes a full suite of flexible administration tools, all accessible remotely.

• Multiple applications can publish to the same board.

• Using Test/Disabled/Enabled modes allows for firmware changes to be made.

• Supports all industrial marquee manufacturers.

• Marquee details and attributes may be cloned for easy configuration.

• Provides full unattended recovery from network outages or display power loss/recovery.

• Once configured in server, users are isolated from requiring any knowledge of marquee protocols.

• Provides preview of any device's current content from a windows workstation.

• For security, regulate system usage to authorized users only.

• Allows changes to any aspect of your configuration at runtime.

• Easy integration for custom implementations.

Marquee Manager Administrator:  How it Works

Marquee Manager is a marquee management system that allows you to easily communicate to a variety 

of different marquees, using a simple generic language.  Marquee Manager establishes connectivity to 

visual displays through serial ports, TCP/IP sockets, or RF connections through the Alarm Cast Server. 

The core engine controls marquee connectivity and implements marquee drivers. The gateways or clients 

then feed requests to Marquee Manager for processing. The engine sorts and prioritizes messages to 

be displayed to ensure high priority messages are displayed first. Because Marquee Manager allows you 

to manage templates, board resources can be shared by production, maintenance, health and safety. 

Marquee Manager centrally controls messages to visual displays from multiple sources simultaneously. It 

displays data from OPC, HMI / SCADA, MES, Building Management and maintenance systems.

Data Sources:

• GE CIMPLICITY

Visual / Audible Display Devices:

• Adaptive Micro Systems

• Allen-Bradley InView

• Electro-Matic Products Inc.
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• Full matrix LED Andon boards

• Line matrix LED Andon boards

• MacDonald Humphries

• NETCON Unit

• Nu-Media Display Systems

• Stack Lights

• Static Controls Corporation

• Sounders and PA Systems

• Uticor Technology

Andon Systems

Andon systems are production quality control and monitoring systems that support plant management. 

Functioning as communication systems, Andon systems aid plant line workers, team leaders, and 

supervisors in completing assembly operations in-station.

If there is a problem at a station, an operator can pull the Andon cord or activate a push button, causing 

the conveyor to stop and the marquee board to display the problem. The Andon marquee boards inform 

every team member of the status of the assembly process. When a problem is reported, using the Andon 

system, the marquee board will illuminate the appropriate station number and play the associated music 

or vocal announcement. Other information displayed on the board could include production information, 

material calls, quality checks, system faults, OEE, and health and safety messages.
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Marquee Manager Administrator: Available Object Types

Object Description Sample

Andon 

Bin Cell

Cell type displays are typically used to display data best represented in a grid 

format.  Example A manufacturing facility is divided into numerous assembly 

stations, each cell represents a station’s state.

Andon 

Char 

Cell

Cell type displays are typically used to display data best represented in a grid 

format.  Example Displays what station or plant location is experiencing a 

problem and display information such as the area and nature of the problem.

Clock A display element specifically designed to display the time of day.

Color 

Block

Used to display a block of color for the state of a plant station.

Con

troller

Used to display various templates in a cycle defined by the administrator or by 

gateway events.

Counter A display element specifically designed to display numeric counts.

Mar

quee

One or more lines to display time, date and message text such as production 

counts.
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Object Description Sample

Sounder Typically used for speaker support to play tunes.

Stack 

Light

Used to display colors in a vertical grid pattern.

Marquee Manager Administrator Pre-configuration

Marquee Manager Administrator Pre-configuration

• Marquee Manager Administrator: DSN Specifications

• Marquee Manager Administrator: Application Folder Availability

Marquee Manager Administrator: DSN Specifications

Marquee Manager installation creates a Marquee Manager Server ODBC data source entry; the entry is a 

default.

Open the ODBC Data Source Administrator.

• 32-Bit System

1. Open the Control Panel

2. Select Administrative Tools > Data Sources (ODBC).

The ODBC Data Source Administrator opens.

1. Choose the System DSN tab.

• 64-Bit System

Important:  System data sources are created in the ODBCAD32  location; they may not be listed on the 

System DSN tab when you open the ODBC Data Source Administrator on a 64-bit system.

1. Click the Start button on the Windows task bar.

2. Enter the following in the Command Line  field.

c:\windows\syswow64\odbcad32.exe

1. Press Enter.
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The ODBC Data Source Administrator opens.

1. Select the DSN tab.

Result: The System Data Sources will be listed.

guide:

Guidelines

• The DSN name and location can be changed

• There are no restrictions to name or location of the DSN or databases as long as the structure and 

table names don’t change.

  

A Select MMSERV

ER.

B Click Configure.

An ODBC Microsoft Access Setup dialog box opens.
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guide:

Guidelines

• The database (.mdb) location can be changed.

For a UNC address, enter \\<Server name>\<Shared folder name>\<data>\<database filename>

• There are no restrictions to name or location of the DSN or databases as long as the structure and 

table names don’t change.

• Administration tools that are provided by Marquee Manager must be used to modify data in the 

databases.

• The default path is ..\Proficy CIMPLICITY\MARQUEEMANAGER\DATA\MMServer.MDB.

Marquee Manager Administrator: Application Folder Availability

1. Choose the MARQUEEMANAGER  application folder, which contains the Marquee Manager data 

and log files.

Following are the default paths for 32-bit and 64-bit systems.

32-bit system ..\Program Files\Proficy\Proficy CIMPLICITY\MARQUEEMANAGER

64-bit system ..\Program Files (x86)\Proficy\Proficy CIMPLICITY\MARQUEEMANAG

ER
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2. Right-click the MARQUEEMANAGER  folder.

3. Assign Full Control to the Everyone  user.

Example: Assign Sharing Permissions to the Everyone User

Do the following on a Windows 7 system; other Windows operating systems may differ slightly.

a. Select Advanced Sharing on the MARQUEEMANAGER Popup menu.

The MARQUEEMANAGER dialog box opens.

a. Select the Sharing tab.

b. Click Advanced Sharing.
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The Advanced Sharing dialog box opens.

a. Do the following.
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A Check Share this fold

er.

B Click Permissions.

A Permissions for MARQUEEMANAGER dialog box opens.

a. Assign Full Control to the Everyone  user.

a. Click OK to close the dialog boxes.

MARQUEEMANAGER is now available

Marquee Manager Administrator Configuration

Marquee Manager Administrator Configuration

• Marquee Manager Administrator Server

• Marquee Manager Administrator Devices

• Marquee Manager Administrator Marquee Types

• Marquee Manager Administrator Distribution Lists

• Marquee Manager Administrator Clients
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Marquee Manager Administrator Server

1. Do the following.

a. Expand Computer in the Workbench left-pane.

b. Double-click Marquee Manager Administrator (in the left or right-pane).

The Marquee Manager Administrator opens.

2. Click New Marquee Server on the Marquee Manager Administrator toolbar.

A Select Data Source dialog box opens.

3. Select the Marquee Manager Server data source.

Default MMSERV

ER
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4. Click OK.

Server configuration  includes the following tabs.

◦ Details Tab

◦ Settings Tab

◦ Security Tab

Details  Tab

Select the Details tab; options are as follows.
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Field Description

Server

Host 

Name

TCP/IP resolvable name for the machine running Marquee Manager Server. This will be 

in your DNS server or local host file and can be reached from the Administrator worksta

tion.

De

scrip

tion

(Optional) Additional details about the Server.

Connection

DSN Automatically entered.

User 

Name

Optional.

Pass

word

Optional.

Logging
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Field Description

Path Log Path  required to access the logs directory on the current Marquee Manager Serv

er. In most cases, if the server is locally installed this path will be a drive letter based di

rectory specification Example C:\Program Files(x86)\Proficy\Proficy CIMPLICITY\MAR

QUEEMANAGER\Logs\ If the server being managed is not the local server then this path 

will most likely be a UNC path (\\server\share\directory\), which provides access to the 

remote servers log directory. Example \\LAB1\MMServer\logs\).

Settings  Tab

Select the Settings tab.

If the Server: The Settings contain:

Has never been configured Defaults

Is already configured and opera

tional

Configured specifica

tions

Options are as follows.
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Field Description

Server

Serv

er 

Port

Port that connects to the Marquee Manager Server.  Defaults to 8011.

Li

cense 

Key

Valid Marquee Manager license key.

Delay/Timeout

Clock 

Sync

Automatically syncs the internal marquee times to that of the Marquee server. Impor

tant:  It is recommended that you run NTP (Network Time Protocol) on the Marquee 

Server machine to set the clock. This will ensure the accuracy of all marquee internal 

times. Default is 3600 seconds (1 hour).

Logging

Log 

Days

Number of days the log file will be kept before being purged. Default is 7 days.

Log 

Level

For use at the request of the Marquee Manager. In the event of any problems, CIMPLICI

TY may request additional levels of logging to assist in problem solving. Default is 0.

Maxi

mum 

Space

Amount of space to allot to the log file. Note:  This prevents the log files from consuming 

too much drive space. Default is 50 MB.

Path Path specification, local to the actual Marquee Manager Server. Note:  The path contains 

the directory where the Marquee Manager Server will store its log files.

Click Save.

Important:

If you are setting up Remote Administrator, the Settings Tab will already be populated.

Security  Tab
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If security is enabled a Login dialog box will open when a user tries to open the Marquee 

Manager Administrator window. Only users who have been configured in the Marquee Manager 

Administrator Tools: Users tree will have access.

Select the Security tab: security options for the selected server are as follows.

Field Description

Security

Mode Security options for the Marquee Manager server are as follows.

NONE Marquee Manager security is not enabled for the server.

Win

dows

A valid user name/password are required. Security is as follows.

a. A Users  folder is added to the Tools tree.

b. Users who should have access to the Marquee Manager server need to 

be added.

c. A Login dialog box opens when a user attempts to open the Alarm Ad

ministrator window.
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Field Description

Result: Listed  users with valid user names/passwords will have access to the 

server.

Win

dows 

Trust

ed

Uses a trusted domain account; does not require a password.

a. A Users  folder is added to the Tools tree.

b. Users who should have access to the Marquee Manager server need to 

be added.

Result: After a listed user logs into Windows, the user can open the Marquee 

Manager Administrator  window; a Login dialog box for the Marquee Manager 

Administrator  is not required.

De

fault

NONE

Important:

If you change the Security mode for Windows/Windows Trusted after you have registered 

users, the users will be deleted. You will have to add users who can be registered for the 

newly selected mode.

5. A Users  folder is added to the Tools tree.

6. Users who should have access to the Marquee Manager server need to be added.

7. A Login dialog box opens when a user attempts to open the Alarm Administrator window.

8. A Users  folder is added to the Tools tree.

9. Users who should have access to the Marquee Manager server need to be added.
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After a listed user logs into Windows, the user can open the Marquee Manager Administrator  window; a 

Login dialog box for the Marquee Manager Administrator  is not required.

Marquee Manager Administrator Devices

Marquee Manager Administrator Devices

• Marquee Manager: Device overview.

• Marquee Manager: Devices

Marquee Manager: Device Overview

Marquee Manager Server formats and delivers the message to the marquee. To accomplish this task, 

Marquee Manager first utilizes a concept of a Device. A Device in Marquee Manager is the physical path 

that the engine will utilize to connect to the marquee.

Using this device connection, Marquee Manager Server communicates to the marquee using the 

manufacturers protocol defined for the marquee. Once the device is named and defined, you can begin to 

add marquees.

TCP/IP:

Sample 1

Sample 2

  Serial:

Sample Serial Connection
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  FirstPAGE:

Sample Alarm Cast Connection

Marquee Manager: Device  Types

1. Click the Devices folder in the Marquee Manager Administrator left-pane.

2. Click New Device on the toolbar.

A Details tab displays.

1. Select a Communications>Type.

Marquee Manager communications types are as follows:

• Marquee MMarquee Manager Administrator

• Device: Serial.anager Administrator Device: FirstPAGE.

• Marquee Manager Administrator Device: Subscription

• Marquee Manager Administrator Device: TCP/IP.

Marquee Manager Administrator Device: TCP/IP

A Device in Marquee Manager is the physical path that the engine will utilize to connect to the marquee.

TCP/IP is the set of communications protocols used for the Internet and other similar networks. It stands 

for Transmission Control Protocol (TCP) and the Internet Protocol (IP).
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IP handles lower-level transmissions from computer to computer as a message makes its way across the 

Internet.

TCP:

• Operates at a higher level, concerned only with the two end systems (i.e. a Web browser and a Web 

server).

• Provides a reliable, ordered delivery of a stream of bytes from one program on one computer to 

another program on another computer.

• Serves as a common application for features such as:

• The Web

• Email

• File transfer

• Performs management tasks that include controlling the following:

• Message size

• Rate at which messages are exchanged

• Network traffic congestion

1. Click the Devices  folder in the Marquee Manager Administrator left-pane.

2. Click New Device on the toolbar.

A Details tab displays.

3. Select TCP/IP in the Communications>Type  field.

The TCP/IP options are as follows.
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Field Description

Device

Name Logical name utilized by the administrator to refer to this physical device. Example A 

Serial Device may be named IPSERVER10.

State Either Enabled or Disabled. Note: Multiple individual devices can be enabled/disabled by 

doing the following.

a. Select the Devices folder.

A list view displays in the right pane

a. Press Ctrl.

b. Select the devices that should be enabled/disabled.

c. Right-click the selection.

d. Select Enable, Enable All or Disable on the Popup menu.

Default is Enabled.

Communication

Type Device type to be associated with the selected Marquee. Note:  A drop-down list con

tains all available Device types.
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Field Description

Re

con

nect 

Inter

val

Rate in seconds that a device will try to reconnect when it loses connection with the 

boards. Default is 5 second intervals. Note:  If no value is set the device will try to recon

nect every second, which can cause excessive network traffic.

Host Host or IP address of the marquee's connection point.

Port Port used to connect to the terminal server or LAN.

4. Select the Devices folder.

A list view displays in the right pane

5. Press Ctrl.

6. Select the devices that should be enabled/disabled.

7. Right-click the selection.

8. Select Enable, Enable All or Disable on the Popup menu.

Default is Enabled.

9. Click Save.

The Device will now be visible under the Devices folder in the tree view.

Marquee Manager Administrator Device: Serial

1. Click the Devices  folder in the Marquee Manager Administrator left-pane.

2. Click New Device on the toolbar.

A Details tab displays.

3. Select Serial in the Communications>Type  field.

The Serial options are as follows.
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Field Description

Device

Name Logical name utilized by the administrator to refer to this physical device. Example Seri

al Device may be named SERIALCOM1.

State Either Enabled or Disabled. Note: Multiple individual devices can be enabled/disabled by 

doing the following.

a. Select the Devices folder.

A list view displays in the right pane

a. Press Ctrl.

b. Select the devices that should be enabled/disabled.

c. Right-click the selection.

d. Select Enable, Enable All or Disable on the Popup menu.

Default is Enabled.

Communication

Type Dropdown list contains all available Device types

Re

con

nect 

Rate in seconds that a device will try to reconnect when it loses connection with the 

boards. Default is 5 second intervals. Note:  If no value is set the device will try to recon

nect every second, which can cause excessive network traffic.
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Field Description

Inter

val

Port COM port to which the device is connected. Notes

◦ Available ports are in the dropdown list.

◦ More than one sign may connect through the same COM port providing a single 

connection point to these devices; this enables multiple applications to share 

them.

Speed Serial port speed. Important:  The selected speed must match the speed that the mar

quee is using. Range is 300-115200.   Default is 9600.

Flow 

Con

trol

Method with which the devices throttle the flow of send and receive data. Select one of 

the following in the dropdown list.

Hardware Uses the device’s Hardware control method

Software Uses the device’s software flow control method.

Important:  The selection must match the flow control that the Marquee is using. Default 

is set to None.

Byte 

Size

Serial port byte size settings Important:  Settings must match the settings the Marquee 

is using. Options are 7 or 8. Default is 8.

Parity Serial port parity settings Important:  Settings must match the settings the Marquee is 

using. Options are:

◦ Even

◦ Odd

◦ Mark

◦ Space

Default is None.

Stop 

Bits

Serial port stop bit settings. Important:  Settings must match the settings the Marquee 

is using. Options are:

◦ 0

◦ 1

◦ 1.5

◦ 2



Addons and Options  | 8 - Pager  | 840

Field Description

Default is 1.

4. Click Save.

The Device will now be visible under the Devices folder in the tree view.

Marquee Manager Administrator Device: FirstPAGE

1. Click the Devices  folder in the Marquee Manager Administrator left-pane.

2. Click New Device on the toolbar.

A Details tab displays.

3. Select FirstPAGE in the Communications>Type  field.

The FirstPAGE options are as follows.

Field Description

Device
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Field Description

Name Logical name utilized by the administrator to refer to this physical device. Example A se

rial device may be named RF_CONNECT.

State Either Enabled or Disabled. Note:  Multiple individual devices can be enabled/disabled by 

doing the following.

a. Select the Devices  folder.

A list view displays in the right pane.

a. Press Ctrl.

b. Select the devices that should be enabled/disabled.

c. Right-click the selection.

d. Select Enable, Enable All or Disable on the Popup menu.

Default is Enabled.

Communication

Type Dropdown list contains all available Device types.

Re

con

nect 

Inter

val

Rate in seconds that a device will try to reconnect when it loses connection with the 

boards. Default is 5 second intervals. Note:  If no value is set the device will try to recon

nect every second, which can cause excessive network traffic.

Host Host name where the Alarm Cast Server is running.

Port Defaults to 8003.

Des

tina

tion

Destination from those available in the dropdown list. Note:  These are generated from 

the Alarm Cast Destination list.

4. Click Save.

The Device will now be visible under the Devices folder in the tree view.

Marquee Manager Administrator Device: Subscription

Reserved for future use.
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Marquee Manager Administrator Marquee Types

Marquee Manager Administrator Marquee Types

A Marquee is a sign display that serves as a visualization communication tool, providing the means to 

display time, date and message text, (e.g. production counts, and what areas of a plant are experiencing 

problems).

The Marquees folder contains information pertaining to marquees and their configuration settings.

Important:

Before using Marquee Manager, you must add one or more marquees to a device. This includes 

the name, manufacturer, model, address and other specifications.

• Marquee Manager Marquee Type: Details Tab.

• Marquee Manager Marquee Type: Types Overview

• Marquee Manager Marquee Type: Andon Bin Cell

• Marquee Manager Marquee Type: Andon Char Cell

• Marquee Manager Marquee Type: Clock

• Marquee Manager Marquee Type: Color Block

• Marquee Manager Marquee Type: Controller

• Marquee Manager Marquee Type: Counter

• Marquee Manager Marquee Type: Marquee

• Marquee Manager Marquee Type: Speaker

• Marquee Manager Marquee Type: Stack Light

• Marquee Manager Marquee Type: Web

Marquee Manager Marquee Type: Details Tab

Do either of the following to begin Marquee Manager configuration.

• Select the Marquees  folder in the Marquee Manager Administrator left-pane; click New Marquee on 

the toolbar.

• Expand a Marquee  device folder in the Marquee Manager Administrator left-pane; select the 

Marquees  folder; click New Marquee on the toolbar.

Result: The selected:
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• Device type is automatically selected in the Device  field.

• Marquee type determines the additions tabs that will be available for configuration.

Details  Tab

Select the Details tab; options are as follows.

Field Description

Marquee

Name Marquee name. The name will display in the Marquee Manager Client and gateways exactly 

as it is entered in this field.

Descrip

tion

(Optional) Details to help identify the Marquee.

Device How the device is selected depends on where the marquee is added. Options are:

Device folder Device name is automatically entered

Marquee folder A Device must be selected from the dropdown list.

State Either Enabled or Disabled. Note:  Multiple marquees can be enabled/disabled/tested (e.g. 

to make firmware changes or for testing).

1. Select the Marquees  folder.
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A list view displays in the right pane.

1. Press Ctrl.

2. Select the marquees that should be enabled/disabled/tested.

3. Right-click the selection.

4. Select Enable, Disable or Test on the Popup menu

Marquee's Manufacturer's default is Test; this mode can determine if the marquee is fully 

functional. State  default is Enabled.

Type

Manu

facturer

Dropdown list contains supported manufacturers.

Model Dropdown list contains the Models specific to the manufacturer selection.

Settings

Address Each manufacturer will have a different address format  (on page 892).

Buttons

Note:  The following buttons display when the Marquee has been saved.

Clear Clears the Marquee of all messages, including those sent through Marquee Manager Client.

Refresh Refreshes the Marquee to be refreshed, maintaining all current messages that are currently 

displayed or in the queue to be displayed.

Tip:

Click the Marquee  folder in the Marquee Manager Administrator left-pane to display the list of 

marquees in the right pane.
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Marquee Manager Marquee Type: Types Overview

The range of Options you are offered for each marquee is dependent on which manufacturer and model 

you chose. Each marquee type has list of configurable options.

Andon Bin Cell Andon Char Cel   Clock Color Block   Controller   Counter   Marquee   Sounder   Stack Light

Option Definition Marquee Type

Cell 

Height

The height, in model specific units (perhaps pixels), of each cell within an 

Andon type display.

Cell 

Width

The width, in model specific units (perhaps pixels) of each cell within an 

Andon type display.

Chan

nel Info

Number of speaker channels.

Chan

nel Vol

ume

Speaker volume of specific speaker channel.
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Cyclic 

Set

tings

Tune type commands that are available. Options are:

• On duration only.

• Continuous only.

• Full cyclic tunes with on, off, and iteration control.

Default 

Delay

Length of time to wait with an empty message queue before sending the 

default message.

De

livery 

Confir

mation

Enable or disable confirmation that the message was delivered to the ap

propriate display. If delivery was unsuccessful, the logs will indicate that 

the delivery failed.

Inser

tion Or

der

Location for inserting new messages in the queue. Options are:

• LIFO: Last In First Out

The last message received is displayed first in the queue.

•  FIFO: First in First Out

Messages are displayed in the order they are received.

Justi

fica

tion/Align

ment 

Sup

port

Layout of the message on the marquee. Options on the Marquee are:

• Right-aligned

• Left-aligned

• Centered

Keep 

Alive 

Interval

Interval at which something (keep-alive) is sent to the board to avoid drop

ping the connection.

Maxi

mum 

Dura

tion

Maximum number of seconds to display the message. Default is calculat

ed as 400 milliseconds per character for the length of the roll-up message. 

Note:  Once the value is calculated, it will be increased to the min viewing 

duration if smaller, or limited to the max if larger.
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Maxi

mum 

Roll-

ups

Maximum number of roll-up pages will be sent. Note:  This is calculated af

ter a message has been broken down into pages.

Mini

mum 

Dura

tion

Minimum number of seconds to display the message. The Default is cal

culated as 400 milliseconds per character for the length of the roll-up mes

sage. Note:  Once this value is calculated, it will be increased to the min 

viewing duration if smaller, or limited to the max if larger.

Num

ber of 

Bins 

per Cell

Number of cell variables, or bins, available per cell.

Num

ber of 

Columns

Number of columns on a particular cell board.

Num

ber of 

Lines

Number of vertical lines on the marquee.

Num

ber of 

Rows

Number of rows on a particular cell board.

Num

ber of 

Slots

Number of messages in the queue that will be displayed.

Num

ber of 

Tunes

Number of tunes available for a particular sounder.

Priority 

Thresh

old

Lowest or highest priority message that will be queued and sent to the 

marquee.

Roll-up 

Wrap

Length a particular word must be in order to be split and hyphenated, rather 

than carried to the next line.
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ping 

Length

Scroll 

Mode

List of the available scroll modes for the target. The options include, en

abled, disable, or roll-up.

Sign 

Height

Height, in model specific units (e.g. pixels), of the target.

Sign 

Width

Width, in model specific units (e.g. pixels), of the target.

Slot 

Throt

tling 

Rate

Minimum time between messages sends (not yet implemented).

Time 

Format

Marquee will display in 12 or 24 hours from the Time Display drop-down.

Tune 

Auto 

Clear

Amount of time to allow a tune to play before clearing automatically.  This 

will clear the tune from the sounders queue even if the clear for it has not 

yet been processed.

Marquee Manager Marquee Type: Andon Bin Cell

Cell type displays are typically used to display data best represented in a grid format.

Example

In a manufacturing facility divided into numerous assembly stations, each cell may represent a station’s 

state. They can be used to show what station or plant location is experiencing a problem and display 

information such as the area and nature of the problem.

Cell-based displays, such as Andon and AndonQueue Boards, require specific setup to define the various 

cells and bins available to display data.

1. Select Netcon Technologies Native Unit in the Manufacturer  field.

2. Select Andon Bin Cell in the Model  field.

Andon Bin Cell configuration includes the following tabs.

◦ Details tab.

◦ Options tab.
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◦ Distribution Lists tab.

◦ Default Config tab.

◦ Bin Config tab.

Details  Tab

Complete Details  (on page 842)  tab configuration.

Options  Tab

Select the Options tab; configure the options  (on page 845)  settings according to your system 

requirements.
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Distribution  Lists

Select the Distribution Lists tab; configure the distribution lists  (on page 880)  according to your 

system requirements.

3. Click Save.

4. Highlight the cells to be configured.

5. Enter a Value in the Bin Value field.

Bin Values entered here must match the bin values that have been entered into the Andon Board’s 

on-board memory by the display installer.

Marquee Manager Marquee Type: Andon Char Cell

1. Select Netcon Technologies Native Unit in the Manufacturer  field.

2. Select Andon Char Cell in the Model  field.

Andon Char Cell configuration includes the following tabs.

◦ Details tab.

◦ Options tab.

◦ Distribution Lists tab.

◦ Default Config tab.
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Details  Tab

Complete Details  (on page 842)  tab configuration.

Options  Tab

Select the Options tab; configure the options  (on page 845)  settings according to your system 

requirements.
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Distribution  Lists

3. Select the Distribution Lists tab; configure the distribution lists  (on page 880)  according to your 

system requirements.

4. Click Save.

The Default Config tab is enabled.

Default  Config Tab

The Default Config tab is where you enter a message that will display when no active messages are being 

sent.  

Select the Default Config tab; options are as follows.
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Field Description

Configuration

Value Text that will display on the marquee when no active messages are being sent.

Foreground Foreground color options are:

• Choose a color from the dropdown list of predetermined colors.

• Click the color swatch to the right of the dropdown list; create a custom col

or.

Background Background color options are.

• Choose a color from the dropdown list of predetermined colors.

• Click the color swatch to the right of the dropdown list; create a custom col

or.

Mode Options to establish how the information will display on the marquee are:

• Static

• Flashing

• Fast Flashing

• Strobe
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• Reverse

• Reverse Flash

• Reverse Fast Flash

Font Font options are:

• Default

• Small

Justifica

tion

Message layout on the marquee. The message can be:

• Right-aligned

• Left-aligned

• Centered

Click Save.

The Marquee setup can now be viewed on the Preview tab.

Marquee Manager Marquee Type: Clock

A Clock Display is a display element specifically designed to display the time of day. The time may be 

displayed in either 12 or 24 hour format.

1. Select Clock in the Model  field.

Clock configuration includes the following tabs.

◦ Details tab.

◦ Options tab.

Details  Tab

Complete Details  (on page 842)  tab configuration.
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Options  Tab

Select the Options tab; configure the options  (on page 845)  settings according to your system 

requirements.
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2. Click Save.

The Marquee setup can now be viewed on the Preview tab.

Marquee Manager Marquee Type: Color Block

Color Block models such as the NETCON Technologies Native Unit Color Block, are typically used to 

display a block of color for the state of a plant station.

Example

In a manufacturing facility divided into numerous assembly stations, each block may represent a station’s 

state. If a station is experiencing a problem, they display a color to alert personnel.  

1. Select Netcon Technologies Native Unit in the Manufacturer  field.

2. Select Clock Block in the Model  field.

Clock Block configuration includes the following tabs.

◦ Details tab.

◦ Options tab.

◦ Distribution Lists tab.

◦ Default Config tab.
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Details  Tab

Complete Details  (on page 842)  tab configuration.

Options  Tab

Select the Options tab; configure the options  (on page 845)  settings according to your system 

requirements.



Addons and Options  | 8 - Pager  | 858

Distribution  Lists

3. Select the Distribution Lists tab; configure the distribution lists  (on page 880)  according to your 

system requirements.

4. Click Save.

The Default Config and Bin Config tabs are enabled.

Default  Config Tab

The Default Config tab is where you enter a message that will display when no active messages are being 

sent.  

Select the Default Config tab; options are as follows.
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Field Description

Configuration

Value Options are:

• ON

• OFF

Foreground Foreground color options are:

• Choose a color from the dropdown list of predetermined colors.

• Click the color swatch to the right of the dropdown list; create a custom col

or.

Back

ground

Background color options are.

• Choose a color from the dropdown list of predetermined colors.

• Click the color swatch to the right of the dropdown list; create a custom col

or.

Mode Options to establish how the information will display on the marquee are:
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• Static

• Flashing

• Fast Flashing

• Strobe

• Reverse

• Reverse Flash

• Reverse Fast Flash

Click Save.

The Marquee setup can now be viewed on the Preview tab.

Marquee Manager Marquee Type: Controller

1. Select Controller in the Model  field.

Controller configuration includes the following tabs and folders/subfolders.

Note

Folder/subfolder Tab

Controller mar

quee

Details tab.

Controller mar

quee

Options tab.

Controller tem

plate

Template Details tab.

Controller cycle Cycle Details tab.

Controller mar

quee

Default Template 

tab.

Controller Tabs

Details  Tab

Complete Details  (on page 842)  tab configuration.
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Options  Tab

Select the Options tab; configure the options  (on page 845)  settings according to your system 

requirements.
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Click Save.

Result: When the Controller marquee options have been saved, two subfolders, Templates and 

Cycles, display under the Controller marquee folder.

In order to configure the Controller marquee's Template Default tab, you must set up a New 

Template to select the template that will be used, as well as the time period or cycle for that 

template.

Template  Tabs

2. Expand a Controller  folder in the Marquee Manager Administrator left-pane.

3. Click the Templates  folder in the Marquee Manager Administrator left-pane.

4. Click New Template on the toolbar.

A Template Details tab displays; options are as follows.

Field Description

Template Details

Name Logical name to describe the marquees that will be on this template.
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De

scrip

tion

(Optional) Details to help identify the Template.

Ad

dress

ID for the template. Important:  The ID must match the Model Number that was created 

when the various models were added.  

Marquees

List List of available marquees. Check the marquees that should be added to the distribu

tion list.

Tip:

Check Show selected only to display only the marquees that will be included in the 

distribution list.

Cycle  Tabs

Defining a Cycle is only required if you to display templates in a sequence for a set duration of time.

5. Expand a Controller  folder in the Marquee Manager Administrator left-pane.

6. Click the Cycles  folder.

7. Click New Cycle on the toolbar.

A Cycle Details tab displays; options are as follows.
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Field Description

Cycle Definitions

Name Logical name to describe the Cycle.

De

scrip

tion

(Optional) Details to help identify the Cycle.

Ad

dress

ID for the template. Important:  The ID must match the Mode Number that was created 

when the various models were added to the 980 via SCC Draw and uploaded to the sign

Buttons

New Opens a Cycle Definition Details dialog box. Options are as follows.
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Template Template that will be used. Choose the template 

from the dropdown list.

Start and End Time Start  and End Time  that the cycle will run from and 

to. The times can be defined for each template 

within a cycle.  

Duration Time in seconds the template will run before run

ning the next template in the cycle.   

Up

date

Updates the list.

Delete Deletes a selected marquee.

8. Click Save.

Controller Tab

When templates and cycles are available for the Controller marquee, a default template or cycle 

can be selected.

Default  Template

Select the Controller's Default Template tab; options are as follows.



Addons and Options  | 8 - Pager  | 866

:

Field Description

Default Template

Tem

plates

a. Check Template to display a default template.

b. Select the default template in the drop down list.

Cycles a. Check Cycle to display cycles

b. Select a cycle yin the drop down list

Note:

The contents of the drop down menu will change based on which option is checked: 

Template or Cycle. It is recommended that Template 1 (Mode Number 1) be configured 

as an information template to indicate that Marquee Manager is unavailable. This can be 

blank or show a hardware default message such as Marquee Manager Unavailable.  

Default is Template 1.

When it is the default, Template 1 is labeled Default on the Default Template tab.

Click Save.
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The Controller template items are listed in the Marquee Manager Administrator left-pane.

Marquee Manager Marquee Type: Counter

1. Select Netcon Technologies Native Unit in the Manufacturer  field.

2. Select Counter in the Model  field.

Counter configuration includes the following tabs.

◦ Details tab.

◦ Options tab.

◦ Distribution Lists tab.

◦ Default Config tab.

Details  Tab

Complete Details  (on page 842)  tab configuration.

 

Options  Tab

Select the Options tab; configure the options  (on page 845)  settings according to your system 

requirements.
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Distribution  Lists

3. Select the Distribution Lists tab; configure the distribution lists  (on page 880)  according to your 

system requirements.

4. Click Save.

The Default Config tab is enabled.

Default  Config Tab

The Default Config tab is where you enter a message that will display when no active messages are being 

sent.  

Select the Default Config tab; options are as follows.
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Field Description

Configuration

Text Enter the text you want to appear on the marquee.

Foreground Foreground color options are:

• Choose a color from the dropdown list of predetermined colors.

• Click the color swatch to the right of the dropdown list; create a custom col

or.

Background Background color options are.

• Choose a color from the dropdown list of predetermined colors.

• Click the color swatch to the right of the dropdown list; create a custom col

or.

Scrolling Read-only

Mode Options to establish how the information will display on the marquee are:

• Static

• Flashing

• Fast Flashing



Addons and Options  | 8 - Pager  | 870

• Strobe

• Reverse

• Reverse Flash

• Reverse Fast Flash

Font Font options are:

• Default

• Small.

Justifica

tion

Message layout on the marquee. The message can be:

• Right-aligned

• Left-aligned

• Centered

Click Save.

The Marquee setup can now be viewed on the Preview tab.

Marquee Manager Marquee Type: Marquee

1. Select Netcon Technologies Native Unit in the Manufacturer  field.

2. Select Marquee in the Model  field.

Marquee configuration includes the following tabs.

◦ Details tab.

◦ Options tab.

◦ Distribution Lists tab.

◦ Default Message tab.

Details  Tab

Complete Details  (on page 842)  tab configuration.
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Options  Tab

Select the Options tab; configure the options  (on page 845)  settings according to your system 

requirements.
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Distribution  Lists

Select the Distribution Lists tab; configure the distribution lists  (on page 880)  according to your 

system requirements.

Default Message  Tab

Select the Default Message tab; options are as follows.

Field Description

Configuration

Text Text that will display on the marquee when no active messages are being sent.

Foreground Foreground color options are:

◦ Choose a color from the dropdown list of predetermined colors.

◦ Click the color swatch to the right of the dropdown list; create a custom 

color.

Background Background color options are.

◦ Choose a color from the dropdown list of predetermined colors.

◦ Click the color swatch to the right of the dropdown list; create a custom 

color.
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Scrolling Read-only

Mode Options to establish how the information will display on the marquee are:

◦ Static

◦ Flashing

◦ Fast Flashing

◦ Strobe

◦ Reverse

◦ Reverse Flash

◦ Reverse Fast Flash

Font Font options are:

◦ Default

◦ Small

Justifica

tion

Message layout on the marquee. The message can be:

◦ Right-aligned

◦ Left-aligned

◦ Centered

Click Save.

The Marquee setup can now be viewed on the Preview tab.

Marquee Manager Marquee Type: Speaker

The speaker models available are Static Controls’ MusicMaker, Electro-Matic’s Stack Light Sounder and 

Netcon Technologies Native Unit's Sounder.  They are typically used for speaker support. It gives the user 

up to 999 tunes to select from, depending on the model selected.

Select Sounder in the Model  field.

Sounder configuration includes the following tabs.

• Details tab.

• Options tab.

• Distribution Lists tab.

• Default Tune tab.

Details  Tab
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Complete Details  (on page 842)  tab configuration.

Options  Tab

Select the Options tab; configure the options  (on page 845)  settings according to your system 

requirements.
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Distribution  Lists

1. Select the Distribution Lists tab; configure the distribution lists, according to your system 

requirements.

2. Click Save.

3. On Duration

4. Off Duration

5. Repeat Count

ExampleIf the:

6. On Duration  setting is 5 sec

7. Off Duration  setting is 5 sec

8. Repeat Count  is 3.

Then the:Default tune will play for 5 sec and be off for 5 sec, 3 times in a row.

Marquee Manager Marquee Type: Stack Light

Stack Light models such as Electro-Matic’s Stack Light – 5 High are typically used to display colors in 

a vertical grid pattern. As with Color Block models, it may be used to show if a station is experiencing a 

problem then display a color to alert personnel.  

Select Stack Light in the Model  field.



Addons and Options  | 8 - Pager  | 876

Stack Light configuration includes the following tabs.

• Details tab.

• Options tab.

• Distribution Lists tab.

• Default Config tab.

• Light Config tab.

Details  Tab

Complete Details  (on page 842)  tab configuration.

Options  Tab

Select the Options tab; configure the options  (on page 845)  settings according to your system 

requirements.
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Distribution  Lists

1. Select the Distribution Lists tab; configure the distribution lists  (on page 880)  according to your 

system requirements.

2. Click Save.

3. On Duration

4. Off Duration

5. Repeat Count

ExampleIf the:

6. On Duration  setting is 5 sec

7. Off Duration  setting is 5 sec

8. Repeat Count  is 3.

Then the:Default tune will play for 5 sec and be off for 5 sec, 3 times in a row.

Marquee Manager Marquee Type: Web

Web models such as that supplied by the Netcon Technologies Native Unit are typically used to display 

web objects on a Video Server display.  It may be used to show multiple URLs on a Video Server and can 

be mixed with regular Andon/Marquee objects.  Marquee Manager Server sends the URL to the Video 

Server and the Video Server then connects to the web server to display it.

Select Web in the Model  field.
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Web configuration includes the following tabs.

• Details tab.

• Options tab.

• Distribution Lists tab.

• Default Config tab.

Details  Tab

Complete Details  (on page 842)  tab configuration.

Options  Tab

Select the Options tab; configure the options  (on page 845)  settings according to your system 

requirements.
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Distribution  Lists

1. Select the Distribution Lists tab; configure the distribution lists  (on page 880)  according to your 

system requirements.

2. Click Save.

Result: The Default URL tab is enabled.

Default URL  Tab

The Default URL tab defines what URL will be displayed as the default when no active messages 

are being sent.

Select the Default URL tab; options are as follows.
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Field Description

Default URL

URL URL to appear on the Video Server display when no active messages are being 

sent.

3. Click Save.

The Marquee setup can now be viewed on the Preview tab.

Marquee Manager Administrator Distribution Lists

Configured marquees can be added to distribution lists enabling the same message to be sent to multiple 

marquees with a single request.

Note:  Marquee Manager Client applications provide the ability to compose messages and send them to a 

marquee distribution list, as to gateways.

1. Click the Distribution Lists  folder in the Marquee Manager Administrator left-pane.

2. Click New Distribution List on the toolbar.

A Details tab displays; options are as follows.
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Field Description

Name Distribution List name.

De

scrip

tion

(Optional) Details to help identify the distribution list.

Back

ground

Use either method to select the background color.

◦ Choose a color from the dropdown list of predetermined colors,

◦ Click the color swatch to the right of the dropdown list; create a custom color.

Type Select which Type of Distribution List to create. Marquees that are listed in the Mar

quees  box are determined by the Type. Available options include:

◦ Bin Cell

◦ Solid Cell

◦ Stack Light

◦ Text Cell

◦ Text/Counter

◦ Tune

Mar

quees

When a Type  is selected, a list of configured marquees that are the selected type dis

plays. Check the marquees that should be added to the distribution list.
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Tip:

Check Show selected only to display only the marquees that will be included in the 

distribution list.

3. Click Save.

Distribution list details are saved.

Marquee Manager Administrator Clients

The Clients folder contains a list of applications or gateways that are using the configured marquees to 

display information. Clicking on a Client folder allows users to see what registered applications are using 

the Marquee Manager. By choosing a specific application, you can clear any transactions if the client or 

gateways lose connection to the Marquee Manager Server.

1. Click the Clients  folder.

A list of current transactions for each client displays in the right pane:

1. Select a Client from the left tree view to see the details of each transaction.

The Transaction Count displays the total number of transactions currently active on each client.

Note:

To clear all transactions for a specific client:

1. Click the host.

2. Click the Clear button.

Result: The default message for that marquee will now display

Marquee Manager Administrator Tools: Users

If Windows or Windows Trusted is selected for the server security, a Users folder is added to the Tools 

tree, if it was not already there.
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Important:

• Security is configured separately in the Marquee Manager components:

• Marquee Manager Administrator

• Marquee Gateway

• Marquee Manager Client authenticates against configured Marquee Manager Administrator users 

when Security is enabled.

• New User

• Details Tab

New User

Do the following.

A Select Users  in the Marquee Manager Administrator window left-pane.

B Click New User on the Marquee Manager Administrator window tool

bar.

Result: Tabs for the User profile display in the Alarm Cast Administrator right-pane.

Details  Tab

Details options to register Marquee Manager users are as follows.
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Field Description

User

User

name

Valid Windows user.

Do

main

Domain the user logs into.

Pass

word

(Required with Windows Security) Password assigned to the logged in Windows user.

Con

firm

(Required with Windows Security) Re-entered password.

Secu

rity

Security levels are as follows.

AD

MIN

Full rights to all features.
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Field Description

Important:

The ADMIN security level is required to access (open) applications. For almost 

all instances, it is recommended that ADMIN be assigned to registered Mar

quee Manager users.

USER Can access only the Marquee Manager Client.

DE

FAULT

USER

Notes

Notes (Optional) Additional details about or for the user.

Marquee Manager Administrator Other Tools

Marquee Manager Administrator Other Tools

There are many features that make using Marquee Manager easier and more effective that include:

• Marquee Manager Administrator: Toolbar and Tree.

• Marquee Manager Administrator: Cloning.

• Marquee Manager Administrator: Options.

• Marquee Manager Administrator: Reports.

• Marquee Manager Administrator: Log Files.

Marquee Manager Administrator Other Tools: Toolbar and Tree

Anything created on the tree view side of the screen (the left hand side) can be modified or deleted at any 

time. You can also change the state to disable.

Tree View Items: Modify

Select the item you want to alter. The information regarding it will show up on the right hand side of 

the screen. At this point, you can change the name along with any other variables attached to it (e.g. 

configuration settings etc.)When you save your changes, they will appear in the Tree View.



Addons and Options  | 8 - Pager  | 886

Important:

Information regarding manufacturer or models, cannot be altered. Once the modified information 

has been saved, you cannot revert to the old information. The only way to retrieve it is to change it 

back to its original state.

Tree View Items: Delete

There are two ways to delete items on the Tree View side of your screen. By selecting the item you want 

to delete, you can choose Edit >Delete on the Menu bar or simply click the red Delete  symbol ( X).

Important:

You cannot recover any deleted item or any information attached to it. You must recreate it.

In certain applications, if a particular item is being used in another part of the application, you will not be 

able to delete it at that level. You must go further down in the Tree View to discern where it is being used, 

and delete it there first.

Marquee Manager Administrator Other Tools: Cloning

1. Right-click the marquee that will be cloned; select Clone Marquee on the Popup menu.

A new configuration screen will display. T

Details that are not cloned are the:

◦ Name

This insures that no duplicates will be created.

◦ Device

This enables the user to select the device to which the new marquee will be connected.



Addons and Options  | 8 - Pager  | 887

◦ Address

All other details, including the default message and attributes, are cloned.

2. Click Save.

The cloned marquee is saved.

Marquee Manager Administrator Other Tools: Options

The Options menu enables users to set Marquee Manager Server details.

Click the Tools>Options on the Marquee Manager Administrator menu bar.

An Options dialog box opens; options tabs are as follows.

• General tab.

• Preference tab.

General  Tab

Select the Details tab.

Options are as follows.
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Op

tion
Description

Data 

Source

Provides the Marquee Manager Server database and user/password requirement.

Li

cense 

key.

Determines the number of servers that can be configured.

Serv

er Re

load

Provides the option to reload the server with any additions, edits or deletions automatically or 

when requested by the user.

Reload 

with every 

change

Reload will occur when the Save button is clicked.
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Op

tion
Description

Reload on

ly when re

quested

You will be informed that there are data changes the server needs to be notified 

about and have the option to either send the reload before closing or close the sys

tem without reloading the changes.

Preferences  Tab

Select the Preferences tab in the Options dialog box.

Options control the Marquee Manager Administrator data entry preferences.

You can control prompting in the event no default was supplied and specify the default attribute handling 

for marquee attributes.

Marquee Manager Administrator Other Tools: Reports

Select Tools>Reports><Report type> on the Marquee Manager Administrator menu bar.
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You can preview and print out a detailed list any of the following current features.

• Devices

• Marquees

• Distribution lists.

Marquee Manager Administrator Other Tools: Log Files

In each application, you are able to view the log files associated with the various components of the 

software. The log files contain an accurate history of every transaction and modification made to the 

database. Log files are important because they ensure the integrity of the data and provide a means of 

data recovery.

Select View to get View Server and View Admin Log options.

The selected log opens.

Marquee Manager Administrator Filter Guidelines

Click the Filters button on the selected log window toolbar.

A Marquee Manager Filter dialog box opens.
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The Events On:  field defaults to the current day.

The Status Message  field can be used to search for a portion of the message in the log.

Important:  When matching special characters, enclose them in brackets.

Example

To find all log items that start with [ enter in [[]* in the Status Message  field.

The common allowed search characters are as follows:

Field Description

Events 

On

Default is the current day.

Status 

Mes

sage

Note:  A portion of the status message can be searched in the log. Important: Only certain char

acters may be used in this field. When matching the following special characters, enclose them 

in brackets: Left Bracket ([), Question Mark (?), Number Sign (#), Asterisk (*).

Example To find all log items that start with [ enter in [[]* in the Status Message  field.

Example: Search Characters

Char

acter
Match Made Example

? Any single char

acter

Text in the log is: ABC, DBC, and XYZ. Entering ?BC returns only: ABC, DBC

* Zero or more 

characters

Entering *Initiated* returns: All log items with the word Initiated

# Any single digit 

(0-9)

Text in the log is: Device1, Device5, Device8, Device10. Entering Device# re

turns: Device1, Device5, Device8.

Check Automatic Refresh to automatically refresh the log file based on the seconds specified.

Marquee Manager Administrator Technical Reference

Marquee Manager Administrator Technical Reference
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• Marquee Manager Administrator: Manufacturers Address Formats

• Marquee Manager Administrator: Sign Properties

• Marquee Manager Administrator: Insertion Tags

Marquee Manager Administrator: Manufacturers Address Formats

Manufacturer Address Format

Adaptive Alpha 

Version 2

2-digit hex from the display Range = 00-FF e.g. 01

Adaptive Micro 

Systems

2-digit hex from the display Range = 00-FF e.g. 0A

Allen-Bradley In

view

2-digit hex from the display Range = 00-FF e.g. 0C

Electro-Matic 

Products Inc.

Stack Light & Sounder: group:unit hex Range = 00-FF for group and unit 4-digit dis

play: 2-digit hex from the display Range = 00-FF e.g. 03

NETCON Tech

nologies Native 

Unit

Fixed length 4-character address field. First two bytes represent group, second two 

bytes represent unit. Valid values 00-FF. All characters in uppercase. e.g. 01:EF

Nu-Media Dis

play Systems

8-bit addressing where group = 0 2-digit hex value e.g. 01

Static Controls 

Corporation

group:unit hex Range = 00-FF for group and unit e.g. 01:FF

Uticor Technolo

gy

group:unit with 00:0000 format e.g. 00:0003

You can use the number zero as a wildcard character when searching for an unknown address. e.g. 01 will 

return all addresses with two digits where the last digit is 1.

Marquee Manager Administrator: Sign Properties

Sign properties include the following.

• Adaptive ALPHA VERSION 2

• Adaptive Micro Systems

• ALLEN-BRADLEY INVIEW
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• Electro-Matic Products Inc.

• NETCON Technologies Native Unit

• NU-MEDIA DISPLAY SYSTEMS*

• STATIC CONTROLS CORPORATION

• Uticor Technology 

Adaptive ALPHA  VERSION 2

Model Color Font Scrolling Flashing Notes

BIGDOT 

13Char

Tri-color Double Height   Supports Rollup

BIGDOT 

26Char

Tri-color Small, Fixed Width, Bold   Supports Rollup

Adaptive Micro  Systems

Model Color Font Scrolling Flashing Notes

ALL Tri-color Small, Bold, Fixed Width ü ü

Beta-Brite Tri-color Small, Bold, Fixed Width ü ü

BIGDOT Tri-color Small, Bold, Fixed Width ü ü

BIGDOT_

26Char

Tri-color Small, Bold, Fixed Width ü ü

PPD Small, Bold, Fixed Width ü  Red and green models

215 Tri-color Small, Bold, Fixed Width  

215C Tri-color Small, Bold, Fixed Width  

320C Tri-color Small, Bold, Fixed Width  

330C Tri-color Small, Bold, Fixed Width  

4080C Tri-color Small, Bold, Fixed Width  

4120C Tri-color Small, Bold, Fixed Width  

4120R Red Small, Bold, Fixed Width  

4160C Tri-color Small, Bold, Fixed Width  

4160R Red Small, Bold, Fixed Width  
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Model Color Font Scrolling Flashing Notes

4200C Tri-color Small, Bold, Fixed Width  

4200R Red Small, Bold, Fixed Width  

4240C Tri-color Small, Bold, Fixed Width  

4240R Red Small, Bold, Fixed Width  

7120 Tri-color Small, Bold, Fixed Width  

7160 Tri-color Small, Bold, Fixed Width  

7200 Tri-color Small, Bold, Fixed Width  

7200_4Line Tri-color Small Caps  

9120 Tri-color Small, Bold, Fixed Width  

9160 Tri-color Small, Bold, Fixed Width  

9200 Tri-color Small, Bold, Fixed Width  

9240 Tri-color Small, Bold, Fixed Width  

ALLEN-BRADLEY  INVIEW

Model Color Font Scrolling Flashing Notes

P42C Tri-color Small, Fixed Width, Bold  

P42R Red Small, Fixed Width, Bold  

P43C Tri-color Small, Fixed Width, Bold  

P43R Red Small, Fixed Width, Bold  

P44C Tri-color Small, Fixed Width, Bold  

P44R Red Small, Fixed Width, Bold  

P72CN2/1 Tri-color Small, Fixed Width, Bold   3 line/20characters

P72CN2/1- 4 line Tri-color Small Caps   4 line/20 charac

ters

P74CN2/1 Tri-color Small, Fixed Width, Bold   3 line/33 charac

ters
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Model Color Font Scrolling Flashing Notes

P74CN2/1 – 4 line Tri-color Small Caps   4 line/33 charac

ters

Electro-Matic  Products Inc.

Model Color Font Scrolling
Flash

ing
Notes

4 Digit Dis

play

Red Fixed 

Width

ü  ü  4 characters-Al

pha or numeric

Stack Light 

– 1 High

Blue, Brown, Green, Light Green, Light Red, 

Orange, Red, White, Yellow

N/A N/A 

Stack Light 

– 2 High

Blue, Brown, Green, Light Green, Light Red, 

Orange, Red, White, Yellow

N/A N/A 

Stack Light 

– 3 High

Blue, Brown, Green, Light Green, Light Red, 

Orange,  Red, White, Yellow

N/A N/A 

Stack Light 

– 4 High

Blue, Brown, Green, Light Green, Light Red, 

Orange, Red, White, Yellow

N/A N/A 

Stack Light 

– 5 High

Blue, Brown, Green, Light Green, Light Red, 

Orange, Red, White, Yellow

N/A N/A 

Stack Light - 

Sounder

Blue, Brown, Green, Light Green, Light Red, 

Orange, Red, White, Yellow

N/A N/A N/A 1 tune played

NETCON  Technologies Native Unit *

Model Color Font Scrolling
Flash

ing
Notes

Clock N/A N/A ü ü Displays time only

Counter Red Fixed 

Width

ü ü Numeric only Max. 8 digits # of  Characters can be set on 

the Options tab in Marquee Administrator

Mar

quee

Mul

ti-Col

or

Fixed 

Width

  Supports Rollup # of Lines and  Characters can be set on the 

Options tab in Marquee Administrator



Addons and Options  | 8 - Pager  | 896

Model Color Font Scrolling
Flash

ing
Notes

Sounder N/A N/A N/A N/A 255 Tunes

NU-MEDIA  DISPLAY SYSTEMS*

Model Color Font Scrolling Flashing Notes

v4.67 Single Line Red Double Height  

v4.67 Dual Line Red Small, Fixed Width, Bold  

STATIC CONTROLS  CORPORATION

Model Color Font Scrolling
Flash

ing
Notes

Alpha 952_20 Red Fixed 

Width

ü  one line 20 characters

Alpha 952_25 Red Fixed 

Width

ü  one line 25 characters

Alpha 952_40 Red Fixed 

Width

ü  one line 40 characters

Alpha 954_10 Red Fixed 

Width

 

Andon 974_0206 Mul

ti-color

N/A ü  Cell board  size: 2 rows, 6 columns

Andon 974_0307 Mul

ti-color

N/A ü  Cell board size: 3 rows, 7 columns

Andon 974_0308 Mul

ti-color

N/A ü  Cell board size: 3 rows, 8 columns

Andon 974_0408 Mul

ti-color

N/A ü  Cell board size: 4 rows, 8 columns

Andon 974_0420 Mul

ti-color

N/A ü  Cell board size 4 rows, 20 columns
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Model Color Font Scrolling
Flash

ing
Notes

AndonQueue 

974_0206

Mul

ti-color

Fixed 

Width

ü  Cell board  size: 2 rows, 6 columns

AndonQueue 

974_0307

Mul

ti-color

Fixed 

Width

ü  Cell board size: 3 rows, 7 columns

AndonQueue 

974_0308

Mul

ti-color

Fixed 

Width

ü  Cell board size: 3 rows, 8 columns

AndonQueue 

974_0408

Mul

ti-color

Fixed 

Width

ü  Cell board size: 4 rows, 8 columns

AndonQueue 

974_0420

Mul

ti-color

Fixed 

Width

ü  Cell board size: 4 rows, 20 columns

AndonQueue 

974_0614

Mul

ti-color

Fixed 

Width

ü  Cell board size: 6 rows, 14 columns

ColorBlock 

974_0104

Mul

ti-color

N/A ü  ColorBlock board size: 1 row, 4 columns

ColorBlock 

974_0404

Mul

ti-color

N/A ü  ColorBlock board size: 4 rows, 4 columns

Marquee 

955GM_0120

Mul

ti-color

Fixed 

Width

ü  GM specific SCC protocol: 1 line, 20 char

acters

Marquee 

955GM_0125

Mul

ti-color

Fixed 

Width

ü  GM specific SCC protocol: 1 line, 25 char

acters

Marquee 

955GM_0133

Mul

ti-color

Fixed 

Width

ü  GM specific SCC protocol: 1 line, 33 char

acters

Marquee 

955GM_0135

Mul

ti-color

Fixed 

Width

ü  GM specific SCC protocol: 1 line, 35 char

acters

Marquee 

955GM_0140

Mul

ti-color

Fixed 

Width

ü  GM specific SCC protocol: 1 line, 40 char

acters

Marquee 

955GM_0225

Mul

ti-color

Fixed 

Width

ü  GM specific SCC protocol: 2 line, 25 char

acters/line
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Model Color Font Scrolling
Flash

ing
Notes

Marquee 

955GM_0235

Mul

ti-color

Fixed 

Width

ü  GM specific SCC protocol: 2 line, 35 char

acters/line

Marquee 

955GM_0240

Mul

ti-color

Fixed 

Width

ü  GM specific SCC protocol: 2 line, 40 char

acters/line

MusicMaker_AC1 N/A N/A N/A N/A 255 tunes

Num 801_N Red Fixed 

Width

ü ü Numeric only

SCC980_Controller N/A N/A N/A N/A Template switching controller

Tim 801_T ü  ü Displays time only

Uticor  Technology 

Model
Col

or
Font Scrolling

Flash

ing
Notes

Uticor Client  3000 – 1 line Red Small, Double Height, Full 

Height

 

Uticor Client  3000 – 2 line Red Small, Double Height, Full 

Height

 

Uticor Client  3000 – 4 line Red Small, Double Height, Full 

Height

 

Uticor Client  3000 Double Wide – 1 

line

Red Small, Double Height, Full 

Height

 

Uticor Client  3000 Double Wide – 2 

line

Red Small, Double Height, Full 

Height

 

Uticor Client  3000 Double Wide – 4 

line

Red Small, Double Height, Full 

Height

 

• For all supported signs, only the bottom line of the sign supports the scrolling feature.
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• If the default message is changed, the Allen-Bradley Inview sign will reboot itself.  With Allen-

Bradley signs, there is no address field passed to specify on which display you want to set the 

default message. 

Marquee Manager Administrator: Insertion Tags

Tag Description Attributes Available

COL Color #rrggbb RGB in uppercase hex

AMB Amber

BLK Black

BLU Blue

BRN Brown

CLR Clear

DEF Default

GRN Green

LGR Light green

ORG Orange

RED Red

WHI White

YLW Yellow

BCL Background 

color

Same as COL

FNT Font BLD Bold

CAP All Capitols

DEF Default

Fix Fixed Width

SML Small

JST Justification CEN Center

DEF Default
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Tag Description Attributes Available

LEFT

RIGHT

MOD Mode DEF Default

FFL Fast flash

FL Flash

REV Reverse

RFF Reverse fast flash

RFL Reverse flash

ST Static

STR Strobe

SCR Scrolling DEF Default

FAST (or SCR-2)

MED (or SCR-1)

S Static

SLOW (or SCR-0)

DATE Date DATE DD/MM/YY DD/MM/YYYY DD-MM-YY DD-MM-YYYY MM/DD/YY 

MM/DD/YYYY MM- DD-YY MM-DD-YYYY YY/MM/DD YY-MM-DD YYYY/MM/DD 

YYYY-MM-DD <DATE-DDD> <DATE-DDDD>

TIME Time 12 24 TIME

WRAP Wrap long line 

around on mul

ti-line text mar

quee.

Only applies to multi-line Text Displays. All <LIN-##> tokens will be removed 

and the most text that can be displayed across all lines on the display will be 

shown. Any resulting text that exceeds the displays capabilities will be truncat

ed.

Marquee Manager Administrator Glossary
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Administrator

Typically a GUI application, this component facilitates configuration and monitoring of a server engine. If 

changes are made to the server configuration the administrator notifies the engine to reload its running 

configuration either automatically or on user demand. An example of an administrator component is 

Marquee Manager Administrator.

This administrator allows you to maintain the Marquee Manager server's engine configuration.

Administrator Kit

An administrator kit contains the product's administration component only. After installing this kit on a 

workstation you may utilize any of the features of the Administrator component.

Andon

Andon boards are used to show where (station or location) there is a problem (fault) or a potential 

problem (blocked or starved station or low on stock). They are used to alert the proper personnel that 

something needs their attention - either immediate or in the near future. A marquee may be used to 

give mention to upcoming meetings, or events and can display the time, date, number of parts that are 

expected and actually produced. Basically, they are a visual communication tool used to help production 

meet their goals and minimize shut down time.

Bin

An area within each cell that contains data relevant to various locations in an environment. (e.g. plant 

stations such as paint) and various statuses typically used in these areas. Data such as current station 

state or a station that may be experiencing a problem may be displayed on the Andon Board.  

Cell

For Andon type marquee signs, a cell refers to one block of data on the sign.

Client

A client component utilizes the facilities of a standard Marquee Manager server. Typically a GUI 

application, this component provides a user-friendly interface of the available services offered by the 

server engine.

Cycle

The time period defined for the display of Controller 980 templates, allowing the display of multiple screen 

templates in sequence.
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Device

A Marquee Manager Server device is a name assigned to a physical connection point on the server, which 

will be used to establish a connection with a marquee.

Distribution List

A Marquee Manager Server distribution list is a collection of marquees, which can be sent a message 

with a single transaction. Similar to an email distribution list, a client which initiates a transaction with a 

distribution list will automatically send the same message to all associated marquees.

DSN

A DSN, Data Source Name, is the name assigned to an ODBC driver and configuration information that 

allows an ODBC enabled application to connect to a data source.

Engine

An engine component implements a unified interface to a set of common, related protocols. The engine 

provides services to clients and gateways such that a common interface may be used to manipulate 

many different types of devices. Engines are administered via Administrator components and are utilized 

by clients, gateways or user written components.

Gateway

A gateway component creates a bridge between a third party product and a standard CIMPLICITY server. 

Typically an engine, this component provides a conduit for forwarding events from the third party product 

into a CIMPLICITY standard server.

An example of a gateway would be an interface to an HMI or SCADA system forwarding events from 

that system to Marquee Manager Alarm Manager for processing. An example of a gateway is Marquee 

Manager Gateway for ActivPlant. This gateway forwards ActivPlant incidents to Marquee Manager.

Marquee

A sign display that serves as a visualization communication tool, providing the means to display time, 

date and message text such as production counts, and what areas of a plant are experiencing problems.

ODBC

The ODBC protocol is an implementation of the Microsoft ‘Open Database Connectivity’. The ODBC API is 

utilized to access the Marquee Manager configuration database.
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Priority Threshold

The importance or priority that is given to each marquee. This number is taken into consideration when 

assigning messages to that marquee, with regards to which messages hold greater importance and when 

that message will display.

Example

If your marquee has a priority threshold set to three, all messages with a priority of three or higher (and 

only those messages) will be displayed.  When they have been acknowledged and are no longer being 

displayed, any other messages with a lower priority will then start displaying on the marquee.

Server Kit

A server kit typically contains the server engine and administrator components. In some cases a client 

component is also included with this kit. The server kit is usually installed on a centralized host and is 

utilized by one or more clients or gateways. An example of a server kit is Marquee Manager Server. This 

kit contains the Marquee Manager engine, administrator and client.

Stack Light

Stacked lights typically used to display colors in a vertical grid pattern from one to five lights high.  They 

may be used to show if a station is experiencing a problem then turn a light on to alert personnel.  

Template

A user formatted guide or page of configured marquees, allowing you to display a page at any given time 

without the need to customize each marquee.

Marquee Manager Gateway

About Marquee Manager Gateway

The following topics contain an overview of the CIMPager product, detailed installation instructions, and 

administration user instructions.

• Marquee Manager Gateway: Key Features

• Marquee Manager Gateway: How it Works

• Marquee Manager Gateway Components
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• Marquee Manager Gateway Tools: Users

• Marquee Manager Gateway for CIMPLICITY Other Tools

• Marquee Manager Gateway Insertion Tag List

• Marquee Manager Gateway Glossary

Marquee Manager Gateway: Key Features

Marquee Manager Gateway for CIMPLICITY is a marquee administration system that allows users 

to easily configure various rules that once triggered will display a message to a variety of different 

marquees, using a simple generic language.

Key Features:

• Local project configuration management

• Support for both scrolling marquees and Andon type marquees

• Support for speaker and marquee on any alarm

• Hot reload of configuration information

• Default messages can be configured for display when no alarms are currently active on a marquee

• Support for embedded point values in alarm messages

• Support for alarm values to be inserted into the alarm message

• Multiple CIMPLICITY projects can populate a shared Marquee Server. 

• Wrapping of alarm text messages and defaults for message lengths - may be specified per 

individual marquee including word wrap rules
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• If a Marquee Server connection is lost, the Gateway for CIMPLICITY will queue marquee requests 

until the server is back on-line.

• Support for multiple projects per machine (Version 6.1 or higher)

Marquee Manager Gateway: How it Works

Marquee Manager Gateway for CIMPLICITY is another product in the Marquee Manager Suite of products 

and may reside on your Marquee Manager Server or access a Marquee Manager Server over a LAN or 

WAN connection.

The Marquee Manager Gateway for CIMPLICITY provides a bridge between CIMPLICITY project alarms 

and your Marquee Manager Server.  Various routing rules can be defined by selecting available Resources, 

Alarms, Classes and alarm message text that have been configured in your CIMPLICITY project.  When 

one of these rules is met, message text can be dispatched to your Marquee Manager Server, including 

embedding alarm and point values within the message text.

There are four valid alarm states that may be configured for each Routing Rule:

Generate The alarm becomes active by meeting the rules defined in the CIMPLICITY Point Properties 

dialog box> Alarm tab.

Acknowl

edged

The alarm is Acknowledged by an operator with Alarm Viewer or the point is set up to Auto 

Ack in the Alarm Options of that point.

Reset The alarm is back within normal parameters or the point is set up to Auto Reset under the 

Alarm Options of that point.

Delete The alarm has met the rules under the Deletion Requirements in the Alarm Options.
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Marquee Manager Gateway Components

Marquee Manager Gateway Components

• Marquee Manager Gateway Server

• Marquee Manager Gateway Routing Rules

• Marquee Manager Gateway Defaults

• Marquee Manager Gateway  Insertion Tags

Marquee Manager Gateway Server

• Marquee Gateway Pre-configuration

• Marquee Gateway Administrator

Marquee Gateway Pre-configuration

Marquee Gateway Enabled
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1. Open the appropriate CIMPLICITY project in the Workbench.

2. Click Project>Properties on the Workbench menu bar.

The Project Properties dialog box opens.

3. Select the General tab.

4. Check Marquee Gateway.

Remote Client

5. Expand Project >Security>Advanced in the Workbench left-pane.

6. Double-click Client.

A New Client dialog box opens.

7. Enter the Computer  name in the Computer field.

8. Click OK.

The client Properties dialog box opens.

9. Enter the following.
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A Enter ADMINISTRA

TOR.

B Check Trusted.

Marquee Gateway Administrator

10. Start the CIMPLICITY project.

11. Stop the MMGATEWAY  process, as follows.

a. Expand Runtime in the Workbench left-pane; double-click Process Control.

The CIMPLICITY Process control dialog box opens.

a. Do the following.

a. Select MMGAMGATEWAY.

b. Click Stop Process.

The MMGAMGATEWAY  process is halted.

12. Open the Marquee Gateway, as follows.

a. Expand Project>Equipment>Marquee Gateway in the Workbench left-pane.

b. Select Administrator.

c. Double-click Administrator  in the Workbench right-pane.

Result: The Marquee Manager Gateway opens.

Note:  Click the Save button on the Marquee Manager Gateway toolbar if the window is empty when 

it first opens.

The Marquee Manager Gateway for CIMPLICITY user interface conveniently displays all 

information in a tree view which, when expanded, shows the current sign default message or the 



Addons and Options  | 8 - Pager  | 909

current active message of the sign. It includes a Routing Rules folder, and a Marquees folder that 

displays Marquees that have already been configured in the Marquee Manager Administrator.

Marquee Gateway Server  configuration includes the following tabs.

◦ Details tab

◦ Settings tab

◦ Security tab

◦ CIMPLICITY tab

Details  Tab

Select the Details tab; options are as follows.

Field Description

Gateway Server

Project 

ID

Automatically assigned when the new server has been saved.

Project 

Name

Automatically entered. Note:  This is the same name as the name of the project that 

was opened in the Workbench.  

Connection

DSN Automatically entered when the server is saved.
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Field Description

User 

Name

Optional.

Pass

word

Optional.

Settings  Tab

Select the Settings tab; options are as follows.

Field Description

Server

Server 

Port

(Automatically entered) default value in the range from 8050 to 8069. Important

◦ Each project must have a unique port assigned to it.

◦ Keep the value the system assigns unless instructed by CIMPLICITY to do 

otherwise.

License 

Key

Valid Marquee Gateway for CIMPLICITY license key

Alarm Cast Alarm Manager Server
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Host 

Name

TCP/IP resolvable name for the machine running the Marquee Manager Server.

Server 

Port

Port that connects to the Marquee Manager Server. Default is 8011.

Logging

Log Days Number of days the log file will be kept before being purged.   Default is 7 days.

Log Level For use at the request of the Marquee Manager. In the event of any problems, CIM

PLICITY may request additional levels of logging to assist in problem solving. De

fault is 0.

Maxi

mum Log 

Space

Amount of space to allot to the log file. Note:  This prevents the log files from con

suming too much drive space. Default is 50 MB.

Path Path to the directory where the Marquee Manager Server will store its log files. Im

portant:  The path should reflect a directory on the CIMPLICITY project server..

Security  Tab

Select the Security tab; options are as follows.

Field Description
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Security

Mode Security options for the Alarm Cast Gateway server are as follows.

NONE Alarm Cast Gateway security is not enabled for the server.

Win

dows

A valid user name and password are required. Security is as follows.

a. A Users folder is added to the Tools tree.

b. Users who should have access to the Alarm Gateway server need to be 

added.

A Login dialog box opens when a user attempts to open the Alarm Cast Gate

way window.

Result: Listed users with valid user names/passwords will have access to the 

server.

Win

dows 

Trusted

Uses a trusted domain account; does not require a password.

a. A Users folder is added to the Tools tree.

b. Users who should have access to the Alarm Gateway server need to be 

added.

Result: After a listed user logs into Windows, the user can open the Alarm Cast 

Gateway window; a Login dialog box for the Alarm Cast Gateway is not required.

Default NONE

CIMPLICITY  Tab

13. A Users folder is added to the Tools tree.

14. Users who should have access to the Alarm Gateway server need to be added.

A Login dialog box opens when a user attempts to open the Alarm Cast Gateway window.
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15. A Users folder is added to the Tools tree.

16. Users who should have access to the Alarm Gateway server need to be added.

17. Select the CIMPLICITY tab; options are as follows.

Field Description

CIMPLICITY

Ignore Alarm 

ACK

Alarm does not need to be acknowledged by an operator to suppress messag

ing Note:  The message will be suppressed even if ACK is required in the alarm’s 

CIMPLICITY configuration.
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Terminate be

tween state 

changes

Stop messaging from escalating further when the alarm state changes.   Mes

saging will commence at level one for the alarm on each state change.   

ACK Termi

nate Alarms

Terminate an alarm when the engine receives an ACK.

18. Click Save on the Marquee Manager Gateway toolbar.

19. Restart the MMGGATEWAY  process in the CIMPLICITY Process Control dialog box.

A Project ID now displays on the Gateway Server Details tab.

Marquee Manager Gateway Routing Rules

1. Click the Distribution Lists  folder in the Marquee Manager Gateway left-pane.

2. Click New Rule on the toolbar.

Routing rules configuration includes the following tabs.

◦ Routing Rule Details tab.

◦ Routing Rule Generated Tab

◦ Routing Rules Acknowledged Tab

◦ Routing Rules Reset Tab

◦ Routing Rules Deleted Tab

Routing Rule Details  Tab

Select the Rule Details tab; options are as follows.
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Field Description

De

scrip

tion

Description for the rule. This should be a logical name to describe the data that will be 

met with this rule.

Alarm 

Load 

button

Click the Alarm Load button to load the alarms from the CIM

PLICITY server and populate the drop downs with the available 

Resources, Alarms, and Classes.

Re

source/Alarm/

Class

Drop down lists contain resources, alarms and classes that have been configured in the 

CIMPLICITY project.

Mes

sage

Part of the message text configured in the CIMPLICITY Point Properties dialog 

box>Alarm tab to filter the alarms returned that match the rule.

Sup

pres

sion 

Point

(Check to enable the field) Points are used for suppression in the Marquee Manager 

Gateway for CIMPLICITY.

Click the Suppression Point button to open a Browse Server 

browser that lists available points.
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Field Description

When suppression is configured and a point evaluates to match one of the following 

values, the associated effect will be applied:

1 Marquee (displayed items, e.g. Andon cells)

2 Tune (sounds)

3 Sum of the values for multiple items to be suppressed (Marquee and 

Tune suppression)

4 Controller (template switch)

Example A tune is playing because a fault has occurred. Plant floor persons are aware 

of the fault. A plant floor person can push a button on an HMI that sets the Suppression 

point to the value 2 and temporarily turn off the tunes.

Important:

Point ID lengths can have a maximum of 255 characters.

guide:

Guidelines: Details tab

◦ The Gateway for CIMPLICITY supports CIMPLICITY wildcards for these fields where * 

matches multiple characters and ? matches single characters. 

Examples

TANK*  matches all tanks.

TANK?0  matches only tanks ending with 0 (e.g. TANK10, TANK20).

◦ The Message: field enables a user to specify a portion of the message text configured in the 

alarm details of point’s properties to narrow the alarms returned that will match the rule.

By default the Message  field value is the wildcard *, effectively matching all messages.

Example

To display only alarms with text including the word HIGH, you could customize the Message  field to 

show *HIGH*.
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◦ Alarm states can send to a marquee, including Andon type boards, a speaker or both. This 

may be edited in each alarm state as one of the following.

◦ Generated

◦ Acknowledge

◦ Reset

◦ Deleted

Routing Rules Generated  Tab

The Generated tab provides the options to specify where the message will be displayed and details 

for that marquee/speaker. 

Select the Generated tab; options are as follows.

Field Description

Status

Check one of the following.

Marquee

Tune

◦ Controller
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Default Marquee/No Operation

Configuration

Priority Order in which messages sent to the marquee will be displayed. Highest priority mes

sages are 1. Lowest priority messages are 9. Default is 9.

Mar

quee

Marquee to which the message will be sent.

Note:

The message can be displayed to either a Group or Distribution List that has 

been configured for the Marquee Manager Administrator.

Check Distribution List to display a list of available groups.

Text Text to display on the marquee. Valid entries are:

◦ Point values

Point values can be inserted in the alarm text with the following syntax:  {POIN

T.pointname}.

◦ Alarm values

◦ Regular text

Text can either be:

◦ Entered manually, using the values shown in the table below

or

◦ Chosen from the drop down menu that displays when you type {.

Important:

Point lengths can have a maximum of 255 characters.

Fore

ground

Use either method to select the foreground color.

◦ Choose a color from the dropdown list of predetermined colors,

◦ Click the color swatch to the right of the dropdown list; create a custom color.

Back

ground

Use either method to select the background color.

◦ Choose a color from the dropdown list of predetermined colors,

◦ Click the color swatch to the right of the dropdown list; create a custom color.

Scrolling Options are:

◦ Default

◦ No Scrolling

◦ Slow Speed
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◦ Medium Speed

◦ Fast Speed.

Font Font options are:

◦ Default

◦ Small

Mode The dropdown list contains the following choices to establish how the information 

will display on the marquee. Static

◦ Flashing

◦ Fast Flashing

◦ Strobe

◦ Reverse

◦ Reverse Flash

◦ Reverse Fast Flash

Justifi

cation

Message layout on the marquee. The message can be:

◦ Right-aligned

◦ Left-aligned

◦ Centered

Note:

Guidelines: Generated tab

◦ Marquee Manager Gateway for CIMPLICITY allows the configuration of additional insertion 

tags to the default message. 

Value Result

{ALARM.NAME} Alarm name

{POINT.XXX} Point name where XXX is the point name that must be entered by the 

user.

{ALARM.RESOURCE} Associated resource name for alarms

{ALARM.CLASS} Associated alarm class

{ALARM.MESSAGE} Alarm message text from the Alarm tab in the alarm’s configuration

{ALARM.STATE} One of GEN, RST, ACK or DEL

{ALARM.SYSTEM} Project name
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◦ (Optional) A maximum length parameter in the format of {CLASS.XXX[:max-length]}  allows 

you to specify the number of characters that will be displayed for that Point value. 

◦ The format is:

CLASS.XXX[:max-length]}

◦ The valid range is 0 to 1024.

Example

ALARM.RESOURCE:6}  will display only 6 characters of the alarm resource point value.

◦ Additional configuration includes the following.

a. When sending a message to a group, only the common colors, fonts, scrolling attributes and 

modes will be displayed in the drop down menus.  If only one color, font, scrolling attribute 

or mode exists among all signs in a group, the dropdown list will default to that.  

{Default}  will also be available to default these attributes to that of the manufacturer.

Depending on the marquee selected, the Preview section will display the available Lines that may 

be configured.

a. If a Group is added with marquees that contain one and two-line signs, the Preview will only 

have one line available for configuration.

Example

A Group contains a two-line Numedia and a Static Controls 952 one-line.

The preview will only display one line available for configuration.

a. Click the Change Tune button and/or the Template button if a tune or a template should play 

when an alarm is generated. This can be selected in addition to displaying the message on 

the selected marquee.

Marquee, speaker and template buttons will then be available to toggle between configurations.

Marquee Manager Gateway Generated: Template

Click the Template  icon to configure the template that will play.

Template options are as follows.
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Field Description

Con

troller

Select from the dropdown list. Note:  The controllers were configured for the Marquee 

Manager Administrator.

Tem

plate

Select from the dropdown list. Note:  The templates were configured for the Marquee 

Manager Administrator.

Routing Rules Generated: Speaker

Click the Speaker  icon to configure a tune that will play.  

Speaker options are as follows.
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Field Description

Priority Order in which messages sent to the marquee will be displayed. Highest priority mes

sages are 1. Lowest priority messages are 9. Default is 9.

Speak

er

Select the from the dropdown list.   Note:  The list includes all sounder models that have 

been configured in Marquee Manager Administrator.

Play 

Dura

tion

Select one of the following to specify the amount of time the tune will play.

◦ Continuously.

◦ For a specific duration of time; enter in the seconds the amount of time the tune 

will play.

Routing Rules Acknowledged  Tab

The Acknowledged tab enables users to configure details for alarms that have been 

acknowledged.

Select the Acknowledged tab; options are as follows.
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guide:

Guidelines: Marquee Manager Gateway Acknowledged

◦ Follow the steps for configuring the Marquee Manager Gateway Routing: Generated Tab to 

set the display attributes for alarms that have been acknowledged.

Example

The Change Display feature for acknowledged alarms could be used to change the message from 

Red to Yellow to indicate it was acknowledged.

Important:

Point ID lengths can have a maximum of 255 characters. Point IDs can be entered into Text 

fields that display when Marquee and/or Tune are checked.

◦ Default is No Operation for both Marquees and Tunes.

Routing Rules Reset  Tab

The Reset tab enables users to configure details for alarms that have been reset.

Select the Reset tab.
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guide:

Guidelines: Marquee Manager Gateway Reset

◦ Follow the steps for configuring the Marquee Manager Gateway Routing: Generated Tab to 

set the display attributes for alarms that have been reset.

Note:

Point ID lengths can have a maximum of 255 characters. Point IDs can be entered into Text 

fields that display when Marquee and/or Tune are checked.

◦ Default is No Operation for both Marquees and Tunes.

Routing Rules Deleted  Tab

The Deleted tab enables users to configure details for alarms that have been deleted.

Select the Deleted tab.
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guide:

Guidelines: Marquee Manager Gateway Deleted

◦ The status for alarms that have been deleted cannot be changed.

Note:  This is the last opportunity the gateway will have to take the message down or stop the 

speaker from playing a tune.

◦ Default is Clear Display and Clear Tune for both Marquees and Tunes.

Click the Save  icon on the Marquee Manager Gateway for CIMPLICITY window toolbar to save the 

routing rule.

Marquee Manager Gateway Defaults

The Marquees folder allows users to add and maintain default messages on each marquee that has been 

configured in Marquee Manager Administrator.

The default configuration allows you to set word wrapping details for multiple line marquees, taking long 

messages values such as {ALARM.MESSAGE}  and wrapping them across multiple lines.

Marquee Manager Gateway: Add a Marquee Default
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1. Expand the Marquees folder.

2. Select a configured marquee to which a default message should be sent.

Options are as follows.

Field Description

Configuration

Line 

Length

Display line number of characters determines when to wrap the message to the next 

line. Note:  The number can be entered or selected by scrolling the field.

Word 

Wrap 

Length

Where to divide a word to wrap it to the next line.

a.  Words longer than this value will be broken with a – at a point that is equal to 

or less than the value.

b. The remaining portion will be wrapped to the next line. (See Note below for ad

ditional details)

If the last word on line 1 is broken with a - and it exceeds the word wrap length, the 

whole word will be wrapped to the next line based on what is configured in the Word 

Wrap Length  field. Example

◦ A message to be displayed is:“My MMSGWCIMP Test Message”

◦ Line Length set to 20.

◦ Word Wrap set to 6.
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Field Description

Normally Message would be broken with a - since it is longer than 6 characters; how

ever, as the break would leave less than 4 characters on line 1, the whole word Mes

sage will get bumped to the next line.

Default Message

Text Text for the marquee’s default message. Notes

◦ The default message for a marquee will display if no alarms are coming from 

the Gateway for CIMPLICITY for that marquee.

◦ Point values can be inserted in the alarm text with the following syntax:  {POIN

T.pointID}.

Important:

Point ID lengths can have a maximum of 255 characters.

Fore

ground

Use either method to select the foreground color.

◦ Choose a color from the dropdown list of predetermined colors,

◦ Click the color swatch to the right of the dropdown list; create a custom color.

Back

ground

Use either method to select the background color.

◦ Choose a color from the dropdown list of predetermined colors,

◦ Click the color swatch to the right of the dropdown list; create a custom color.

Scrolling Options are:

◦ Default

◦ No Scrolling

◦ Slow Speed

◦ Medium Speed

◦ Fast Speed.

Font Font options are:

◦ Default

◦ Small

Mode The dropdown list contains the following choices to establish how the information 

will display on the marquee. Static

◦ Flashing

◦ Fast Flashing

◦ Strobe

◦ Reverse
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Field Description

◦ Reverse Flash

◦ Reverse Fast Flash

Justifi

cation

Message layout on the marquee. The message can be:

◦ Right-aligned

◦ Left-aligned

◦ Centered

Note:

◦ If a marquee is configured in the Gateway with a default message, then it is removed from 

Marquee Manager Server, it will show up in the tree view under the Marquees folder with an 

X.  The Gateway will then allow this marquee to be deleted.

◦ A Groups  folder will display in the tree view under the Marquee folder, if

a. If you are using Marquee Manager Gateway for CIMPLICITY version 9.0 or higher,

b. Distribution Lists are configured in Marquee Manager.

◦ When an item is selected in Groups, there is an option to configure the Line Length  and 

Word Wrap Length.

3.  Words longer than this value will be broken with a – at a point that is equal to or less than the 

value.

4. The remaining portion will be wrapped to the next line. (See Note below for additional details)
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If the last word on line 1 is broken with a - and it exceeds the word wrap length, the whole word will 

be wrapped to the next line based on what is configured in the Word Wrap Length  field.Example

◦ A message to be displayed is:“My MMSGWCIMP Test Message”

◦ Line Length set to 20.

◦ Word Wrap set to 6.

Normally Message would be broken with a - since it is longer than 6 characters; however, as the 

break would leave less than 4 characters on line 1, the whole word Message will get bumped to the 

next line.

Marquee Manager Gateway  Insertion Tags

Marquee Manager Gateway for CIMPLICITY allows for additional tags to be added to the Slot Details 

tab>Text field Insertion tags can be used to specify different attributes per marquee line.  

Example

ALARM.NAME} - <COL-YLW><MOD-ST> {ALARM.RESOURCES}

Add an insertion tag

Select the line of the slot to which an insertion tag will be added.

Tip:  the symbol < opens a drop down of available tags.

The tags currently available are:

• <COL>

• <BCL>

• <FNT>

• <JST>

• <MOD>

• <SCR>

• <DATE>

• <TIME>

Note:

The insertion tags must be included in brackets and must be all upper case.
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Marquee Manager Gateway Tools: Users

If Windows or Windows Trusted is selected for the server security, a Tools tree with a Users folder is 

added to the Marquee Manager Gateway window left-pane.

Do the following.
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A Select Users  in the Marquee Manager Gateway window left-pane.

B Click New User on the Marquee Manager Gateway window tool

bar.

A Details Tab displays; options to register users are as follows.

Field Description

User

User

name

Valid Windows user.

Do

main

Domain the user logs into.

Pass

word

(Required with Windows Security) Password assigned to the logged in Windows user.

Con

firm

(Required with Windows Security) Re-entered password

Secu

rity

Security levels are as follows.
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Field Description

AD

MIN

Full rights to all features.

Important:

The ADMIN security level is required to access (open) applications. For almost 

all instances, it is recommended that ADMIN be assigned to registered Alarm 

Cast users.

DE

FAULT

(Optional) Additional details about or for the user.

Notes

Notes (Optional) Additional details about or for the user.

Marquee Manager Gateway for CIMPLICITY Other Tools

Marquee Manager Gateway for CIMPLICITY Other Tools

Marquee Manager Gateway for CIMPLICITY usage tools include the following.

The Marquee Manager Gateway for CIMPLICITY user interface is conveniently displayed in a tree view. 

The Server, when expanded, displays a Resources  folder that enables the user to select from resources 

that have been configured in the CIMPLICITY project.

It includes an Alarms folder and a Classes folder that enable the user to add various alarms and classes 

of alarms that once triggered, will route alarms to a marquee or a speaker that have been configured in 

Marquee Manager Administrator.

There are many features that make using Marquee Manager Gateway for CIMPLICITY easier and more 

effective that include:

• Marquee Manager Gateway Other Tools: Toolbar and Tree

• Marquee Manager Gateway Other Tools: Options

• Marquee Manager Gateway Other Tools: Log Files

Marquee Manager Gateway Other Tools: Toolbar and Tree
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Anything created on the tree view side of the screen (the left hand side) can be modified or deleted at any 

time.

Tree View Items: Modify

Select the item you want to alter. The information regarding it will show up on the right hand side of 

the screen. At this point, you can change the name along with any other variables attached to it (e.g. 

configuration settings etc.)When you save your changes, they will appear in the Tree View.

Important:

Information regarding manufacturer or models, cannot be altered. Once the modified information 

has been saved, you cannot revert to the old information. The only way to retrieve it is to change it 

back to its original state.

Tree View Items: Delete

There are two ways to delete items on the Tree View side of your screen. By selecting the item you want 

to delete, you can choose Edit >Delete on the Menu bar or simply click the red Delete  symbol ( X).

Important:

You cannot recover any deleted item or any information attached to it. You must recreate it.

In certain applications, if a particular item is being used in another part of the application, you will not be 

able to delete it at that level. You must go further down in the Tree View to discern where it is being used, 

and delete it there first.

Marquee Manager Gateway Other Tools: Options

Before using Marquee Manager Gateway for CIMPLICITY, configure the various settings that control 

the interface to the gateway.  The Options menu allows users to set Marquee Manager Gateway for 

CIMPLICITY details.

Click the Tools>Options on the Marquee Manager Gateway menu bar.

General Tab

Select the General tab; options are as follows.



Addons and Options  | 8 - Pager  | 934

Op

tion
Description

Da

ta 

Source

Installation will default the Data Source to MMGWCIMPADMIN , pointing to the Marquee Manager Gate

way for CIMPLICITY administrator database.

Dis

play

 Display options, specifying how the alarm rules will be displayed in the tree view. An example of 

a typical tree view is to group by Resources, then Alarms, then Classes.  In this sample, a typical 

Resource may be TANK, a typical Alarm may be LEVEL-OVERFLOW and Class may be HIGH.   This 

information would be displayed in the tree view as: TANK (Resource)             LEVEL-OVERFLOW 

(Alarm)                         HIGH    (Class) Display options may be changed at any time without affect

ing your current configuration.

Serv

er 

Re

load

Enables the user to select when they want a reload to server: with every change, or only when re

quested.

Reload 

with every 

change

Reload will occur when the Save button is clicked.
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Op

tion
Description

Reload on

ly when re

quested

You will be informed that there are data changes the server needs to be notified 

about and have the option to either send the reload before closing or close the sys

tem without reloading the changes.

Marquee Manager Gateway Other Tools: Log Files

In each application, you are able to view the log files associated with the various components of the 

software. The log files contain an accurate history of every transaction and modification made to the 

database. Log files are important because they ensure the integrity of the data and provide a means of 

data recovery.

To View:

Select View to get View Server and View Admin Log options.

The selected log opens.

Marquee Manager Gateway Filter Guidelines

• Click the Filters button on the selected log window toolbar.

An Alarm Cast Gateway Filter dialog box opens.

The Events On:  field defaults to the current day.

The Status Message  field can be used to search for a portion of the message in the log.

Important:  When matching special characters, enclose them in brackets.

Example

To find all log items that start with [ enter in [[]* in the Status Message  field.
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The common allowed search characters are as follows:

Char

acter
Match Made Example

? Any single character Text in the log is:

• ABC

• DBC

• XYZ.

Entering ?BC returns only:

• ABC

• DBC

* Zero or more charac

ters

Entering *Initiated* returns: All log items with the word Initiat

ed

# Any single digit (0-9) Text in the log is

• Device1

• Device5

• Device8

• Device10.

Entering Device# returns:

• Device1

• Device5

• Device8.

Check Automatic Refresh to automatically refresh the log file based on the seconds specified.

Marquee Manager Gateway Insertion Tag List

Tag Description Attributes Available

COL Color #rrggbb RGB in uppercase hex

AMB Amber
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Tag Description Attributes Available

BLK Black

BLU Blue

BRN Brown

CLR Clear

DEF Default

GRN Green

LGR Light green

ORG Orange

RED Red

WHI White

YLW Yellow

BCL Background 

color

Same as COL

FNT Font BLD Bold

CAP All Capitols

DEF Default

Fix Fixed Width

SML Small

JST Justification CEN Center

DEF Default

LEFT

RIGHT

MOD Mode DEF Default

FFL Fast flash

FL Flash

REV Reverse
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Tag Description Attributes Available

RFF Reverse fast flash

RFL Reverse flash

ST Static

STR Strobe

SCR Scrolling DEF Default

FAST (or SCR-2)

MED (or SCR-1)

S Static

SLOW (or SCR-0)

DATE Date DATE DD/MM/YY DD/MM/YYYY DD-MM-YY DD-MM-YYYY MM/DD/YY 

MM/DD/YYYY MM- DD-YY MM-DD-YYYY YY/MM/DD YY-MM-DD YYYY/MM/DD 

YYYY-MM-DD <DATE-DDD> <DATE-DDDD>

TIME Time 12 24 TIME

WRAP Wrap long line 

around on mul

ti-line text mar

quee.

Only applies to multi-line Text Displays. All <LIN-##> tokens will be removed 

and the most text that can be displayed across all lines on the display will be 

shown. Any resulting text that exceeds the displays capabilities will be truncat

ed.

Marquee Manager Gateway Glossary

Administrator

Typically a GUI application, this component facilitates configuration and monitoring of a server engine. If 

changes are made to the server configuration the administrator notifies the engine to reload its running 

configuration either automatically or on user demand. An example of an administrator component is 

Marquee Manager Administrator.

This administrator allows you to maintain the Marquee Manager server's engine configuration.

Administrator Kit

An administrator kit contains the product's administration component only.  After installing this kit on a 

workstation you may utilize any of the features of the Administrator component.
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Alarm

Generates alarms for points that are in an alarm state.  It can generate alarm messages about system 

events, such as device failures, and device statuses.

Class

Alarm class is the order in which an alarm appears relative to other alarms.  Alarms with similar 

characteristics are usually grouped by class.

Default Message

The message that has been configured in Marquee Manager Gateway for CIMPLICITY as the default, 

should the sign be cleared of all slots.

Distribution List

A Marquee Manager Server distribution list is a collection of marquees, which can be sent a message 

with a single transaction. Similar to an e-mail distribution list a client who initiates a transaction with a 

distribution list will automatically send the same message to all associated marquees.

Marquee

A sign display that serves as a visualization communication tool, providing the means to display time, 

date and message text such as production counts, and what areas of a plant are experiencing problems.

Point

Data that can be collected from various devices such as programmable controllers.  Point configuration 

defines where a point originates, how the data is collected, and what constitutes an alarm state.

Priority

The importance or priority that can be placed on each message sent to the marquee sign, with one being 

the highest priority and nine being the lowest priority.

Resource

The physical or conceptual units that comprise your facility and can be anything from devices and 

machines to stations where work is performed.
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Server Kit

A server kit typically contains the server engine and administrator components. In some cases a client 

component is also included with this kit. The server kit is usually installed on a centralized host and is 

utilized by one or more clients or gateways. An example of a server kit is Marquee Manager Server. This 

kit contains the Marquee Manager engine, administrator and client.

Speaker

A device connected to the marquee display that allows a tune to be played for alarm states of Generate, 

Acknowledge, or Reset.

Marquee Manager Client

About CIMPLICITY  Marquee Manager Client

The following topics contain an overview of the CIMPLICITY Marquee Manager Client product, detailed 

installation instructions, and administration user instructions.

• Marquee Manager Client: Key Features

• Marquee Manager Client: How it Works

• Marquee Manager Client Components

• Marquee Manager Client Tools

• Marquee Manager Client Sign Properties

• Marquee Manager Client Glossary

Marquee Manager Client: Key Features

Marquee Manager Client is the end user interface of the Marquee Manager Suite of applications.  It allows 

you to maintain the contents of a network of marquee signs. 
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Key Features:

User-friendly maintenance of Marquee and Distribution List Slot information.

• Supports up to 10 slot messages per marquee/distribution list.

• Ability to view all message details on all configured marquees

• Supported Manufacturers/Models:

Manufacturer Model

AdaptiveMicro All models

AllenBradley InView

Electro-Matic Stack lights

Nu-Media FIS models

Static Con

trols

All models

Uticor PMD3000 models

Marquee Manager Client: How it Works

The Marquee Manager Client provides a single unified interface for adding and editing messages to 

numerous different marquee manufacturers and models that have been configured in the Marquee 

Manager Administrator.  

The Marquee Manager Client, when refreshed, displays a list of all configured Marquees and Distribution 

Lists that have been added via Marquee Manager Administrator.  The user can view, edit or delete 

sign details for all marquees and distribution lists.  The full page of the sign where messages can be 
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configured is referred to as a Slot, which contains one or more lines depending on the sign type.  Each 

configured slot is automatically scrolled once it has been loaded into the sign.

A copy of Marquee Manager Client is included with the Marquee Manager Server software; it will be 

installed automatically when you install the server. The Marquee Manager Client program can be 

accessed from the server, or any workstation by purchasing the Marquee Manager Client kit.

The Marquee Manager Client user interface conveniently displays all information in a tree view that when 

expanded shows the current sign default message or the current active message of the sign.  It includes 

a Marquees folder and a Distribution List folder that display Marquees and Distribution Lists that have 

already been configured using the Marquee Manager Administrator.

If your administrator has enabled security in Marquee Manager Client, you will be prompted for the 

following before you can access Marquee Manager Client.

• User ID/password.

• Valid Domain name.

Marquee Manager Client Components

Marquee Manager Client Components

Marquee Manager Client key component configuration includes the following.
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• Marquee Manager Client Slots

• Marquee Manager Client Insertion Tags

• Marquee Manager Client Marquee Types

Important:

If Windows security has been implemented in the Marquee Manager Administrator, a Login 

dialog box will open before a user can access the Marquee Manager Client. Valid user names and 

passwords are pulled from the names configured in the Marquee Manager Administrator.

Marquee Manager Client Slots

1. Expand the Marquees folder.

2. Select the marquee to which a message will be added.

3. Right-click Slots in the tree view and select New Slot. Or, select the Slots folder and click New Slot 

on the toolbar. The Slots Details options are as follows.

Field Description

Priori

ty

Order in which messages that are sent to the sign will be displayed. Priorities are 1 – 9, 

where 1 is the highest priority Default is 9.

Text Message that will display for each line of the selected sign.

Note:  Sign properties  (on page 964)  in the drop down menus are automatically limited to the 

selected sign’s capabilities. Features, whose options can be selected from the drop down lists, in

clude:

◦ Foreground

◦ Scrolling

◦ Font
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Field Description

◦ Background

◦ Mode

◦ Justification

Pre

view

Reflects what is currently on the marquee.  It will display any slots, if available, or display 

the default message that was configured in the Marquee Manager Administrator. Note: 

The Preview is only an approximation of the exact marquee contents.   All textual data 

will be correct but slot order, font, pixel height etc. may not match exactly.

 

Click the Save  icon to save your new Slot details 

guide:

Guidelines

◦ If the number of slots exceeds the queue size configured on the marquee in the Marquee 

Manager Administrator, the message will be submitted and will wait until an available slot 

is available or a match is found on the priority threshold set for that marquee. If the Queue 

size is set to 5 and more than five slots have been added in the Marquee Manager Client, 

only those matching the priority threshold set on that marquee will be displayed. Priority 

threshold is set to 3 on that marquee, only those slots with a priority of 3 or higher will be 
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displayed.   The two remaining slots will display when the higher priority slots have been 

cleared.

◦ Any marquees that have an unknown display type will display in the tree view with a red X 

through the Marquee  icon

Marquee Manager Client Insertion Tags

Marquee Manager Client allows additional tags to be added to the Text  field of the Slot configuration.

1. Select the line of the slot to which the insertion tag will be added.

Note:  The symbol < opens a drop down of available tags.

The tags that are currently available are:

◦ <COL>

◦ <BCL>

◦ <FNT>

◦ <JST>

◦ <MOD>

◦ <SCR>

◦ <DATE>

◦ <TIME>

2. 2. Make sure the insertion tags are in brackets and are all UPPER case.
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Marquee Manager Client Marquee Types

Marquee Manager Client Marquee Types

Following are the Marquee Manager Client Marquee types.

• Marquee Manager Client Marquee Type: Andon Bin Cell.

• Marquee Manager Client Marquee Type: Andon Char Cell.

• Marquee Manager Client Marquee Type: Clock.

• Marquee Manager Client Marquee Type: Color block.

• Marquee Manager Client Marquee Type: Controller.

• Marquee Manager Client Marquee Type: Counter.

• Marquee Manager Client Marquee Type: Marquee.

• Marquee Manager Client Marquee Type: Sounder.

• Marquee Manager Client Marquee Type: Stack light.

• Marquee Manager Client Marquee Type: Distribution lists.

Marquee Manager Client Marquee Type: Andon Bin Cell

1. Select the Andon Bin Cell in the Marquee Manager Client window left-pane.

2. Select the Cell Config tab.

Note:  Cell configuration must be completed in the Marquee Manager Administrator window and 

cannot be edited in the Client application.
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3. Select the Preview tab.

A preview of what is currently on the Andon Bin Cell displays.
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Marquee Manager Client Marquee Type: Andon Char Cell

• Cell type displays:

• Are typically used to display data best represented in a grid format.

Example

In a manufacturing facility divided into numerous assembly stations, each cell may represent a station’s 

state.

The cells can be used to show what station or plant location is experiencing a problem and display 

information such as the area and nature of the problem.

• Require specific setup to define the various cells and bins available to display data.

• Char cell boards contain text cells that may be configured with up to three characters for display.

• Each cell can have one or more values displayed at one time.

• Each value is displayed on the marquee for eight seconds before proceeding to the next value in 

that cell.

1. Select the Andon Char Cell board in the Marquee Manager Client window left-pane.

2. Select the Cell Config tab.

Note:  Configuration must be completed in the Marquee Manager Administrator window and cannot 

be edited in the Client application.  
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3. Select the Preview tab.

A preview of what is currently on the Andon Char Cell displays.
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Marquee Manager Client Marquee Type: Clock

1. Select the Clock board in the Marquee Manager Client window left-pane.

Note:  Configuration must be completed in the Marquee Manager Administrator window and cannot 

be edited in the Client application.

2. Select the Preview tab.

A preview of what is currently on the clock displays

Marquee Manager Client Marquee Type: Color Block

Color Block models such as the NETCON Technologies Native Unit Color Block, are typically used to 

display a block of color for the state of a plant station.

Example

In a manufacturing facility divided into numerous assembly stations, each block may represent a station’s 

state.

If a station is experiencing a problem, they display a color to alert personnel.  
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1. Select the Color Block in the Marquee Manager Client window left-pane.

2. Select the Cell Config tab.

Note:  Configuration must be completed in the Marquee Manager Administrator window and cannot 

be edited in the Client application.

3. Select the Preview tab. to view what is currently displayed on the Color Block.
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A preview of what is currently on the Color Block marquee displays.

Marquee Manager Client Marquee Type: Controller

1. Select the Controller  type marquee in the Marquee Manager Client window left-pane.

2. Do one of the following.

◦ Right click Slots  in the tree view; Select New Template on the Popup menu.

◦ Select the Slots  folder; click the New Template button on the Marquee Manager Client 

toolbar.

3. Check which to add to the slot on the Template Details tab.

◦ Template

◦ Cycle

A drop-down menu, based on your selection, displays a list of available templates or cycles that 

have been configured in the Marquee Manager Administrator.

4. Select the template or cycle to display.
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5. Click the Save button to save the slot details.

Marquee Manager Client Marquee Type: Counter

A Counter Display is a display element specifically designed to display numeric counts.

The counts may be positive or negative.

1. Select the Counter  type marquee in the Marquee Manager Client window left-pane.

2. Do one of the following.

◦ Right click Slots  in the tree view; Select New Template on the Popup menu.

◦ Select the Slots  folder; click the New Template button on the Marquee Manager Client 

toolbar.

3. Select the message Priority.

This determines the order in which messages sent to the sign will be displayed.  

High priority messages have a priority of 1.

Low priority message have a priority of 9.  

Default is 9.

4. Enter Text that will display for each message line on the selected sign.
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Note:  Sign properties  (on page 964)  in the drop down menus will automatically be limited to the 

sign capabilities.

5. Select the following options from the dropdown lists.

◦ Foreground

◦ Background

◦ Scrolling

◦ Mode

◦ Font

◦ Justification

The Preview reflects what is currently on the marquee.

It will display either of the following.

◦ Any slots, if available.

◦ The default message that was configured in Marquee Manager Administrator.

The Preview is only an approximation of the exact marquee contents.  All textual data will be 

correct but slot order, font, pixel height etc. may not match exactly.

 

6. Click the Save button to save your new Slot details. 

Marquee Manager Client Marquee Type: Marquee
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1. Select the Marquee type marquee in the Marquee Manager Client window left-pane.

2. Do one of the following.

◦ Right click Slots  in the tree view; Select New Template on the Popup menu.

◦ Select the Slots  folder; click the New Template button on the Marquee Manager Client 

toolbar.

3. Select the message Priority.

This determines the order in which messages sent to the sign will be displayed.  

High priority messages have a priority of 1.

Low priority message have a priority of 9.  

Default is 9.

4. Enter Text that will display for each message line on the selected sign.

Note:  Sign properties  (on page 964)  in the drop down menus will automatically be limited to the 

sign capabilities.

5. Select the following options from the dropdown lists.

◦ Foreground

◦ Background

◦ Scrolling

◦ Mode

◦ Font

◦ Justification

The Preview reflects what is currently on the marquee.

It will display either of the following.

◦ Any slots, if available.

◦ The default message that was configured in Marquee Manager Administrator.

The Preview is only an approximation of the exact marquee contents.  All textual data will be 

correct but slot order, font, pixel height etc. may not match exactly.
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If the Marquee has more than one line, click the Forward/Back button to configure the details on 

that line(s) if required.

6. Click the Save button to save your new Slot details. 

Marquee Manager Client Marquee Type: Sounder

1. Select the Sounder type marquee in the Marquee Manager Client window left-pane.

2. Do one of the following.

◦ Right click Tunes  in the tree view; Select New Tune on the Popup menu.

◦ Select the Tunes  folder; click the New Tune button on the Marquee Manager Client toolbar.

The Tune Details tab displays

3. Select the tune Priority.

This determines the order in which tunes sent to the sign will be played.  

High priority tunes have a priority of 1.

Low priority tunes have a priority of 9.  

Default is 9.

4. Select the tune to be played from the Tune #  field.
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Note:  Static Controls’ MusicMaker model has up to 255 tunes available.

5. Check one of the following.

◦ Play Continuously

The tune will play continuously

◦ Play for

Duration entries in seconds are:

On Duration (seconds) the tune plays in an on/off segment.

Off Dura

tion

(seconds) the tune pauses in an on/off segment

Repeat Number of times the on/off segment is repeat

ed.

6. Click the Save button to save the Tune details.

Marquee Manager Client Marquee Type: Stack Light
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1. Select the Stack Light marquee type in the Marquee Manager Client window left-pane.

2. Select the Stack Light Config tab.

Note:  Configuration must be completed in the Marquee Manager Administrator window and cannot 

be edited in the Client application.

3. Select the Preview tab.

A preview of what is currently on the Stack Light displays.

Marquee Manager Client Distribution Lists

The Distribution Lists folder in the Marquee Manager Client window left-pane:

• Displays a list of all distribution lists that have been configured in Marquee Administrator.

This allows the same message to be sent to multiple marquees at the same time.

• Allows users to add slots to configured marquees in distribution lists, enabling the same message 

to be sent to multiple marquees with a single request.

Marquee Manager Client applications provide the ability to compose messages and send them to a 

marquee distribution list, as to gateways.
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1. Expand the Distribution Lists folder in the Marquee Manager Client window left-pane.

2. Select the Slots folder; click the New Slot button on the Marquee Manager Client toolbar.

A Slot Details tab displays.

Enter Text that will display for each message line on the selected sign  (on page 964).

a. Select the following options from the dropdown lists.

• Foreground

• Background

• Scrolling

• Mode

• Font

• Justification

The Preview reflects what is currently on the marquee.

It will display either of the following.

• Any slots, if available.

• The default message that was configured in Marquee Manager Administrator.
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The Preview is only an approximation of the exact marquee contents.  All textual data will be correct but 

slot order, font, pixel height etc. may not match exactly.

a. Click the Save button to save the new Distribution List Slot details.

Marquee Manager Client Tools

Marquee Manager Client Tools

Marquee Manager Client tools include the following.

• Modifying and deleting Tree View items.

• Using Marquee tools - Options.

• Viewing the Log files.

Marquee Manager Client Tools: Tree View

Anything created on the tree view side of the screen (the left hand side) can be modified or deleted at any 

time.

Tree View Items: Modify

Select the item you want to alter. The information regarding it will show up on the right hand side of 

the screen. At this point, you can change the name along with any other variables attached to it (e.g. 

configuration settings etc.)When you save your changes, they will appear in the Tree View.

Important:

Information regarding manufacturer or models, cannot be altered. Once the modified information 

has been saved, you cannot revert to the old information. The only way to retrieve it is to change it 

back to its original state.

Tree View Items: Delete

There are two ways to delete items on the Tree View side of your screen. By selecting the item you want 

to delete, you can choose Edit >Delete on the Menu bar or simply click the red Delete  symbol ( X).
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Important:

You cannot recover any deleted item or any information attached to it. You must recreate it.

In certain applications, if a particular item is being used in another part of the application, you will not be 

able to delete it at that level. You must go further down in the Tree View to discern where it is being used, 

and delete it there first.

Marquee Manager Client Tools: Options

The Options menu allows users to set Marquee Manager Server details.

1. Click Tools>Options on the Marquee Manager Client window menu.

An Options dialog box opens displaying a Preferences tab.

The Preferences tab controls the Marquee Manager Administrator data entry preferences.

1. Select how attributes will be handled in the event that no default was supplied.
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Marquee Manager Client Tools: Log Files

Select View to get the View Admin Log options.

The selected log opens.

guide:

Marquee Manager Client Filter Guidelines

• Click the Filters button on the selected log window toolbar.

An Alarm Cast Gateway Filter dialog box opens.
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The Events On:  field defaults to the current day.

The Status Message  field can be used to search for a portion of the message in the log.

Important:  When matching special characters, enclose them in brackets.

Example

To find all log items that start with [ enter in [[]* in the Status Message  field.

The common allowed search characters are as follows:

Char

acter
Match Made Example

? Any single character Text in the log is:

• ABC

• DBC

• XYZ.

Entering ?BC returns only:

• ABC

• DBC

* Zero or more charac

ters

Entering *Initiated* returns: All log items with the word Initiat

ed

# Any single digit (0-9) Text in the log is

• Device1

• Device5

• Device8

• Device10.

Entering Device# returns:

• Device1

• Device5

• Device8.

• Check Automatic Refresh to automatically refresh the log file based on the seconds specified.
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Marquee Manager Client Sign Properties

Adaptive ALPHA VERSION 2 *

Model Color Font Scrolling Flashing Notes

BIGDOT 

13Char

Tri-color Double Height 0 0 Supports Rollup

BIGDOT 

26Char

Tri-color Small, Fixed Width, Bold 0 0 Supports Rollup

Adaptive Micro Systems*

Model Color Font Scrolling Flashing Notes

ALL Tri-color Small, Bold, Fixed Width ü ü

Beta-Brite Tri-color Small, Bold, Fixed Width ü ü

BIGDOT Tri-color Small, Bold, Fixed Width ü ü

BIGDOT_

26Char

Tri-color Small, Bold, Fixed Width ü ü

PPD Small, Bold, Fixed Width ü ü Red and green models

215 Tri-color Small, Bold, Fixed Width ü ü

215C Tri-color Small, Bold, Fixed Width ü ü

320C Tri-color Small, Bold, Fixed Width ü ü

330C Tri-color Small, Bold, Fixed Width ü ü

4080C Tri-color Small, Bold, Fixed Width ü ü

4120C Tri-color Small, Bold, Fixed Width ü ü

4120R Red Small, Bold, Fixed Width ü ü

4160C Tri-color Small, Bold, Fixed Width ü ü

4160R Red Small, Bold, Fixed Width ü ü

4200C Tri-color Small, Bold, Fixed Width ü ü

4200R Red Small, Bold, Fixed Width ü ü
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Model Color Font Scrolling Flashing Notes

4240C Tri-color Small, Bold, Fixed Width ü ü

4240R Red Small, Bold, Fixed Width ü ü

7120 Tri-color Small, Bold, Fixed Width ü ü

7160 Tri-color Small, Bold, Fixed Width ü ü

7200 Tri-color Small, Bold, Fixed Width ü ü

7200_4Line Tri-color Small Caps ü ü

9120 Tri-color Small, Bold, Fixed Width ü ü

9160 Tri-color Small, Bold, Fixed Width ü ü

9200 Tri-color Small, Bold, Fixed Width ü ü

9240 Tri-color Small, Bold, Fixed Width ü ü

ALLEN-BRADLEY INVIEW**

Model Color Font Scrolling Flashing Notes

P42C Tri-color Small, Fixed Width, Bold ü ü

P42R Red Small, Fixed Width, Bold ü ü

P43C Tri-color Small, Fixed Width, Bold ü ü

P43R Red Small, Fixed Width, Bold ü ü

P44C Tri-color Small, Fixed Width, Bold ü ü

P44R Red Small, Fixed Width, Bold ü ü

P72CN2 Tri-color Small, Fixed Width, Bold ü ü 3 line/20characters

P72CN2/1- 4 line Tri-color Small Caps ü ü 4 line/20 charac

ters

P74CN2/1 Tri-color Small, Fixed Width, Bold ü ü 3 line/33 charac

ters

P74CN2/1 – 4 line Tri-color Small Caps ü ü 4 line/33 charac

ters
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Electro-Matic Products Inc.

Model Color Font Scrolling
Flash

ing
Notes

4 Digit Dis

play

Red Fixed 

Width

x x 4 characters al

pha or numeric

Stack Light 

– 1 High

Blue, Brown, Green, Light Green, Light Red, 

Orange, Red, White, Yellow

N/A N/A ü

Stack Light 

– 2 High

Blue, Brown, Green, Light Green, Light Red, 

Orange, Red, White, Yellow

N/A N/A ü

Stack Light 

– 3 High

Blue, Brown, Green, Light Green, Light Red, 

Orange, Red, White, Yellow

N/A N/A ü

Stack Light 

– 4 High

Blue, Brown, Green, Light Green, Light Red, 

Orange, Red, White, Yellow

N/A N/A ü

Stack Light 

– 5 High

Blue, Brown, Green, Light Green, Light Red, 

Orange, Red, White, Yellow

N/A N/A ü

Stack Light - 

Sounder

Blue, Brown, Green, Light Green, Light Red, 

Orange, Red, White, Yellow

N/A N/A N/A 1 tune played

NETCON Technologies Native Unit *

Model Color Font Scrolling
Flash

ing
Notes

Clock N/A N/A x x Displays time only

Counter Red Fixed 

Width

x x • Numeric only

• Max. 8 digits

• # of  Characters can be set on the Options tab in 

Marquee Administrator

Mar

quee

Mul

ti-Col

or

Fixed 

Width

ü ü • Supports Rollup

• # of Lines and  Characters can be set on the Options 

tab in Marquee Administrator

Sounder N/A N/A N/A N/A 255 Tunes
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NU-MEDIA DISPLAY SYSTEMS*

Model Color Font Scrolling Flashing Notes

v4.67 Single Lin Red Double Height ü ü

v4.67 Dual Line Red Small, Fixed Width, Bold ü ü

STATIC CONTROLS CORPORATION

Model Color Font Scrolling
Flash

ing
Notes

Alpha 952_20 Red Fixed 

Width

x ü • one line

• 20 characters

Alpha 952_25 Red Fixed 

Width

x ü • one line

• 20 characters

Alpha 952_40 Red Fixed 

Width

x ü • one line

• 20 characters

Alpha 954_10 Red Fixed 

Width

ü ü

Andon 974_0206 Mul

ti-color

N/A x ü Cell board  size: 2 rows, 6 columns

Andon 974_0307 Mul

ti-color

N/A x ü Cell board size:  3 rows, 7 columns

Andon 974_0308 Mul

ti-color

N/A x ü Cell board size:  3 rows, 8 columns

Andon 974_0408 Mul

ti-color

N/A x ü Cell board size:  4 rows, 8 columns

Andon 974_0420 Mul

ti-color

N/A x ü Cell board size:  4 rows, 20 columns

AndonQueue 

974_0206

Mul

ti-color

Fixed 

Width

x ü Cell board  size: 2 rows, 6 columns

AndonQueue 

974_0307

Mul

ti-color

Fixed 

Width

x ü Cell board size:  3 rows, 7 columns
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Model Color Font Scrolling
Flash

ing
Notes

AndonQueue 

974_0308

Mul

ti-color

Fixed 

Width

x ü Cell board size:  3 rows, 8 columns

AndonQueue 

974_0408

Mul

ti-color

Fixed 

Width

x ü Cell board size:  4 rows, 8 columns

AndonQueue 

974_0420

Mul

ti-color

Fixed 

Width

x ü Cell board size:  4 rows, 20 columns

AndonQueue 

974_0614

Mul

ti-color

Fixed 

Width

x ü Cell board size:  6 rows, 14 columns

ColorBlock 

974_0104

Mul

ti-color

N/A x ü ColorBlock board size:  1 row, 4 columns

ColorBlock 

974_0404

Mul

ti-color

N/A x ü ColorBlock board size:  4 rows, 4 columns

Marquee 

955GM_0120

Mul

ti-color

Fixed 

Width

x ü GM specific SCC protocol:  1 line, 20 char

acters

Marquee 

955GM_0125

Mul

ti-color

Fixed 

Width

x ü GM specific SCC protocol:  1 line, 25 char

acters

Marquee 

955GM_0133

Mul

ti-color

Fixed 

Width

x ü GM specific SCC protocol:  1 line, 33 char

acters

Marquee 

955GM_0135

Mul

ti-color

Fixed 

Width

x ü GM specific SCC protocol:  1 line, 35 char

acters

Marquee 

955GM_0140

Mul

ti-color

Fixed 

Width

x ü GM specific SCC protocol:  1 line, 40 char

acters

Marquee 

955GM_0225

Mul

ti-color

Fixed 

Width

x ü GM specific SCC protocol:  2 line, 25 char

acters/line

Marquee 

955GM_0235

Mul

ti-color

Fixed 

Width

x ü GM specific SCC protocol:  2 line, 35 char

acters/line

Marquee 

955GM_0240

Mul

ti-color

Fixed 

Width

x ü GM specific SCC protocol:  2 line, 40 char

acters/line

MusicMaker_AC1 N/A N/A N/A N/A 255 tunes
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Model Color Font Scrolling
Flash

ing
Notes

Num 801_N Red Fixed 

Width

x x Numeric only

SCC980_Controller N/A N/A N/A N/A Template switching controller

Tim 801_T Displays time only

Uticor Technology 

Model
Col

or
Font Scrolling

Flash

ing
Notes

Uticor Slave  3000 – 1 line Red Small, Double Height, Full 

Height

ü ü

Uticor Slave  3000 – 2 line Red Small, Double Height, Full 

Height

ü ü

Uticor Slave  3000 – 4 line Red Small, Double Height, Full 

Height

ü ü

Uticor Slave  3000 Double Wide – 1 

line

Red Small, Double Height, Full 

Height

ü ü

Uticor Slave  3000 Double Wide – 2 

line

Red Small, Double Height, Full 

Height

ü ü

Uticor Slave  3000 Double Wide – 4 

line

Red Small, Double Height, Full 

Height

ü ü

*    For all supported signs, only the bottom line of the sign supports the scrolling feature.

** If the default message is changed, the Allen-Bradley Inview sign will reboot itself.  With Allen-Bradley 

signs, there is no address field passed to specify on which display you want to set the default message. 

Marquee Manager Client Glossary

Administrator

Typically a GUI application, this component facilitates configuration and monitoring of a server engine. If 

changes are made to the server configuration the administrator notifies the engine to reload its running 
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configuration either automatically or on user demand. An example of an administrator component is 

Marquee Manager Administrator.

This administrator allows you to maintain the Marquee Manager server's engine configuration.

Administrator Kit

An administrator kit contains the product's administration component only.  After installing this kit on a 

workstation you may utilize any of the features of the Administrator component.

Andon

Andon boards are used to show where (what station or location) there is a problem (blocked or starved 

station) or a potential problem (blocked or starved station) or a potential problem (low on stock). They 

are used to alert the proper personnel that something needs their attention - either immediate or in-the 

near future. A marquee may be used to give mention to upcoming meetings, or events and can display the 

time, date, number of parts that are expected and actually produced. They are a visual communication 

tool used to help production meet their goals and minimize shut down time.

Bin

An area within each cell that contains data relevant to various locations in an environment. (i.e.  plant 

stations such as paint)  Data such as station state or a station that may be experiencing a problem, may 

be displayed on the Andon Board.

Cell

For cell-based Andon Board marquee signs, a cell refers to one block of data on the sign.

Client

A client component utilizes the facilities of a standard NETCON server.  Typically a GUI application, this 

component provides a user-friendly interface of the available services offered by the server engine. 

An example of a client tool would be FirstPAGE Client, which presents the user with a list of known 

messaging destinations and allows them to send messages to one or more destinations.

Default Message

The message that has been configured in Marquee Manager Administrator as the default, should the sign 

be cleared of all slots.
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Distribution List

A Marquee Manager Server distribution list is a collection of marquees, which can be sent a message 

with a single transaction. Similar to an e-mail distribution list a client who initiates a transaction with a 

distribution list will automatically send the same message to all associated marquees.

Marquee

A sign display that serves as a visualization communication tool, providing the means to display time, 

date and message text such as production counts, and what areas of a plant are experiencing problems.

Server Kit

A server kit typically contains the server engine and administrator components. In some cases a client 

component is also included with this kit. The server kit is usually installed on a centralized host and 

is utilized by one or more clients or gateways. An example of a server kit is FirstPAGE Server. This kit 

contains the FirstPAGE engine, administrator and client.

Slot

The full page or area of the sign where messages can be configured.  Each slot contains one or more 

lines depending on the sign type.  Marquees may contain up to ten slots.  Each will be displayed in a 

rotating queue.

Stack Light

Stacked lights typically used to display colors in a vertical grid pattern from one to five lights high.  They 

may be used to show if a station is experiencing a problem then turn a light on to alert personnel. 

Alarm Cast Administrator

About Alarm Cast Administrator

The following topics provide an overview of the CIMPLICITY Alarm Cast Administrator product including 

detailed configuration descriptions.

• Alarm Cast Administrator - Key Features  (on page 972)

• Alarm Cast Administrator: How it Works  (on page 973)

• Alarm Cast Administrator Pre-configuration  (on page 974)

• Alarm Cast Administrator Components  (on page 984)

• Alarm Cast Administrator Other Tools  (on page 1064)
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• Alarm Cast Redundancy  (on page 1069)

• Alarm Cast Administrator Glossary  (on page 1083)

Alarm Cast Administrator - Key Features

CIMPLICITY Alarm Cast is a high volume message processing engine that can be coupled with any 

combination of Alarm Cast auxiliary products to have messages dispatched from any application. It is 

easy to use in an operational setting and includes a full suite of flexible administration tools, all accessible 

remotely.

The Alarm Cast messaging engine is a standardized interface between personal communication devices 

and applications sending messages through either an internal paging service and/or external service 

providers. Alarm Cast Server maintains a database of all destinations, the addressing information of the 

device and the associated service provider connection information. This database can be shared with any 

application allowing messages to be dispatched from any part of the organization.

Key Alarm Cast Features:

• Simple, efficient installation wizards make for easy installation.

• Supports personal messaging groups (i.e. distribution lists).

• User-friendly maintenance of Devices, Providers, Destinations, Distribution Lists, Groups, Modems, 

etc.
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• Unlimited messaging groups and destinations.

• Detailed transaction logging and viewing of these logs.

• Allows the administrator to import modem manufacturer modem definition files.

• Compatible with in-house paging systems.

• Supports serial modems, direct connections, TCP/IP sockets and terminal servers.

• Dispatches 60+ pages/minutes per modem.

• Dispatches 10000+ pages/minute via direct connections

• Online re-configuration of any engine setting or device/provider configuration.

• Concurrent device/modem support allows for extreme message throughput (i.e. 1,000,000 + pages 

per 8 hour day).

Alarm Cast Administrator: How it Works

Alarm Cast Server provides its clients with a single unified interface for dispatching text messages 

to numerous different destination types. The destination may be an actual text pager, a mobile phone 

handset, or an email address.  The format and connection method is irrelevant; Alarm Cast Server formats 

and delivers the message to the destination for you.

To accomplish this task Alarm Cast utilizes a concept of a Device. A Device in Alarm Cast is the physical 

path the engine will utilize to connect to the destination service providers. Examples of devices include 

serial ports, internal or external modems, modems hosted via TCP/IP connected modem sharing devices, 

or Internet connections etc. Once the device is named and defined, it may be used to define service 

providers.

Using this device connection Alarm Cast Server communicates to the service provider using the protocol 

defined for the provider. In the case of most North American one-way paging service providers, the TAP 

protocol is used. In this case, serial packets are sent to the provider using the associated device.  Once 

protocol initiation is established, message transactions are dispatched to the provider using the selected 

protocol method for transaction initiation and completion.

For each destination a unique network id is sent along with the message to identify the end destination 

on the provider’s network. The creation of a destination in Alarm Cast Server allows you to use a familiar 

name in place of the unique provider’s network id, which is often numeric and not easily remembered. 

Once the message request is sent, a response from the provider is returned to Alarm Cast where it is 

evaluated for transaction success or failure. The result of this message is logged within the Alarm Cast 

Server logs for later review. Should the transaction require a retry, it is scheduled for the next connection 

to the provider.
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Supported Alarm Cast Protocols:

MS-

SPEECH

Speech API that converts text to speech

ODBC Open Database Connectivity (Support for any ODBC compliant database)

OUCHPUSH Orange Ouch Protocol

SMTP Simple Mail Transport Protocol (For e-mail input to messaging service providers)

SMTP-FOR

DAU

Simple Mail Transport Protocol for Ford Australia (Proprietary protocol)

SNPP Simple Network Paging Protocol (For Internet input into messaging service providers)

TAP Telocator Alphanumeric Protocol, including IXO and PET (For most North American mes

saging service providers)

TR500 TR500 PBX Protocol

UCP Universal Computer Protocol (Primarily for European GSM/SMS handsets)

Alarm Cast Administrator Pre-configuration

Alarm Cast Administrator Pre-configuration

The Alarm Cast Administrator utility program is used to configure and control the Alarm Cast Server 

engine.

System managers responsible for Alarm Cast are the intended users of Alarm Cast Administrator.

The features and operations that can be performed with Alarm Cast Administrator include adding, 

modifying, deleting, listing, printing database information, viewing logs and changing server 

configurations, etc.

Do the following before configuring the Alarm Cast Administrator.

• Alarm Cast Administrator Database Conversion

• Alarm Cast Administrator  DSN Specifications

• Alarm Cast Administrator Application Folder

• Availability
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Alarm Cast Administrator Database Conversion

The database for the Alarm Cast server is FPServer.mdb.

Important:

If the previous CIMPLICITY Pager was installed, the corresponding FPAdmin.mdb database will be 

incompatible with Alarm Cast Administrator; however it can be converted

If you have not converted the database, when you start the Alarm Cast Administrator for the first time 

after you install Alarm Cast, a message will report that the database is incompatible; the Database 

Convertor must be run.

Example: Windows 7

1. 1. Open the Windows Start menu.

2. 2. Select CIMPLICITY>Alarm Cast>Database Conversion.

An Unavailable Servers dialog box opens.

3. Click OK.

A Database Conversion dialog box opens.
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4. Click Next.

The Wizard will:

• Report if the database is up to date or needs conversion; if the database requires conversion the 

Wizard will guide you through the steps for the Alarm Cast Administrator and Alarm Cast Alarm 

Administrator.

• Display a summary of changes that will be made to your database, including the current version 

that is running and the target database.

Click Start to run the converter. Conversion results will then be displayed.

Important:

Restart the Alarm Cast Server service after completing the database conversion.

Alarm Cast Administrator: DSN Specifications

1. Open the ODBC Data Source Administrator.

◦ 32-Bit System

a. Open the Control Panel

b. Select Administrative Tools > Data Sources (ODBC).
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The ODBC Data Source Administrator opens.

a. Choose the System DSN tab.

◦ 64-Bit System

Important:  System data sources are created in the ODBCAD32 location; they may not be listed on 

the System DSN tab when you open the ODBC Data Source Administrator on a 64-bit system.

a. Expand the HMI/SCADA CIMPLICITY v<n> on the Windows Start menu.

b. Enter the following in the Command Line field.

c:\windows\syswow64\odbcad32.exe

a. Press Enter.

The ODBC Data Source Administrator opens.

a. Select the System DSN tab.

Note:  You can also click ODBCAD32 – View 32bit DSNs.

◦ On many operating systems, it is located in the HMI/SCADA CIMPLICITY v<n>list on the 

Start menu.

◦ On operating systems, such as Windows 8, it will have its own icon on the Start screen.

Result: The System Data Sources will be listed.

2. Click Add.

A Create New Data Source screen opens.
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3. Double click Microsoft Access Driver (*.mdb).

4. Click Finish.

An ODBC Microsoft Access Setup dialog box opens.

5. Do the following.

A Enter the Data Source name.

B Click Select.

A Select Database dialog box opens.

6. Do the following.

A Select the database file’s directory. Note:  The path is ..\<CIMPLICITY installation>\ALARM

CAST\DATA
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B Select FPSERVER.MDB.

C Click OK.

The ODBC Microsoft Access Setup dialog bop re-opens; the database path is entered.

7. Click OK.

The new data source is listed on the ODBC Data Source Administrator>System DSN tab.

Alarm Cast Administrator: Application Folder Availability
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The Alarm Cast Administrator utility program is used to configure and control the Alarm Cast Server 

engine. System managers responsible for Alarm Cast are the intended users of Alarm Cast Administrator.

The features and operations that can be performed with Alarm Cast Administrator include adding, 

modifying, deleting, listing, printing database information, viewing logs and changing server 

configurations, etc.

A copy of Alarm Cast Administrator is included with the Alarm Cast Server software; it will be installed 

automatically when you install the server. The Alarm Cast Administrator program can be accessed from 

any administrator workstation by purchasing the Alarm Cast Administrator Kit.

Before installing and configuring Alarm Cast Administrator do the following.

Note:

This procedure is for a Windows 7 system. The exact steps may differ slightly on your system.

Choose the ALARMCAST  application folder, which contains the Alarm Cast data and log files.

Following are the default paths for 32-bit and 64-bit systems.

32-bit system ..Program Files\Proficy\Proficy CIMPLICITY\ALARMCAST

64-bit system ...Program Files (x86)\Proficy\Proficy CIMPLICITY\ALARM

CAST



Addons and Options  | 8 - Pager  | 981

Right-click the ALARMCAST  folder to open the ALARMCAST Properties dialog box.

Assign Full Control to the Everyone  user.

Example: Assign Sharing Permissions to the Everyone User

Do the following on a Windows 7 system; other Windows operating systems may differ slightly.

Select Properties on the ALARMCAST Popup menu.

The Server Properties dialog box opens.

Do the following.



Addons and Options  | 8 - Pager  | 982

A Select the Sharing tab.

B Click Advanced Shar

ing.

An Advanced Sharing dialog box opens.

Do the following.
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A Check Share this fold

er.

B Click Permissions.

A Permissions for ALARMCAST dialog box opens.

Do the following.
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A Select Everyone.

B Make sure Allow is checked for all options.

C Click Apply.

Click OK to close the dialog boxes.

Result: ALARMCAST is now available

Alarm Cast Administrator Components

Alarm Cast Administrator Components

• Alarm Cast Administrator Server.

• Alarm Cast Administrator Devices.

• Alarm Cast Administrator Providers.

• Alarm Cast Administrator Destinations.
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• Alarm Cast Administrator Distribution Lists.

Alarm Cast Administrator Server

• Alarm Cast Administrator: New Server

• Alarm Cast Administrator: Server Configuration

• Alarm Cast Administrator Server: Save

Alarm Cast Administrator: New Server

1. Enable Alarm Cast Gateway in the CIMPLICITY Workbench, as follows.

a. Click Project>Properties on the Workbench menu bar.

The Project Properties dialog box opens.

a. Check Alarm Cast Gateway in the General tab>Options box.

b. Close the Project Properties dialog box.

2. Do the following.

A Expand Computer  in the Workbench left-pane.

B Double-click Alarm Cast Administrator  (in the left or right-

pane).

The Alarm Cast Administrator window opens.
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3. Do the following.

A Select Alarm Cast Servers in the Alarm Cast Administrator left-pane.

B Click the New Server button on the Alarm Cast Administrator toolbar. A New Server menu dis

plays.

4. Select Alarm Cast Server on the New Server menu.

A Select Data Source dialog box opens.

5. Select the Alarm Cast Server data source.

Default FPSERV

ER
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6. Click OK.

7. Must be in your DNS server or local host file.

8. Can be reached from the Administrator workstation

9.  Three alternate names.

10. One locator name.

Note

◦ Aliases can be customized by editing the text preceding and following the &symbol.

◦ The &  symbol serves as a shortcut key and can be placed anywhere in the Alias 

descriptions.

11. A Users  folder is added to the Tools tree.

12. Users who should have access to the Alarm Cast server need to be added.

13. A Login dialog box opens when a user attempts to open the Alarm Administrator window.

14. A Users  folder is added to the Tools tree.

15. Users who should have access to the Alarm Cast server need to be added.
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After a listed user logs into Windows, the user can open the Alarm Cast Administrator  window; a Login 

dialog box for the Alarm Cast Administrator  is not required.

Alarm Cast Administrator Devices

Alarm Cast Administrator Devices

• Alarm Cast Administrator: Device overview.

• Alarm Cast Administrator: Devices

Alarm Cast Administrator: Device Overview

The Devices folder allows you to add and maintain all devices and device-related information such as 

device type and communication settings. Devices are the physical connections that the server will utilize 

to connect to the various service providers required. Devices must be configured before any service 

providers may be defined.

guide:

Guideline:  To facilitate high throughput via serial communications numerous similar devices 

may be pooled together. To accomplish this more than one device can have the same name. The 

resulting device pool can then operate in tandem.

Example

If two modems are entered under the name DIALOUT; this device is assigned to a provider, then the server 

can utilize both of the modems simultaneously to connect to the service provider and allow it to send 

pages concurrently to the provider.

When choosing a Device type, the type you choose will determine what Communications options display 

on this tab.

The following outlines the device options

Database using ODBC protocol
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Direct connection (by serial cable)

Modem, ModemIP (a modem hosted on a TCP/IP sharing device)

TCP/IP for an Internet connection

Audio for text to speech output



Addons and Options  | 8 - Pager  | 990

Alarm Cast Administrator: Devices

• Alarm Cast Administrator Device: Audio.

• Alarm Cast Administrator Device: Database.

• Alarm Cast Administrator Device: Direct.

• Alarm Cast Administrator Device: Modem.

•  Alarm Cast Administrator Device:  TCP/IP.

•  Alarm Cast Administrator Device: UDP.

•  Alarm Cast Administrator Device:  Wizard.

Alarm Cast Administrator Device: Audio

1. Click the Devices  folder in the Alarm Cast Administrator left-pane.

2. Click New Device on the toolbar.

A Details tab displays.

3. Select Audio in the Communications>Type  field.

The Audio options are as follows.
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Field Description

Device

Name (Logical name) utilized by the administrator to refer to this physical device. Exam

ple An Audio Device may be named AUDIO_1.

Communications

Type All Audio from the list of device types.

Sound Card All available output cards.

Volume Measured in percent.

Inter Mes

sage Delay

The delay between messages specified in milliseconds. Values are 1000 – 5000 

ms. Default is 2000.

Description

Notes Optional

4. Click Save.

The Device will now be visible under the Devices folder in the tree view.

Alarm Cast Administrator Device: Database
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1. Click the Devices  folder in the Alarm Cast Administrator left-pane.

2. Click New Device on the toolbar.

A Details tab displays.

3. Select Database in the Communications>Type  field.

The Database options are as follows.

Field Description

Device

Name Logical name utilized by the administrator to refer to this physical device. Example An 

ODBC Database Device may be named ODBC_DB1.

Communications

Type Select Database from the list of device types.

Description

Notes Optional

4. Click Save.

The Device will now be visible under the Devices folder in the tree view. By selecting the Devices folder, all 

of the devices will be visible in the working pane.
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Alarm Cast Administrator Device: Direct

1. Click the Devices  folder in the Alarm Cast Administrator left-pane.

2. Click New Device on the toolbar.

A Details tab displays.

3. Select Direct in the Communications>Type  field.

The Direct options are as follows.

Field Description

Device

Name (Logical name) utilized by the administrator to refer to this physical device. For exam

ple, a Direct Device may be named COM1.

Communications

Type Select Direct from the list of Device types. .  

Port 

Name

All available ports.

Flow 

Control

The way the devices throttle the flow of send and receive data. Select one of the fol

lowing.
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Field Description

◦ Hardware to use the devices hardware flow control method

◦ Software to use the devices software flow control method.

Default value is None.

Description

Notes Optional

4. Click Save.

The Device will now be visible under the Devices folder in the tree view. By selecting the Devices folder, all 

of the devices will be visible in the working pane.

Alarm Cast Administrator Device: Modem

• Modem/ModemIP.

• Modem Pool.

Important:

A modem is hosted on a TCP/IP sharing device. Several steps are required to set up a Modem 

device. To make changes to the default Modem configuration, you must add a modem to the 

Tools folder.

Modem/ModemIP

Do the following to configure the Modem/ModemIP option.

1. Click the Devices  folder in the Alarm Cast Administrator left-pane.

2. Click New Device on the toolbar.

A Details tab displays.

3. Select Modem or ModemIP in the Communications>Type  field.

Note:  If you select ModemIP, your screen will differ slightly, with Host Name  and Host Port 

replacing Port Name and Flow Control.

The Modem/ModemIP options are as follows.
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Field Description

Device

Name (Logical name) utilized by the administrator to refer to this physical device. For 

example, a Modem Device may include the name of the modem.

Communications

Type Select Modem or ModemIP from the list of device types.

Manufactur

er

All available output cards. Important:  A modem must be added before choosing 

a manufacturer.

Modem Click the Modem button to add a modem.

Port Name 

(Modem)

List of available ports. Default is the next available port.  

Flow Control 

(Modem)

The way that devices throttle the flow of send and receive data. Select one of the 

following.

◦ Hardware to use the devices hardware flow control method

◦ Software to use the devices software flow control method.

Default value is None.

Host Name 

(ModemIP)

Name of the machine being connected.
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Field Description

Host Port 

(ModemIP)

Port of the machine being connected.

Description

Notes Optional

Modem/ModemIP: Add a Modem

The Modems folder enables users to add a modem that does not display in the list of available 

modem manufacturers and models.

Adding a modem involves the import of modem definitions from Windows INF files supplied by 

Microsoft or the modem manufacturer.

There are two ways to add a modem:

◦ Modem Included with Windows

◦ Import the INF files

◦ Modem from a Manufacturer Supplied INF File

◦ Utilize a manufacturer supplied INF file

Modem Included  with Windows

Import the INF files that are included with Microsoft Windows

a. Click the Modem button to the right of the Modem  field.

The Add Modem Wizard opens.

a. Select a modem in the Standard Modem Types  list.

Tip:

If your modem is not available in the browse list, use the Show Excluded option to display 

modem configurations that have been suppressed by the manufacturer.
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a. Click Next.

A Target Server screen opens.

a. Select the Alarm Cast Server to connect to.

a. Click Next.

A Notes screen opens.

a. (Optional) Enter a note in the Notes  field.

b. Click Next.

A Ready to Add screen will indicate that your modem is being added.

a. Click Finish.

Result: Adding the modem is completed.

Modem from a Manufacturer  Supplied INF File

Utilize a manufacturer supplied INF file from a modem CD or diskette distribution.

a. Click the Modem button to the right of the Modem  field.

The Add Modem Wizard opens.

a. Select a manufacturer in the Add Modem Wizard left-pane.

b. Select a modem in the Manufacturer's  list.
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Tip:

If your modem is not available in the browse list,  use the Show Excluded option to reveal 

modem configurations that have been suppressed by the manufacturer.

a. Click Have Disk to add your manufacturer/model of modem.

b. Select the location of your modem INF file then select OK. This will begin the file transfer.

a. Click Finish to complete the addition of the Modem.

Result: When you have added the required modem(s), you can choose the Manufacturer and 

Modem from the drop-down menu in the Alarm Cast Administrator.

4. Click Save.

Result: The Modem device(s) display:
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A In the Devices folder.

B On the Tools menu in the tree view. By selecting a modem, the details specific to that modem 

show up in the Window pane. Note:  These fields are read-only.

Modem Pool

A modem pool adds multiple modems to a single device to share the load of sending messages, 

using more than one modem at one time.

Do the following to configure the Modem Pool option.

5. Click the Devices  folder in the Alarm Cast Administrator left-pane.

6. Click New Device on the toolbar.

A Details tab displays.

7. Select Modem Pool in the Communications>Type  field.

The Pool options are as follows.
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Field Description

Device

Name (Logical name) utilized by the administrator to refer to this physical device. Example A 

Modem Pool Device may be named DELL_POOL to show that the members are all Dell 

modems in this modem pool.

Communications

Type Select Modem Pool from the list of device types.

Mem

bers

A list of all available modems to add to the modem pool.  Check the modems that will 

be members of this modem pool.

Description

Notes Optional

8. Click Save.

The Device will now be visible under the Devices folder in the tree view. By selecting the Devices folder, all 

of the devices will be visible in the working pane.

Alarm Cast Administrator Device: TCP/IP
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1. Click the Devices  folder in the Alarm Cast Administrator left-pane.

2. Click New Device on the toolbar.

A Details tab displays.

3. Select TCP/IP in the Communications>Type  field.

4. Enter the device name in the Name  field.

There are no other TCP/IP options.

5. Click Save.

The Device will now be visible under the Devices folder in the tree view. By selecting the Devices folder, all 

of the devices will be visible in the working pane.

Alarm Cast Administrator Device: UDP

1. Click the Devices  folder in the Alarm Cast Administrator left-pane.

2. Click New Device on the toolbar.

A Details tab displays.

3. Select UDP in the Communications>Type  field.

4. Enter the device name in the Name  field.

There are no other UDP options.
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5. Click Save.

The Device will now be visible under the Devices folder in the tree view. By selecting the Devices folder, all 

of the devices will be visible in the working pane.

Alarm Cast Administrator Device: Wizard

1. A new Device can also be added using the Wizard, which guides the user through the required 

fields for each device type.

1. Click File>New on the Alarm Cast Administrator menu bar.

A New Item screen opens.

2. Do the following.
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A Select De

vice.

B Click OK.

A Select Server screen opens.

3. Do the following.

A Select the server to which the device will be 

added.
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B Click Next.

4. Do the following.

A Select the device type in the dropdown Type 

list.

B Click Next.

A summary of the device details will display..If the information is not correct, click the Back button 

to edit details.

5. Click Finish to add the new device to the Alarm Cast Administrator. 

The Device will now be listed in the Devices folder in the Alarm Cast Administrator left-pane.

Alarm Cast Administrator Providers

Alarm Cast Administrator Providers

1. When the limit is reached, all messages for this provider will be bounced and logged as being 

dropped due to excessive activity.  

Messages will continue to be dropped while the level of activity is higher than the limit.  

2. When messages per period drop below the specified trigger limit, the flow of messages will be 

restored automatically and logged in the sender log.
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Alarm Cast Administrator Provider: Audio

1. Do one of the following.

◦ Select the Providers folder in the Alarm Cast Administrator left-pane.

a. Click New Provider on the toolbar.

b. Select Audio in the Devices  field.

◦ Expand an Audio  device folder in the Alarm Cast Administrator left-pane.

a. Select the Providers  folder.

b. Click New Provider on the toolbar.

Audio is automatically selected in the Devices  field.

Audio provider tabs are as follows.

◦ Details Tab

◦ Connection Tab

◦ Common Tabs for Providers

Details  Tab

Select the Details tab; options are as follows.

Field Description

Server

Name Name associated with the provider.

Coverage Geographical area in which the provider can deliver messages.

Device Device to associate with the Provider.

Protocol

Max. Con

nection

Not required.

Max. 

Transac

tions

Not required.

Alpha 

Length 

Maximum length of alphanumeric pages allowed by the provider.
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Field Description

(on page 

1032)

Numer

ic Length 

(on page 

1032)

Maximum length of numeric pages allowed by the provider. Messages longer than 

this will be split into segments and sent automatically.

Protocol Language used for communicating with the messaging service provider. In this 

case, MS-SPEECH.

Communications

These fields are not required for a Provider created on an Audio type Device.

Connection  Tab

Select the Connection tab; options are as follows.

Field Description

Address 1

Voice Drop-down list of MS voices installed on the comput

er.

Description

Notes Optional.

2. Click Save.

The provider will be listed under the Provider folder as well as the Device - Provider sub-folder of the 

modem device it is associated with.

Alarm Cast Administrator Provider: Database

1. Do one of the following.

◦ Select the Providers folder in the Alarm Cast Administrator left-pane.

a. Click New Provider on the toolbar.

b. Select Database in the Devices  field.

◦ Expand a Database  device folder in the Alarm Cast Administrator left-pane.
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a. Select the Providers  folder.

b. Click New Provider on the toolbar.

Database is automatically selected in the Devices  field.

Database provider tabs are as follows.

◦ Details Tab

◦ Connection Tab

◦ Common Tabs for Providers

Details  Tab

Select the Details tab; options are as follows.

Field Description

Server

Name Name associated with the provider.

Cov

erage

Geographical area in which the provider can deliver messages.

De

vice

Device to associate with this Provider. Note:  Select the device from the dropdown list.

Protocol
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Field Description

Max. 

Con

nec

tion

Maximum connection time, in seconds, that Alarm Cast Server will remain connected to 

the provider.  This controls how long the server will attempt to transmit to the provider 

in a single session. The entry should be slightly less than the actual time to avoid be

ing disconnected during transmission of a message. Important  If there is no maximum 

number, enter 0; 0 = infinite.

Max. 

Trans

ac

tions

Maximum number of transactions that the Alarm Cast Server will perform during one 

connection.   Important: If there is no maximum number, enter 0; 0 = infinite.

Alpha 

Length 

(on 

page 

1032)

Maximum length of alphanumeric pages allowed by the provider.

Nu

meric 

Length 

(on 

page 

1032)

Maximum length of numeric pages allowed by the provider. Messages longer than this 

will be split into segments and sent automatically

Pro

tocol

Language used for communicating with the messaging service provider.  In this case, 

ODBC.

Communications

Not required.

Connection  Tab

Select the Connection tab; options are as follows.
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Field Description

Address 1

DSN Data source that has been configured to access the ODBC database for this device. 

  

User 

Name

Optional.

User 

Password

Optional.

Address 2

Address Phone number or Internet address the messaging service provider uses to accept 

pages based on the coverage area.   

User 

Name

Optional.

User 

Password

Optional.

Description
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Field Description

Notes Optional.

2. Click Save.

The provider will be listed under the Provider folder as well as the Device - Provider sub-folder of the 

modem device it is associated with.

Alarm Cast Administrator Provider: Direct

Do one of the following to configure the Direct provider option.

• Select the Providers folder in the Alarm Cast Administrator left-pane. Click New Provider on the 

toolbar. Select Direct in the Devices  field.

• Expand a Direct  device folder in the Alarm Cast Administrator left-pane. Select the Providers  folder. 

Click New Provider on the toolbar.

Direct is automatically selected in the Devices  field.

Direct provider tabs are as follows.

• Details Tab

• Connection Tab

• Common Tabs for Providers

Details  Tab

Select the Details tab; options are as follows.
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Field Description

Server

Name Name associated with the provider. Note:  The name helps users identify the provider; it does 

not affect Pager functionality.

Cover

age

Geographical area in which the provider can deliver messages.

Device Device to associate with this Provider. Note:  Select the device from the dropdown list

Protocol

Max. 

Con

nection

Not required.

Max. 

Trans

actions

Not required.

Alpha 

Length 

(on 

page 

1032)

Maximum length of alphanumeric pages allowed by the provider.
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Field Description

Nu

meric 

Length 

(on 

page 

1032)

Maximum length of numeric pages allowed by the provider. Messages longer than this will 

be split into segments and sent automatically.

Proto

col

Language used for communicating with the messaging service provider. In this case, TAP.

Communications

Byte 

Size

Number of data bits encoding a character. The value can be 7 or 8.

Parity Method of detecting some errors in transmission. The parity bit in each character can be set 

to any of the following.

• None

• Odd

• Even

• Mark

• Space.

Note:  None means that no parity bit is sent at all.

Stop 

Bits

Stop bits sent at the end of every character allow the receiving signal hardware to detect the 

end of a character and to resynchronize with the character stream. Options are 0, 1, 1.5, and 

2. Electronic devices usually use one stop bit.

Speed Rate of the transmission.

Modem 

Com

pres

sion

Read-only.

Error 

Correc

tion

Read-only.
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Connection  Tab

Select the Connection tab; options are as follows.

Field Description

Address 1

Address Not applicable.

User Name Optional.

User Pass

word

Optional.

Address 2

Address

User Name Optional.

User Pass

word

Optional.

Description

Notes Optional.

Click Save.
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Result: The provider will be listed under the Provider folder as well as the Device - Provider sub-folder of 

the modem device it is associated with.

Alarm Cast Administrator Provider: Modems

• Modem/ModemIP Provider

• Modem Pool Provider

Modem/ModemIP  Provider

Do the following to configure the Modem/ModemIP Provider option.

1. Do one of the following.

◦ Select the Providers folder in the Alarm Cast Administrator left-pane.

a. Click New Provider on the toolbar.

b. Select Modem/ModemIP in the Devices  field.

◦ Expand a Modem/ModemIP  device folder in the Alarm Cast Administrator left-pane.

a. Select the Providers  folder.

b. Click New Provider on the toolbar.

Modem/ModemIP is automatically selected in the Devices  field.

Modem/ModemIP provider tabs are as follows.

◦ Modem/ModemIP: Details Tab

◦ Modem/ModemIP: Connection Tab

◦ Common Tabs for Providers

Details  Tab

Select the Details tab; options are as follows.



Addons and Options  | 8 - Pager  | 1015

Field Description

Server

Name Name associated with the provider

Cov

erage

Geographical area in which the provider can deliver messages.

De

vice

Device to associate with this Provider. Note:  Select the device from the dropdown list

Protocol

Max. 

Con

nec

tion

Maximum connection time, in seconds, Alarm Cast Server will remain connected to the 

provider. Typically this:

◦ Specifies the maximum connection time, in seconds, allowed by the messaging 

service provider for the modem connection.

◦ Controls how long the server will attempt to transmit to the provider in a single 

session.

The entry should be slightly less than the actual time to avoid being disconnected dur

ing transmission of a message. Important  If there is no maximum number, enter 0; 0 = 

infinite.

Max. 

Trans

Maximum number of transactions that the Alarm Cast Server will perform during one 

connection. Some commercial service providers place a maximum on the number of 
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Field Description

ac

tions

messages that may be transmitted during one communication. If this is the case, en

ter the maximum number here so Alarm Cast Server does not exceed the threshold and 

get disconnected unexpectedly. Important  If there is no maximum number, enter 0; 0 = 

infinite.

Alpha 

Length

Maximum length of alphanumeric pages allowed by the provider.

Nu

meric 

Length

Maximum length of numeric pages allowed by the provider. Messages longer than this 

will be split into segments and sent automatically.

Proto

col

Language used for communicating with the messaging service provider. The drop-down 

list gives you various protocols depending on the Device type selected.  Any other pro

tocols should only be used as requested from CIMPLICITY. Available protocols include 

the following.

◦ ASCOM

◦ HARK3IDS

◦ HARBANNER

◦ IXO

◦ PET

◦ SMS

◦ TAP

◦ UCP

Communications

Byte 

Size

Number of data bits encoding a character. This value can be 7 or 8.

Parity Method of detecting some errors in transmission. The parity bit in each character can 

be set to any of the following.

◦ None

◦ Odd

◦ Even

◦ Mark

◦ Space.

Note:  None means that no parity bit is sent at all.
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Field Description

Stop 

Bits

Stop bits sent at the end of every character allow the receiving signal hardware to de

tect the end of a character and to re-synchronize with the character stream. Options 

are:

◦ 0

◦ 1

◦ 1.5

◦ 2

Electronic devices usually use 1 stop bit.

Speed Rate of the transmission.

Mo

dem 

Com

pres

sion

Use the default values unless otherwise instructed by your service provider.

Error 

Cor

rec

tion

(Checked) error correction will be used when connecting to this service provider.

Connection  Tab

Select the Connection tab; options are as follows.
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Field Description

Address 1

Provider # Phone number or Internet address the messaging service provider uses to accept 

pages based on the coverage area.

User 

Name

Optional.

User 

Password

Optional.

Address 2

Address Phone number or Internet address the messaging service provider uses to accept 

pages based on the coverage area.

User 

Name

Optional.

User 

Password

Optional.

Description

Notes Optional.
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2. Click Save.

Result: The provider will be listed under the Provider folder as well as the Device - Provider sub-

folder of the modem device it is associated with.

Modem Pool  Provider

3. Do the following to configure the Modem Pool Provider option.

◦ Select the Providers folder in the Alarm Cast Administrator left-pane.

a. Click New Provider on the toolbar.

b. Select Modem Pool in the Devices  field.

◦ Expand an Modem Pool  device folder in the Alarm Cast Administrator left-pane.

a. Select the Providers  folder.

b. Click New Provider on the toolbar.

Modem Pool is automatically selected in the Devices  field.

Modem Pool provider tabs are as follows.

◦ Modem Pool: Details tab.

◦ Modem Pool: Connection tab.

Details  Tab

Select the Details tab; options are as follows.
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Field Description

Server

Name Name associated with the provider.

Cov

erage

Geographical area in which the provider can deliver messages.

De

vice

Device to associate with this Provider. Note:  Select the device from the dropdown list

Protocol

Max. 

Con

nec

tion

Maximum connection time, in seconds, Alarm Cast Server will remain connected to the 

provider. Typically this:

◦ Specifies the maximum connection time, in seconds, allowed by the messaging 

service provider for the modem connection.

◦ Controls how long the server will attempt to transmit to the provider in a single 

session.

The entry should be slightly less than the actual time to avoid being disconnected dur

ing transmission of a message. Important  If there is no maximum number, enter 0; 0 = 

infinite.

Max. 

Trans

ac

tions

Maximum number of transactions that the Alarm Cast Server will perform during one 

connection. Some commercial service providers place a maximum on the number of 

messages that may be transmitted during one communication. If this is the case, en

ter the maximum number here so Alarm Cast Server does not exceed the threshold and 

get disconnected unexpectedly. Important  If there is no maximum number, enter 0; 0 = 

infinite.

Alpha 

Length

Maximum length of alphanumeric pages allowed by the provider.

Nu

meric 

Length

Maximum length of numeric pages allowed by the provider. Messages longer than this 

will be split into segments and sent automatically.

Proto

col

Language used for communicating with the messaging service provider. In this case, 

TAP.

Communications
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Field Description

Byte 

Size

Number of data bits encoding a character. This value can be 7 or 8.

Parity Method of detecting some errors in transmission. The parity bit in each character can 

be set to any of the following.

◦ None

◦ Odd

◦ Even

◦ Mark

◦ Space.

Note:  None means that no parity bit is sent at all.

Stop 

Bits

Stop bits sent at the end of every character allow the receiving signal hardware to de

tect the end of a character and to re-synchronize with the character stream. Options 

are:

◦ 0

◦ 1

◦ 1.5

◦ 2

Electronic devices usually use 1 stop bit.

Speed Rate of the transmission.

Mo

dem 

Com

pres

sion

Use the default values unless otherwise instructed by your service provider.

Error 

Cor

rec

tion

(Checked) error correction will be used when connecting to this service provider.

Connection  Tab

Select the Connection tab; options are as follows.
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Field Description

Address 1

Provider # Phone number or Internet address the messaging service provider uses to accept 

pages based on the coverage area.

User 

Name

Optional.

User 

Password

Optional.

Address 2

Address Phone number or Internet address the messaging service provider uses to accept 

pages based on the coverage area.

User 

Name

Optional.

User 

Password

Optional.

Description
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Field Description

Notes Optional.

4. Click Save.

The provider will be listed under the Provider folder as well as the Device - Provider sub-folder of the 

modem device it is associated with.

Alarm Cast Administrator Provider: TCP/IP

• Configuration: TCP/IP Procedure

• Configuration: Connection Tests

Configuration: TCP/IP Procedure

Do one of the following.

• Select the Providers folder in the Alarm Cast Administrator left-pane. Click New Provider on the 

toolbar. Select TCP/IP in the Devices  field.

• Expand a TCP/IP  device folder in the Alarm Cast Administrator left-pane. Select the Providers 

folder. Click New Provider on the toolbar.

TCP/IP is automatically selected in the Devices  field.

TCP/IP provider tabs are as follows.

• Details Tab

• Connection Tab

• Common Tabs for Providers

Details  Tab

Select the Details tab; options are as follows.
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Field Description

Server

Name Name associated with the provider.

Cov

erage

Geographical area in which the provider can deliver messages.

De

vice

Device to associate with this Provider. Note:  Select the device from the dropdown list

Protocol

Max. 

Con

nec

tion

Maximum connection time, in seconds, Alarm Cast Server will remain connected to the 

provider. Typically this:

• Specifies the maximum connection time, in seconds, allowed by the messaging service 

provider for the modem connection.

• Controls how long the server will attempt to transmit to the provider in a single session.

The entry should be slightly less than the actual time to avoid being disconnected during trans

mission of a message. Important  If there is no maximum number, enter 0; 0 = infinite.

Max. 

Trans

Maximum number of transactions that the Alarm Cast Server will perform during one connec

tion. Some commercial service providers place a maximum on the number of messages that 

may be transmitted during one communication. If this is the case, enter the maximum number 
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Field Description

ac

tions

here so Alarm Cast Server does not exceed the threshold and get disconnected unexpectedly. 

Important  If there is no maximum number, enter 0; 0 = infinite.

Alpha 

Length 

(on 

page 

1032)

Maximum length of alphanumeric pages allowed by the provider.

Nu

meric 

Length 

(on 

page 

1032)

Maximum length of numeric pages allowed by the provider. Messages longer than this will be 

split into segments and sent automatically.

Pro

tocol

Language used for communicating with the messaging service provider. In this case, SNPP-

LEVEL1.

Communications

Not required

Connection  Tab

Select the Connection tab; options are as follows.
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Field Description

Address 1

Host[Port] (SNPP or OUCHPUSH type Protocol) DSN name of the provider.

(SMTP type Protocol) Email server to send the message to the provider.  

User 

Name

Optional.

Password Optional.

Address 2 (for SNPP type Protocol)

Address Phone number or Internet address the messaging service provider uses to accept pages 

based on the coverage area.  

User 

Name

Optional.

Password Optional.

Address 2 (for SMTP type Protocol)

From Ad

dress

Email where the message was sent. The service provider uses this address, if required, to 

send back a message about problems sending to the destination you specified.

Hello Do

main

Domain name used to log on to the SMTP mail server specified for this provider.
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Field Description

Subject Message that will be sent to the destination.   Max length is 40 characters.

Description

Notes Optional.

Address 2 (for OUCHPUSH type Protocol)

Service 

Code

Service code supplied by provider.

Originator Specifies the phone number or name of the sender.

Click Save.

Result: The provider will be listed under the Provider folder as well as the Device - Provider sub-folder of 

the modem device it is associated with.

Configuration: Connection Tests

Test: SNPP

To test connection to your SNPP mail server from a DOS prompt type:

 TELNET snppserverhostname 444 (SNPP is usually port 444)

It should return a string in the ncformat  similar to the following: 

220 SNPP Gateway Ready

Example

NEXTEL returns:

220 SNPP Gateway Ready

after initiating the following command:

C:> TELNET SNPP.NEXTEL.COM 444

Tag Description

AUTH.HOST Host or IP-address of message sender
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Tag Description

AUTH.DO

MAIN

Domain used to log in by message sender

AUTH.USER User ID used to log in by message sender

MSG.DEST FPS destination name

MSG.NETID Email address of destination

SRV.HOST FPS hostname

SRV.DATE_S Locale specific short date format

SRV.DATE_L Locale specific long date format

SRV.TIME Locale specific time

SRV.TIME_12 Forced 12 hour time

SRV.TIME_24 Forced 24 hour time

Test: SMTP

If Protocol type is SMTP, a similar test can be done test connection.

To test connection to your SMTP mail server from a DOS prompt type:

TELNET smtpmailserverhostname 25 (mail is usually port 25)

It should return a string in the format: 

220 mailservername SMTP mailserversoft version date/timestamp

Example

Netcon’s site returns:

220 ncti103.ncti.com ESMTP Sendmail 8.11.3nb1/8.11.1;Mon, 22 Sep            2003 22:08:22-0400 

(EDT)

after initiating the following command:

C:> TELNET SMTP.NCTI.COM 25

Alarm Cast Administrator Provider: UDP
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1. Do one of the following.

◦ Select the Providers folder in the Alarm Cast Administrator left-pane.

a. Click New Provider on the toolbar.

b. Select UDP in the Devices  field.

◦ Expand an UDP  device folder in the Alarm Cast Administrator left-pane.

a. Select the Providers  folder.

b. Click New Provider on the toolbar.

UDP is automatically selected in the Devices  field.

UDP provider tabs are as follows.

◦ Details Tab

◦ Connection Tab

◦ Common Tabs for Providers

Details  Tab

Select the Details tab; options are as follows.

Field Description

Server

Name Name associated with the provider.
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Field Description

Cov

erage

Geographical area in which the provider can deliver messages.

De

vice

Device to associate with this Provider. Note:  Select the device from the dropdown list

Protocol

Max. 

Con

nec

tion

Maximum connection time, in seconds, Alarm Cast Server will remain connected to the 

provider. Typically this:

◦ Specifies the maximum connection time, in seconds, allowed by the messaging 

service provider for the modem connection.

◦ Controls how long the server will attempt to transmit to the provider in a single 

session.

The entry should be slightly less than the actual time to avoid being disconnected dur

ing transmission of a message. Important  If there is no maximum number, enter 0; 0 = 

infinite.

Max. 

Trans

ac

tions

Maximum number of transactions that the Alarm Cast Server will perform during one 

connection. Some commercial service providers place a maximum on the number of 

messages that may be transmitted during one communication. If this is the case, enter 

the maximum number here so Alarm Cast Server does not exceed the threshold and get 

disconnected unexpectedly. Important  If there is no maximum number, enter 0; 0 = in

finite.

Alpha 

Length 

(on 

page 

1032)

Maximum length of alphanumeric pages allowed by the provider.

Nu

meric 

Length 

(on 

page 

1032)

Maximum length of numeric pages allowed by the provider. Messages longer than this 

will be split into segments and sent automatically.

Pro

tocol

Language used for communicating with the messaging service provider. In this case, 

SNPP-LEVEL1.
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Field Description

Communications

Not required.

Connection  Tab

Select the Connection tab; options are as follows.

Field Description

Address 1

Host[Port] DSN name of the provider.

User Name Optional.

User Pass

word

Optional.

Address 2

Address Not applicable.

User Name Optional.

User Pass

word

Optional.
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Field Description

Description

Notes Optional.

2. Click Save.

The provider will be listed under the Provider folder as well as the Device - Provider sub-folder of the 

modem device it is associated with.

Alarm Cast Administrator Provider: Alpha and Numeric Lengths

The following tables lists the minimum and maximum alpha and numeric lengths for selected protocols.

Protocol Minimum Maximum

ANS 5 250

ASCOM 5 160

HARK3IDS 5 250

HARKBANNER 5 250

IXO 5 250

PET 5 250

MS-SPEECH 5 250

OUCHPUSH 5 150

SMS 5 160

SMTP 5 250

SMTP-FOR

DAU

5 250

SNPP 5 160

TAP 5 250

TP500 5 128

UCP 5 160
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Alarm Cast Administrator Provider: Wizard

1. A new Provider can also be added using the Wizard which guides the user through the required 

fields for each device type.

1. Click File>New on the Alarm Cast Administrator menu bar.

A New Item screen opens.

2. Do the following.

A Select Provider.

B Click OK.

A Select Server screen opens.

3. Do the following.
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A Check This existing Alarm Cast server:

B Select the server to which the provider will be added.

C Click Next.

A Select Device screen opens.

4. Do the following.
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A Check This existing device:

B Select the device to which the provider will be 

added.

C Click Next.

The Provider Identification screen opens.

a. Do the following.

A Enter the specifications that are also on the provider's Details tab in the Alarm Cast Adminis

trator.

B Click Next.

The Provider Addresses opens.

a. Do the following.
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A Enter the specifications that are also on the provider's Connection tab in the Alarm Cast Ad

ministrator.

B Click Next.

A summary of the provider details will display. If the information is not correct, click the Back 

button to edit details. 

5. Click Finish to add the new provider to the Alarm Cast Administrator. 

The provider will now be listed under the Devices folder and the Provider's folder in the Alarm Cast 

Administrator left-pane.

Alarm Cast Administrator Destinations

Alarm Cast Administrator Destinations

A Destination:

• Contains information pertaining to destinations and their configuration settings.

• Is a messaging service such as a pager, mobile phone or a database or e-mail account.

• Will be available in the Alarm Cast Alarm Administrator window.

By selecting the destinations folder you can add destinations to the system and modify their settings.
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1. Click the Destinations  folder in the Alarm Cast Administrator left-pane.

2. Click  New Destination on the toolbar.

Destination configuration includes the following tabs.

◦ Details tab.

◦ Aliases tab.

Details  Tab

Select the Details tab; options are as follows.

Description

Destination Note:  Administrative section; entries are not functional.

Name Logical name utilized by the administrator to refer to this destination.

Title Optional.

E-Mail Optional Note:  For administrative use only; the destination that is used is entered in 

the Network ID field.

Time 

Zone

Time Zone name that the destination resides in. Default is the Alarm Cast Administra

tor workstation time zone.
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Description

Note:

◦ The Time Zone can be changed in the Time Zone field.

◦ Time Zone is used when determining when schedules apply to destinations.

Type Medium for receiving messages for this destination.

Alpha 

Pager

Alphabetic text.

Numeric 

Pager

Only numerals (i.e. 0-9).

Handset Alphabetic text and numbers Example: Handset A handheld mobile multi

function device such as a Nextel handset.

Email Alphabetic text and number to a destination’s email address.

Unknown Destination device type is unknown, and assumed to be alpha numeric. 

Provider

Provider Known Providers that have been added to each Device type.

Cover

age

Geographical area in which the provider can deliver messages.

Net

work ID

Provider’s user ID number. See table below.

Description

Notes Optional

The following table outlines the Network ID for each Protocol type:

Protocol Network ID

ANS Numeric ID

ASCOM Telephone Handset Number

HARBANNER Numeric ID

HARK3IDS Numeric ID
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IXO Numeric ID

PET Numeric ID

MS-SPEECH Numeric ID

SMS Numeric ID

SMTP Email address

SMTP-FOR

DAU

Numeric ID

SNPP Numeric ID

TAP Numeric ID

UCP Numeric ID

TR500 Subscriber Number (a group number should be proceeded with an “@” sym

bol

Aliases  Tab

Select the Aliases tab; options are as follows.

Field Description

Aliases
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Field Description

Alias 

1

Alternate name that can be used for each destination. Aliases may be typed in place of 

the full destinations name in the Alarm Cast Client.  

Alias 

2

Alternate name that can be used for each destination. Aliases may be typed in place of 

the full destinations name in the Alarm Cast Client.  

Alias 

3

Alternate name that can be used for each destination. Aliases may be typed in place of 

the full destinations name in the Alarm Cast Client.  

Locator

Loca

tor 1

Reference field only which usually signifies the location of the pager. Example PLANT

FLOOR

Description

Notes Optional

3. Click Save.

The Destination will now be listed in the Destinations folder. By selecting the Destinations folder, all of the 

destinations will be visible in the working pane.

Note:

Guidelines

• It is advisable to test the new destination connection to the provider.

Click the Test button on the Alarm Cast Administrator toolbar. 

Alarm Cast will send a test message to the destination and notify of success or failure. 

• Details of the message can be viewed from the Message Log.

• The Distribution Lists, Groups, and Schedules tabs on a new Destination will not be populated until 

they are first added to the Administrator.

Alarm Cast Administrator Destinations: Wizard

1. A new destination can also be added using the Wizard, which guides the user through the required 

fields for each device type.
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1. Click File>New on the Alarm Cast Administrator menu bar.

Important:

A New Item screen opens.

2. Do the following.

A Select Destination.

B Click OK.

A Select Server screen opens.

3. Do the following.
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A Check This existing Alarm Cast server:

B Select the server to which the destination will be added.

C Click Next.

A Select Device screen opens.

4. Do the following.
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A Check This existing device:

B Select the device to which the destination will be 

added.

C Click Next.

A Select Provider screen opens.

5. Do the following.

A Check This existing provider:

B Select the provider to which  the Destination will be added

C Click Next.

The next screen contains all the information that appears on the Destination’s Details tab.

Note:  If the information is not correct, click the Back button to edit details.

6. Click Finish to add the new destination to the Alarm Cast Administrator. 

The destination will now be listed under the Destinations folder in the Alarm Cast Administrator left-pane.

.More information

• Alarm Cast Administrator destinations.
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Alarm Cast Administrator Distribution Lists

Alarm Cast Administrator Distribution Lists

1. Click the Distribution Lists  folder in the Alarm Cast Administrator left-pane.

2. Click New Distribution List on the toolbar.

Distribution configuration includes the following tabs.

◦ Details tab.

◦ Schedules tab.

Details  Tab

Select the Details tab; options are as follows.

Field Description

Distribution List

Name (Logical name) utilized by the administrator to refer to this distribution list.

Descrip

tion

Optional.

Time 

Zone

Time Zone name that the destination resides in. Default is the Alarm Cast Administra

tor workstation time zone.
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Field Description

Note:

◦ The Time Zone can be changed in the Time Zone field.

◦ Time Zone is used when determining when schedules apply to destinations.

Destinations

Name Checked destination names will be members of this distribution list.

Tip:

Check Show selected destinations only to filter the destinations list.

Schedules  Tab

Select the Schedules tab.

Schedule details must first be added via the Tools folder before assigning distribution lists. 

3. Click Save.

The distribution list will now be listed under the Distribution Lists folder in the tree view. By selecting the 

Distribution Lists folder, all of the devices will be visible in the working pane.
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Tip:

You can also add a Destination to a Distribution List by selecting the destination through the 

Devices folder then selecting the Distribution Lists tab for a list of already configured distribution 

lists.

Alarm Cast Administrator Distribution Lists: Wizard

A new distribution list can also be added using the Wizard which guides the user through the required 

fields for each provider type.

1. Click File>New on the Alarm Cast Administrator menu bar.

A New Item screen opens.

1. Do the following.

A Select Distribution List.

B Click OK.

A Select Server screen opens.

2. Do the following.



Addons and Options  | 8 - Pager  | 1047

A Check This existing Alarm Cast server:

B Select the server to which the distribution list will be added.

C Click Next.

A Distribution List Identification screen opens.

3. Do the following.
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A Enter a name for the distribution list:

B Check destinations that will be added to this distribution list.

C Click Next.

A summary of the distribution list details will display.

If the information is not correct, click the Back button to edit details.

4. Click Finish to add the new distribution list to the Alarm Cast Administrator. 

The distribution list will now be visible under the Distribution Lists folder in the tree view. By selecting the 

Distribution Lists folder, all of the devices will be visible in the working pane.

Tip:

You can also add a Destination to a Distribution List by selecting the destination through the 

Devices folder then selecting the Distribution Lists tab for a list of already configured distribution 

lists.

Alarm Cast Administrator Tools

Alarm Cast Administrator Tools

Alarm Cast Administrator comes equipped with additional tools that allow a user to configure Groups, 

Schedules and Phrases. The tools are conveniently displayed in the tree view in the Tools folder.  

• Alarm Cast Administrator Tools: Groups.

• Alarm Cast Administrator Tools:  Schedules.

• Alarm Cast Administrator Tools: Users

Alarm Cast Administrator Tools: Groups

A Group enables you to control more than one configured destination in a single package.

Adding destinations to groups provides a limitation on the available list of destinations to control, to 

which destinations a client can send messages.
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1. Expand the Tools  folder.

2. Select the Groups folder in the Alarm Cast Administrator left-pane.

3. Click New Group on the Alarm Cast Administrator toolbar.

A Details tab displays; group options are as follows.

Field Description

Group

Name Name of the Group.

Description Optional

Destination

Name Checked destination names will be members of this distribution list.

Tip:

Check Show selected destinations only to filter the destinations list.

Click Save.

The Group will now be visible under the Groups folder in the tree view. By selecting the Groups folder, all 

of the groups will be visible in the working pane.

Registry Setting
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A registry setting has been created during the Alarm Cast server installation to enable you to exclude or 

include various groups in Alarm Cast Client. This enables you to filter out the list of available destinations 

that are available for paging in Alarm Cast Client.

Open the Registry Editor (regedit.exe) on the Alarm Cast server.

Select the following:

HKEY_LOCAL_MACHINE\SOFTWARE\NETCON\Alarm Cast\

Client\Config

Double click the Group List key to enter which groups to exclude or include in Alarm Cast Client.

Groups are excluded/included, as follows.

Exclude/In

clude
Enter as:

Exclude –GROUPNAME

Include GROUPNAME

Example

Two groups have been created in Alarm Cast Administrator: 

• SUPPORT (containing DEST1, DEST2 and DEST3)

• TEST (containing DEST1, DEST4 and DEST5)

Exclude/Include Enter :

Exclude the 

groups

-TEST  This removes DEST1, DEST2, DEST4 and DEST5 from the 

list.

Include the groups SUPPORT   DEST1, DEST2 and DEST3 will be included in the list.

Alarm Cast Administrator Tools: Schedules

1. Expand the Tools  folder.

2. Select the Schedules  folder in the Alarm Cast Administrator left-pane.

3. Click New Schedule on the Alarm Cast Administrator toolbar.
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A Details tab displays; schedule detail options are:

Field Description

Schedule

Name Name associated with the Schedule.

Description Optional

Times

Type Schedule type options are:

◦ Daily

◦ Weekly

◦ Weekdays

◦ Weekend

◦ Do Not Disturb.

Do either of the following.

◦ Use the dropdown menu options.

Time is in 30 Min. increments.

◦ Type in your own time.

Important:  The schedule details must be saved before adding Destinations

4. Select the Destinations tab.

5. Click the Add button to add destinations to the schedule.
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An Assign Schedule Wizard opens; a Source screen displays.

Selection tools are as follows.

A Press Ctrl or Shift to multi-select the desired destina

tions.

B Click the Select All button to add all destinations.

C Click Next.

A Schedule Dates screen opens.

6. Do the following.
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A Select the Start  and End  Date for the Schedule

B (Optional) Enter a note about the selected schedule dates.

C Click Next.

A summary of the schedule details will display.

If the information is not correct, click the Back button to edit details.

7. Click Finish to add the new schedule to the Alarm Cast Administrator. 

Result: The schedule will now be listed under the Tools Schedules folder in the Alarm Cast 

Administrator left-pane.

New Schedule Wizard (Alternative Launch)

The New Schedule Wizard can also be opened through the New Item screen.

8. Click File>New on the Alarm Cast Administrator menu bar.

A New Item screen opens.

9. Do the following.
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A Select Schedule.

B Click OK.

A Select Server screen opens.

10. Do the following.

A Check This existing Alarm Cast server:

B Select the server to which the schedule will be added.
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C Click Next.

A Schedule Identification screen opens.

11. Do the following.

A Enter a name for the schedule.

B Click Next.

A Schedule Times screen opens.

12. Do the following.
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A Check the schedule type; options are:

◦ Daily

◦ Weekly

◦ Weekdays

◦ Weekend

◦ Do Not Disturb

Note:  The Do Not Disturb type is a schedule that can be set up to suppress a currently active 

schedule. Example An employee works Jan 1 – Mar 15 and wants to take a vacation Mar 16 

– Mar 23.   The employee will continue to get paged during holiday unless a Do Not Disturb 

schedule is created, like or similar to the following.

MORNING Jan 1 – Mar15

Do Not Disturb Mar 16 – Mar 23

AFTERNOON Mar 24 – June 31

Do Not Disturb July 1 – July 20

In these sample schedules, the employee would not receive any pages during the Do Not Dis

turb periods, but paging would resume during the regular schedules of MORNING and AFTER

NOON.

B Enter schedules for the selected type times.

C Click Next.
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A summary of the schedule details will display.

If the information is not correct, click the Back button to edit details.

13. Click Finish to add the new schedule to the Alarm Cast Administrator.

Result: The Schedule will now be listed in the tree view under the Tools, Schedules folder.

Add a Group, Schedule or Phrase

Alarm Cast Administrator comes equipped with additional tools that allow a user to configure 

Groups, Schedules and Phrases. It is conveniently displayed in the tree view under the Tools folder. 

 

The schedules option only displays if the required license key is entered on the Server’s Settings 

tab.  The Tools  folder contains the following options:

◦ Groups

◦ Schedules

◦ Modems

◦ Users

◦ Phrases

There are two ways to add Tools Options.

Method 1

Add Tools Options directly under the Destination through either of the following.

◦ Device>Provider>Destination.

◦ Destinations folder.

14. Select the Destinations folder.

15. Select the destination to be configured.

16. Click the Groups or Schedules tabs to configure these options.



Addons and Options  | 8 - Pager  | 1058

Method 2

17. Select the Tools folder

18. Select the options to configure from the available folders.

19. Click the Groups folder to add a new Group.

Note:  Modems and Users may already be populated if they have already been added.

Alarm Cast Administrator Tools: Users
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If Windows or Windows Trusted is selected for the server security, a Users folder is added to the Tools 

tree, if it was not already there.

Important:

• Security is configured separately in the Alarm Cast components:

• Alarm Cast Administrator

• Alarm Cast Alarm Administrator

• Alarm Cast Gateway

• Alarm Cast Client authenticates against configured Alarm Cast Administrator users when Security 

is enabled.

Alarm Cast Administrator: New User

Do the following.

A Select Users  in the Alarm Cast Administrator window left-pane.

B Click New User on the Alarm Cast Administrator window tool

bar.

Result: Tabs for the User profile display in the Alarm Cast Administrator right-pane.
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Alarm Cast Administrator: User Configuration

User configuration includes the following tabs.

• Details Tab

• Destinations Tab

• Distribution Lists Tab

• Preferences Tab

Details  Tab

Select the Details tab; details options to register users are as follows.

Field Description

User

User

name

Valid Windows user.

Do

main

Domain the user logs into.

Pass

word

(Required with Windows Security) Password assigned to the logged in Windows user.

Con

firm

(Required with Windows Security) Re-entered password
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Field Description

Secu

rity

Security levels are as follows.

AD

MIN

Full rights to all features.

Important:

: The ADMIN security level is required to access (open) applications. For al

most all instances, it is recommended that ADMIN be assigned to registered 

Alarm Cast users.

DE

FAULT

Can access only the Alarm Cast Client to send a manual message.

Notes

Notes (Optional) Additional details about or for the user.

Destinations  Tab

Select the Destinations tab; do the following.

A Check the destinations for the selected user’s notices.

B (Optional) Check to display only the checked destina

tions.
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Distribution  Lists Tab

Select the Distribution Lists tab; do the following.

A Check the distribution lists for the selected user’s notices.

B (Optional) Check to display only the checked distribution 

lists.

Preferences  Tab

Select the Preferences tab; options for the registered user are as follows.
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Field Description

Signature

State VOptions for manual messages being dispatched from the Alarm Cast Client are as follows.

ON Includes the signature.

OFF Does not include the signature.

Locked Options to control editing the signature are as follows.

YES The signature cannot be edited; it is locked.

NO The signature can be edited; it is unlocked.

Method Signature sources can be any of the following.

Authenticated User Login user name.

Environment Variable Defined windows variable used as a signature

User Entered Typed literal text from the Text  field (below).

Text User entered text. Note:  The text is used as the signature when the:

• State  is On.

• Method  is User Entered.
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Alarm Cast Administrator Other Tools

Alarm Cast Administrator Other Tools

The Alarm Cast Administrator provides other tools that can be accessed through the Alarm Cast 

Administrator menu bar.

• Alarm Cast Administrator Other Tools: Toolbar and Tree.

• Alarm Cast Administrator Other Tools: Options.

• Alarm Cast Administrator Other Tools: Reports.

• Alarm Cast Administrator Other Tools: Log Files

Alarm Cast Administrator Other Tools: Toolbar and Tree

The Alarm Cast Administrator user interface is conveniently displayed in a tree view. The Server, when 

expanded, shows folders for Devices, Providers, Destinations, and Distribution Lists. They enable the user 

to add information about the devices the server will use to communicate with the destinations and will 

serve as shortcuts to already configured Destinations and Distribution Lists, allowing the user to quickly 

locate this information without knowing the device that supports them.

Under the Devices folder, there will be a Provider folder which contains the providers set up under that 

particular device. The same providers are also listed under the main Provider folder.

Under the Providers folder, there will be Destinations folder which contains the destinations set up under 

that particular provider.  The same destinations are also listed under the main Destinations folder.  

The Distribution Lists folder also contains a Destinations folder which contains the destinations included 

under each particular list.

Anything created on the tree view side of the screen (left-pane) can be modified or deleted at any time. 

You can also change the state to disable.

Tree View Items: Modify

Select the item you want to alter. The information regarding it will show up on the right hand side of 

the screen. At this point, you can change the name along with any other variables attached to it (e.g. 

configuration settings etc.)When you save your changes, they will appear in the Tree View.
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Important:

Information regarding manufacturer or models, cannot be altered. Once the modified information 

has been saved, you cannot revert to the old information. The only way to retrieve it is to change it 

back to its original state.

Tree View Items: Delete

There are two ways to delete items on the Tree View side of your screen. By selecting the item you want 

to delete, you can choose Edit >Delete on the Menu bar or simply click the red Delete  symbol ( X).

Important:

You cannot recover any deleted item or any information attached to it. You must recreate it.

In certain applications, if a particular item is being used in another part of the application, you will not be 

able to delete it at that level. You must go further down in the Tree View to discern where it is being used, 

and delete it there first.

Alarm Cast Administrator Other Tools: Options

The Tools menu enables users to set Alarm Cast Server options and details.

Click the Tools>Options on the Alarm Cast Administrator menu bar.

An Options dialog box opens; options tabs are as follows.

• Details tab.

• Preference tab.

Details  Tab

Select the Details tab.

Options are as follows.
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Option Description

Data 

Source

Provides the Alarm Cast Server database and user/password requirement.

License 

key.

Enter the license key. Note: The key determines the number of servers that can be config

ured.

Server Re

load

Provides the option to reload the server with any additions, edits or deletions automatically 

or when requested by the user.

Reload with every 

change

Reload will occur when the Save button is clicked.

Reload only when re

quested

Alarm Cast will report that there are data changes with the option 

to either:

• Send the reload before closing

• Close the system without reloading the changes.



Addons and Options  | 8 - Pager  | 1067

Preferences  Tab

Select the Preferences tab in the Options dialog box.

Options are as follows.

Option Description

Log File 

Path

Identifies the Log File path. Example C:\Proficy\Proficy CIMPLICITY\ALARMCAST\LOGS

Time 

Format

Identifies the default format for time. Note:  Change the Display Time Format and Inactivity 

Timeout according to your system needs.

Alarm Cast Administrator Other Tools:  Reports

The Reports menu enables users to view and print various reports on configured devices, providers, 

destinations or aliases.
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1. Click Reports on the Alarm Cast Administrator menu bar.

2. Select a report to view or print.

Reports display the following.

• Devices report displays devices that have been configured, including:

• Audio, Database

• Direct

• Modem

• Modem Pool

• Modem IP

• TCP/IP

• UDP.

• Providers report displays the providers that have been configured such SJNPP or SMTP type 

providers.

• Destinations report displays each destination and the provider they are configured to. 

• Aliases report displays all configured aliases that have been assigned to each destination.

Alarm Cast Administrator Other Tools:  Log Files

1. Select View>View Logs on the Alarm Cast Administrator menu bar.

2. Click the log to be viewed.

The selected log opens.

guide:

Alarm Cast Administrator Filter Guidelines

◦ Click the Filters button on the selected log window toolbar.
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An Alarm Cast Gateway Filter dialog box opens.

◦ The Events On:  field defaults to the current day.

◦ The Status Message  field can be used to search for a portion of the message in the log.

Important:  When matching special characters, enclose them in brackets.

Example

To find all log items that start with [ enter in [[]* in the Status Message  field.

The common allowed search characters are as follows:

Char

ac

ter

Match 

Made
Example

? Any single 

character

Text in the log is ABC, DBC and XYZ. If ?BC is used in the Status Message 

field, only ABC and DBC will be returned.

* Zero or 

more char

acters

*Initiated* in the Status Message field would return all log items with the 

word ‘Initiated'

# Any single 

digit (0-9)

Text in the log is Device1, Device5, Device8, Device10. Keying in Device# in 

the Status Message field, will return Device1, Device5, and Device8.

◦ Check Automatic Refresh to automatically refresh the log file based on the seconds 

specified.

Alarm Cast Redundancy

Alarm Cast Redundancy

Beginning with CIMPLICITY v9.0, Alarm Cast redundancy can be implemented with some redundancy 

functionality, while preserving Alarm Cast for paging.

This documentation provides a configuration guide based on using an email server  as the endpoint for 

paging.
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1  (on 

page 

1070)

Alarm Cast Redundancy: Primary Server

2  (on 

page 

1077)

Alarm Cast Redundancy: Secondary Server

3  (on 

page 

1082)

Alarm Cast Redundancy: Final Setup Steps

o  (on 

page 

1082)

Alarm Cast Redundancy: Known Issues

Important:

Before you configure redundancy for Alarm Cast, make sure that the following is true.

• Server Redundancy without Alarm Cast is:

• Configured

• Working properly

• The host files have been configured.

• An Email server is accessible from both the Primary and Secondary systems

• You have a working knowledge of Alarm Cast standalone configuration.

1. Alarm Cast Redundancy: Primary Server

Configure the following on the Primary server.

A  (on 

page 

1071)

Primary Server: Alarm Cast Administrator

B  (on 

page 

1072)

Primary Server: Start CIMPLICITY Project
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C  (on 

page 

1072)

Primary Server: Alarm Cast Gateway

D  (on 

page 

1075)

Primary Server: Stop CIMPLICITY Project

E  (on 

page 

1075)

Primary Server: Alarm Cast Alarm Administra

tor

F  (on 

page 

1076)

Primary Server: Alarm Cast Registry Settings

1. Primary Server: Alarm Cast Administrator

Configure the Alarm Cast Administrator first on the Primary computer.

1. Open the Alarm Cast Administrator window on the primary server.

2. Select the Details tab.

3. Make sure the required values are entered correctly.
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Field Description

Alarm Cast Alarm Manager Server

Host 

Name

LOCALHOST  must be entered for the host name. Important: Using a computer name will 

prevent a smooth copy of the configuration to the secondary server.

Connection

DSN (Source host) Primary computer name.

Logging

Path The same log paths (as defined in this configuration) must exist on the secondary sys

tem. This physical path must exist on both systems.

4. Define your:

a. Email/ISP providers.

b. Destinations.

c. Distribution lists.

5. Test your configuration to be sure you can send and receive the test emails.

a. Primary Server: Start  CIMPLICITY Project

Start the CIMPLICITY project on the primary server only.

a. Primary Server: Alarm Cast Gateway

Open the Alarm Cast Gateway window on the primary server.

6. Expand Equipment>Alarm Cast in the Workbench left-pane.

7. Double-click Administrator.

Alarm Cast Gateway configuration for redundancy includes the following.

◦ Primary Alarm Cast Gateway: Details Tab

◦ Primary Alarm Cast Gateway: Security

Primary Alarm Cast Gateway: Details  Tab

8. Select the Details tab in the Alarm Cast Gateway window.

9. Make sure the required values are entered correctly
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Field Description

Alarm Cast Alarm Server

Host 

Name

LOCALHOST must be entered for the host name.

Source 

Host

Primary computer name.

Logging

Path The same log paths (as defined in this configuration) must exist on the secondary 

system.

Primary Alarm Cast Gateway: Security

In order for Alarm Cast to communicate with the CIMPLICITY project security must be configured 

so the processes can exchange information.

Configuration options for the Security component are as follows.

◦ Primary Alarm Cast Gateway Security: Workbench Option

◦ Primary Alarm Cast Gateway Security: Alarm Cast Option

Primary Alarm Cast Gateway Security: Workbench  Option

(Not Recommended) The nodes can be configured to be trusted clients in CIMPLICITY security.
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Important:

Using the trusted method will create a trust that forces CIMPLICITY to always use the 

specified user for login to these nodes.

10. Open the Pager project in the CIMPLICITY Workbench.

11. Select Security>Advanced>Client  in the Workbench left-pane.

12. Create a new client for each node.

13. Check Trusted in the Client Properties dialog box for each node.

Result: Both nodes will be listed as trusted nodes in the Workbench right-pane.

Primary Alarm Cast Gateway Security: Alarm Cast Option

(Recommended)

14. Make sure at least Alarm Cast v9.4.01 is installed.

Note:  Additional options are available in the Alarm Cast CIMPLICITY Gateway beginning with 

version 9.4.01.

15. Open the Alarm Cast Gateway window, if it is not already opened.
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16. Enter the following.

Field Description

Settings

User Name Name of user who has access to Pager alarms.

Password Valid password for the specified user.

a. Primary Server: Stop  CIMPLICITY Project

Stop the project on the primary server.

a. Primary Server: Alarm Cast Alarm Administrator

The Alarm Cast Alarm Administrator on the primary server has one configuration requirement for a 

successful redundancy setup.

17. Open the Alarm Cast Alarm Administrator window.

a. Expand Computer in the Workbench left-pane.

b. Double-click Alarm Cast Alarm Administrator in the Workbench left or right-pane.

18. Select the Connections tab.

19. Enter LOCALHOST in the Host Name  field.

Note:  The Alarm Manager should look locally for the alarms.
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a. Primary Server: Alarm Cast Registry  Settings

Alarm Cast redundancy requires edits in the Microsoft Windows Registry.

20. Stop both of the following services.

◦ First Page Alarm Manager service.

◦ First Page Server service.

21. Open Regedit.exe.

22. Add/modify the following string registry key:

a. Select the key.

Locations on 32-bit and 64-bit machines are as follows.

32-

bit:

HKEY_LOCALMACHINE\Software\SEQENT\FirstPAGE Alarm Manager\Server\Config\CIM

PRedundancy

64-

bit:

HKEY_LOCALMACHINE\\Software\Wow6432Node\SEQENT\FirstPAGE Alarm Manag

er\Server\Config\CIMPRedundancy

a. Enter Enabled for the Value.

23. Close the Microsoft Windows Registry.

24. Perform a configuration update for the CIMPLICITY project on the primary server.

25. Restart the following services:

◦ First Page Alarm Manager service.

◦ First Page Server service.

The primary server has been set up for Alarm Cast redundancy.
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2. Alarm Cast Redundancy: Secondary Server

Configure the following on the secondary server.

A  (on 

page 

1077)

Secondary Server: Database

B  (on 

page 

1078)

Secondary Server: Alarm Cast Administrator

C  (on 

page 

1079)

Secondary Server: Start CIMPLICITY Project

D  (on 

page 

1079)

Secondary Server: Alarm Cast Gateway

E  (on 

page 

1080)

Secondary Server: Stop CIMPLICITY Project

F  (on 

page 

1080)

Secondary Server: Alarm Cast Alarm Administra

tor

G  (on 

page 

1081)

Secondary Server: Alarm Cast Registry Settings

1. Secondary Server: Database

1. Select the secondary server.

2. Stop the following services.

◦ First Page Alarm Manager service.

◦ First Page Server service.

3. Copy the database files from the Alarm Cast configuration of the Primary system to the secondary.

The database files are located in a default installation path:
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32-bit: C:\Program Files\Proficy\Proficy Cimplicity\AlarmCast\DATA\

64-bit: C:\Program Files (X86)\Proficy\Proficy Cimplicity\AlarmCast\DA

TA\

Important:

a. Backup the currently existing .mdb files on the secondary server.

b. Copy only the .mdb files from the primary to the secondary server.

4. Configure the Data source Name (DSN) for the Alarm Cast Gateway.

5. Create an exact copy of the ALARMCASTGWCIMPServer_1 DSN that was created on the Primary 

System.

Note the path where you copied the .mdb files.

6. Restart the following services:

◦ First Page Alarm Manager service.

◦ First Page Server service.

a. Secondary Server: Alarm Cast Administrator

7. Expand the Proficy HMI SCADA – CIMPLICITY v<n>Alarm Cast folder on the Windows Start menu.



Addons and Options  | 8 - Pager  | 1079

Note:  The Alarm Cast folder may be at the bottom of the list, below Workbench.

8. Click Administrator.

The Alarm Cast Administrator window opens.

9. Verify that the:

a. Configuration was brought over from the primary server.

b. COMPUTER name information matches the Secondary server name.

c. Secondary Server: Start  CIMPLICITY Project

10. Make sure the CIMPLICITY project is stopped on the primary server.

11. Create a new project with the same name as the CIMPLICITY project on the primary server.

12. Make sure Alarm Cast Gateway is enabled in the project.

13. Start the project on the secondary server.

a. Secondary Server: Alarm Cast Gateway

Open the Alarm Cast Gateway window on the secondary server.

Configuration is as follows.

◦ Secondary Alarm Cast Gateway: Settings Tab

◦ Secondary Alarm Cast Gateway: CIMPLICITY Tab

Secondary Alarm Cast Gateway: Settings  Tab

14. Select the Settings tab in the Alarm Cast Gateway window.

15. Change the Source Host  name to the name of the secondary server.

Note:  The name that is automatically entered is the name of the primary server; this is incorrect.
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Secondary Alarm Cast Gateway: CIMPLICITY  Tab

16. Select the CIMPLICITY tab in the Alarm Cast Gateway window.

17.  Verify that the configuration has been set with the correct project User name/Password 

connection credentials.

18. Save the changes.

a. Secondary Server: Stop  CIMPLICITY Project

19. Stop the CIMPLICITY project on the secondary server.

20. Close the project’s Workbench.

21. Delete the project.

Note:  This project is no longer needed.

a. Secondary Server: Alarm Cast Alarm Administrator

22. Expand the Proficy HMI SCADA – CIMPLICITY v<n>Alarm Cast folder on the Windows Start menu.

Note:  The Alarm Cast folder may be at the bottom of the list, below the Workbench.

23. Click Alarm Administrator.

The Alarm Cast Alarm Administrator window opens.

24. Select the Connections tab.

25. Change the Host Name to reflect the proper Gateway.

Note:The Computer name should reflect the name of the secondary computer.

If the Host Name  is set to LOCALHOST, leave this setting.
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a. Secondary Server: Alarm Cast Registry  Settings

Alarm Cast redundancy requires edits in the Microsoft Windows Registry.

26. Stop both of the following services.

◦ First Page Alarm Manager service.

◦ First Page Server service.

27. Open Regedit.exe.

28. Add/modify the following string registry key:

a. Select the key.

Locations on 32-bit and 64-bit machines are as follows.

32-

bit:

HKEY_LOCALMACHINE\Software\SeQuent\FirstPAGE Alarm Manager\Server\Config\CIM

PRedundancy

64-

bit:

HKEY_LOCALMACHINE\\Software\Wow6432Node\SeQuent\FirstPAGE Alarm Manag

er\Server\Config\CIMPRedundancy

a. Enter Enabled for the Value.

29. Close the Microsoft Windows Registry.

30. Perform a configuration update for the CIMPLICITY project on the secondary server.

31. Restart the following services:

◦ First Page Alarm Manager service.

◦ First Page Server service.

The secondary server has been set up for Alarm Cast redundancy.
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3. Alarm Cast Redundancy: Final Setup Steps

1. Make sure that:

◦ A configuration update was performed on the redundant project.

◦ The following services have been started on both the primary and secondary servers.

◦ First Page Alarm Manager Service

◦ First Page Server Services

2. Start the project.

3. Open the Alarm Cast Alarm Administrator on both the Primary and Secondary servers.

4. Navigate to one of your alarms.

5. Click the Initiate alarm button.

6. Click Terminate alarm.

Any errors regarding the Gateway will indicate the host name resolution to LOCALHOST.

You should verify that you can resolve to127.0.0.1or you are having port issues with the firewall.

Tip:

You can use the {SERVER.HOST.CURR} message shortcut to state which system is sending the 

message.

Alarm Cast Redundancy: Known Issues

1. Stop the CIMPLICITY project.

2. Confirm that Alarm Cast is stopped.

3. Add all new Alarm Cast modifications on the primary server.

4. Copy the modifications over to the secondary server.

Tip:

You can manually enter the alarm into the Alarm Administrator or the Administrator tool; as 

long as you keep the modifications entered the same.

Ping LOCALHOST resolution to ::1 (IPV6 TCP IP Protocol) breaks alarm cast:

If the ping response of LOCALHOST is ::1, you are using IP6.

Alarm Cast does not support the IP6 standard.
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Do the following.

5. Disable the protocol on all network cards

6. Remove the ‘# ::1 LOCALHOST‘  entry from the host file in windows.

7. Add the line 127.0.0.1 LOCALHOST  to the host file

8. Reboot the server.

Alarm Cast Administrator Glossary

Administrator

Typically a GUI application, this component facilitates configuration and monitoring of a server engine. If 

changes are made to the server configuration the administrator notifies the engine to reload its running 

configuration either automatically or on user demand. An example of an administrator component is 

Alarm Cast Administrator.  This administrator allows you to maintain the Alarm Cast server's engine 

configuration.

Administrator Kit

An administrator kit contains the product's administration component only.  After installing this kit on a 

workstation you may utilize any of the features of the Administrator component.

Alias

An Alarm Cast Server alias is an alternate name, which may be assigned to a destination. Alarm Cast 

Server client applications may choose to allow users to utilize aliases to lookup actual destination names.

Alpha Length

The Alpha Length property of a provider indicates the maximum length a single message may be for this 

service provider. Messages of longer than this length will either be rejected by the provider or truncated. 

By setting this value to a number either the same or smaller than the provider’s maximum, Alarm Cast 

Server will automatically break any transactions exceeding this limit into multiple messages.

ANS

The ANS protocol is a proprietary messaging protocol of Ford Motor Company.

ASCOM

The ASCOM protocol is a proprietary messaging protocol used to interface with the ASCOM PBX.
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Client

A client component utilizes the facilities of a standard server.  Typically a GUI application, this component 

provides a user-friendly interface of the available services offered by the server engine. An example 

of a client tool would be Alarm Cast Client, which presents the user with a list of known messaging 

destinations and allows them to send messages to one or more destinations.

Coverage

The coverage property of a provider is a name assigned to reflect the geographical area that this 

connection to the service provider allows you to send message too. Usually for example in the case of 

dial-up modem connection to service providers a different phone number is provider for each city. The 

coverage field provides the administrator an easy method of tracking all of the different coverage areas a 

single provider is supporting.

Destination

An Alarm Cast Server destination is a name assigned to a messaging location to which text messages 

may be delivered. Ex. SCOTTS_PAGER, KENS_PHONE, JIMS_EMAIL.

Device

An Alarm Cast Server device is a name assigned to a physical connection point on the server that will be 

used to establish a connection with a service provider.

Device Pool

A device pool is a collection of multiple devices that work together to provider a higher throughput 

connection to one or more providers. Commonly used with modems a device pool of 3 modems can 

provide a high level of throughput to a provider with only dialup modems for input, or two or more 

providers can share the modem pool and use as many modems as they require at the time. Should more 

throughputs be required one or more additional devices may be added to the pool at any time.

Distribution List

An Alarm Cast Server distribution list is a collection of destinations that can be sent a message with 

a single transaction. Similar to an e-mail distribution list a client that initiates a transaction with a 

distribution list will automatically send the same message to all associated destinations.
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DSN

A DSN, Data Source Name, is the name assigned to an ODBC driver and configuration information that 

allows an ODBC enabled application to connect to a data source.

Engine

An engine component implements a unified interface to a set of common,        related protocols. 

The engine provides services to clients and gateways such that a common interface may be used to 

manipulate many different types of devices. Engines are administered via Administrator components and 

are utilized by clients, gateways or use written components.

Error Correction

The Error Correction property of a provider indicates that for the modem connection to this provider the 

providers modem use or do not use modem error correction features. If this item is unchecked then error 

correction will not be used when connecting to this service provider.

Gateway

A gateway component creates a bridge between a third party product and a standard server. Typically 

an engine this component provides a conduit for forwarding events from the third party product into a 

standard server.

Group

An Alarm Cast Server group is a name assigned to a collection of destinations that are logically 

connected. Groups are used by Alarm Cast Server clients to limit the destinations which are available for 

use.

IXO

The IXO protocol is the predecessor to the TAP protocol. See TAP.

Max Transactions

The max transactions property for an Alarm Cast Server provider reflects the maximum number of 

message transactions the provider will allow in a single session, before disconnecting the device. 

Entering a value of slightly lower than the provider, allows Alarm Cast Server to cleanly interface with the 

service provider.
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Max Connection

The max connection property for a Alarm Cast Server provider reflects the maximum number of seconds 

the Alarm Cast Server may remain connected to the provider before the provider initiates a disconnect. By 

entering a value of slightly lower than the time the provider allows before forcing a disconnect, Alarm Cast 

Server will be able to more cleanly interface with the service provider.

Modem Compression

The Modem Compression property of a provider indicates that for the modem connection to this provider 

the providers modem use or do not use modem compression features. If this item is unchecked then 

modem compression will not be used when connecting to this service provider.

Modem Pool

A modem pool is a device pool consisting of only devices of type: Modem, ModemIP, or a combination of 

the two.

Network ID

A destination network id is the identifier the messaging network requires to remit a message to an 

end destination. Similar to a phone number a network id can be any number of numbers, alphabetic 

characters, or a combination of the two. For TAP connected providers the network id is usually a numeric 

value. For SMTP connected providers the network id is the devices assigned e-mail address.

Numeric Length

The Numeric Length property of a provider provides the same functionality as the Alpha Length property.

ODBC

The ODBC protocol is an implementation of the Microsoft ‘Open Database Connectivity’ API allows Alarm 

Cast Server to forward messages to any ODBC compliant data source.

PET

The PET protocol is the predecessor to the IXO protocol. See TAP.

Phrase

An Alarm Cast Server phrase is a word or group or words, which the system administrator can restrict 

from being transmitted to a destination. Primarily designed to limit the use of foul language, any 

transaction containing one of the defined phrases will be rejected by the engine.
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Provider

An Alarm Cast Server provider is a name assigned to the configuration information required to connect to 

a messaging service provider.

MS-Speech

The MS-Speech protocol is a speech API protocol that converts text to speech using available voice 

options.

Schedule

An Alarm Cast Server schedule is a name assigned to a set of weekday configuration rules, which define 

the times during which a destination may receive messages. A schedule, once defined may then be 

assigned to a destination over a time period.

Server Kit

A server kit typically contains the server engine and administrator components. In some cases a client 

component is also included with this kit. The server kit is usually installed on a centralized host, and one 

or more clients or gateways utilize this server. An example of a server kit is Alarm Cast Server. This kit 

contains the Alarm Cast engine, administrator and client.

SMS

The SMS acronym stands for ‘Short Message Service’. This term is usually used to define the paging 

component of today’s multi-functional wireless phone handsets.

SMTP

The SMTP protocol is the ‘Simple Mail Transfer Protocol’. Forming the backbone of the Internet mail 

transport, this protocol is used to move almost 100% of all e-mail sent via the Internet. Some wireless 

service providers assign a unique e-mail address to each wireless device to allow anyone with an Internet 

e-mail account to send messages to the device.

SNPP

The SNPP protocol is the ‘Simple Network Paging Protocol’. Loosely based on the SMTP protocol, SNPP 

has been tailored to support both one and two way messaging services. It is used to connect to providers 

who offer connections to their networks via the Internet.
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TAP

The TAP provider protocol is the ‘Telocator Access Protocol’. This protocol, standardized by the PCIA 

(Personal Communications Industry Association) it providers Alarm Cast Server with the primary 

connection method for most of North America’s one-way paging providers.

UCP

The UCP protocol is the ‘Universal Computer Protocol’. Primary utilized to connect to European GSM/

SMS telephone handset PBX’s, this protocol contains many more features than the more common TAP 

protocol.

Wizard

A wizard is a prompted process that guides an application user through a complicated data entry process, 

providing hints as to the appropriate answers required for each field or screen.

Alarm Cast Alarm Administrator

About Alarm Cast Alarm Administrator

The following topics contain an overview of the CIMPLICITY Alarm Cast Alarm Administrator and Alarm 

Cast Alarm server.

Important:

• The Alarm Cast Administrator and Alarm Cast Alarm Administrator must be on the same machine.

• Warning messages might open during configuration that Alarm Cast cannot connect to the project 

if the Alarm Cast Gateway is not running.

Note:  The Alarm Cast Gateway runs when the project is running.

Alarm Cast Alarm Administrator: Key Features

Alarm Cast Alarm Administrator: How it Works.

Alarm Cast Alarm Administrator Pre-configura

tion.

Alarm Cast Alarm Administrator Components.

Alarm Cast Alarm Administrator Tools
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Alarm Cast Alarm Administrator Glossary

Alarm Cast Alarm Administrator: Key Features

Alarm Cast Alarm Administrator is another product in the Alarm Cast Suite of products and may reside 

on your Alarm Cast Server or access an Alarm Cast Server over a LAN or WAN connection. It is designed 

to centralize all wireless alarm management into one single application. This means that alarms/events 

from all automated monitoring systems in your enterprise can be centrally maintained and dispatched 

from one system.

Alarm Cast Alarm Administrator adds full alarm management capabilities to Alarm Cast. Utilizing the 

alarm management features of Alarm Cast Alarm Administrator, proper attention can be directed towards 

events based on severity including repeat messages and event escalation. Active alarms are then 

reported to the engine for initiation; the engine then records and tracks each alarm over its lifetime.

Key Features:

• Escalation hierarchy: includes built-in logic including attributes, delay before send, repeat and more

• Optionally sends terminate message to prevent unnecessary responses once problem resolved

• Server configuration is hot reloadable, allowing real-time changes to the live system with no impact 

on alarms in process

• Time-based escalation

Alarm Cast Alarm Administrator: How it Works
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Alarm Cast Alarm server alarms or events are triggered by automated monitoring systems and 

communicated to Alarm Cast Alarm Administrator through a Gateway for CIMPLICITY for a specific 

product, or a user developed application.

The most popular and reliable interface is TCP/IP sockets. Upon receipt of an alarm, the Alarm Cast 

Alarm engine repeatedly notifies and escalates messages until they are cleared by the automated 

monitoring system. Utilizing the Alarm Cast Alarm Administrator, alarm names are selected from a 

dynamic list of alarms or events and configured. Destinations and text messages are defined for each 

level of escalation. Escalation templates are utilized to provide rapid for setup.

Alarm Cast Alarm Administration requires that the source application only report when an event has 

started and (optionally) when an event has stopped. The Alarm Cast Alarm Server is informed as to which 

alarms to process and what messaging attributes to apply to each event. This enables the applicable level 

of attention to be paid to each event, depending on its severity.

These attributes can include: 

• People who should be alerted.

• A delay (time active) before the event is sent.

• How often and at what interval a message can be resent.

• Notifications that an event has cleared.

• Optional text if the text sent by the source application is not applicable.

An alarm message database can be quite dynamic and require a lot of management.  Alarm Cast Alarm 

Manager Server has the following tools to make the job easier:

• Mass Add, Position Swap and Mass Delete configuration tools.

• Report generator - by alarm or individual.

• Workstation administrator to allow decentralized alarm configuration.

• Visual icons that display what has /has not been configured.

Alarm Cast Alarm Administrator: Supported Gateways

HMI/SCADA CIMPLICITY

Alarm Cast Alarm Administrator Pre-configuration

Alarm Cast Alarm Administrator Pre-configuration
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The Alarm Cast Alarm Manager Administrator utility program is used to configure and control the Alarm 

Cast Alarm Manager Server engine.

System managers responsible for Alarm Cast are the intended users of Alarm Cast Alarm Manager 

Administrator.

The features and operations that can be performed with Alarm Cast Alarm Manager Administrator include 

adding, modifying, deleting, listing, printing database information, viewing logs and changing server 

configurations, etc.

Do the following before configuring the Alarm Cast Alarm Administrator.

Alarm Cast Alarm Administrator:  Database conversion.

Alarm Cast Alarm Administrator: DSN Specifications.

Alarm Cast Alarm Administrator: Application folder availabili

ty.

Alarm Cast Alarm Administrator: Database Conversion

The database for the Alarm Cast server is FPAMServer.mdb.

Note:

If the previous CIMPLICITY Pager was installed, the corresponding FPAMAdmin.mdb database will be 

incompatible with Alarm Cast Administrator; however it can be converted

Note:  If you have not converted then database, when you start the Alarm Cast Administrator for the first 

time after you install Alarm Cast, a message will report that the database is incompatible;  the Database 

Convertor must be run.

Example: Windows 7

1. Open the Windows Start menu.

2. Select CIMPLICITY>Alarm Cast>Database Conversion.
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A Database Conversion dialog box opens.

3. Click Next.

The Wizard will report if the database is up to date or needs conversion; if the database requires 

conversion the Wizard will guide you through the steps

Alarm Cast Alarm Administrator: DSN Specifications

Open the ODBC Data Source Administrator.

• 32-Bit System

a. Open the Control Panel

b. Select Administrative Tools > Data Sources (ODBC).

The ODBC Data Source Administrator opens.

a. Choose the System DSN tab.

• 64-Bit System

Important:  System data sources are created in the ODBCAD32  location; they may not be listed on the 

System DSN tab when you open the ODBC Data Source Administrator on a 64-bit system.
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a. Click the Start button on the Windows task bar.

b. Enter the following in the Command Line  field.

c:\windows\syswow64\odbcad32.exe

a. Press Enter.

The ODBC Data Source Administrator opens.

a. Select the DSN tab.

The System Data Sources will be listed.

Note:

Guidelines

• The DSN name and location can be changed

• There are no restrictions to name or location of the DSN or databases as long as the structure and 

table names don’t change.



Addons and Options  | 8 - Pager  | 1094

A Select FPAMSERV

ER.

B Click Configure.

An ODBC Microsoft Access Setup dialog box opens.

Note:

Guidelines

• The database (.mdb) location can be changed.

For a UNC address, enter \\<Server name>\<Shared folder name>\<data>\<database filename>

• There are no restrictions to name or location of the DSN or databases as long as the structure and 

table names don’t change.

• Administration tools that are provided by Alarm Cast must be used to modify data in the 

databases.

• The default path is ..\Proficy CIMPLICITY\ALARMCAST\DATA\FPAMServer.MDB.

Alarm Cast Alarm Administrator: Application Folder Availability

An Alarm Cast application folder that contains data and log files needs to be shared in order to be 

accessible for Alarm Cast requirements.
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Note:  This procedure is for Windows 7 64-bit; it might be slightly different for other operating systems.

1. Choose the ALARMCAST  application folder, which contains the Alarm Cast data and log files.

Following are the default paths for 32-bit and 64-bit systems.

32-bit system ...Program Files\Proficy\Proficy CIMPLICITY\ALARMCAST

64-bit system ...Program Files (x86)\Proficy\Proficy CIMPLICITY\ALARM

CAST

2. Right-click the ALARMCAST  folder to open the ALARMCAST Properties dialog box.

3. Assign Full Control to the Everyone  user.

Example: Assign Sharing Permissions to the Everyone User

Do the following on a Windows 7 system; other Windows operating systems may differ slightly.

a. Select Properties on the ALARMCAST Popup menu.

The Server Properties dialog box opens.

4. Do the following.
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A Select the Sharing tab.

B Click Advanced Shar

ing.

An Advanced Sharing dialog box opens.

a. Do the following.
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A Check Share this fold

er.

B Click Permissions.

A Permissions for ALARMCAST dialog box opens.

5. Do the following.
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A Select Everyone.

B Make sure Allow is checked for all options.

C Click Apply.

6. Click OK to close the dialog boxes.

ALARMCAST is now available

Alarm Cast Alarm Administrator Components

Alarm Cast Alarm Administrator Components

Note:  Configure the Alarm Cast Alarm Administrator key components in the following order.

Alarm Cast Alarm Administrator Server.

Alarm Cast Alarm Administrator Escalation Schemes.
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Alarm Cast Alarm Administrator Gateway for CIMPLICITY 

Agents

Alarm Cast Alarm Administrator Server

• Alarm Cast Alarm Administrator: New Server

• Alarm Cast Alarm Administrator: Server Configuration

Alarm Cast Alarm Administrator: New  Server

1. Do the following.

A Expand Computer  in the Workbench left-pane.

B Select Alarm Cast Alarm Administrator.

C Double-click Alarm Cast Alarm Administrator  in the Workbench right-

pane.

2. Do the following.
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A Select Alarm Cast Alarm Servers in the Alarm Cast Alarm Administrator left-

pane.

B Click the New Server button on the Alarm Cast Alarm Administrator toolbar.

A Select Data Source browser opens.

3. Select the Alarm Cast Alarm Server data source.

Default FPAMSERV

ER
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4. Click OK.

Alarm Cast Alarm Administrator: Server Configuration

Server configuration includes the following tabs.

◦ Details tab.

◦ Settings tab.

◦ Alarm Cast Servers tab.

◦ Agent Licenses tab.

◦ Security Tab

Details  Tab

The Details tab defines the connection from the Alarm Cast Alarm Administrator to the Alarm Cast 

Alarm Server allowing it to maintain a server.
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Field Description

Server

Host 

Name

TCP/IP resolvable name that:

a. Must be in your DNS server or local host file.

b. Can be reached from the Administrator workstation.

De

scrip

tion

Additional details to help identify the server.

Connection

DSN Automatically entered when the server is saved.

User 

Name

Optional

Pass

word

Optional

Logging

Path Log Path  required to access the logs directory on the current Alarm Cast server. 

In most cases, if the server is locally installed this path will be a drive letter based 

directory specification. Example C:\Program Files(x86)\Proficy\Proficy CIMPLICI

TY\ALARMCAST\Logs\ If the server being managed is not the local server then this 



Addons and Options  | 8 - Pager  | 1103

path will most likely be a UNC path (\\server\share\directory\), which provides ac

cess to the remote servers log directory. Example \\LAB1\FPServer\logs\.

Settings  Tab

Select the Settings tab to configure the server options.

◦ If the server has never been configured, the contents of the Settings tab contain defaults.

◦ If the server is already configured and operational, these fields will be filled with the current 

server's settings

\

Field Description

Server

TCP/

IP 

Port

Default is 8001.

Li

cense 

Key

Valid license key

Logging

Log 

Days

Number of days the log file will be kept before being purged. Defaults is 7 days.
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Log 

Level

Notes

◦ In the event of any problems, CIMPLICITY may request additional levels of 

logging to assist in problem solving.

◦ A log level of 15 is recommended for initial setup.

If something is going to go wrong it will be on initial setup; a 15 log level will cap

ture that. When everything is set up you can decrease the level or leave it at 15; it 

does not affect functionality. However, the higher number will cause the logs to col

lect more, which will make them roll over more on a busy system. This may make it 

more difficult to go through them and understand.

Maxi

mum 

Space

Amount of space to allot to the log file. Note: This prevents the log files from con

suming too much drive space. Default is 50 MB.

Path Path specification, local to the actual Alarm Cast Alarm Manager Server. It contains 

the directory where the Alarm Cast Server will store its log files. Tip:  You can copy 

the path selected on the Details tab into this field.

Alarm Cast Servers  Tab

Select the Alarm Cast Servers tab to configure the Alarm Cast Server details.

Field Description

Alarm Cast Server
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Server 

Name

Name of the Alarm Cast Server. Note:  It is preferable to enter the actual ma

chine name rather than use LOCALHOST.

Port Port the Alarm Cast Server uses.  Default is 8003.

Retries Number of attempts that are made to connect to the Alarm Cast Server.  De

fault is 3 attempts.

Honor 

Schedules

Check this option if Alarm Cast alarms should honor schedules that have been 

configured in the Alarm Cast Alarm server.

Agent Licenses  Tab

Select the Agent Licenses tab to enter valid license keys for all agents that will be utilized.  

Alarm Cast Alarm Administrator has been designed to centralize alarm/event management and 

notification. To handle the many different types of alarm/event monitoring systems and other plant 

floor devices, different agents have been developed to interface with the various types of systems.

Alarm Cast Alarm Administrator enables users to register only the agents desired by entering a 

license key specific to that agent.

Security  Tab

If security is enabled a Login dialog box will open when a user tries to open the Alarm Cast Alarm 

Administrator window. Only users who have been configured in the Tools>Users tree will have 

access.
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Select the Security tab: security options for the selected server are as follows.

Field Description

Security

Mode Security options for the Alarm Cast Alarm Administrator server are as follows.

NONE Alarm Cast security is not enabled for the server.

Win

dows

A valid user name/password are required. Security is as follows.

a. A Users  folder is added to the Tools tree.

b. Users who should have access to the Alarm Cast server need to be 

added.

c. A Login dialog box opens when a user attempts to open the Alarm Cast 

Alarm Administrator window.

Result: Listed  users with valid user names/passwords will have access to the 

server.



Addons and Options  | 8 - Pager  | 1107

Win

dows 

Trusted

Uses a trusted domain account; does not require a password.

a. A Users  folder is added to the Tools tree.

b. Users who should have access to the Alarm Cast server need to be 

added.

Result: After a listed user logs into Windows, the user can open the Alarm 

Cast Alarm Administrator window; a Login dialog box is not required.

Default NONE

5. Must be in your DNS server or local host file.

6. Can be reached from the Administrator workstation.

7. A Users  folder is added to the Tools tree.

8. Users who should have access to the Alarm Cast server need to be added.

9. A Login dialog box opens when a user attempts to open the Alarm Cast Alarm Administrator 

window.

10. A Users  folder is added to the Tools tree.

11. Users who should have access to the Alarm Cast server need to be added.

12. Click Save on the Alarm Cast Alarm Administrator toolbar.

the server configuration is saved.

Alarm Cast Alarm Administrator: Escalation Schemes

The Escalation Schemes folder enables you to add and maintain all escalation schemes that determine 

the hierarchy of incoming alarms. Multiple escalation schemes can be created to handle and organize 

alarms by priority or by level of importance.  For example, low level escalation schemes might be required 

to deal with low level priorities and high-level escalation schemes to deal with higher priority alarms.

Due to the hierarchical nature of escalation levels, the function of each alarm scheme is directly related to 

the escalation levels directly above and below it.

Escalation schemes include the following configuration.
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• Escalation Scheme: Defined

• Escalation Scheme: Item

Escalation Scheme: Defined

Escalation scheme configuration options depend on what type is selected.

1. Select Escalation Schemes in the Alarm Cast Alarm Administrator left-pane.

2. Click the New Escalation Scheme button on the Alarm Cast Alarm Administrator toolbar.

A Details tab displays; options are as follows.

Field Description

Details

Name Logical name utilized by the administrator to refer to this escalation scheme.

De

scrip

tion

Additional details to help identify the escalation.

Type Types are as follows.

Delay Advances through its levels as the alarm ages.

 Count Begins notification only after the specified number of times an incident occurs in 

a time frame.
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Scheme Items

Lists the escalation scheme items in order of priority; the first scheme is the highest pri

ority. Tip:  Click the Up or Down arrow to change a selected scheme's position in the list.

3. Click Save on the Alarm Cast Alarm Administrator toolbar.

Result: The escalation scheme will now be visible in the Escalation Schemes folder in the tree view.

 Escalation Scheme: Item

4. Expand an Escalation Scheme in the Alarm Cast Alarm Administrator left-pane.

An Items folder displays.

5. Select the Items folder;

6. Click New Escalation Item on the Alarm Cast Alarm Administrator toolbar.

Escalation scheme item configuration includes the following tabs.

◦ Details tab

◦ Destinations tab

Details  Tab

Select the Details tab options depend on the escalation scheme type.

◦ Delay

◦ Count

Escalation Scheme: Delay

Select the Details tab; escalation scheme Delay type, options are as follows.
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Field Description

Details

Name Logical name utilized by the administrator to refer to this escalation item/level. 

Example An area at this level will send a message first to: SUPERVISOR_ASSMBLY_

LINE1

Description Details that help identify the escalation level.

Type Automatically set when the Escalation Scheme was created.

Settings

Initial Delay Delay in seconds after an alarm has been initiated; before a message is sent.

After Item Check to send the message after another level has been completed.

guide:

 Guidelines

◦ Select the level from the dropdown list.  

◦ One level must be completed before using the After Item option.  

◦ Select either of the following options to specify when the message will be 

sent:

◦ After the specified item is completed for X seconds

◦ The item has been active for X seconds.
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Message 

Count

Number of messages to be sent. Default is 5 messages.

Delay be

tween Mes

sages

Delay in seconds between each message that will be sent.

Escalation Scheme: Count

Select the Details tab; escalation scheme Count type, options are as follows.

Field Description

Details

Name Logical name utilized by the administrator to refer to this escalation item/level. 

Example An area at this level will send a message first to: SUPERVISOR_ASSMBLY_

LINE1

Description Details that help identify the escalation item/level.

Type Automatically set when the Escalation Scheme was created.

Settings

Every x 

times in x

Number of occurrences to monitor the fault occurrence as well as the specified 

time frame in one of the following.

◦ Seconds

◦ Minutes
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◦ Hours

◦ Days

When the criteria are met, the notification process will begin.

Message 

Count

Number of messages to be sent.   Default is 5 messages.

Delay be

tween Mes

sages

Delay in seconds between each message that will be sent.

Destinations  Tab

7. Select the Destinations tab.

8. Check the names of persons and/or groups who should receive notifications about the selected 

item.

9. Click Save.

The escalation scheme item will now be visible in the associated escalation scheme's folder in the tree 

view.

Alarm Cast Alarm Administrator Agents

Alarm Cast Alarm Administrator Agents
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• Gateway: For CIMPLICITY Agents

• Gateway: For Message Templates

• Gateway: For CIMPLICITY Alarms

• Gateway: Message Value Fields

Gateway for CIMPLICITY: Agents

1. Click the Agents  folder in the Alarm Cast Administrator left-pane.

2. Click New Agents on the toolbar.

Gateway for CIMPLICITY automatically displays in the Agent Type  field.

Gateway for CIMPLICITY agent configuration provides the following tabs.

◦ Details tab

◦ Connections tab

◦ Settings tab

◦ Event Throttling tab

◦ Wildcard Exceptions tab

◦ Alarm Defaults tab

Details  Tab

Select the Details tab; details options are as follows.

Field Description
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Configuration

Agent 

Type

Gateway for CIMPLICITY.

Dis

play 

Name

Logical name utilized by the administrator to refer to the agent. Note:  The name will be 

listed in the tree view when the configuration is saved.

Source 

Host

Name of the machine where the agent selected is running.   Important:  The name must 

match the Source Host  name that is configured on the Gateway. This becomes partic

ularly important if you are working with more than one project and there is one Alarm 

Cast Administrator and Alarm Cast Alarm Administrator running.

Appli

cation

Gateway for CIMPLICITY.

Project 

Name

CIMPLICITY project that is opened and running; this connects the agent to that project.

Alarm 

Termi

nate 

sup

ported

Automatically checked if the agent type supports alarm termination.  

Connections  Tab

Select the Connections tab; connections options, which are automatically created based on the 

source host, are as follows.
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Field Description

Gateway Settings

Host 

Name

Only required when connecting to the Gateways.

Port Only required when connecting to the Gateways.  Default is the port of the Host Name 

entered on the Details tab.

Connection

DSN Not required.

User 

Name

Not required.

Pass

word

Not required.

Event Throttling  Tab

Select the Event Throttling tab; event throttling options are as follows.
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Field Description

Throttling

Enable Alarm Throttling Check to enable the throttling feature. 

Disable any Event that fires 

more than n times in n sec

onds.

Number of times and seconds that must occur before the event 

is disabled.

Page the Administrator when 

the event is disabled

Check if an administrator is to be paged when event throttling is 

enabled, to report that a particular event stops sending alarms.

Destination Distribution List 

Name

Message destination.

Throttling Message Message that will be sent to the Administrator

Wildcard  Exceptions Tab

3. Select the Wildcard Exceptions tab if there are exceptions to be made on an Agent level for events 

being paged.

Example

A system has more than 100 tanks and one, TANK7, is down for maintenance.

TANK7 is entered in the Exception Details tab.
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Tank* can still be used in the alarm configuration.

However, the alarm for TANK7 will be excluded/ignored when an alarm is fired.

Field Description

Exception Details

Re

source

CIMPLICITY resource associated with the alarm

Alarm Alarm that will be included in the exception.

Class Alarm class associated with the alarm.

Message Message that describes the alarm or alarm excep

tion.

4. Click Add.

Result: The alarm is added to the Exception list.

Note:

Tips

◦ A dialog box is available in which you can select a value for each field from drop down lists; 

the values are taken from the associated project.
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a. Select the alarm  and specifications in the drop down lists.

a. Click OK.

The Select CIMPLICITY Alarm dialog box closes; field selections display in the fields on the 

Wildcard Exceptions tab.

Important:

Alarm ID lengths can have a maximum of 255 characters. If an alarm ID has 256 

characters it will not be included in the dropdown list.

a. Click Add to add the exception to the list.

◦ Any exception can be deleted from the list.

Select an exception in the list; click Remove.

Alarm Defaults  Tab

5. Select the Alarm Defaults tab to set defaults that will be used during new alarm configuration; 

options are as follows.
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Field Description

Alarm Defaults

Esc Scheme Escalation scheme that will be the default for all new alarms. 

Note: The dropdown list includes all configured escalation 

schemes.

Msg Template  (on page 

1120)

Message for the agent that can be saved as a template for fur

ther alarm configuration.  

guide:

 Guidelines

◦ To configure the message, use the { symbol to launch a 

drop down list of message options.

◦ The agent must be configured and saved first before a 

message template may be configured.

Send Alarm Termination mes

sage default “ON” for new 

Alarms

Do the following.

◦ Check if an alarm termination message will be sent for 

new Alarms

◦ Select the Terminate template from the dropdown list.  
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Important:  The agent must be configured and saved first before 

a terminate message template may be configured.

6. Click Save.

The CIMPLICITY GATE will now be visible in the Agents folder; the CIMPLICITY GATE folder includes an 

Alarms and Message Templates folder.

Gateway for CIMPLICITY: Message Templates

1. Expand Agents< CIMPLICITY GATE in the Alarm Cast Alarm Administrator left-pane.

2. Select the Message Templates  folder.

3. Click New Message Template on the Alarm Cast Alarm Administrator toolbar.

A Details tab is available; options are as follows.

Field Description

Details

Name Logical name utilized by the administrator to refer to the message.   Note:  The name 

will be listed in the tree view when the configuration is saved.

De

scrip

tion

Additional text to describe the message.
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Message

Level 

x of x

Allows up to infinite levels to be configured.

Mes

sage

Text that will display when the message template is added to an alarm.

guide:

  Guidelines:  The following may be used:

◦ Regular text.

◦ The { symbol, to obtain other values.

◦ ESCALATIONTEXT LEVEL1-LEVEL10, which was added when the escalation schemes 

were created.

Related Alarms

View Click View to display alarms that use the selected message template. The resulting list 

displays the alarm and its usage.

4. Click Save.

The message template will be listed in the selected agent's Message Templates folder.

Gateway for CIMPLICITY: Alarms

1. Expand Agents< CIMPLICITY GATE in the Alarm Cast Alarm Administrator left-pane.

2. Select the Alarms  folder.

3. Click the New Alarms button on the Alarm Cast Alarm Administrator toolbar.

Alarms configuration includes the following tabs.

◦ Details tab

◦ Message tab

◦ Wildcard Exceptions tab

◦ Destination Exceptions tab

Details  Tab

Select the Details tab; options are as follows.
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Field Description

Details

Resource Machine name (e.g. TANK1)

Alarm Alarm that is associated with the resource (e.g. HIGH, LOW).

Class Further category to organize alarms

Message Configured by the user to match message text configured on CIMPLICITY alarm. 

 Wild cards can be used. Example *CRITICAL*  will find all alarms with the text 

‘CRITICAL’.

Description Additional text to further describe the alarm.

Pattern 

Match

Options are:

◦ None

◦ Simple Pattern Matching

◦ Full Regular Expressions.  

Note:  Information at this URL http://en.wikipedia.org/wiki/Regular_expression pro

vides further details about creating regular expressions.

Ignore Ac

knowledge

ment

Used for the Alarm Cast Alarm Administrator console, which will send pages re

gardless if acknowledgement of the alarm is given.
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Escalation Details

Escalation 

Scheme

Escalation scheme that will be the default for all new alarms. Note:The dropdown 

list includes all configured escalation schemes

Message  Tab

Select the Message tab; options are as follows.

Field Description

Message Details

Message Tem

plate

Message template to be associated with the alarm. Note:  The dropdown list 

contains configured templates for the agent being configured.

Terminate Message Details

Send Alarm Mes

sage Terminate

Check if the alarm is to receive a message when the alarm is terminated.

Message Tem

plate

Message that will be sent when the alarm is terminated. Note:  The drop

down list configured templates for the agent being configured.  

Escalation Text
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Same message 

for all levels

Check if all alarm levels are to send the same message.

Message Alarm specific message, created at the alarm level.  

guide:

 Guideline:  Either of the following can be used.

◦ Regular text

◦ The { symbol to obtain other values.

Message Preview

Message Displays the selected escalation text message

Terminate Displays the Level one message.

Wildcard  Exceptions Tab

Select the Wildcard Exceptions  (on page 1116)  tab if there are exceptions to be made on an Agent 

level for events being paged.

Note:  Click the Add button to add multiple exceptions.
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Click the Browse button   to the right of the Resource  field to open the Select a CIMPLICITY 

Alarm dialog box  (on page 1118)  and select a resource, alarm and (alarm) class from dropdown 

menus.

Destination  Exceptions Tab

Select the Destination Exceptions tab to set which destination will be excluded or added for the 

current alarm

Destination exception options are as follows.

Field Description

Exception Removals

Destinations that will be excluded from receiving messages regarding this alarm.   Note: 

The destinations were configured in the Alarm Cast Server Administrator.

Exception Additions

Destinations that will be added to/receive messages regarding this alarm.   Note:  These 

are additional destinations that are not currently part of the alarm’s escalation scheme and 

have been configured in the Alarm Cast Server Administrator.

Note:  Click Add to add multiple exceptions.

4. Click Save.
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The alarm will be listed in the selected agent's Alarms folder.

Gateway for CIMPLICITY: Message Value Fields

Following are Gateway for CIMPLICITY Agents message value fields.

Message Val

ue

Available 

Fields

Description

SERVER ACTIVE 

ALARM

Full string representation of the active alarm, including:

• SERVER  

• System

• Resource

• Alarm Name

• Alarm Class.

ALARM  Name of the active CIMPLICITY alarm.

APPLICATION Which source (i.e. Gateway) the alarm originated from.

DATE Date the alarm was initiated.

DATETIME Date and time the alarm was initiated.

DESCRIPTION  Alarm Cast description (display name) of the active alarm.

DESTNAME Destination or distribution list to which this alarm is being routed.

ESCITEM Numeric value of the current level of escalation for this alarm.

HOST Host name of the machine where the page originated.

TIME Timestamp of when the alarm was initiated.

USERTEXT ALARM Name of the active CIMPLICITY alarm.

CLASS Class of the active CIMPLICITY alarm.

RESOURCE Resource of the active CIMPLICITY alarm.

SYSTEM Project containing the active CIMPLICITY alarm.

STATE State of the active CIMPLICITY alarm.

RULE String representation of the rule that captured this alarm for action.

MESSAGE Message value of the active CIMPLICITY alarm.
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ESCALATION

TEXT

LEVEL1…LEV

EL10

Level specific escalation text templates as defined on the Messages 

tab of the alarm.

Alarm Cast Alarm Administrator Tools

Alarm Cast Alarm Administrator Tools

Alarm Cast Alarm Administrator comes equipped with additional tools that allow a user to view 

destinations and alarms with which they are associated, register users and verify destinations. The tools 

are conveniently displayed in the tree view in the Tools folder.  

Alarm Cast Alarm Administrator Tools: Destina

tions

Alarm Cast Alarm Administrator Tools: Users

Alarm Cast Alarm Administrator Tools: Verifier

Alarm Cast Alarm Administrator Tools: Destinations

1. Expand the Tools folder.

2. Select the Destinations folder in the Alarm Cast Administrator left-pane.

The destinations, which are pulled in from the Alarm Cast server, are listed and can be associated 

with alarms and escalation schemes.
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Alarm Cast Alarm Administrator Tools: Users

If Windows or Windows Trusted is selected for the Alarm Cast Alarm server security, a User Security 

Configuration folder is added to the Tools tree, if it was not already there.

Do the following.

A Select User Security Configuration  in the Alarm Cast Alarm Administrator window left-

pane.

B Click New User on the Alarm Cast Alarm Administrator window toolbar.

Result: Tabs for the User profile display in the Alarm Cast Administrator right-pane.

Alarm Cast Administrator Users: Details Tab

Select the Details tab; details options to register users are as follows.
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Field Description

User

User 

ID

Valid Windows user.

Do

main

Domain the user logs into.

Pass

word

(Required with Windows Security  (on page 1105)) Password assigned to the logged in Win

dows user.

Con

firm

(Required with Windows Security  (on page 1105)) Re-entered password

Secu

rity

Security levels are as follows.

SERV

ER AD

MINIS

TRATION

Full rights to all features.

Important:

: The SERVER ADMINISTRATION security level is required to access (open) 

applications. For almost all instances, it is recommended that SERVER AD

MINISTRATION be assigned to registered Alarm Cast users.

USER Can access only the Alarm Cast Client to send a manual message.
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Notes

Notes (Optional) Additional details about or for the user.

Alarm Cast Alarm Administrator Tools: Verifier

The Verifier tool alerts you to discrepancies in destination configuration and eliminates invalid 

destinations.

(If a destination name was changed in the Alarm Cast Administrator, the Verifier provides you with the tool 

to verify if the original name should be removed or replace the new name.)

1. Expand the Tools  folder.

2. Select Verifier in the Alarm Cast Alarm Administrator left-pane.

3. The Alarm Cast Alarm Administrator right-pane provides the following.

A Make sure Verify Configured Destinations is checked. Default is checked.

B Click Start.

The Verifier lists the discrepancies.

C Select the items in the list; click Remove or Replace to tell the Verifier what to do with each 

discrepancy.

The Alarm Cast Alarm Administrator verifies and fixes, when necessary, the configured destinations.
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Alarm Cast Alarm Administrator Other Tools

Alarm Cast Alarm Administrator Other Tools

Alarm Cast Alarm Administrator: Toolbar and 

tree.

Alarm Cast Alarm Administrator: Options.

Alarm Cast Alarm Administrator:  Reports.

Alarm Cast Alarm Administrator: Alarm search.

Alarm Cast Alarm Manager: Log files.

Alarm Cast Alarm Administrator Other Tools: Toolbar and Tree

The Alarm Cast Alarm Manager Administrator user interface is displayed in a tree view. The Server, when 

expanded, shows folders for Agents, Escalation Schemes and Tools. They enable the user to register 

various agents to work closely with a specific alarming/event notification system. An agent is then set up 

to manage alarms from each notification system.

It includes a Destination folder that serves as a shortcut to already configured destinations, allowing the 

user to quickly locate the alarms that the destinations are configured to without knowing the agent/alarm 

that supports them.

Anything created on the tree view side of the screen (the left hand side) can be modified or deleted at any 

time. You can also change the state to disable.

Tree View Items: Modify

Select the item you want to modify. The information regarding it will display on the right hand side of 

the window. At this point, you can change the name along with any other variables attached to it (e.g. 

configuration settings etc.) When you save your changes, they will appear in the Tree View.

Important:

Information regarding manufacturer or models, cannot be altered. Once the modified information 

has been saved, you cannot revert to the old information. The only way to retrieve it is to change it 

back to its original state.
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Tree View Items: Delete

There are two ways to delete items on the tree view side of the window. By selecting the item you want to 

delete, you can choose Edit >Delete on the Menu bar or simply click the red Delete  symbol ( X).

Important:

You cannot recover any deleted item or any information attached to it. You must recreate it.

In certain applications, if a particular item is being used in another part of the application, you will not be 

able to delete it at that level. You must go further down in the Tree View to discern where it is being used 

and delete it there first.

Alarm Cast Alarm Administrator Other Tools: Options

The Tools menu enables users to set Alarm Cast Alarm Server options and details.

Click the Tools>Options on the Alarm Cast Administrator menu bar.

An Options dialog box opens.

The General tab determines the number of servers that can be configured; options are as follows.
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Option Description

Data 

Source

Provides the Alarm Cast Alarm Server database and user/password requirement.

License 

key.

Determines the number of servers that can be configured.

Server 

Reload

Provides the option to reload the server with any additions, edits or deletions automatically 

or when requested by the user.

Reload with every 

change

Reload will occur when the Save button is clicked.

Reload only when re

quested

Reports that there are data changes about which the server needs to 

be notified. Options are:

• Send the reload before closing.

• Close the system without reloading the changes.

Alarm Cast Alarm Administrator Other Tools: Reports
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The Reports menu enables users to view and print various reports on configured devices, providers, 

destinations or aliases.

1. Click Tools>Reports on the Alarm Cast Alarm Administrator menu bar.

2. Select a report to view or print.

Reports display the following.

•  Alarm List report displays the alarms that have been configured and the agent they are configured 

to.

• Destination Alarm List report displays the destinations that have been configured and the agent 

they are configured to.

• Destination List report displays the destinations that have been configured and the agent they are 

configured to.  

• Escalation Scheme List report displays each escalation scheme and associated levels or items.

 More information

• Alarm Cast Alarm Administrator Other Tools

Alarm Cast Alarm Administrator Other Tools: Alarm Search

1. Click Tools>Search Configured Alarms on the Alarm Cast Alarm Administrator toolbar.

A Find Configured Alarms dialog box opens.

2. Do one of the following.
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Field Description

Look In Agent Agent that might contain the alarm being searched

Search for Alarms Alarm name. Note:  Wild cards can be used.

3. Click Find Now.

Alarms that match the selected criteria are listed in the Results box.

Alarm Cast Alarm Administrator Other Tools: Log Files

1. Select View on the Alarm Cast Gateway menu bar.

2. Click the log to be viewed. Options are:

◦ View Server Log

◦ View Admin Log

3. Double-click the log entry for further information.

guide:

Alarm Cast Gateway Filter Guidelines
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◦ Click the Filters button on the selected log window toolbar.

An Alarm Cast Gateway Filter dialog box opens.

The Events On:  field defaults to the current day.

The Status Message  field can be used to search for a portion of the message in the log.

Important:  When matching special characters, enclose them in brackets.

Example

To find all log items that start with [ enter in [[]* in the Status Message  field.

The common allowed search characters are as follows:

Char

ac

ter

Match 

Made

Example

? Any single 

character

Text in the log is ABC, DBC and XYZ. If ?BC is used in the Status Message 

field, only ABC and DBC will be returned.

* Zero or 

more char

acters

*Initiated* in the Status Message field would return all log items with the 

word ‘Initiated'

# Any single 

digit (0-9)

Text in the log is Device1, Device5, Device8, Device10. Keying in Device# in 

the Status Message field, will return Device1, Device5, and Device8.

◦ Check Automatic Refresh to automatically refresh the log file based on the seconds 

specified.

Alarm Cast Alarm Administrator Glossary

Administrator

Typically a GUI application, this component facilitates configuration and monitoring of a server engine. If 

changes are made to the server configuration the administrator notifies the engine to reload its running 

configuration either automatically or on user demand. An example of an administrator component is 

Alarm Cast Administrator.  This administrator allows you to maintain the Alarm Cast server's engine 

configuration.
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Administrator Kit

An administrator kit contains the product's administration component only. After installing this kit on a 

workstation you may utilize any of the features of the Administrator component.

Agent

A module that is developed to work closely with a specific alarming/event notification system.

Client

A client component utilizes the facilities of a standard server.  Typically a GUI application, this component 

provides a user-friendly interface of the available services offered by the server engine. An example 

of a client tool would be Alarm Cast Client, which presents the user with a list of known messaging 

destinations and allows them to send messages to one or more destinations.

Destination

An Alarm Cast Server destination is a name assigned to a messaging location to which text messages 

may be delivered. Ex. SCOTTS_PAGER, KENS_PHONE, JIMS_EMAIL.

DSN

A DSN, Data Source Name, is the name assigned to an ODBC driver and configuration information that 

allows an ODBC enabled application to connect to a data source.

Engine

An engine component implements a unified interface to a set of common, related protocols. The engine 

provides services to clients and gateways such that a common interface may be used to manipulate 

many different types of devices. Engines are administered via Administrator components and are utilized 

by clients, gateways or use written components.

Gateway

A gateway component creates a bridge between a third party product and a standard server. Typically 

an engine this component provides a conduit for forwarding events from the third party product into a 

CIMPLICITY standard server.

An example of a gateway would be an interface to an HMI or SCADA system forwarding events from that 

system to Alarm Cast Alarm Manager for processing.
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Host

The host is the location or machine name where alarms are initiated from.

ODBC

The ODBC protocol is an implementation of the Microsoft ‘Open Database Connectivity’ API allows Alarm 

Cast Server to forward messages to any ODBC compliant data source.

Schedule

An Alarm Cast Server schedule is a name assigned to a set of weekday configuration rules, which define 

the times during which a destination may receive messages. A schedule, once defined may then be 

assigned to a destination over a time period.

Server Kit

A server kit typically contains the server engine and administrator components. In some cases a client 

component is also included with this kit. The server kit is usually installed on a centralized host, and one 

or more clients or gateways utilize this server. An example of a server kit is Alarm Cast Server. This kit 

contains the Alarm Cast engine, administrator and client.

User Text

Custom text fields that may be added to alarm messages.  Alarm Manager allows up to 20 user text 

messages to be configured.

Wizard

A wizard is a prompted process that guides an application user through a complicated data entry process, 

providing hints as to the appropriate answers required for each field or screen.

Alarm Cast Gateway for CIMPLICITY

About Alarm Cast Gateway for CIMPLICITY

The following topics provide an overview of the Alarm Cast Gateway for CIMPLICITY including detailed 

configuration descriptions.

Alarm Cast Gateway for CIMPLICITY: Key Features

Alarm Cast Gateway for CIMPLICITY:  How it Works
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Alarm Cast Gateway for CIMPLICITY Components

Alarm Cast Gateway for CIMPLICITY Tools: Users

Alarm Cast Gateway for CIMPLICITY Other Tools

Alarm Cast Gateway for CIMPLICITY Glossary

Alarm Cast Gateway for CIMPLICITY: Key Features

Alarm Cast Alarm Manager Gateway for CIMPLICITY is an Alarm Cast administration system that enables 

users to easily configure various rules that, once triggered, will send a message to a variety of Alarm Cast 

destinations, using a simple generic language.

Key Features:

• Hot reload for any configuration changes/additions.

• Data items embedded in alarm messages are updated during the life of the alarm.

Alarm Cast Gateway for CIMPLICITY:  How it Works

Alarm Cast Gateway for CIMPLICITY is another product in the Alarm Cast suite of products. Alarm Cast 

Alarm Manager Gateway can reside on your Alarm Cast Alarm Manager Server or access an Alarm Cast 

Alarm Manager Server over a LAN or WAN connection.
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The Alarm Cast Gateway for CIMPLICITY provides a bridge between CIMPLICITY project alarms and the 

Alarm Cast Alarm Manager Server.  Various routing rules can be defined by selecting available Resources, 

Alarms, Classes and alarm message text that have been configured in a CIMPLICITY project. When one of 

these rules is met, message text can be dispatched to Alarm Cast Server, including embedding alarm and 

point values within the message text.

There are four valid alarm states that may be configured for each Routing Rule:

State The alarm:

Generate Has gone into an active state.

Acknowledged Is acknowledged either:

• Manually by an operator in the Alarm Viewer.

• Automatically (The point alarm is set up to Auto Ack).

Reset • Is back either:

• Manually by an operator in the Alarm Viewer.

• Automatically reset.

Delete Has been terminated after meeting the Deletion Require

ments.

Alarm Cast Gateway for CIMPLICITY Components

• Alarm Cast Gateway: Enabled

• Alarm Cast Gateway: Remote Client

• Alarm Cast Gateway: Server

Alarm Cast Gateway: Enabled

1. Open the appropriate CIMPLICITY project in the Workbench.

2. Click Project>Properties on the Workbench menu bar.

The Project Properties dialog box opens.

3. Select the General tab.

4. Check Alarm Cast Gateway.
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Alarm Cast Gateway: Remote Client

5. Expand Project >Security>Advanced in the Workbench left-pane.

6. Double-click Client.

A New Client dialog box opens.

7. Enter the Computer  name in the Computer field.

8. Click OK.

The client Properties dialog box opens.

9. Enter the following.
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A Enter ADMINISTRA

TOR.

B Check Trusted.

Alarm Cast Gateway: Server

10. Start the CIMPLICITY project.

11. Stop the FPAMGATEWAY  process, as follows.

a. Expand Runtime in the Workbench left-pane; double-click Process Control.

The CIMPLICITY Process control dialog box opens.

a. Do the following.

1 Select FPAMGATEWAY.

2 Click Stop Process.

The FPAMGATEWAY  process is halted.

12. Open the Alarm Cast Gateway, as follows.
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A Expand Project>Equipment>Alarm Cast in the Workbench left-

pane.

B Select Administrator.

C Double-click Administrator  in the Workbench right-pane.

Result: The Alarm Cast Gateway window opens.

Alarm Cast Gateway configuration includes the following tabs.

◦ Details Tab

◦ Settings Tab

◦ Security Tab

◦ CIMPLICITY Tab

Details  Tab

Select the Details tab; options are as follows.
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Field Description

Gateway Server

Project ID Automatically assigned when the new server has been saved.

Project 

Name

Automatically entered. Note:  This is the same name as the project that was 

opened in Workbench.  

Connection

DSN Automatically entered when the server is saved.

User Name Optional.

Password Optional.

Settings  Tab

Select the Settings tab; options are as follows.
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Field Description

Server

Server 

Port

(Automatically entered) default value in the range from 8070 to 8089.

Important:

◦ Each project must have a unique port assigned to it.

◦ Keep the value the system assigns unless instructed by CIMPLICITY to do 

otherwise.

License 

Key

Valid Alarm Cast Gateway for CIMPLICITY license key

Alarm Cast Alarm Manager Server

Host 

Name

TCP/IP resolvable name for the machine running Alarm Cast Alarm Manager Server.

Server 

Port

Port that connects to the Alarm Cast Alarm Manager Server. Default is 8001.
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Source 

Host

(Automatically entered) TCP/IP resolvable name for the machine running the Alarm 

Cast Alarm Manager Gateway for CIMPLICITY and where the CIMPLICITY project is 

running.

Logging

Log Days Number of days the log file will be kept before being purged. Default is 7 days.

Log Lev

el

For use at the request of CIMPLICITY. In the event of any problems, CIMPLICITY may 

request additional levels of logging to assist in problem solving. Default is 0.

Maxi

mum 

Log 

Space

Amount of space to allot to the log file. Note: This prevents the log files from con

suming too much drive space. Default is 50 MB.

Path Path to directory where the Marquee Manager Server will store its log files. Impor

tant:  The path should reflect a directory on the CIMPLICITY project server.

Security  Tab

If security is enabled a Login dialog box will open when a user tries to open the Alarm Cast 

Gateway window. Only users who have been configured in the Tools>Users tree will have access.

Select the Security tab: security options for the selected server are as follows.
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Field Description

Security

Mode Security options for the Alarm Cast Gateway server are as follows.

NONE Alarm Cast Gateway security is not enabled for the server.

Win

dows

A valid user name/password are required. Security is as follows.

a. A Users  folder is added to the Tools tree.

b. Users who should have access to the Alarm Gateway server need to be 

added.

c. A Login dialog box opens when a user attempts to open the Alarm Cast 

Gateway window.

Result: Listed  users with valid user names/passwords will have access to the 

server.

Win

dows 

Trusted

Uses a trusted domain account; does not require a password.

a. A Users  folder is added to the Tools tree.

b. Users who should have access to the Alarm Gateway server need to be 

added.

Result: After a listed user logs into Windows, the user can open the Alarm Cast 

Gateway window; a Login dialog box for the Alarm Cast Gateway  is not re

quired.

Default NONE

CIMPLICITY  Tab

Select the CIMPLICITY tab.

Selections are global to all alarms within the project; options are as follows.
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Field Description

CIMPLICITY

Ignore Alarm 

ACK

Alarm does not need to be acknowledged by an operator to suppress messag

ing Note:  The message will be suppressed even if ACK is required in the alarm’s 

CIMPLICITY configuration.

Terminate be

tween state 

changes

Stop messaging from escalating further when the alarm state changes.   Mes

saging will commence at level one for the alarm on each state change.   

ACK Termi

nate Alarms

Terminate an alarm when the engine receives an ACK.

Suppress 

alarms at 

startup

Will not initiate enabled alarms that are found at the startup.

Settings

User Name Name that matches a user name in the CIMPLICITY project Note:  The users are 

accessed by selecting Security>Users in the Workbench left-pane; the users are 

listed in the right-pane.

Password Valid password for the selected user.
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13. A Users  folder is added to the Tools tree.

14. Users who should have access to the Alarm Gateway server need to be added.

15. A Login dialog box opens when a user attempts to open the Alarm Cast Gateway window.

16. A Users  folder is added to the Tools tree.

17. Users who should have access to the Alarm Gateway server need to be added.

18. Click Save on the Alarm Cast Gateway toolbar.

19. Restart the FPAMGATEWAY  process in the CIMPLICITY Process Control dialog box.

A Project ID now displays on the Gateway Server Details tab.

Alarm Cast Gateway for CIMPLICITY Tools: Users

If Windows or Windows Trusted is selected for the server security, a Tools tree with a Users folder is 

added to the Alarm Cast Gateway window left-pane.

Do the following.
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A Select Users  in the Alarm Cast Gateway window left-pane.

B Click New User on the Alarm Cast Gateway window tool

bar.

A Details Tab displays; options to register users are as follows.

Field Description

User Details

User

name

Valid Windows user.

Do

main

Domain the user logs into.

Pass

word

(Required with Windows Security  (on page 1146)) Password assigned to the logged in Win

dows user.

Con

firm

(Required with Windows Security  (on page 1146)) Re-entered password

Secu

rity

Security levels are as follows.
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AD

MIN

Full rights to all features.

Important:

: The ADMIN security level is required to access (open) applications. For al

most all instances, it is recommended that ADMIN be assigned to registered 

Alarm Cast users.

DE

FAULT

Can access only the Alarm Cast Client to send a manual message.

Notes

Notes (Optional) Additional details about or for the user.

Alarm Cast Gateway for CIMPLICITY Other Tools

Alarm Cast Gateway for CIMPLICITY Other Tools

Once configured, there is very little interaction between the user and Alarm Cast Gateway for 

CIMPLICITY. The management of this application takes place within its associated Alarm Cast 

Administrator agent.

Alarm Cast Gateway for CIMPLICITY: Options.

Alarm Cast Gateway for CIMPLICITY: Log Files

Alarm Cast Gateway for CIMPLICITY: Options

Before using Alarm Cast Gateway for CIMPLICITY, configure the various settings that control the interface 

to the gateway. 

Click the Tools>Options on the Alarm Cast Gateway menu bar.

An Options dialog box opens; options are as follows.
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Op

tion

Description

Data 

Source

Installation will default the Data Source to FPAMGWCIMPADMIN , pointing to the Gateway for CIM

PLICITY administrator database.

Serv

er 

Re

load

Enables the user to select when they want a reload to server: with every change, or only when re

quested.

Reload 

with every 

change

Reload will occur when the Save button is clicked.

Reload on

ly when re

quested

You will be informed that there are data changes the server needs to be notified 

about and have the option to either send the reload before closing or close the sys

tem without reloading the changes.

Alarm Cast Gateway: Log Files
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1. Select View on the Alarm Cast Gateway menu bar.

2. Click the log to be viewed. Options are:

◦ View Server Log

◦ View Admin Log

3. Double-click the log entry for further information.

guide:

Alarm Cast Gateway Filter Guidelines

◦ Click the Filters button on the selected log window toolbar.

An Alarm Cast Gateway Filter dialog box opens.

◦ The Events On:  field defaults to the current day.

◦ The Status Message  field can be used to search for a portion of the message in the log.

Important:  When matching special characters, enclose them in brackets.  

Example

To find all log items that start with [ enter in [[]* in the Status Message  field.

The common allowed search characters are as follows:

Charac

ter

Match Made Example

? Any single character Text in the log is:

◦ ABC

◦ DBC

◦ XYZ.

Entering ?BC returns only:

◦ ABC

◦ DBC

* Zero or more charac

ters

Entering *Initiated* returns: All log items with the word Initiat

ed

# Any single digit (0-9) Text in the log is

◦ Device1

◦ Device5
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◦ Device8

◦ Device10.

Entering Device# returns:

◦ Device1

◦ Device5

◦ Device8.

◦ Check Automatic Refresh to automatically refresh the log file based on the seconds 

specified.

Alarm Cast Gateway for CIMPLICITY Glossary

Administrator

Typically a GUI application, this component facilitates configuration and monitoring of a server engine. If 

changes are made to the server configuration the administrator notifies the engine to reload its running 

configuration either automatically or on user demand. An example of an administrator component is 

Alarm Cast Administrator.

This administrator allows you to maintain the Alarm Cast server's engine configuration.

Administrator Kit

An administrator kit contains the product's administration component only.  After installing this kit on a 

workstation you may utilize any of the features of the Administrator component.

Alarm

Generates alarms for points that are in an alarm state.  It can generate alarm messages about system 

events, such as device failures, and device statuses.

Class

Alarm class is the order in which an alarm appears relative to other alarms. Alarms with similar 

characteristics are usually grouped by class.

Distribution List

An Alarm Cast Server distribution list is a collection of marquees, which can be sent a message with 

a single transaction. Similar to an e-mail distribution list a client who initiates a transaction with a 

distribution list will automatically send the same message to all associated marquees.
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Point

Data that can be collected from various devices such as programmable controllers.  Point configuration 

defines where a point originates, how the data is collected, and what constitutes an alarm state.

Resource

The physical or conceptual units that comprise your facility and can be anything from devices and 

machines to stations where work is performed.

Server Kit

A server kit typically contains the server engine and administrator components. In some cases a client 

component is also included with this kit. The server kit is usually installed on a centralized host and is 

utilized by one or more clients or gateways. An example of a server kit is Alarm Cast Server. This kit 

contains the Alarm Cast engine, administrator and client. 

Alarm Cast Client

About Alarm Cast Client

Alarm Cast Client provides a simple, easy to use interface for creating and manually sending messages to 

remote users. It provides full access to a detailed address book of all users accessible by name, alias or 

locator.

Alarm Cast Client: Key Features

Alarm Cast Client: How it Works

Alarm Cast Client Components

Alarm Cast Client Tools

Alarm Cast Client Glossary

Alarm Cast Client: Key Features
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Key Features:

• Full access to a detailed address book of all users accessible by name, alias or locator.

• User-friendly maintenance of Destinations, Distribution Lists, Recurrences and Common Messages 

conveniently displayed in a tree view.

• Supports the addition of personal destinations and personal distribution lists.

• Detailed transaction logging and viewing of these logs.

• Logon security that can be configured for each Client machine.

• The ability to view Client in Classic Mode, for quick efficient processing of messages.

Alarm Cast Client: How it Works

Alarm Cast Client is the end user interface of the Alarm Cast Suite of applications. It enables you to create 

and send pages to remote users. 

The primary function of Alarm Cast is to send pages to remote destinations. This is facilitated through the 

use of Alarm Cast Server and a central service provider.

Alarm Cast Client allows the use of these two elements to create and deliver electronic pages simply and 

efficiently.
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Alarm Cast Client Components

Alarm Cast Client Components

Before using Alarm Cast Client, more personal destinations may be added and other features can be 

configured that will facilitate the efficient sending of messages.  

Alarm Cast Client key component configuration includes the following.

•  Alarm Cast Client Personal Destinations

• Alarm Class Client Recurrence Items

• Alarm Cast Client Common Message

• Alarm Cast Client Transaction Viewing

Important:

If Windows security has been implemented in the Alarm Cast Administrator, a Login dialog box 

will open before a user can access the Alarm Cast Client. Valid user names and passwords are 

pulled from the names configured in the Alarm Cast Administrator.

Alarm Cast Client Personal Destinations

There are two types of destinations.

Destination 

Type

Defined in Description

Public Alarm Cast Server Adminis

trator

Display on all clients that are connected to the Alarm 

Cast server.
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Personal Alarm Cast Client Only available on the selected Alarm Cast client.

Important:

Personal Destination to providers must already be configured as Destinations in the Alarm Cast 

Server.

Do the following to configure the Personal Destination option.

1. Click the Destination  folder in the Alarm Cast Client left-pane.

2. Click New Personal Destination on the toolbar.

A Details tab displays; details options are as follows.

Field Description

Destination

Name Logical name utilized by the administrator to refer to this destination.

Title Optional.

E-Mail Optional.

Time 

Zone

Time Zone name that the destination resides in. Defaults to the Alarm Cast Admin

istrator workstation time zone, but may be changed here. Is used when determining 

when schedules apply to destinations.
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Type This is the medium for receiving messages for this destination. 

Alpha 

Pager

Alphabetic text

Numeric 

Pager

Only numerals (i.e. 0-9).

Handset Allows alphabetic text and numbers such as a handheld mobile multifunc

tion device such as Nextel handset.

Email Alphabetic text and number to a destination’s email address.

Unknown Destination device type is unknown and assumed to be alpha numeric.

Provider

Provider Provider selected from the dropdown list of the known Providers that have been 

added to each Device type.

Cover

age

Geographic area in which the provider can deliver messages.

Net

work ID

Provider's user ID number.

Description

Notes Optional.

3. Click Save.

The Personal Destination is listed in the Destination folder.

Alarm Cast Client Personal Distribution Lists

The Distribution Lists  folder provides the tools to add configured destinations to distribution lists, 

allowing the same message to be sent to multiple destinations at the same time. Alarm Cast Client 

applications provide the ability to compose messages and send them to a destination, distribution list, or 

multiple combinations of both types.

Alarm Cast Client allows the user to create Distribution Lists: Standard Client or Classic Client.
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• Standard Mode utilizes a tree view, convenient for locating the desired destination or distribution 

list to send a message.

• Classic Mode utilizes a simplified interface with a single list of all destinations and distribution 

lists.

New Distribution List: Standard Client

1. Click the Distribution Lists folder in the Alarm Cast Client left-pane.

2. Click New Client on the Alarm Cast Client toolbar.

A Details tab displays; options are as follows.

Field Description

Distribution List

Name Logical name utilized by the administrator to refer to this distribution 

list.

Description Optional

Destinations

Name Checked names will are members of the selected distribution list.

3. Click Save.

Result: The Distribution List will now be listed in the Distribution Lists folder in the Alarm Cast 

Client window left-pane.
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Note:

Destinations can be:

◦ Filtered out of the destinations list by selecting the Show selected destinations only option.

You will not be able to edit any public distribution lists that have been created in Alarm Cast 

Administrator.

◦ Added to the Distribution list by selecting the destination in the Devices folder, then 

selecting the Distribution Lists tab for a list of already configured distribution lists.

New Distribution List: Classic Client

4. Click View>View Classic Mode on the Alarm Cast Client window menu bar.

 The following window opens; options are as follows.

5. Click Tools>Distribution List on the alarm Cast Client - <LOCALHOST>  window menu bar.

An Alarm Cast User Distribution List dialog box opens.
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Note:

◦ Public distribution lists can be viewed but not edited. A Personal distribution list has to be 

added; the list will be available only to this Client.

◦ Click Properties to edit existing personal distribution lists.

6. Click New.

A Distribution List Properties dialog box opens.

7. Entries are as follows.
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A Distribution List Name Name for the new personal distribution list.

B Available Destinations Checked destinations that will be members of the distribution list.

8. Click OK.

The distribution list is saved for the local client.

Alarm Cast Client Recurrence Items

A recurrence enables the user to set a recurrence pattern (schedule) to send a page daily, weekly, monthly 

or yearly. A one -time page can also be sent to a destination at a given time.

Alarm Cast Client enables the user to create Recurrence Items via Standard Client or Classic Client.

• Standard Mode utilizes a tree view, convenient for locating the desired destination or distribution 

list to send a message.

• Classic Mode utilizes a simplified interface with a single list of all destinations and distribution 

lists.

• Standard mode.

• Classic mode.

Standard  Mode

1. Click the Recurrence Items  folder in the Alarm Cast Client left-pane.

2. Click New Recurrence on the toolbar.

Recurrence configuration includes the following tabs.

◦ Message tab.

◦ Details tab.

Message  Tab

Select the Message tab; options are as follows.
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Field Description

Message

To Click to select a name associated with the Recurrence. Currently recipients may only be 

selected from Public Destinations or Public Distribution Lists.

Mes

sage

Message that will be sent with this recurrence.

Sig

na

ture

(If signature is set in Tools/Options>Preferences) When checked Signature  will include 

the signature with the recurrence message.

Details  Tab

Select the Details tab; options are as follows.
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Field Description

Send Time

Send Time the recurrence will be sent. Default is current time + 5 minutes.

Recurrence Pattern

Pat

tern

When the recurrence will be sent: Options are:

◦ Daily

◦ Weekly

◦ Monthly

◦ Yearly

◦ Every x days

◦ Every Weekday

Range of Recurrence

Start Date the recurrence will start, specifying when the recurrence will end. Options 

are:

◦ No end date

◦ End after x occurrences

◦ End by a specified date.

3. Click Save.

The recurrence item is listed in the Recurrence Items folder in the Alarm Cast Client left-pane.
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Classic  Mode

As per Standard Client Mode, recurrences can only be sent to Public Destinations and Public Distribution 

Lists.

Click View> View Classic Mode on the Alarm Cast Client window menu bar.

An Alarm Cast Client <LOCALHOST> dialog box opens;  entries are as follows.

A Destinations Selected lists are the destination lists for the selected recur

rence.

B Message Message for the selected recurrence.

Details for the recurrence are the same as they are for the Standard Client mode.

Alarm Cast Client Common Message

The Common Message folder enables users to

• Add text that is used frequently when sending messages. This feature is optional but can make 

sending of messages more efficient.

• Create Common Messages using the Standard Client or Classic Client.

• Standard mode.

• Classic mode.

Standard  Mode
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The Standard Mode utilizes a tree view, convenient for locating the desired destination or distribution list 

to send a message. 

1. Click the Common Messages  folder in the Alarm Cast Client left-pane.

2. Click New Common Message on the toolbar.

A Details tab displays.

3. Enter a common message in the Common Message  box.

4. Click Save.

Result: The common message is assigned an ID number and listed in the Common Messages 

folder.

Classic  Mode

The Classic Mode utilizes a simplified interface with a single list of all destinations and distribution 

lists.

5. Click Tools>Common Messages on the Alarm Cast Client toolbar.

An Alarm Cast Client dialog box opens.

6. Enter a common message in the Message box.

7. Click Common Messages>Add on the Alarm Cast Client toolbar.

8. Select View>View Classic Mode on the Alarm Cast Client menu bar.
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The Alarm Cast Client dialog box closes; the message is listed in the Common Messages folder in the 

Alarm Cast Client (window) left-pane.

Alarm Cast Client Transactions

Alarm Cast Client provides the capability to view all page transactions to determine the status of each 

message that has been sent.

Click the Transactions  folder in the Alarm Cast Client left-pane.

Result: The Alarm Cast Client right pane provides a listing of transactions with details as to the status of 

the transaction. 

Alarm Cast Client Tools

Alarm Cast Client Tools

The Alarm Cast Client user interface is conveniently displayed in a tree view with folders for Destinations, 

Distribution Lists, Recurrence Items, Common Messages and Transactions. They serve as shortcuts to 

already configured Destinations and Distribution Lists, allowing the user to quickly locate this information 

for sending messages.

Alarm Cast Client Tools: Send a Message

Alarm Cast Client Tools: Address Book

Alarm Cast Client Tools: Tree View



Addons and Options  | 8 - Pager  | 1169

Alarm Cast Client Tools: Options

Alarm Cast Client Tools: Log Files

Alarm Cast Client Tools: Send a Message

Alarm Cast Client enables a user to send messages via a Standard Mode as well as a Classic Mode. 

• Standard Mode utilizes a tree view, convenient for locating the desired destination or distribution 

list to send a message.

• Classic Mode utilizes a simplified interface with a single list of all destinations and distribution 

lists.

• Standard mode.

• Classic mode.

Standard  Mode

Do the following to configure the Database Provider option.

1. Do one of the following.

◦ Select the Destinations  folder in the Alarm Cast Client left-pane; select a destination in the 

Alarm Cast Client right-pane.

◦ Expand the Destinations  folder in the Alarm Cast Administrator left-pane; select a 

destination in the expanded tree.

A read-only Details tab for the selected destination displays.

2. Click New Message on the Alarm Cast Client toolbar.

A Message dialog box opens; options are as follows.



Addons and Options  | 8 - Pager  | 1170

Option Description

To Name of the destination to page.

◦ The To button opens a Select Names browser that includes a list of destina

tions available for messaging.

◦ A destination’s Alias that has been configured in Alarm Cast Administrator 

can also be entered. 

Example Enter alias Bob to page Robert Plant.

Honor 

Schedule

When checked, sends the message to the users who are currently available, as a re

sult, limits pages only to those users who are currently working.

Signature When checked, includes a signature with the message.

File>Check 

Names

(On the Message dialog box menu bar) verifies the destination names.  If keying the 

destination name, be sure to use the full name or enter in the Alias for the destina

tion, if one has been created in the Pager Administrator.

Auto Spell 

Check

When checked, verifies the text used in the message text field.

Common 

Messages

When clicked, displays a list of previously entered messages, which are available for 

selection..

Send When clicked, sends the message.
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guide:

Guidelines

◦ Some service providers have upper limits on the amount of data per page. If the message 

is longer than is supported by the service provider.  Alarm Cast will automatically break the 

message up into multiple pages.

◦ If the user you have chosen has a numeric pager, you will be limited to typing numeric 

characters (i.e. 0, 1, 2…9). 

The following cannot be sent to a distribution list that contains users with numeric destinations.

◦ An empty message cannot.

◦ Textual messages.

Alarm Cast will prompt that users with numeric destinations exist in the distribution list and that 

the message cannot be sent.

Classic  Mode

◦ Message configuration.

◦ Page postponement.

Message  Configuration

Click View> View Classic Mode on the Alarm Cast Client menu bar.

An Alarm Cast Client dialog box opens; options are as follows.
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Option Description

To Name of the destination to page.

◦ The To button opens a Select Names browser that includes a list of destina

tions available for messaging.

◦ A destination’s Alias that has been configured in Alarm Cast Administrator 

may be also be entered. 

Example Enter alias Bob to page Robert Plant.

Message Text of the message. Note:  The Message Length field provides an automatic count 

of characters in the message.

Signature When checked, includes a signature with the message.

Honor Shift 

Schedules

When checked, sends the message to the users who are currently available, as a re

sult, limits pages only to those users who are currently working.

Send When clicked, sends the message. Note:  Pressing Enter also sends the page.

Page Postponement

Classic Mode enables a user to send a single deferred page to a destination.

The page for a message that has been configured to be sent can be postponed to a later 

time or date.  This feature is particularly useful when used to set up a reminder for meetings, 

appointments, etc. 

Do the following.

3. Click the Send Deferred button on the toolbar after entering text in the Message  field and selecting 

at least one recipient.

A Deferred Date Time calendar opens.
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4. Select the date and time that the deferred page will be sent.

5. Click the Send button.

The page will be sent at the specified date and time.

Important:

Make sure a destination is selected to send the message to, as well as a message then click the 

Send button.  The message will be stored and sent on the date and time specified.

Alarm Cast Client Tools: Address Book

The address book is a built in directory of all available destinations in the database. It enables you to 

search through the entire database to select a destination.

• Standard mode.

• Classic mode.

Standard  Mode

1. Select the destination to send a message to then

2. Click New Message on the toolbar. A Message dialog box opens.

3. Click the To button, or click Tools>Address Book on the Message menu bar. A Select Names 

browser opens.
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4. Select names in any of the following: Destinations, Distribution lists, Personal destinations, 

or Personal distribution lists, and click OK. Selecting the check box by the Name category, 

e.g.  Destinations, selects all names/distribution lists under that category.

Result: The Alarm Cast Client re-opens.  All of the selected destinations will be listed in the To: 

field.

Classic  Mode

5. Click Tools>Address Book on the Alarm Cast client (classic) dialog box menu bar. A Users Search 

browser opens.

6. Enter the first letter of the last name of the user or use the scroll bar to locate the user within the 

list.

7. Double click the user name to select it from the list. 

8. Click OK.

The Alarm Cast Client re-opens.  All of the selected destinations will be listed in the To: field.

Note:  Multiple users can be selected at the same time by holding down the Shift key or the Ctrl key, then 

selecting destinations from the list.

Alarm Cast Client Tools: Tree View

Anything created on the tree view side of the screen (the left hand side) can be modified or deleted at any 

time with the exception of Public Destinations and Public Distribution Lists.  The delete option is greyed 

out and can only be performed via Alarm Cast Administrator.

Tree View Items: Modify

Select the item you want to alter. The information regarding it will show up on the right hand side of 

the screen. At this point, you can change the name along with any other variables attached to it (e.g. 

configuration settings etc.) When you save your changes, they will appear in the Tree View.

Important:

: Once the modified information has been saved, you cannot revert to the old information. The 

only way to retrieve it is to change it back to its original state.

Tree View Items: Delete

There are two ways to delete items on the Tree View side of your screen By selecting the item you want to 

delete, you can choose Edit >Delete on the Menu bar or simply click the Delete symbol ( X).
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Important:

: You cannot recover any deleted item or any information attached to it. You must recreate it.

In certain applications, if a particular item is being used in another part of the application, you will not be 

able to delete it at that level. You must go further down in the Tree View to discern where it is being used 

and delete it there first.

Alarm Cast Client Tools: Options

The Tools menu enables users to set Alarm Cast Client options.

Click Tools>Options on the Alarm Cast Client window menu bar.

The Options dialog box opens.

Client Tools Options: General Tab

Select the General tab in the Options dialog box.

The General tab displays the Log File Path to the ALARMCAST Server where messages successes and 

failures are logged as well as details about the server connection.
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Client Tools Options: Servers Tab

Select the Servers tab in the Options dialog box.

The Servers tab displays the ALARMCAST server Host name and port details.

Client Tools Options: Security Tab

Select the Security tab in the Options dialog box.
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(Optional) Select the Wait time.

When set, the machine will lock after the given time has expired, requiring a valid login user name and 

password.

Client Tools Options: Preferences Tab

Select the Preferences tab in the Options dialog box.
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Alarm Cast Client User Message Defaults  is where:

• Schedules that have been configured in the Alarm Cast Administrator will be honored

• Auto spell check messages can be enabled.

• A signature can be set and appended to messages,

Alarm Cast Client Tools: Log Files

In each application, you are able to view the log files associated with the various components of the 

software. The log files contain an accurate history of every transaction and modification made to the 

database. Log files are important because they ensure the integrity of the data and provide a means of 

data recovery.

Click View>View Log on the Alarm Cast Client menu bar.

An Alarm Cast Client log opens.

Alarm Cast Client Filter Guidelines

• Click the Filters button on the selected log window toolbar.

An Alarm Cast Gateway Filter dialog box opens.



Addons and Options  | 8 - Pager  | 1179

• The Events On:  field defaults to the current day.

• The Status Message  field can be used to search for a portion of the message in the log.

Important:  When matching special characters, enclose them in brackets.

Example

To find all log items that start with [ enter in [[]* in the Status Message  field.

The common allowed search characters are as follows:

Charac

ter

Match Made Example

? Any single character Text in the log is:

• ABC

• DBC

• XYZ.

Entering ?BC returns only:

• ABC

• DBC

* Zero or more charac

ters

Entering *Initiated* returns: All log items with the word Initiat

ed

# Any single digit (0-9) Text in the log is

• Device1

• Device5

• Device8

• Device10.

Entering Device# returns:

• Device1

• Device5

• Device8.

• Check Automatic Refresh to automatically refresh the log file based on the seconds specified.
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Alarm Cast Client Glossary

Administrator

Typically a GUI application, this component facilitates configuration and monitoring of a server engine. If 

changes are made to the server configuration the administrator notifies the engine to reload its running 

configuration either automatically or on user demand. An example of an administrator component is 

Alarm Cast Administrator.  This administrator allows you to maintain the Alarm Cast server's engine 

configuration.

Administrator Kit

An administrator kit contains the product's administration component only.  After installing this kit on a 

workstation you may utilize any of the features of the Administrator component.

Client

A client component utilizes the facilities of a standard server.  Typically a GUI application, this component 

provides a user-friendly interface of the available services offered by the server engine. An example 

of a client tool would be Alarm Cast Client, which presents the user with a list of known messaging 

destinations and allows them to send messages to one or more destinations.

Common Message

Frequently used text messages that may be used to send out common or broadcast messages.

Destination

An Alarm Cast Server destination is a name assigned to a messaging location to which text messages 

may be delivered. e.g. SCOTTS_PAGER, KENS_PHONE, JIMS_EMAIL.

Distribution List

An Alarm Cast Server distribution list is a collection of destinations that can be sent a message with 

a single transaction. Similar to an e-mail distribution list a client that initiates a transaction with a 

distribution list will automatically send the same message to all associated destinations.

Recurrence

Similar to a deferred page, allowing the user to set a schedule to send pages daily, weekly, monthly or 

yearly as well as the range of the recurrence.
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Server Kit

A server kit typically contains the server engine and administrator components. In some cases a client 

component is also included with this kit. The server kit is usually installed on a centralized host, and one 

or more clients or gateways utilize this server. An example of a server kit is Alarm Cast Server. This kit 

contains the Alarm Cast engine, administrator and client.

Transaction

The life cycle of every Alarm Cast message sent, allowing the user to see the current status of a message:

  Sent, Pending or Failure.
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